
 

Unity Manual 
Welcome to Unity.  

Unity is made to empower users to create the best interactive entertainment or multimedia experience that they can. This manual is 

designed to help you learn how to use Unity, from basic to advanced techniques. It can be read from start to finish or used as a reference.  

The manual is divided into different sections. The first section, User Guide, is an introduction to Unity's interface, asset workflow, and the 

basics of building a game. If you are new to Unity, it is recommended that you start learning by reading the Unity Basics subsection.  

The iOS Guide addresses iOS specific topics such as iOS-specific scripting API, optimizations, and general platform development 

questions.  

The Android Guide addresses Android specific topics such as setting up the Android SDK and general development questions.  

The next section, FAQ, is a collection of frequently asked questions about performing common tasks that require a few steps.  

The last section, Advanced, addresses topics such as game optimization, shaders, file sizes, and deployment.  

When you're done reading, be sure to take a look at the Reference Manual and the Scripting Reference for further details about the 

different possibilities of constructing your games with Unity.  

If you find that any question you have is not answered in this manual please ask on Unity Answers or Unity Forums. You'll definitely find 

your answer there.  

Happy reading,  

The Unity team  

The Unity Manual Guide contains sections that apply onto to certain platforms. Please select which platforms you want to see. Platform-

specific information can always be seen by clicking on the disclosure triangles on each page.  
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User Guide 
This section of the Manual is focused on the features and functions of Unity. It discusses the interface, core Unity building blocks, asset 

workflow, and basic gameplay creation. By the time you are done reading the user guide, you will have a solid understanding of how to use 

Unity to put together an interactive scene and publish it.  

We recommend that new users begin by reading the Unity Basics section.  
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Unity Basics 
This section is your key to getting started with Unity. It will explain the Unity interface, menu items, using assets, creating scenes, and 

publishing builds.  

When you are finished reading this section, you will understand how Unity works, how to use it effectively, and the steps to put a basic 

game together.  

  Learning the Interface  

 

There is a lot to learn, so take the time you 

need to observe and understand the 

interface. We will walk through each 

interface element together. 

  Asset Workflow 

 

Here we'll explain the steps to use a single 

asset with Unity. These steps are general 

and are meant only as an overview for 

basic actions.  

  Creating Scenes 

 

Scenes contain the objects of your game. 

In each Scene, you will place your 

environments, obstacles, and decorations, 

designing and building your game in 

pieces. 

 

   Publishing Builds 

 

At any time while you are creating your 

game, you might want to see how it looks 

when you build and run it outside of the 

editor as a standalone or web player. This 

section will explain how to access the Build 

Settings and how to create different builds 

of your games. 

  Tutorials 

 

These online tutorials will let you work with 

Unity while you follow along, providing 

hands-on experience with building real 

projects. 
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Learning the Interface 

First Launch 

Let's begin learning Unity. If you have not yet opened Unity, you can find it inside Start->Programs->Unity on Windows, or Applications-

>Unity on Mac. The Unity Editor will appear. Take your time to look over the Unity Editor interface and familiarize yourself with it. The 

Main Editor Window is made up of several Tabbed Windows, called Views. There are several types of Views in Unity, each with a 

specific purpose.  

 

Project View 



 

Every Unity project contains an Assets folder. The contents of this folder are presented in the Project View. This is where you store all the 

assets that make up your game, like scenes, scripts, 3D models, textures, audio files, and Prefabs. If you right-click on any asset in the 

Project View, you can choose Reveal in Explorer (Reveal in Finder on Mac) to actually see the asset itself in your file system.  

Important Note: You should never move project assets around using the OS since this will break any metadata associated with the asset. 

Always use the Project View to organize your assets.  

To add assets to your project, you can drag any file from your OS into the Project View, or use Assets->Import New Asset. Your asset is 

now ready to be used in your game. For more information about working with assets, skip ahead to the Asset Workflow section of the 

manual.  

Scenes are also stored in the Project View. Think of these as individual levels. For example, the Islands Scene loads by default when Unity 

first launches. To create a new Scene, use Control-N (Command-N on Mac). To save the current Scene into the Project View, use 

Control-S (Command-S on Mac).  

Some game assets need to be created from within Unity. To do this, use the Create drop-down, or right click->Create.  

http://unity3d.com/support/documentation/Manual/Scripting.html
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The Create drop-down 

This will allow you to add scripts, Prefabs, or folders to keep your project organized. You can rename any asset/folder by pressing F2 on 

Windows, or Enter on Mac, or with two paced clicks on the asset name. If you hold the Alt key while you expand or contract a directory, all 

subdirectories will also be expanded or contracted.  

Hierarchy 

 

The Hierarchy contains every GameObject in the current Scene. Some of these are direct instances of asset files like 3D models, and 

others are instances of Prefabs -- custom objects that will make up much of your game. You can select and Parent objects in the Hierarchy. 

As objects are added and removed from the scene, they will appear and disappear from the Hierarchy as well.  

Parenting 

Unity uses a concept called Parenting. To make any GameObject the child of another, drag the desired child onto the desired parent in the 

Hierarchy. A child will inherit the movement and rotation of its parent. You can now expand and contract the parent to see its children in the 

Hierarchy without affecting your game.  



 

Two unparented objects 

 

One object parented to another 

To learn more about Parenting, please review the Parenting section of the Transform Component page.  

Toolbar 

 

The Toolbar consists of five basic controls. Each relate to different parts of the Editor.  

Transform Tools -- used with the Scene View  

Transform Gizmo Toggles -- affect the Scene View display  

Play/Pause/Step Buttons -- used with the Game View  

Layers Drop-down -- controls which objects are displayed in Scene View  

Layout Drop-down -- controls arrangement of all Views 

Scene View 

http://unity3d.com/support/documentation/Components/class-Transform.html#Parenting
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The Scene View 

The Scene View is your interactive sandbox. You will use the Scene View to select and position environments, the player, the camera, 

enemies, and all other GameObjects. Maneuvering and manipulating objects within the Scene View are some of the most important 

functions in Unity, so it's important to be able to do them quickly.  

Scene View Navigation 

See Scene View Navigation for full details on navigating the scene view. Here's a brief overview of the essentials:  

 Hold the right mouse button to enter Flythrough mode. This turns your mouse and WASD keys (plus Q and E for up and down) into quick 

first-person view navigation.  

 Select any GameObject and press the F key. This will center the Scene View and pivot point on the selection.  

 Use the arrow keys to move around on the X/Z plane.  

 Hold Alt and click-drag to orbit the camera around the current pivot point.  

 Hold Alt and middle click-drag to drag the Scene View camera around.  

 Hold Alt and right click-drag to zoom the Scene View. This is the same as scrolling with your mouse wheel.  

You might also find use in the Hand Tool (shortcut: Q), especially if you are using a one-button mouse. With the Hand tool is selected,  

Click-drag to drag the camera around.  

Hold Alt and click-drag to orbit the camera around the current pivot point.  

Hold Control (Command on Mac) and click-drag to zoom the camera. 

In the upper-right corner of the Scene View is the Scene Gizmo. This displays the Scene Camera's current orientation, and allows you to 

quickly modify the viewing angle.  

 

http://unity3d.com/support/documentation/Manual/Scene%20View%20Navigation.html


You can click on any of the arms to snap the Scene Camera to that direction and change it to Isometric Mode. While in Isometric Mode, 

you can right-click drag to orbit, and Alt-click drag to pan. To exit this mode, click the middle of the Scene Gizmo. You can also Shift-click 

the middle of the Scene Gizmo any time to toggle Isometric Mode.  

Positioning GameObjects 

See Positioning GameObjects for full details on positioning GameObjects in the scene. Here's a brief overview of the essentials:  

When building your games, you'll place lots of different objects in your game world. To do this use the Transform Tools in the Toolbar to 

Translate, Rotate, and Scale individual GameObjects. Each has a corresponding Gizmo that appears around the selected GameObject in 

the Scene View. You can use the mouse and manipulate any Gizmo axis to alter the Transform Component of the GameObject, or you 

can type values directly into the number fields of the Transform Component in the Inspector.  

 

Scene View Control Bar 

 

The Scene View control bar lets you see the scene in various view modes - Textured, Wireframe, RGB, Overdraw, and many others. It will 

also enable you to see (and hear) in-game lighting, game elements, and sound in the Scene View. See View Modes for all the details.  

Game View 

 

The Game View is rendered from the Camera(s) in your game. It is representative of your final, published game. You will need to use one 

or more Cameras to control what the player actually sees when they are playing your game. For more information about Cameras, please 

view the Camera Component page.  

Play Mode 
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Use the buttons in the Toolbar to control the Editor Play Mode and see how your published game will play. While in Play mode, any 

changes you make are temporary, and will be reset when you exit Play mode. The Editor UI will darken to remind you of this.  

Game View Control Bar 

 

The first drop-down on the Game View control bar is the Aspect Drop-down. Here, you can force the aspect ratio of the Game View 

window to different values. It can be used to test how your game will look on monitors with different aspect ratios.  

Further to the right is the Maximize on Play toggle. While enabled, the Game View will maximize itself to 100% of your Editor Window for a 

nice full-screen preview when you enter Play mode.  

Continuing to the right is the Gizmos toggle. While enabled, all Gizmos that appear in Scene View will also be drawn in Game View. This 

includes Gizmos drawn using any of the Gizmos class functions.  

Finally we have the Stats button. This shows Rendering Statistics window that is very useful for Optimizing Graphics Performance.  

 

Game View Stats of your game.  

Inspector 

http://unity3d.com/support/documentation/Manual/RenderingStatistics.html
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Games in Unity are made up of multiple GameObjects that contain meshes, scripts, sounds, or other graphical elements like Lights. The 

Inspector displays detailed information about your currently selected GameObject, including all attached Components and their 

properties. Here, you modify the functionality of GameObjects in your scene. You can read more about the GameObject-Component 

relationship, as it is very important to understand.  

Any property that is displayed in the Inspector can be directly modified. Even script variables can be changed without modifying the script 

itself. You can use the Inspector to change variables at runtime to experiment and find the magic gameplay for your game. In a script, if you 

define a public variable of an object type (like GameObject or Transform), you can drag and drop a GameObject or Prefab into the 

Inspector to make the assignment.  

http://unity3d.com/support/documentation/Manual/GameObjects.html
http://unity3d.com/support/documentation/Manual/GameObjects.html


 

Click the question mark beside any Component name in the Inspector to load its Component Reference page. Please view the Component 

Reference for a complete and detailed guide to all of Unity's Components.  

 

Add Components from the Component menu 

You can click the tiny gear icon (or right-click the Component name) to bring up a context menu for the specific Component.  

http://unity3d.com/support/documentation/Components/Components.html
http://unity3d.com/support/documentation/Components/Components.html


 

The Inspector will also show any Import Settings for a selected asset file.  



 

Click Apply to reimport your asset. 



 

Use the Layer drop-down to assign a rendering Layer to the GameObject. Use the Tag drop-down to assign a Tag to this GameObject.  

Prefabs 

If you have a Prefab selected, some additional buttons will be available in the Inspector. For more information about Prefabs, please view 

the Prefab manual page.  

Other Views 

The Views described on this page covers the basics of the interface in Unity. The other Views in Unity are described elsewhere on separate 

pages:  

 The Console shows logs of messages, warnings, and errors.  

 The Animation View can be used to animate objects in the scene.  

 The Profiler can be used to investigate and find the performance bottle-necks in your game.  

 The Asset Server View can be used to manage version control of the project using Unity's Asset Server.  

 The Lightmapping View can be used to manage lightmaps using Unity's built-in lightmapping.  

 The Occlusion Culling View can be used to manage Occlusion Culling for improved performance.  
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Customizing Your Workspace 

Customizing Your Workspace 

You can customize your Layout of Views by click-dragging the Tab of any View to one of several locations. Dropping a Tab in the Tab 

Area of an existing window will add the Tab beside any existing Tabs. Alternatively, dropping a Tab in any Dock Zone will add the View in 

a new window.  
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Views can be docked to the sides or bottom of any existing window 

Tabs can also be detached from the Main Editor Window and arranged into their own floating Editor Windows. Floating Windows can 

contain arrangements of Views and Tabs just like the Main Editor Window.  

 

Floating Editor Windows are the same as the Main Editor Window, except there is no Toolbar 

When you've created a Layout of Editor Windows, you can Save the layout and restore it any time. You do this by expanding the Layout 

drop-down (found on the Toolbar) and choosing Save Layout.... Name your new layout and save it, then restore it by simply choosing it 

from the Layout drop-down.  



 

A completely custom Layout 

At any time, you can right-click the tab of any view to view additional options like Maximize or add a new tab to the same window.  
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Asset Workflow 
Here we'll explain the steps to use a single asset with Unity. These steps are general and are meant only as an overview for basic actions. 

For the example, we'll talk about using a 3D mesh.  

Create Rough Asset 

Use any supported 3D modeling package to create a rough version of your asset. Our example will use Maya. Work with the asset until you 

are ready to save. For a list of applications that are supported by Unity, please see this page.  

Import 

http://unity3d.com/support/documentation/Manual/HOWTO-importObject.html


When you save your asset initially, you should save it normally to the Assets folder in your Project folder. When you open the Unity project, 

the asset will be detected and imported into the project. When you look in the Project View, you'll see the asset located there, right where 

you saved it. Please note that Unity uses the FBX exporter provided by your modeling package to convert your models to the FBX file 

format. You will need to have the FBX exporter of your modeling package available for Unity to use. Alternatively, you can directly export as 

FBX from your application and save in the Projects folder. For a list of applications that are supported by Unity, please see this page.  

Import Settings 

If you select the asset in the Project View the import settings for this asset will appear in the Inspector. The options that are displayed will 

change based on the type of asset that is selected.  

Adding Asset to the Scene 

Simply click and drag the mesh from the Project View to the Hierarchy or Scene View to add it to the Scene. When you drag a mesh to the 

scene, you are creating a GameObject that has a Mesh Renderer Component. If you are working with a texture or a sound file, you will 

have to add it to a GameObject that already exists in the Scene or Project.  

Putting Different Assets Together 

Here is a brief description of the relationships between the most common assets  

 A Texture is applied to a Material  

 A Material is applied to a GameObject (with a Mesh Renderer Component)  

 An Animation is applied to a GameObject (with an Animation Component)  

 A sound file is applied to a GameObject (with an Audio Source Component)  

Creating a Prefab 

Prefabs are a collection of GameObjects & Components that can be re-used in your scenes. Several identical objects can be created from 

a single Prefab, called instancing. Take trees for example. Creating a tree Prefab will allow you to instance several identical trees and place 

them in your scene. Because the trees are all linked to the Prefab, any changes that are made to the Prefab will automatically be applied to 

all tree instances. So if you want to change the mesh, material, or anything else, you just make the change once in the Prefab and all the 

other trees inherit the change. You can also make changes to an instance, and choose GameObject->Apply Changes to Prefab from the 

main menu. This can save you lots of time during setup and updating of assets.  

When you have a GameObject that contains multiple Components and a hierarchy of child GameObjects, you can make a Prefab of the 

top-level GameObject (or root), and re-use the entire collection of GameObjects.  

Think of a Prefab as a blueprint for a structure of GameObjects. All the Prefab clones are identical to the blueprint. Therefore, if the 

blueprint is updated, so are all the clones. There are different ways you can update the Prefab itself by changing one of its clones and 

applying those changes to the blueprint. To read more about using and updating Prefabs, please view the Prefabs page.  

To actually create a Prefab from a GameObject in your scene, first create a new Prefab in your Project View. Name the new Prefab 

whatever you like. Then, click on the Game Object in the scene that you want to make into a Prefab. Drag it to the new Prefab, and you 

should see the Game Object's name text turn blue. You have now created a re-usable prefab.  

Updating Assets 

You have imported, instantiated, and linked your asset to a Prefab. Now when you want to edit your source asset, just double-click it from 

the Project View. The appropriate application will launch, and you can make any changes you want. When you're done updating it, just 

Save it. Then, when you switch back to Unity, the update will be detected, and the asset will be re-imported. The asset's link to the Prefab 

will also be maintained. So the effect you will see is that your Prefab will update. That's all you have to know to update assets. Just open it 

and save!  

Optional - Adding Labels to the Assets. 

Is always a good idea to add labels to your assets if you want to keep organized all your assets, with this you can search for the labels 

associated to each asset in the search field in the project view or in the object selector.  

http://unity3d.com/support/documentation/Manual/HOWTO-importObject.html
http://unity3d.com/support/documentation/Manual/Prefabs.html


Steps for adding a label to an asset:  

 Select the asset you want to add the label to (From the project view).  

 In the inspector click on the "Add Label" icon ( ) if you dont have any Labels associated to that asset.  

o If you have a label associated to an asset then just click where the labels are.  

 Start writing your labels.  

Notes:  

 You can have more than one label for any asset.  

 To separate/create labels, just press space or enter when writing asset label names.  
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Creating Scenes 
Scenes contain the objects of your game. They can be used to create a main menu, individual levels, and anything else. Think of each 

unique Scene file as a unique level. In each Scene, you will place your environments, obstacles, and decorations, essentially designing and 

building your game in pieces.  

Instancing Prefabs 

Use the method described in the last section to create a Prefab. You can also read more details about Prefabs here. Once you've created 

a Prefab, you can quickly and easily make copies of the Prefab, called an Instance. To create an instance of any Prefab, drag the Prefab 

from the Project View to the Hierarchy or Scene View. Now you have a unique instance of your Prefab to position and tweak as you like.  

Adding Component & Scripts 

When you have a Prefab or any GameObject highlighted, you can add additional functionality to it by using Components. Please view the 

Component Reference for details about all the different Components. Scripts are a type of Component. To add a Component, just highlight 

your GameObject and select a Component from the Component menu. You will then see the Component appear in the Inspector of the 

GameObject. Scripts are also contained in the Component menu by default.  

If adding a Component breaks the GameObject's connection to its Prefab, you can always use GameObject->Apply Changes to Prefab 

from the menu to re-establish the link.  

Placing GameObjects 

Once your GameObject is in the scene, you can use the Transform Tools to position it wherever you like. Additionally, you can use the 

Transform values in the Inspector to fine-tune placement and rotation. Please view the Transform Component page for more information 

about positioning and rotating GameObjects.  

Working with Cameras 

Cameras are the eyes of your game. Everything the player will see when playing is through one or more cameras. You can position, rotate, 

and parent cameras just like any other GameObject. A camera is just a GameObject with a Camera Component attached to it. Therefore it 

can do anything a regular GameObject can do, and then some camera-specific functions too. There are also some helpful Camera scripts 

that are installed with the standard assets package when you create a new project. You can find them in Components->Camera-Control 

from the menu. There are some additional aspects to cameras which will be good to understand. To read about cameras, view the Camera 

component page.  

Lights 

Except for some very few cases, you will always need to add Lights to your scene. There are three different types of lights, and all of them 

behave a little differently from each other. The important thing is that they add atmosphere and ambience to your game. Different lighting 

can completely change the mood of your game, and using lights effectively will be an important subject to learn. To read about the different 

lights, please view the Light component page.  

http://unity3d.com/support/documentation/Manual/Prefabs.html
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Publishing Builds 
At any time while you are creating your game, you might want to see how it looks when you build and run it outside of the editor as a 

standalone or web player. This section will explain how to access the Build Settings and how to create different builds of your games.  

File->Build Settings... is the menu item to access the Build Settings window. It pops up an editable list of the scenes that will be included 

when you build your game.  

 

The Build Settings window 

The first time you view this window in a project, it will appear blank. If you build your game while this list is blank, only the currently open 

scene will be included in the build. If you want to quickly build a test player with only one scene file, just build a player with a blank scene 

list.  

It is easy to add scene files to the list for multi-scene builds. There are two ways to add them. The first way is to click the Add Current 

button. You will see the currently open scene appear in the list. The second way to add scene files is to drag them from the Project View to 

the list.  

At this point, notice that each of your scenes has a different index value. Scene 0 is the first scene that will be loaded when you build the 

game. When you want to load a new scene, use Application.LoadLevel() inside your scripts.  

http://unity3d.com/support/documentation/ScriptReference/Application.LoadLevel.html


If you've added more than one scene file and want to rearrange them, simply click and drag the scenes on the list above or below others 

until you have them in the desired order.  

If you want to remove a scene from the list, click to highlight the scene and press Command-Delete. The scene will disappear from the list 

and will not be included in the build.  

When you are ready to publish your build, select a Platform and make sure that the Unity logo is next to the platform; if its not then click in 

the Switch Platform button to let Unity know which platform you want to build for. Finally press the Build button. You will be able to select 

a name and location for the game using a standard Save dialog. When you click Save, Unity builds your game pronto. It's that simple. If 

you are unsure where to save your built game to, consider saving it into the projects root folder. You cannot save the build into the Assets 

folder.  

Enabling the Debug build checkbox on any standalone player will enable Profiler functionality. Additionally, the player will be built with 

debug symbols, so you can use 3rd party profiling or debugging tools.  

 

Desktop  
 

Web Player Streaming 

Streaming Web Players allow your Web Player games to begin playing as soon as Scene 0 is finished loading. If you have a game with 10 

levels, it doesn't make much sense to force the player to wait and download all assets for levels 2-10 before they can start playing level 1. 

When you publish a Streaming Web Player, the assets that must be downloaded will be sequenced in the order of the Scene file they 

appear in. As soon as all assets contained in Scene 0 are finished downloading, the Web Player will begin playing.  

Put simply, Streaming Web Players will get players playing your game faster than ever.  

The only thing you need to worry about is checking to make sure that the next level you want to load is finished streaming before you load 

it.  

Normally, in a non-streamed player, you use the following code to load a level:  

Application.LoadLevel("levelName"); 

In a Streaming Web Player, you must first check that the level is finished streaming. This is done through the 

CanStreamedLevelBeLoaded() function. This is how it works:  

var levelToLoad = 1; 

 

function LoadNewLevel () { 

 if (Application.CanStreamedLevelBeLoaded (levelToLoad)) { 

  Application.LoadLevel (levelToLoad); 

 } 
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} 

If you would like to display the level streaming progress to the player, for a loading bar or other representation, you can read the progress 

by accessing GetStreamProgressForLevel().  

Offline webplayer deployment 

If the Offline Deployment option is enabled for a webplayer then the UnityObject.js file (used to interface the player with the host page) will 

be placed alongside the player during the build. This enables the player to work with the local script file even when there is no network 

connection; normally, UnityObject.js is downloaded from Unity's webserver so as to make use of the latest version.  

Building standalone players 

With Unity you can build standalone applications for Windows and Mac (Intel, PowerPC or Universal, which runs on both architectures). It's 

simply a matter of choosing the build target in the build settings dialog, and hitting the 'Build' button. When building standalone players, the 

resulting files will vary depending on the build target. On Windows an executable file (.exe) will be built, along with a Data folder which 

contains all the resources for your application. On Mac an app bundle will be built, containing the file needed to run the application, as well 

as the resources.  

Distributing your standalone on Mac is just to provide the app bundle (everything is packed in there). On Windows you need to provide both 

the .exe file and the Data folder for others to run it. Think of it like this: Other people must have the same files on their computer, as the 

resulting files that Unity builds for you, in order to run your game.  

Inside the build process 

The building process will place a blank copy of the built game application wherever you specify. Then it will work through the scene list in 

the build settings, open them in the editor one at a time, optimize them, and integrate them into the application package. It will also 

calculate all the assets that are required by the included scenes and store that data in a separate file within the application package.  

 Any GameObject in a scene that is tagged with 'EditorOnly' will be not be included in the published build. This is useful for debugging 

scripts that don't need to be included in the final game.  

 When a new level loads, all the objects in the previous level are destroyed. To prevent this, use DontDestroyOnLoad() on any objects you 

don't want destroyed. This is most commonly used for keeping music playing while loading a level, or for game controller scripts which keep 

game state and progress.  

 After the loading of a new level is finished, the message: OnLevelWasLoaded() will be sent to all active game objects.  

 For more information on how to best create a game with multiple scenes, for instance a main menu, a high-score screen, and actual game 

levels, see the Scripting Tutorial.pdf  

 

iOS 
 

Inside the iOS build process 

The iPhone/iPad application build process is a two step process:  

1. XCode project is generated with all the required libraries, precompiled .NET code and serialized assets.  

2. XCode project is built and deployed on the actual device.  

When "Build" is hit on "Build settings" dialog only the first step is accomplished. Hitting "Build and Run" performs both steps. If in the project 

save dialog the user selects an already existing folder an alert is displayed. Currently there are two XCode project generation modes to 

select:  

 replace - all the files from target folder are removed and the new content is generated  

 append - the "Data", "Libraries" and project root folder are cleaned and filled with newly generated content. The XCode project file is 

updated according to the latest Unity project changes. XCode project "Classes" subfolder could be considered as safe place to place 

http://unity3d.com/support/documentation/ScriptReference/Application.GetStreamProgressForLevel.html
http://unity3d.com/support/documentation/ScriptReference/Object.DontDestroyOnLoad.html
http://unity3d.com/support/documentation/ScriptReference/MonoBehaviour.OnLevelWasLoaded.html
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custom native code, but making regular backups is recommended. Append mode is supported only for the existing XCode projects 

generated with the same Unity iOS version.  

If Cmd+B is hit then the automatic build and run process is invoked and the latest used folder is assumed as the build target. In this case 

append mode is assumed as default.  

 

Android 
 

The Android application build process is performed in two steps:  

1. Application package (.apk file) is generated with all the required libraries and serialized assets.  

2. Application package is deployed on the actual device.  

When "Build" is hit on "Build settings" dialog only the first step is accomplished. Hitting "Build and Run" performs both steps. If Cmd+B is hit 

then the automatic build and run process is invoked and the latest used file is assumed as the build target.  

Upon the first attempt to build an Android project, Unity would ask you to locate the Android SDK, that is required to build and install your 

Android application on the device. You can change this setting later in Preferences.  

 

When building the app to the Android, be sure that the device has the "USB Debugging" and the "Allow mock locations" checkboxes 

checked in the device settings.  
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You can ensure that the operating system sees your device by running adb devices command found in your Android 

SDK/platform-tools folder. This should work both for Mac and Windows.  

 

Unity builds an application archive (.apk file) for you and installs it on the connected device. In some cases your application cannot 

autostart like on iPhone, so you need to unlock the screen, and in some rare cases find the newly installed application in the menu.  

Texture Compression 

Under Build Settings you'll also find the Texture Compression option. By default, Unity uses ETC1/RGBA16 texture format for textures 

that don't have individual texture format overrides (see Texture 2D / Per-Platform Overrides).  

If you want to build an application archive (.apk file) targeting a specific hardware architecture, you can use the Texture Compression 

option to override this default behavior. Any texture that uses texture format overrides will be left alone; only textures set to Automatic 

Compressed will use the format selected in the Texture Compression option.  

To make sure the application is only deployed on devices which support the selected texture compression, Unity will edit the 

AndroidManifest to include tags matching the particular format selected. This will enable the Android Market filtering mechanism to only 

serve the application to devices with the appropriate graphics hardware.  

Preloading 

Published builds automatically preload all assets in a scene when the scene loads. The exception to this rule is scene 0. This is because 

the first scene is usually a splashscreen, which you want to display as quickly as possible.  

http://unity3d.com/support/documentation/Manual/android-GettingStarted.html
http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://developer.android.com/guide/topics/manifest/supports-gl-texture-element.html


To make sure all your content is preloaded, you can create an empty scene which calls Application.LoadLevel(1). In the build settings 

make this empty scene's index 0. All subsequent levels will be preloaded.  

You're ready to build games 

By now, you have learned how to use Unity's interface, how to use assets, how to create scenes, and how to publish your builds. There is 

nothing stopping you from creating the game of your dreams. You'll certainly learn much more along the way, and we're here to help.  

To learn more details about using Unity itself, you can continue reading the manual or follow the Tutorials.  

To learn more about Components, the nuts & bolts of game behaviors, please read the Component Reference.  

To learn more about Scripting, please read the Scripting Reference.  

To learn more about creating Art assets, please read the Assets section of the manual.  

To interact with the community of Unity users and developers, visit the Unity Forums. You can ask questions, share projects, build a team, 

anything you want to do. Definitely visit the forums at least once, because we want to see the amazing games that you make.  
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Tutorials 
These tutorials will let you work with Unity while you follow along. They will give you hands-on experience with building real projects. For 

new users, it is recommended that you follow the GUI Essentials and Scripting Essentials tutorials first. After that, you can follow any of 

them. They are all in PDF format, so you can print them out and follow along or read them alongside Unity.  

Note: These Tutorials are intended for use with the Desktop version of Unity, these will not work with Android or iOS devices (iPhone/iPad).  

 

Also if you are searching for other resources like presentations, articles, assets or extensions for Unity, then you can find them here.  

http://unity3d.com/support/documentation/Manual/Building%20Scenes.html
http://unity3d.com/support/documentation/Manual/Tutorials.html
http://unity3d.com/support/documentation/Components/Components.html
http://unity3d.com/support/documentation/ScriptReference/index.html
http://unity3d.com/support/documentation/Manual/Asset%20Import%20and%20Creation.html
http://forum.unity3d.com/
http://unity3d.com/support/resources/
http://unity3d.com/support/documentation/tutorials/
http://unity3d.com/support/documentation/Images/manual/GUIEssentials.pdf
http://unity3d.com/support/documentation/Images/manual/ScriptingTutorial.pdf


You can also check the latest additions about tutorials just by checking our Unity3D Tutorial's Home Page.  
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Building Scenes 
This section will explain the core elements you will work with to build scenes for complete games.  

 GameObjects  

o The GameObject-Component Relationship  

o Using Components  

o The Component-Script Relationship  

 Using the Inspector  

o Editing Value Properties  

o Assigning References  

o Inspector Options  

 Using the Scene View  

o Scene View Navigation  

o Positioning GameObjects  

o View Modes  

o Gizmos and Icons  

 Searching  

 Prefabs  

 Lights  

 Cameras  

 Particle Systems  

 Terrain Engine Guide  
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GameObjects 
GameObjects are the most important objects in Unity. It is very important to understand what a GameObject is, and how it can be used. 

This page will explain all that for you.  

What are GameObjects? 

Every object in your game is a GameObject. However, GameObjects don't do anything on their own. They need special properties before 

they can become a character, an environment, or a special effect. But every one of these objects does so many different things. If every 

object is a GameObject, how do we differentiate an interactive power-up object from a static room? What makes these GameObjects 

different from each other?  

The answer to this question is that GameObjects are containers. They are empty boxes which can hold the different pieces that make up a 

lightmapped island or a physics-driven car. So to really understand GameObjects, you have to understand these pieces; they are called 

Components. Depending on what kind of object you want to create, you will add different combinations of Components to the 

GameObject. Think of a GameObject as an empty cooking pot, and Components as different ingredients that make up your recipe of 

gameplay. You can also make your own Components using Scripts.  

You can read more about GameObjects, Components, and Script Components on the pages in this section:  

 The GameObject-Component Relationship  

http://unity3d.com/support/resources/tutorials
http://unity3d.com/support/documentation/Manual/GameObjects.html
http://unity3d.com/support/documentation/Manual/The%20GameObject-Component%20Relationship.html
http://unity3d.com/support/documentation/Manual/Using%20Components.html
http://unity3d.com/support/documentation/Manual/The%20Component-Script%20Relationship.html
http://unity3d.com/support/documentation/Manual/Using%20The%20Inspector.html
http://unity3d.com/support/documentation/Manual/Editing%20Value%20Properties.html
http://unity3d.com/support/documentation/Manual/Editing%20Reference%20Properties.html
http://unity3d.com/support/documentation/Manual/Inspector%20Options.html
http://unity3d.com/support/documentation/Manual/Using%20The%20Scene%20View.html
http://unity3d.com/support/documentation/Manual/Scene%20View%20Navigation.html
http://unity3d.com/support/documentation/Manual/Positioning%20GameObjects.html
http://unity3d.com/support/documentation/Manual/View%20Modes.html
http://unity3d.com/support/documentation/Manual/Gizmo%20and%20Icon%20Visibility.html
http://unity3d.com/support/documentation/Manual/Searching.html
http://unity3d.com/support/documentation/Manual/Prefabs.html
http://unity3d.com/support/documentation/Manual/Lights.html
http://unity3d.com/support/documentation/Manual/Cameras.html
http://unity3d.com/support/documentation/Manual/Particle%20Systems.html
http://unity3d.com/support/documentation/Manual/Terrains.html
http://unity3d.com/support/documentation/Manual/The%20GameObject-Component%20Relationship.html


 Using Components  

 The Component-Script Relationship  
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The GameObject-Component Relationship 
As described on the GameObjects page, a GameObject contains Components. We'll explore this relationship by discussing a GameObject 

and its most common Component -- the Transform Component. With any Unity Scene open, create a new GameObject (using Shift-

Control-N on Windows or Shift-Command-N on Mac), select it and take a look at the Inspector.  

 

The Inspector of an Empty GameObject 

Notice that an empty GameObject still contains a Name, a Tag, and a Layer. Every GameObject also contains a Transform Component.  

The Transform Component 

It is impossible to create a GameObject in Unity without a Transform Component. The Transform Component is one of the most important 

Components, since all of the GameObject's Transform properties are enabled by its use of this Component. It defines the GameObject's 

position, rotation, and scale in the game world/Scene View. If a GameObject did not have a Transform Component, it would be nothing 

more than some information in the computer's memory. It effectively would not exist in the world.  

The Transform Component also enables a concept called Parenting, which is utilized through the Unity Editor and is a critical part of 

working with GameObjects. If you would like to learn more about the Transform Component and Parenting, please read the Transform 

Component Reference page.  

Other Components 

The Transform Component just happens to be critical to all GameObjects, so each GameObject has one. But GameObjects can contain 

other Components as well.  

http://unity3d.com/support/documentation/Manual/Using%20Components.html
http://unity3d.com/support/documentation/Manual/The%20Component-Script%20Relationship.html
http://unity3d.com/support/documentation/Manual/GameObjects.html
http://unity3d.com/support/documentation/Components/Tags.html
http://unity3d.com/support/documentation/Components/Layers.html
http://unity3d.com/support/documentation/Components/class-Transform.html
http://unity3d.com/support/documentation/Components/class-Transform.html
http://unity3d.com/support/documentation/Components/class-Transform.html


 

The Main Camera, added to each scene by default 

Taking a look at the Main Camera GameObject, we can see that it contains a different collection of Components. Specifically, a Camera 

Component, a GUILayer, a Flare Layer, and an Audio Listener. All of these Components provide additional functionality to the GameObject. 

Without them, there would be nothing rendering the graphics of the game for the person playing! Rigidbodies, Colliders, Particles, and 

Audio are all different Components (or combinations thereof) that can be added to any given GameObject.  
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Using Components 
Components are the nuts & bolts of objects and behaviors in a game. They are the functional pieces of every GameObject. If you don't 

yet understand the relationship between Components and GameObjects, we recommend that you read the GameObjects page before 

going any further.  

A GameObject is a container for many different Components. By default, all GameObjects automatically have a Transform Component. 

This is because the Transform dictates where the GameObject is located, and how it is rotated and scaled. Without a Transform 

Component, the GameObject wouldn't have a location in the world. Try creating an empty GameObject now as an example. Click the 

GameObject->Create Empty menu item. Select the new GameObject, and look at the Inspector.  

 

Even empty GameObjects have a Transform Component  

http://unity3d.com/support/documentation/Components/class-Camera.html
http://unity3d.com/support/documentation/Components/class-Camera.html
http://unity3d.com/support/documentation/Components/class-GUILayer.html
http://unity3d.com/support/documentation/Components/class-FlareLayer.html
http://unity3d.com/support/documentation/Components/class-AudioListener.html
http://unity3d.com/support/documentation/Manual/GameObjects.html


Remember that you can always use the Inspector to see which Components are attached to the selected GameObject. As Components are 

added and removed, the Inspector will always show you which ones are currently attached. You will use the Inspector to change all the 

properties of any Component (including scripts)  

Adding Components 

You can add Components to the selected GameObject through the Components menu. We'll try this now by adding a Rigidbody to the 

empty GameObject we just created. Select it and choose Component->Physics->Rigidbody from the menu. When you do, you will see 

the Rigidbody's properties appear in the Inspector. If you press Play while the empty GameObject is still selected, you might get a little 

surprise. Try it and notice how the Rigidbody has added functionality to the otherwise empty GameObject. (The y-component of the 

GameObject starts to decrease. This is because the physics engine in Unity is causing the GameObject to fall under gravity.)  

 

An empty GameObject with a Rigidbody Component attached  

You can attach any number or combination of Components to a single GameObject. Some Components work best in combination with 

others. For example, the Rigidbody works with any Collider. The Rigidbody controls the Transform through the NVIDIA PhysX physics 

engine, and the Collider allows the Rigidbody to collide and interact with other Colliders. A different example of Component combinations is 

a Particle System. They use a Particle Emitter, Particle Animator, and Particle Renderer to create a group of moving particles.  

If you want to know more about using a particular Component, you can read about any of them in the Component Reference. You can also 

access the reference page for a Component from Unity by clicking on the small ? on the Component's header in the Inspector.  

Editing Components 

One of the great aspects of Components is flexibility. When you attach a Component to a GameObject, there are different values or 

Properties in the Component that can be adjusted in the editor while building a game, or by scripts when running the game. There are two 

main types of Properties: Values and References.  

Look at the image below. It is an empty GameObject with an Audio Source Component. All the values of the Audio Source in the 

Inspector are the default values.  

http://unity3d.com/support/documentation/Components/Components.html


 

This Component contains a single Reference property, and seven Value properties. Audio Clip is the Reference property. When this Audio 

Source begins playing, it will attempt to play the audio file that is referenced in the Audio Clip property. If no reference is made, an error 

will occur because there is no audio to be played. You must reference the file within the Inspector. This is as easy as dragging an audio file 

from the Project View onto the Reference Property or using the Object Selector.  



 

Now a sound effect file is referenced in the Audio Clip property  

Components can include references to any other type of Component, GameObjects, or Assets. You can read more about assigning 

references on the Assigning References page.  

The remaining properties on the Audio Clip are all Value properties. These can be adjusted directly in the Inspector. The Value properties 

on the Audio Clip are all toggles, numeric values, drop-down fields, but value properties can also be text strings, colors, curves, and other 

types. You can read more about these and about editing value properties on the Editing Value Properties page.  

Testing out Properties 

While your game is in Play Mode, you are free to change properties in any GameObject's Inspector. For example, you might want to 

experiment with different heights of jumping. If you create a Jump Height property in a script, you can enter Play Mode, change the value, 

and press the jump button to see what happens. Then without exiting Play Mode you can change it again and see the results within 

seconds. When you exit Play Mode, your properties will revert to their pre-Play Mode values, so you don't lose any work. This workflow 

http://unity3d.com/support/documentation/Manual/Editing%20Reference%20Properties.html
http://unity3d.com/support/documentation/Manual/Editing%20Value%20Properties.html


gives you incredible power to experiment, adjust, and refine your gameplay without investing a lot of time in iteration cycles. Try it out with 

any property in Play Mode. We think you'll be impressed.  

Removing Components 

If you want to remove a Component, option- or right-click on its header in the Inspector, and choose Remove Component. Or you can left-

click the options icon next to the ? on the Component header. All the property values will be lost and this cannot be undone, so be 

completely sure you want to remove the Component before you do.  
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The Component-Script Relationship 
When you create a script and and attach it to a GameObject, the script appears in the GameObject's Inspector just like a Component. This 

is because scripts become Components when they are saved - a script is just a specific type of Component. In technical terms, a script 

compiles as a type of Component, and is treated like any other Component by the Unity engine. So basically, a script is a Component that 

you are creating yourself. You will define its members to be exposed in the Inspector, and it will execute whatever functionality you've 

written.  

Read more about creating and using scripts on the Scripting page.  
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Using The Inspector 
The Inspector is used to view and edit Properties of many different types.  

Games in Unity are made up of multiple GameObjects that contain meshes, scripts, sounds, or other graphical elements like Lights. When 

you select a GameObject in the Hierarchy or Scene View, the Inspector will show and let you modify the Properties of that GameObject 

and all the Components and Materials on it. The same will happen if you select a Prefab in the Project View. This way you modify the 

functionality of GameObjects in your game. You can read more about the GameObject-Component relationship, as it is very important to 

understand.  

http://unity3d.com/support/documentation/Manual/Scripting.html
http://unity3d.com/support/documentation/Manual/GameObjects.html#Relationship


 

Inspector shows the properties of a GameObject and the Components and Materials on it. 

When you create a script yourself, which works as a custom Component type, the member variables of that script are also exposed as 

Properties that can be edited directly in the Inspector when that script component has been added to a GameObject. This way script 

variables can be changed without modifying the script itself.  

Furthermore, the Inspector is used for showing import options of assets such as textures, 3D models, and fonts when selected. Some 

scene and project-wide settings are also viewed in the Inspector, such as all the Settings Managers.  

Any property that is displayed in the Inspector can be directly modified. There are two main types of Properties: Values and References.  

 Editing Value Properties  

 Assigning References  

 Inspector Options  
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Editing Value Properties 
Value properties do not reference anything and they can be edited right on the spot. Typical value properties are numbers, toggles, strings, 

and selection popups, but they can also be colors, vectors, curves, and other types.  

http://unity3d.com/support/documentation/Components/comp-ManagerGroup.html
http://unity3d.com/support/documentation/Manual/Editing%20Value%20Properties.html
http://unity3d.com/support/documentation/Manual/Editing%20Reference%20Properties.html
http://unity3d.com/support/documentation/Manual/Inspector%20Options.html


 

Value properties on the inspector can be numbers, checkboxes, strings... 

Many value properties have a text field and can be adjusted simply by clicking on them, entering a value using the keyboard, and pressing 

Enter to save the value.  

 You can also put your mouse next to a numeric property, left-click and drag it to scroll values quickly  

 Some numeric properties also have a slider that can be used to visually tweak the value.  

Some Value Properties open up a small popup dialog that can be used to edit the value.  

Color Picker 

Properties of the Color type will open up the Color Picker. (On Mac OS X this color picker can be changed to the native OS color picker by 

enabling Use OS X Color Picker under Unity->Preferences.)  

The Color Picker reference in the inspector is represented by:  

 

Color Picker reference in the inspector. 

And opens the Color Picker just by clicking on it:  



 

Color Picker descriptions. 

Use the Eyedropper Tool when you want to find a value just by putting your mouse over the color you want to grab. 

RGB / HSV Selector lets you switch your values from Red, Green, Blue to Hue, Saturation and Value (Strength) of your color. 

Finally, the transparency of the Color selected can be controlled by the Alpha Channel value.  

Curve Editor 

Properties of the AnimationCurve type will open up the Curve Editor. The Curve Editor lets you edit a curve or choose from one of the 

presets. For more information on editing curves, see the guide on Editing Curves.  

The type is called AnimationCurve for legacy reasons, but it can be used to define any custom curve function. The function can then be 

evaluated at runtime from a script.  

An AnimationCurve property is shown in the inspector as a small preview:  

 

A preview of an AnimationCurve in the Inspector. 

Clicking on it opens the Curve Editor:  

http://unity3d.com/support/documentation/Components/EditingCurves.html


 

The Curve Editor is for editing AnimationCurves. 

Wrapping Mode Lets you select between Ping Pong, Clamp and Loop for they Control Keys in your curve. 

The Presets lets you modify your curve to default outlines the curves can have.  
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Editing Reference Properties 
Reference properties are properties that reference other objects such as GameObjects, Components, or Assets. The reference slot will 

show what kind of objects can be used for this reference.  



 

The Audio Clip property slot shows that it accept references to objects of type Audio Clip  



 

Now an Audio Clip file is referenced in the Audio Clip property.  

This type of referencing is very quick and powerful, especially when using scripting. To learn more about using scripts and properties, 

please view the Scripting Tutorial on the tutorials page.  

Object references can be assigned to a reference property either by drag and drop or by using the Object Picker.  

Drag and Drop 

You can use drag and drop simply by selecting the desired object in the Scene View, Hierarchy, or Project View and dragging it into the slot 

of the reference property.  

If a reference property accepts a specific Component type (for example a Transform) then dragging a GameObject or a Prefab onto the 

reference property will work fine provided that the GameObject or Prefab contains a component of the correct type. The property will then 

reference the component in question, even though it was a GameObject or Prefab you dragged onto it.  



If you drag an object onto an reference property, and the object is not of the correct type, or does not contain the right component, then you 

won't be able to assign the object to the reference property.  

The Object Picker 

You can click on the small target icon next to a reference slot to open the Object Picker.  

 

References to the Object Picker from the Editor. 

The Object Picker is a simple window for assigning objects in the inspector after allowing you to preview and search those available.  

Although the Object Picker is really easy to use, there are a few things you should be aware of. These are described below.  

 

Anatomy of the Object Picker. 

1. Search: When there are lots of objects in the picker, you can use the Search field to filter them. This search field can also search 

objects using their Labels.  

2. View Selector: Switches the base of the search between objects in the scene and assets.  

3. Preview Size: This horizontal scroll bar lets you increase/decrease the size of your preview objects in the preview window. With 

this you can see more or fewer objects in the preview window at any moment.  

4. Preview Window: Here are all the objects that reside in your Scene/Assets folder filtered by the Search field.  

http://unity3d.com/support/documentation/Manual/Asset%20Workflow.html#AssetLabels


5. Object Info: Displays information about the currently selected object. The content of this field depends on the type of object being 

viewed, so if for example you pick a mesh, it will tell you the number of vertices and triangles, and whether or not it has UV's and 

is skinned. However, if you pick an audio file it will give you information such as the bit rate of the audio, the length, etc.  

6. Object Preview: This also depends on the type of object you are viewing. If you select a mesh, it will display you how the mesh 

looks, but if you select a script file, it will just display an icon of the file.  

The Object Picker works on any asset you have in your project, which can be a video, a song, a terrain, a GUI skin, a scripting file, or a 

mesh; it is a tool you will use often.  

Hints 

 Use Labels on your Assets and you will be able to find them more easily by searching for them using the search field of the Object Picker  

 If you dont want to see the descriptions of the objects you can move the slider in the bottom middle of the preview window downward.  

 If you want to see a detailed preview of the object, you can enlarge the object preview by dragging the slider in the bottom middle of the 

preview window.  
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Inspector Options 
The Inspector Lock and the Inspector Debug Mode are two useful options that can help you in your workflow.  

Lock 

The Lock lets you maintain focus on a specific GameObject in the Inspector while selecting other GameObjects. To toggle the lock of an 

Inspector click on the lock/unlock ( ) icon above the Inspector or open the tab menu and select Lock.  

 

Locking the Inspector from the tab menu. 

Note that you can have more than one Inspector open, and that you can for example lock one of them to a specific GameObject while 

keeping the other one unlocked to show whichever GameObject is selected.  

Debug 

The Debug Mode lets you inspect private variables of components in the Inspector, which are normally not shown. To change to Debug 

Mode, open the tab menu and select Debug.  

In Debug Mode, all components are shown using a default interface, rather than the custom interfaces that some components use in the 

Normal Mode. For example, the Transform component will in Debug Mode show the raw Quaternion values of the rotation rather than the 

Euler angles shown in the Normal Mode. You can also use the Debug Mode to inspect the values of private variables in your own script 

components.  

http://unity3d.com/support/documentation/Manual/Asset%20Workflow.html#AssetLabels


 

Debug Mode in the Inspector lets you inspect private variables in your scripts and in other components. 

The Debug mode is per Inspector and you can have one Inspector in Debug Mode while another one is not.  
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Using The Scene View 
The Scene View is your interactive sandbox. You will use the Scene View to select and position environments, the player, the camera, 

enemies, and all other GameObjects. Maneuvering and manipulating objects within the Scene View are some of the most important 

functions in Unity, so it's important to be able to do them quickly.  

 Scene View Navigation  

 Positioning GameObjects  

 View Modes  

 Gizmos and Icons  
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Scene View Navigation 
Navigate the Scene View quickly and efficiently with the Scene View controls.  

Arrow Movement 

Use Arrow Keys to move around the scene. Holding down Shift will make you move faster.  

Focusing 

Select any GameObject and press the F key. This will center the Scene View and pivot point on the selection. This is also known as Frame 

Selection.  

Orbit, Move, and Zoom 

Orbiting, moving, and zooming is at the core of the Scene View navigation. In order to to ensure that it's easy and accessible regardless of 

the setup you're using, there's a few different ways to do it.  

http://unity3d.com/support/documentation/Manual/Scene%20View%20Navigation.html
http://unity3d.com/support/documentation/Manual/Positioning%20GameObjects.html
http://unity3d.com/support/documentation/Manual/View%20Modes.html
http://unity3d.com/support/documentation/Manual/Gizmo%20and%20Icon%20Visibility.html


These controls can be used regardless of which tool is selected. Holding down Shift will make you move and zoom faster.  

With a Three Button Mouse 

 Orbit: Hold Alt and click-drag to orbit the camera around the current pivot point.  

 Move: Hold Alt and middle click-drag to drag the camera around.  

 Zoom: Hold Alt and right click-drag to zoom the camera.  

With No Middle Mouse Button 

 Orbit: Hold Alt and click-drag to orbit the camera around the current pivot point.  

 Move: Hold Alt-Control (Alt-Command on Mac) and click-drag to drag the camera around.  

 Zoom: Hold Alt and right click-drag to zoom the camera.  

Using a One-Button Mouse 

 Orbit: Hold Alt and click-drag to orbit the camera around the current pivot point.  

 Move: Hold Alt-Command and click-drag to drag the camera around.  

 Zoom: Hold Alt-Control and click-drag to zoom the camera.  

Using the Hand Tool 

You might also find use in the Hand Tool (shortcut: Q), especially if you are using a one-button mouse. With the Hand tool is selected,  

Click-drag to drag the camera around.  

Hold Alt and click-drag to orbit the camera around the current pivot point.  

Hold Control (Command on Mac) and click-drag to zoom the camera. 

Zooming with the Mouse Wheel 

You can always zoom the camera by scrolling using a mouse wheel or a track-pad.  

Flythrough Mode  

The Flythrough mode lets you navigate the Scene View by flying around in first person similar to how you would navigate in many games.  

 Click and hold the right mouse button.  

 Now you can move the view around using the mouse and use the WASD keys to move left/right forward/backward and the Q and E keys to 

move up and down.  

 Holding down Shift will make you move faster.  

Scene Gizmo 

In the upper-right corner of the Scene View is the Scene Gizmo. This displays the Scene View Camera's current orientation, and allows 

you to quickly modify the viewing angle.  

 

You can click on any of the arms to snap the Scene View Camera to that direction and change it to Isometric Mode. While in Isometric 

Mode, you can right-click drag to orbit, and Alt-click drag to pan. To exit this mode, click the middle of the Scene Gizmo. You can also Shift-

click the middle of the Scene Gizmo any time to toggle Isometric Mode.  



 

Perspective mode. 

 

Isometric mode. Objects do not get smaller with distance here! 
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Positioning GameObjects 
When building your games, you'll place lots of different objects in your game world.  

Focusing 

It can be useful to focus the Scene View Camera on an object before manipulating it. Select any GameObject and press the F key. This will 

center the Scene View and pivot point on the selection. This is also known as Frame Selection.  



Translate, Rotate, and Scale 

Use the Transform Tools in the Toolbar to Translate, Rotate, and Scale individual GameObjects. Each has a corresponding Gizmo that 

appears around the selected GameObject in the Scene View. You can use the mouse and manipulate any Gizmo axis to alter the 

Transform Component of the GameObject, or you can type values directly into the number fields of the Transform Component in the 

Inspector.  

 

 Click and drag in the center of the Gizmo to manipulate the object on all axes at once.  

 If you have a three button mouse, you can click the middle button to adjust the last-adjusted axis (which turns yellow) without clicking 

directly on it.  

 Be careful when using the scaling tool, as non-uniform scales (e.g. 1,2,1) can cause unusual scaling of child objects.  

 For more information on transforming GameObjects, please view the Transform Component page.  

Gizmo Display Toggles 

The Gizmo Display Toggles are used to define the location of any Transform Gizmo.  

 

Gizmo Display Toggles 

 Position:  

o Center will position the Gizmo at the center of the object's rendered bounds.  

o Pivot will position the Gizmo at the actual pivot point of a Mesh.  

 Rotation:  

o Local will keep the Gizmo's rotation relative to the object's.  

o Global will clamp the Gizmo to world space orientation.  

Unit Snapping 

While dragging any Gizmo Axis using the Translate Tool, you can hold the Control key (Command on Mac) to snap to increments defined 

in the Snap Settings.  

You can change the unit distance that is used for the unit snapping using the menu Edit->Snap Settings...  

 

Scene View Unit Snapping settings. 

Surface Snapping 

http://unity3d.com/support/documentation/Components/class-Transform.html


While dragging in the center using the Translate Tool, you can hold Shift and Control (Command on Mac) to snap the object to the 

intersection of any Collider. This makes precise positioning of objects incredibly fast.  

Look-At Rotation 

While using the Rotate Tool, you can hold Shift and Control (Command on Mac) to rotate the object towards a point on the surface of any 

Collider. This makes orientation of objects relative to one another simple.  

Vertex Snapping 

You can assemble your worlds more easily with a feature called Vertex Snapping. This feature is a really simple but powerful tool in Unity. 

It lets you take any vertex from a given mesh and with your mouse place that vertex in the same position as any vertex from any other 

mesh you choose.  

With this you can assemble your worlds really fast. For example, you can place roads in a racing game with high precision and add power 

up items on the vertices of a mesh.  

 

Assembling roads with Vertex Snapping. 

Using vertex snapping in Unity is simple. Just follow these steps:  

 Select the mesh you want to manipulate and make sure the Transform Tool is active.  

 Press and hold the V key to activate the vertex snapping mode.  

 Move your cursor over the vertex on your mesh that you want to use as the pivot point.  

 Hold down the left button once your cursor is over the desired vertex and drag your mesh next to any other vertex on another mesh.  

 Release your mouse button and the V key when you are happy with the results.  

 Shift-V acts as a toggle of this functionality.  

 You can snap vertex to vertex, vertex to surface and pivot to vertex.  

A video on how to use vertex snapping can be found here.  
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View Modes 
The Scene View control bar lets you see the scene in various view modes - Textured, Wireframe, RGB, Overdraw, and many others. It will 

also enable you to see (and hear) in-game lighting, game elements, and sound in the Scene View.  

http://vimeo.com/10945727


 

Draw Mode 

The first drop-down is for choosing a Draw Mode. You can choose to view the entire scene Textured, Wireframe, Tex - Wire, Render 

Paths, or Lightmap Resolution. This has no effect on your game when it is published.  

 

Draw Mode drop-down  

 Textured shows surfaces with their textures on, like in the game.  

 Wireframe shows the wireframes of the meshes in the scene.  

 Tex - Wire shows wireframes on top of the textures.  

 Render Paths shows which rendering paths objects are using. Green: deferred lighting, yellow: forward, red: vertex lit.  

 Lightmap Resolution shows a checkered grid overlaid on the scene that corresponds to the resolution of the lightmaps, to make it easier to 

see if they have the right resolution.  

Render Mode 

The next drop-down is for choosing one of four Render Modes. You can choose to fill the Scene View with RGB, Alpha, Overdraw, or 

Mipmaps. Again, this will not affect your published game.  

 

Render Mode drop-down  

 RGB is simply all the colors of your game rendered as normal.  

 Alpha will render all alpha values for fine-tuning transparency or fullscreen effects that make use of alpha values.  

 Overdraw will indicate how much of the screen is consuming overdraw time.  

 Mipmaps shows ideal texture sizes -- red means the particular texture is larger than necessary (at the current distance and resolution), 

while blue means the texture could be larger. Of course ideal texture sizes depend on the resolution the game will run at, and how close the 

camera can get to the respective surfaces.  

Scene Lighting, Game Overlay, and Audition Mode 

Next, we have three buttons: Scene Lighting, Game Overlay, and Audition Mode.  

 

 Enabling Scene Lighting will override the default Scene View lighting with whatever lights you have positioned to create your final light 

setup.  

 Enabling Game Overlay will show items like Skyboxes and GUI Elements in the Scene View, and it will also hide the grid.  

 Enabling Audition Mode will make AudioSources in the scene play so they can be heard without going into Play Mode.  
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Gizmo and Icon Visibility 

The Icon Selector 

Using the Icon Selector you can easily set custom icons for GameObjects and scripts that will be used both in the Scene View and the 

Inspector. To change icons for a GameObject simply click on its icon in the Inspector. This works similar with script assets, where you can 

also click on its icon in the Inspector. In the Icon Selector is a special kind of icon called a Label Icon. This type of icon will show up in the 

Scene View as a text label using the name of the GameObject. Icons for built-in Components cannot be changed.  

Note: When modifying a the icon the asset will be marked as modified and therefore picked up as a modified asset by Revision Control Systems. 

 

Selecting an icon for a GameObject  

 

Selecting an icon for a script  

Showing and Hiding Icons and Gizmos 

With the Gizmos dropdown it is possible to toggle which gizmos and icons should be visible per Component type. As increasingly more 

gizmos and icons are added in the Scene View a way is needed to filter out the increasing cluttering of gizmos and icons when working on 

a specific area.  

To show the the current gizmo and icon state click on Gizmos in the control bar of the Scene or Game View. The toggles here are used to 

set which icons and gizmos are be visible.  

Note that the scripts that show up in the section Scripts are the scripts that either have a custom icon or have OnDrawGizmos () or 

OnDrawGizmosSelected () implemented.  



 

The Gizmos dropdown, displaying the visibility state of icons and gizmos  

Component Expanded State 

While icon visibility is controlled exclusively from the Gizmos dropdown, the gizmo visibility state is also tied to whether a Component is 

expanded in the Inspector or not. They are one and the same - checking or unchecking the checkbox for a gizmo in the Gizmos dropdown 

will also expand or collapse its corresponding Somponent in the Inspector, and vice versa. So one way to toggle a gizmo is to collapse or 

expand its corresponding Component in the Inspector. Note that the state exists regardless of whether an Inspector is currently shown or 

not, and it can always be seen in the Gizmos dropdown.  

Icon Scaling 

With the Icon Scaling slider the icon world size can be adjusted. When icons are set to have a world size, they are shown larger the closer 

they are, up to a maximum screen size. The further the slider is to the right, the bigger the world size is. When it is all the way to the right, 

all icons have their maximum screen size and when it is all the way to the left all icons are entirely hidden.  
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Searching 
When working with large complex scenes it can be useful to search for specific objects. By using the Search feature in Unity, you can filter 

out only the object or group of objects that you want to see. You can search assets by their name, by Component type, and in some cases 

by asset Labels. You can specify the search mode by choosing from the Search drop-down menu.  

Scene Search 

When a scene is loaded in the Editor, you can see the objects in both the Scene View and the Hierarchy. The specific assets are shared in 

both places, so if you type in a search term (e.g. "bridge"), you'll see the the filter applied both visually in the Scene View and a more typical 

manner in the Hierarchy. There is also no difference between typing the search term into the search field in the Scene View or the Hierachy 

-- the filter takes effect in both views in either case.  

http://unity3d.com/support/documentation/Manual/Asset%20Workflow.html#AssetLabels


 

Scene View and Hierarchy with no search applied. 

 

Scene View and Hierarchy with active filtering of search term. 

When a search term filter is active, the Hierarchy doesn't show hierarchical relationships between GameObjects, but you can select any 

GameObject, and it's hierarchical path in the scene will be shown at the bottom of the Hierarchy.  

 

Click on a GameObject in the filtered list to see its hierarchical path.  

When you want to clear the search filter, just click the small cross in the search field.  



In the Scene search you can search either by Name or by Type. Click on the small magnifying glass in the search field to open the search 

drop-down menu and choose the search mode.  

 

Search by Name, Type, or All.  

Project Search 

The same fundamentals apply to searching of assets in the Project View -- just type in your search term and you'll see all the relevant 

assets appear in the filter.  

In the Project search you can search by Name or by Type as in the Scene search, and additionally you can search by Label. Click on the 

small magnifying glass in the search field to open the search drop-down menu and choose the search mode.  

 

Search by Name, Type, Label, or All.  

Object Picker Seach 

When assigning an object via the Object Picker, you can also type in any search term search to filter down to only the objects you want to 

see.  
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Prefabs 
A Prefab is a type of asset -- a reusable GameObject stored in Project View. Prefabs can be inserted into any number of scenes, multiple 

times per scene. When you add a Prefab to a scene, you create an instance of it. All Prefab instances are linked to the original Prefab and 

are essentially clones of it. No matter how many instances exist in your project, when you make any changes to the Prefab you will see the 

change applied to all instances.  

Creating Prefabs 

In order to create a Prefab, you must make a new blank Prefab using the menu. This blank Prefab contains no GameObjects, and you 

cannot create an instance of it. Think of a new Prefab as an empty container, waiting to be filled with GameObject data.  

http://unity3d.com/support/documentation/Manual/Editing%20Reference%20Properties.html#ObjectPicker


 

A new, empty Prefab. It cannot be instanced until you fill it with a GameObject.  

To fill the Prefab, you use a GameObject that you've created in the scene.  

1. Choose Assets->Create->Prefab from the menu bar and name your new Prefab.  

2. In Hierarchy View, select the GameObject you wish to make into a Prefab.  

3. Drag & drop the GameObject from the Hierarchy onto the new Prefab in Project View.  

After you have performed these steps, the GameObject and all its children have been copied into the Prefab data. The Prefab can now be 

re-used in multiple instances. The original GameObject in the Hierarchy has now become an instance of the Prefab.  

Prefab Instances 

To create a Prefab instance in the current scene, drag the Prefab from the Project View into the Scene or Hierarchy View. This instance is 

linked to the Prefab, as displayed by the blue text used for their name in the Hierarchy View.  

 

Three of these GameObjects are linked to Prefabs. One of them is not.  

 If you have selected a Prefab instance, and want to make a change that affects all instances, you can click the Select button in the 

Inspector to select the source Prefab.  

 Information about instantiating prefabs from scripts is in the Instantiating Prefabs page.  

Inheritance 

Inheritance means that whenever the source Prefab changes, those changes are applied to all linked GameObjects. For example, if you 

add a new script to a Prefab, all of the linked GameObjects will instantly contain the script as well. However, it is possible to change the 

properties of a single instance while keeping the link intact. Simply change any property of a prefab instance, and watch as the variable 

name becomes bold. The variable is now overridden. All overridden properties will not be affected by changes in the source Prefab.  

This allows you to modify Prefab instances to make them unique from their source Prefabs without breaking the Prefab link.  

http://unity3d.com/support/documentation/Manual/Instantiating%20Prefabs.html


 

A linked GameObject with no overrides enabled. 

 

A linked GameObject with several (bold) overrides enabled. 

 If you want to update the source Prefab and all instances with the new overridden values, you can click the Apply button in the Inspector.  

 If you want to discard all overrides on a particular instance, you can click the Revert button.  

Breaking and Restoring Prefab Links 

There are certain actions which will break the link between a single instance and its source prefab, but the link can always be restored. 

Actions that will break the link:  

 Adding or removing a Component  

 Adding or removing a child GameObject  



These actions will prompt a warning/confirmation message about breaking the link. Confirming the action will break the link so changes to 

the source Prefab will no longer affect the broken instance. To restore the link, you can click either the Reconnect or Apply buttons in the 

Inspector of the instance.  

 Reconnect will discard all differences from the source Prefab.  

 Apply will copy all differences into the source Prefab (and therefore, all other Prefab instances)  

Imported Prefabs 

When you place a mesh asset into your Assets folder, Unity automatically imports the file and generates something that looks similar to a 

Prefab out of the mesh. This is not actually a Prefab, it is simply the asset file itself. Instancing and working with assets introduces some 

limitations that are not present when working with normal Prefabs.  

 

Notice the asset icon is a bit different from the Prefab icons 

The asset is instantiated in the scene as a GameObject, linked to the source asset instead of a normal Prefab. Components can be added 

and removed from this GameObject as normal. However, you cannot apply any changes to the asset itself since this would add data to the 

asset file itself! If you're creating something you want to re-use, you should make the asset instance into a Prefab following the steps listed 

above under "Creating Prefabs".  

 When you have selected an instance of an asset, the Apply button in the Inspector is replaced with an Edit button. Clicking this button will 

launch the editing application for your asset (e.g. Maya or Max).  
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Lights 
Lights are an essential part of every scene. While meshes and textures define the shape and look of a scene, lights define the color and 

mood of your 3D environment. You'll likely work with more than one light in each scene. Making them work together requires a little practice 

but the results can be quite amazing.  



 

A simple, two-light setup  

Lights can be added to your scene from the GameObject->Create Other menu. There are three types of lights which we'll discuss in a 

moment. Once a light has been added, you can manipulate it like any other GameObject. Additionally, you can add a Light Component to 

any selected GameObject by using Component->Rendering->Light.  

There are many different options within the Light Component in the Inspector.  

 

Light Component properties in the Inspector  

By simply changing the Color of a light, you can give a whole different mood to the scene.  



 

Bright, sunny lights  

 

Dark, medieval lights  



 

Spooky night lights  

The lights you create this way are realtime lights - their lighting is calculated each frame while the game is running. If you know the light will 

not change, you can make your game faster and look much better by using Lightmapping.  

Rendering paths 

Unity supports different Rendering Paths, these paths affect mainly Lights and Shadows, so choosing the correct rendering path depending 

on your game requirements can improve your project's performance. For more info about rendering paths you can visit the Rendering paths 

section.  

More information 

For more information about using Lights, check the Lights page in the Reference Manual.  
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Cameras 
Just as cameras are used in films to display the story to the audience, Cameras in Unity are used to display the game world to the player. 

You will always have at least one camera in a scene, but you can have more than one. Multiple cameras can give you a two-player 

splitscreen or create advanced custom effects. You can animate cameras, or control them with physics. Practically anything you can 

imagine is possible with cameras, and you can use typical or unique cameras to fit your game's style.  

The remaining text is from the Camera Component reference page.  

Camera 
Cameras are the devices that capture and display the world to the player. By customizing and manipulating cameras, you can make the 

presentation of your game truly unique. You can have an unlimited number of cameras in a scene. They can be set to render in any order, 

at any place on the screen, or only certain parts of the screen.  

http://unity3d.com/support/documentation/Manual/Lightmapping.html
http://unity3d.com/support/documentation/Manual/RenderingPaths.html
http://unity3d.com/support/documentation/Manual/RenderingPaths.html
http://unity3d.com/support/documentation/Components/class-Light.html
http://unity3d.com/support/documentation/Components/index.html
http://unity3d.com/support/documentation/Components/class-Camera.html


 

Unity's flexible Camera object 

Properties 

  

Clear Flags Determines which parts of the screen will be cleared. This is handy when using multiple Cameras to draw 

different game elements. 

Background Color applied to the remaining screen after all elements in view have been drawn and there is no skybox. 

Culling Mask Include or omit layers of objects to be rendered by the Camera. Assign layers to your objects in the Inspector. 

Projection Toggles the camera's capability to simulate perspective. 

Perspective Camera will render objects with perspective intact. 

Orthographic Camera will render objects uniformly, with no sense of perspective. 

Size (when Orthographic is 

selected) 

The viewport size of the Camera when set to Orthographic. 

Field of view Width of the Camera's view angle, measured in degrees along the local Y axis. 

Clipping Planes Distances from the camera to start and stop rendering. 

Near The closest point relative to the camera that drawing will occur. 

Far The furthest point relative to the camera that drawing will occur. 

Normalized View Port 

Rect 

Four values that indicate where on the screen this camera view will be drawn, in Screen Coordinates (values 0-

1). 

X The beginning horizontal position that the camera view will be drawn. 

Y The beginning vertical position that the camera view will be drawn. 

W (Width) Width of the camera output on the screen. 

H (Height) Height of the camera output on the screen. 

Depth The camera's position in the draw order. Cameras with a larger value will be drawn on top of cameras with a 

smaller value. 

Rendering Path Options for defining what rendering methods will be used by the camera. 

Use Player Settings This camera will use whichever Rendering Path is set in the Player Settings. 

Vertex Lit All objects rendered by this camera will be rendered as Vertex-Lit objects. 

Forward All objects will be rendered with one pass per material, as was standard in Unity 2.x. 

Deferred Lighting (Unity 

Pro only) 

All objects will be drawn once without lighting, then lighting of all objects will be rendered together at the end of 

the render queue. 

Target Texture (Unity 

Pro/Advanced only) 

Reference to a Render Texture that will contain the output of the Camera view. Making this reference will 

disable this Camera's capability to render to the screen. 

Details 

Cameras are essential for displaying your game to the player. They can be customized, scripted, or parented to achieve just about any kind 

of effect imaginable. For a puzzle game, you might keep the Camera static for a full view of the puzzle. For a first-person shooter, you 

would parent the Camera to the player character, and place it at the character's eye level. For a racing game, you'd likely want to have the 

Camera follow your player's vehicle.  

http://unity3d.com/support/documentation/Components/class-RenderTexture.html


You can create multiple Cameras and assign each one to a different Depth. Cameras are drawn from low Depth to high Depth. In other 

words, a Camera with a Depth of 2 will be drawn on top of a Camera with a depth of 1. You can adjust the values of the Normalized View 

Port Rectangle property to resize and position the Camera's view onscreen. This can create multiple mini-views like missile cams, map 

views, rear-view mirrors, etc.  

Render Path 

Unity supports different Rendering Paths. You should choose which one you use depending on your game content and target platform / 

hardware. Different rendering paths have different features and performance characteristics that mostly affect Lights and Shadows. 

The rendering Path used by your project is chosen in Player Settings. Additionally, you can override it for each Camera.  

For more info on rendering paths, check the rendering paths page.  

Clear Flags 

Each Camera stores color and depth information when it renders its view. The portions of the screen that are not drawn in are empty, and 

will display the skybox by default. When you are using multiple Cameras, each one stores its own color and depth information in buffers, 

accumulating more data as each Camera renders. As any particular Camera in your scene renders its view, you can set the Clear Flags to 

clear different collections of the buffer information. This is done by choosing one of the four options:  

Skybox 
This is the default setting. Any empty portions of the screen will display the current Camera's skybox. If the current Camera has no skybox 

set, it will default to the skybox chosen in the Render Settings (found in Edit->Render Settings). It will then fall back to the Background 

Color. Alternatively a Skybox component can be added to the camera. If you want to create a new Skybox, you can use this guide.  

Solid Color 
Any empty portions of the screen will display the current Camera's Background Color.  

Depth Only 
If you wanted to draw a player's gun without letting it get clipped inside the environment, you would set one Camera at Depth 0 to draw the 

environment, and another Camera at Depth 1 to draw the weapon alone. The weapon Camera's Clear Flags should be set to to depth 

only. This will keep the graphical display of the environment on the screen, but discard all information about where each object exists in 3-

D space. When the gun is drawn, the opaque parts will completely cover anything drawn, regardless of how close the gun is to the wall.  

 

The gun is drawn last, after clearing the depth buffer of the cameras before it 

Don't Clear 

http://unity3d.com/support/documentation/Manual/RenderingPaths.html
http://unity3d.com/support/documentation/Components/class-RenderSettings.html
http://unity3d.com/support/documentation/Components/class-Skybox.html
http://unity3d.com/support/documentation/Manual/HOWTO-UseSkybox.html


This mode does not clear either the color or the depth buffer. The result is that each frame is drawn over the next, resulting in a smear-

looking effect. This isn't typically used in games, and would likely be best used with a custom shader.  

Clip Planes 

The Near and Far Clip Plane properties determine where the Camera's view begins and ends. The planes are laid out perpendicular to the 

Camera's direction and are measured from the its position. The Near plane is the closest location that will be rendered, and the Far plane 

is the furthest.  

The clipping planes also determine how depth buffer precision is distributed over the scene. In general, to get better precision you should 

move the Near plane as far as possible.  

Note that the near and far clip planes together with the planes defined by the field of view of the camera describe what is popularly known 

as the camera frustum. Unity ensures that when rendering your objects those which are completely outside of this frustum are not 

displayed. This is called Frustum Culling. Frustum Culling happens irrespective of whether you use Occlusion Culling in your game.  

For performance reasons, you might want to cull small objects earlier. For example, small rocks and debris could be made invisible at much 

smaller distance than large buildings. To do that, put small objects into a separate layer and setup per-layer cull distances using 

Camera.layerCullDistances script function.  

Culling Mask 

The Culling Mask is used for selectively rendering groups of objects using Layers. More information on using layers can be found here.  

Commonly, it is good practice to put your User Interface on a different layer, then render it by itself with a separate Camera set to render 

the UI layer by itself.  

In order for the UI to display on top of the other Camera views, you'll also need to set the Clear Flags to Depth only and make sure that 

the UI Camera's Depth is higher than the other Cameras.  

Normalized Viewport Rectangle 

Normalized Viewport Rectangles are specifically for defining a certain portion of the screen that the current camera view will be drawn 

upon. You can put a map view in the lower-right hand corner of the screen, or a missile-tip view in the upper-left corner. With a bit of design 

work, you can use Viewport Rectangle to create some unique behaviors.  

It's easy to create a two-player split screen effect using Normalized Viewport Rectangle. After you have created your two cameras, 

change both camera H value to be 0.5 then set player one's Y value to 0.5, and player two's Y value to 0. This will make player one's 

camera display from halfway up the screen to the top, and player two's camera will start at the bottom and stop halfway up the screen.  

http://unity3d.com/support/documentation/Components/Layers.html
http://unity3d.com/support/documentation/ScriptReference/Camera-layerCullDistances.html
http://unity3d.com/support/documentation/Components/Layers.html


 

Two-player display created with Normalized Viewport Rectangle 

Orthographic 

Marking a Camera as Orthographic removes all perspective from the Camera's view. This is mostly useful for making isometric or 2D 

games.  

Note that fog is rendered uniformly in orthographic camera mode and may therefore not appear as expected. Read more about why in the 

component reference on Render Settings.  

 

Perspective camera. 

http://unity3d.com/support/documentation/ScriptReference/class-RenderSettings.html


 

Orthographic camera. Objects do not get smaller with distance here! 

Render Texture  

This feature is only available for Unity Advanced licenses . It will place the camera's view onto a Texture that can then be applied to another 

object. This makes it easy to create sports arena video monitors, surveillance cameras, reflections etc.  

 

A Render Texture used to create a live arena-cam 

Hints 

 Cameras can be instantiated, parented, and scripted just like any other GameObject.  

 To increase the sense of speed in a racing game, use a high Field of View.  

 Cameras can be used in physics simulation if you add a Rigidbody Component.  

 There is no limit to the number of Cameras you can have in your scenes.  

 Orthographic cameras are great for making 3D user interfaces  

 If you are experiencing depth artifacts (surfaces close to each other flickering), try setting Near Plane to as large as possible.  

 Cameras cannot render to the Game Screen and a Render Texture at the same time, only one or the other.  

http://unity3d.com/support/documentation/Components/class-RenderTexture.html


 Pro license holders have the option of rendering a Camera's view to a texture, called Render-to-Texture, for even more unique effects.  

 Unity comes with pre-installed Camera scripts, found in Components->Camera Control. Experiment with them to get a taste of what's 

possible.  
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Particle Systems 
Particles are essentially 2D images rendered in 3D space. They are primarily used for effects such as smoke, fire, water droplets, or 

leaves. A Particle System is made up of three separate Components: Particle Emitter, Particle Animator, and a Particle Renderer. You 

can use a Particle Emitter and Renderer together if you want static particles. The Particle Animator will move particles in different directions 

and change colors. You also have access to each individual particle in a particle system via scripting, so you can create your own unique 

behaviors that way if you choose.  

Please view the Particle Scripting Reference here.  

The remainder of this page's text is from the Particle Component Reference pages.  

Particle Components 

Particle Systems 

Particle Systems in Unity are used to make clouds of smoke, steam, fire and other atmospheric effects. Particle Systems work by using 

one or two Textures & drawing them many times, creating a chaotic effect.  

 

A Particle System included in the Standard Assets 

A typical Particle System in Unity is an object that contains a Particle Emitter, a Particle Animator and a Particle Renderer. The Particle 

Emitter generates the particles, the Particle Animator moves them over time, and the Particle Renderer draws them on the screen.  

If you want your particles to interact with the world, add a Particle Collider Component to the GameObject.  

http://unity3d.com/support/documentation/ScriptReference/ParticleEmitter.html
http://unity3d.com/support/documentation/Components/comp-ParticlesGroup.html
http://unity3d.com/support/documentation/Components/class-EllipsoidParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-EllipsoidParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-ParticleAnimator.html
http://unity3d.com/support/documentation/Components/class-ParticleRenderer.html
http://unity3d.com/support/documentation/Components/class-WorldParticleCollider.html


Ellipsoid Particle Emitter 
The Ellipsoid Particle Emitter spawns particles inside a sphere. Use the Ellipsoid property below to scale & stretch the sphere.  

 

The Ellipsoid Particle Emitter Inspector 

Properties 

  
Emit If enabled, the emitter will emit particles. 

Min Size The minimum size each particle can be at the time when it is spawned. 

Max Size The maximum size each particle can be at the time when it is spawned. 

Min Energy The minimum lifetime of each particle, measured in seconds. 

Max Energy The maximum lifetime of each particle, measured in seconds. 

Min Emission The minimum number of particles that will be spawned every second. 

Max Emission The maximum number of particles that will be spawned every second. 

World Velocity The starting speed of particles in world space, along X, Y, and Z. 

Local Velocity The starting speed of particles along X, Y, and Z, measured in the object's orientation. 

Rnd Velocity A random speed along X, Y, and Z that is added to the velocity. 

Emitter Velocity Scale The amount of the emitter's speed that the particles inherit. 

Tangent Velocity The starting speed of particles along X, Y, and Z, across the Emitter's surface. 

Simulate In World Space If enabled, the particles don't move when the emitter moves. If false, when you move the emitter, the particles 

follow it around. 

One Shot If enabled, the particle numbers specified by min & max emission is spawned all at once. If disabled, the 

particles are generated in a long stream. 

Ellipsoid Scale of the sphere along X, Y, and Z that the particles are spawned inside. 

MinEmitterRange Determines an empty area in the center of the sphere - use this to make particles appear on the edge of the 

sphere. 

Details 

Ellipsoid Particle Emitters (EPEs) are the basic emitter, and are included when you choose to add a Particle System to your scene from 

Components->Particles->Particle System. You can define the boundaries for the particles to be spawned, and give the particles an initial 

velocity. From here, use the Particle Animator to manipulate how your particles will change over time to achieve interesting effects.  

Particle Emitters work in conjunction with Particle Animators and Particle Renderers to create, manipulate, and display Particle Systems. All 

three Components must be present on an object before the particles will behave correctly. When particles are being emitted, all different 

velocities are added together to create the final velocity.  

Spawning Properties 

Spawning properties like Size, Energy, Emission, and Velocity will give your particle system distinct personality when trying to achieve 

different effects. Having a small Size could simulate fireflies or stars in the sky. A large Size could simulate dust clouds in a musky old 

building.  

http://unity3d.com/support/documentation/Components/class-ParticleAnimator.html
http://unity3d.com/support/documentation/Components/class-ParticleAnimator.html
http://unity3d.com/support/documentation/Components/class-ParticleRenderer.html


Energy and Emission will control how long your particles remain onscreen and how many particles can appear at any one time. For 

example, a rocket might have high Emission to simulate density of smoke, and high Energy to simulate the slow dispersion of smoke into 

the air.  

Velocity will control how your particles move. You might want to change your Velocity in scripting to achieve interesting effects, or if you 

want to simulate a constant effect like wind, set your X and Z Velocity to make your particles blow away.  

Simulate in World Space 

If this is disabled, the position of each individual particle will always translate relative to the Position of the emitter. When the emitter 

moves, the particles will move along with it. If you have Simulate in World Space enabled, particles will not be affected by the translation 

of the emitter. For example, if you have a fireball that is spurting flames that rise, the flames will be spawned and float up in space as the 

fireball gets further away. If Simulate in World Space is disabled, those same flames will move across the screen along with the fireball.  

Emitter Velocity Scale 

This property will only apply if Simulate in World Space is enabled.  

If this property is set to 1, the particles will inherit the exact translation of the emitter at the time they are spawned. If it is set to 2, the 

particles will inherit double the emitter's translation when they are spawned. 3 is triple the translation, etc.  

One Shot 

One Shot emitters will create all particles within the Emission property all at once, and cease to emit particles over time. Here are some 

examples of different particle system uses with One Shot Enabled or Disabled:  

Enabled:  

 Explosion  

 Water splash  

 Magic spell  

Disabled:  

 Gun barrel smoke  

 Wind effect  

 Waterfall  

Min Emitter Range 

The Min Emitter Range determines the depth within the ellipsoid that particles can be spawned. Setting it to 0 will allow particles to spawn 

anywhere from the center core of the ellipsoid to the outer-most range. Setting it to 1 will restrict spawn locations to the outer-most range of 

the ellipsoid.  



 

Min Emitter Range of 0 

 

Min Emitter Range of 1 

Hints 

 Be careful of using many large particles. This can seriously hinder performance on low-level machines. Always try to use the minimum 

number of particles to attain an effect.  

 The Emit property works in conjunction with the AutoDestruct property of the Particle Animator. Through scripting, you can cease the 

emitter from emitting, and then AutoDestruct will automatically destroy the Particle System and the GameObject it is attached to.  

Mesh Particle Emitter 



The Mesh Particle Emitter emits particles around a mesh. Particles are spawned from the surface of the mesh, which can be necessary 

when you want to make your particles interact in a complex way with objects.  

 

The Mesh Particle Emitter Inspector 

Properties 

  
Emit If enabled, the emitter will emit particles. 

Min Size The minimum size each particle can be at the time when it is spawned. 

Max Size The maximum size each particle can be at the time when it is spawned. 

Min Energy The minimum lifetime of each particle, measured in seconds. 

Max Energy The maximum lifetime of each particle, measured in seconds. 

Min Emission The minimum number of particles that will be spawned every second. 

Max Emission The maximum number of particles that will be spawned every second. 

World Velocity The starting speed of particles in world space, along X, Y, and Z. 

Local Velocity The starting speed of particles along X, Y, and Z, measured in the object's orientation. 

Rnd Velocity A random speed along X, Y, and Z that is added to the velocity. 

Emitter Velocity Scale The amount of the emitter's speed that the particles inherit. 

Tangent Velocity The starting speed of particles along X, Y, and Z, across the Emitter's surface. 

Simulate In World Space If enabled, the particles don't move when the emitter moves. If false, when you move the emitter, the particles 

follow it around. 

One Shot If enabled, the particle numbers specified by min & max emission is spawned all at once. If disabled, the 

particles are generated in a long stream. 

Interpolate Triangles If enabled, particles are spawned all over the mesh's surface. If disabled, particles are only spawned from the 

mesh's vertrices. 

Systematic If enabled, particles are spawned in the order of the vertices defined in the mesh. Although you seldom have 

direct control over vertex order in meshes, most 3D modelling applications have a very systematic setup when 

using primitives. It is important that the mesh contains no faces in order for this to work. 

Min Normal Velocity Minimum amount that particles are thrown away from the mesh. 

Max Normal Velocity Maximum amount that particles are thrown away from the mesh. 

Details 

Mesh Particle Emitters (MPEs) are used when you want more precise control over the spawn position & directions than the simpler 

Ellipsoid Particle Emitter gives you. They can be used for making advanced effects.  



MPEs work by emitting particles at the vertices of the attached mesh. Therefore, the areas of your mesh that are more dense with polygons 

will be more dense with particle emission.  

Particle Emitters work in conjunction with Particle Animators and Particle Renderers to create, manipulate, and display Particle Systems. All 

three Components must be present on an object before the particles will behave correctly. When particles are being emitted, all different 

velocities are added together to create the final velocity.  

Spawning Properties 

Spawning properties like Size, Energy, Emission, and Velocity will give your particle system distinct personality when trying to achieve 

different effects. Having a small Size could simulate fireflies or stars in the sky. A large Size could simulate dust clouds in a musky old 

building.  

Energy and Emission will control how long your particles remain onscreen and how many particles can appear at any one time. For 

example, a rocket might have high Emission to simulate density of smoke, and high Energy to simulate the slow dispersion of smoke into 

the air.  

Velocity will control how your particles move. You might want to change your Velocity in scripting to achieve interesting effects, or if you 

want to simulate a constant effect like wind, set your X and Z Velocity to make your particles blow away.  

Simulate in World Space 

If this is disabled, the position of each individual particle will always translate relative to the Position of the emitter. When the emitter 

moves, the particles will move along with it. If you have Simulate in World Space enabled, particles will not be affected by the translation 

of the emitter. For example, if you have a fireball that is spurting flames that rise, the flames will be spawned and float up in space as the 

fireball gets further away. If Simulate in World Space is disabled, those same flames will move across the screen along with the fireball.  

Emitter Velocity Scale 

This property will only apply if Simulate in World Space is enabled.  

If this property is set to 1, the particles will inherit the exact translation of the emitter at the time they are spawned. If it is set to 2, the 

particles will inherit double the emitter's translation when they are spawned. 3 is triple the translation, etc.  

One Shot 

One Shot emitters will create all particles within the Emission property all at once, and cease to emit particles over time. Here are some 

examples of different particle system uses with One Shot Enabled or Disabled:  

Enabled:  

 Explosion  

 Water splash  

 Magic spell  

Disabled:  

 Gun barrel smoke  

 Wind effect  

 Waterfall  

Interpolate Triangles 

Enabling your emitter to Interpolate Triangles will allow particles to be spawned between the mesh's vertices. This option is off by default, 

so particles will only be spawned at the vertices.  

http://unity3d.com/support/documentation/Components/class-ParticleAnimator.html
http://unity3d.com/support/documentation/Components/class-ParticleRenderer.html


 

A sphere with Interpolate Triangles off (the default) 

Enabling this option will spawn particles on and in-between vertices, essentially all over the mesh's surface (seen below).  



 

A sphere with Interpolate Triangles on 

It bears repeating that even with Interpolate Triangles enabled, particles will still be denser in areas of your mesh that are more dense 

with polygons.  

Systematic 

Enabling Systematic will cause your particles to be spawned in your mesh's vertex order. The vertex order is set by your 3D modeling 

application.  



 

An MPE attached to a sphere with Systematic enabled 

Normal Velocity 

Normal Velocity controls the speed at which particles are emitted along the normal from where they are spawned.  

For example, create a Mesh Particle System, use a cube mesh as the emitter, enable Interpolate Triangles, and set Normal Velocity Min 

and Max to 1. You will now see the particles emit from the faces of the cube in a straight line.  

See Also 

 How to make a Mesh Particle Emitter  

Hints 

 Be careful of using many large particles. This can seriously hinder performance on low-level machines. Always try to use the minimum 

number of particles to attain an effect.  

 The Emit property works in conjunction with the AutoDestruct property of the Particle Animator. Through scripting, you can cease the 

emitter from emitting, and then AutoDestruct will automatically destroy the Particle System and the GameObject it is attached to.  

 MPEs can also be used to make glow from a lot of lamps placed in a scene. Simply make a mesh with one vertex in the center of each 

lamp, and build an MPE from that with a halo material. Great for evil sci-fi worlds.  

Particle Animator 
Particle Animators move your particles over time, you use them to apply wind, drag & color cycling to your particle systems.  

http://unity3d.com/support/documentation/Manual/HOWTO-MeshParticleEmitter.html


 

The Particle Animator Inspector 

Properties 

  

Does Animate Color If enabled, particles cycle their color over their lifetime. 

Color Animation The 5 colors particles go through. All particles cycle over this - if some have a shorter life span than others, they 

will animate faster. 

World Rotation Axis An optional world-space axis the particles rotate around. Use this to make advanced spell effects or give 

caustic bubbles some life. 

Local Rotation Axis An optional local-space axis the particles rotate around. Use this to make advanced spell effects or give caustic 

bubbles some life. 

Size Grow Use this to make particles grow in size over their lifetime. As randomized forces will spread your particles out, it 

is often nice to make them grow in size so they don't fall apart. Use this to make smoke rise upwards, to 

simulate wind, etc. 

Rnd Force A random force added to particles every frame. Use this to make smoke become more alive. 

Force The force being applied every frame to the particles, measure relative to the world. 

Damping How much particles are slowed every frame. A value of 1 gives no damping, while less makes them slow down. 

Autodestruct If enabled, the GameObject attached to the Particle Animator will be destroyed when all particles disappear. 

Details 

Particle Animators allow your particle systems to be dynamic. They allow you to change the color of your particles, apply forces and 

rotation, and choose to destroy them when they are finished emitting. For more information about Particle Systems, reference Mesh 

Particle Emitters, Ellipsoid Particle Emitters, and Particle Renderers.  

Animating Color 

If you would like your particles to change colors or fade in/out, enable them to Animate Color and specify the colors for the cycle. Any 

particle system that animates color will cycle through the 5 colors you choose. The speed at which they cycle will be determined by the 

Emitter's Energy value.  

If you want your particles to fade in rather than instantly appear, set your first or last color to have a low Alpha value.  

http://unity3d.com/support/documentation/Components/class-MeshParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-MeshParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-EllipsoidParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-ParticleRenderer.html


 

An Animating Color Particle System 

Rotation Axes 

Setting values in either the Local or World Rotation Axes will cause all spawned particles to rotate around the indicated axis (with the 

Transform's position as the center). The greater the value is entered on one of these axes, the faster the rotation will be.  

Setting values in the Local Axes will cause the rotating particles to adjust their rotation as the Transform's rotation changes, to match its 

local axes.  

Setting values in the World Axes will cause the particles' rotation to be consistent, regardless of the Transform's rotation.  

Forces & Damping 

You use force to make particles accelerate in the direction specified by the force.  

Damping can be used to decelerate or accelerate without changing their direction:  

 A value of 1 means no Damping is applied, the particles will not slow down or accelerate.  

 A value of 0 means particles will stop immediately.  

 A value of 2 means particles will double their speed every second.  

Destroying GameObjects attached to Particles 

You can destroy the Particle System and any attached GameObject by enabling the AutoDestruct property. For example, if you have an 

oil drum, you can attach a Particle System that has Emit disabled and AutoDestruct enabled. On collision, you enable the Particle Emitter. 

The explosion will occur and after it is over, the Particle System and the oil drum will be destroyed and removed from the scene.  

Note that automatic destruction takes effect only after some particles have been emitted. The precise rules for when the object is destroyed 

when AutoDestruct is on:  

 If there have been some particles emitted already, but all of them are dead now, or  

 If the emitter did have Emit on at some point, but now Emit is off.  

Hints 

http://unity3d.com/support/documentation/Components/class-EllipsoidParticleEmitter.html


 Use the Color Animation to make your particles fade in & out over their lifetime - otherwise, you will get nasty-looking pops.  

 Use the Rotation Axes to make whirlpool-like swirly motions.  

Particle Collider 
The World Particle Collider is used to collide particles against other Colliders in the scene.  

 

A Particle System colliding with a Mesh Collider 

Properties 

  

Bounce Factor Particles can be accelerated or slowed down when they collide against other objects. This factor is similar to 

the Particle Animator's Damping property. 

Collision Energy Loss Amount of energy (in seconds) a particle should lose when colliding. If the energy goes below 0, the particle is 

killed. 

Min Kill Velocity If a particle's Velocity drops below Min Kill Velocity because of a collision, it will be eliminated. 

Collides with Which Layers the particle will collide against. 

Send Collision Message If enabled, every particle sends out a collision message that you can catch through scripting. 

Details 

To create a Particle System with Particle Collider:  

1. Create a Particle System using GameObject->Create Other->Particle System  

2. Add the Particle Collider using Component->Particles->World Particle Collider  

Messaging 

If Send Collision Message is enabled, any particles that are in a collision will send the message OnParticleCollision() to both the 

particle's GameObject and the GameObject the particle collided with.  

Hints 

 Send Collision Message can be used to simulate bullets and apply damage on impact.  

 Particle Collision Detection is slow when used with a lot of particles. Use Particle Collision Detection wisely.  

 Message sending introduces a large overhead and shouldn't be used for normal Particle Systems.  

Particle Renderer 
The Particle Renderer renders the Particle System on screen.  

http://unity3d.com/support/documentation/Components/Layers.html


 

The Particle Renderer Inspector 

Properties 

  

Materials Reference to a list of Materials that will be displayed in the position of each individual particle. 

Camera Velocity Scale The amount of stretching that is applied to the Particles based on Camera movement. 

Stretch Particles Determines how the particles are rendered. 

Billboard The particles are rendered as if facing the camera. 

Stretched The particles are facing the direction they are moving. 

SortedBillboard The particles are sorted by depth. Use this when using a blending material. 

VerticalBillboard All particles are aligned flat along the X/Z axes. 

HorizontalBillboard All particles are aligned flat along the X/Y axes. 

Length Scale If Stretch Particles is set to Stretched, this value determines how long the particles are in their direction of 

motion. 

Velocity Scale If Stretch Particles is set to Stretched, this value determines the rate at which particles will be stretched, 

based on their movement speed. 

UV Animation If either of these are set, the UV coordinates of the particles will be generated for use with a tile animated 

texture. See the section on Animated Textures below. 

X Tile Number of frames located across the X axis. 

Y Tile Number of frames located across the Y axis. 

Cycles How many times to loop the animation sequence. 

Details 

Particle Renderers are required for any Particle Systems to be displayed on the screen.  

http://unity3d.com/support/documentation/Components/class-Camera.html
http://unity3d.com/support/documentation/printable.html#AnimatedTextures


 

A Particle Renderer makes the Gunship's engine exhaust appear on the screen 

Choosing a Material 

When setting up a Particle Renderer it is very important to use an appropriate material and shader that renders both sides of the material. 

Most of the time you want to use a Material with one of the built-in Particle Shaders. There are some premade materials in the Standard 

Assets->Particles->Sources folder that you can use.  

Creating a new material is easy:  

1. Select Assets->Create Other->Material from the menu bar.  

2. The Material has a shader popup, choose one of the shaders in the Particles group. Eg. Particles->Multiply.  

3. Now assign a Texture. The different shaders use the alpha channel of the textures slightly differently, but most of the time a value 

of black will make it invisible and white in the alpha channel will display it on screen.  

Distorting particles 

By default particles are rendered billboarded. That is simple square sprites. This is good for smoke and explosions and most other particle 

effects.  

Particles can be made to either stretch with the velocity. This is useful for sparks, lightning or laser beams. Length Scale and Velocity 

Scale affects how long the stretched particle will be.  

Sorted Billboard can be used to make all particles sort by depth. Sometimes this is necessary, mostly when using Alpha Blended particle 

shaders. This can be expensive and should only be used if it really makes a quality difference when rendering.  

Animated textures 

Particle Systems can be rendered with an animated tile texture. To use this feature, make the texture out of a grid of images. As the 

particles go through their life cycle, they will cycle through the images. This is good for adding more life to your particles, or making small 

rotating debris pieces.  

Hints 

 Use Particle Shaders with the Particle Renderer.  

http://unity3d.com/support/documentation/Components/class-Material.html
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Terrains 
This section will explain how to use the Terrain Engine. It will cover creation, technical details, and other considerations. It is broken into 

the following sections:  

Using Terrains 

This section covers the most basic information about using Terrains. This includes creating Terrains and how to use the new Terrain tools & 

brushes.  

 

Height 

This section explains how to use the different tools and brushes that alter the Height of the Terrain.  

http://unity3d.com/support/documentation/Components/terrain-UsingTerrains.html
http://unity3d.com/support/documentation/Components/terrain-Height.html
http://unity3d.com/support/documentation/Components/terrain-UsingTerrains.html


 

Terrain Textures 

This section explains how to add, paint and blend Terrain Textures using different brushes.  

 

Trees 

This section contains important information for creating your own tree assets. It also covers adding and painting trees on your Terrain.  

http://unity3d.com/support/documentation/Components/terrain-Textures.html
http://unity3d.com/support/documentation/Components/terrain-Trees.html
http://unity3d.com/support/documentation/Components/terrain-Height.html
http://unity3d.com/support/documentation/Components/terrain-Textures.html


 

Grass 

This section explains how grass works, and how to use it.  

 

Detail Meshes 

This section explains practical usage for detail meshes like rocks, haystacks, vegetation, etc.  

http://unity3d.com/support/documentation/Components/terrain-Grass.html
http://unity3d.com/support/documentation/Components/terrain-DetailMeshes.html
http://unity3d.com/support/documentation/Components/terrain-Trees.html
http://unity3d.com/support/documentation/Components/terrain-Grass.html


 

Lightmaps 

You can lightmap terrains just like any other objects using Unity's built-in lightmapper. See Lightmapping Quickstart for help.  

 

Other Settings 

This section covers all the other settings associated with Terrains.  

 

iOS 
 

Due to performance hit, Terrain Engine usage is discouraged on pre-ipad2 devices.  

http://unity3d.com/support/documentation/Manual/Lightmapping.html
http://unity3d.com/support/documentation/Manual/Lightmapping.html
http://unity3d.com/support/documentation/Components/terrain-OtherSettings.html
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
http://unity3d.com/support/documentation/Components/terrain-DetailMeshes.html
http://unity3d.com/support/documentation/Manual/Lightmapping.html
javascript:ShowHideDiv('iosRef','specific-ios', 'iOS');


 

Android 
 

Due to performance hit, Terrain Engine usage is discouraged on non high-end devices.  
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Asset Import and Creation 
A large part of making a game is utilizing your asset source files in your GameObjects. This goes for textures, models, sound effects and 

behaviour scripts. Using the Project View inside Unity, you have quick access to all the files that make up your game:  

 

The Project View displays all source files and created Prefabs 

This view shows the organization of files in your project's Assets folder. Whenever you update one of your asset files, the changes are 

immediately reflected in your game!  

To import an asset file into your project, move the file into (your Project folder)->Assets in the Finder, and it will automatically be imported 

into Unity. To apply your assets, simply drag the asset file from the Project View window into the Hierarchy or Scene View. If the asset is 

meant to be applied to another object, drag the asset over the object.  

Hints 

 Is always a good idea to add labels to your assets when you are working with big projects or when you want to keep organized all your 

assets, with this you can search for the labels associated to each asset in the search field in the project view.  

javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
javascript:ShowHideDiv('androidRef','specific-android', 'Android');


 When backing up a project folder always back up both Library and Assets folders. The Library folder contains all meta data and all the 

connections between objects, thus if the Library folder gets lost, you will lose references from scenes to assets. Easiest is just to back up 

the whole project folder containing both the Assets and Library folder.  

 Rename and move files to your heart's content inside Project View; nothing will break.  

 Never rename or move anything from the Finder or another program; everything will break. In short, Unity stores lots of metadata for each 

asset (things like import settings, cached versions of compressed textures, etc.) and if you move a file externally, Unity can no longer 

associate metadata with the moved file.  

Continue reading for more information:  

 Importing Assets  

 Meshes  

 Animations  

 Materials and Shaders  

 Texture 2D  

 Procedural Materials  

 Movie Texture  

 Audio Files  

o Tracker Modules  

 Using Scripts  

 Asset Store  

o Accessing the Asset Store  

o Navigating the Asset Store  

o Managing previous downloads and purchases  

 Asset Server Guide  

 Behind the Scenes  
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Importing Assets 
Unity will automatically detect files as they are added to your Project folder's Assets folder. When you put any asset into your Assets folder, 

you will see the asset appear in your Project View.  

http://unity3d.com/support/documentation/Manual/Importing%20Assets.html
http://unity3d.com/support/documentation/Manual/Meshes.html
http://unity3d.com/support/documentation/Manual/Animations.html
http://unity3d.com/support/documentation/Manual/Materials.html
http://unity3d.com/support/documentation/Manual/Textures.html
http://unity3d.com/support/documentation/Manual/Procedural%20Materials.html
http://unity3d.com/support/documentation/Manual/Video%20Files.html
http://unity3d.com/support/documentation/Manual/Audio%20Files.html
http://unity3d.com/support/documentation/Manual/TrackerModules.html
http://unity3d.com/support/documentation/Manual/Scripting.html
http://unity3d.com/support/documentation/Manual/Asset%20Store.html
http://unity3d.com/support/documentation/Manual/AssetStore-Accessing.html
http://unity3d.com/support/documentation/Manual/AssetStore-Navigation.html
http://unity3d.com/support/documentation/Manual/AssetStore-DownloadManager.html
http://unity3d.com/support/documentation/Manual/Asset%20Server.html
http://unity3d.com/support/documentation/Manual/Behind%20the%20Scenes.html


 

The Project View is your window into the Assets folder, normally accessible from the file manager 

When you are organizing your Project View, there is one very important thing to remember:  

Never move any assets or organize this folder from the Explorer (Windows) or Finder (OS X). Always use the Project View! 

There is a lot of meta data stored about relationships between asset files within Unity. This data is all dependent on where Unity expects to 

find these assets. If you move an asset from within the Project View, these relationships are maintained. If you move them outside of Unity, 

these relationships are broken. You'll then have to manually re-link lots of dependencies, which is something you probably don't want to do.  

So just remember to only save assets to the Assets folder from other applications, and never rename or move files outside of Unity. Always 

use Project View. You can safely open files for editing from anywhere, of course.  

Creating and Updating Assets 

When you are building a game and you want to add a new asset of any type, all you have to do is create the asset and save it somewhere 

in the Assets folder. When you return to Unity or launch it, the added file(s) will be detected and imported.  

Additionally, as you update and save your assets, the changes will be detected and the asset will be re-imported in Unity. This allows you 

to focus on refining your assets without struggling to make them compatible with Unity. Updating and saving your assets normally from its 

native application provides optimum, hassle-free workflow that feels natural.  

Asset Types 

There are a handful of basic asset types that will go into your game. The types are:  

 Mesh Files & Animations  

 Texture Files  

 Sound Files  

We'll discuss the details of importing each of these file types and how they are used.  



Meshes & Animations 

Whichever 3D package you are using, Unity will import the meshes and animations from each file. For a list of applications that are 

supported by Unity, please see this page.  

Your mesh file does not need to have an animation to be imported. If you do use animations, you have your choice of importing all 

animations from a single file, or importing separate files, each with one animation. For more information about importing animations, please 

see page about Animation Import.  

Once your mesh is imported into Unity, you can drag it to the Scene or Hierarchy to create an instance of it. You can also add 

Components to the instance, which will not be attached to mesh file itself.  

Meshes will be imported with UVs and a number of default Materials (one material per UV). You can then assign the appropriate texture 

files to the materials and complete the look of your mesh in Unity's game engine.  

Textures 

Unity supports all image formats. Even when working with layered Photoshop files, they are imported without disturbing the Photoshop 

format. This allows you to work with a single texture file for a very care-free and streamlined experience.  

You should make your textures in dimensions that are to the power of two (e.g. 32x32, 64x64, 128x128, 256x256, etc.) Simply placing them 

in your project's Assets folder is sufficient, and they will appear in the Project View.  

Once your texture has been imported, you should assign it to a Material. The material can then be applied to a mesh, Particle System, or 

GUI Texture. Using the Import Settings, it can also be converted to a Cubemap or Normalmap for different types of applications in the 

game. For more information about importing textures, please read the Texture Component page.  

Sounds 

 

Desktop  
 

Unity features support for two types of audio: Uncompressed Audio or Ogg Vorbis. Any type of audio file you import into your project will 

be converted to one of these formats.  

File Type Conversion 

.AIFF Converted to uncompressed audio on import, best for short sound effects. 

.WAV Converted to uncompressed audio on import, best for short sound effects. 

.MP3 Converted to Ogg Vorbis on import, best for longer music tracks. 

.OGG Compressed audio format, best for longer music tracks. 

Import Settings 

If you are importing a file that is not already compressed as Ogg Vorbis, you have a number of options in the Import Settings of the Audio 

Clip. Select the Audio Clip in the Project View and edit the options in the Audio Importer section of the Inspector. Here, you can 

compress the Clip into Ogg Vorbis format, force it into Mono or Stereo playback, and tweak other options. There are positives and 

negatives for both Ogg Vorbis and uncompressed audio. Each has its own ideal usage scenarios, and you generally should not use either 

one exclusively.  

Read more about using Ogg Vorbis or Uncompressed audio on the Audio Clip Component Reference page.  

 

iOS 
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Unity features support for two types of audio: Uncompressed Audio or MP3 Compressed audio. Any type of audio file you import into 

your project will be converted to one of these formats.  

File Type Conversion 
.AIFF Imports as uncompressed audio for short sound effects. Can be compressed in Editor on demand. 

.WAV Imports as uncompressed audio for short sound effects. Can be compressed in Editor on demand. 

.MP3 Imports as Apple Native compressed format for longer music tracks. Can be played on device hardware. 

.OGG OGG compressed audio format, incompatible with the iPhone device. Please use MP3 compressed sounds on the iPhone. 

Import Settings 
When you are importing an audio file, you can select its final format and choose to force it to stereo or mono channels. To access the 

Import Settings, select the Audio Clip in the Project View and find Audio Importer under Inspector tab. Here, you can compress the Clip 

into Ogg Vorbis format, force it into Mono or Stereo playback, and tweak other options, like very important Decompress On Load setting.  

Read more about using MP3 Compressed or Uncompressed audio on the Audio Clip Component Reference page.  

 

Android 
 

Unity features support for two types of audio: Uncompressed Audio or MP3 Compressed audio. Any type of audio file you import into 

your project will be converted to one of these formats.  

File Type Conversion 
.AIFF Imports as uncompressed audio for short sound effects. Can be compressed in Editor on demand. 

.WAV Imports as uncompressed audio for short sound effects. Can be compressed in Editor on demand. 

.MP3 Imports as MP3 compressed format for longer music tracks. 

.OGG OGG compressed audio format, is incompatible with some Android devices, so Unity does not support it for Android platform. 

Please use MP3 compressed sounds instead. 

Import Settings 
When you are importing an audio file, you can select its final format and choose to force it to stereo or mono channels. To access the 

Import Settings, select the Audio Clip in the Project View and find Audio Importer under Inspector tab. Here, you can compress the Clip 

into Ogg Vorbis format, force it into Mono or Stereo playback, and tweak other options, like very important Decompress On Load setting.  

Read more about using MP3 Compressed or Uncompressed audio on the Audio Clip Component Reference page.  

Once sound files are imported, they can be attached to any GameObject. The Audio file will create an Audio Source Component 

automatically when you drag it onto a GameObject.  
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Meshes 
At the core of any 3D game are Meshes - objects consisting of triangles, with textures applied.  

Meshes in Unity are rendered with renderer components. Although there may be many variations, a Mesh Renderer is the most commonly 

used.  

 The renderer displays the mesh at the GameObject's position.  

 The appearance of the mesh is controlled through the renderer's Materials.  
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A Mesh Filter together with Mesh Renderer makes the model appear on screen. 

Meshes 
Meshes make up a large part of your 3D worlds. You don't build your meshes in Unity, but in another application.  

In Unity, we have done everything in our power to make this process as simple as possible. There are a lot of details, but the following 

pages should address all specificities of the common 3D art packages:  

 Maya  

 Cinema 4D  

 3ds Max  

 Cheetah3D  

 Modo  

 Lightwave  

 Blender  

Other applications 

Unity can read .FBX, .dae (Collada), .3DS, .dxf and .obj files, so if your program can export to this format you're home free. FBX exporters 

for popular 3D packages can be found here. Many packages also have a Collada exporter available.  

Textures 

Unity will attempt to hook up materials to your imported scenes automatically. To take advantage of this, place your textures in a folder 

called "Textures" next to the scene file, or in any folder above it.  

http://unity3d.com/support/documentation/Components/class-MeshFilter.html
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Place your textures in a Textures folder at or above the asset's level 

Import settings. 

To access the Import Settings for a 3D mesh file, select it and the relevant options will appear in the Inspector.  



 

The Mesh Import Settings dialog 

  Meshes 
 

Scale Factor Unity's physics system expects 1 meter in the game world to be 1 unit in the imported file. If you like to model at 

a different scale, this is the place to fix it. 



Use File Units This option is available only for 3dsMax files. If enabled it imports 3dsMax file as 1FileUnit=1UnityUnit, 

otherwise it imports as 1cm=1UnityUnit. 

Mesh Compression Turning this up will reduce the file size of the mesh, but might introduce irregularities. It's best to turn it up as 

high as possible without the mesh looking too different from the uncompressed version. This is useful for 

optimizing game size. 

Generate Colliders If this is enabled, your meshes will be imported with Mesh Colliders automatically attached. This is useful for 

quickly generating a collision mesh for environment geometry, but should be avoided for geometry you will be 

moving. For more info see Colliders below. 

Swap UVs Use this if lightmapped objects pick up wrong UV channels. This will swap your primary and secondary UV 

channels. 

Generate Lightmap UVs Use this to create UV2 to be used for Lightmapping. 

Advanced Options See Lightmapping UVs document. 

Normals & Tangents 
 

Normals Defines if and how normals should be calculated. This is useful for optimizing game size. 

Import Default option. Imports normals from the file. 

Calculate Calculates normals based on Smoothing angle. If selected, the Smoothing Angle becomes enabled. 

None Disables normals. Use this option if the mesh is neither normal mapped nor affected by realtime lighting. 

Tangents Defines if and how tangents and binormals should be calculated. This is useful for optimizing game size. 

Import Imports tangents and binormals from the file. This option is available only for FBX, Maya and 3dsMax files and 

only when normals are imported from the file. 

Calculate Default option. Calculates tangents and binormals. This option is available only when normals are either 

imported or calculated. 

None Disables tangents and binormals. The mesh will have no Tangents, so won't work with normal-mapped 

shaders. 

Smoothing Angle Sets how sharp an edge has to be to be treated as a hard edge. It is also used to split normal map tangents. 

Split Tangents Enable this if normal map lighting is broken by seams on your mesh. This usually only applies to characters. 

Materials 
 

Generation Controls how materials are generated: 

Off This will not generate materials at all. 

Per Texture Enable this to generate material files near the found texture files. When enabled, different scenes will share the 

same material settings when they use the same textures. For the precise rules, see Material Generation below. 

Per Material This will generate materials per scene, so only this scene uses them. 

Animations 
 

Generation Controls how animations are imported: 

Don't Import No animation or skinning is imported. 

Store in Original Roots Animations are stored in root objects of your animation package (these might be different from root objects in 

Unity). 

Store in Nodes Animations are stored together with the objects they animate. Use this when you have a complex animation 

setup and want full scripting control. 

Store in Root Animations are stored in the scene's transform root objects. Use this when animating anything that has a 

hierarchy. 

Bake Animations When using IK or simulation in your animation package, enable this. Unity will convert to FK on import. This 

option is available only for Maya, 3dsMax and Cinema4D files. 

Animation Wrap mode The default Wrap Mode for the animation in the mesh being imported 

Split Animations If you have multiple animations in a single file, here you can split it into multiple clips. 

Name Name of the split animation clip 

Start First frame of this clip in the model file 

End Last frame of this clip in the model file 

WrapMode What the split clip does when the end of the animation is reached 

Loop Depending on how the animation was created, one extra frame of animation may be required for the split clip to 

loop properly. If your looping animation doesn't look correct, try enabling this option. 

Animation Compression 
 

Anim. Compression What type of compression will be applied to this mesh's animation(s) 

Off Disables animation compression. This means that Unity doesn't reduce keyframe count on import, which leads 

to the highest precision animations, but slower performance and bigger file and runtime memory size. It's not 

recommended to use this option - if you need higher precision animation, you should enable keyframe 

reduction and lower allowed Animation Compression Error values instead. 

http://unity3d.com/support/documentation/Manual/Reducing%20File%20size.html
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Keyframe Reduction Reduces keyframes on import. If selected, the Animation Compression Errors options are displayed. 

Keyframe Reduction and 

Compression 

Reduces keyframes on import and compresses keyframes when storing animations in files. This affects only file 

size - the runtime memory size is the same as Keyframe Reduction. If selected, the Animation Compression 

Errors options are displayed. 

Animation Compression 

Errors 

These options are available only when keyframe reduction is enabled. 

Rotation Error Defines how much rotation curves should be reduced. The smaller value you use - the higher precision you get. 

Position Error Defines how much position curves should be reduced. The smaller value you use - the higher precision you get. 

Scale Error Defines how much scale curves should be reduced. The smaller value you use - the higher precision you get. 

Material Generation 

Materials are found based on the following rules:  

 Unity gets the name of the main diffuse material bound to the objects in the scene.  

 Unity looks for a material with this name in a Folder called Materials next to the scene.  

 Unity goes up the project folders, looking for the Material in each Materials folder along the way.  

If Unity can't find the Material, it tries to create one from the texture:  

 Unity checks for a texture with the correct name in the same folder as the scene.  

 Unity checks for a texture with the correct name in a folder called Textures next to the scene.  

 Unity goes up the project folders, looking for the correct texture in each Textures folder along the way.  

 If Unity finds the texture, it creates a Materials folder next to it and creates a material in there.  

Colliders 

Unity features two primary types of colliders: Mesh Colliders and Primitive Colliders. Mesh colliders are components that use imported 

mesh data and can be used for environment collision. When you enable Generate Colliders in the Import Settings, a Mesh collider is 

automatically added when the mesh is added to the Scene. It will be considered solid as far as the physics system is concerned.  

If you are moving the object around (a car for example), you can not use Mesh colliders. Instead, you will have to use Primitive colliders. In 

this case you should disable the Generate Colliders setting.  

Animations 

Animations are automatically imported from the scene. For more details about animation import options see the Animation Import chapter.  

Normal mapping and characters 

If you have a character with a normal map that was generated from a high-polygon version of the model, you should import the game-

quality version with a Smoothing angle of 180 degrees. This will prevent odd-looking seams in lighting due to tangent splitting. If the 

seams are still present with these settings, enable Split tangents across UV seams.  

If you are converting a greyscale image into a normal map, you don't need to worry about this.  

Hints 

 Merge your meshes together as much as possible. Make them share materials and textures. This has a huge performance benefit.  

 If you need to set up your objects further in Unity (adding physics, scripts or other coolness), save yourself a world of pain and name your 

objects properly in your 3D application. Working with lots of pCube17 or Box42-like objects is not fun.  

 Make your meshes be centered on the world origin in your 3D app. This will make them easier to place in Unity.  

The Unity Editor shows too many triangles (compared to what my 3D app says) 

This is correct. What you are looking at is the amount of triangles actually being sent to OpenGLES for rendering. In addition to case where 

something like the material requires them to be sent twice, other things like hard-normals and non contiguous UV increase vertex/triangle 

counts significantly compared to what a modeling app or Unity tells you. Triangles need to be contiguous in both 3D and UV space to form 

a strip, so when you have UV seams, degenerate triangles have to be made to form strips - this bumps up the count. Previously Unity 

http://unity3d.com/support/documentation/Manual/Animations.html


would report triangle counts incorrectly. This was fixed first in the run-time, and recently in the Editor. Now both will report the correct 

amount of triangles *actually* being sent to OpenGLES for rendering.  

See Also 

 Modeling Optimized Characters  

 How do I use normal maps?  

 How do I fix the rotation of an imported model?  
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Animations 
Unity's Animation System allows you to create beautifully animated skinned characters. The Animation System supports animation 

blending, mixing, additive animations, walk cycle time synchronization, animation layers, control over all aspects of the animation playback 

(time, speed, blend-weights), mesh skinning with 1, 2 or 4 bones per vertex and finally physically based ragdolls.  

There are some best practices for creating a rigged character with optimal performance in Unity. It is recommended that you read about 

these techniques on the Modeling Optimized Characters page.  

If you like, quickly jump to one of the topics covered on this page:  

 Importing Character Animations  

o Animation Splitting  

o Multiple Files  

o Inverse Kinematics  

 Inserting Into a Unity Scene  

You can download an example demo showing pre-setup animated characters here.  

Importing The Animations 

First of all we have to import the character. Unity natively imports Maya (.mb or .ma) files, Cinema 4D (.c4d) files, and fbx files which can be 

exported from most animation packages. Click here to learn how to export from your modelling/animation package.  

Importing Animations using Animation Splitting 

The most convenient way for animators to work is to have a single model containing all animations. When importing the animated model, 

you can define which frames make up each part of the animation. Unity will automatically split the animation into the individual parts, called 

Animation Clips.  

For example:  

 walk animation during frames 1 - 33  

 run animation during frames 41 - 57  

 kick animation during frames 81 - 97  

To import the animations you simply place the model in the Assets folder of your project. Unity will now automatically import it. Highlight it 

in the Project View and edit the Import Settings in the Inspector.  
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The Import Settings Dialog for a mesh 

In the Import Settings, the Split Animations table is where you tell Unity which frames in your asset file make up which Animation Clip. The 

names you specify here are used to activate them in your game.  

  

name Defines the Animation Clip's name within Unity. 

start frame The first frame of the animation. The frame number refers to the same frame as in the 3D program used to 

create the animation. 

stop frame The last frame of the animation. 

WrapMode Defines how should time beyond the playback range of the clip be treated (Once, Loop, PingPong, 

ClampForever). 

loop frame If enabled, an extra loop frame is inserted at the end of the animation. This frame matches the first frame in the 

clip. Use this if you want to make a looping animation and the first & last frames don't match up exactly. 

Importing Animations using multiple model files 



The other way to import animations is to follow the @ animation naming scheme. You create separate model files and use this naming 

convention: 'model name'@'animation name'.fbx  

 

An example of four animation files for an animated character  

Unity automatically imports all four files and collects all animations to the file without the @ sign in. In the example above, the goober.mb 

file will be set up to reference idle, jump, walk and wallJump automatically.  

Importing Inverse Kinematics 

When importing animated characters from Maya that are created using IK, you have to check the Bake IK & simulation box in the Import 

Settings. Otherwise, your character will not animate correctly.  

Bringing the character into the Scene 

When you have imported your model you drag the object from the Project view into the Scene View or Hierarchy.  

 

The animated character is added by dragging it into the scene 

The character above has three animations in the animation list and no default animation. You can add more animations to the character by 

dragging animation clips from the Project View on to the character (in either the Hierarchy or Scene View). This will also set the default 

animation. When you hit Play, the default animation will be played.  

TIP: You can use this to quickly test if your animation plays back correctly. Also use the Wrap Mode to view different behaviors of the animation, especially looping. 
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Materials 
There is a close relationship between Materials and Shaders in Unity. Shaders contain code that defines what kind of properties and 

assets to use. Materials allow you to adjust properties and assign assets.  

 

A Shader is implemented through a Material 

To create a new Material, use Assets->Create->Material from the main menu or the Project View context menu. Once the Material has 

been created, you can apply it to an object and tweak all of its properties in the Inspector. To apply it to an object, just drag it from the 

Project View to any object in the Scene or Hierarchy.  

Setting Material Properties 

You can select which Shader you want any particular Material to use. Simply expand the Shader drop-down in the Inspector, and choose 

your new Shader. The Shader you choose will dictate the available properties to change. The properties can be colors, sliders, textures, 

numbers, or vectors. If you have applied the Material to an active object in the Scene, you will see your property changes applied to the 

object in real-time.  

There are two ways to apply a Texture to a property.  

1. Drag it from the Project View on top of the Texture square  

2. Click the Select button, and choose the texture from the drop-down list that appears  

Two placement options are available for each Texture:  

  
Tiling Scales the texture along the different. 

Offset Slides the texture around. 

Built-in Shaders 

There is a library of built-in Shaders that come standard with every installation of Unity. There are over 30 of these built-in Shaders, and six 

basic families.  

 Normal: For opaque textured objects.  

http://unity3d.com/support/documentation/Components/Built-in%20Shader%20Guide.html
http://unity3d.com/support/documentation/Components/Built-in%20Shader%20Guide.html
http://unity3d.com/support/documentation/Components/shader-NormalFamily.html


 Transparent: For partly transparent objects. The texture's alpha channel defines the level of transparency.  

 TransparentCutOut: For objects that have only fully opaque and fully transparent areas, like fences.  

 Self-Illuminated: For objects that have light emitting parts.  

 Reflective: For opaque textured objects that reflect an environment Cubemap.  

In each group, built-in shaders range by complexity, from the simple VertexLit to the complex Parallax Bumped with Specular. For more 

information about performance of Shaders, please read the built-in Shader performance page  

This grid displays a thumbnail of all built-in Shaders:  

 

The builtin Unity shaders matrix 

Shader technical details 

Unity has an extensive Shader system, allowing you to tweak the look of all in-game graphics. It works like this:  

A Shader basically defines a formula for how the in-game shading should look. Within any given Shader is a number of properties (typically 

textures). Shaders are implemented through Materials, which are attached directly to individual GameObjects. Within a Material, you will 

choose a Shader, then define the properties (usually textures and colors, but properties can vary) that are used by the Shader.  

This is rather complex, so let's look at a workflow diagram:  

 

http://unity3d.com/support/documentation/Components/shader-TransparentFamily.html
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On the left side of the graph is the Carbody Shader. 2 different Materials are created from this: Blue car Material and Red car Material. 

Each of these Materials have 2 textures assigned; the Car Texture defines the main texture of the car, and a Color FX texture. These 

properties are used by the shader to make the car finish look like 2-tone paint. This can be seen on the front of the red car: it is yellow 

where it faces the camera and then fades towards purple as the angle increases. The car materials are attached to the 2 cars. The car 

wheels, lights and windows don't have the color change effect, and must hence use a different Material. At the bottom of the graph there is 

a Simple Metal Shader. The Wheel Material is using this Shader. Note that even though the same Car Texture is reused here, the end 

result is quite different from the car body, as the Shader used in the Material is different.  

To be more specific, a Shader defines:  

 The method to render an object. This includes using different methods depending on the graphics card of the end user.  

 Any vertex and fragment programs used to render.  

 Some texture properties that are assignable within Materials.  

 Color and number settings that are assignable within Materials.  

A Material defines:  

 Which textures to use for rendering.  

 Which colors to use for rendering.  

 Any other assets, such as a Cubemap that is required by the shader for rendering.  

Shaders are meant to be written by graphics programmers. They are created using the ShaderLab language, which is quite simple. 

However, getting a shader to work well on a variety graphics cards is an involved job and requires a fairly comprehensive knowledge of 

how graphics cards work.  

A number of shaders are built into Unity directly, and some more come in the Standard Assets Library. If you like, there is plenty more 

shader information in the Built-in Shader Guide.  
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Textures 
Textures bring your Meshes, Particles, and interfaces to life! They are image or movie files that you lay over or wrap around your objects. 

As they are so important, they have a lot of properties. If you are reading this for the first time, jump down to Details, and return to the 

actual settings when you need a reference.  

The shaders you use for your objects put specific requirements on which textures you need, but the basic principle is that you can put any 

image file inside your project. If it meets the size requirements (specified below), it will get imported and optimized for game use. This 

extends to multi-layer Photoshop or TIFF files - they are flattened on import, so there is no size penalty for your game.  

Properties 

http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
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The Texture Inspector looks a bit different from most others:  

 

The top section contains a few settings, and the bottom part contains the Texture Importer and the texture preview.  

  

Aniso Level Increases texture quality when viewing the texture at a steep angle. Good for floor and ground textures, see 

below. 

Filter Mode Selects how the Texture is filtered when it gets stretched by 3D transformations: 

http://unity3d.com/support/documentation/printable.html#anisotropy


Point The Texture becomes blocky up close 

Bilinear The Texture becomes blurry up close 

Trilinear Like Bilinear, but the Texture also blurs between the different mip levels 

Wrap Mode Selects how the Texture behaves when tiled: 

Repeat The Texture repeats (tiles) itself 

Clamp The Texture's edges get stretched 

Texture Importer 

Textures all come from image files in your Project Folder. How they are imported is specified by the Texture Importer. You change these 

by selecting the file texture in the Project View and modifying the Texture Importer in the Inspector.  

In Unity 3 we simplified for you all the settings, now you just need to select what are you going to use the texture for and Unity will set 

default parameters for the type of texture you have selected. Of course if you want to have total control of your texture and do specific 

tweaks, you can set the Texture Type to Advanced. This will present the full set of options that you have available.  

  
Texture Type Select this to set basic parameters depending on the purpose of your texture. 

Texture This is the most common setting used for all the textures in general. 

Normal Map Select this to turn the color channels into a format suitable for real-time normal mapping. For more info, see 

Normal Maps 

GUI Use this if your texture is going to be used on any HUD/GUI Controls. 

Reflection Also known as Cube Maps, used to create reflections on textures. check Cubemap Textures for more info. 

Cookie This sets up your texture with the basic parameters used for the Cookies of your lights 

Advanced Select this when you want to have specific parameters on your texture and you want to have total control over 

your texture. 

 

Basic Texture Settings Selected 

Generate Alpha From 

Grayscale 

If enabled, an alpha transparency channel will be generated by the image's existing values of light & 

dark. 

 

Normal Map Settings in the Texture Importer 

Generate from Greyscale 

Bumpiness Control the amount of bumpiness. 

Filtering Determine how the bumpiness is calculated: 

Smooth This generates normal maps that are quite smooth. 

Sharp Also known as a Sobel filter. this generates normal maps that are sharper than Standard. 

 

GUI Settings for the Texture Importer 

You dont need to set any values in this case, Unity will set all the values for you.  

 

Reflection Settings in the Texture Importer 

Mapping This determines how the texture will be mapped to a cubemap. 

Sphere Mapped Maps the texture to a "sphere like" cubemap. 
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Cylindrical Maps the texture to a cylinder, use this when you want to use reflections on objects that are like cylinders. 

Simple Sphere Maps the texture to a simple sphere, deforming the reflection when you rotate it. 

Nice Sphere Maps the texture to a sphere, deforming it when you rotate but you still can see the texture's wrap 

An interesting way to add a lot of visual detail to your scenes is to use Cookies - greyscale textures you use to control the precise look of 

in-game lighting. This is fantastic for making moving clouds and giving an impression of dense foliage. The Light page has more info on all 

this, but the main thing is that for textures to be usable for cookies you just need to set the Texture Type to Cookie.  

 

Cookie Settings in the Texture Importer 

Light Type Type of light that the texture will be applied to. (This can be Spotlight, Point or Directional lights). For Directional Lights 

this texture will tile, so in the texture inspector, you must set the Edge Mode to Repeat; for SpotLights You should keep 

the edges of your cookie texture solid black in order to get the proper effect. In the Texture Inspector, set the Edge Mode 

to Clamp. 

Generate Alpha 

from Greyscale 

If enabled, an alpha transparency channel will be generated by the image's existing values of light & dark. 

 

The Advanced Texture Importer Settings dialog 

Non Power of 

2 

If texture has non-power-of-two size, this will define a scaling behavior at import time (for more info see the Texture Sizes 

section below): 

None Texture will be padded to the next larger power-of-two size for use with GUITexture component. 

To nearest Texture will be scaled to the nearest power-of-two size at import time. For instance 257x511 texture will become 256x512. 

Note that PVRTC formats require textures to be square (width equal to height), therefore final size will be upscaled to 

512x512. 

To larger Texture will be scaled to the next larger power-of-two size at import time. For instance 257x511 texture will become 

512x512. 

To smaller Texture will be scaled to the next smaller power-of-two size at import time. For instance 257x511 texture will become 

256x256. 

Generate 

Cube Map 

Generates a cubemap from the texture using different generation methods. 

Read/Write 

Enabled 

Select this to enable access to the texture data from scripts (GetPixels, SetPixels and other Texture2D functions). Note 

however that a copy of the texture data will be made, doubling the amount of memory required for texture asset. Use only if 

absolutely necessary. This is only valid for uncompressed and DTX compressed textures, other types of compressed 

textures cannot be read from. Disabled by default. 

Generate Mip 

Maps 

Select this to enable mip-map generation. Mip maps are smaller versions of the texture that get used when the texture is 

very small on screen. For more info, see Mip Maps below. 
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Correct 

Gamma 

Select this to enable per-mip-level gamma correction. 

Border Mip 

Maps 

Select this to avoid colors seeping out to the edge of the lower Mip levels. Used for light cookies (see below). 

Mip Map 

Filtering 

Two ways of mip map filtering are available to optimize image quality: 

Box The simplest way to fade out the mipmaps - the mip levels become smoother and smoother as they go down in size. 

Kaiser A sharpening Kaiser algorithm is run on the mip maps as they go down in size. If your textures are too blurry in the distance, 

try this option. 

Fade Out 

Mips 

Enable this to make the mipmaps fade to gray as the mip levels progress. This is used for detail maps. The left most scroll 

is the first mip level to begin fading out at. The rightmost scroll defines the mip level where the texture is completely grayed 

out 

Generate 

Normal Map 

Enable this to turn the color channels into a format suitable for real-time normal mapping. For more info, see Normal Maps, 

below. 

Bumpiness Control the amount of bumpiness. 

Filtering Determine how the bumpiness is calculated: 

Smooth This generates normal maps that are quite smooth. 

Sharp Also known as a Sobel filter. this generates normal maps that are sharper than Standard. 

Normal Map Select this if you want to see how the normal map will be applied to your texture. 

Lightmap Select this if you want to use the texture as a lightmap. 

Per-Platform Overrides 

When you are building for different platforms, you have to think on the resolution of your textures for the target platform, the size and the 

quality. With Unity 3 you can override these options and assign specific values depending on the platform you are deploying to. Note that if 

you don't select any value to override, the Editor will pick the default values when building your project.  

 

Default settings for all platforms. 

Max Texture 

Size 

The maximum imported texture size. Artists often prefer to work with huge textures - scale the texture down to a suitable 

size with this. 

Texture Format What internal representation is used for the texture. This is a tradeoff between size and quality. In the examples below we 

show the final size of a in-game texture of 256 by 256 pixels: 

Compressed Compressed RGB texture. This is the most common format for diffuse textures. 4 bits per pixel (32 KB for a 256x256 

texture). 

16 bit Low-quality truecolor. Has 16 levels of red, green, blue and alpha. 

Truecolor Truecolor, this is the highest quality. At 256 KB for a 256x256 texture. 

If you have set the Texture Type to Advanced then the Texture Format has different values.  

 

Desktop  
 

Texture Format What internal representation is used for the texture. This is a tradeoff between size and quality. In the examples below 

we show the final size of an in-game texture of 256 by 256 pixels: 

RGB 

Compressed 

DXT1 

Compressed RGB texture. This is the most common format for diffuse textures. 4 bits per pixel (32 KB for a 256x256 

texture). 

RGBA 

Compressed 

DXT5 

Compressed RGBA texture. This is the main format used for diffuse & specular control textures. 1 byte/pixel (64 KB for 

a 256x256 texture). 

RGB 16 bit 65 thousand colors with no alpha. Compressed DXT formats use less memory and usually look better. 128 KB for a 

256x256 texture. 

http://unity3d.com/support/documentation/printable.html#normalmaps
javascript:ShowHideDiv('desktopRef','specific-desktop','Desktop');
javascript:ShowHideDiv('desktopRef','specific-desktop','Desktop');
javascript:ShowHideDiv('desktopRef','specific-desktop','Desktop');


RGB 24 bit Truecolor but without alpha. 192 KB for a 256x256 texture. 

Alpha 8 bit High quality alpha channel but without any color. 64 KB for a 256x256 texture. 

RGBA 16 bit Low-quality truecolor. Has 16 levels of red, green, blue and alpha. Compressed DXT5 format uses less memory and 

usually looks better. 128 KB for a 256x256 texture. 

RGBA 32 bit Truecolor with alpha - this is the highest quality. At 256 KB for a 256x256 texture, this one is expensive. Most of the 

time, DXT5 offers sufficient quality at a much smaller size. The main way this is used is for normal maps, as DXT 

compression there often carries a visible quality loss. 

 

iOS 
 

Texture Format What internal representation is used for the texture. This is a tradeoff between size and quality. In the examples 

below we show the final size of a in-game texture of 256 by 256 pixels: 

RGB Compressed 

PVRTC 4 bits 

Compressed RGB texture. This is the most common format for diffuse textures. 4 bits per pixel (32 KB for a 

256x256 texture) 

RGBA Compressed 

PVRTC 4 bits 

Compressed RGBA texture. This is the main format used for diffuse & specular control textures or diffuse 

textures with transparency. 4 bits per pixel (32 KB for a 256x256 texture) 

RGB Compressed 

PVRTC 2 bits 

Compressed RGB texture. Lower quality format suitable for diffuse textures. 2 bits per pixel (16 KB for a 256x256 

texture) 

RGBA Compressed 

PVRTC 2 bits 

Compressed RGBA texture. Lower quality format suitable for diffuse & specular control textures. 2 bits per pixel 

(16 KB for a 256x256 texture) 

RGB Compressed DXT1 Compressed RGB texture. This format is not supported on iOS, but kept for backwards compatibility with desktop 

projects. 

RGBA Compressed 

DXT5 

Compressed RGBA texture. This format is not supported on iOS, but kept for backwards compatibility with 

desktop projects. 

RGB 16 bit 65 thousand colors with no alpha. Uses more memory than PVRTC formats, but could be more suitable for UI or 

crisp textures without gradients. 128 KB for a 256x256 texture. 

RGB 24 bit Truecolor but without alpha. 192 KB for a 256x256 texture. 

Alpha 8 bit High quality alpha channel but without any color. 64 KB for a 256x256 texture. 

RGBA 16 bit Low-quality truecolor. Has 16 levels of red, green, blue and alpha. Uses more memory than PVRTC formats, but 

can be handy if you need exact alpha channel. 128 KB for a 256x256 texture. 

RGBA 32 bit Truecolor with alpha - this is the highest quality. At 256 KB for a 256x256 texture, this one is expensive. Most of 

the time, PVRTC formats offers sufficient quality at a much smaller size. 

 

Android 
 

Texture Format What internal representation is used for the texture. This is a tradeoff between size and quality. In the examples 

below we show the final size of a in-game texture of 256 by 256 pixels: 

RGB Compressed 

DXT1 

Compressed RGB texture. Supported by Nvidia Tegra. 4 bits per pixel (32 KB for a 256x256 texture). 

RGBA Compressed 

DXT5 

Compressed RGBA texture. Supported by Nvidia Tegra. 6 bits per pixel (64 KB for a 256x256 texture). 

RGB Compressed 

ETC 4 bits 

Compressed RGB texture. This is the default texture format for Android projects. ETC1 is part of OpenGL ES 2.0 

and is supported by all OpenGL ES 2.0 GPUs. It does not support alpha. 4 bits per pixel (32 KB for a 256x256 

texture) 

RGB Compressed 

PVRTC 2 bits 

Compressed RGB texture. Supported by Imagination PowerVR GPUs. 2 bits per pixel (16 KB for a 256x256 

texture) 

RGBA Compressed 

PVRTC 2 bits 

Compressed RGBA texture. Supported by Imagination PowerVR GPUs. 2 bits per pixel (16 KB for a 256x256 

texture) 

RGB Compressed 

PVRTC 4 bits 

Compressed RGB texture. Supported by Imagination PowerVR GPUs. 4 bits per pixel (32 KB for a 256x256 

texture) 

RGBA Compressed 

PVRTC 4 bits 

Compressed RGBA texture. Supported by Imagination PowerVR GPUs. 4 bits per pixel (32 KB for a 256x256 

texture) 

RGB Compressed 

ATC 4 bits 

Compressed RGB texture. Supported by Qualcomm Snapdragon. 4 bits per pixel (32 KB for a 256x256 texture). 

RGBA Compressed Compressed RGBA texture. Supported by Qualcomm Snapdragon. 6 bits per pixel (64 KB for a 256x256 texture). 
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ATC 8 bits 

RGB 16 bit 65 thousand colors with no alpha. Uses more memory than the compressed formats, but could be more suitable for 

UI or crisp textures without gradients. 128 KB for a 256x256 texture. 

RGB 24 bit Truecolor but without alpha. 192 KB for a 256x256 texture. 

Alpha 8 bit High quality alpha channel but without any color. 64 KB for a 256x256 texture. 

RGBA 16 bit Low-quality truecolor. The default compression for the textures with alpha channel. 128 KB for a 256x256 texture. 

RGBA 32 bit Truecolor with alpha - this is the highest quality compression for the textures with alpha. 256 KB for a 256x256 

texture. 

Unless you're targeting a specific hardware, like Tegra, we'd recommend using ETC1 compression. If needed you could store an external 

alpha channel and still benefit from lower texture footprint. If you absolutely want to store an alpha channel in a texture, RGBA16 bit is the 

compression supported by all hardware vendors.  

If your app utilizes an unsupported texture compression, the textures will be uncompressed to RGBA 32 and stored in memory along with 

the compressed ones. So in this case you lose time decompressing textures and lose memory storing them twice. It may also have a very 

negative impact on rendering performance.  

Details 

Supported Formats 

Unity can read the following file formats: PSD, TIFF, JPG, TGA, PNG, GIF, BMP, IFF, PICT. It should be noted that Unity can import multi-

layer PSD & TIFF files just fine. They are flattened automatically on import but the layers are maintained in the assets themselves, so you 

don't lose any of your work when using these file types natively. This is important as it allows you to just have one copy of your textures that 

you can use from Photoshop, through your 3D modelling app and into Unity.  

Texture Sizes 

Ideally texture sizes should be powers of two on the sides. These sizes are as follows: 2, 4, 8, 16, 32, 64, 128, 256, 512, 1024 or 2048 

pixels. The textures do not have to be square, i.e. width can be different from height.  

It is possible to use other (non power of two) texture sizes with Unity. Non power of two texture sizes work best when used on GUI 

Textures, however if used on anything else they will be converted to an uncompressed RGBA 32 bit format. That means they will take up 

more video memory (compared to PVRT(iOS)/DXT(Desktop) compressed textures), will be slower to load and slower to render (if you are 

on iOS mode). In general you'll use non power of two sizes only for GUI purposes.  

Non power of two texture assets can be scaled up at import time using the Non Power of 2 option in the advanced texture type in the 

import settings. Unity will scale texture contents as requested, and in the game they will behave just like any other texture, so they can still 

be compressed and very fast to load.  

UV Mapping 

When mapping a 2D texture onto a 3D model, some sort of wrapping is done. This is called UV mapping and is done in your 3D modelling 

app. Inside Unity, you can scale and move the texture using Materials. Scaling normal & detail maps is especially useful.  

Mip Maps 

Mip Maps are a list of progressively smaller versions of an image, used to optimise performance on real-time 3D engines. Objects that are 

far away from the camera use the smaller texture versions. Using mip maps uses 33% more memory, but not using them can be a huge 

performance loss. You should always use mipmaps for in-game textures; the only exceptions are textures that will never be minified (e.g. 

GUI textures).  

Normal Maps 

Normal maps are used by normal map shaders to make low-polygon models look as if they contain more detail. Unity uses normal maps 

encoded as RGB images. You also have the option to generate a normal map from a grayscale height map image.  

Detail Maps 
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If you want to make a terrain, you normally use your main texture to show where there are areas of grass, rocks sand, etc... If your terrain 

has a decent size, it will end up very blurry. Detail textures hide this fact by fading in small details as your main texture gets up close.  

When drawing detail textures, a neutral gray is invisible, white makes the main texture twice as bright and black makes the main texture 

completely black.  

Reflections (Cube Maps) 

If you want to use texture for reflection maps (e.g. use the Reflective builtin shaders), you need to use Cubemap Textures.  

Anisotropic filtering 

Anisotropic filtering increases texture quality when viewed from a grazing angle, at some expense of rendering cost (the cost is entirely on 

the graphics card). Increasing anisotropy level is usually a good idea for ground and floor textures. In Quality Settings anisotropic filtering 

can be forced for all textures or disabled completely.  

 

No anisotropy (left) / Maximum anisotropy (right) used on the ground texture 
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Procedural Materials 
Unity 3.4 incorporates a new asset type known as Procedural Materials. These are essentially the same as standard Materials except that 

the textures they use can be generated at runtime rather than being predefined and stored.  

The script code that generates a texture procedurally will typically have a much smaller memory footprint than a stored bitmap image and 

so Procedural Materials can help reduce download times. Additionally, the generation script can be equipped with parameters that can be 

changed in order to vary the visual properties of the material at runtime. These properties can be anything from color variations to the size 

of bricks in a wall. Not only does this mean that many variations can be generated from a single Procedural Material but also that the 

material can be animated on a frame-by-frame basis. Many interesting visual effects are possible - imagine a character gradually turning to 

stone or acid damaging a surface as it touches.  

Unity's Procedural Material system is based around an industry standard product called Substance, developed by Allegorithmic.  

Supported Platforms 

http://unity3d.com/support/documentation/Manual/HOWTO-UseDetailTexture.html
http://unity3d.com/support/documentation/Components/class-Cubemap.html
http://unity3d.com/support/documentation/Components/class-QualitySettings.html


In Unity 3.4 Procedural Materials are fully supported for standalone and webplayer build targets only (Windows and Mac OS X). For all 

other platforms, Unity will pre-render or bake them into ordinary Materials during the build. Although this clearly negates the runtime 

benefits of procedural generation, it is still useful to be able to create variations on a basic material in the editor.  

Adding Procedural Materials to a Project 

A Procedural Material is supplied as a Substance Archive file (SBSAR) which you can import like any other asset (drag and drop directly 

onto the Assets folder or use Assets->Import New Asset...). A Substance Archive asset contains one or more Procedural Materials and 

contains all the scripts and images required by these. Uncompiled SBS files are not supported.  

Although they are implemented differently, Unity handles a Procedural Material just like any other Material. To assign a Procedural Material 

to a mesh, for example, you just drag and drop it onto the mesh exactly as you would with any other Material.  

Procedural Properties 

Each Procedural Material is a custom script which generates a particular type of material. These scripts are similar to Unity scripts in that 

they can have variables exposed for assignment in the inspector. For example, a "Brick Wall" Procedural Material could expose properties 

that let you set the number of courses of bricks, the colors of the bricks and the color of the mortar. This potentially offers infinite material 

variations from a single asset. These properties can also be set from a script at runtime in much the same way as the public variables of a 

MonoBehaviour script.  

Procedural Materials can also incorporate complex texture animation. For example, you could animate the hands of the clock or 

cockroaches running across a floor.  

 

Creating Procedural Materials From Scratch 

Procedural Materials can work with any combination of procedurally generated textures and stored bitmaps. Additionally, included bitmap 

images can be filtered and modified before use. Unlike a standard Material, a Procedural Material can use vector images in the form of 

SVG files which allows for resolution-independent textures.  

The design tools available for creating Procedural Materials from scratch use visual, node-based editing similar to the kind found in artistic 

tools. This makes creation accessible to artists who may have little or no coding experience. As an example, here is a screenshot from 

Allegorithmic's Substance Designer which shows a "brick wall" Procedural Material under construction:  



 

Obtaining Procedural Materials 

Since Unity's Procedural Materials are based on the industry standard Substance product, Procedural Material assets are readily available 

from internet sources, including Unity's own Asset Store. Allegorithmic's Substance Designer can be used to create Procedural Materials, 

but there are other applications (3D modelling apps, for example) that incorporate the Substance technology and work just as well with 

Unity.  

Performance and Optimization 

Procedural Materials inherently tend to use less storage than bitmap images. However, the trade-off is that they are based around scripts 

and running those scripts to generate materials requires some CPU and GPU resources. The more complex your Procedural Materials are, 

the greater their runtime overhead.  

Procedural Materials support a form of caching whereby the material is only updated if its parameters have changed since it was last 

generated. Further to this, some materials may have many properties that could theoretically be changed and yet only a few will ever need 

to change at runtime. In such cases, you can inform Unity about the variables that will not change to help it cache as much data as possible 

from the previous generation of the material. This will often improve performance significantly.  

Procedural Materials can refer to hidden, system-wide, variables, such as elapsed time or number of Procedural Material instances (this data can be useful for 

animations). Changes in the values of these variables can still force a Procedural Material to update even if none of the explicitly defined parameters change.  

Procedural Materials can also be used purely as a convenience in the editor (ie, you can generate a standard Material by setting the 

parameters of a Procedural Material and then "baking" it). This will remove the runtime overhead of material generation but naturally, the 

baked materials can't be changed or animated during gameplay.  

Using the Substance Player to Analyze Performance 

Since the complexity of a Procedural Material can affect runtime performance, Allegorithmic incorporates profiling features in its Substance 

Player tool. This tool is available to download for free from Allegorithmic�s website.  

Substance Player uses the same optimized rendering engine as the one integrated into Unity 3.4, so its rendering measurement is more 

representative of performance in Unity than that of Substance Designer.  
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Video Files 
Note: This is a Pro/Advanced feature only.  

http://www.allegorithmic.com/


 

Desktop  
 

Movie Textures are animated Textures that are created from a video file. By placing a video file in your project's Assets Folder, you can 

import the video to be used exactly as you would use a regular Texture.  

Video files are imported via Apple QuickTime. Supported file types are what your QuickTime installation can play (usually .mov, .mpg, 

.mpeg, .mp4, .avi, .asf). On Windows movie importing requires Quicktime to be installed (download here).  

Properties 

The Movie Texture Inspector is very similar to the regular Texture Inspector.  

 

Video files are Movie Textures in Unity 

  
Aniso Level Increases Texture quality when viewing the texture at a steep angle. Good for floor and ground textures 

Filtering Mode Selects how the Texture is filtered when it gets stretched by 3D transformations 

Loop If enabled, the movie will loop when it finishes playing 

Quality Compression of the Ogg Theora video file. A higher value means higher quality, but larger file size 

Details 

When a video file is added to your Project, it will automatically be imported and converted to Ogg Theora format. Once your Movie Texture 

has been imported, you can attach it to any GameObject or Material, just like a regular Texture.  

Playing the Movie 

Your Movie Texture will not play automatically when the game begins running. You must use a short script to tell it when to play.  
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// this line of code will make the Movie Texture begin playing 

renderer.material.mainTexture.Play(); 

Attach the following script to toggle Movie playback when the space bar is pressed:  

function Update () { 

 if (Input.GetButtonDown ("Jump")) { 

  if (renderer.material.mainTexture.isPlaying) { 

   renderer.material.mainTexture.Pause(); 

  } 

  else { 

   renderer.material.mainTexture.Play(); 

  } 

 } 

} 

For more information about playing Movie Textures, see the Movie Texture Script Reference page  

Movie Audio 

When a Movie Texture is imported, the audio track accompanying the visuals are imported as well. This audio appears as an AudioClip 

child of the Movie Texture.  

 

The video's audio track appears as a child of the Movie Texture in the Project View 

To play this audio, the Audio Clip must be attached to a GameObject, like any other Audio Clip. Drag the Audio Clip from the Project View 

onto any GameObject in the Scene or Hierarchy View. Usually, this will be the same GameObject that is showing the Movie. Then use 

audio.Play() to make the the movie's audio track play along with its video.  

http://unity3d.com/support/documentation/ScriptReference/MovieTexture.html
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iOS 
 

Movie Textures are not supported on iOS. Instead a full-screen streaming playback is provided using iPhoneUtils.PlayMovie and 

iPhoneUtils.PlayMovieURL.  

You can import your video file just like a regular asset or alternatively you can specify a network-based URL to play a movie located on a 

remote server.  

You need to keep your videos inside of the StreamingAssets folder located in your Project directory. 

Unity iOS supports any movies that already play correctly on an iPod or iPhone, usually that means files with the extensions .mov, .mp4, 

.mpv, and .3gp and using one of the following compression standards:  

 H.264 Baseline Profile Level 3.0 video  

 MPEG-4 Part 2 video  

For more information about supported compression standards consult with iPhone SDK MPMoviePlayerController Class Reference.  

As soon as you call iPhoneUtils.PlayMovie or iPhoneUtils.PlayMovieURL, the screen will fade from your current content to the designated 

background color. It might take some time while movie is ready for playing, meanwhile the player will continue displaying the background 

color and may also display a progress indicator to let the user know the movie is loading. When playback finishes, the screen will fade back 

to your content.  

Video player does not respect switching to mute while playing videos 

As written above, video files are being played using Apple's embedded player (as of SDK 3.2 and iPhone OS 3.1.2 and earlier), so basically 

we cannot do anything about this, since it is a bug in Apple's software. So yes, mute switch is not respected here.  

Video player does not respect device orientation 

Apple video player and iPhone SDK do not provide a way to adjust the orientation of the video. Common approach is to manually create 

two copies of each movie in landscape and portrait orientations, then to determine the orientation of the device before playback and choose 

one of two movies.  

 

Android 
 

Movie Textures are not supported on Android. Instead a full-screen streaming playback is provided using iPhoneUtils.PlayMovie and 

iPhoneUtils.PlayMovieURL.  

You can import your video file just like a regular asset or alternatively you can specify a network-based URL to play a movie located on a 

remote server.  

You need to keep your videos inside of the StreamingAssets folder located in your Project directory. 

Unity Android supports any movies that already Android platform supports, usually that means files with the extensions .mp4 and .3gp and 

using one of the following compression standards:  

 H.263  

 H.264 AVC  

 MPEG-4 SP  
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However device vendors are keen on expanding this list, so some Android devices are able to play HD videos and other than listed file 

formats.  

For more information about supported compression standards consult with Android SDK Core Media Formats documentation.  

As soon as you call iPhoneUtils.PlayMovie or iPhoneUtils.PlayMovieURL, the screen will fade from your current content to the designated 

background color. It might take some time while movie is ready for playing, meanwhile the player will continue displaying the background 

color and may also display a progress indicator to let the user know the movie is loading. When playback finishes, the screen will fade back 

to your content.  
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Audio Files 
Just like when using Meshes or Textures, the workflow for Audio File assets is designed to make things work for you quickly and easily. 

You can make your Audio Files with any format you like, and Unity can import them and play them back, but there's some specific 

information you should know for working with Audio Files.  

Audio in Unity is either Native or Compressed. Unity support the most common formats (see list after this). Just drag the file into the Editor 

to import the file. The default mode is Native and Unity just uses the original file. Unity can also compress the supplied file. Choose the 

Compressed option in the importer. (Unity IPhone can make use of the hardware decoder. See IPhone specific documentation for this). The 

difference between Native and Compressed is outlined here:  

 Compressed: Compress sounds by choosing the compressed option from inside the Editor. The audio data will be small, but will cost CPU 

cycles to decode at play time. Depending on the target, Unity will encode the audio to either Ogg Vorbis(Mac/PC/Consoles) or MP3 (Mobile 

platforms). For the best sound quality supply the audio in an uncompressed format such as WAV or AIFF (containing PCM data) and let 

Unity do the encoding. If only targeting Mac/PC (standalones, webplayers) importing an Ogg Vorbis file will not degrade the quality. But 

converting to mobile platforms will force a re-encode to MP3 and cause a slight quality degradation. Same goes for importing MP3, when 

only targeting mobile platforms.  

 Native: Use Native (WAV, AIFF) audio for short sound effects. The audio data will be larger, but sounds won't need to be decoded at play 

time.  

Any Audio File imported into Unity is an Audio Clip. Audio Clips work in conjunction with Audio Sources and an Audio Listener. Think of 

Clips as audio data only. When you attach your Clip to an object in the game, it becomes an Audio Source and it now has Volume, Pitch, 

and a wealth of other properties. While a Source is playing, an Audio Listener can "hear" all Sources that are close enough, and those are 

the sounds you will hear through your speakers. There can be only one Audio Listener in your scene, and this is usually attached to the 

Main Camera. In most cases you will work with Audio Sources more than Clips or Listeners.  

Supported Formats 

Format Compressed as (Mac/PC) Compressed as (Mobile) 

MPEG(1/2/3) Ogg Vorbis MP3 

Ogg Vorbis Ogg Vorbis MP3 

WAV Ogg Vorbis MP3 

AIFF Ogg Vorbis MP3 

MOD - - 

IT - - 

S3M - - 

XM - - 

See the Sound chapter in the Creating Gameplay section of this manual for more information on using sound in Unity.  

http://developer.android.com/guide/appendix/media-formats.htm
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Audio Clip 
Audio Clips are audio data used by Audio Sources. Unity supports mono, stereo and multi (up to 8) channels audio assets. Unity supports 

importing the following audio file formats: .aif, .wav, .mp3, and .ogg, and the following tracker module file formats: .xm, .mod, .it, and 

.s3m. The tracker module assets works the same way as any other audio assets in Unity except no waveform preview can be rendered to 

the asset import inspector.  

 

The Audio Clip Inspector 

Properties 

  
Audio Format The specific format that will be used for the sound at runtime. 

Native Larger file size, higher quality. Best for very short sound effects. 

Compressed Smaller file size, lower/variable quality. Best for medium length sound effects and music. 

3D Sound If enabled, the sound will play back in 3D space. Both Mono and Stereo sounds can be played in 3D. 

Force to mono If enabled, the audio clip will be down-mixed to a single channel sound. 

Load Type The way Unity load audio assets runtime. 

Decompress on load Decompress sounds upon load. Use this for smaller compressed sounds to avoid the performance overhead of 

decompressing on the fly. Beware that decompressing sounds on load will use ~10x more memory than 

http://unity3d.com/support/documentation/Components/class-AudioSource.html
http://unity3d.com/support/documentation/Manual/TrackerModules.html
http://unity3d.com/support/documentation/Manual/TrackerModules.html


keeping them compressed in memory, so don't use this for large files. 

Compressed in memory Keep sounds compressed in memory and decompress while playing. This have a slight performance overhead 

(esp. for Ogg/Vorbis compressed files) so only use this for bigger files. 

Stream from disc Stream audio data directly from disc. This uses a fraction of the original sounds size of memory. Use this for 

your music or very long tracks. Depending on the hardware, a general advice is to keep this down to 1-2 

simultaneously streams. 

Compression Amount of Compression to be applied to a Compressed clip. Statistics about file size can be seen beneath the 

slider. It is suggested to drag the slider to a place that leaves the playback "good enough" but still at a small 

enough size to meet your file size/distribution needs. 

Hardware 

Decoding 

(iOS ONLY) Available for compressed audio on iOS devices. Uses Apple's hardware decoder for less CPU intensive 

decompression. Check out Platform Specific details for more info. 

Gapless 

looping 

(Android/iOS ONLY) Use this when compressing a perfect looping audio source file (in a non-compressed PCM format) to 

preserve the loop. Standard MPEG encoders introduce silence around the loop point, which will play as little "click" or "pop". 

Unity handles this smoothly for you. 

Importing Audio Assets 

Unity supports both Compressed and Native Audio. Any type of file (except MP3/Ogg Vorbis) will be initially imported as Native. 

Compressed audio files must be decompressed by the CPU while the game is running, but are smaller in file size. If Stream is checked the 

audio is decompressed on the fly, or else the audio is decompressed entirely upon load. Native PCM formats (WAV, AIFF) have the benefit 

of being higher fidelity without increasing CPU taxation, but create much larger files. Module files (.mod,.it,.s3m..xm) can deliver very high 

quality with an extremely low footprint.  

As a general rule of thumb, Compressed audio(or modules) are best for long files like background music or dialog, and uncompressed is 

better for short sound effects. Tweak the amount of Compression with the compression slider to just before the difference in sound quality 

is noticeable.  

Using 3D Audio 

If an audio clip is marked as a 3D Sound then it will be played back to simulate its position in the game world's 3D space. 3D sounds 

emulate distance and location of sounds by attenuating volume and panning across speakers. Both mono and multiple channel sounds can 

be positioned in 3D. For multiple channel audio, use the spread option on the Audio Source to spread and split out the discrete channels in 

speaker space. Unity offers a variety of options to control and fine-tune the audio behavior in 3D space. Take a look at Audio Source.  

Platform specific details 

 

iOS 
 

On mobile platforms compressed audio is encoded as MP3 for less CPU intensive decompression.  

For performance reasons audio clips can be played back using the Apple hardware codec. To enable this check the "Hardware Decoding" 

checkbox in the Audio Importer. Note that only one hardware audio stream can be decompressed at a time, including the background iPod 

audio.  

If the hardware decoder is not available, the decompression will fall back on the software decoder (on iPhone 3GS or newer Apple's 

software decoder is used over Unity's(FMOD) own decoder).  

 

Android 
 

On mobile platforms compressed audio is encoded as MP3 for less CPU intensive decompression.  
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TrackerModules 
Tracker Modules can be described as packages of audio samples that have been modeled, arranged and sequenced programatically. The 

family of file formats was initially introduced in the 80's Amiga computers and has been very popular in the early game development and 

demo culture.  

Tracker Module files are similar to MIDI files in many ways. The tracks are scores that contain information about when to play the samples, 

at what pitch, volume, effect, etc.; essentially information about what melody or rhythm each instrument should play. However, the 

shortcomings of MIDI are that the sounds are dependent on the sound bank that are in the hardware that outputs the sound, so MIDI music 

can sound different on different computers. The power of the Tracker Module files lies in the fact that they embed high quality PCM 

samples that ensure a similar experience on all hardware.  

Supported formats 

Unity supports the four most used formats, namely Impulse Tracker (.it), Scream Tracker (.s3m), Extended Module File Format (.xm), and 

the original Module File Format (.mod).  

Benefits of Using Tracker Modules 

Tracker Modules distinguish themselves from the widely used PCM (.aif, .wav, .mp3, and .ogg) format by being very small despite the 

sound quality. Game developers can benefit from these because a module can contain a single tiny sample that can be modeled to a very 

wide spectrum of sounds without taking up more space and bandwidth. A PCM file that sounds exactly the same take up much more space 

and bandwidth.  

3rd Party Tools and Further References 

The most popular tools at the moment to create and edit Tracker Modules are MilkyTracker for OSX and OpenMPT for Windows. For more 

info and discussion, please see the blog post .mod in Unity from June 2010.  
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Scripting 
This is a short introduction on how to create and utilize scripts in a project. For detailed information about the Scripting API, please view the 

Scripting Reference. For detailed information about creating game play through scripting, please view the Creating Gameplay page of this 

manual.  

Scripting inside Unity is done by writing simple behaviour scripts in JavaScript, C#, or Boo. You can use one or all scripting languages in a 

single project, there is no penalty for using more than one. Unless stated otherwise, all the scripting examples are in JavaScript.  

Creating New Scripts 

Unlike other assets like Meshes or Textures, Script files can be created from within Unity. To create a new script, open the Assets-

>Create->JavaScript (or Assets->Create->C Sharp Script or Assets->Create->Boo Script) from the main menu. This will create a new 

script called NewBehaviourScript and place it in the selected folder in Project View. If no folder is selected in Project View, the script will 

be created at the root level.  

http://blogs.unity3d.com/2010/06/29/mod-in-unity/
http://unity3d.com/support/documentation/ScriptReference/index.html
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You can edit the script by double-clicking on it in the Project View. This will launch your default selected editor in Unity's preferences. You 

do all your scripting in an external text editor, and not in Unity directly. To set the default script editor, change the drop-down item in Unity-

>Preferences->External Script editor.  

These are the contents of a new, empty behaviour script:  

function Update () { 

}  

A new, empty script does not do a lot on its own, so let's add some functionality. Change the script to read the following:  

function Update () { 

    print("Hello World"); 

}  

When executed, this code will print "Hello World" to the console. But there is nothing that causes the code to be executed yet. We have to 

attach the script to an active GameObject in the Scene before it will be executed.  

Attaching scripts to objects 

Save the above script and create a new object in the Scene by selecting GameObject->Create Other->Cube. This will create a new 

GameObject called "Cube" in the current Scene.  



 

Now drag the script from the Project View to the Cube (in the Scene or Hierarchy View, it doesn't matter). You can also select the Cube 

and choose Component->Scripts->New Behaviour Script. Either of these methods will attach the script to the Cube. Every script you 

create will appear in the Component->Scripts menu. If you have changed the name of your script, you will that name instead.  

 

If you select the Cube and look at the Inspector, you will see that the script is now visible. This means it has been attached.  

 

Press Play to test your creation. You should see the text "Hello World" appear beside the Play/Pause/Step buttons. Exit play mode when 

you see it.  

 

Manipulating the GameObject 



A print() statement can be very handy when debugging your script, but it does not manipulate the GameObject it is attached to. Let's 

change the script to add some functionality:  

function Update () { 

    transform.Rotate(0, 5*Time.deltaTime, 0); 

}  

If you're new to scripting, it's okay if this looks confusing. These are the important concepts to understand:  

1. function Update () {} is a container for code that Unity executes multiple times per second (once per frame).  

2. transform is a reference to the GameObject's Transform Component.  

3. Rotate() is a function contained in the Transform Component.  

4. The numbers in-between the commas represent the degrees of rotation around each axis of 3D space: X, Y, and Z.  

5. Time.deltaTime is a member of the Time class that evens out movement over one second, so the cube will rotate at the same 

speed no matter how many frames per second your machine is rendering. Therefore, 5 * Time.deltaTime means 5 degrees per 

second.  

With all this in mind, we can read this code as "every frame, rotate this GameObject's Transform component a small amount so that it will 

equal five degrees around the Y axis each second."  

You can access lots of different Components the same way as we accessed transform already. You have to add Components to the 

GameObject using the Component menu. All the Components you can easily access are listed under Variables on the GameObject 

Scripting Reference Page.  

For more information about the relationship between GameObjects, Scripts, and Components, please jump ahead to the GameObjects 

page or Using Components page of this manual.  

The Power of Variables 

Our script so far will always rotate the Cube 5 degrees each second. We might want it to rotate a different number of degrees per second. 

We could change the number and save, but then we have to wait for the script to be recompiled and we have to enter Play mode before we 

see the results. There is a much faster way to do it. We can experiment with the speed of rotation in real-time during Play mode, and it's 

easy to do.  

Instead of typing 5 into the Rotate() function, we will declare a speed variable and use that in the function. Change the script to the 

following code and save it:  

var speed = 5.0; 

 

function Update () { 

    transform.Rotate(0, speed*Time.deltaTime, 0); 

} 

Now select the Cube and look at the Inspector. Notice how our speed variable appears.  
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This variable can now be modified directly in the Inspector, just like renaming a file in the file explorer. Select it, press Return and change 

the value. You can also right- or option-click on the value and drag the mouse up or down. You can change the variable at any time, even 

while the game is running.  

Hit Play and try modifying the speed value. The Cube's rotation speed will change instantly. When you exit Play mode, you'll see that your 

changes are reverted back to their value before entering Play mode. This way you can play, adjust, and experiment to find the best value, 

then apply that value permanently.  

Using this method of changing a variable's value in the Inspector means that you can re-use one script on many objects, each with a 

different variable value. If you attach the script to multiple Cubes, and change the speed of each cube, they will all rotate at different 

speeds even though they use the same script.  

Accessing Other Components 

When writing a script Component, you can access other components on the GameObject from within that script.  

Using the GameObject members 

You can directly access any member of the GameObject class. You can see a list of all the GameObject class members here. If any of the 

indicated classes are attached to the GameObject as a Component, you can access that Component directly through the script by simply 

typing the member name. For example, typing transform is equivalent to gameObject.transform. The gameObject is assumed by the 

compiler, unless you specifically reference a different GameObject.  

Typing this will be accessing the script Component that you are writing. Typing this.gameObject is referring to the GameObject that the 

script is attached to. You can access the same GameObject by simply typing gameObject. Logically, typing this.transform is the same as 

typing transform. If you want to access a Component that is not included as a GameObject member, you have to use 

gameObject.GetComponent() which is explained on the next page.  

There are many Components that can be directly accessed in any script. For example, if you want to access the Translate function of the 

Transform component, you can just write transform.Translate() or gameObject.transform.Translate(). This works because all scripts are 

attached to a GameObject. So when you write transform you are implicitly accessing the Transform Component of the GameObject that is 

being scripted. To be explicit, you write gameObject.transform. There is no advantage in one method over the other, it's all a matter of 

preference for the scripter.  

To see a list of all the Components you can access implicitly, take a look at the GameObject page in the Scripting Reference.  

Using GetComponent() 

There are many Components which are not referenced directly as members of the GameObject class. So you cannot access them 

implicitly, you have to access them explicitly. You do this by calling the GetComponent("component name") and storing a reference to 

the result. This is most common when you want to make a reference to another script attached to the GameObject.  

http://unity3d.com/support/documentation/Components/class-GameObject.html
http://unity3d.com/support/documentation/ScriptReference/GameObject.html
http://unity3d.com/support/documentation/ScriptReference/index.html


Pretend you are writing Script B and you want to make a reference to Script A, which is attached to the same GameObject. You would have 

to use GetComponent() to make this reference. In Script B, you would simply write:  

scriptA = GetComponent("ScriptA");  

Then you would be able access any of the Script A variables by writing scriptA.variableName within Script B. For more help with using 

GetComponent(), take a look at the GetComponent() Script Reference page.  

Where to go from here 

This was just a short introduction on how to use scripts inside the Editor. For more examples, check out the Tutorials that come with Unity. 

You should also read through Scripting Overview inside the Script Reference, which contains a more thorough introduction into scripting 

with Unity plus pointers into the reference itself for in-depth information. If you're really stuck, be sure to visit the Unity Answers or Unity 

Forums and ask questions there. Someone is always willing to help.  
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Asset Store 
The Unity Asset Store is a built in store for buying and downloading assets for your project. The Asset Store contains a constantly growing 

library of free and commercial assets created by Unity users and Unity Technologies.  

The Asset Store contains everything from textures, models, animations up to whole project examples, tutorials and Editor extensions 

directly accessible from a simple interface built directly into the Unity Editor.  

 Accessing the Asset Store  

 Navigating the Asset Store  

 Managing previous downloads and purchases  
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AssetStore-Accessing 
To open the Asset Store window, select Window->AssetStore from the main menu. This will open the Asset Store window. If this is the 

first time you have opened the Asset Store you will be prompted to log in or create a free user account.  
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The Asset Store front page. 
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AssetStore-Navigation 
The Asset Store is navigated using a browser-like interface. Navigation happens either by using the free text search or by browsing through 

featured packages and categories. The Asset Store window contains a tool bar containing navigation buttons and buttons for accessing the 

Asset Store Package manager and to show the current contents of your shopping cart.  

Asset Store Navigation Buttons -- used to move around in browsing history.  

Download Manager and Shopping Cart -- use the Download Manager to manage previously downloaded packages and the shopping cart to see a list of 

packages selected for purchase. 
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AssetStore-DownloadManager 
The Asset Store Download Manager can be used to view packages you have already bought or downloaded from the Asset Store. It also 

lists the all standard packages that are distributed with Unity. To view the Download Manager, click on the Download Manager button in the 

Asset Store tool bar.  



 

The Download Manager. 

In addition to listing packages that have already been fetched from the store, the Download Manager allows you to check for updates and 

redownload any package that you have previously bought or downloaded. You can also use the Download Manager to import downloaded 

packages into your current project.  
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Asset Server 

Unity Asset Server Overview 

The Unity Asset Server is an asset and version control system with a graphical user interface integrated into Unity. It is meant to be used 

by team members working together on a project on different computers either in-person or remotely. The Asset Server is highly optimized 

for handling large binary assets in order to cope with large multi gigabyte project folders. When uploading assets, Import Settings and 

other meta data about each asset is uploaded to the asset server as well. Renaming and moving files is at the core of the system and well 

supported.  

It is available only for Unity Pro, and is an additional license per client. To purchase an Asset Server Client License, please visit the Unity 

store at http://unity3d.com/store  

New to Source Control? 

If you have never used Source Control before, it can be a little unfriendly to get started with any versioning system. Source Control works 

by storing an entire collection of all your assets - meshes, textures, materials, scripts, and everything else - in a database on some kind of 

server. That server might be your home computer, the same one that you use to run Unity. It might be a different computer in your local 

network. It might be a remote machine colocated in a different part of the world. It could even be a virtual machine. There are a lot of 

options, but the location of the server doesn't matter at all. The important thing is that you can access it somehow over your network, and 

that it stores your game data.  

In a way, the Asset Server functions as a backup of your Project Folder. You do not directly manipulate the contents of the Asset Server 

while you are developing. You make changes to your Project locally, then when you are done, you Commit Changes to the Project on the 

Server. This makes your local Project and the Asset Server Project identical.  

Now, when your fellow developers make a change, the Asset Server is identical to their Project, but not yours. To synchronize your local 

Project, you request to Update from Server. Now, whatever changes your team members have made will be downloaded from the server 

to your local Project.  

This is the basic workflow for using the Asset Server. In addition to this basic functionality, the Asset Server allows for rollback to previous 

versions of assets, detailed file comparison, merging two different scripts, resolving conflicts, and recovering deleted assets.  

http://unity3d.com/store


Setting up the Asset Server  

The Asset Server requires a one time server setup and a client configuration for each user. You can read about how to do that in the Asset 

Server Setup page.  

The rest of this guide explains how to deploy, administrate, and regularly use the Asset Server.  

Daily use of the Asset Server 
This section explains the common tasks, workflow and best practices for using the Asset Server on a day-to-day basis.  

Getting Started 

If you are joining a team that has a lot of work stored on the Asset Server already, this is the quickest way to get up and running correctly. If 

you are starting your own project from scratch, you can skip down to the Workflow Fundamentals section.  

1. Create a new empty Project with no packages imported  

2. From the menubar, select Window->Asset Server  

3. Click the Connection button  

4. Enter your user name and password (provided by your Asset Server administrator)  

5. Click Show Projects and select the desired project  

6. Click Connect  

7. Click the Update tab  

8. Click the Update button  

9. If a conflict occurs, discard all local versions  

10. Wait for the update to complete  

11. You are ready to go  

Continue reading for detailed information on how to use the Asset Server effectively every day.  

Workflow Fundamentals 

When using the Asset Server with a multi-person team, it is generally good practice to Update all changed assets from the server when you 

begin working, and Commit your changes at the end of the day, or whenever you're done working. You should also commit changes when 

you have made significant progress on something, even if it is in the middle of the day. Committing your changes regularly and frequently is 

recommended.  

Understanding the Server View 

The Server View is your window into the Asset Server you're connected to. You can open the Server View by selecting "Window->Asset 

Server".  

http://unity3d.com/support/documentation/Components/assetserver-Setup.html
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The Overview tab 

The Server View is broken into tabs: Overview Update, and Commit. Overview will show you any differences between your local project 

and the latest version on the server with options to quickly commit local changes or download the latest updates. Update will show you the 

latest remote changes on the server and allow you to download them to your local project. Commit allows you to create a Changeset and 

commit it to the server for others to download.  

Connecting to the server 

Before you can use the asset server, you must connect to it. To do this you click the Connection button, which takes you to the connection 

screen:  

 

The Asset Server connection screen 

Here you need to fill in:  

1. Server address  

2. Username  

3. Password  

By clicking Show projects you can now see the available projects on the asset server, and choose which one to connect to by clicking 

Connect. Note that the username and password you use can be obtain from your system administrator. Your system administrator created 

accounts when they installed Asset Server.  

Updating from the Server 



To download all updates from the server, select the Update tab from the Overview tab and you will see a list of the latest committed 

Changesets. By selecting one of these you can see what was changed in the project as well as the provided commit message. Click 

Update and you will begin downloading all Changeset updates.  

 

The Update Tab 

Committing Changes to the Server 

When you have made a change to your local project and you want to store those changes on the server, you use the top Commit tab.  

 

The Commit tab 

Now you will be able to see all the local changes made to the project since your last update, and will be able to select which changes you 

wish to upload to the server. You can add changes to the changeset either by manually dragging them into the changeset field, or by using 



the buttons placed below the commit message field. Remember to type in a commit message which will help you when you compare 

versions or revert to an earlier version later on, both of which are discussed below.  

Resolving conflicts 

With multiple people working on the same collection of data, conflicts will inevitably arise. Remember, there is no need to panic! If a conflict 

exists, you will be presented with the Conflict Resolution dialog when updating your project.  

 

The Conflict Resolution screen 

Here, you will be informed of each individual conflict, and be presented with different options to resolve each individual conflict. For any 

single conflict, you can select Skip Asset (which will not download that asset from the server), Discard My Changes (which will completely 

overwrite your local version of the asset) or Ignore Server Changes (which will ignore the changes others made to the asset and after this 

update you will be able to commit your local changes over server ones) for each individual conflict. Additionally, you can select Merge for 

text assets like scripts to merge the server version with the local version.  

If you run into a conflict while you are committing your local changes, Unity will refuse to commit your changes and inform you that a conflict 

exists. To resolve the conflicts, select Update. Your local changes will not automatically be overwritten. At this point you will see the 

Conflict Resolution dialog, and can follow the instructions in the above paragraph.  

Browsing revision history and reverting assets 

The Asset Server retains all uploaded versions of an asset in its database, so you can revert your local version to an earlier version at any 

time. You can either select to restore the entire project or single files. To revert to an older version of an asset or a project, select the 

Overview tab then click Show History listed under Asset Server Actions. You will now see a list of all commits and be able to select and 

restore any file or all project to an older version.  



 

The History dialog 

Here, you can see the version number and added comments with each version of the asset or project. This is one reason why descriptive 

comments are helpful. Select any asset to see its history or Entire Project for all changes made in project. Find revision you need. You can 

either select whole revision or particular asset in revision. Then click Download Selected File to get your local asset replaced with a copy 

of the selected revision. Revert All Project will revert entire project to selected revision.  

Prior to reverting, if there are any differences between your local version and the selected server version, those changes will be lost when 

the local version is reverted.  

If you only want to abandon the changes made to the local copy, you don't have to revert. You can discard those local modifications by 

selecting Discard Changes in the main asset server window. This will immediately download the current version of the project from the 

server to your local Project.  

Comparing asset versions 

If you're curious to see the differences between two particular versions you can explicitly compare them. To do this, open History window, 

select revision and asset you want to compare and press Compare to Local Version. If you need to compare two different revisions of an 

asset - right click on it, in the context menu select Compare to Another Revision then find revision you want to compare to and select it.  

Note: this feature requires that you have one of supported file diff/merge tools installed. Supported tools are:  

 On Windows:  

o TortoiseMerge: part of TortoiseSVN or a separate download from the project site.  

o WinMerge.  

o SourceGear Diff/Merge.  

o Perforce Merge (p4merge): part of Perforce's visual client suite (P4V).  

o TkDiff.  

 On Mac OS X:  

o SourceGear Diff/Merge.  

o FileMerge: part of Apple's XCode development tools.  

o TkDiff.  

o Perforce Merge (p4merge): part of Perforce's visual client suite (P4V).  

Recovering deleted assets 

Deleting a local asset and committing the delete to the server will in fact not delete an asset permanently. Just as any previous version of 

an asset can be restored through History window from the Overview tab.  
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The History dialog 

Expand Deleted Assets item, find and select assets from the list and hit Recover, the selected assets will be downloaded and re-added to 

the local project. If the folder that the asset was located in before the deletion still exists, the asset will be restored to the original location, 

otherwise it will be added to the root of the Assets folder in the local project.  

Asset Server training complete 

You should now be equipped with the knowledge you need to start using the Asset Server effectively. Get to it, and don't forget the good 

workflow fundamentals. Commit changes often, and don't be afraid of losing anything.  
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Behind the Scenes 
Unity automatically imports assets for you and �manages all kinds of metadata for you. How does this all work?  

When you place an Asset like a texture in the Assets folder, Unity will first detect that a new file it doesn't know about has been added. A 

new unique identifier will be given to the asset and Unity will then start importing it. Unity processes every imported asset. When you see a 

texture in the Project View, this is already a processed asset.  

This way you can attach a lot of metadata to an imported asset. For example in the texture's import settings you can tell the texture to use 

mip maps. Photoshop of course doesn't support mip maps, thus the need for metadata. All metadata for each asset is stored in the Library 

folder. As as user, you should never have to manually alter the Library folder.  

In Unity you can organize and move Assets around however you like from the Project View. Unity automatically tracks all movements of 

files and references to other assets. You must move the files inside of Unity. You can easily do this via drag & drop in Project View. But if 

you move an object in the Explorer (Windows) or Finder (OS X), Unity will not detect the move. It will treat it like as if new asset was 

created and another one deleted. Thus if you move an asset in the OS file manager, connections to the asset will be lost.  

The Library folder is critical to your project. Unity manages the Library folder for you automatically. Thus you should never move files 

around in it or touch it. But still it is critical to your project. If you delete it, all your connections to assets will be lost.  

When backing up a project, always back up the project folder-level, containing both the Assets and Library folders!  
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Creating Gameplay 
Unity empowers game designers to make games. What's really special about Unity is that you don't need years of experience with code or 

a degree in art to make fun games. There are a handful of basic workflow concepts needed to learn Unity. Once understood, you will find 

yourself making games in no time. With the time you will save getting your games up and running, you will have that much more time to 

refine, balance, and tweak your game to perfection.  

This section will explain the core concepts you need to know for creating unique, amazing, and fun gameplay. The majority of these 

concepts require you to write Scripts. For an overview of creating and working with Scripts, please read the Scripting page.  

 Instantiating Prefabs at runtime  

 Input  

 Transforms  

 Physics  

 Animation View Guide  

 Animation Scripting  

 Sound  

 Game Interface Elements  

 Networked Multiplayer  
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Instantiating Prefabs 
By this point you should understand the concept of Prefabs at a fundamental level. They are a collection of predefined GameObjects & 

Components that are re-usable throughout your game. If you don't know what a Prefab is, we recommend you read the Prefabs page for a 

more basic introduction.  

Prefabs come in very handy when you want to instantiate complicated GameObjects at runtime. The alternative to instantiating Prefabs is 

to create GameObjects from scratch using code. Instantiating Prefabs has many advantages over the alternative approach:  

 You can instantiate a Prefab from one line of code, with complete functionality. Creating equivalent GameObjects from code takes an 

average of five lines of code, but likely more.  

 You can set up, test, and modify the Prefab quickly and easily in the Scene and Inspector.  

 You can change the Prefab being instanced without changing the code that instantiates it. A simple rocket might be altered into a super-

charged rocket, and no code changes are required.  

Common Scenarios 

To illustrate the strength of Prefabs, let's consider some basic situations where they would come in handy:  

1. Building a wall out of a single "brick" Prefab by creating it several times in different positions.  

2. A rocket launcher instantiates a flying rocket Prefab when fired. The Prefab contains a Mesh, Rigidbody, Collider, and a child 

GameObject with its own trail Particle System.  

3. A robot exploding to many pieces. The complete, operational robot is destroyed and replaced with a wrecked robot Prefab. This 

Prefab would consist of the robot split into many parts, all set up with Rigidbodies and Particle Systems of their own. This 

technique allows you to blow up a robot into many pieces, with just one line of code, replacing one object with a Prefab.  

Building a wall 

This explanation will illustrate the advantages of using a Prefab vs creating objects from code.  
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First, lets build a brick wall from code:  

function Start () { 

    for (var y = 0; y < 5; y++) { 

        for (var x = 0; x < 5; x++) { 

            var cube = GameObject.CreatePrimitive(PrimitiveType.Cube); 

            cube.AddComponent(Rigidbody); 

            cube.transform.position = Vector3 (x, y, 0); 

        } 

    } 

}  

 To use the above script we simply save the script and drag it onto an empty GameObject.  

 Create an empty GameObject with GameObject->Create Empty.  

If you execute that code, you will see an entire brick wall is created when you enter Play Mode. There are two lines relevant to the 

functionality of each individual brick: the CreatePrimitive() line, and the AddComponent() line. Not so bad right now, but each of our 

bricks is un-textured. Every additional action to want to perform on the brick, like changing the texture, the friction, or the Rigidbody mass, 

is an extra line.  

If you create a Prefab and perform all your setup before-hand, you use one line of code to perform the creation and setup of each brick. 

This relieves you from maintaining and changing a lot of code when you decide you want to make changes. With a Prefab, you just make 

your changes and Play. No code alterations required.  

If you're using a Prefab for each individual brick, this is the code you need to create the wall.  

var cube : Transform; 

function Start () { 

    for (var y = 0; y < 5; y++) { 

        for (var x = 0; x < 5; x++) { 

            var cube = Instantiate(cube, Vector3 (x, y, 0), Quaternion.identity); 

        } 

    } 

}  



This is not only very clean but also very reusable. There is nothing saying we are instantiating a cube or that it must contain a rigidbody. All 

of this is defined in the Prefab and can be quickly created in the Editor.  

Now we only need to create the Prefab, which we do in the Editor. Here's how:  

1. Choose GameObject->Create Other->Cube  

2. Choose Component->Physics->Rigidbody  

3. Choose Assets->Create Prefab  

4. In the Project View, change the name of your new Prefab to "Brick"  

5. Drag the cube you created in the Hierarchy onto the "Brick" Prefab in the Project View  

6. With the Prefab created, you can safely delete the Cube from the Hierarchy (Delete on Windows, Command-Backspace on Mac)  

We've created our Brick Prefab, so now we have to attach it to the cube variable in our script. Select the empty GameObject that contains 

the script. Notice that a new variable has appeared in the Inspector, called "cube".  

 

This variable can accept any GameObject or Prefab 

Now drag the "Brick" Prefab from the Project View onto the cube variable in the Inspector. Press Play and you'll see the wall built using the 

Prefab.  

This is a workflow pattern that can be used over and over again in Unity. In the beginning you might wonder why this is so much better, 

because the script creating the cube from code is only 2 lines longer.  

But because you are using a Prefab now, you can adjust the Prefab in seconds. Want to change the mass of all those instances? Adjust 

the Rigidbody in the Prefab only once. Want to use a different Material for all the instances? Drag the Material onto the Prefab only once. 

Want to change friction? Use a different Physic Material in the Prefab's collider. Want to add a Particle System to all those boxes? Add a 

child to the Prefab only once.  

Instantiating rockets & explosions 

Here's how Prefabs fit into this scenario:  

1. A rocket launcher instantiates a rocket Prefab when the user presses fire. The Prefab contains a mesh, Rigidbody, Collider, and a 

child GameObject that contains a trail particle system.  

2. The rocket impacts and instantiates an explosion Prefab. The explosion Prefab contains a Particle System, a light that fades out 

over time, and a script that applies damage to surrounding GameObjects.  

While it would be possible to build a rocket GameObject completely from code, adding Components manually and setting properties, it is far 

easier to instantiate a Prefab. You can instantiate the rocket in just one line of code, no matter how complex the rocket's Prefab is. After 

instantiating the Prefab you can also modify any properties of the instantiated object (e.g. you can set the velocity of the rocket's 

Rigidbody).  



Aside from being easier to use, you can update the prefab later on. So if you are building a rocket, you don't immediately have to add a 

Particle trail to it. You can do that later. As soon as you add the trail as a child GameObject to the Prefab, all your instantiated rockets will 

have particle trails. And lastly, you can quickly tweak the properties of the rocket Prefab in the Inspector, making it far easier to fine-tune 

your game.  

This script shows how to launch a rocket using the Instantiate() function.  

// Require the rocket to be a rigidbody. 

// This way we the user can not assign a prefab without rigidbody 

var rocket : Rigidbody; 

var speed = 10.0; 

 

function FireRocket () { 

    var rocketClone : Rigidbody = Instantiate(rocket, transform.position, transform.rotation); 

    rocketClone.velocity = transform.forward * speed; 

    // You can also acccess other components / scripts of the clone 

    rocketClone.GetComponent(MyRocketScript).DoSomething(); 

} 

 

// Calls the fire method when holding down ctrl or mouse 

function Update () { 

    if (Input.GetButtonDown("Fire1")) { 

        FireRocket(); 

    } 

}  

Replacing a character with a ragdoll or wreck 

Let's say you have a fully rigged enemy character and he dies. You could simply play a death animation on the character and disable all 

scripts that usually handle the enemy logic. You probably have to take care of removing several scripts, adding some custom logic to make 

sure that no one will continue attacking the dead enemy anymore, and other cleanup tasks.  



A far better approach is to immediately delete the entire character and replace it with an instantiated wrecked prefab. This gives you a lot of 

flexibility. You could use a different material for the dead character, attach completely different scripts, spawn a Prefab containing the object 

broken into many pieces to simulate a shattered enemy, or simply instantiate a Prefab containing a version of the character.  

Any of these options can be achieved with a single call to Instantiate(), you just have to hook it up to the right prefab and you're set!  

The important part to remember is that the wreck which you Instantiate() can be made of completely different objects than the original. For 

example, if you have an airplane, you would model two versions. One where the plane consists of a single GameObject with Mesh 

Renderer and scripts for airplane physics. By keeping the model in just one GameObject, your game will run faster since you will be able to 

make the model with less triangles and since it consists of fewer objects it will render faster than using many small parts. Also while your 

plane is happily flying around there is no reason to have it in separate parts.  

To build a wrecked airplane Prefab, the typical steps are:  

1. Model your airplane with lots of different parts in your favorite modeler  

2. Create an empty Scene  

3. Drag the model into the empty Scene  

4. Add Rigidbodies to all parts, by selecting all the parts and choosing Component->Physics->Rigidbody  

5. Add Box Colliders to all parts by selecting all the parts and choosing Component->Physics->Box Collider  

6. For an extra special effect, add a smoke-like Particle System as a child GameObject to each of the parts  

7. Now you have an airplane with multiple exploded parts, they fall to the ground by physics and will create a Particle trail due to the 

attached particle system. Hit Play to preview how your model reacts and do any necessary tweaks.  

8. Choose Assets->Create Prefab  

9. Drag the root GameObject containing all the airplane parts into the Prefab  

var wreck : GameObject; 

 

// As an example, we turn the game object into a wreck after 3 seconds automatically 

function Start () { 

    yield WaitForSeconds(3); 

    KillSelf(); 

} 

 

// Calls the fire method when holding down ctrl or mouse 

function KillSelf () { 

    // Instantiate the wreck game object at the same position we are at 

    var wreckClone = Instantiate(wreck, transform.position, transform.rotation); 

 



    // Sometimes we need to carry over some variables from this object 

    // to the wreck 

    wreckClone.GetComponent(MyScript).someVariable = GetComponent(MyScript).someVariable; 

 

    // Kill ourselves 

    Destroy(gameObject); 

}  

The First Person Shooter tutorial explains how to replace a character with a ragdoll version and also synchronize limbs with the last state of 

the animation. You can find that tutorial on the Tutorials page.  

Placing a bunch of objects in a specific pattern 

Lets say you want to place a bunch of objects in a grid or circle pattern. Traditionally this would be done by either:  

1. Building an object completely from code. This is tedious! Entering values from a script is both slow, unintuitive and not worth the 

hassle.  

2. Make the fully rigged object, duplicate it and place it multiple times in the scene. This is tedious, and placing objects accurately in 

a grid is hard.  

So use Instantiate() with a Prefab instead! We think you get the idea of why Prefabs are so useful in these scenarios. Here's the code 

necessary for these scenarios:  

// Instantiates a prefab in a circle 

 

var prefab : GameObject; 

var numberOfObjects = 20; 

var radius = 5; 

 

function Start () { 

    for (var i = 0; i < numberOfObjects; i++) { 

        var angle = i * Mathf.PI * 2 / numberOfObjects; 

        var pos = Vector3 (Mathf.Cos(angle), 0, Mathf.Sin(angle)) * radius; 

        Instantiate(prefab, pos, Quaternion.identity); 

http://unity3d.com/support/documentation/Manual/Tutorials.html


    } 

}  

// Instantiates a prefab in a grid 

 

var prefab : GameObject; 

var gridX = 5; 

var gridY = 5; 

var spacing = 2.0; 

 

function Start () { 

    for (var y = 0; y < gridY; y++) { 

        for (var x=0;x<gridX;x++) { 

            var pos = Vector3 (x, 0, y) * spacing; 

            Instantiate(prefab, pos, Quaternion.identity); 

        } 

    } 

}  
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Input 
 

Desktop  
 

Note: Keyboard, joystick and gamepad input works only on the desktop version of Unity.  

Unity supports keyboard, joystick and gamepad input.  
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Virtual axes and buttons can be created in the Input Manager, and end users can configure Keyboard input in a nice screen configuration 

dialog.  

 

You can setup joysticks, gamepads, keyboard, and mouse, then access them all through one simple scripting interface.  

From scripts, all virtual axes are accessed by their name.  

Every project has the following default input axes when it's created:  

 Horizontal and Vertical are mapped to w, a, s, d and the arrow keys.  

 Fire1, Fire2, Fire3 are mapped to Control, Option (Alt), and Command, respectively.  

 Mouse X and Mouse Y are mapped to the delta of mouse movement.  

 Window Shake X and Window Shake Y is mapped to the movement of the window.  

Adding new Input Axes 

If you want to add new virtual axes go to the Edit->Project Settings->Input menu. Here you can also change the settings of each axis.  



 

You map each axis to two buttons on a joystick, mouse, or keyboard keys.  

  

Name The name of the string used to check this axis from a script. 

Descriptive Name Positive value name displayed in the input tab of the configuration dialog for standalone builds. 

Descriptive Negative 

Name 

Negative value name displayed in the Input tab of the Configuration dialog for standalone builds. 

Negative Button The button used to push the axis in the negative direction. 

Positive Button The button used to push the axis in the positive direction. 

Alt Negative Button Alternative button used to push the axis in the negative direction. 

Alt Positive Button Alternative button used to push the axis in the positive direction. 

Gravity Speed in units per second that the axis falls toward neutral when no buttons are pressed. 

Dead Size of the analog dead zone. All analog device values within this range result map to neutral. 

Sensitivity Speed in units per second that the the axis will move toward the target value. This is for digital devices only. 

Snap If enabled, the axis value will reset to zero when pressing a button of the opposite direction. 

Invert If enabled, the Negative Buttons provide a positive value, and vice-versa. 

Type The type of inputs that will control this axis. 

Axis The axis of a connected device that will control this axis. 

Joy Num The connected Joystick that will control this axis. 

Use these settings to fine tune the look and feel of input. They are all documented with tooltips in the Editor as well.  



Using Input Axes from Scripts 

You can query the current state from a script like this:  

value = Input.GetAxis ("Horizontal");  

An axis has a value between -1 and 1. The neutral position is 0. This is the case for joystick input and keyboard input.  

However, Mouse Delta and Window Shake Delta are how much the mouse or window moved during the last frame. This means it can be 

larger than 1 or smaller than -1 when the user moves the mouse quickly.  

It is possible to create multiple axes with the same name. When getting the input axis, the axis with the largest absolute value will be 

returned. This makes it possible to assign more than one input device to one axis name. For example, create one axis for keyboard input 

and one axis for joystick input with the same name. If the user is using the joystick, input will come from the joystick, otherwise input will 

come from the keyboard. This way you don't have to consider where the input comes from when writing scripts.  

Button Names 

To map a key to an axis, you have to enter the key's name in the Positive Button or Negative Button property in the Inspector.  

The names of keys follow this convention:  

 Normal keys: "a", "b", "c" ...  

 Number keys: "1", "2", "3", ...  

 Arrow keys: "up", "down", "left", "right"  

 Keypad keys: "[1]", "[2]", "[3]", "[+]", "[equals]"  

 Modifier keys: "right shift", "left shift", "right ctrl", "left ctrl", "right alt", "left alt", "right cmd", "left cmd"  

 Mouse Buttons: "mouse 0", "mouse 1", "mouse 2", ...  

 Joystick Buttons (from any joystick): "joystick button 0", "joystick button 1", "joystick button 2", ...  

 Joystick Buttons (from a specific joystick): "joystick button 0", "joystick button 1", "joystick 1 button 0", ...  

 Special keys: "backspace", "tab", "return", "escape", "space", "delete", "enter", "insert", "home", "end", "page up", "page down"  

 Function keys: "f1", "f2", "f3", ...  

The names used to identify the keys are the same in the scripting interface and the Inspector.  

value = Input.GetKey ("a");  

Mobile Input 
Unity iOS/Android offers you access to the iPhone, iPad and Android input systems via Input and iOS Input scripting interfaces.  

Input provides access to the multi-touch screen, accelerometer and device orientation. iOS Input provides access to geographical location.  

Access to keyboard on mobile devices is provided via the iOS keyboard.  

Multi-Touch Screen 

The iPhone and iPod Touch devices are capable of tracking up to five fingers touching the screen simultaneously. You can retrieve the 

status of each finger touching the screen during the last frame by accessing the Input.touches property array.  

Android devices don't have a unified limit on how many fingers they track. Instead, it varies from device to device and can be anything from 

two-touch on older devices to five fingers on some newer devices.  

Each finger touch is represented by an Input.Touch data structure:  

http://unity3d.com/support/documentation/ScriptReference/Input.html
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fingerId The unique index for a touch. 

position The screen position of the touch. 

deltaPosition The screen position change since the last frame. 

deltaTime Amount of time that has passed since the last state change. 

tapCount The iPhone/iPad screen is able to distinguish quick finger taps by the user. This counter will let you know how 

many times the user has tapped the screen without moving a finger to the sides. Android devices do not count 

number of taps, this field is always 1. 

phase Describes so called "phase" or the state of the touch. It can help you determine if the touch just began, if user 

moved the finger or if he just lifted the finger. 

Phase can be one of the following:  

Began A finger just touched the screen. 

Moved A finger moved on the screen. 

Stationary A finger is touching the screen but hasn't moved since the last frame. 

Ended A finger was lifted from the screen. This is the final phase of a touch. 

Canceled The system cancelled tracking for the touch, as when (for example) the user puts the device to her face or more than five 

touches happened simultaneously. This is the final phase of a touch. 

Following is an example script which will shoot a ray whenever the user taps on the screen:  

var particle : GameObject; 

function Update () { 

 for (var touch : Touch in Input.touches) { 

  if (touch.phase == TouchPhase.Began) { 

   // Construct a ray from the current touch coordinates 

   var ray = Camera.main.ScreenPointToRay (touch.position); 

   if (Physics.Raycast (ray)) { 

    // Create a particle if hit 

    Instantiate (particle, transform.position, transform.rotation); 

   } 

  } 

 } 

} 

Mouse Simulation 

On top of native touch support Unity iOS/Android provides a mouse simulation. You can use mouse functionality from the standard Input 

class.  

http://unity3d.com/support/documentation/ScriptReference/Input.html


Device Orientation 

Unity iOS/Android allows you to get discrete description of the device physical orientation in three-dimensional space. Detecting a change 

in orientation can be useful if you want to create game behaviors depending on how the user is holding the device.  

You can retrieve device orientation by accessing the Input.deviceOrientation property. Orientation can be one of the following:  

Unknown The orientation of the device cannot be determined. For example when device is rotate diagonally. 

Portrait The device is in portrait mode, with the device held upright and the home button at the bottom. 

PortraitUpsideDown The device is in portrait mode but upside down, with the device held upright and the home button at the top. 

LandscapeLeft The device is in landscape mode, with the device held upright and the home button on the right side. 

LandscapeRight The device is in landscape mode, with the device held upright and the home button on the left side. 

FaceUp The device is held parallel to the ground with the screen facing upwards. 

FaceDown The device is held parallel to the ground with the screen facing downwards. 

Accelerometer 

As the mobile device moves, a built-in accelerometer reports linear acceleration changes along the three primary axes in three-dimensional 

space. Acceleration along each axis is reported directly by the hardware as G-force values. A value of 1.0 represents a load of about +1g 

along a given axis while a value of -1.0 represents -1g. If you hold the device upright (with the home button at the bottom) in front of you, 

the X axis is positive along the right, the Y axis is positive directly up, and the Z axis is positive pointing toward you.  

You can retrieve the accelerometer value by accessing the Input.acceleration property.  

The following is an example script which will move an object using the accelerometer:  

var speed = 10.0; 

function Update () { 

 var dir : Vector3 = Vector3.zero; 

 

 // we assume that the device is held parallel to the ground 

 // and the Home button is in the right hand 

 

 // remap the device acceleration axis to game coordinates: 

 //  1) XY plane of the device is mapped onto XZ plane 

 //  2) rotated 90 degrees around Y axis 

 dir.x = -Input.acceleration.y; 

 dir.z = Input.acceleration.x; 

 

http://unity3d.com/support/documentation/ScriptReference/Input-deviceOrientation.html
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 // clamp acceleration vector to the unit sphere 

 if (dir.sqrMagnitude > 1) 

  dir.Normalize(); 

 

 // Make it move 10 meters per second instead of 10 meters per frame... 

 dir *= Time.deltaTime; 

 

 // Move object 

 transform.Translate (dir * speed); 

} 

Low-Pass Filter 

Accelerometer readings can be jerky and noisy. Applying low-pass filtering on the signal allows you to smooth it and get rid of high 

frequency noise.  

The following script shows you how to apply low-pass filtering to accelerometer readings:  

var AccelerometerUpdateInterval : float = 1.0 / 60.0; 

var LowPassKernelWidthInSeconds : float = 1.0; 

 

private var LowPassFilterFactor : float = AccelerometerUpdateInterval / LowPassKernelWidthInSeconds; // tweakable 

private var lowPassValue : Vector3 = Vector3.zero; 

function Start () { 

 lowPassValue = Input.acceleration; 

} 

 

function LowPassFilterAccelerometer() : Vector3 { 

 lowPassValue = Mathf.Lerp(lowPassValue, Input.acceleration, LowPassFilterFactor); 



 return lowPassValue; 

} 

The greater the value of LowPassKernelWidthInSeconds, the slower the filtered value will converge towards the current input 

sample (and vice versa). You should be able to use the LowPassFilter() function instead of avgSamples().  

I'd like as much precision as possible when reading the accelerometer. What should I do? 

Reading the Input.acceleration variable does not equal sampling the hardware. Put simply, Unity samples the hardware at a frequency of 

60Hz and stores the result into the variable. In reality, things are a little bit more complicated -- accelerometer sampling doesn't occur at 

consistent time intervals, if under significant CPU loads. As a result, the system might report 2 samples during one frame, then 1 sample 

during the next frame.  

You can access all measurements executed by accelerometer during the frame. The following code will illustrate a simple average of all the 

accelerometer events that were collected within the last frame:  

var period : float = 0.0; 

var acc : Vector3 = Vector3.zero; 

for (var evnt : iPhoneAccelerationEvent  in iPhoneInput.accelerationEvents) { 

 acc += evnt.acceleration * evnt.deltaTime; 

 period += evnt.deltaTime; 

} 

if (period > 0) 

 acc *= 1.0/period; 

return acc; 

Further Reading 

The Unity mobile input API is originally based on Apple's API. It may help to learn more about the native API to better understand Unity's 

Input API. You can find the Apple input API documentation here:  

 Programming Guide: Event Handling (Apple iPhone SDK documentation)  

 UITouch Class Reference (Apple iOS SDK documentation)  

Note: The above links reference your locally installed iPhone SDK Reference Documentation and will contain native ObjectiveC code. It is 

not necessary to understand these documents for using Unity on mobile devices, but may be helpful to some!  

 

iOS 
 

Device geographical location 

http://unity3d.com/support/documentation/ScriptReference/Input-acceleration.html
/Library/Developer/Shared/Documentation/DocSets/com.apple.adc.documentation.AppleiPhone2_0.iPhoneLibrary.docset/Contents/Resources/Documents/documentation/iPhone/Conceptual/iPhoneOSProgrammingGuide/EventHandling/chapter_8_section_1.html
/Library/Developer/Shared/Documentation/DocSets/com.apple.adc.documentation.AppleiPhone2_0.iPhoneLibrary.docset/Contents/Resources/Documents/documentation/UIKit/Reference/UITouch_Class/Reference/Reference.html
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Device geographical location can be obtained via the iPhoneInput.lastLocation property. Before calling this property you should start 

location service updates using iPhoneSettings.StartLocationServiceUpdates() and check the service status via 

iPhoneSettings.locationServiceStatus. See the scripting reference for details.  

Page last updated: 2011-05-19 

 

 

Transforms 
Transforms are a key Component in every GameObject. They dictate where the GameObject is positioned, how it is rotated, and its 

scale. It is impossible to have a GameObject without a Transform. You can adjust the Transform of any GameObject from the Scene View, 

the Inspector, or through Scripting.  

The remainder of this page's text is from the Transform Component Reference page.  

Transform 
The Transform Component determines the actual Position, Rotation, and Scale of all objects in the scene. Every object has a 

Transform.  

 

The Transform Component is viewable and editable in the Inspector 

Properties 

  

Position Position of the Transform in X, Y, and Z coordinates. 

Rotation Rotation of the Transform around the X, Y, and Z axes, measured in degrees. 

Scale Scale of the Transform along X, Y, and Z axes. Value "1" is the original size (size at which the object was 

imported). 

All properties of a Transform are measured relative to the Transform's parent. If the Transform has no parent, the properties are measured 

relative to World Space.  

Using Transforms 

Transforms are always manipulated in 3D space using X, Y, and Z axes. In Unity, these axes are represented by the colors red, green, and 

blue respectively. Remember: XYZ = RGB.  

http://unity3d.com/support/documentation/ScriptReference/iPhoneInput-lastLocation.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings.StartLocationServiceUpdates.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings-locationServiceStatus.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings.StartLocationServiceUpdates.html
http://unity3d.com/support/documentation/Components/class-Transform.html


 

Color-coded relationship between 3 axes and Transform properties 

Transform Components can be directly manipulated using the Scene View or the Inspector. The Inspector will list the properties stated 

above for easy editing. You can also modify Transforms in your Scene by interacting with them, using the Move, Rotate, and Scale tools. 

These tools are located in the upper left-hand corner of the Unity Editor.  

 

The View, Translate, Rotate, and Scale tools 

The tools will be usable on any object in your scene. Click on the object, and you will see the tool gizmo appear around it. Depending on 

the current tool, the gizmo will look slightly different. Clicking the object will also cause the Transform component to become visible in the 

Inspector. If the Inspector does not display the Transform component or its properties, then you do not have an object highlighted in the 

Scene View.  

 

 

All three Gizmos can be directly edited in Scene View. 

To manipulate the Transform, click and drag on one of the 3 gizmo axes, you'll notice its color changes. As you drag the mouse, you will 

see the object translate, rotate, or scale along the axis. When you release the mouse button, you'll notice that the axis remains selected. 

You can click the middle mouse button and drag the mouse to manipulate the Transform along the selected axis. To access all 3 axes at 

once click and drag the center point of all 3 gizmos.  

 

Any individual axis will become selected when you click on it 

Parenting 



Parenting is one of the most important concepts to understand when using Unity. When a GameObject is a Parent of another GameObject, 

the Child GameObject will move, rotate, and scale exactly as its Parent does. Just like your arms are attached to your body, when you turn 

your body, your arms move because they're attached. Any object can have multiple children, but only one parent.  

You can create a Parent by dragging any GameObject in the Hierarchy View onto another. This will create a Parent-Child relationship 

between the two GameObjects.  

 

A real-world example of a Parent-Child hierarchy. All the GameObjects with arrows to the left are Parents. 

In the above example, we say that the arms are parented to the body, and the hands are parented to the arms. The scenes you make in 

Unity will contain collections of these Transform hierarchies. The topmost parent object is called the Root object. When you move, scale, 

or rotate a parent, all the changes in its Transform are applied to its children as well.  

It is worth pointing out that the Transform values in the Inspector of any Child GameObject are displayed relative to the Parent's Transform 

values. These are also called the Local Coordinates. Through scripting, you can access the Global Coordinates as well as the Local 

Coordinates.  

You can build compound objects by parenting multiple separate objects together, like the skeletal structure of a human ragdoll. You can 

also create small yet effective objects with single parents. For example, if you have a horror game that takes place at night, you can create 

an effective atmosphere with a flashlight. To create this object, you would parent a spotlight Transform to the flashlight Transform. Then, 

any alteration of the flashlight Transform will affect the spotlight, creating a convincing flashlight effect.  

Importance of Scale 

The scale of the Transform determines the difference between the size of your mesh in your modeling application, and the size of your 

mesh in Unity. The mesh's size in Unity (and therefore the Transform's scale) is very important, especially during physics simulation. There 

are 3 factors that can determine the Scale of your object:  

 The size of your mesh in your 3D modeling application.  

 The Mesh Scale Factor setting in the object's Import Settings.  

 The Scale values of your Transform Component.  

Ideally, you should not adjust the Scale of your object in the Transform Component. The best option is to create your models at real-life 

scale, so you won't have to change your Transform's scale. The second-best option is to adjust the scale at which your mesh is imported in 

the Import Settings for your individual mesh. Certain optimizations occur based on the import size, and instantiating an object that has an 



adjusted scale value can decrease performance. For more information, read through the Rigidbody component's section on optimizing 

scale.  

Hints 

 When parenting Transforms, put the parent's location at 0,0,0 before applying the child. This will save you many headaches later.  

 Particle Systems are not affected by the Transforms Scale. In order to scale a Particle System, you need to modify the properties in the 

System's Particle Emitter, Animator and Renderer.  

 If you are using Rigidbodies for physics simulation, there is some important information about the Scale property to be read on the 

Rigidbody page.  

 You can change the colors of the Transform axes (and other UI elements) from the Unity Menu->Preferences->Colors & keys.  

 If you can avoid scaling, do so. Try to have the scales of your object finalized in your 3D modeling application, or in the Import Settings of 

your mesh.  

Page last updated: 2007-11-16 

 

 

Physics 
Unity has NVIDIA PhysX physics engine built-in. This allows for unique emergent behaviour and is generally very cool.  

Basics 

To put an object under physics control, simply add a Rigidbody to it. When you do this, the object will be affected by gravity, and can 

collide with other objects in the world.  

Rigidbodies 

Rigidbodies are physically simulated objects. You use Rigidbodies for things that the player can push around, eg. crates or loose objects, 

or you can move Rigidbodies around directly by adding forces to it by scripting.  

If you move the Transform of a non-Kinematic Rigidbody directly it may not collide correctly with other objects. Instead you should move a 

Rigidbody by applying forces and torque to it. You can also add Joints to rigidbodies to make the behavior more complex. For example, you 

could make a physical door or a crane with a swinging chain.  

You also use Rigidbodies to bring vehicles to life, for example you can make cars using a Rigidbody, 4 Wheel Colliders and a script 

applying wheel forces based on the user's Input.  

You can make airplanes by applying forces to the Rigidbody from a script. Or you can create special vehicles or robots by adding various 

Joints and applying forces via scripting.  

Rigidbodies are most often used in combination with primitive colliders.  

Tips:  

 You should never have a parent and child rigidbody together  

 You should never scale the parent of a rigidbody  

Kinematic Rigidbodies 

A Kinematic Rigidbody is a Rigidbody that has the isKinematic option enabled. Kinematic Rigidbodies are not affected by forces, gravity 

or collisions. They are driven explicitly by setting the position and rotation of the Transform or animating them, yet they can interact with 

other non-Kinematic Rigidbodies.  

http://unity3d.com/support/documentation/Components/class-Rigidbody.html
http://unity3d.com/support/documentation/Components/class-Rigidbody.html
http://unity3d.com/support/documentation/Components/class-Rigidbody.html
http://unity3d.com/support/documentation/Components/class-HingeJoint.html
http://unity3d.com/support/documentation/Components/class-WheelCollider.html
http://unity3d.com/support/documentation/Components/class-InputManager.html
http://unity3d.com/support/documentation/Components/class-BoxCollider.html


Kinematic Rigidbodies correctly wake up other Rigidbodies when they collide with them, and they apply friction to Rigidbodies placed on 

top of them.  

These are a few example uses for Kinematic Rigidbodies:  

1. Sometimes you want an object to be under physics control but in another situation to be controlled explicitly from a script or 

animation. For example you could make an animated character whose bones have Rigidbodies attached that are connected with 

joints for use as a Ragdoll. Most of the time the character is under animation control, thus you make the Rigidbody Kinematic. But 

when he gets hit you want him to turn into a Ragdoll and be affected by physics. To accomplish this, you simply disable the 

isKinematic property.  

2. Sometimes you want a moving object that can push other objects yet not be pushed itself. For example if you have an animated 

platform and you want to place some Rigidbody boxes on top, you should make the platform a Kinematic Rigidbody instead of just 

a Collider without a Rigidbody.  

3. You might want to have a Kinematic Rigidbody that is animated and have a real Rigidbody follow it using one of the available 

Joints.  

Static Colliders 

A Static Collider is a GameObject that has a Collider but not a Rigidbody. Static Colliders are used for level geometry which always stays 

at the same place and never moves around. You can add a Mesh Collider to your already existing graphical meshes (even better use the 

Import Settings Generate Colliders check box), or you can use one of the other Collider types.  

You should never move a Static Collider on a frame by frame basis. Moving Static Colliders will cause an internal recomputation in PhysX 

that is quite expensive and which will result in a big drop in performance. On top of that the behaviour of waking up other Rigidbodies 

based on a Static Collider is undefined, and moving Static Colliders will not apply friction to Rigidbodies that touch it. Instead, Colliders that 

move should always be Kinematic Rigidbodies.  

Character Controllers 

You use Character Controllers if you want to make a humanoid character. This could be the main character in a third person platformer, 

FPS shooter or any enemy characters.  

These Controllers don't follow the rules of physics since it will not feel right (in Doom you run 90 miles per hour, come to halt in one frame 

and turn on a dime). Instead, a Character Controller performs collision detection to make sure your characters can slide along walls, walk 

up and down stairs, etc.  

Character Controllers are not affected by forces but they can push Rigidbodies by applying forces to them from a script. Usually, all 

humanoid characters are implemented using Character Controllers.  

Character Controllers are inherently unphysical, thus if you want to apply real physics - Swing on ropes, get pushed by big rocks - to your 

character you have to use a Rigidbody, this will let you use joints and forces on your character. Character Controllers are always aligned 

along the Y axis, so you also need to use a Rigidbody if your character needs to be able to change orientation in space (for example under 

a changing gravity). However, be aware that tuning a Rigidbody to feel right for a character is hard due to the unphysical way in which 

game characters are expected to behave. Another difference is that Character Controllers can slide smoothly over steps of a specified 

height, while Rigidbodies will not.  

If you parent a Character Controller with a Rigidbody you will get a "Joint" like behavior.  

Rigidbody 
Rigidbodies enable your GameObjects to act under the control of physics. The Rigidbody can receive forces and torque to make your 

objects move in a realistic way. Any GameObject must contain a Rigidbody to be influenced by gravity, act under added forces via scripting, 

or interact with other objects through the NVIDIA PhysX physics engine.  

http://unity3d.com/support/documentation/Components/RigidbodySleeping.html
http://unity3d.com/support/documentation/Components/class-CharacterController.html


 

Rigidbodies allow GameObjects to act under physical influence 

Properties 

  
Mass The weight of the object in kilograms. It is recommended to make masses not more or less than 100 times that 

of other Rigidbodies. 

Drag How much air resistance affects the object when moving from forces. 0 means no air resistance, and infinity 

makes the object stop moving immediately. 

Angular Drag How much air resistance affects the object when rotating from torque. 0 means no air resistance, and infinity 

makes the object stop rotating immediately. 

Use Gravity If enabled, the object is affected by gravity. 

Is Kinematic If enabled, the object will not be driven by the physics engine, and can only be manipulated by its Transform. 

This is useful for moving platforms or if you want to animate a Rigidbody that has a HingeJoint attached. 

Interpolate Try one of the options only if you are seeing jerkiness in your Rigidbody's movement. 

None No Interpolation is applied. 

Interpolate Transform is smoothed based on the Transform of the previous frame. 

Extrapolate Transform is smoothed based on the estimated Transform of the next frame. 

Freeze Rotation If enabled, this GameObject will never rotate based on collisions or forces added via script -- it will only rotate 

when using transform.Rotate(). 

Collision Detection Used to prevent fast moving objects from passing through other objects without detecting collisions. 

Discrete Use Discreet collision detection against all other colliders in the scene. Other colliders will use Discreet collision 

detection when testing for collision against it. Used for normal collisions (This is the default value). 

Continuous Use Discrete collision detection against dynamic colliders (with a rigidbody) and continuous collision detection 

against static MeshColliders (without a rigidbody). Rigidbodies set to Continuous Dynamic will use continuous 

collision detection when testing for collision against this rigidbody. Other rigidbodies will use Discreet Collision 

detection. Used for objects which the Continuous Dynamic detection needs to collide with. (This has a big 

impact on physics performance, leave it set to Discrete, if you don't have issues with collisions of fast objects) 

Continuous Dynamic Use continuous collision detection against objects set to Continuous and Continuous Dynamic Collision. It will 

also use continuous collision detection against static MeshColliders (without a rigidbody). For all other colliders 

it uses discreet collision detection. Used for fast moving objects. 

Constraints Restrictions on the Rigidbody's motion:- 

Freeze Position Stops the Rigidbody moving in the world X, Y and Z axes selectively. 

Freeze Rotation Stops the Rigidbody rotating around the world X, Y and Z axes selectively. 

Details 

Rigidbodies allow your GameObjects to act under control of the physics engine. This opens the gateway to realistic collisions, varied types 

of joints, and other very cool behaviors. Manipulating your GameObjects by adding forces to a Rigidbody creates a very different feel and 

look than adjusting the Transform Component directly. Generally, you shouldn't manipulate the Rigidbody and the Transform of the same 

GameObject - only one or the other.  

The biggest difference between manipulating the Transform versus the Rigidbody is the use of forces. Rigidbodies can receive forces and 

torque, but Transforms cannot. Transforms can be translated and rotated, but this is not the same as using physics. You'll notice the 

distinct difference when you try it for yourself. Adding forces/torque to the Rigidbody will actually change the object's position and rotation of 

the Transform component. This is why you should only be using one or the other. Changing the Transform while using physics could cause 

problems with collisions and other calculations.  



Rigidbodies must be explicitly added to your GameObject before they will be affected by the physics engine. You can add a Rigidbody to 

your selected object from Components->Physics->Rigidbody in the menubar. Now your object is physics-ready; it will fall under gravity 

and can receive forces via scripting, but you may need to add a Collider or a Joint to get it to behave exactly how you want.  

Parenting 

When an object is under physics control, it moves semi-independently of the way its transform parents move. If you move any parents, they 

will pull the Rigidbody child along with them. However, the Rigidbodies will still fall down due to gravity and react to collision events.  

Scripting 

To control your Rigidbodies, you will primarily use scripts to add forces or torque. You do this by calling AddForce() and AddTorque() on 

the object's Rigidbody. Remember that you shouldn't be directly altering the object's Transform when you are using physics.  

Animation 

For some situations, mainly creating ragdoll effects, it is neccessary to switch control of the object between animations and physics. For this 

purpose Rigidbodies can be marked isKinematic. While the Rigidbody is marked isKinematic, it will not be affected by collisions, forces, 

or any other part of physX. This means that you will have to control the object by manipulating the Transform component directly. Kinematic 

Rigidbodies will affect other objects, but they themselves will not be affected by physics. For example, Joints which are attached to 

Kinematic objects will constrain any other Rigidbodies attached to them and Kinematic Rigidbodies will affect other Rigidbodies through 

collisions.  

Colliders 

Colliders are another kind of component that must be added alongside the Rigidbody in order to allow collisions to occur. If two Rigidbodies 

bump into each other, the physics engine will not calculate a collision unless both objects also have a Collider attached. Collider-less 

Rigidbodies will simply pass through each other during physics simulation.  

 

Colliders define the physical boundaries of a Rigidbody 

Add a Collider with the Component->Physics menu. View the Component Reference page of any individual Collider for more specific 

information:  

 Box Collider - primitive shape of a cube  

 Sphere Collider - primitive shape of a sphere  

 Capsule Collider - primitive shape of a capsule  

 Mesh Collider - creates a collider from the object's mesh, cannot collide with another Mesh Collider  

 Wheel Collider - specifically for creating cars or other moving vehicles  

Compound Colliders 

Compound Colliders are combinations of primitive Colliders, collectively acting as a single Collider. They come in handy when you have a 

complex mesh to use in collisions but cannot use a Mesh Collider. To create a Compound Collider, create child objects of your colliding 

object, then add a primitive Collider to each child object. This allows you to position, rotate, and scale each Collider easily and 

independently of one another.  

http://unity3d.com/support/documentation/ScriptReference/Rigidbody.AddForce.html
http://unity3d.com/support/documentation/ScriptReference/Rigidbody.AddTorque.html
http://unity3d.com/support/documentation/ScriptReference/Rigidbody-isKinematic.html
http://unity3d.com/support/documentation/Components/class-Transform.html
http://unity3d.com/support/documentation/Components/class-BoxCollider.html
http://unity3d.com/support/documentation/Components/class-SphereCollider.html
http://unity3d.com/support/documentation/Components/class-CapsuleCollider.html
http://unity3d.com/support/documentation/Components/class-MeshCollider.html
http://unity3d.com/support/documentation/Components/class-WheelCollider.html


 

A real-world Compound Collider setup 

In the above picture, the environment has a Mesh Collider attached. Mesh Colliders work the best for terrain or environments made from 

irregular shapes. The gun_model GameObject has a Rigidbody attached, and multiple primitive Colliders as child GameObjects. When the 

Rigidbody parent is moved around by forces, the child Colliders move along with it. The primitive Colliders will collide with the 

environment's Mesh Collider, and the parent Rigidbody will alter the way it moves based on forces being applied to it and how its child 

Colliders interact with other Colliders in the Scene.  

Mesh Colliders can't normally collide with each other. If a Mesh Collider is marked as Convex, then it can collide with another Mesh 

Collider. The typical solution is to use primitive Colliders for any objects that move, and Mesh Colliders for static background objects.  

Continuous Collision Detection 

Continuous collision detection is a feature to prevent fast-moving colliders from passing each other. This may happen when using normal 

(Discrete) collision detection, when an object is one side of a collider in one frame, and already passed the collider in the next frame. To 

solve this, you can enable continuous collision detection on the rigidbody of the fast-moving object. Set the collision detection mode to 

Continuous to prevent the rigidbody from passing through any static (ie, non-rigidbody) MeshColliders. Set it to Continuous Dynamic to 

also prevent the rigidbody from passing through any other supported rigidbodies with collision detection mode set to Continuous or 

Continuous Dynamic. Continuous collision detection is supported for Box-, Sphere- and CapsuleColliders.  

Use the right size 

The size of the your GameObject's mesh is much more important than the mass of the Rigidbody. If you find that your Rigidbody is not 

behaving exactly how you expect - it moves slowly, floats, or doesn't collide correctly - consider adjusting the scale of your mesh asset. 

Unity's default unit scale is 1 unit = 1 meter, so the scale of your imported mesh is maintained, and applied to physics calculations. For 

example, a crumbling skyscraper is going to fall apart very differently than a tower made of toy blocks, so objects of different sizes should 

be modeled to accurate scale.  

If you are modeling a human make sure he is around 2 meters tall in Unity. To check if your object has the right size compare it to the 

default cube. You can create a cube using GameObject->Create Other->Cube. The cube's height will be exactly 1 meter, so your human 

should be twice as tall.  

If you aren't able to adjust the mesh itself, you can change the uniform scale of a particular mesh asset by selecting it in Project View and 

choosing Assets->Import Settings... from the menubar. Here, you can change the scale and re-import your mesh.  

If your game requires that your GameObject needs to be instantiated at different scales, it is okay to adjust the values of your Transform's 

scale axes. The downside is that the physics simulation must do more work at the time the object is instantiated, and could cause a 

performance drop in your game. This isn't a terrible loss, but it is not as efficient as finalizing your scale with the other two options. Also 

keep in mind that non-uniform scales can create undesirable behaviors when Parenting is used. For these reasons it is always optimal to 

create your object at the correct scale in your modeling application.  

Hints 

 The relative Mass of two Rigidbodies determines how they react when they collide with each other.  



 Making one Rigidbody have greater Mass than another does not make it fall faster in free fall. Use Drag for that.  

 A low Drag value makes an object seem heavy. A high one makes it seem light. Typical values for Drag are between .001 (solid block of 

metal) and 10 (feather).  

 If you are directly manipulating the Transform component of your object but still want physics, attach a Rigidbody and make it Kinematic.  

 If you are moving a GameObject through its Transform component but you want to receive Collision/Trigger messages, you must attach a 

Rigidbody to the object that is moving.  

Constant Force 
Constant Force is a quick utility for adding constant forces to a Rigidbody. This works great for one shot objects like rockets, if you don't 

want it to start with a large velocity but instead accelerate.  

 

A rocket propelled forward by a Constant Force 

Properties 

  

Force The vector of a force to be applied in world space. 

Relative Force The vector of a force to be applied in the object's local space. 

Torque The vector of a torque, applied in world space. The object will begin spinning around this vector. The longer the 

vector is, the faster the rotation. 

Relative Torque The vector of a torque, applied in local space. The object will begin spinning around this vector. The longer the 

vector is, the faster the rotation. 

Details 

To make a rocket that accelerates forward set the Relative Force to be along the positive z-axis. Then use the Rigidbody's Drag property 

to make it not exceed some maximum velocity (the higher the drag the lower the maximum velocity will be). In the Rigidbody, also make 

sure to turn off gravity so that the rocket will always stay on its path.  

Hints 

 To make an object flow upwards, add a Constant Force with the Force property having a positive Y value.  

 To make an object fly forwards, add a Constant Force with the Relative Force property having a positive Z value.  

Sphere Collider 
The Sphere Collider is a basic sphere-shaped collision primitive.  



 

A pile of Sphere Colliders 

Properties 

  

Material Reference to the Physic Material that determines how this Collider interacts with others. 

Is Trigger If enabled, this Collider is used for triggering events, and is ignored by the physics engine. 

Radius The size of the Collider. 

Center The position of the Collider in the object's local space. 

Details 

The Sphere Collider can be resized to uniform scale, but not along individual axes. It works great for falling boulders, ping pong balls, 

marbles, etc.  

 

A standard Sphere Collider  

Colliders work with Rigidbodies to bring physics in Unity to life. Whereas Rigidbodies allow objects to be controlled by physics, Colliders 

allow objects to collide with each other. Colliders must be added to objects independently of Rigidbodies. A Collider does not necessarily 

need a Rigidbody attached, but a Rigidbody must be attached in order for the object to move as a result of collisions.  

When a collision between two Colliders occurs and if at least one of them has a Rigidbody attached, three collision messages are sent out 

to the objects attached to them. These events can be handled in scripting, and allow you to create unique behaviors with or without making 

use of the built-in NVIDIA PhysX engine.  

Triggers 

An alternative way of using Colliders is to mark them as a Trigger, just check the IsTrigger property checkbox in the Inspector. Triggers are 

effectively ignored by the physics engine, and have a unique set of three trigger messages that are sent out when a collision with a Trigger 

occurs. Triggers are useful for triggering other events in your game, like cutscenes, automatic door opening, displaying tutorial messages, 

etc. Use your imagination!  

Be aware that in order for two Triggers to send out trigger events when they collide, one of them must include a Rigidbody as well. For a 

Trigger to collide with a normal Collider, one of them must have a Rigidbody attached. For a detailed chart of different types of collisions, 

see the collision action matrix in the Advanced section below.  

Friction and bouncyness 

http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionStay.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerStay.html


Friction, bouncyness and softness are defined in the Physic Material. The Standard Assets contain the most common physics materials. To 

use one of them click on the Physic Material drop-down and select one, eg. Ice. You can also create your own physics materials and tweak 

all friction values.  

Compound Colliders 

Compound Colliders are combinations of primitive Colliders, collectively acting as a single Collider. They come in handy when you have a 

complex mesh to use in collisions but cannot use a Mesh Collider. To create a Compound Collider, create child objects of your colliding 

object, then add a primitive Collider to each child object. This allows you to position, rotate, and scale each Collider easily and 

independently of one another.  

 

A real-world Compound Collider setup 

In the above picture, the environment has a Mesh Collider attached. Mesh Colliders work the best for terrain or environments made from 

irregular shapes. The gun_model GameObject has a Rigidbody attached, and multiple primitive Colliders as child GameObjects. When the 

Rigidbody parent is moved around by forces, the child Colliders move along with it. The primitive Colliders will collide with the 

environment's Mesh Collider, and the parent Rigidbody will alter the way it moves based on forces being applied to it and how its child 

Colliders interact with other Colliders in the Scene.  

Mesh Colliders can't normally collide with each other. If a Mesh Collider is marked as Convex, then it can collide with another Mesh 

Collider. The typical solution is to use primitive Colliders for any objects that move, and Mesh Colliders for static background objects.  

Hints 

 To add multiple Colliders for an object, create child GameObjects and attach a Collider to each one. This allows each Collider to be 

manipulated independently.  

 You can look at the gizmos in the Scene View to see how the Collider is being calculated on your object.  

 Colliders do their best to match the scale of an object. If you have a non-uniform scale (a scale which is different in each direction), only the 

Mesh Collider can match completely.  

 If you are moving an object through its Transform component but you want to receive Collision/Trigger messages, you must attach a 

Rigidbody to the object that is moving.  

 If you make an explosion, it can be very effective to add a rigidbody with lots of drag and a sphere collider to it in order to push it out a bit 

from the wall it hits.  

Advanced 

Collider combinations 

There are numerous different combinations of collisions that can happen in Unity. Each game is unique, and different combinations may 

work better for different types of games. If you're using physics in your game, it will be very helpful to understand the different basic Collider 

types, their common uses, and how they interact with other types of objects.  

Static Collider 
These are GameObjects that do not have a Rigidbody attached, but do have a Collider attached. These objects should remain still, or 

move very little. These work great for your environment geometry. They will not move if a Rigidbody collides with them.  

http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html


Rigidbody Collider 
These GameObjects contain both a Rigidbody and a Collider. They are completely affected by the physics engine through scripted forces 

and collisions. They might collide with a GameObject that only contains a Collider. These will likely be your primary type of Collider in 

games that use physics.  

Kinematic Rigidbody Collider 
This GameObject contains a Collider and a Rigidbody which is marked IsKinematic. To move this GameObject, you modify its Transform 

Component, rather than applying forces. They're similar to Static Colliders but will work better when you want to move the Collider around 

frequently. There are some other specialized scenarios for using this GameObject.  

This object can be used for circumstances in which you would normally want a Static Collider to send a trigger event. Since a Trigger must 

have a Rigidbody attached, you should add a Rigidbody, then enable IsKinematic. This will prevent your Object from moving from physics 

influence, and allow you to receive trigger events when you want to.  

Kinematic Rigidbodies can easily be turned on and off. This is great for creating ragdolls, when you normally want a character to follow an 

animation, then turn into a ragdoll when a collision occurs, prompted by an explosion or anything else you choose. When this happens, 

simply turn all your Kinematic Rigidbodies into normal Rigidbodies through scripting.  

If you have Rigidbodies come to rest so they are not moving for some time, they will "fall asleep". That is, they will not be calculated during 

the physics update since they are not going anywhere. If you move a Kinematic Rigidbody out from underneath normal Rigidbodies that are 

at rest on top of it, the sleeping Rigidbodies will "wake up" and be correctly calculated again in the physics update. So if you have a lot of 

Static Colliders that you want to move around and have different object fall on them correctly, use Kinematic Rigidbody Colliders.  

Collision action matrix 

Depending on the configurations of the two colliding Objects, a number of different actions can occur. The chart below outlines what you 

can expect from two colliding Objects, based on the components that are attached to them. Some of the combinations only cause one of 

the two Objects to be affected by the collision, so keep the standard rule in mind - physics will not be applied to objects that do not have 

Rigidbodies attached.  

Collision detection occurs and messages are sent upon collision 

  Static Collider Rigidbody Collider Kinematic  

Rigidbody Collider 

Static  

Trigger Collider 

Rigidbody  

Trigger Collider 

Kinematic Rigidbody  

Trigger Collider 

Static Collider   Y         

Rigidbody Collider Y Y Y       

Kinematic Rigidbody Collider   Y         

Static Trigger Collider             

Rigidbody Trigger Collider             

Kinematic Rigidbody Trigger Collider             

Trigger messages are sent upon collision 

  Static Collider Rigidbody Collider Kinematic  

Rigidbody Collider 

Static  

Trigger Collider 

Rigidbody  

Trigger Collider 

Kinematic Rigidbody  

Trigger Collider 

Static Collider         Y Y 

Rigidbody Collider       Y Y Y 

Kinematic Rigidbody Collider       Y Y Y 

Static Trigger Collider   Y Y   Y Y 

Rigidbody Trigger Collider Y Y Y Y Y Y 

Kinematic Rigidbody Trigger Collider Y Y Y Y Y Y 

Layer-Based Collision Detection 

In Unity 3.x we introduce something called Layer-Based Collision Detection, and is that you can now selectively tell Unity GameObjects 

to collide with specific layers they are attached to. For more info, you can click here  

Box Collider 
The Box Collider is a basic cube-shaped collision primitive.  

http://unity3d.com/support/documentation/Components/class-Transform.html
http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html
http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html


 

A pile of Box Colliders 

Properties 

  

Material Reference to the Physic Material that determines how this Collider interacts with others. 

Is Trigger If enabled, this Collider is used for triggering events, and is ignored by the physics engine. 

Size The size of the Collider in the X, Y, Z directions. 

Center The position of the Collider in the object's local space. 

Details 

The Box Collider can be resized into different shapes of rectangular prisms. It works great for doors, walls, platforms, etc. It is also effective 

as a human torso in a ragdoll or as a car hull in a vehicle. Of course, it works perfectly for just boxes and crates as well!  

 

A standard Box Collider 

Colliders work with Rigidbodies to bring physics in Unity to life. Whereas Rigidbodies allow objects to be controlled by physics, Colliders 

allow objects to collide with each other. Colliders must be added to objects independently of Rigidbodies. A Collider does not necessarily 

need a Rigidbody attached, but a Rigidbody must be attached in order for the object to move as a result of collisions.  

When a collision between two Colliders occurs and if at least one of them has a Rigidbody attached, three collision messages are sent out 

to the objects attached to them. These events can be handled in scripting, and allow you to create unique behaviors with or without making 

use of the built-in NVIDIA PhysX engine.  

Triggers 

An alternative way of using Colliders is to mark them as a Trigger, just check the IsTrigger property checkbox in the Inspector. Triggers are 

effectively ignored by the physics engine, and have a unique set of three trigger messages that are sent out when a collision with a Trigger 

occurs. Triggers are useful for triggering other events in your game, like cutscenes, automatic door opening, displaying tutorial messages, 

etc. Use your imagination!  

http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionStay.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerStay.html


Be aware that in order for two Triggers to send out trigger events when they collide, one of them must include a Rigidbody as well. For a 

Trigger to collide with a normal Collider, one of them must have a Rigidbody attached. For a detailed chart of different types of collisions, 

see the collision action matrix in the Advanced section below.  

Friction and bouncyness 

Friction, bouncyness and softness are defined in the Physic Material. The Standard Assets contain the most common physics materials. To 

use one of them click on the Physic Material drop-down and select one, eg. Ice. You can also create your own physics materials and tweak 

all friction values.  

Mesh Collider 
The Mesh Collider takes a Mesh Asset and builds its Collider based on that mesh. It is far more accurate for collision detection than using 

primitives for complicated meshes. Mesh Colliders that are marked as Convex can collide with other Mesh Colliders.  

 

A Mesh Collider used on level geometry 

Properties 

  
Material Reference to the Physic Material that determines how this Collider interacts with others. 

Is Trigger If enabled, this Collider is used for triggering events, and is ignored by the physics engine. 

Mesh Reference to the Mesh to use for collisions. 

Smooth Sphere 

Collisions 

When this is enabled, collision mesh normals are smoothed. You should enable this on smooth surfaces eg. 

rolling terrain without hard edges to make sphere rolling smoother. 

Convex If enabled, this Mesh Collider will collide with other Mesh Colliders. Convex Mesh Colliders are limited to 255 

triangles. 

Details 

The Mesh Collider builds its collision representation from the Mesh attached to the GameObject, and reads the properties of the attached 

Transform to set its position and scale correctly.  

Collision meshes use backface culling. If an object collides with a mesh that will be backface culled graphically it will also not collide with it 

physically.  

There are some limitations when using the Mesh Collider. Usually, two Mesh Colliders cannot collide with each other. All Mesh Colliders 

can collide with any primitive Collider. If your mesh is marked as Convex, then it can collide with other Mesh Colliders.  

Colliders work with Rigidbodies to bring physics in Unity to life. Whereas Rigidbodies allow objects to be controlled by physics, Colliders 

allow objects to collide with each other. Colliders must be added to objects independently of Rigidbodies. A Collider does not necessarily 

need a Rigidbody attached, but a Rigidbody must be attached in order for the object to move as a result of collisions.  

When a collision between two Colliders occurs and if at least one of them has a Rigidbody attached, three collision messages are sent out 

to the objects attached to them. These events can be handled in scripting, and allow you to create unique behaviors with or without making 

use of the built-in NVIDIA PhysX engine.  

http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/Components/class-Mesh.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/Components/class-Mesh.html
http://unity3d.com/support/documentation/Components/class-Transform.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionStay.html


Triggers 

An alternative way of using Colliders is to mark them as a Trigger, just check the IsTrigger property checkbox in the Inspector. Triggers are 

effectively ignored by the physics engine, and have a unique set of three trigger messages that are sent out when a collision with a Trigger 

occurs. Triggers are useful for triggering other events in your game, like cutscenes, automatic door opening, displaying tutorial messages, 

etc. Use your imagination!  

Be aware that in order for two Triggers to send out trigger events when they collide, one of them must include a Rigidbody as well. For a 

Trigger to collide with a normal Collider, one of them must have a Rigidbody attached. For a detailed chart of different types of collisions, 

see the collision action matrix in the Advanced section below.  

Friction and bouncyness 

Friction, bouncyness and softness are defined in the Physic Material. The Standard Assets contain the most common physics materials. To 

use one of them click on the Physic Material drop-down and select one, eg. Ice. You can also create your own physics materials and tweak 

all friction values.  

Hints 

 Mesh Colliders cannot collide with each other unless they are marked as Convex. Therefore, they are most useful for background objects 

like environment geometry.  

 Convex Mesh Colliders must be fewer than 255 triangles.  

 Primitive Colliders are less costly for objects under physics control.  

 When you attach a Mesh Collider to a GameObject, its Mesh property will default to the mesh being rendered. You can change that by 

assigning a different Mesh.  

 To add multiple Colliders for an object, create child GameObjects and attach a Collider to each one. This allows each Collider to be 

manipulated independently.  

 You can look at the gizmos in the Scene View to see how the Collider is being calculated on your object.  

 Colliders do their best to match the scale of an object. If you have a non-uniform scale (a scale which is different in each direction), only the 

Mesh Collider can match completely.  

 If you are moving an object through its Transform component but you want to receive Collision/Trigger messages, you must attach a 

Rigidbody to the object that is moving.  

Physic Material 
The Physic Material is used to adjust friction and bouncing effects of colliding objects.  

To create a Physic Material select Assets->Create->Physic Material from the menu bar. Then drag the Physic Material from the Project 

View onto a Collider in the scene.  

 

The Physic Material Inspector 

Properties 

  

Dynamic Friction The friction used when already moving. Usually a value from 0 to 1. A value of zero feels like ice, a value of 1 

will make it come to rest very quickly unless a lot of force or gravity pushes the object. 

Static Friction The friction used when an object is laying still on a surface. Usually a value from 0 to 1. A value of zero feels 

http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerStay.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html


like ice, a value of 1 will make it very hard to get the object moving. 

Bouncyness How bouncy is the surface? A value of 0 will not bounce. A value of 1 will bounce without any loss of energy. 

Friction Combine Mode How the friction of two colliding objects is combined. 

Average The two friction values are averaged. 

Min The smallest of the two values is used. 

Max The largest of the two values is used. 

Multiply The friction values are multiplied with each other. 

Bounce Combine How the bouncyness of two colliding objects is combined. It has the same modes as Friction Combine Mode 

Friction Direction 2 The direction of anisotropy. Anisotropic friction is enabled if this direction is not zero. Dynamic Friction 2 and 

Static Friction 2 will be applied along Friction Direction 2. 

Dynamic Friction 2 If anisotropic friction is enabled, DynamicFriction2 will be applied along Friction Direction 2. 

Static Friction 2 If anisotropic friction is enabled, StaticFriction2 will be applied along Friction Direction 2. 

Details 

Friction is the quantity which prevents surfaces from sliding off each other. This value is critical when trying to stack objects. Friction comes 

in two forms, dynamic and static. Static friction is used when the object is lying still. It will prevent the object from starting to move. If a 

large enough force is applied to the object it will start moving. At this point Dynamic Friction will come into play. Dynamic Friction will 

now attempt to slow down the object while in contact with another.  

Hints 

 Don't try to use a standard physic material for the main character. Make a customized one and get it perfect.  

Hinge Joint 
The Hinge Joint groups together two Rigidbodies, constraining them to move like they are connected by a hinge. It is perfect for doors, but 

can also be used to model chains, pendulums, etc.  

 

The Hinge Joint Inspector 

Properties 

  

http://unity3d.com/support/documentation/Components/class-Rigidbody.html


Connected Body Optional reference to the Rigidbody that the joint is dependent upon. If not set, the joint connects to the world. 

Anchor The position of the axis around which the body swings. The position is defined in local space. 

Axis The direction of the axis around which the body swings. The direction is defined in local space. 

Use Spring Spring makes the Rigidbody reach for a specific angle compared to its connected body. 

Spring Properties of the Spring that are used if Use Spring is enabled. 

Spring The force the object asserts to move into the position. 

Damper The higher this value, the more the object will slow down. 

Target Position Target angle of the spring. The spring pulls towards this angle measured in degrees. 

Use Motor The motor makes the object spin around. 

Motor Properties of the Motor that are used if Use Motor is enabled. 

Target Velocity The speed the object tries to attain. 

Force The force applied in order to attain the speed. 

Free Spin If enabled, the motor is never used to brake the spinning, only accelerate it. 

Use Limits If enabled, the angle of the hinge will be restricted within the Min & Max values. 

Limits  Properties of the Limits that are used if Use Limits is enabled. 

Min The lowest angle the rotation can go. 

Max The highest angle the rotation can go. 

Min Bounce How much the object bounces when it hits the minimum stop. 

Max Bounce How much the object bounces when it hits the maximum stop. 

Break Force The force that needs to be applied for this joint to break. 

Break Torque The torque that needs to be applied for this joint to break. 

Details 

A single Hinge Joint should be applied to a GameObject. The hinge will rotate at the point specified by the Anchor property, moving 

around the specified Axis property. You do not need to assign a GameObject to the joint's Connected Body property. You should only 

assign a GameObject to the Connected Body property if you want the joint's Transform to be dependent on the attached object's 

Transform.  

Think about how the hinge of a door works. The Axis in this case is up, positive along the Y axis. The Anchor is placed somewhere at the 

intersection between door and wall. You would not need to assign the wall to the Connected Body, because the joint will be connected to 

the world by default.  

Now think about a doggy door hinge. The doggy door's Axis would be sideways, positive along the relative X axis. The main door should 

be assigned as the Connected Body, so the doggy door's hinge is dependent on the main door's Rigidbody.  

Chains 

Multiple Hinge Joints can also be strung together to create a chain. Add a joint to each link in the chain, and attach the next link as the 

Connected Body.  

Hints 

 You do not need to assign a Connected Body to your joint for it to work.  

 Use Break Force in order to make dynamic damage systems. This is really cool as it allows the player to break a door off its hinge by 

blasting it with a rocket launcher or running into it with a car.  

 The Spring, Motor, and Limits properties allow you to fine-tune your joint's behaviors.  

Spring Joint 
The Spring Joint groups together two Rigidbodies, constraining them to move like they are connected by a spring.  



 

The Spring Joint Inspector 

Properties 

  

Connected Body Optional reference to the Rigidbody that the joint is dependent upon. 

Anchor Position in the object's local space (at rest) that defines the center of the joint. This is not the point that the 

object will be drawn toward. 

X Position of the joint's local center along the X axis. 

Y Position of the joint's local center along the Y axis. 

Z Position of the joint's local center along the Z axis. 

Spring Strength of the spring. 

Damper Amount that the spring is reduced when active. 

Min Distance Distances greater than this will not cause the Spring to activate. 

Max Distance Distances less than this will not cause the Spring to activate. 

Break Force The force that needs to be applied for this joint to break. 

Break Torque The torque that needs to be applied for this joint to break. 

Details 

Spring Joints allows a Rigidbodied GameObject to be pulled toward a particular "target" position. This position will either be another 

Rigidbodied GameObject or the world. As the GameObject travels further away from this "target" position, the Spring Joint applies forces 

that will pull it back to its original "target" position. This creates an effect very similar to a rubber band or a slingshot.  

The "target" position of the Spring is determined by the relative position from the Anchor to the Connected Body (or the world) when the 

Spring Joint is created, or when Play mode is entered. This makes the Spring Joint very effective at setting up Jointed characters or objects 

in the Editor, but is harder to create push/pull spring behaviors in runtime through scripting. If you want to primarily control a GameObject's 

position using a Spring Joint, it is best to create an empty GameObject with a Rigidbody, and set that to be the Connected Rigidbody of 

the Jointed object. Then in scripting you can change the position of the Connected Rigidbody and see your Spring move in the ways you 

expect.  

Connected Rigidbody 

You do not need to use a Connected Rigidbody for your joint to work. Generally, you should only use one if your object's position and/or 

rotation is dependent on it. If there is no Connected Rigidbody, your Spring will connect to the world.  

Spring & Damper 

Spring is the strength of the force that draws the object back toward its "target" position. If this is 0, then there is no force that will pull on 

the object, and it will behave as if no Spring Joint is attached at all.  

Damper is the resistance encountered by the Spring force. The lower this is, the springier the object will be. As the Damper is increased, 

the amount of bounciness caused by the Joint will be reduced.  



Min & Max Distance 

If the position of your object falls in-between the Min & Max Distances, then the Joint will not be applied to your object. The position must 

be moved outside of these values for the Joint to activate.  

Hints 

 You do not need to assign a Connected Body to your Joint for it to work.  

 Set the ideal positions of your Jointed objects in the Editor prior to entering Play mode.  

 Spring Joints require your object to have a Rigidbody attached.  

 

iOS 
 

iOS physics optimization hints can be found here.  
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Animation 
The Animation View in Unity allows you create and modify Animation Clips directly inside Unity. It is meant to be a powerful and easy 

tool that can supplement external 3D animation programs or even be used instead. It is great for creating simple Animation Clips, and has 

the added benefits of being able to animate variables of materials and components, and add Animation Events to Animation Clips that can 

call script functions at specific points in time.  

For information about importing animations from external programs see the page about Animation import. For information about animating 

characters through scripting see the page about Animation Scripting.  

This Animation View Guide is broken up into different pages that focus on different areas of the Animation View itself. Please visit the 

following pages to build comprehensive knowledge about using the Animation View.  

Using the Animation View 

 

javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
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http://unity3d.com/support/documentation/Manual/iphone-Optimizing-Physics.html
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http://unity3d.com/support/documentation/Components/animeditor-UsingAnimationEditor.html
javascript:ShowHideDiv('iosRef','specific-ios', 'iOS');
http://unity3d.com/support/documentation/Components/animeditor-UsingAnimationEditor.html


This section covers the most basic information about using the Animation View. This includes creating Animations Clips and how to edit 

them using the Animation Mode.  

Using Animation Curves 

 

This section covers how to add Animation Curves directly in the Animation View. This includes creating Animation Curves, creating and 

moving keyframes, setting WrapModes, and tips on all the things can be done with Animation Curves.  

Editing Curves 

 

This section covers how to edit Animation Curves directly in the Animation View. This includes efficient navigation, creating and moving 

keys, and editing tangents and tangent types.  

Objects with Multiple Moving Parts 

http://unity3d.com/support/documentation/Components/animeditor-AnimationCurves.html
http://unity3d.com/support/documentation/Components/EditingCurves.html
http://unity3d.com/support/documentation/Components/animeditor-MultipleParts.html
http://unity3d.com/support/documentation/Components/animeditor-AnimationCurves.html
http://unity3d.com/support/documentation/Components/animeditor-AnimationCurves.html


 

This section covers how to animate Game Objects with multiple moving parts and how to handle cases where there is more than one 

Animation Component that can control the selected Game Object.  

Using Animation Events 

 

This section covers how to add Animation Events to an Animation Clip. Animation Events lets you call a script function similar to 

SendMessage as part of playing back an animation.  
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Animation Scripting 
Unity's Animation System allows you to create beautifully animated skinned characters. The Animation System supports animation 

blending, mixing, additive animations, walk cycle time synchronization, animation layers, control over all aspects of the animation playback 

(time, speed, blend-weights), mesh skinning with 1, 2 or 4 bones per vertex as well as supporting physically based rag-dolls and procedural 

animation. To obtain the best results, it is recommended that you read about the best practices and techniques for creating a rigged 

character with optimal performance in Unity on the Modeling Optimized Characters page.  

Making an animated character involves two things; moving them through the world and animating them accordingly. If you want to learn 

more about moving characters around, take a look at the Character Controller page. This page focuses on the animation. The actual 

animating of characters is done through Unity's scripting interface.  

http://unity3d.com/support/documentation/Components/animeditor-AnimationEvents.html
http://unity3d.com/support/documentation/Manual/Modeling%20Optimized%20Characters.html
http://unity3d.com/support/documentation/Components/class-CharacterController.html
http://unity3d.com/support/documentation/Components/animeditor-MultipleParts.html
http://unity3d.com/support/documentation/Components/animeditor-AnimationEvents.html


You can download example demos showing pre-setup animated characters. Once you have learned the basics on this page you can also 

see the animation script interface.  

If you like, quickly jump to one of the topics covered on this page:  

 Animation Blending  

 Animation Layers  

 Animation Mixing  

 Additive Animation  

 Procedural Animation  

 Animation Playback and Sampling  

Animation Blending 

In today's games, animation blending is an essential feature to ensure that characters have smooth animations. Animators create separate 

animations, e.g. a walk cycle, run cycle, idle animation or shoot animation. At any point in time in your game you need to be able to 

transition from the idle animation into the walk cycle and vice versa. Of course you don't want any sudden jumps in the motion, you want 

the animation to smoothly transition.  

This is where animation blending comes in. In Unity you can have an arbitrary amount of animations playing on the same character. All 

animations are blended or added together to generate the final animation.  

Our first step will be to make a character smoothly blend between the idle and walk animations. In order to make our job simpler when 

scripting, we will first set the Wrap Mode of the animation to Loop. Then we will turn off Play Automatically to make sure our script is the 

only one playing animations.  

Our first script for animating the character is quite simple; we only need some way to detect how fast our character is moving, and then fade 

between walk and idle animation. For this simple test we use the pre-setup input axes.  

function Update () { 

   if (Input.GetAxis("Vertical") > 0.2) 

       animation.CrossFade ("walk"); 

   else 

      animation.CrossFade ("idle"); 

}  

To get this script running:  

1. Create a javascript using Assets->Create Other->Javascript.  

2. Copy & Paste the code into it  

3. Drag the script onto the character (It needs to be the same GameObject as the animation)  

When you hit the Play button, the character will start walking in place when you hold the up arrow key and return to the idle pose when you 

release it.  

Animation Layers 

Layers are an incredibly useful concept that allow you to group animations and prioritize weighting.  

http://www.unity3d.com/examples/
http://unity3d.com/support/documentation/ScriptReference/Animation.html
http://unity3d.com/support/documentation/printable.html#AnimBlend
http://unity3d.com/support/documentation/printable.html#AnimLayers
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http://unity3d.com/support/documentation/printable.html#Procedural
http://unity3d.com/support/documentation/printable.html#Playback


In Unity's animation system, you can blend between as many animation clips as you want. You can assign blend weights manually or 

simply use animation.CrossFade(), which will animate the weight automatically.  

Blend weights are always normalized before being applied 

Let's say you have a walk cycle and a run cycle, both have a weight of 1 (100%). When Unity generates the final animation it will normalize 

the weights, which means walk will contribute 50% to the animation, the run cycle will also contribute 50%.  

This is all very nice, but often you want to prioritize which animation receives most weight when there are two animations playing. Surely 

you could just make sure that the weight sums up to 100% manually, but it is a lot easier to use layers for this purpose.  

Layering Example 

As an example, you might have a shoot animation, an idle and a walk cycle. You will want to continously fade between the walk and idle 

animation based on the player's speed. But when the player shoots you want to only show the shoot animation. Thus the shoot animation 

essentially has a higher priority.  

The easiest way to do this is to simply keep playing the walk and idle animations while shooting. Then we need to make sure that the shoot 

animation is in a higher layer than idle and walk. This means the shoot animation will receive blend weights first. The walk and idle 

animation will receive weights only if the shoot animation doesn't use all of the 100% blend weights. So when CrossFading the shoot 

animation in, the weight will start out at zero and over a short period become 100%. In the beginning the walk and idle layer will still receive 

blend weights but when the shoot animation is completely faded in, they will receive no weights at all. This is exactly what we need!  

function Start () { 

   // Set all animations to loop 

   animation.wrapMode = WrapMode.Loop; 

   // except shooting 

   animation["shoot"].wrapMode = WrapMode.Once; 

 

   // Put idle and walk into lower layers (The default layer is always 0) 

   // This will do two things 

   // - Since shoot and idle/walk are in different layers they will not affect 

   //   each other's playback when calling CrossFade. 

   // - Since shoot is in a higher layer, the animation will replace idle/walk 

   //   animations when faded in. 

   animation["shoot"].layer = 1; 

 



   // Stop animations that are already playing 

   //(In case user forgot to disable play automatically) 

   animation.Stop(); 

} 

 

function Update () { 

   // Based on the key that is pressed, 

   // play the walk animation or the idle animation 

   if (Mathf.Abs(Input.GetAxis("Vertical")) > 0.1) 

      animation.CrossFade("walk"); 

   else 

      animation.CrossFade("idle"); 

 

   // Shoot 

   if (Input.GetButtonDown ("Fire1")) 

      animation.CrossFade("shoot"); 

}  

By default the animation.Play() and animation.CrossFade() will stop or fade out animations that are in the same layer. This is exactly 

what we want in most cases. In our shoot, idle, run example, playing idle and run will not affect the shoot animation and vice versa (you can 

change this behavior with an optional parameter to animation.CrossFade if you like).  

Animation Mixing 

Animation mixing allow you to cut down on the number of animations you have to create for your game by having some animations apply to 

part of the body only. This means such animations can be used together with other animations in various combinations.  

You add an animation mixing transform to an animation by calling AddMixingTransform() on the given AnimationState.  

Mixing Example 

For example you might have a hand-waving animation. You might want to play the hand waving animation on a idle character or on a 

walking character. Without animation mixing you would have to create two hand waving animations: One for idle, and one for walking. 

However, if you add the shoulder transform as a mixing transform to the hand waving animation, the hand waving animation will have full 



control only from the shoulder and out. The rest of the body will not be affected by it, and will continue playing the idle or walk animation. 

Thus you only need one hand waving animation.  

/// Adds a mixing transform using a Transform variable 

var shoulder : Transform; 

animation["wave_hand"].AddMixingTransform(shoulder); 

Another example using a path.  

function Start () { 

   // Adds a mixing transform using a path instead 

   var mixTransform : Transform = transform.Find("root/upper_body/left_shoulder"); 

   animation["wave_hand"].AddMixingTransform(mixTransform); 

} 

Additive Animations 

Additive Animations and Animation mixing allow you to cut down on the number of animations you have to create for your game, and are 

important for creating facial animations.  

Let's say you want to create a character that leans to the sides when running and turning.  

You already made a walk and run cycle, now you could make individual walk-lean-left, walk-lean-right, run-lean-left, run-lean-right 

animations.  

But that means you just quadrupled the amount of animation work! Creating a huge amount of animations is not feasible. Additive 

animations and Mixing to the rescue!  

Additive Animation Example 

Additive animations allow you to overlay the effects of animation on top of any others that may be playing. When making additive 

animations, Unity will calculate the difference between the first frame in the animation clip and the current frame. Then it will apply this 

difference on top of all other playing animations.  

Now you only have to make a lean-left and lean-right animation. Unity will then layer this animation on top of the walk, idle or run cycle.  

Here is the code to make that happen:  

private var leanLeft : AnimationState; 

private var leanRight : AnimationState; 

 

function Start () { 



   leanLeft = animation["leanLeft"]; 

   leanRight = animation["leanRight"]; 

 

   // Put the leaning animation in a separate layer 

   // So that other calls to CrossFade won't affect it. 

   leanLeft.layer = 10; 

   leanRight.layer = 10; 

 

   // Set the lean animation to be additive 

   leanLeft.blendMode = AnimationBlendMode.Additive; 

   leanRight.blendMode = AnimationBlendMode.Additive; 

 

   // Set the lean animation ClampForever 

   // With ClampForever animations will not stop  

   // automatically when reaching the end of the clip 

   leanLeft.wrapMode = WrapMode.ClampForever; 

   leanRight.wrapMode = WrapMode.ClampForever; 

 

   // Enable the animation and fade it in completely 

   // We don't use animation.Play here because we manually adjust the time 

   // in the Update function. 

   // Instead we just enable the animation and set it to full weight 

   leanRight.enabled = true; 

   leanLeft.enabled = true; 



   leanRight.weight = 1.0; 

   leanLeft.weight = 1.0; 

 

   // For testing just play "walk" animation and loop it 

   animation["walk"].wrapMode = WrapMode.Loop; 

   animation.Play("walk"); 

} 

 

// Every frame just set the normalized time 

// based on how much lean we want to apply 

function Update () { 

   var lean = Input.GetAxis("Horizontal"); 

   // normalizedTime is 0 at the first frame and 1 at the last frame in the clip 

   leanLeft.normalizedTime = -lean; 

   leanRight.normalizedTime = lean; 

}  

Tip: 

When using Additive animations it is critical that you are also playing some other non-additive animation on every transform that is also 

used in the additive animation, otherwise the animations will add on top of the last frame's result. This is most certainly not what you want.  

Procedurally Animating Characters 

Sometimes you want to animate the bones of your character procedurally. For example you might want the head of your character to look 

at a specific point in 3D space. This is best done with a script. Fortunately, Unity makes this very easy. In Unity all bones are just 

Transforms which drive the skinned mesh. Thus you can script bones of a character just like any other GameObject.  

One important thing to know is that the animation system updates the Transforms after the Update() function and before the LateUpdate() 

function is called. Thus if you want to do a LookAt() function you should do that in LateUpdate() to make sure that you are really overriding 

the animation.  

Ragdolls are created in the same way. You simply have to attach Rigidbodies, Character Joints and Capsule Colliders to the different 

bones. This will then physically animate your skinned character.  

Animation Playback and Sampling 



This section explains how animations in Unity are sampled when they are played back by the engine.  

AnimationClips are typically authored at a fixed frame rate. For example, you may create your animation in 3ds Max or Maya at a frame 

rate of 60 frames per second (fps). When importing the animation in Unity, this frame rate will be read by the importer, so the data of the 

imported animation is also sampled at 60 fps.  

However, games typically run at a variable frame rate. The frame rate may be higher on some computers than on others, and it may also 

vary from one second to the next based on the complexity of the view the camera is looking at at any given moment. Basically this means 

that we can make no assumptions about the exact frame rate the game is running at. What this means is that even if an animation is 

authored at 60 fps, it may be played back at a different frame rate, such as 56.72 fps, or 83.14 fps. It can be anything.  

Unity samples animation at this variable frame rate, not at the frame rate they were authored with. Luckily, animations for 3d computer 

graphics do not consist of discrete frames, but rather of continuous curves. These curves are well suited for being sampled at any point in 

time; not just at those points in time that corresponds to one of the original frames. It also means that if the game runs at a higher frame 

rate than the animation was authored with, the animation will actually look smoother and more fluid in the game.  

For most practical purposes, the fact that Unity samples animations at this variable frame rate is not something you need to be concerned 

with. However, if you have gameplay logic that relies on animations that animate transforms or properties into very specific configurations, 

then you need to be aware of it. For example, if you have an animation that rotates an object from 0 to 180 degrees over 30 frames, and 

you want to know from your code when it has reached half way there, you should not do it by having a conditional statement in your code 

that checks if the current rotation is 90 degrees. Because Unity samples the animation according to the variable frame rate of the game, it 

may sample it when the rotation is just below 90 degrees, and the next time right after it reached 90 degrees. If you need to be notified 

when a specific point in an animation is reached, you should use an AnimationEvent instead.  

Note also that as a consequence of the variable frame rate sampling, an animation that is played back using WrapMode.Once may not be 

sampled at the exact time of the last frame. In one frame of the game the animation may be sampled just before the end of the animation, 

and in the next frame the time can have exceeded the length of the animation, so it is disabled and not sampled further. If you absolutely 

need the last frame of the animation to be sampled exactly, you have to use WrapMode.ClampForever. In that case the animation will 

keep sampling the last frame infinitely until you stop the animation yourself.  
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Sound 

Audio Listener 
The Audio Listener acts as a microphone-like device. It receives input from any given Audio Source in the scene and plays sounds 

through the computer speakers. For most applications it makes the most sense to attach the listener to the Main Camera. If an audio 

listener is within the boundaries of a Reverb Zone reverberation is applied to all audible sounds in the scene. (PRO only) Furthermore, 

Audio Effects can be applied to the listener and it will be applied to all audible sounds in the scene.  

http://unity3d.com/support/documentation/Components/animeditor-AnimationEvents.html
http://unity3d.com/support/documentation/Components/class-AudioSource.html
http://unity3d.com/support/documentation/Components/class-Camera.html
http://unity3d.com/support/documentation/Components/class-AudioReverbZone.html
http://unity3d.com/support/documentation/Components/class-AudioEffect.html


 

The Audio Listener, attached to the Main Camera 

Properties 

The Audio Listener has no properties. It simply must be added to work. It is always added to the Main Camera by default.  

Details 

The Audio Listener works in conjunction with Audio Sources, allowing you to create the aural experience for your games. When the Audio 

Listener is attached to a GameObject in your scene, any Sources that are close enough to the Listener will be picked up and output to the 

computer's speakers. Each scene can only have 1 Audio Listener to work properly.  

If the Sources are 3D (see import settings in Audio Clip), the Listener will emulate position, velocity and orientation of the sound in the 3D 

world (You can tweak attenuation and 3D/2D behavior in great detail in Audio Source) . 2D will ignore any 3D processing. For example, if 

your character walks off a street into a night club, the night club's music should probably be 2D, while the individual voices of characters in 

the club should be mono with their realistic positioning being handled by Unity.  

You should attach the Audio Listener to either the Main Camera or to the GameObject that represents the player. Try both to find what suits 

your game best.  

Hints 

 Each scene can only have one Audio Listener.  

 You access the project-wide audio settings using the Audio Manager, found in the Edit->Project Settings->Audio menu.  

 View the Audio Clip Component page for more information about Mono vs Stereo sounds.  

Audio Source 
The Audio Source plays back an Audio Clip in the scene. If the Audio Clip is a 3D clip, the source is played back at a given position and 

will attenuate over distance. The audio can be spread out between speakers (stereo to 7.1) (Spread) and morphed between 3D and 2D 

(PanLevel). This can be controlled over distance with falloff curves. Also, if the listener is within 1 or multiple Reverb Zones, reverberations 

is applied to the source. (PRO only) Individual filters can be applied to each audio source for an even richer audio experience. See Audio 

Effects for more details.  

http://unity3d.com/support/documentation/Components/class-AudioSource.html
http://unity3d.com/support/documentation/Components/class-AudioClip.html
http://unity3d.com/support/documentation/Components/class-AudioSource.html
http://unity3d.com/support/documentation/Components/class-AudioManager.html
http://unity3d.com/support/documentation/Components/class-AudioClip.html
http://unity3d.com/support/documentation/Components/class-AudioClip.html
http://unity3d.com/support/documentation/Components/class-AudioListener.html
http://unity3d.com/support/documentation/Components/class-AudioReverbZone.html
http://unity3d.com/support/documentation/Components/class-AudioEffect.html
http://unity3d.com/support/documentation/Components/class-AudioEffect.html


 

The Audio Source gizmo in the Scene View and its settings in the inspector. 

Properties 

  

Audio Clip Reference to the sound clip file that will be played. 

Mute If enabled the sound will be playing but muted. 

Bypass Effects This Is to quickly "by-pass" filter effects applied to the audio source. An easy way to turn all effects on/off. 

Play On Awake If enabled, the sound will start playing the moment the scene launches. If disabled, you need to start it using 

the Play() command from scripting. 

Loop Enable this to make the Audio Clip loop when it reaches the end. 

Priority Determines the priority of this audio source among all the ones that coexist in the scene. (Priority: 0 = most 

important. 256 = least important. Default = 128.). Use 0 for music tracks to avoid it getting occasionally 

swapped out. 

Volume How loud the sound is at a distance of 1 world unit (1 meter) from the Audio Listener. 

Pitch Amount of change in pitch due to slowdown/speed up of the Audio Clip. Value 1 is normal playback speed. 

3D Sound Settings Settings that are applied to the audio source if the is a 3D Sound. 

Pan Level Sets how much the 3d engine has an effect on the audio source. 

Spread Sets the spread angle to 3d stereo or multichannel sound in speaker space. 

Doppler Level Determines how much doppler effect will be applied to this audio source (if is set to 0, then no effect is applied). 

Min Distance Within the MinDistance, the sound will stay at loudest possible. Outside MinDistance it will begin to attenuate. 

Increase the MinDistance of a sound to make it 'louder' in a 3d world, and decrease it to make it 'quieter' in a 3d 

world. 

Max Distance The distance where the sound stops attenuating at. Beyond this point it will stay at the volume it would be at 

MaxDistance units from the listener and will not attenuate any more. 

Rolloff Mode How fast the sound fades. The higher the value, the closer the Listener has to be before hearing the 

sound.(This is determined by a Graph). 

Logarithmic Rolloff The sound is loud when you are close to the audio source, but when you get away from the object it decreases 

significantly fast. 

Linear Rolloff The more far away from the audio source you go, the less you can hear it. 

Custom Rolloff The sound from the audio source behaves accordingly to how you set the graph of roll offs. 

2D Sound Settings Settings that are applied to the audio source if the is a 3D Sound. 

Pan 2D Sets how much the engine has an effect on the audio source. 



Types of Rolloff 

There are three Rolloff modes: Logarithmic, Linear and Custom Rolloff. The Custom Rolloff can be modified by modifying the volume 

distance curve as described below. If you try to modify the volume distance function when it is set to Logarithmic or Linear, the type will 

automatically change to Custom Rolloff.  

 

Rolloff Modes that an audio source can have. 

Distance Functions 

There are several properties of the audio that can be modified as a function of the distance between the audio source and the audio 

listener.  

Volume: Amplitude(0.0 - 1.0) over distance. 

Pan: Left(-1.0) to Right(1.0) over distance. 

Spread: Angle (degrees 0.0 - 360.0) over distance. 

Low-Pass (only if LowPassFilter is attached to the AudioSource): Cutoff Frequency (22000.0-10.0) over distance.  

 

Distance functions for Volume, Pan, Spread and Low-Pass audio filter. The current distance to the Audio Listener is marked in the graph. 

To modify the distance functions, you can edit the curves directly. For more information, see the guide to Editing Curves.  

Creating Audio Sources 

Audio Sources don't do anything without an assigned Audio Clip. The Clip is the actual sound file that will be played back. The Source is 

like a controller for starting and stopping playback of that clip, and modifying other audio properties.  

To create a new Audio Source:  

1. Import your audio files into your Unity Project. These are now Audio Clips.  

2. Go to GameObject->Create Empty from the menubar.  

3. With the new GameObject selected, select Component->Audio->Audio Source.  

http://unity3d.com/support/documentation/Components/EditingCurves.html


4. Assign the Audio Clip property of the Audio Source Component in the Inspector.  

Note: If you want to create an audio source just for one Audio Clip that you have in the Assets folder, you can drag and drop that Audio 

Clip to the scene view and an Audio Source game object will be created automatically for it.  

Platform specific details 

 

iOS 
 

On mobile platforms compressed audio is encoded as MP3 for speedier decompression. Beware that this compression can remove 

samples at the end of the clip and potentially break a "perfect-looping" clip. Make sure the clip is right on a specific MP3 sample boundary 

to avoid sample clipping (Tools to perform this is widely available). For performance reasons audio clips can be played back using the 

Apple hardware codec. To enable this check the "Use Hardware" checkbox in the import settings. See the Audio Clip documentation for 

more details.  

 

Android 
 

On mobile platforms compressed audio is encoded as MP3 for speedier decompression. Beware that this compression can remove 

samples at the end of the clip and potentially break a "perfect-looping" clip. Make sure the clip is right on a specific MP3 sample boundary 

to avoid sample clipping (Tools to perform this is widely available).  

Audio Clip 
Audio Clips are audio data used by Audio Sources. Unity supports mono, stereo and multi (up to 8) channels audio assets. Unity supports 

importing the following audio file formats: .aif, .wav, .mp3, and .ogg, and the following tracker module file formats: .xm, .mod, .it, and 

.s3m. The tracker module assets works the same way as any other audio assets in Unity except no waveform preview can be rendered to 

the asset import inspector.  

javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
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javascript:ShowHideDiv('iosRef','specific-ios', 'iOS');
javascript:ShowHideDiv('androidRef','specific-android', 'Android');


 

The Audio Clip Inspector 

Properties 

  
Audio Format The specific format that will be used for the sound at runtime. 

Native Larger file size, higher quality. Best for very short sound effects. 

Compressed Smaller file size, lower/variable quality. Best for medium length sound effects and music. 

3D Sound If enabled, the sound will play back in 3D space. Both Mono and Stereo sounds can be played in 3D. 

Force to mono If enabled, the audio clip will be down-mixed to a single channel sound. 

Load Type The way Unity load audio assets runtime. 

Decompress on load Decompress sounds upon load. Use this for smaller compressed sounds to avoid the performance overhead of 

decompressing on the fly. Beware that decompressing sounds on load will use ~10x more memory than 

keeping them compressed in memory, so don't use this for large files. 

Compressed in memory Keep sounds compressed in memory and decompress while playing. This have a slight performance overhead 

(esp. for Ogg/Vorbis compressed files) so only use this for bigger files. 

Stream from disc Stream audio data directly from disc. This uses a fraction of the original sounds size of memory. Use this for 

your music or very long tracks. Depending on the hardware, a general advice is to keep this down to 1-2 

simultaneously streams. 

Compression Amount of Compression to be applied to a Compressed clip. Statistics about file size can be seen beneath the 



slider. It is suggested to drag the slider to a place that leaves the playback "good enough" but still at a small 

enough size to meet your file size/distribution needs. 

Hardware 

Decoding 

(iOS ONLY) Available for compressed audio on iOS devices. Uses Apple's hardware decoder for less CPU intensive 

decompression. Check out Platform Specific details for more info. 

Gapless 

looping 

(Android/iOS ONLY) Use this when compressing a perfect looping audio source file (in a non-compressed PCM format) to 

preserve the loop. Standard MPEG encoders introduce silence around the loop point, which will play as little "click" or "pop". 

Unity handles this smoothly for you. 

Importing Audio Assets 

Unity supports both Compressed and Native Audio. Any type of file (except MP3/Ogg Vorbis) will be initially imported as Native. 

Compressed audio files must be decompressed by the CPU while the game is running, but are smaller in file size. If Stream is checked the 

audio is decompressed on the fly, or else the audio is decompressed entirely upon load. Native PCM formats (WAV, AIFF) have the benefit 

of being higher fidelity without increasing CPU taxation, but create much larger files. Module files (.mod,.it,.s3m..xm) can deliver very high 

quality with an extremely low footprint.  

As a general rule of thumb, Compressed audio(or modules) are best for long files like background music or dialog, and uncompressed is 

better for short sound effects. Tweak the amount of Compression with the compression slider to just before the difference in sound quality 

is noticeable.  

Using 3D Audio 

If an audio clip is marked as a 3D Sound then it will be played back to simulate its position in the game world's 3D space. 3D sounds 

emulate distance and location of sounds by attenuating volume and panning across speakers. Both mono and multiple channel sounds can 

be positioned in 3D. For multiple channel audio, use the spread option on the Audio Source to spread and split out the discrete channels in 

speaker space. Unity offers a variety of options to control and fine-tune the audio behavior in 3D space. Take a look at Audio Source.  

Platform specific details 

 

iOS 
 

On mobile platforms compressed audio is encoded as MP3 for less CPU intensive decompression.  

For performance reasons audio clips can be played back using the Apple hardware codec. To enable this check the "Hardware Decoding" 

checkbox in the Audio Importer. Note that only one hardware audio stream can be decompressed at a time, including the background iPod 

audio.  

If the hardware decoder is not available, the decompression will fall back on the software decoder (on iPhone 3GS or newer Apple's 

software decoder is used over Unity's(FMOD) own decoder).  

 

Android 
 

On mobile platforms compressed audio is encoded as MP3 for less CPU intensive decompression.  
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Game Interface Elements 
To create interface elements for your game, you have some options to choose from. You can use GUI Text and GUI Texture objects, or you 

can use UnityGUI. UnityGUI is the Interface Scripting system introduced in Unity 2.0.  

http://unity3d.com/support/documentation/Components/class-AudioSource.html
http://unity3d.com/support/documentation/Components/class-AudioSource.html
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The rest of this page contains a detailed guide for getting up and running with UnityGUI.  

GUI Scripting Guide 

Overview 

GUI stands for Graphical User Interface. Unity's GUI system is called UnityGUI. UnityGUI allows you to create a huge variety of GUIs 

complete with functionality very quickly and easily. Rather than creating a GUI object, manually positioning it, and then writing a script that 

handles its functionality, you do all of this at once in a small amount of code. This works by creating GUI Controls, which are instantiated, 

positioned, and defined all at once.  

For example, the following code will create a fully functional button from scratch:  

function OnGUI () { 

 if (GUI.Button (Rect (10,10,150,100), "I am a button")) { 

  print ("You clicked the button!"); 

 } 

} 

 

This is the button created by the code above 

Although this example is very simple, there are very powerful and complex techniques available for use in UnityGUI. It is a broad subject, 

and the following sections will help you get up to speed as quickly as possible. This guide can be read straight through, or used as 

reference material.  

UnityGUI Basics 

This section covers the important concepts of UnityGUI, giving you an overview as well as a bunch of working examples you can paste into 

your own projects. UnityGUI is very friendly to play with, so this is a good place to get started.  

http://unity3d.com/support/documentation/Components/gui-Basics.html


Controls 

This section lists every available Control in UnityGUI. It is complete with code examples and images.  

Customization 

Creating functional GUI controls would not be as useful if their appearances couldn't be customized. Thankfully, we've thought of this. All 

controls in UnityGUI can be customized with GUIStyles and GUISkins. This section explains how to use them.  

Layout Modes 

UnityGUI features two ways to arrange your GUIs. You can manually place each control on the screen, or you can use an Automatic Layout 

system which works a lot like HTML tables. Using one system or the other is as simple as using a different class, and you can mix the two 

together. This section explains the functional differences between the two systems, including examples.  

Extending UnityGUI 

UnityGUI is very easy to extend with new Control types. This chapter shows you how to make simple compound controls - complete with 

integration into Unity's event system.  

Extending Unity Editor 

The main Unity editor is written using UnityGUI. It is completely extensible using the same code as you would use for in-game GUI. In 

addition, there are a bunch of Editor specific GUI widgets to help you out when creating custom editor GUI.  
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Networked Multiplayer 
Realtime networking is a complex field, but with Unity we have made it extremely simple to achieve. However, it is still best to understand 

the breadth and depth involved with creating any kind of network game. This section will explain the fundamentals of networking concepts, 

and the Unity-specific executions of these concepts for you to use. If you have never created a network game before it is highly 

recommended that you read this guide in detail before attempting to create one.  

High Level Overview 

This section will outline all the concepts involved in networking. It will serve as an introduction to deeper topics.  

Networking Elements in Unity 

This section of the guide will cover Unity's execution of the ideas discussed above.  

RPC Details 

RPC stands for Remote Procedure Call. It is a way of calling a function on a remote machine. This may be a client calling a function on the 

server, or the server calling a function on all or specific clients, etc. This page explains RPC concepts in detail.  

State Synchronization 

State Synchronization is a method of regularly updating a specific set of data across two or more game instances running on the network.  

Minimizing Bandwidth 

Every choice you make about where and how to share data will affect the bandwidth your game uses. This page will share some details 

about bandwidth usage and how to keep it to a minimum.  

Network View 

Network Views are Components you use to share data across the network. They are extremely important to understand. This page will 

explain them in detail.  

http://unity3d.com/support/documentation/Components/gui-Controls.html
http://unity3d.com/support/documentation/Components/gui-Customization.html
http://unity3d.com/support/documentation/Components/gui-Layout.html
http://unity3d.com/support/documentation/Components/gui-Extending.html
http://unity3d.com/support/documentation/Components/gui-ExtendingEditor.html
http://unity3d.com/support/documentation/Components/net-HighLevelOverview.html
http://unity3d.com/support/documentation/Components/net-UnityNetworkElements.html
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Network Instantiate 

One difficult subject in networking is ownership of an object. Who controls what? Network Instantiation will determine this logic for you. This 

page will explain how to do this. It will also explain the complex alternatives, for situations when you just need more control.  

Master Server 

The Master Server is like a game lobby where servers can advertise their presence to clients. It is also a solution to enabling 

communication from behind a firewall or home network. When needed it makes it possible to use a technique called NAT punchthrough 

(with help from a facilitator) to make sure your players can always connect with each other. This page will explain how to use the Master 

Server.  
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iphone-GettingStarted 

Developing for the iOS 
Building games for devices like the iPhone/iPad requires a different approach than targeting the home PC market. Unlike the PC market, 

your target hardware is standardized and not as fast or powerful as a computer with a dedicated video card. Because of this, you will have 

to approach developing your games for these platforms a little differently. Additionally, the feature set in Unity iOS also differs from that of 

Unity for desktop PCs.  

Setting Up Your Apple Developer Account 

Before you can run Unity iOS games on the actual device, you will need to have your Apple Developer account approved and set up. This 

includes setting up your team, adding your devices, and finalizing your provisioning profiles. All this setup is performed through Apple's 

developer website. Since this is a complex process, we have provided a basic outline of what tasks must be completed before you can run 

code on your iOS devices. However, the best thing to do is follow the instructions step-by-step from Apple's iPhone Developer portal.  

Note: We recommended that you set up your Apple Developer account before proceeding because an Apple Developer account is required 

in order to use Unity iOS to its full potential.  

Access iOS Unique Functionality 

Unity iOS provides a number of new scripting APIs to access multi-touch screen, accelerometer, device geographical location and much 

more. You can find out more about new scripting classes on iOS scripting page.  

Exposing Native C, C++ or Objective-C Code to Scripts 

Unity iOS allows you to call custom native functions written in C, C++ or Objective-C directly from C# scripts. To find out how to bind native 

functions, visit the plugins page.  

Prepare Your Application for In-App Purchases 

Unity iOS runtime allows you to download new content, and you can use this feature to implement in-app purchases. To find out how to 

make your content downloadable, visit the downloadable content page.  

Occlusion Culling 

Unity iOS Advanced includes support for occlusion culling, which is perfect for squeezing high performance out of complex scenes with 

many objects. To learn how occlusion culling works, visit the occlusion culling page.  

Splash Screen Customization 

If you want to customize the splash screen that appears when launching your game on the device, you should visit splash screen 

customization page.  

Troubleshooting 

http://unity3d.com/support/documentation/Components/net-NetworkInstantiate.html
http://unity3d.com/support/documentation/Components/net-MasterServer.html
http://unity3d.com/support/documentation/Manual/iphone-accountsetup.html
http://developer.apple.com/iphone
http://unity3d.com/support/documentation/Manual/iphone-API.html
http://unity3d.com/support/documentation/Manual/Plugins.html
http://unity3d.com/support/documentation/Manual/iphone-Downloadable-Content.html
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http://unity3d.com/support/documentation/Manual/Android%20Splash%20Screen.html
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If your game crashes on a device, please consult the how to troubleshoot on iOS page for a list of common issues and solutions.  

Reporting Crash Bugs on iOS 

We welcome valid bug reports, but please look through the troubleshooting on iOS page first.  

How Unity iOS Differs from Desktop Unity 

Strongly Typed JavaScript 

Dynamic typing in JavaScript is always turned off in Unity iOS. This is the same as adding #pragma strict to your scripts, but it is 

done by default instead. This greatly improves performance (which is especially important on the iPhone/iPad devices). When you launch 

an existing Unity Project, you will receive compiler errors if you are using dynamic typing. You can easily fix them by either using static 

typing for the variables that are causing errors or taking advantage of type interface.  

Terrain Engine 

The terrain engine is not supported on iPhone/iPad devices yet. The terrain engine is built to work with modern PC GPUs and does not 

sensibly scale down to iOS. Using custom low poly meshes and occlusion culling is the best way to create terrains on iOS devices.  

Tree Creator 

The tree creator is not supported on iPhone/iPad devices. The tree creator is built to work with modern PC GPUs and does not sensibly 

scale down to iOS. Using custom hand-made low poly meshes is the best way to create vegetation on iOS devices.  

MP3 Instead of Ogg Vorbis Audio Compression 

For performance reasons, MP3 compression is favored on iPhone/iPad devices. If your project contains audio files with Ogg Vorbis 

compression, they will be re-compressed to MP3 while building for iOS. Consult the audio clip documentation for more information on 

usage of compressed audio for the iPhone.  

PVRTC Instead of DXT Texture Compression 

Unity iOS does not support DXT textures. Instead, PVRTC texture compression is natively supported by iPhone/iPad devices. Consult the 

texture import settings documentation to learn more about iOS texture formats.  

Movie Playback 

Movie Textures are not supported on the iPhone/iPad. Instead, a full-screen streaming playback is provided via scripting functions. To learn 

about supported file formats and scripting API, consult the movie page.  

Further Reading 

 Unity iOS Basics  

 Unity Remote  

 iOS Scripting  

o Input  

o Mobile Keyboard  

o Advanced Unity Mobile Scripting  

o Using .NET API 2.0 compatibility level  

 iOS Hardware Guide  

 Optimizing Performance in iOS.  

o Optimizing Graphics Performance  

 Draw Call Batching  

 Modeling Optimized Characters  

 Rendering Statistics Window  

o Optimizing Physics Performance  

o Optimizing Script Performance  

o Measuring Performance with the Built-in Profiler  

o Tuning Main Loop Performance  

o Optimizing iOS Players build Size  
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 Customizing your Mobile target's Splash screen  

 Trouble Shooting  

 Reporting crash bugs on iOS  
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iphone-basic 
This section covers the most common and important questions that come up when starting to work with iOS.  

Prerequisites 

I've just received iPhone Developer approval from Apple, but I've never developed for iOS before. What do I do first? 

A: Download the SDK, get up and running on the Apple developer site, and set up your team, devices, and provisioning. We've provided a 

basic list of steps to get you started.  

Can Unity-built games run in the iPhone Simulator? 

A: No, but Unity iOS can build to iPad Simulator if you're using the latest SDK. However the simulator itself is not very useful for Unity 

because it does not simulate all inputs from iOS or properly emulate the performance you get on the iPhone/iPad. You should test out 

gameplay directly inside Unity using the iPhone/iPad as a remote control while it is running the Unity Remote application. Then, when you 

are ready to test performance and optimize the game, you publish to iOS devices.  

Unity Features 

How do I work with the touch screen and accelerometer? 

A: In the scripting reference inside your Unity iOS installation, you will find classes that provide the hooks into the device's functionality that 

you will need to build your apps. Consult the Input System page for more information.  

Does iOS support Unity's Terrain Engine? 

A: Terrains are not currently supported in Unity iOS because you need extremely low poly rendering for terrains on iOS. The terrain system 

is not designed for this purpose, and you can do much better by simply implementing extremely low poly terrains.  

My existing particle systems seem to run very slowly on iOS. What should I do? 

A: iOS has relatively low fillrate. If your particles cover a rather large portion of the screen with multiple layers, it will kill iOS performance 

even with the simplest shader. We suggest baking your particle effects into a series of textures off-line. Then, at run-time, you can use 1-2 

particles to display them via animated textures. You can get fairly decent looking effects with a minimum amount of overdraw this way.  

Can I make a game that uses heavy physics? 

A: Physics can be expensive on iOS is it requires a lot of floating point number crunching. You should completely avoid MeshColliders if at 

all possible, but they can be used if they are really necessary. To improve performance, use a low fixed framerate using Edit->Time-

>Fixed Delta Time. A framerate of 10-30 is recommended. Enable rigidbody interpolation to achieve smooth motion while using low 

physics frame rates. In order to achieve completely fluid framerate without oscillations, it is best to pick fixed deltaTime value based on 

the average framerate your game is getting on iOS. Either 1:1 or half the frame rate is recommended. For example, if you get 30 fps, you 

should use 15 or 30 fps for fixed frame rate (0.033 or 0.066)  

Can I access the gallery, music library or the native iPod player in Unity iOS? 

http://unity3d.com/support/documentation/Manual/iphone-accountsetup.html
http://unity3d.com/support/documentation/Manual/iphone-unsupported.html
http://unity3d.com/support/documentation/Manual/Plugins.html#iPhonePlugins
http://unity3d.com/support/documentation/Manual/iphone-Downloadable-Content.html
http://unity3d.com/support/documentation/Manual/Android%20Splash%20Screen.html
http://unity3d.com/support/documentation/Manual/TroubleShooting.html#iPhoneTroubleShooting
http://unity3d.com/support/documentation/Manual/iphone-bugreporting.html
http://unity3d.com/support/documentation/Manual/iphone-accountsetup.html
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A: Yes - if you implement it. Unity iPhone supports the native plugin system, where you can add any feature you need -- including access to 

Gallery, Music library, iPod Player and any other feature that the iOS SDK exposes. Unity iOS does not provide an API for accessing the 

listed features through Unity scripts.  

UnityGUI Considerations 

What kind of performance impact will UnityGUI make on my games? 

A: UnityGUI is fairly expensive when many controls are used. It is ideal to limit your use of UnityGUI to game menus or very minimal GUI 

Controls while your game is running. It is important to note that every object with a script containing an OnGUI() call will require additional 

processor time -- even if it is an empty OnGUI() block. It is best to disable any scripts that have an OnGUI() call if the GUI Controls are 

not being used. You can do this by marking the script as enabled = false.  

Any other tips for using UnityGUI? 

A: Try using GUILayout as little as possible. If you are not using GUILayout at all from one OnGUI() call, you can disable all GUILayout 

rendering using MonoBehaviour.useGUILayout = false; This doubles GUI rendering performance. Finally, use as few GUI 

elements while rendering 3D scenes as possible.  
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unity-remote 
Unity Remote is a software application that makes your iPhone/iPad act as a remote control for your project in Unity. This is useful for rapid 

development when you don't want to compile and deploy your project to device for each change and prefer to use the Editor Game window 

instead.  

Where can I find Unity Remote? 

A functional version of the Unity remote is available to download from the AppStore at no charge. If you prefer to build and deploy the Unity 

remote yourself, you can download the source from the Unity website.  

How do I build Unity Remote? 

This section describes how to build Unity Remote from source code.  

First, download the project source code from the Unity website, and unzip it to your directory of choice. This contains an XCode project that 

you'll launch with XCode and build to install the Unity Remote onto your device.  

Assuming you have already created the provisioning profile and successfully installed iOS apps on your device, you just need to double-

click the UnityRemote.xcodeproj in the UnityRemote folder of your Unity iOS install directory. This will launch XCode where you then click 

"Build and Go". The app should then be installed to your iPhone/iPad. If you have never built and run applications before, we strongly 

recommend that you consider building some of the Apple examples first to familiarize yourself with XCode and iOS.  

Once it is installed, make sure your device is connected via Wi-Fi to the same network as your development machine. Launch the Unity 

Remote on your iPhone/iPad while Unity is running on your computer, and select your computer from the list that appears. Now, whenever 

you enter Play mode in the Editor, your device will act as a remote control that you use for developing and testing your game. You'll be able 

to control the application with the iPhone wirelessly. You will also see a low-res version of the app on the iPhone/iPad itself.  

Note: The Unity iOS editor cannot correctly emulate iPhone/iPad OS and hardware, so you will not get the same behavior (of graphics 

performance, touch responsiveness, sounds playback, etc) that you would on a real device.  

XCode shows strange errors while deploying Unity Remote to my device. What should I do? 

The default Identifier in the Unity Remote project is not compatbile with your provisioning profile. You will have to manually alter this 

Identifier in your XCode project. This Identifier has to match your provisioning profile.  

http://unity3d.com/
http://unity3d.com/


If you have a provisioned AppID with an asterisk on the end (e.g. ######.com.mycompany.*) already, you can skip the rest of this 

paragraph. If you have not created an AppID with an trailing asterisk, then you will have to create one in the Program Portal on Apple's 

iPhone Developer Program. Go to the Program Portal, choose the AppIDs tab, click the Add ID button (in the top right corner) and type your 

usual bundle identifier followed by dot and asterisk (e.g. com.mycompany.*) in the App ID (Bundle Seed ID + Bundle Identifier) field. Add 

the new AppID to you provisioning profile, download and reinstall it. Don't forget to restart XCode afterwards. If you have any trouble, 

consult the Provisioning How-to section on Apple's website.  

 

Don't forget to change the Identifier before you can install the Unity Remote on your device. 

Open the Unity Remote project with XCode. In the menu select Project->Edit Active Target "Unity Remote". This will open a new 

window titled Target "Unity Remote" Info. Select the Properties tab. Change the Identifier property field from com.unity3d.UnityRemote to 

bundle identifier in your AppID followed by "." (dot) followed by "UnityRemote". For example, if your provisioning profile contains 

######.com.mycompany.* AppID, then change the Identifier field to com.mycompany.UnityRemote.  

Next, select Build->Clean all targets in the menu, and compile and install Unity Remote again. You may also need to change Active SDK 

from Simulator to Device - 2.0 | Release. It is OK to select SDK 2.0 even if your device runs a newer OS version.  

I'm getting really poor graphics quality when running my game in UnityRemote. What can I do to improve it? 

When developing game with UnityRemote the game actually runs on your Mac and its visual content is heavily compressed and streamed 

to the device. As a result you see a low-res version of the app on iOS. How the game actually runs on device could be tested by launching 

Build & Run from the Editor menu (File->Build Settings->Build & Run).  

Unity Remote is laggy. Can I improve it? 

Performance of Unity Remote strongly depends on Wi-Fi speed, the quality of your networking hardware, and other side factors. For the 

best experience, create an Ad-Hoc network between your Mac and your iPhone/iPad. Just click the Airport icon on your Mac, chose 

"Create Network", enter a name/password, and click OK. On your iPhone/iPad, choose Settings->Wi-Fi and select the new Wi-Fi network 

you have just created. Remember that an ad-hoc network is really a wireless connection that does not involve a wireless access point. 

Therefore, you will usually not have internet access while using ad-hoc networking.  

Turning Bluetooth off on both on your iPhone/iPad and on Mac should also improve connection quality.  

If you do not need to have game view on iDevice, you can turn image synchronization off in the remote machine list. This will reduce the 

network traffic needed for the Remote to work.  

Unity Remote connection is still poor. 

If you experience this, it can either be due to a problem with the installation or other side factors that prevent Unity Remote from functioning 

properly. Try the following steps and see if the performance improves before moving on to the next:  

1. First of all, you need to check if Bluetooth is turned on. Both, your Mac and iPhone/iPad should have it turned off. Second, delete 

the settings file located at ~/Library/Preferences/com.unity3d.UnityEditoriPhone.plist  

2. Reinstall Unity iOS on your iPhone/iPad.  

3. Reinstall Unity iOS on your Mac.  

4. As a last step, it may be a good idea to hard reset your iPhone/iPad.  

http://developer.apple.com/iphone/manage/provisioningprofiles/howto.action


If you still experience problems, try installing Unity Remote on another iDevice (in another location if possible) and see if it gives you better 

results. There could be problems with RF interference or other software influencing the performance of the wireless adapter performance 

on your Mac or iDevice.  

We have a lot of Wi-Fi networks in our environment, and Unity Remote is unusable. What should we do? 

You can try to speed up input in Unity Remote by sacrificing the appearance of the application on iOS. To do this, go to the source project 

located in your Applications folder, locate the file setup.h file (in UnityRemote/Classes), and try changing some of the enums in there.  

Unity Remote doesn't see my Mac. What should I do? 

 Check if Unity Remote and your Mac are connected to the same wireless network.  

 Check your firewall's settings, router's security settings, and any other hardware/software that may filter packets on your network.  

 Leave Unity Remote running, turn off your Mac's Airport for a minute or two, and turn in on again.  

 Restart both Unity and Unity Remote. Sometimes you also need to cold-restart your iPhone/iPad (hold menu and power buttons).  

 Unity Remote uses the Apple Bonjour service, so check if your Mac has it turned on.  

 Reinstall Unity Remote from the latest Unity iOS package.  

Android Remote 

Please also read about Android Remote.  
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iphone-API 
Unity iOS provides a number of new scripting APIs to access unique device functionality. For cross-platform projects, UNITY_IPHONE is 

defined for conditionally compiling iOS-specific C# code. The following new scripting classes were introduced:  

iPhoneInput Access to multi-touch screen, accelerometer, device orientation and geographical location. 

iPhoneSettings  iOS specific settings, such as screen orientation, dimming and information about device hardware. 

iPhoneKeyboard Support for native on-screen keyboard. 

iPhoneUtils Useful functions for movie playback, anti-piracy protection and vibration. 

Further Reading 

 Input  

 Mobile Keyboard  

 Advanced Unity Mobile Scripting  

 Using .NET API 2.0 compatibility level  
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iphone-Input 
 

Desktop  
 

Note: Keyboard, joystick and gamepad input works only on the desktop version of Unity.  

Unity supports keyboard, joystick and gamepad input.  

http://unity3d.com/support/documentation/Manual/android-remote.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneInput.html
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Virtual axes and buttons can be created in the Input Manager, and end users can configure Keyboard input in a nice screen configuration 

dialog.  

 

You can setup joysticks, gamepads, keyboard, and mouse, then access them all through one simple scripting interface.  

From scripts, all virtual axes are accessed by their name.  

Every project has the following default input axes when it's created:  

 Horizontal and Vertical are mapped to w, a, s, d and the arrow keys.  

 Fire1, Fire2, Fire3 are mapped to Control, Option (Alt), and Command, respectively.  

 Mouse X and Mouse Y are mapped to the delta of mouse movement.  

 Window Shake X and Window Shake Y is mapped to the movement of the window.  

Adding new Input Axes 

If you want to add new virtual axes go to the Edit->Project Settings->Input menu. Here you can also change the settings of each axis.  



 

You map each axis to two buttons on a joystick, mouse, or keyboard keys.  

  

Name The name of the string used to check this axis from a script. 

Descriptive Name Positive value name displayed in the input tab of the configuration dialog for standalone builds. 

Descriptive Negative 

Name 

Negative value name displayed in the Input tab of the Configuration dialog for standalone builds. 

Negative Button The button used to push the axis in the negative direction. 

Positive Button The button used to push the axis in the positive direction. 

Alt Negative Button Alternative button used to push the axis in the negative direction. 

Alt Positive Button Alternative button used to push the axis in the positive direction. 

Gravity Speed in units per second that the axis falls toward neutral when no buttons are pressed. 

Dead Size of the analog dead zone. All analog device values within this range result map to neutral. 

Sensitivity Speed in units per second that the the axis will move toward the target value. This is for digital devices only. 

Snap If enabled, the axis value will reset to zero when pressing a button of the opposite direction. 

Invert If enabled, the Negative Buttons provide a positive value, and vice-versa. 

Type The type of inputs that will control this axis. 

Axis The axis of a connected device that will control this axis. 

Joy Num The connected Joystick that will control this axis. 

Use these settings to fine tune the look and feel of input. They are all documented with tooltips in the Editor as well.  



Using Input Axes from Scripts 

You can query the current state from a script like this:  

value = Input.GetAxis ("Horizontal");  

An axis has a value between -1 and 1. The neutral position is 0. This is the case for joystick input and keyboard input.  

However, Mouse Delta and Window Shake Delta are how much the mouse or window moved during the last frame. This means it can be 

larger than 1 or smaller than -1 when the user moves the mouse quickly.  

It is possible to create multiple axes with the same name. When getting the input axis, the axis with the largest absolute value will be 

returned. This makes it possible to assign more than one input device to one axis name. For example, create one axis for keyboard input 

and one axis for joystick input with the same name. If the user is using the joystick, input will come from the joystick, otherwise input will 

come from the keyboard. This way you don't have to consider where the input comes from when writing scripts.  

Button Names 

To map a key to an axis, you have to enter the key's name in the Positive Button or Negative Button property in the Inspector.  

The names of keys follow this convention:  

 Normal keys: "a", "b", "c" ...  

 Number keys: "1", "2", "3", ...  

 Arrow keys: "up", "down", "left", "right"  

 Keypad keys: "[1]", "[2]", "[3]", "[+]", "[equals]"  

 Modifier keys: "right shift", "left shift", "right ctrl", "left ctrl", "right alt", "left alt", "right cmd", "left cmd"  

 Mouse Buttons: "mouse 0", "mouse 1", "mouse 2", ...  

 Joystick Buttons (from any joystick): "joystick button 0", "joystick button 1", "joystick button 2", ...  

 Joystick Buttons (from a specific joystick): "joystick button 0", "joystick button 1", "joystick 1 button 0", ...  

 Special keys: "backspace", "tab", "return", "escape", "space", "delete", "enter", "insert", "home", "end", "page up", "page down"  

 Function keys: "f1", "f2", "f3", ...  

The names used to identify the keys are the same in the scripting interface and the Inspector.  

value = Input.GetKey ("a");  

Mobile Input 
Unity iOS/Android offers you access to the iPhone, iPad and Android input systems via Input and iOS Input scripting interfaces.  

Input provides access to the multi-touch screen, accelerometer and device orientation. iOS Input provides access to geographical location.  

Access to keyboard on mobile devices is provided via the iOS keyboard.  

Multi-Touch Screen 

The iPhone and iPod Touch devices are capable of tracking up to five fingers touching the screen simultaneously. You can retrieve the 

status of each finger touching the screen during the last frame by accessing the Input.touches property array.  

Android devices don't have a unified limit on how many fingers they track. Instead, it varies from device to device and can be anything from 

two-touch on older devices to five fingers on some newer devices.  

Each finger touch is represented by an Input.Touch data structure:  

http://unity3d.com/support/documentation/ScriptReference/Input.html
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fingerId The unique index for a touch. 

position The screen position of the touch. 

deltaPosition The screen position change since the last frame. 

deltaTime Amount of time that has passed since the last state change. 

tapCount The iPhone/iPad screen is able to distinguish quick finger taps by the user. This counter will let you know how 

many times the user has tapped the screen without moving a finger to the sides. Android devices do not count 

number of taps, this field is always 1. 

phase Describes so called "phase" or the state of the touch. It can help you determine if the touch just began, if user 

moved the finger or if he just lifted the finger. 

Phase can be one of the following:  

Began A finger just touched the screen. 

Moved A finger moved on the screen. 

Stationary A finger is touching the screen but hasn't moved since the last frame. 

Ended A finger was lifted from the screen. This is the final phase of a touch. 

Canceled The system cancelled tracking for the touch, as when (for example) the user puts the device to her face or more than five 

touches happened simultaneously. This is the final phase of a touch. 

Following is an example script which will shoot a ray whenever the user taps on the screen:  

var particle : GameObject; 

function Update () { 

 for (var touch : Touch in Input.touches) { 

  if (touch.phase == TouchPhase.Began) { 

   // Construct a ray from the current touch coordinates 

   var ray = Camera.main.ScreenPointToRay (touch.position); 

   if (Physics.Raycast (ray)) { 

    // Create a particle if hit 

    Instantiate (particle, transform.position, transform.rotation); 

   } 

  } 

 } 

} 

Mouse Simulation 

On top of native touch support Unity iOS/Android provides a mouse simulation. You can use mouse functionality from the standard Input 

class.  

http://unity3d.com/support/documentation/ScriptReference/Input.html


Device Orientation 

Unity iOS/Android allows you to get discrete description of the device physical orientation in three-dimensional space. Detecting a change 

in orientation can be useful if you want to create game behaviors depending on how the user is holding the device.  

You can retrieve device orientation by accessing the Input.deviceOrientation property. Orientation can be one of the following:  

Unknown The orientation of the device cannot be determined. For example when device is rotate diagonally. 

Portrait The device is in portrait mode, with the device held upright and the home button at the bottom. 

PortraitUpsideDown The device is in portrait mode but upside down, with the device held upright and the home button at the top. 

LandscapeLeft The device is in landscape mode, with the device held upright and the home button on the right side. 

LandscapeRight The device is in landscape mode, with the device held upright and the home button on the left side. 

FaceUp The device is held parallel to the ground with the screen facing upwards. 

FaceDown The device is held parallel to the ground with the screen facing downwards. 

Accelerometer 

As the mobile device moves, a built-in accelerometer reports linear acceleration changes along the three primary axes in three-dimensional 

space. Acceleration along each axis is reported directly by the hardware as G-force values. A value of 1.0 represents a load of about +1g 

along a given axis while a value of -1.0 represents -1g. If you hold the device upright (with the home button at the bottom) in front of you, 

the X axis is positive along the right, the Y axis is positive directly up, and the Z axis is positive pointing toward you.  

You can retrieve the accelerometer value by accessing the Input.acceleration property.  

The following is an example script which will move an object using the accelerometer:  

var speed = 10.0; 

function Update () { 

 var dir : Vector3 = Vector3.zero; 

 

 // we assume that the device is held parallel to the ground 

 // and the Home button is in the right hand 

 

 // remap the device acceleration axis to game coordinates: 

 //  1) XY plane of the device is mapped onto XZ plane 

 //  2) rotated 90 degrees around Y axis 

 dir.x = -Input.acceleration.y; 

 dir.z = Input.acceleration.x; 

 

http://unity3d.com/support/documentation/ScriptReference/Input-deviceOrientation.html
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 // clamp acceleration vector to the unit sphere 

 if (dir.sqrMagnitude > 1) 

  dir.Normalize(); 

 

 // Make it move 10 meters per second instead of 10 meters per frame... 

 dir *= Time.deltaTime; 

 

 // Move object 

 transform.Translate (dir * speed); 

} 

Low-Pass Filter 

Accelerometer readings can be jerky and noisy. Applying low-pass filtering on the signal allows you to smooth it and get rid of high 

frequency noise.  

The following script shows you how to apply low-pass filtering to accelerometer readings:  

var AccelerometerUpdateInterval : float = 1.0 / 60.0; 

var LowPassKernelWidthInSeconds : float = 1.0; 

 

private var LowPassFilterFactor : float = AccelerometerUpdateInterval / LowPassKernelWidthInSeconds; // tweakable 

private var lowPassValue : Vector3 = Vector3.zero; 

function Start () { 

 lowPassValue = Input.acceleration; 

} 

 

function LowPassFilterAccelerometer() : Vector3 { 

 lowPassValue = Mathf.Lerp(lowPassValue, Input.acceleration, LowPassFilterFactor); 



 return lowPassValue; 

} 

The greater the value of LowPassKernelWidthInSeconds, the slower the filtered value will converge towards the current input 

sample (and vice versa). You should be able to use the LowPassFilter() function instead of avgSamples().  

I'd like as much precision as possible when reading the accelerometer. What should I do? 

Reading the Input.acceleration variable does not equal sampling the hardware. Put simply, Unity samples the hardware at a frequency of 

60Hz and stores the result into the variable. In reality, things are a little bit more complicated -- accelerometer sampling doesn't occur at 

consistent time intervals, if under significant CPU loads. As a result, the system might report 2 samples during one frame, then 1 sample 

during the next frame.  

You can access all measurements executed by accelerometer during the frame. The following code will illustrate a simple average of all the 

accelerometer events that were collected within the last frame:  

var period : float = 0.0; 

var acc : Vector3 = Vector3.zero; 

for (var evnt : iPhoneAccelerationEvent  in iPhoneInput.accelerationEvents) { 

 acc += evnt.acceleration * evnt.deltaTime; 

 period += evnt.deltaTime; 

} 

if (period > 0) 

 acc *= 1.0/period; 

return acc; 

Further Reading 

The Unity mobile input API is originally based on Apple's API. It may help to learn more about the native API to better understand Unity's 

Input API. You can find the Apple input API documentation here:  

 Programming Guide: Event Handling (Apple iPhone SDK documentation)  

 UITouch Class Reference (Apple iOS SDK documentation)  

Note: The above links reference your locally installed iPhone SDK Reference Documentation and will contain native ObjectiveC code. It is 

not necessary to understand these documents for using Unity on mobile devices, but may be helpful to some!  

 

iOS 
 

Device geographical location 
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/Library/Developer/Shared/Documentation/DocSets/com.apple.adc.documentation.AppleiPhone2_0.iPhoneLibrary.docset/Contents/Resources/Documents/documentation/iPhone/Conceptual/iPhoneOSProgrammingGuide/EventHandling/chapter_8_section_1.html
/Library/Developer/Shared/Documentation/DocSets/com.apple.adc.documentation.AppleiPhone2_0.iPhoneLibrary.docset/Contents/Resources/Documents/documentation/UIKit/Reference/UITouch_Class/Reference/Reference.html
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
javascript:ShowHideDiv('iosRef','specific-ios', 'iOS');


Device geographical location can be obtained via the iPhoneInput.lastLocation property. Before calling this property you should start 

location service updates using iPhoneSettings.StartLocationServiceUpdates() and check the service status via 

iPhoneSettings.locationServiceStatus. See the scripting reference for details.  
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iOS-Keyboard 
Sometimes when developing your game you might need to have access to the keyboard Input that your target platform provides, this is 

done straight forward in unity just by calling some attributes via scripting.  

 

iOS 
 

Using the Keyboard 

GUI Elements 

The keyboard will appear automatically when a user taps on editable GUI elements. Currently, GUI.TextField, GUI.TextArea and 

GUI.PasswordField are capable of automatic handling of keyboard. Please read GUI documentation to find out how to use these.  

Manual Keyboard Handling 

Use the iPhoneKeyboard.Open function to open the keyboard. Please see the iPhoneKeyboard scripting reference for the parameters that 

this function takes.  

Keyboard Type Summary 

The Keyboard supports the following types:  

  
iPhoneKeyboardType.Default Letters. Can be switched to keyboard with numbers and punctuation. 

iPhoneKeyboardType.ASCIICapable Letters. Can be switched to keyboard with numbers and punctuation. 

iPhoneKeyboardType.NumbersAndPunctuation Numbers and punctuation. Can be switched to keyboard with letters. 

iPhoneKeyboardType.URL Letters with slash and .com buttons. Can be switched to keyboard with numbers and 

punctuation. 

iPhoneKeyboardType.NumberPad Only numbers from 0 to 9. 

iPhoneKeyboardType.PhonePad Keyboard used to enter phone numbers. 

iPhoneKeyboardType.NamePhonePad Letters. Can be switched to phone keyboard. 

iPhoneKeyboardType.EmailAddress Letters with @ sign. Can be switched to keyboard with numbers and punctuation. 

Text Preview 

By default, an edit box will be created and placed on top of the keyboard after it appears. This works as preview of the text that user is 

typing, so the text is always visible for the user. However, you can disable text preview by setting iPhoneKeyboard.hideInput to true. Note 

that this works only for certain keyboard types and input modes. For example, it will not work for phone keypads and multi-line text input. In 

such cases, the edit box will always appear. iPhoneKeyboard.hideInput is a global variable and will affect all keyboards.  

Keyboard Orientation 

By default, the keyboard automatically follows the device orientation. To disable or enable rotation to a certain orientation, use the following 

properties available in iPhoneKeyboard:  

  

autorotateToPortrait Enable or disable autorotation to portrait orientation (button at the bottom). 

autorotateToPortraitUpsideDown Enable or disable autorotation to portrait orientation (button at top). 

autorotateToLandscapeLeft Enable or disable autorotation to landscape left orientation (button on the right). 

http://unity3d.com/support/documentation/ScriptReference/iPhoneInput-lastLocation.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings.StartLocationServiceUpdates.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings-locationServiceStatus.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings.StartLocationServiceUpdates.html
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autorotateToLandscapeRight Enable or disable autorotation to landscape right orientation (button on the left). 

Visibility and Keyboard Size 

There are three keyboard properties in iPhoneKeyboard that determine keyboard visibility status and size on the screen.  

  

visible Returns true if the keyboard is fully visible on the screen and can be used to enter characters. 

area Returns the position and dimensions of the keyboard. 

active Returns true if the keyboard is activated. This property is not static property. You must have a keyboard 

instance to use this property. 

Note that iPhoneKeyboard.area will return a rect with position and size set to 0 until the keyboard is fully visible on the screen. You should 

not query this value immediately after iPhoneKeyboard.Open. The sequence of keyboard events is as follows:  

 iPhoneKeyboard.Open is called. iPhoneKeyboard.active returns true. iPhoneKeyboard.visible returns false. iPhoneKeyboard.area 

returns (0, 0, 0, 0).  

 Keyboard slides out into the screen. All properties remain the same.  

 Keyboard stops sliding. iPhoneKeyboard.active returns true. iPhoneKeyboard.visible returns true. iPhoneKeyboard.area returns real 

position and size of the keyboard.  

Secure Text Input 

It is possible to configure the keyboard to hide symbols when typing. This is useful when users are required to enter sensitive information 

(such as passwords). To manually open keyboard with secure text input enabled, use the following code:  

iPhoneKeyboard.Open("", iPhoneKeyboardType.Default, false, false, true); 

 

Hiding text while typing  

Alert keyboard 

To display the keyboard with a black semi-transparent background instead of the classic opaque, call iPhoneKeyboard.Open as follows:  

iPhoneKeyboard.Open("", iPhoneKeyboardType.Default, false, false, true, true); 

http://unity3d.com/support/documentation/ScriptReference/iPhoneKeyboard.html


 

Classic keyboard  

 

Alert keyboard  

 

Android 
 

Unity Android reuses the iOS API to display system keyboard. Even though Unity Android supports most of the functionality of its iPhone 

counterpart, there are two aspects which are not supported:  

 iPhoneKeyboard.hideInput  

 iPhoneKeyboard.area  

Please also note that the layout of a iPhoneKeyboardType can differ somewhat between devices.  
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iOS 
 

Advanced iOS scripting 

Determining Device Generation 
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Different device generations support different functionality and widely varying performance. You should query the device for its generation 

and decide which functionality should be disabled to compensate for slower devices.  

You can retrieve device generation by accessing the iPhoneSettings.generation property. Generation can be one of the following:  

 iPhone  

 iPhone3G  

 iPhone3GS  

 iPhone4  

 iPodTouch1Gen  

 iPodTouch2Gen  

 iPodTouch3Gen  

 iPodTouch4Gen  

 iPad1Gen  

You can find more information about different device generations, performance and supported functionality in iPhone Hardware Guide.  

Device Properties 

There are a number of device specific properties that you can access:  

  

iPhoneSettings.uniqueIdentifier  Unique device identifier. 

iPhoneSettings.name User specified name for device. 

iPhoneSettings.model Is it iPhone or iPod Touch? 

iPhoneSettings.systemName  Operating system. 

SystemInfo.operatingSystem  Operating system version. 

Anti-Piracy Check 

It is not uncommon for pirates to hack applications from AppStore by removing Apple DRM protection and redistributing them for free. Unity 

iOS comes with anti-piracy check which allows you to determine if your application was altered after it was submitted to AppStore.  

You can check if your application is genuine (not-hacked) by accessing iPhoneUtils.isApplicationGenuine property. If this property returns 

false you're free to notify user that he is using hacked application or you can disable access to some functions of your application.  

Note: accessing iPhoneUtils.isApplicationGenuine property is reasonably expensive operation and you should never do it on a frame-to-

frame basis.  

Vibration Support 

You can trigger iOS vibration by calling iPhoneUtils.Vibrate. However iPod Touch devices lack vibration hardware and will just ignore this 

call.  

Standard Assets 

"Standard Assets" is a folder with special meaning (same as "Plugins" and "Editor) and its content is compiled before all other scripts. You 

should keep your scripts in folders without special name.  

 

Android 
 

Advanced iOS scripting 

Determining Device Generation 

http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings-generation.html
http://unity3d.com/support/documentation/Manual/iphone-Hardware.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings-uniqueIdentifier.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings-name.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings-model.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings-systemName.html
http://unity3d.com/support/documentation/ScriptReference/SystemInfo-operatingSystem.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneUtils-isApplicationGenuine.html
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Different Android devices support different functionality and widely varying performance. You should target specific devices or device 

families and decide which functionality should be disabled to compensate for slower devices. There are a number of device specific 

properties that you can access to figure out the device.  

Note: Android Marketplace does some additional compatibility filtering, so you should not bother that your ARMv7 only app optimized for 

OGLES2 is offered to some old slow devices.  

Device Properties 

  

iPhoneSettings.uniqueIdentifier  Unique device identifier. 

iPhoneSettings.model Is it iPhone or iPod Touch? 

iPhoneSettings.systemName  Operating system. 

SystemInfo.operatingSystem  Operating system version. 

Anti-Piracy Check 

It is not uncommon for pirates to hack applications by removing Apple DRM protection and redistributing them for free. Unity Android comes 

with anti-piracy check which allows you to determine if your application was altered after it was submitted to AppStore.  

You can check if your application is genuine (not-hacked) by accessing iPhoneUtils.isApplicationGenuine property. If this property returns 

false you're free to notify user that he is using hacked application or you can disable access to some functions of your application.  

Note: iPhoneUtils.isApplicationGenuineAvailable should be used along with iPhoneUtils.isApplicationGenuine to verify that application 

integrity can actually be confirmed.  

Note: accessing iPhoneUtils.isApplicationGenuine property is reasonably expensive operation and you should never do it on a frame-to-

frame basis.  

Vibration Support 

You can trigger device vibration by calling iPhoneUtils.Vibrate. However devices lacking vibration hardware will just ignore this call.  

Standard Assets 

"Standard Assets" is a folder with special meaning (same as "Plugins" and "Editor) and its content is compiled before all other scripts. You 

should keep your scripts in folders without special name.  
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iOS 
 

Now Unity iOS supports two .NET API compatibility levels: .NET 2.0 and a subset of .NET 2.0 You can select the appropriate level in 

PlayerSettings.  

.NET API 2.0 

Unity for iPhone/iPad targets supports the .NET 2.0 API profile; It is close to the full .NET 2.0 API and offers best compatibility with pre-

existing .NET code.  

Pros: 

1. Better code compatibility with desktop Unity and third party libraries  

http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings-uniqueIdentifier.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings-model.html
http://unity3d.com/support/documentation/ScriptReference/iPhoneSettings-systemName.html
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2. More features in standard the API set  

Cons: 

1. Application build size is bigger  

2. Slightly worse application startup time  

Note: Unity iOS does not support namespaces in the scripts. If you have third party library with the source, then the best practice is to 

compile this library outside Unity iOS Editor and drop library .dll file into Assets folder.  

.NET 2.0 Subset  

Unity iOS targets also support the .NET 2.0 Subset API profile. It is closest to the Mono "monotouch" profile, so many limitations that are 

applicable to the "monotouch" profile are also applicable for Unity iOS implementation of this .NET profile. More information on 

"monotouch" profile limitations can be found here.  

Pros: 

1. Smaller application distribution size especially when stripping is not used  

Cons: 

1. Worse compatibility with standard and third party libraries  

 

Android 
 

Unity Android supports two .NET API compatibility levels: .NET 2.0 and a subset of .NET 2.0 You can select the appropriate level in 

PlayerSettings.  

.NET API 2.0 

Unity Android targets supports the .NET 2.0 API profile; It is close to the full .NET 2.0 API and offers best compatibility with pre-existing 

.NET code.  

Pros: 

1. Better code compatibility with desktop Unity and third party libraries  

2. More features in standard the API set  

Cons: 

1. Application build size is bigger  

2. Slightly worse application startup time  

Note: Unity Android does not support namespaces in the scripts. If you have third party library with the source, then the best practice is to 

compile this library outside Unity Android Editor and drop library .dll file into Assets folder.  

.NET 2.0 Subset  

Unity Android targets also support the .NET 2.0 Subset API profile. It is closest to the Mono "monotouch" profile, so many limitations that 

are applicable to the "monotouch" profile are also applicable for Unity Android implementation of this .NET profile. More information on 

"monotouch" profile limitations can be found here.  

Pros: 

http://monotouch.net/Documentation/Limitations
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1. Smaller application distribution size especially when stripping is not used  

Cons: 

1. Worse compatibility with standard and third party libraries  
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iphone-Hardware 

Hardware models 

Following table summarizes iOS hardware available in devices of various generations:  

Common to all iOS devices 

 Screen: 320x480 pixels, LCD at 163ppi (unless stated otherwise)  

 Built-in accelerometer  

 Wi-Fi  

Original iPhone 

 ARM11, 412 Mhz CPU  

 PowerVR MBX Lite 3D graphics processor  

 128MB of memory  

 2 megapixel camera  

 Speaker and microphone  

 Vibration support  

 Silent switch  

iPhone 3G 

 ARM11, 412 Mhz CPU  

 PowerVR MBX Lite 3D graphics processor  

 128MB of memory  

 2 megapixel camera  

 Speaker and microphone  

 Vibration support  

 Silent switch  

 GPS support  

iPhone 3GS 

 ARM Cortex A8, 600 MHz CPU  

 PowerVR SGX graphics processor  

 256MB of memory  

 3 megapixel camera with video capture capability  

 Speaker and microphone  

 Vibration support  

 Silent switch  

 GPS support  

 Compass support  

iPhone 4 



 ARM Cortex-A8 Apple A4 CPU  

 ARM Cortex-A8 Apple A4 graphics processor  

 512MB of memory  

 Cameras  

o Rear 5.0 MP backside illuminated CMOS image sensor with 720p HD video at 30 fps and LED flash  

o Front 0.3 MP (VGA) with geotagging, tap to focus, and 480p SD video at 30 fps  

 Screen: 960x640 pixels, LCD at 326 ppi, 800:1 contrast ratio.  

 Speaker and microphone  

 Vibration Support  

 Silent switch  

 GPS support  

 Compass Support  

iPod Touch 1st generation 

 ARM11, 412 Mhz CPU  

 PowerVR MBX Lite 3D graphics processor  

 128MB of memory  

iPod Touch 2nd generation 

 ARM11, 533 Mhz CPU  

 PowerVR MBX Lite 3D graphics processor  

 128MB of memory  

 Speaker and microphone  

iPad 

 1 GHz Apple A4 CPU  

 Wifi + Blueooth + (3G Cellular HSDPA, 2G cellular EDGE on the 3G version)  

 Accelerometer, ambient light sensor, magnetometer (for digital compass)  

 Mechanical keys: Home, sleep, screen rotation lock, volume.  

 Screen: 1024x768 pixels, LCD at 132 ppi, LED-backlit.  

Graphics Processing Unit and Hidden Surface Removal 

The iPhone/iPad graphics processing unit (GPU) is a Tile-Based Deferred Renderer. In contrast with most GPUs in desktop computers, the 

iPhone/iPad GPU focuses on minimizing the processing required to render an image as early in the processing of a scene as possible, so 

that only the pixels that actually will be seen consume processing resources.  

The GPU's frame buffer is divided up into tiles and rendering happens tile by tile. First, triangles for the whole frame are gathered and 

assigned to the tiles. Next, visible fragments of each triangle are chosen. Finally, the selected triangle fragments are passed to rasterizer 

(triangle fragments occluded from the camera are rejected at this stage).  

In other words iPhone/iPad GPU implements Hidden Surface Removal operation at reduced cost. Such architecture consumes less 

memory bandwidth, has lower power consumption, and utilizes texture cache better. Tile-Based Deferred Rendering allows the device to 

reject occluded fragments before actual rasterization which is effective to keep overdraw low.  

For more information see also:  

 POWERVR MBX Technology Overview  

 Apple Notes on iPhone/iPad GPU and OpenGL ES  

 Apple Performance Advices for OpenGL ES in General  

 Apple Performance Advices for OpenGL ES Shaders  

SGX series 

http://www.imgtec.com/factsheets/SDK/PowerVR%20Technology%20Overview.1.0.2e.External.pdf
http://developer.apple.com/iphone/library/documentation/3DDrawing/Conceptual/OpenGLES_ProgrammingGuide/OpenGLESPlatforms/OpenGLESPlatforms.html#//apple_ref/doc/uid/TP40008793-CH106-SW1
http://developer.apple.com/library/ios/#documentation/3DDrawing/Conceptual/OpenGLES_ProgrammingGuide/Performance/Performance.html
http://developer.apple.com/library/ios/#documentation/3DDrawing/Conceptual/OpenGLES_ProgrammingGuide/BestPracticesforShaders/BestPracticesforShaders.html


Starting from iPhone 3GS and newer devices are equipped with SGX series of GPUs. SGX series features support for OpenGL ES2.0 

rendering API, vertex and pixel shaders. Fixed-function pipeline is not supported natively on such GPUs, instead it is emulated by 

generating vertex and pixel shaders with analogous functionality on the fly.  

SGX series fully supports MultiSample anti-aliasing.  

MBX series 

Older devices such as iPhone, iPhone 3G, iPod Touch 1st and 2nd Generation are equipped with MBX series of GPUs. MBX series 

supports only OpenGL ES1.1, fixed function Transform&Lighting pipeline and 2 textures per fragment.  

Texture Compression 

The only texture compression format supported by iOS is PVRTC. PVRTC provides support for RGB and RGBA (color information + alpha 

channel) texture formats and can compress single pixel to 4 or 2 bits.  

PVRTC format is essential to save memory footprint and to reduce consumption of memory bandwidth (rate at which data can be read from 

memory, usually very limited on Mobile devices).  

Vertex Processing Unit 

The iPhone/iPad has a dedicated unit responsible for vertex processing. It runs calculations in parallel with rasterization. In order to achieve 

better parallelization, the iPhone/iPad processes vertices one frame ahead of the rasterizer.  

Unified Memory Architecture 

Both CPU and GPU on the iPhone/iPad share the same memory. The advantage is that you don't need to worry about running out of video 

memory for your textures (unless, of course, you run out of main memory too). The disadvantage is that you share same memory 

bandwidth for gameplay and graphics. The more memory bandwidth you dedicate to graphics, less you will have for gameplay and physics.  

Multimedia CoProcessing Unit 

The iPhone/iPad main CPU is equipped with a powerful SIMD (Single Instruction, Multiple Data) coprocessor either supporting VFP or 

NEON architectures. The Unity iOS run-time takes advantage of these units for multiple tasks such as calculating skinned mesh 

transformations, geometry batching, audio processing and other calculation-intensive operations.  
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iphone-performance 
Making games for the iPhone/iPad is fun. But in order for your game to be successful, you need to make it run smoothly. Therefore, it is 

important to understand the graphical capabilities and processing power of the iPhone.  

You should expect the iPhone/iPad capabilities to be somewhere between the Nintendo DS and the PlayStation Portable. Please plan your 

games accordingly!  

Thankfully, Unity is there for you! We have spent a lot of time and energy making Unity-created iOS projects run fast. Below we have 

gathered some guidelines which will help you to achieve better performance on iOS:  

 Optimizing Graphics Performance  

o Draw Call Batching  

o Modeling Optimized Characters  

o Rendering Statistics Window  

 Optimizing Physics Performance  

 Optimizing Script Performance  

 Measuring Performance with the Built-in Profiler  

http://unity3d.com/support/documentation/Manual/Optimizing%20Graphics%20Performance.html#iPhoneOptimizingGraphicsPerformance
http://unity3d.com/support/documentation/Manual/iphone-DrawCall-Batching.html
http://unity3d.com/support/documentation/Manual/Modeling%20Optimized%20Characters.html
http://unity3d.com/support/documentation/Manual/RenderingStatistics.html#RenderingStatisticsIPhone
http://unity3d.com/support/documentation/Manual/iphone-Optimizing-Physics.html
http://unity3d.com/support/documentation/Manual/iphone-Optimizing-Scripts.html
http://unity3d.com/support/documentation/Manual/iphone-InternalProfiler.html


 Tuning Main Loop Performance  

 Optimizing iOS Players build Size  
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iPhone Optimizing Graphics Performance 
 

Desktop  
 

Making your game run smoothly is critical to its success. Thankfully Unity is there for you! We have spent a lot of time and energy making 

Unity iOS run fast on a wide variety of hardware. Below are some simple guidelines to maximizing the speed of your game.  

In Summary - Combine, Combine, Combine 

 If you care about performance, combine meshes.  

 If you care about performance, make sure all of your combined meshes also share the same material and texture.  

 The Profiler and Rendering Statistics window are very helpful!  

In Detail: 

Modern graphics cards are really good at pushing a lot of polygons, but they have quite a bit of overhead for every batch that you submit to 

the graphics card. So if you have a 100-triangle object it is going to be just as expensive to render as a 1500-triangle object. The "sweet 

spot" for optimal rendering performance is somewhere around 1500-4000 triangles per mesh.  

You only pay a rendering cost for objects that have a Mesh Renderer attached. And you only pay for those that are within the view 

frustum. There is no rendering cost from having a lot of empty GameObjects in your scene.  

 The best way to improve rendering performance is to combine objects together so each mesh has around 1500 or more triangles and uses 

only one Material for the entire mesh.  

It is important to understand that just combining two objects which don't share a material does not give you any performance increase at all. 

If you want to combine effectively, you need to make sure your mesh uses only one material after you have combined it.  

There is, however, one thing to be aware of when combining objects: if you use a lot of small lights in your scene, it might make sense to 

combine only objects that are close to each other.  

The rendering cost for a mesh that has multiple materials is the same as having multiple renderers for each material. The most common 

reason why you have multiple materials is that two meshes don't share the same textures. So, if you want to optimize rendering 

performance, you need to make sure that the objects you combine share textures.  

 Unity is very good at pushing lots of polygons. Unity uploads all geometry to the graphics card for good cache utilization and optimal data 

alignment.  

 You simply have to make sure that the graphics card doesn't have to handle large numbers of batches.  

 If you use Forward rendering path, the number of Pixel Lights affecting an object heavily affects performance.  

Pixel Lights in Forward Rendering Path 

Note: this applies only to Forward rendering path.  

If you use pixel lighting, then each GameObject has to be rendered as many times as there are pixel lights that affect the object. If you 

combine two objects that are very far apart, it might increase the size of the object and now you have a lot of lights affecting this big object. 

If your objects were separate however, the light won't have to be applied on the part of the mesh which is far away. This can result in 

http://unity3d.com/support/documentation/Manual/iphone-Optimizing-MainLoop.html
http://unity3d.com/support/documentation/Manual/iphone-playerSizeOptimization.html
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rendering the combined mesh as many times as the uncombined mesh (thus not saving anything). For this reason, you should keep 

GameObjects that are very far away as individual Meshes.  

When rendering a mesh, Unity finds all lights surrounding the mesh. It then figures out what lights affect the mesh the most. The 

QualitySettings are used to modify how many of the lights end up as pixel lights and how many as vertex lights.  

Every light calculates its importance based on how far away it is from the mesh and how intense it is.  

Some lights are more important than others depending on the game context. For this reason, every light has a Render Mode setting which 

can be set to Important or Not Important.  

Imagine the player's car with head lights driving through the night. The head lights are the most important light in the game. For this reason, 

the head lights Render Mode should be set to Important.  

If you have a light that is not very important and also visually doesn't gain much from being a pixel light, set the lights Render Mode to Not 

Important. This way, you don't waste rendering performance or lose any visual quality.  

Per-Layer Cull Distances 

You might want to cull small objects earlier to reduce number of draw calls. For example, small rocks and debris could be made invisible at 

much smaller distance than large buildings. To do that, put small objects into a separate layer and setup per-layer cull distances using the 

Camera.layerCullDistances script function.  

Shadows 

If you are deploying for Desktop platforms then you should pay attention to shadows; shadows are generally expensive. They can add a lot 

of performance overhead to your game if they are not used correctly. For more details about shadows, please read the Shadows page.  

Note: Remember that shadows are not currently supported on iOS or Android devices.  

See Also 

 Modeling Optimized Characters  

 Rendering Statistics Window  

 

iOS 
 

If you want to optimize your content for iOS, then it is beneficial for you to learn more about iOS hardware devices.  

Alpha-Testing 

Contrary to the desktop, alpha-testing (or use of discard / clip operation in pixel shader) is very expensive on iOS. If you can replace your 

alpha-test shader with alpha-blend, do so. If you absolutely need to use alpha-testing, then you should keep areas of visible alpha-tested 

pixels to a minimum.  

Vertex Performance 

Generally you should aim at 40K or less vertices visible per frame when targeting iPhone 3GS or newer devices. You should aim at 10K or 

less vertices visible per frame when targeting older devices equipped with MBX GPU, such as: iPhone, iPhone 3G, iPod Touch 1st and 2nd 

Generation.  

Lighting Performance 

http://unity3d.com/support/documentation/Components/class-QualitySettings.html
http://unity3d.com/support/documentation/Components/Layers.html
http://unity3d.com/support/documentation/ScriptReference/Camera-layerCullDistances.html
http://unity3d.com/support/documentation/Manual/Shadows.html
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Per-pixel dynamic lighting will add significant cost to every affected pixel and can lead to rendering object in multiple passes. Avoid having 

more than one Pixel Light affecting any single object, prefer it to be a directional light. Note that Pixel Light is a light which has a Render 

Mode setting set to Important.  

Per-vertex dynamic lighting can add significant cost to vertex transformations. Avoid multiple lights affecting single objects. Bake lighting for 

static objects.  

Optimize Model Geometry 

When optimizing the geometry of a model, there are two basic rules:  

 Don't use excessive amount of faces if you don't have to  

 Keep the number of UV mapping seams and hard edges as low as possible  

Note that the actual number of vertices that graphics hardware has to process is usually not the same as what is displayed in a 3D 

application. Modeling applications usually display the geometric vertex count, i.e. number of points that make up a model.  

For a graphics card however, some vertices have to be split into separate ones. If a vertex has multiple normals (it's on a "hard edge"), or 

has multiple UV coordinates, or has multiple vertex colors, it has to be split. So the vertex count you see in Unity is almost always different 

from the one displayed in 3D application.  

Texture Compression 

Use iOS native PVRT compression formats. They will not only decrease the size of your textures (resulting in faster load times and smaller 

memory footprint), but also can dramatically increase your rendering performance! Compressed texture requires only a fraction of memory 

bandwidth compared to full blown 32bit RGBA textures. For performance comparison check iOS Hardware Guide.  

Some images are prone to visual artifacts in alpha channels of PVRT compressed textures. In such case you might want to tweak PVRT 

compression parameters directly in your imaging software. You can do that by installing PVR export plugin or using PVRTexTool from 

Imagination Tech -- creators of PVRT format. Resulting compressed image with .pvr extension will be imported by Unity Editor as is and 

manually specified compression parameters will be preserved.  

If PVRT compression formats do not deliver enough visual quality and you need extra crisp imaging (for example UI textures), then you 

should consider using 16bit texture over full 32bit RGBA texture. At least you will reduce memory bandwidth by half.  

Tips for writing well performing shaders 

Although GPUs fully support pixel and vertex shaders since iPhone 3GS, do not expect to grab a desktop shader with complex per-pixel 

functionality and run it on iOS device at 30 frames per second. Most often shaders will have to be hand optimized, calculations and texture 

reads kept to a minimum in order to achieve good frame rates.  

Complex arithmetic operations 

Arithmetic operations such as pow, exp, log, cos, sin, tan etc heavily tax GPU. Rule of thumb is to have not more than one such operation 

per fragment. Consider that sometimes lookup textures could be a better alternative.  

Do NOT try to roll your own normalize, dot, inversesqrt operations however. Always use built-in ones -- this was driver will generate much 

better code for you.  

Keep in mind that discard operation will make your fragments slower.  

Floating point operations 

Always specify precision of the floating point variables while writing custom shaders. It is crucial to pick smallest possible format in order to 

achieve best performance.  

If shader is written in GLSL ES, then precision is specified as following:  

http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/Manual/iphone-Hardware.html
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 highp - full 32 bits floating point format, well suitable for vertex transformations, slowest  

 mediump - reduced 16 bits floating point format, well suitable for texture UV coordinates, roughly x2 faster than highp  

 lowp - 10 bits fixed point format, well suitable for colors, lighting calculation and other high performant operations, roughly x4 faster than 

highp  

If shader is written in CG or it is a surface shader, then precision is specified as following:  

 float - analogous to highp in GLSL ES, slowest  

 half - analogous to mediump in GLSL ES, roughly x2 faster than float  

 fixed - analogous to lowp in GLSL ES, roughly x4 faster than float  

For more details about general shader performance, please read the Shader Performance page.  

Hardware documentation 

Take your time to study Apple documentations on hardware and best practices for writing shaders. Note that we would suggest to be more 

aggressive with floating point precision hints however.  

Bake Lighting into Lightmaps 

Bake your scene static lighting into textures using Unity built-in Lightmapper. The process of generating a lightmapped environment takes 

only a little longer than just placing a light in the scene in Unity, but:  

 It is going to run a lot faster (2-3 times for eg. 2 pixel lights)  

 And look a lot better since you can bake global illumination and the lightmapper can smooth the results  

Share Materials 

If a number of objects being rendered by the same camera uses the same material, then Unity iOS will be able to employ a large variety of 

internal optimizations such as:  

 Avoiding setting various render states to OpenGL ES.  

 Avoiding calculation of different parameters required to setup vertex and pixel processing  

 Batching small moving objects to reduce draw calls  

 Batching both big and small objects with enabled "static" property to reduce draw calls  

All these optimizations will save you precious CPU cycles. Therefore, putting extra work to combine textures into single atlas and making 

number of objects to use the same material will always pay off. Do it!  

Simple Checklist to make Your Game Faster 

 Keep vertex count below:  

o 40K per frame when targeting iPhone 3GS and newer devices (with SGX GPU)  

o 10K per frame when targeting older devices (with MBX GPU)  

 If you're using built-in shaders, peek ones from Mobile category. Keep in mind that Mobile/VertexLit is currently the fastest shader.  

 Keep the number of different materials per scene low - share as many materials between different objects as possible.  

 Set Static property on a non-moving objects to allow internal optimizations.  

 Use PVRTC formats for textures when possible, otherwise choose 16bit textures over 32bit.  

 Use combiners or pixel shaders to mix several textures per fragment instead of multi-pass approach.  

 If writing custom shaders, always use smallest possible floating point format:  

o fixed / lowp -- perfect for color, lighting information and normals,  

o half / mediump -- for texture UV coordinates,  

o float / highp -- avoid in pixel shaders, fine to use in vertex shader for vertex position calculations.  

 Minimize use of complex mathematical operations such as pow, sin, cos etc in pixel shaders.  

 Do not use Pixel Lights when it is not necessary -- choose to have only a single (preferably directional) pixel light affecting your geometry.  

 Do not use dynamic lights when it is not necessary -- choose to bake lighting instead.  

 Choose to use less textures per fragment.  

http://unity3d.com/support/documentation/Components/SL-ShaderPerformance.html
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 Avoid alpha-testing, choose alpha-blending instead.  

 Do not use fog when it is not necessary.  

 Learn benefits of Occlusion culling and use it to reduce amount of visible geometry and draw-calls in case of complex static scenes with 

lots of occlusion. Plan your levels to benefit from Occlusion culling.  

 Use skyboxes to "fake" distant geometry.  

See Also 

 Optimizing iOS Performance  

 iOS Hardware Guide  

 iOS Automatic Draw Call Batching  

 Modeling Optimized Characters  

 Rendering Statistics  

 

Android 
 

Lighting Performance 

Per-pixel dynamic lighting will add significant cost to every affected pixel and can lead to rendering object in multiple passes. Avoid having 

more than one Pixel Light affecting any single object, prefer it to be a directional light. Note that Pixel Light is a light which has a Render 

Mode setting set to Important.  

Per-vertex dynamic lighting can add significant cost to vertex transformations. Avoid multiple lights affecting single objects. Bake lighting for 

static objects.  

Optimize Model Geometry 

When optimizing the geometry of a model, there are two basic rules:  

 Don't use excessive amount of faces if you don't have to  

 Keep the number of UV mapping seams and hard edges as low as possible  

Note that the actual number of vertices that graphics hardware has to process is usually not the same as what is displayed in a 3D 

application. Modeling applications usually display the geometric vertex count, i.e. number of points that make up a model.  

For a graphics card however, some vertices have to be split into separate ones. If a vertex has multiple normals (it's on a "hard edge"), or 

has multiple UV coordinates, or has multiple vertex colors, it has to be split. So the vertex count you see in Unity is almost always different 

from the one displayed in 3D application.  

Texture Compression 

All Android devices with support for OpenGL ES 2.0 also support the ETC1 compression format; it's therefore encouraged to whenever 

possible use ETC1 as the prefered texture format. Using compressed textures is important not only to decrease the size of your textures 

(resulting in faster load times and smaller memory footprint), but can also increase your rendering performance dramatically! Compressed 

textures require only a fraction of memory bandwidth compared to full blown 32bit RGBA textures.  

If targeting a specific graphics architecture, such as the Nvidia Tegra or Qualcomm Snapdragon, it may be worth considering using the 

proprietary compression formats available on those architectures. The Android Market also allows filtering based on supported texture 

compression format, meaning a distribution archive (.apk) with for example DXT compressed textures can be prevented for download on a 

device which doesn't support it.  

Enable Mip Maps 

As a rule of thumb, always have Generate Mip Maps enabled. In the same way Texture Compression can help limit the amount of texture 

data transfered when the GPU is rendering, a mip mapped texture will enable the GPU to use a lower-resolution texture for smaller 
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triangles. The only exception to this rule is when a texel (texture pixel) is known to map 1:1 to the rendered screen pixel, as with UI 

elements or in a pure 2D game.  

Tips for writing well performing shaders 

Although all Android OpenGL ES 2.0 GPUs fully support pixel and vertex shaders, do not expect to grab a desktop shader with complex 

per-pixel functionality and run it on Android device at 30 frames per second. Most often shaders will have to be hand optimized, 

calculations and texture reads kept to a minimum in order to achieve good frame rates.  

Complex arithmetic operations 

Arithmetic operations such as pow, exp, log, cos, sin, tan etc heavily tax GPU. Rule of thumb is to have not more than one such operation 

per fragment. Consider that sometimes lookup textures could be a better alternative.  

Do NOT try to roll your own normalize, dot, inversesqrt operations however. Always use built-in ones -- this was driver will generate much 

better code for you.  

Keep in mind that discard operation will make your fragments slower.  

Floating point operations 

Always specify precision of the floating point variables while writing custom shaders. It is crucial to pick smallest possible format in order to 

achieve best performance.  

If shader is written in GLSL ES, then precision is specified as following:  

 highp - full 32 bits floating point format, well suitable for vertex transformations, slowest  

 mediump - reduced 16 bits floating point format, well suitable for texture UV coordinates, roughly x2 faster than highp  

 lowp - 10 bits fixed point format, well suitable for colors, lighting calculation and other high performant operations, roughly x4 faster than 

highp  

If shader is written in CG or it is a surface shader, then precision is specified as following:  

 float - analogous to highp in GLSL ES, slowest  

 half - analogous to mediump in GLSL ES, roughly x2 faster than float  

 fixed - analogous to lowp in GLSL ES, roughly x4 faster than float  

For more details about general shader performance, please read the Shader Performance page. Quoted performance figures are based on 

the PowerVR graphics architecture, available in devices such as the Samsung Nexus S. Other hardware architectures may experience less 

(or more) benefit from using reduced register precision.  

Bake Lighting into Lightmaps 

Bake your scene static lighting into textures using Unity built-in Lightmapper. The process of generating a lightmapped environment takes 

only a little longer than just placing a light in the scene in Unity, but:  

 It is going to run a lot faster (2-3 times for eg. 2 pixel lights)  

 And look a lot better since you can bake global illumination and the lightmapper can smooth the results  

Share Materials 

If a number of objects being rendered by the same camera uses the same material, then Unity Android will be able to employ a large 

variety of internal optimizations such as:  

 Avoiding setting various render states to OpenGL ES.  

 Avoiding calculation of different parameters required to setup vertex and pixel processing  

 Batching small moving objects to reduce draw calls  

http://unity3d.com/support/documentation/Components/SL-ShaderPerformance.html
http://unity3d.com/support/documentation/Manual/Lightmapping.html


 Batching both big and small objects with enabled "static" property to reduce draw calls  

All these optimizations will save you precious CPU cycles. Therefore, putting extra work to combine textures into single atlas and making 

number of objects to use the same material will always pay off. Do it!  

Simple Checklist to make Your Game Faster 

 If you're using built-in shaders, peek ones from Mobile category. Keep in mind that Mobile/VertexLit is currently the fastest shader.  

 Keep the number of different materials per scene low - share as many materials between different objects as possible.  

 Set Static property on a non-moving objects to allow internal optimizations.  

 Use ETC1 format for textures when possible, otherwise choose 16bit textures over 32bit for uncompressed texture data.  

 Use mipmaps.  

 Use combiners or pixel shaders to mix several textures per fragment instead of multi-pass approach.  

 If writing custom shaders, always use smallest possible floating point format:  

o fixed / lowp -- perfect for color, lighting information and normals,  

o half / mediump -- for texture UV coordinates,  

o float / highp -- avoid in pixel shaders, fine to use in vertex shader for vertex position calculations.  

 Minimize use of complex mathematical operations such as pow, sin, cos etc in pixel shaders.  

 Do not use Pixel Lights when it is not necessary -- choose to have only a single (preferably directional) pixel light affecting your geometry.  

 Do not use dynamic lights when it is not necessary -- choose to bake lighting instead.  

 Choose to use less textures per fragment.  

 Avoid alpha-testing, choose alpha-blending instead.  

 Do not use fog when it is not necessary.  

 Learn benefits of Occlusion culling and use it to reduce amount of visible geometry and draw-calls in case of complex static scenes with 

lots of occlusion. Plan your levels to benefit from Occlusion culling.  

 Use skyboxes to "fake" distant geometry.  

See Also 

 iPhone Optimizing Graphics Performance (for when the graphics architecture is known to be Imagination Tech's PowerVR.)  
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iphone-DrawCall-Batching 
To draw an object on the screen, the engine has to issue a draw call to graphics API (OpenGL ES in case of iOS). Every single draw call 

requires a significant amount of work to be executed inside the graphics API. Therefore, each draw call causes significant performance 

overhead on the CPU side.  

Unity is smart enough to combine a number of objects at the run-time and draw them together with a single draw call. This operation is 

called "batching". The more objects Unity can batch together the better rendering performance you will get.  

Built-in batching support in Unity has significant benefit over simply combining geometry in the modeling tool (or using the CombineChildren 

script from the Standard Assets package). Batching in Unity happens after visibility determination step. Therefore, the engine can cull each 

objects individually thus keeping amount of rendered geometry at the same level as it would without batching. Combining geometry in the 

modeling tool, on the other hand, prevents effecient culling and results in much higher amount of geometry being rendered.  

Materials 

Only objects sharing the same material can be batched together. Therefore, if you want to achieve good batching, you need to share as 

many materials among different objects as possible.  

If you have two identical materials which differ only in textures, you can combine those textures into a single big texture - a process often 

called texture atlasing. Once textures are in the same atlas, you can use single material instead.  

http://unity3d.com/support/documentation/Manual/Optimizing%20Graphics%20Performance.html#iPhoneOptimizingGraphicsPerformance
http://en.wikipedia.org/wiki/Texture_atlas


If you need to access shared material properties from the scripts, then it is important to note that modifying Renderer.material will create a 

copy of the material. Instead, you should use Renderer.sharedMaterial to keep material shared.  

Dynamic Batching 

Unity can automatically batch moving objects into the same draw call if they share the same material. Batching dynamic objects has certain 

overhead per vertex, so batching is applied only to meshes containing less than 300 vertices.  

Dynamic batching is done automatically and does not require any additional effort on your side.  

Static Batching 

Static batching, on the other hand, allows the engine to reduce draw calls for geometry of any size (provided it does not move and shares 

the same material). Static batching is significantly more efficient than dynamic batching. You should choose static batching as it will require 

less CPU power.  

In order to take advantage of static batching, you need explicitly specify that certain objects are static and will not move, rotate or scale in 

the game. To do so, you can mark objects as static using the Static checkbox in the Inspector:  

 

Using static batching will require additional memory to store combined geometry. If several objects shared the same geometry before static 

batching, then a copy of geometry will be created for each object -- either in the Editor or at the run-time. This might not always be a good 

idea -- sometimes you will have to sacrifice rendering performance by avoiding static batching for some objects to keep a smaller memory 

footprint. For example, marking trees as static in a dense forest level can have serious memory impact.  

Static batching is only available in Unity iOS Advanced.  

Further Reading 

 Measuring performance with the Built-in Profiler  

 Rendering Statistics  
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iphone-ModelingOptimizedCharacters 

Use one Skinned Mesh Renderer 

Your character should use only a single skinned mesh renderer. There is usually no reason to use multiple meshes for a character. Unity 

also has optimizations related to visibility culling and bounding volume updating which only kick in if you use one animation component and 

one skinned mesh renderer in conjunction. If you care about performance, multiple skinned meshes per character is not an option. If you 

use two skinned mesh renderers for one character instead of one, the time spent on rendering the character will most likely double!  

Don't Use Many Materials 

http://unity3d.com/support/documentation/ScriptReference/Renderer-material.html
http://unity3d.com/support/documentation/ScriptReference/Renderer-sharedMaterial.html
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You also want to keep the number of materials on that mesh as low as possible. There is only one reason why you might want to have 

more than one material on the character: when you need to use a different shader (e.g. if you want to use a special shader for the eyes). 

However, 2-3 materials per character should be sufficient in almost all cases. If your character is carrying a gun, it might be useful to have 

the gun a separate object, simply because it might get detached.  

Reduce Amount of Bones 

Medium Desktop games use bone hierarchies with 15-60 bones. The fewer bones you use the faster; with 30 bones you can achieve very 

good quality on Desktop platforms and fairly good quality on Mobile Platforms. Unless you really have to, we strongly recommend you 

use fewer than 30 bones if you are developing for Mobile Platforms and around 30 bones per character on Desktop platforms.  

Polygon Count 

How many polygons you should use depends on the quality you require and the platform you are targeting. Anything between 300-1500 

triangles on Mobile Platforms and 500-6000 triangles on Desktop Platforms is reasonable. If you want lots of characters on screen or 

want the game to run on old machines, you will have to reduce the polygon count for each character. As an example: Half Life 2 characters 

used 2500-5000 triangles per character. Next-gen AAA games running on PS3 or Xbox 360 usually have characters with 5000-7000 

triangles.  

Separate Out IK and FK 

Separate out inverse kinematics (IK) and forward kinematics (FK). When animations are imported, the IK nodes are baked into FK, thus 

Unity doesn't need the IK nodes at all. You can either kill the GameObjects in Unity or the nodes in the modelling tool. By removing them, 

the IK nodes don't need to be animated every frame anymore. For this reason it is a very bad idea to intermix IK and FK hierarchies. 

Instead, you should create two hierarchies: one strictly for IK and one for FK. This way you can very easily select the whole IK hierarchy 

and delete it.  

Use Reusable Rigs 

Create a rig which you can reuse. This allows you to share animations between different characters.  

Name Bones Correctly 

Name the bones correctly (left hip, left ankle, left foot etc.). Especially with characters, naming your bones correctly is very important. For 

example if you want to turn a character into a Ragdoll you will have to find the right bones for each body part. If they are not named 

correctly, finding all the body parts will take much longer.  
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iphone-RenderingStatistics 
The Game View has a Stats button top right. When this Stats button is pressed, an overlay window is displayed with realtime rendering 

statistics. This is very useful for helping to optimize your game. The statistics displayed vary depending on your build target.  

http://unity3d.com/support/documentation/Components/class-Material.html


 

Rendering Statistics Window. 

Statistics window contains the following information:  

Time per frame 

and FPS 

How much time it takes to process and render one game frame (and resulting FPS). Note that this number only includes 

frame update and rendering of the game view; and does not include time taken in the editor to draw the scene view, 

inspector and other editor-only processing. 

Draw Calls How many objects are drawn in total. This accumulates objects that are drawn multiple times as well, for example some 

object that is affected by pixel lights will add several draw calls. 

Batched (Draw 

Calls) 

Number of draw calls that where batched together. Batching means that engine will be able to combine rendering of 

multiple objects into one draw-call which leads to lower CPU overhead. To ensure good batching you should share as 

many materials between different objects as possible. 

Tris and Verts Number of triangles and vertices drawn. This is mostly important when optimizing for low-end hardware 

Used Textures Count and memory size of textures used when drawing this frame. 

Render 

Textures 

Count and memory size of Render Textures that are created. Also displays how many times active Render Texture was 

switched during this frame. 

Screen Size, anti-aliasing level and memory taken by the screen itself. 

VRAM usage Approximate bounds of current video memory (VRAM) usage. Also shows how much video memory your graphics card 

has. 

VBO total Number of unique meshes (vertex buffers) that are uploaded to the graphics card. Each different model will cause new 

VBO to be created. In some cases scaled objects will cause additional VBOs to be created. In case of a static batching 

however number of objects can share same VBO. 

Visible Skinned 

Meshes 

How many skinned meshes are rendered. 

Animations How many animations are playing. 

 

Desktop  
 

See Optimizing Graphics Performance for more advice.  

 

iOS 
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See Optimizing iOS Graphics Performance for more advice.  

 

Android 
 

See Optimizing Android Graphics Performance for more advice.  

Also, the Profiler shows additional rendering statistics.  
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iphone-Optimizing-Physics 
Unity has the next-generation NVIDIA PhysX physics engine built-in. This allows for unique emergent behaviour. But you should not forget 

that iOS is an OS designed for mobile devices and has its own performance limits which can be very easily reached. The following are high 

level tips for how to tune physics to get optimal performance on the iOS:  

 Keep Fixed Timestep in Time manager high enough to save cpu cycles, but still low enough to run physics smoothly.  

 Set Maximum Allowed Timestep in Time manager to 8-10fps to cap the time spent on physics in the worst case scenario.  

 Use colliders with great care. Some of them (like mesh collider) are very expensive while some (like sphere collider) are quite cheap. This 

list enumerates colliders in order of growing performance penalty:  

o Sphere collider (cheap)  

o Box collider  

o Capsule collider  

o Mesh collider  

o Wheel collider (expensive)  

The total amount of physics calculations depends on the number of non-sleeping rigid bodies and colliders in the scene and the complexity 

of the colliders. Try to minimize these numbers and track what impact it has on physics calculation time. Track these statistics with internal 

profiler.  
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iphone-Optimizing-Scripts 
This page gives some general hints for how to improve script performance on iOS.  

Reduce Fixed Delta Time 

Use a fixed delta time of 15-25 fps. You can change this in Edit->Project Settings->Time. This reduces how often FixedUpdate is 

called and how often the physics engine has to perform collision detection and rigidbody updates. If you are using rigidbodies for the main 

character, you can enable interpolation in the Rigidbody Component to smooth out low fixed delta time steps.  

Reduce GetComponent Calls 

Using GetComponent or BuiltIn component accessors can have a noticeable overhead. You can reduce it by caching a direct 

reference to the component.  

For example:  
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function Update () { 

    transform.Translate(0, 1, 0); 

} 

You can optimize your script to this instead:  

myTransform : Transform; 

function Awake () { 

   myTransform = transform; 

} 

function Update () { 

    myTransform.Translate(0, 1, 0); 

} 

Avoid Allocating Memory 

 Minimize your allocations in scripts.  

 Use structs. Structs do not allocate memory, instead they are placed on the stack and are passed by value which is fast.  

Reduce the GUI 

 Don't use GUILayout, use GUI functions instead and minimize the amount of GUI on screen  

 Use MonoBehaviour.useGUILayout = false; to minimize GUI overhead  

function Awake () { 

    useGUILayout = false; 

} 

Use iOS Script Call Optimization 

Most of the functions in UnityEngine namespace are implemented in C/C++. Calling such functions from scripts has additional 

performance overhead. Consider using iOS Script Call optimization in Edit->Project Settings->Player to gain several extra milliseconds 

per frame:  

 Slow and Safe - default mono internal call handling with exception support.  

 Fast and Exceptions Unsupported - fast mono internal call implementation, but exceptions are not supported, so use it with care. A 

typical scenario when it could be useful: application deals a lot with Unity Engine and does not throw any exceptions. This option could 

save 1-4 ms / frame.  

Optimizing Garbage Collection 



 As mentioned above ,try avoiding any allocations  

 If allocations can't be avoided then there are two allocation/collection strategies:  

o small heap fast and frequent garbage collection 

This strategy might work well for games that have long action gameplay and needs smooth framerate. 

Typical heap for Unity iOS game which allocates small blocks for short period of time often is ~200 KB, garbage collection of such heap 

takes ~5ms (on iPhone 3G). With a 1 MB heap the duration of garbage collection increases to ~7 ms. 

Sometimes it can be useful to force garbage collection every Nth frame: 

o if (Time.frameCount % 30 == 0) 

o { 

o    System.GC.Collect(); 

o } 

But use it with care, watch internal profiler statistics, and make decisions based on them.  

o large heap slow and rare garbage collection 

This strategy might work for games that are have short to medium length smooth framerate demanding gameplay. The idea is to avoid 

garbage collection while gameplay is running and make garbage collections during gameplay pauses. It is good idea to preallocate some 

space on the heap during startup which is large enough to survive gameplay sessions yet small enough to avoid application kil ling by OS 

because of low system memory. Mono tries to expand the heap only when necessary, so sometimes it is good idea to force its expansion 

on startup: 

o function Start() { 

o  var tmp = new System.Object[1024]; 

o  // make allocations in smaller blocks to avoid them to be treated in a special way, which is designed for large blocks 

o         for (var i : int = 0; i < 1024; i++) 

o   tmp[i] = new byte[1024]; 

o  // release reference 

o         tmp = null; 

o } 

Later, you can force garbage collection when gameplay is paused: 

System.GC.Collect(); 

Use this with care, pay attention to internal profiler statistics, and make decisions based on the actual numbers.  
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iphone-InternalProfiler 



Unity iOS provides your project with a built-in performance profiler. Note that it is disabled by default. In order to enable it you will have to 

open the Unity -generated XCode project, select the AppController.mm file and change #define 

ENABLE_INTERNAL_PROFILER 0 to #define ENABLE_INTERNAL_PROFILER 1. Choose Run->Console in the XCode menu 

to display output (GDB) console and then run your project. Unity iOS will output statistics to the console window every 30 frames. For 

example:  

iPhone/iPad Unity internal profiler stats: 

cpu-player>    min:  9.8   max: 24.0   avg: 16.3 

cpu-ogles-drv> min:  1.8   max:  8.2   avg:  4.3 

cpu-waits-gpu> min:  0.8   max:  1.2   avg:  0.9 

cpu-present>   min:  1.2   max:  3.9   avg:  1.6 

frametime>     min: 31.9   max: 37.8   avg: 34.1 

draw-call #>   min:   4    max:   9    avg:   6     | batched:    10 

tris #>        min:  3590  max:  4561  avg:  3871   | batched:  3572 

verts #>       min:  1940  max:  2487  avg:  2104   | batched:  1900 

player-detail> physx:  1.2 animation:  1.2 culling:  0.5 skinning:  0.0 batching:  0.2 render: 12.0 fixed-update-count: 1 .. 2 

mono-scripts>  update:  0.5   fixedUpdate:  0.0 coroutines:  0.0  

mono-memory>   used heap: 233472 allocated heap: 548864  max number of collections: 1 collection total duration:  5.7 

All times are measured in milliseconds per frame. You can see the minimum, maximum and average times over last 30 frames.  

General CPU Activity 

cpu-player Displays time your game spends inside Unity engine and executing scripts on the CPU. 

cpu-ogles-

drv 

Displays time spent in the OpenGL ES driver on the CPU. Many factors like number of draw calls, amount of internal rendering 

state changes, rendering pipeline setup and even number of processed vertices can have effect on the driver time. 

cpu-waits-

gpu 

Displays time CPU spent waiting until GPU finishes rendering. If this number exceeds 2-3 milliseconds, your application is 

most probably fillrate/GPU processing bound. 

cpu-present The amount of time spent executing the presentRenderbuffer command in OpenGL ES. 

frametime Represents overall time of a game frame. Note that iPhone/iPad hardware is always locked at 60Hz refresh rate, thus you will 

always get multiples times of ~16.7ms (1000ms/60Hz = ~16.7ms). 

Rendering Statistics 

draw-call 

# 

The number of draw calls per frame. Keep it as low as possible. 

tris # Total number of triangles sent for rendering. 

verts # Total number of vertices sent for rendering. You should keep this number below 10000, if you use only static geometry. On the 

other hand, if you have lots of skinned geometry, then you should keep this number much lower. 

batched Number of draw-calls, triangles and vertices which were automatically batched by the engine. Comparing these numbers with 

draw-call and triangle totals will give you an idea how well is your scene prepared for batching. Share as many materials among 

your objects to improve batching. 



Detailed Unity Player Statistics 

player-detail section provides a detailed breakdown of what is happening inside the engine:  

physx Time spent on physics. 

animation Time spent animating bones. 

culling Time spent culling objects outside camera frustum. 

skinning Time spent applying animations to skinned meshes. 

batching Time spent batching geometry. Batching dynamic geometry is considerably more expensive than batching static geometry. 

render Time spent rendering visible objects. 

fixed-update-

count 

Minimum and maximum number of FixedUpdates executed during this frame. Too many FixedUpdate will deteriorate 

perforamance really fast. Follow some simple guidelines to setup an effective fixed delta time. 

Detailed Scripts Statistics 

mono-scripts section provides a detailed breakdown of time spent in Mono runtime:  

update Total time spent executing all Update() functions in scripts. 

fixedUpdate Total time spent executing all FixedUpdate() functions in scripts. 

coroutines Time spent inside script coroutines. 

Detailed Statistics on Memory Allocated by Scripts 

mono-memory section gives you an idea how much memory is used by the Mono garbage collector:  

allocated heap Total amount of memory which can be filled with objects. If there is a need for more objects than the size of allocated 

heap, then Garbage Collector will start a collection phase during which all unreferenced objects will be thrown away from 

memory. If there is not enough free memory after the collection phase, then the allocated heap will grow in size. 

used heap Portion of the allocated heap which is currently used up by objects. Every time you create a new class instance (not a 

struct) this number will grow until collection phase is invoked. 

max number of 

collections 

Number of garbage collection passes during the last 30 frames. 

collection total 

duration 

Total time (in milliseconds) of all garbage collection passes that happened during the last 30 frames. 
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iphone-Optimizing-MainLoop 

Setting Up Desired Frame-Rate 

Unity iOS allows you to tweak how many times per second your application will try to execute its rendering loop. By default it is 30 times per 

second. By lowering this number, your application will save more battery power but will render fewer frames per second. By increasing this 

value, rendering will be prioritized over other activities such as touch input and accelerometer processing. You will need to experiment with 

the frame-rate selection and determine for yourself the impact it has on your specific game.  

If your application is computational or rendering heavy and can maintain say only 15 frames per second, then setting desired frame rate 

over 15 wouldn't make any sense. First you have to optimize your application, then increase desired frame-rate.  

To set the desired frame-rate, open your XCode project generated by Unity iOS, and select the AppController.mm file. Locate and 

change #define kFPS 30 to a desired value, for example: #define kFPS 60.  

Choosing the Best Rendering Loop 

The Apple standard way of using System Timer for scheduling rendering is perfect for non-performance critical applications which favours 

battery life and scrupulous correct events processing over rendering performance. However, some games might prefer frame-rate over 

battery life. Therefore, Unity provides alternate methods which allows you to run in a tighter rendering loop:  

http://unity3d.com/support/documentation/printable.html#FixedDeltaTime


 System Timer - approach usually suggested by Apple. Uses NSTimer to schedule rendering. Has worst performance, but guarantees to 

process all input events.  

 Thread - separate thread is used to schedule rendering. Provides good performance improvement comparing with System Timer approach, 

but sometimes could miss touch or accelerometer events. This approach is easiest to setup.  

 Event Pump - uses CFRunLoop object to dispatch events. Provides good performance improvement comparing with System Timer 

approach. Allows you to explicitly define how much time operating system should spend on processing touch and accelerometer events. 

Care must be taken however as lack of time will result in lost touch or accelerometer events.  

Unity uses a thread-based rendering loop for devices with operating system older than version 3.1 by default.  

Setting up System Timer Based Main Loop 

Open the XCode project generated by Unity iOS. Select the AppController.mm file, locate and uncomment #define 

MAIN_LOOP_TYPE NSTIMER_BASED_LOOP, make sure both defines for other main loop types are removed or commented out:  

#define MAIN_LOOP_TYPE NSTIMER_BASED_LOOP 

//#define MAIN_LOOP_TYPE THREAD_BASED_LOOP 

//#define MAIN_LOOP_TYPE EVENT_PUMP_BASED_LOOP 

If you want to prioritize rendering over input processing with the System Timer based approach you have to locate and change #define 

kThrottleFPS 2.0 in AppController.mm file (for example, to #define kThrottleFPS 4.0). Increasing this number will 

give higher priority to rendering. The result of changing this value might differ for different applications, so it's best to try it for yourself and 

see the impact on your specific case.  

Setting up Thread Based Main Loop 

Open the XCode project generated by Unity iOS. Select the AppController.mm file, locate and uncomment #define 

MAIN_LOOP_TYPE THREAD_BASED_LOOP, and make sure both defines for other main loop types are removed or commented out:  

//#define MAIN_LOOP_TYPE NSTIMER_BASED_LOOP 

#define MAIN_LOOP_TYPE THREAD_BASED_LOOP 

//#define MAIN_LOOP_TYPE EVENT_PUMP_BASED_LOOP 

Setting up Event Pump Based Main Loop 

Open the XCode project generated by Unity iOS. Select the AppController.mm file, locate and uncomment #define 

MAIN_LOOP_TYPE EVENT_PUMP_BASED_LOOP, and make sure both defines for other main loop types are removed or commented 

out:  

//#define MAIN_LOOP_TYPE NSTIMER_BASED_LOOP 

//#define MAIN_LOOP_TYPE THREAD_BASED_LOOP 

#define MAIN_LOOP_TYPE EVENT_PUMP_BASED_LOOP 

If you chose the Event Pump based rendering loop, then you have to carefully tweak the 

kMillisecondsPerFrameToProcessEvents constant to achieve the desired responsiveness. The 

kMillisecondsPerFrameToProcessEvents constant allows you to specify exactly how much time (in milliseconds) you will allow 

the OS to process events. If you allocate insufficient time for this task, then touch or accelerometer events might be lost resulting in a fast, 

but less responsive application.  



To specify the amount of time (in milliseconds) that the OS will spend processing events, you have to locate and change #define 

kMillisecondsPerFrameToProcessEvents 7.0 in AppController.mm file, for example to #define 

kMillisecondsPerFrameToProcessEvents 3.0  

Display Link Support 

Although CADisplayLink was introduced in the iOS3.1 and theoretically should be a preferable approach for scheduling rendering, some 

developers reported occasional input lag on 1st generation of devices with OS 3.1 installed. If you wish to enable CADisplayLink support for 

your application, then you will have to open the XCode project generated by Unity iOS, select the AppController.mm file, and locate 

and change #define USE_DISPLAY_LINK_IF_AVAILABLE 0 into #define USE_DISPLAY_LINK_IF_AVAILABLE 1  

Tuning Accelerometer Processing Frequency 

A high frequency of accelerometer input processing might have a negative impact on overall performance of your game. By default an iOS 

Unity application will query the accelerometer input 60 times per second. You might discover an additional performance improvement by 

lowering the accelerometer frequency or even setting it to 0, if your game is not using the accelerometer at all.  

To specify desired processing frequency for the accelerometer you will have to open the Unity generated XCode project, select the 

AppController.mm file and change #define kAccelerometerFrequency 60 to a different value, for example: define 

kAccelerometerFrequency 10  
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iphone-playerSizeOptimization 
There are two ways to reduce the size of the player built by Unity iOS:  

1. changing the Active Build Configuration within Xcode; or  

2. changing the Stripping Level within Unity iOS.  

Building in Release Mode 

After building your Xcode project folder, it is possible to select Debug or Release from a the Active Build Configuration drop-down menu. 

Building as Release instead of Debug will reduce your built player size by up to 2-3MB, depending on your game.  



 

The Active Build Configuration drop-down 

The trade-off for building a Release Build is that all debug information is stripped from the player, so if your game crashes or has other 

problems, no stack trace information is output. In these cases, it is best to build a Debug version of your game and reproduce the crash so 

you get full debug information.  

iOS Stripping Level (Advanced License feature) 

Stripping-related size optimizations work in following way:  

A) Strip assemblies level: script byte code is analyzed. Classes and methods that are not referenced from the scripts are removed from 

the DLLs and are also excluded from the AOT step. This optimization reduces the size of the main binary and accompanying DLLs. This 

feature is safe when no reflection is used.  

B) Strip ByteCode level: accompanying .NET DLLs (stored in the Data folder) are stripped down to metadata only. This is possible 

because all the code is already precompiled with the AOT and linked into the main binary.  

C) Use micro mscorlib level: a special, smaller version of mscorlib is used. Some components are removed from this library, for example: 

Security, Reflection.Emit, Remoting, non Gregorian calendars, etc. Also, internal component inter-dependencies are minimized. This 

optimization reduces the main binary and mscorlib.dll size. This feature is not compatible with some System and System.Xml assembly 

classes, so use it with care.  

Note: These levels are accumulative, so level (C) optimization includes both levels (B) and (A), and level (B) optimization includes level (A).  

Note: Micro mscorlib is a heavily stripped version of a core library. Only those items that are required by the Mono runtime on Unity engine 

remain. Best practice for using micro mscorlib is not to use any class/features of .NET that are not required by you application. GUIDs are a 

good example of what shouldn't be used; these could be easily replaced with custom made pseudo GUIDs and it would offer you both 

better performance and app size.  

Tips 

How to Deal with Stripping when Using Reflection 



Stripping heavily depends on static code analysis and sometimes it fails to do the job right, especially when dynamic features (like 

reflection) are used. In such cases some hinting what classes shouldn't be touched is needed. Unity iOS supports per project custom 

stripping black list. The process is simple:  

1. Create link.xml file and place it directly into Assets (project root) folder.  

2. link.xml sample structure is as follows: 

<linker> 

       <assembly fullname="System.Web.Services"> 

               <type fullname="System.Web.Services.Protocols.SoapTypeStubInfo" preserve="all"/> 

               <type fullname="System.Web.Services.Configuration.WebServicesConfigurationSectionHandler" preserve="all"/> 

       </assembly> 

 

       <assembly fullname="System"> 

               <type fullname="System.Net.Configuration.WebRequestModuleHandler" preserve="all"/> 

               <type fullname="System.Net.HttpRequestCreator" preserve="all"/> 

               <type fullname="System.Net.FileWebRequestCreator" preserve="all"/> 

       </assembly> 

</linker> 

Note: Sometimes there is a problem to identify what code gets stripped, but still is required for application to run. You might get some 

useful hints by running stripped application on simulator and watching Xcode console for error messages.  

Simple Checklist of How to Make Your Distribution as Small as Possible 

1. Minimize your assets: make all textures PVRTC compressed and reduce texture resolution if possible; minimize uncompressed 

sounds. Check file size reduction documentation here.  

2. Set iOS Stripping Level to Use micro mscorlib.  

3. Set script call optimization to Fast but no exceptions.  

4. Don't use anything that lives in System.dll or System.Xml.dll in your code. Those two are not compatible with micro mscorlib.  

5. Remove unnecessary code dependencies.  

6. Remove unnecessary assets.  

7. Use .Net 2.0 subset as Api Compatibility Level Note: .Net 2.0 subset has limited compatibility with other libraries.  

8. Set Target Platform to armv6 (OpenGL ES1.1).  

9. Don't use JS Arrays.  

10. Avoid generic containers in combination with value types (all structs are value types).  

Can I go below 20 mega bytes with Unity iOS? 

Yes, empty project would take ~13 MB in the AppStore if all the size optimizations are turned off. You still have 7MB budged for 

compressed assets for your game. If you own an Advanced License (required for the stripping option) you are in much better shape. In this 

http://unity3d.com/support/documentation/Manual/Reducing%20File%20size.html


case an empty scene with just the main camera will take up about 6 MB in the AppStore (zipped and DRM attached) and you will have ~14 

MB budged for compressed assets.  

My app has grown in size when released to AppStore. What should we do to to keep the size from growing? 

When published to the AppStore, Apple first encrypts the binary file and then compresses it via zip. Most often Apple's DRM increases 

binary size about 4 MB or so. As a general rule you may expect the "final" size to be approximately: The size of the zip compressed archive 

of all files except the executable + the size of the uncompressed executable file. Please read the short list above about how to get the 

distribution size as small as possible.  
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iphone-accountsetup 
There are some steps you must follow before you can build and run any code (including Unity-built games) on your iPhone/iPad. These 

steps are prerequisite to publishing your own iOS games.  

1. Apply for and Become a Registered iPhone/iPad Developer: 

You do this through Apple's website: http://developer.apple.com/iphone/program/  

2. Upgrade your Operating System and iTunes Installation: 

Please note that these are Apple induced requirements as part of using the iPhone SDK and this can change.  

3. Download the iPhone SDK 

Go to the iPhone dev center and log-in. Download and install the latest iPhone SDK. Do not download the beta version of the SDK, only 

use the latest shipping version. Note that downloading and installing the iPhone SDK will also install XCode.  

4. Get Your Device Identifier 

Using the USB cable plug-in your iOS device and launch XCode. XCode will detect your phone as a new device; press the button to "Use 

For Development". If that doesn't open the Organizer window then go to Window->Organizer. You should see your iPhone/iPod 

Touch/iPad) in the devices list at left, select it and note your device's identifier code (it's long, 40 digits or so).  

5. Add Your Device 

Log in to the iPhone developer center, and enter the program portal (button on the right). Go to the Devices page (link on left side), once on 

the Devices page click the Add Device button on the right. Enter a name for your device (alpha numeric only) and your device's identifier 

code (gathered in step 5 above). Click the Submit button when done.  

6. Create a Certificate 

Within the iPhone Developer Program Portal click the Certificates link on the left side, follow the instructions listed under How-To...  

7. Download WWDR Intermediate Certificate (and install). 

Download link is in the same "Certificates" just above "Important Notice" red text block. Link is called WWDR Intermediate Certificate. Once 

downloaded, double-click to install the certificate.  

8. Create a Provisioning File 

Provisioning Profiles are a bit complex, and should be set up differently depending on how you've organized your team. Since there is no 

case that fits all circumstances, please read up on how Provisioning works on Apple's Developer site in the Provisioning How-to section.  
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iphone-unsupported 

Graphics 

 DXT texture compression is not supported; use PVRTC formats instead. Please see the Texture2D Component page for more information.  

 Rectangular textures can not be compressed to PVRTC formats.  

 Movie Textures are not supported; use a full-screen streaming playback instead. Please see the Movie playback page for more information.  

 Terrain engine is not supported.  

 Tree Creator is not supported.  

 Open GL ES2.0 is not supported on iPhone, iPhone 3G, iPod Touch 1st and iPod Touch 2nd Generation hardware.  

Audio 

 Ogg audio compression is not supported. Ogg audio will be automatically converted to MP3 when you switch to iOS platform in the Editor. 

Please see the AudioClip Component page for more information about audio support in Unity iOS.  

Scripting 

 OnMouseDown, OnMouseEnter, OnMouseOver, OnMouseExit, OnMouseDown, OnMouseUp, OnMouseDrag events are not 

supported.  

 Dynamic features like Duck Typing are not supported. Use #pragma strict for your scripts to force the compiler to report dynamic 

features as errors.  

 Video streaming via WWW class is not supported.  

 FTP support by WWW class is limited.  

Features Restricted to Unity iOS Advanced License 

 Static batching is only supported in Unity iOS Advanced.  

 Video playback is only supported in Unity iOS Advanced.  

 Splash-screen customization is only supported in Unity iOS Advanced.  

 AssetBundles are only supported in Unity iOS Advanced.  

 Code stripping is only supported in Unity iOS Advanced.  

 .NET sockets are only supported in Unity iOS Advanced.  

Note: it is recommended to minimize your references to external libraries, because 1 MB of .NET CIL code roughly translates to 3-4 MB of 

ARM code. For example, if your application references System.dll and System.Xml.dll then it means additional 6 MB of ARM code if 

stripping is not used. At some point application will reach limit when linker will have troubles linking the code. If you care a lot about 

application size you might find C# a more suitable language for your code as is has less dependencies than JavaScript.  
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iphone-Plugins 
Unity has extensive support for C, C++ or Objective-C based Plugins. Plugins allow your game code (written in Javascript, C# or Boo) to 

call into native code libraries. This allows Unity to integrate with other middleware libraries or legacy game code.  

Note: Plugins are a Pro-only feature. For desktop builds, plugins will work in standalones only. They are disabled when building a Web 

Player for security reasons.  

In order to use a plugin you need to do two things:  

 Write a plugin in a C based language and compile it.  

http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/Manual/Video%20Files.html
http://unity3d.com/support/documentation/Components/class-AudioClip.html


 Create a C# script which calls functions in the plugin to do something.  

So the plugin provides a simple C interface. The script then invokes the functions exposed by the plugin.  

Here is a very simple example:  

The C File of a Minimal Plugin: 

float FooPluginFunction () { return 5.0F; }  

A C# Script that Uses the Plugin: 

 

Desktop  
 

using UnityEngine; 

using System.Runtime.InteropServices; 

 

class SomeScript : MonoBehaviour { 

   // This tells unity to look up the function FooPluginFunction 

   // inside the plugin named "PluginName" 

   [DllImport ("PluginName")] 

   private static extern float FooPluginFunction (); 

 

   void Awake () { 

      // Calls the FooPluginFunction inside the PluginName plugin 

      // And prints 5 to the console 

      print (FooPluginFunction ()); 

   } 

}  

 

iOS 
 

using UnityEngine; 
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using System.Runtime.InteropServices; 

 

class SomeScript : MonoBehaviour { 

   // This tells unity to look up the function FooPluginFunction 

   // inside the static binary 

   [DllImport ("__Internal")] 

   private static extern float FooPluginFunction (); 

 

   void Awake () { 

      // Calls the native FooPluginFunction 

      // And prints 5 to the console 

      print (FooPluginFunction ()); 

   } 

}  

 

Android 
 

using UnityEngine; 

using System.Runtime.InteropServices; 

 

class SomeScript : MonoBehaviour { 

   // This tells unity to look up the function FooPluginFunction 

   // inside the plugin named "PluginName" 

   [DllImport ("PluginName")] 

   private static extern float FooPluginFunction (); 
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   void Awake () { 

      // Calls the FooPluginFunction inside the PluginName plugin 

      // And prints 5 to the console 

      print (FooPluginFunction ()); 

   } 

}  

 

Desktop  
 

Building a Plugin for Mac OS X 

If you are building a plugin for Mac OS X, you have to create a bundle. The easiest way to do this is using XCode. Use File->NewProject... 

and select the Bundle - Carbon/Cocoa Loadable Bundle.  

If you are using C++ (.cpp) or Objective-C (.mm) to implement the plugin you have to make sure the functions are declared with C linkage 

to avoid name mangling issues.  

extern "C" { 

  float FooPluginFunction (); 

}  

Building a Plugin for Windows 

Plugins on Windows are DLL files with exported functions. Practically any language or development environment that can create DLL files 

can be used to create plugins. 

Again, if you use C++, declare functions with C linkage to avoid name mangling issues.  

Using your plugin from C# 

Once you have built your bundle you have to copy it to Assets->Plugins folder. Unity will then find it by its name when you define a 

function like this:  

[DllImport ("PluginName")] 

private static extern float FooPluginFunction ();  

Please note that PluginName should not include the extension of the filename. Be aware that whenever you change code in the Plugin you 

will have to recompile scripts in your project or else the plugin will not have the latest compiled code.  

Deployment 
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For cross platform plugins you have to include both .bundle (for Mac) and .dll (for Windows) files in Plugins folder. Once you have placed 

your plugins in the Plugins folder there is no more work required on your side. Unity automatically picks the right plugin for the right 

deployment platform and includes it with the player.  

 

iOS 
 

Building an Application with Native Plugin for iOS 

1. Define your extern method like:  

2. [DllImport ("__Internal")] 

private static extern float FooPluginFunction (); 

3. Switch the editor to iOS platform  

4. Add your native implementation to the generated XCode project's "Classes" folder (this folder is not overwritten when project is 

updated, but don't forget to backup your native code).  

If you are using C++ (.cpp) or Objective-C (.mm) to implement the plugin you have to make sure the functions are declared with C linkage 

to avoid name mangling issues.  

extern "C" { 

  float FooPluginFunction (); 

}  

Using Your Plugin from C# 

iOS native plugins can be called only when deployed on the actual device, so it is recommended to wrap all native code methods with an 

additional C# code layer. This code could check Application.platform and call native methods only when running on the actual device and 

return mockup values when running in the Editor. Check the Bonjour browser sample application.  

Calling C# / JavaScript back from native code 

Unity iOS supports limited native->managed callback functionality via UnitySendMessage: 

UnitySendMessage("GameObjectName1", "MethodName1", "Message to send"); 

This function has three parameters : game object name, game object script method to call, message to pass to the called method. 

Limitations to know:  

1. only script methods that correspond to the following signature can be called from native code: function 

MethoName(message:string)  

2. calls to UnitySendMessage are asynchronous and have a one frame delay.  

Automated plugin integration 

Unity iOS supports limited automated plugin integration.  

1. All the .a,.m,.mm,.c,.cpp located in Assets/Plugins/iOS will be automatically merged into produced Xcode project.  

2. Merging is done by symlinking files from Assets/Plugins/iOS to the final destination and this might affect some workflows.  

3. .h files are not included into Xcode project tree, but they appear on final destination file system, thus allowing compilation of 

.m/.mm/.c/.cpp.  
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Note: subfolders are not supported.  

iOS Tips 

1. Managed -> unmanaged calls are quite expensive on iOS. Try to avoid calling multiple native methods per frame.  

2. As mentioned above wrap your native methods with an additional C# layer that would call actual code on the device and return 

mockup values in the Editor.  

3. String values returned from a native method should be UTF-8 encoded and allocated on the heap. Mono marshaling calls are free 

for them.  

4. As mentioned above the XCode project's "Classes" folder is a good place to store your native code, because it is not overwritten 

when the project is updated.  

5. Another good place for storing native code is the Assets folder or one of its subfolders. Just add references from the XCode 

project to the native code files: right click on the "Classes" subfolder and choose "Add->Existing files...".  

 

Android 
 

Building a Plugin for Android 

To build a plugin for Android, you first need the Android NDK. Please familiarize yourself with the steps how to build a shared library.  

If you are using C++ (.cpp) to implement the plugin you have to make sure the functions are declared with C linkage to avoid name 

mangling issues.  

extern "C" { 

  float FooPluginFunction (); 

}  

Using Your Plugin from C# 

Once you have built your shared library you have to copy it to Assets->Plugins->Android folder. Unity will then find it by its name when 

you define a function like this:  

[DllImport ("PluginName")] 

private static extern float FooPluginFunction ();  

Please note that PluginName should not include the prefix ('lib') nor the extension ('.so') of the filename. It is recommended to wrap all 

native code methods with an additional C# code layer. This code could check Application.platform and call native methods only when 

running on the actual device and return mockup values when running in the Editor. You can also use platform defines to control platform 

dependent code compilation.  

Deployment 

For cross platform plugins, your Plugins folder may include plugins for several different platforms (i.e. libPlugin.so for Android, 

Plugin.bundle for Mac and Plugin.dll for Windows). Unity automatically picks the right plugin for the right deployment platform and includes 

it with the player.  

Using Java Plugins 

The Android plugin mechanism also allows Java to be used to enable interaction with the Android OS. Java code can not be called directly 

from C#, so you'd need to write a native plugin to 'translate' the calls between C# and Java.  
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Building a Java Plugin for Android 

There are several ways to create a Java plugin. What they have in common is that you will end up with a .jar file containing the .class files 

for your plugin. One way is to start off with downloading the JDK, then compile your .java files from command line with javac to create .class 

files and package them into a .jar with the jar command line tool. Another way is to use Eclipse IDE together with the ADT.  

Using Your Java Plugin from Native Code 

Once you have built your Java plugin (.jar) you have to copy it to Assets->Plugins->Android folder. Unity will package your .class files 

together with the rest of the Java code, and then call it through something called Java Native Interface (JNI). JNI works both ways; calling 

native code from Java, and interacting with Java (or the JavaVM) from native code.  

To find your Java code from the native side you need to have access to the Java VM. Fortunately that is quite easy; just add a function like 

this to your C(++) code:  

jint JNI_OnLoad(JavaVM* vm, void* reserved) { 

  JNIEnv* jni_env = 0; 

  vm->AttachCurrentThread(&jni_env, 0); 

}  

This is all that is needed to start using Java from C(++). Completely explaining JNI is somewhat beyond the scope of this document, but 

usually it includes finding the class definition, resolving the constructor (<init>) method and create a new object instance, as shown here:  

jobject createJavaObject(JNIEnv* jni_env) { 

  jclass cls_JavaClass = jni_env->FindClass("com/your/java/Class");   // find class definition 

  jmethodID mid_JavaClass = jni_env->GetMethodID (cls_JavaClass, "<init>",  "()V");  // find constructor method 

  jobject obj_JavaClass = jni_env->NewObject(cls_JavaClass, mid_JavaClass);  // create object instance 

  return jni_env->NewGlobalRef(obj_JavaClass);      // return object with a 

global reference 

}  

Using Your Java Plugin with helper classes 

AndroidJNIHelper together with AndroidJNI can be used to ease a bit of pain with raw JNI.  

AndroidJavaObject and AndroidJavaClass automate a lot of things and also use caches to make calls to Java faster. The combination of 

AndroidJavaObject and AndroidJavaClass builds on top of AndroidJNI and AndroidJNIHelper, but also has a lot of logic in itself (to 

handle the automation). These classes also come in a 'static' version to access static members of Java class.  

You can opt for any approach you like, be it a raw JNI through AndroidJNI class methods, or AndroidJNIHelper together with AndroidJNI 

and eventually AndroidJavaObject/AndroidJavaClass for the maximum automation and convenience.  

 UnityEngine.AndroidJNI is a wrapper for the JNI calls available in C (as described above). All methods in this class are static and have a 

1:1 mapping to the Java Native Interface.  
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 UnityEngine.AndroidJNIHelper provides helper functionality used by the next level, but is exposed as public methods because they may be 

useful for some special cases.  

 Instances of UnityEngine.AndroidJavaObject and UnityEngine.AndroidJavaClass have a 1:1 mapping to an instances of java.lang.Object 

and java.lang.Class (or subclasses thereof) on the Java side, correspondingly. They essentially provide 3 types of interaction with the Java 

side:  

o Call a method  

o Get the value of a field  

o Set the value of a field  

The Call is separated into two categories: Call to a 'void' method, and Call to a method with non-void return type. A generic type is used to 

represent the return type of those methods which return a non-void type.The Get/Set always take a generic type representing the field type.  

Example 1 

//The comments is what you would need to do if you use raw JNI 

 AndroidJavaObject jo = new AndroidJavaObject("java.lang.String", "some_string");  

 // jni.FindClass("java.lang.String");  

 // jni.GetMethodID(classID, "<init>", "(Ljava/lang/String;)V");  

 // jni.NewStringUTF("some_string");  

 // jni.NewObject(classID, methodID, javaString);  

 int hash = jo.Call<int>("hashCode");  

 // jni.GetMethodID(classID, "hashCode", "()I");  

 // jni.CallIntMethod(objectID, methodID); 

Here we're creating an instance of java.lang.String, initialized with a of our choice and retrieving the hash value for that string.  

The AndroidJavaObject constructor takes at least one parameter: the name of class for which we want to construct an instance. 

Everything after the class name are parameters for the constructor call of the object, in this case a string "some_string". Then the Call to 

hashCode() that returns an 'int' which is why we use that as the generic type parameter to the Call method.  

Note: You cannot instantiate nested Java class using dotted notation. Inner classes must use $ separator, and it should work in both dotted 

and slash'd format. So android.view.ViewGroup$LayoutParams or android/view/ViewGroup$LayoutParams can be used, where 

LayoutParams class is nested in ViewGroup class.  

Example 2 

One of the plugin samples above shows how to get the cache dir for the current application. This is how you would to it from C# without any 

plugins:  

 AndroidJavaClass jc = new AndroidJavaClass("com.unity3d.player.UnityPlayer");  

 // jni.FindClass("com.unity3d.player.UnityPlayer");  

 AndroidJavaObject jo = jc.GetStatic<AndroidJavaObject>("currentActivity");  
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 // jni.GetStaticFieldID(classID, "Ljava/lang/Object;");  

 // jni.GetStaticObjectField(classID, fieldID);  

 // jni.FindClass("java.lang.Object");  

 

 Debug.Log(jo.Call<AndroidJavaObject>("getCacheDir").Call<string>("getCanonicalPath"));  

 // jni.GetMethodID(classID, "getCacheDir", "()Ljava/io/File;"); // or any baseclass thereof!  

 // jni.CallObjectMethod(objectID, methodID);  

 // jni.FindClass("java.io.File");  

 // jni.GetMethodID(classID, "getCanonicalPath", "()Ljava/lang/String;");  

 // jni.CallObjectMethod(objectID, methodID);  

 // jni.GetStringUTFChars(javaString); 

Here we start with AndroidJavaClass instead of AndroidJavaObject, because we want access a static member of 

com.unity3d.player.UnityPlayer, not create a new object (there is already one created as part of the Android UnityPlayer). Then we 

access the static field "currentActivity" but this time we use AndroidJavaObject as the generic parameter. This is because the actual field 

type (android.app.Activity) is a subclass of java.lang.Object, and any non-primitive type must be accessed as AndroidJavaObject (strings 

are the exception to that rule; they can be accessed directly even though they don't represent a primitive type in Java).  

After that it's just a matter of simply traversing the Activity through getCacheDir(), to get the File object representing the cache directory, 

and call getCanonicalPath() to get a string representation.  

Of course nowadays you don't need to do that to get the cache directory; we have provided access to the application's cache and file 

directory through Application.temporaryCachePath, Application.persistentDataPath.  

Example 3 

Finally a small trick to show how we can pass data from Java to script code using UnitySendMessage.  

using UnityEngine;  

public class NewBehaviourScript : MonoBehaviour {  

 

 void Start () {  

  JNIHelper.debug = true;  

  using (JavaClass jc = new JavaClass("com.unity3d.player.UnityPlayer")) {  
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   jc.CallStatic("UnitySendMessage", "Main Camera", "JavaMessage", "whoowhoo");  

  }  

 }  

 

 void JavaMessage(string message) {  

  Debug.Log("message from java: " + message);  

 } 

}  

The Java class com.unity3d.player.UnityPlayer now has a static method UnitySendMessage, equivalent to the iOS' UnitySendMessage 

on the native side; it can be used in Java to pass data to script code.  

But here we call it directly from script code. That essentially relays the message on the Java side, which then calls back in the native/Unity 

to deliver the message to the object named "Main Camera", with a script attached to it which as a method called "Java Message".  

The best practices of using the Java plugins with Unity 

As this section is manly targeted at people who don't have comprehensive JNI, Java and Android experience, we assume that 

AndroidJavaObject/AndroidJavaClass approach has been taken to interact with Java code from Unity.  

The very first thing that should be noted is that any operation you do on a AndroidJavaObject / AndroidJavaClass is expensive (as is a 

raw JNI approach though). It's very much recommended to keep the number of transitions between managed and native/java to a 

minimum. Both for the sake of performance and also complexity.  

Basically you could have a Java method to do all the actual work and then use AndroidJavaObject / AndroidJavaClass to communicate 

with that method and get the result. That's said, it may be beneficial to know, that with JNI helper classes we try to cache as much data as 

possible.  

//The first time you call a Java function like  

AndroidJavaObject jo = new AndroidJavaObject("java.lang.String", "some_string");  // somewhat expensive 

int hash = jo.Call<int>("hashCode");  // first time - expensive 

int hash = jo.Call<int>("hashCode");  // second time - not as expensive as we already know the java method and can call it straight 

It's the same way as a JIT: first time you call it, it will be slow because the code doesn't exist. Next time is much cheaper. In other words, 

you pay for every .Call /.Get / .Set, but you pay less after the first time you call it, per object. You pay for creating a AndroidJavaClass / 

AndroidJavaObject.  

Mono garbage collector should release all the created instances of AndroiJavaObject / AndroidJavaClass, yet it is strongly advised to 

keep them in a using(){} statement to ensure they are deleted as soon as possible. Otherwise there is no real guarantee when they will be 

destroyed. If you set AndroidJNIHelper.debug = true; you will see the debug output exposing the Garbage Collector behavior.  

http://unity3d.com/support/documentation/Manual/Plugins.html#iPhonePlugins


//Getting the system language with the safe approach 

void Start () {  

 using (AndroidJavaClass cls = new AndroidJavaClass("java.util.Locale")) {  

  using(AndroidJavaObject locale = cls.CallStatic<AndroidJavaObject>("getDefault")) {  

   Debug.Log("current lang = " + locale.Call<string>("getDisplayLanguage"));  

 

  }  

 }  

} 

You can also call the .Dispose() method directly to ensure there are no Java objects lingering. The actual C# object might live a bit longer 

though, but will be garbage collected by mono eventually.  

Extending the UnityPlayerActivity Java Code 

With Unity Android it is also possible to extend the regular UnityPlayerActivity (primary Java class for the Unity Player on Android, similarly 

to AppController.mm on Unity iOS).  

An application can, by creating a new Activity which derives from UnityPlayerActivity (UnityPlayerActivity.java can be found at 

/Applications/Unity/Unity.app/Contents/PlaybackEngines/AndroidPlayer/src/com/unity3d/player on Mac and usually at C:\Program 

Files\Unity\Editor\Data\PlaybackEngines\AndroidPlayer\src\com\unity3d\player), override any and all of the basic interaction between 

Android OS and Unity Android.  

To do that first locate the classes.jar shipped with Unity Android. It is found under the installation folder (usually C:\Program 

Files\Unity\Editor\Data (on Windows) or /Applications/Unity (on Mac)) in a folder called PlaybackEngines/AndroidPlayer/bin. Then 

add that classes.jar file to the classpath used to compile the new activity. The resulting .class file(s) should be compressed into a .jar file 

and placed under Assets->Plugins->Android. As the manifest dictates which activity to launch it's also necessary to create a new 

AndroidManifest.xml. The AndroidManifest.xml should also be placed under Assets->Plugins->Android.  

The new activity could look like OverrideExample.java:  

package com.company.product; 

 

import com.unity3d.player.UnityPlayerActivity; 

 

import android.os.Bundle; 

import android.util.Log; 

http://developer.android.com/reference/android/app/Activity.html
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public class OverrideExample extends UnityPlayerActivity { 

 

  protected void onCreate(Bundle savedInstanceState) { 

 

    // call UnityPlayerActivity.onCreate() 

    super.onCreate(savedInstanceState); 

 

    // print debug message to logcat 

    Log.d("OverrideActivity", "onCreate called!"); 

  } 

 

  public void onBackPressed() 

  { 

    // instead of calling UnityPlayerActivity.onBackPressed() we just ignore the back button event 

    // super.onBackPressed(); 

  } 

}  

And this is what the matching AndroidManifest.xml would look like:  

<?xml version="1.0" encoding="utf-8"?> 

<manifest xmlns:android="http://schemas.android.com/apk/res/android" package="com.company.product"> 

  <application android:icon="@drawable/app_icon" android:label="@string/app_name"> 

 <activity android:name=".OverrideExample" 

     android:label="@string/app_name"> 



        <intent-filter> 

   <action android:name="android.intent.action.MAIN" /> 

   <category android:name="android.intent.category.LAUNCHER" /> 

  </intent-filter> 

 </activity> 

  </application> 

</manifest>  

Examples 
 

Desktop  
 

Simplest Plugin 

This is a basic example of a project and a plugin that only do basic operations (prints a number, prints a string, adds two floats and adds 

two integers). Check this example if this is your first time learning plugins in Unity. 

The project can be found here.  

This project includes both Windows and Mac project files.  

Midi Plugin 

A complete example of the Plugin interface can be found here.  

This is a complete Midi plugin for OS X which uses Apple's CoreMidi API. It provides a simple C API and a C# class using the C API. The 

C# class contains a high level API, with easy access to NoteOn and NoteOff events and their velocity.  

Texture Plugin 

An example of how to assign image data to a texture from C++ directly to OpenGL (note that this will only work when Unity is using an 

OpenGL renderer). This example includes both XCode (for Mac) and Visual Studio (for Windows) project files. The plugin with 

accompanying Unity project can be found here.  

 

iOS 
 

Bonjour Browser Sample 

A simple example of the use of native code plugin can be found here  

This sample demonstrates how objective-C code can be invoked from a Unity iOS application. This application implements a very simple 

Bonjour client. The application consists of a Unity iOS project (Plugins/Bonjour.cs: C# interface to the native code, BonjourTest.js: JS script 

that implements application logic) and native code (Assets/Code) that should be added to built XCode project.  
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Android 
 

Native Plugin Sample 

A simple example of the use of native code plugin can be found here  

This sample demonstrates how C code can be invoked from a Unity Android application. The package includes a scene which displays the 

sum to two values, calculated by the native plugin. Please note that you will need the Android NDK to compile the plugin.  

Java Plugin Sample 

An example of the use of Java code can be found here  

This sample demonstrates how Java code can be used to interact with the Android OS and how C++ creates a bridge between C# and 

Java. The package includes a scene which displays a button that when pressed fetches the application cache directory, as defined by the 

Android OS. Please note that you will need both the JDK and the Android NDK to compile the plugins.  

The same example but based on a prebuilt JNI library to wrap the native code into C# can be found here  

More Information 

Mono Interop with native libraries.  

P-invoke documentation on MSDN.  
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iphone-Downloadable-Content 
This chapter does not aim to cover how to integrate your game with Apple's "StoreKit" API. It is assumed that you already have integration 

with "StoreKit" via a native code plugin.  

Apple's "StoreKit" documentation defines four kinds of Products that could be sold via the "In App Purchase" process:  

 Content  

 Functionality  

 Services  

 Subscriptions  

This chapter covers the first case only and focuses mainly on the downloadable content concept. AssetBundles are ideal candidates for 

use as downloadable content, and two scenarios will be covered:  

 How to export asset bundles for use on iOS  

 How download and cache them on iOS  

Exporting your assets for use on iOS 

Having separate projects for downloadable content can be a good idea, allowing better separation between content that comes with your 

main application and content that is downloaded later.  

Please note: Any game scripts included in downloadable content must also be present in the main executable.  

1. Create an Editor folder inside the Project View.  
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2. Create an ExportBundle.js script there and place the following code inside: 

3. @MenuItem ("Assets/Build AssetBundle From Selection - Track dependencies") 

4. static function ExportBundle(){ 

5.  

6.         var str : String = EditorUtility.SaveFilePanel("Save Bundle...", Application.dataPath, Selection.activeObject.name, 

"assetbundle"); 

7.         if (str.Length != 0){ 

8.              BuildPipeline.BuildAssetBundle(Selection.activeObject, Selection.objects, str, BuildAssetBundleOptions.CompleteAssets, 

BuildTarget.iPhone); 

9.         } 

10. } 

11. Design your objects that need to be downloadable as prefabs  

12. Select a prefab that needs to be exported and mouse right click 

 

If the first two steps were done properly, then the Build AssetBundle From Selection - Track dependencies context menu item 

should be visible.  

13. Select it if you want to include everything that this asset uses.  

14. A save dialog will be shown, enter the desired asset bundle file name. An .assetbundle extension will be added automatically. 

The Unity iOS runtime accepts only asset bundles built with the same version of the Unity editor as the final application. Read 

BuildPipeline.BuildAssetBundle for details.  

Downloading your assets on iOS 

1. Asset bundles can be downloaded and loaded by using the WWW class and instantiating a main asset. Code sample: 

2.  var download : WWW; 

3.  

http://unity3d.com/support/documentation/ScriptReference/BuildPipeline.BuildAssetBundle.html
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4.  var url = "http://somehost/somepath/someassetbundle.assetbundle"; 

5.  

6.  download = new WWW (url); 

7.  

8.  yield download; 

9.  

10.  assetBundle = download.assetBundle; 

11.  

12.  if (assetBundle != null) { 

13.   // Alternatively you can also load an asset by name (assetBundle.Load("my asset name")) 

14.   var go : Object = assetBundle.mainAsset; 

15.  

16.   if (go != null) 

17.    instanced = Instantiate(go); 

18.   else 

19.    Debug.Log("Couldnt load resource");  

20.  } else { 

21.   Debug.Log("Couldnt load resource");  

22.  } 

23. You can save required files to a Documents folder next to your game's Data folder. 

24.         public static string GetiPhoneDocumentsPath () {  

25.                 // Your game has read+write access to /var/mobile/Applications/XXXXXXXX-XXXX-XXXX-XXXX-

XXXXXXXXXXXX/Documents  

26.                 // Application.dataPath returns               

27.                 // /var/mobile/Applications/XXXXXXXX-XXXX-XXXX-XXXX-XXXXXXXXXXXX/myappname.app/Data  



28.                 // Strip "/Data" from path  

29.                 string path = Application.dataPath.Substring (0, Application.dataPath.Length - 5);  

30.                 // Strip application name  

31.                 path = path.Substring(0, path.LastIndexOf('/'));   

32.                 return path + "/Documents";  

33.         } 

34. Cache a downloaded asset bundle using the .NET file API and for reuse it in the future by loading it via WWW class and 

file:///pathtoyourapplication/Documents/savedassetbundle.assetbundle. Sample code for caching: 

35.  // Code designed for caching on iPhone, cachedAssetBundle path must be different when running in Editor 

36.  // See code snippet above for getting the path to your Documents folder 

37.  private var cachedAssetBundle : "path to your Documents folder" + "/savedassetbundle.assetbundle";  

38.  var cache = new System.IO.FileStream(cachedAssetBundle, System.IO.FileMode.Create); 

39.  cache.Write(download.bytes, 0, download.bytes.Length); 

40.  cache.Close(); 

41.  Debug.Log("Cache saved: " + cachedAssetBundle); 
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MobileCustomizeSplashScreen 
 

iOS 
 

How do I make a splash screen? 
As part of your game publishing process, you may want to customize the splash screen that appears when launching your game on the 

device. Unity iOS Basic users can choose between four different orientations of the included splash screen, and Unity iOS Advanced users 

can use any texture to create their own unique splash screens to be displayed.  

The splash screen can be customized in Player Settings. The desired splash orientation is specified via the "Default Screen Orientation" 

Player Settings (Resolution and Presentation section) property.  

Using one of the included splash screens 

You can choose one of four default splash screen orientations:  
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1. Portrait - The user interface and splash screen are oriented vertically. The home button is on the bottom of the device.  

2. Portrait Upside Down - The user interface and splash screen are oriented vertically. The home button is on the top of the device.  

3. Landscape Right - The user interface and splash screen are oriented horizontally. The home button is on the left side of the 

device.  

4. Landscape Left - The user interface and splash screen are oriented horizontally. The home button is on the right side of the 

device.  

Using a unique splash screen (Pro License feature) 

Unity iOS Pro users can use any texture as a splash screen. The standard splash screen size varies with the device (320x480 pixels for 1-

3rd gen devices, 1024x768 for iPad, 640x960 for 4th gen devices). Textures not matching this size will be automatically re-sized. 

Instructions:  

1. Drop your splash screen texture anywhere in the Assets folder.  

2. In Player Settings (Splash Image section), select your texture for Mobile Splash Screen, High Res. iPhone or iPad 

Portrait/Landscape properties. You need to specify only the ones that are applicable for your target device.  

That's it! When your game is built, your custom image will be used.  

 

Android 
 

How do I make a Splash Screen? 
As part of your game publishing process, you may want to customize the splash screen that appears when launching your game on the 

device. Unity Android Basic users can choose between two orientations of the included splash screen, and Unity Android Advanced users 

can use any texture to create their own unique splash screen to be displayed.  

Customizing the splash screen is performed in Player Settings. The desired splash orientation is specified via "Default Screen Orientation" 

Player Settings (Resolution and Presentation section) property.  

Using One of the Included Splash Screens 

You can choose one of four default Splash Screen orientations:  

1. Portrait - user interface and Splash Screen is oriented vertically. Home button is on the bottom of device.  

2. Portrait Upside Down - falls back to Portrait.  

3. Landscape Left - user interface and Splash Screen is oriented horizontally. Home button is on right side of device.  

4. Landscape Right - falls back to Landscape Left.  

Using a Unique Splash Screen (Pro License feature) 

Unity Android Pro users can use any texture as a splash screen. Instructions:  

1. Drop your texture for Splash Screen anywhere in Assets folder.  

2. In Player Settings (Splash Image section) select your texture for Mobile Splash Screen property.  

3. Select a Splash scaling that best suit your needs.  

o Center (only scale down) will try to draw your image "pixel correct", with no scaling unless needed to fit it on screen.  

o Scale to fit (letter-boxed) will try to draw your image full screen, but without cropping it, an fill the empty space with black pixels.  

o Scale to fill (cropped) will draw your image full screen, and cut the parts which extend outside the screen.  

That's it! When your game is built, your custom image will be used.  

Page last updated: 2011-02-24 
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iphone-troubleshooting 
This section address common problems you can find when using Unity, please choose the platform you are having problems at.  

 

Desktop  
 

In MonoDevelop, the Debug button is greyed out! 

 This means that MonoDevelop was unable to find the Unity executable; in the MonoDevelop preferences go to the Unity/Debugger section, 

and then browse to where your Unity executable is located.  

Is there a way to get rid of the welcome page in Mono Develop? 

 Yes, there is. In the MonoDevelop preferences, go to the Visual Style section, and uncheck "Load welcome page on startup".  

Geforce 7300GT on OSX 10.6.4 

 Deferred rendering is disabled because materials are not displayed correctly for Geforce 7300GT on OX 10.6.4; This happens because of 

buggy video drivers.  

On Windows x64, Unity crashes when my script throws a NullReferenceException 

 Please apply Windows Hotfix #976038.  

Graphics 

Slow framerate and/or visual artifacts. 

 This may occur if your video card drivers are not up to date. Make sure you have the latest official drivers from your card vendor.  

Shadows 

I see no shadows at all! 

 Shadows are a Unity Pro only feature, so without Unity Pro you won't get shadows. Simpler shadow methods, like using a Projector, are 

still possible of course.  

 Shadows also require certain graphics hardware support. See Shadows page for details.  

 Check if shadows are not completely disabled in Quality Settings.  

 Shadows are currently not supported for Android and iOS mobile platforms.  

Some of my objects do not cast or receive shadows 

First, the Renderer has to have Receive Shadows on to have shadows on itself; and Cast Shadows on to cast shadows on other objects 

(both are on by default).  

Next, only opaque objects cast and receive shadows; that means if you use built-in Transparent or Particle shaders then you'll get no 

shadows. In most cases it's possible to Transparent Cutout shaders (for objects like fences, vegetation etc.). If you use custom written 

Shaders, they have to be pixel-lit and use Geometry render queue. Objects using VertexLit shaders do not receive shadows either (but 

can cast shadows just fine).  
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Finally, only Pixel lights cast shadows. If you want to make sure that some light always casts shadows, no matter how many other lights 

are in the scene, set it to Force Pixel render mode (see Light documentation).  

 

iOS 
 

Troubleshooting on iOS devices 
There are some known scenarios where your game works perfectly in the Unity iOS Editor but doesn't work or doesn't even start on the 

actual device. The problems are often related to code or content quality. This chapter describes the most common scenarios.  

Xcode 3.2.x fails to build application with error "libiPhone-lib.a, missing required architecture i386 in file 

Undefined symbols: "Register_UnityEngine_Input_GetMouseButtonDown()", referenced from: 

RegisterAllStrippedInternalCalls() in RegisterMonoModules.o 

This build error usually happens when originally non-simulator SDK is selected in Player Settings, but later in Xcode SDK is switched to 

simulator. To run a simulator build you should choose simulator SDK in Player Settings.  

Xcode 4.x fails to build application with error "No architectures to compile for (ARCHS=armv6, 

VALID_ARCHS=i386)." 

Currently Unity has limited support for Xcode 4.x and some manual effort is required to build final application. Build&Run action will open 

Unity iOS generated Xcode project, but it won't select proper build target and proper target device. If you are building for testing on device 

you should select "Unity-iPhone" build target and some iOS devices, which is connected to your Mac. If you are building for testing on 

simulator (Note: this needs appropriate SDK selection in Player Settings) then you should select "Unity-iPhone-simulator" target and 

appropriate simulator device.  

Game stops responding after some time. Xcode shows "interrupted" in the status bar. 

There could be several causes for this. Typical causes include:  

1. Scripting errors, like : using initialized variables, etc.  

2. Using 3rd party Thumb compiled native libraries. Such libraries trigger known problem in iOS SDK linker and might cause random 

crashes.  

3. Using generic types with value types as parameter (like List<int>, List<SomeStruct>, List<SomeEnum>) for serializable script 

properties.  

4. Using reflection when managed code stripping is enabled.  

5. Errors in native plugin interface (managed code method signature does not match native code function signature).  

You need to review the XCode Debugger console for details. The Xcode Debugger console can be accessed from the Xcode menu Run-

>Console.  

Xcode console shows "Program received signal: “SIGBUS” or EXC_BAD_ACCESS error. 

This message typically appears on iOS devices when your application receives a NullReferenceException. There two ways to figure out 

where the fault happened:  

Managed stack traces 
Since version 3.4 Unity includes software based handling of NullReferenceException. AOT compiler includes tiny checks for null reference 

each time object method or field is accessed. This feature impacts your script performance that's why it is enabled only for development 

builds (for basic license users it is enough to enable "development build" option in Build Settings dialog, iOS pro license users additionally 

need to check "script debugging" option). If everything was done right and fault actually is happening in .NET code then you won't 

EXC_BAD_ACCESS anymore. Instead of it .NET exception text will be printed in Xcode console (or just your code will catch it in "catch" 

statement). Typical output might be:  

Unhandled Exception: System.NullReferenceException: A null value was found where an object instance was required. 
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  at DayController+$handleTimeOfDay$121+$.MoveNext () [0x0035a] in DayController.js:122  

It tells that fault happened in DayController class handleTimeOfDay method, which works as coroutine. Also if that's script code you 

probably will get exact code line, like in this sample "DayController.js:122". Which corresponds to following code:  

 Instantiate(_imgwww.assetBundle.mainAsset); 

Usually this happens when script code doesn't properly check if WWW class successfully downloaded Asset Bundle, but blindly accesses 

its fields.  

Native stack traces 
Native stack traces are much more powerful tool for fault investigation, but it requires quite some expertise. Also usually you can't continue 

after these native (hardware memory access) faults happen. To get native stack trace type thread apply all bt into Xcode Debugger 

Console. Carefully inspect the printed stack traces - they may contain hints about where the error occurred. You might see something like:  

... 

Thread 1 (thread 11523):  

#0 0x006267d0 in OptionsMenu_Start ()  

#1 0x002e4160 in wrapper_runtime_invoke_object_runtime_invoke_void__this___object_intptr_intptr_intptr ()  

#2 0x00a1dd64 in mono_jit_runtime_invoke (method=0x18b63bc, obj=0x5d10cb0, params=0x0, exc=0x2fffdd34) at 

/Users/mantasp/work/unity/unity-mono/External/Mono/mono/mono/mini/mini.c:4487 

#3 0x0088481c in MonoBehaviour::InvokeMethodOrCoroutineChecked () 

... 

First of all you should find the stack trace for "Thread 1". This is the main thread. The very first lines of its stack trace will point to the place 

where error occurred. In this example, it indicates that the NullReferenceException happened inside the "OptionsMenu" script's "Start" 

method. Looking carefully at this method implementation would reveal the cause of the problem. Typically NullReferenceExceptions 

happen inside the Start method when wrong assumptions are made about initialization order. In some cases only a partial stack trace is 

seen on Debugger Console:  

Thread 1 (thread 11523):  

#0 0x0062564c in start () 

This indicates that native symbols were stripped during the Release build of your application. The full stack trace can be obtained by 

following these guidelines:  

 Select Debug configuration in Xcode project.  

 Clean all targets.  

 Build and run.  

 Get stack traces again as described above.  

EXC_BAD_ACCESS starts to happen only when external library is linked to Unity iOS application. 



That usually happens when external library is compiled with ARM Thumb instruction set. Currently such libraries are not compatible with 

Unity iOS. Problem could be easily solved by recompiling library without Thumb instructions. Detailed instructions for library's Xcode 

project:  

 in Xcode menu select "Project" -> "Edit active target"  

 in "Target Info" dialog select "Configuration: All Configurations"  

 in search field enter : "thumb"  

 "Compile for Thumb" setting will appear, uncheck it and rebuild the library.  

If library source is not available you should ask library provider for non-thumb version of the library.  

Xcode console shows "WARNING -> applicationDidReceiveMemoryWarning()" followed by immediate application crash. 

(Sometimes you might see a message like Program received signal: �0�.) This warning message is in many cases not fatal, and only 

indicates that iOS is low on memory and has asked applications to free some memory. Typically, some background processes like Mail will 

free some memory and your application can continue to run. However, if your application continues to use memory or ask for more, the OS 

will start killing applications at some point, and your application could be killed. Apple does not document what memory usage is safe, but 

empirical observations show that applications using less than 25 MB of RAM (80 MB for 3rd generation devices) do not have any memory 

usage problems. Applications using 40 MB of RAM may have memory problems on 1-2nd generation devices and may require a device 

restart to run properly. The primary metric on which you should rely is how much RAM your application uses. Your application memory 

usage consists of three major parts:  

 application code (the OS needs to load and keep your application code in RAM)  

 native heap (which is used by the engine to store its state, your assets, etc. in RAM)  

 managed heap (which is used by your Mono runtime to keep C# or JavaScript objects)  

Your application memory usage can be tracked by two Xcode Instruments tools: Activity Monitor and Object Allocations. You can start 

one or the other from the Xcode Run menu: Run->Start with Performance Tool->Activity Monitor and Run->Start with Performance 

Tool->Object Allocations. The first tool shows all process statistics, including Real memory, which can be considered the total amount of 

RAM used by your application.  

 

Note: The internal profiler shows only heap allocated by .NET scripts. Total memory usage could be obtained via Xcode Instruments as 

shown above. This figure includes the application binary, which will be loaded into memory and takes ~7 MB, some standard framework 

buffers, Unity engine internal state buffers, .NET runtime heap (number printed by internal profiler), and some other miscellaneous stuff. 

The other tool displays all allocations made by your application and includes native heap + managed heap statistics (don't forget to check 

the Created and still living box to get the current state of the application). You should look at the Net bytes value.  

http://unity3d.com/support/documentation/Manual/iphone-InternalProfiler.html


 

Some hints about how to keep the memory usage low:  

 Reduce the application binary size by using the strongest iOS stripping options (Advanced license feature), and avoid unnecessary 

dependencies of various .NET libraries. Check for details in the player settings and player size optimization documentation  

 Reduce your content size: use PVRTC compression for textures, use low poly models. Check for details in the reducing filesize 

documentation  

 Don't allocate too much in your scripts. Track mono heap size and usage with the internal profiler  

 Note: with Unity 3.0, the scene loading implementation has changed a lot, and now all scene assets are preloaded. This guarantees fewer 

hiccups while instantiating game objects. If you need more fine-grained control of asset loading and unloading during gameplay, you should 

use Resources.Load / Object.Destroy.  

Querying the OS for the amount of free memory may seem like a good idea to evaluate how well your application performs. However, this 

has very little relation to real life, because the OS uses a lot of dynamic buffers and caches. You should always track memory consumption 

for your application and use it as the main metric. That should be the only reliable method. Just asking how much free memory is left from 

the OS will lead you nowhere. Pay attention to how the graphs from the tools described above change over time, especially after loading 

new levels.  

Game runs fine when launched from Xcode and crashes on first level load when launched manually on the 

device. 

There could be several reasons for this. You need to inspect the device logs to get more details. Connect the device to your Mac, launch 

Xcode, go to the Xcode menu Window->Organizer, select your device in the Organizer's left toolbar, click on the "Console" tab and review 

the latest messages carefully. Additionally, you may need to investigate crash reports. You can find out how to obtain crash reports here: 

http://developer.apple.com/iphone/library/technotes/tn2008/tn2151.html.  

Xcode Organizer console contains "killed by SpringBoard". 

There is a not well documented time limit for an iOS application to render its first frames and process input. If your application misses this 

time limit, it gets killed by SpringBoard. A typical case is an application with a large first scene. To avoid this problem, it is recommended to 

create a small initial scene which just displays a splash screen, waits a frame or two with yield and starts loading the real scene. A code 

sample for this could be:  

  

function Start () { 

    yield; 
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    Application.LoadLevel("Test"); 

} 

Type.GetProperty() / Type.GetValue() cause crashes on device 

Currently Type.GetProperty() and Type.GetValue() are supported only for .NET 2.0 Subset profile. You can select .NET API compatibility 

level in Player Settings.  

Note: Type.GetProperty() and Type.GetValue() might be incompatible with managed code stripping and might need to be exclude Types 

that you use from stripping by supplying custom non-strippable type list. You can find more details in iOS player size optimization guide.  

Game crashes with following error message "ExecutionEngineException: Attempting to JIT compile method 

'SometType`1<SomeValueType>:.ctor ()' while running with --aot-only." 

Mono .NET implementation for iOS is based on AOT (ahead of time compilation to native code) technology. This technology has own 

limitations. It compiles only these generic type methods (when value type is used as generic parameter), which are explicitly used by other 

code. When such methods are used only via reflection or from native code (i.e. serialization system) then they get skipped during AOT 

compilation. AOT compiler might be hinted to include code by adding mock method somewhere to the script code, which would touch 

missing methods and so get them compiled ahead of use time.  

void _unusedMethod() 

{ 

    var tmp = new SometType<SomeValueType>(); 

} 

Note: value types are basic types, enums and structs.  

Various crashes experienced on device in combination of System.Security.Cryptography and managed code 

stripping 

.NET Cryptography services heavily rely on reflection thus are not compatible with managed code stripping which relies on static code 

analysis. Sometimes easiest solution is to exclude whole System.Security.Crypography namespace from stripping process.  

Stripping process can be customized by adding custom link.xml file to your Unity iOS project Assets folder, which specifies what types or 

namespaces should be excluded from stripping. More details can be found in iOS player size optimization guide.  

link.xml 

<linker> 

       <assembly fullname="mscorlib"> 

               <namespace fullname="System.Security.Cryptography" preserve="all"/> 

       </assembly> 

</linker> 
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"Ran out of trampolines of type 1/2" runtime error 

This error usually happens if you use lots of recursive generics. You can hint AOT compiler to allocate more trampolines of first or second 

type. Additional AOT compiler command line options could be specified in PlayerSettings other settings section. For type 1 trampolines 

specify nrgctx-trampolines=ABCD, where ABCD is new trampoline count (i.e. 4096). For type 2 trampolines specify nimt-

trampolines=ABCD.  

 

Android 
 

Troubleshooting Android development 

Unity fails to install your application to your device 

1. Verify that your computer can actually see and communicate with the device. More on this at Publishing Builds section.  

2. Please find the error (marked with red sign) in the Unity console. It should display a helpful error message.  

Your application crashes immediately after start. 

1. Ensure you're not trying to use NativeActivity with devices that do not support it.  

2. Try removing any native plugins you have.  

3. Try to disable stripping.  

4. Use adb logcat to obtain the crash report from your device.  

Building DEX Failed 

This an error which will present itself similar to this  

Building DEX Failed! 

G:\Unity\JavaPluginSample\Temp/StagingArea> java -Xmx1024M  

-Djava.ext.dirs="G:/AndroidSDK/android-sdk_r09-windows\platform-tools/lib/"  

-jar "G:/AndroidSDK/android-sdk_r09-windows\platform-tools/lib/dx.jar"  

--dex --verbose --output=bin/classes.dex bin/classes.jar plugins 

Error occurred during initialization of VM 

Could not reserve enough space for object heap 

Could not create the Java virtual machine. 

This is usually caused by a bad version of Java being installed on your machine. Try updating your Java install to the latest version and this 

will generally solve this issue.  

My game quits when I press the sleep button 

Please change the <activity> tag in the AndroidManifest.xml to contain <android:configChanges> tag as described 

here.  

An example activity tag can look like this:  
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<activity android:name=".AdMobTestActivity" 

                  android:label="@string/app_name" 

                  android:configChanges="keyboardHidden|orientation"> 

            <intent-filter> 

                <action android:name="android.intent.action.MAIN" /> 

                <category android:name="android.intent.category.LAUNCHER" /> 

            </intent-filter> 

        </activity> 
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iphone-bugreporting 
Before submitting a bug with just "it crashes" in the message body, please look through the iOS Troubleshooting page. You'll learn how to 

debug your game and how to find precious yet hidden info about your app.  

If your application crashes in Xcode debugger, then follow these steps: 

1. Press Continue (Run->Continue) twice  

2. Open the debugger console (Run->Console) and enter (in the console): thread apply all bt  

3. Copy all console output and send it together with your bugreport.  

If your application crashes on your iDevice, but not when run from Xcode debugger, then follow these steps: 

1. Retrieve crashreport as described on Apple's website: 

http://developer.apple.com/iphone/library/technotes/tn2008/tn2151.html#ACQUIRING_CRASH_REPORTS  

2. Attach the crashreport, your built application and console log to the bugreport  
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android-GettingStarted 

Developing for Android 
Building games for a device running Android OS requires an approach similar to that for iOS development. However, the device's hardware 

is not completely standardized, which raises issues that don't occur in iOS development. There are some feature differences in the Android 

version of Unity just as there are with the iOS version.  

Setting up your Android Developer environment 

Before you can run Unity Android games on the actual device, you'll need to have your Android developer environment set up. This 

involves downloading and installing the Android SDK with the different Android plaforms and adding your physical device to your system 

http://unity3d.com/support/documentation/Manual/TroubleShooting.html#iPhoneTroubleShooting
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(this is done a bit differently depending on whether you are developing on Windows or Mac). This setup process is explained on the 

Android developer website, and there may be additional information provided by the manufacturer of your device. Since this is a complex 

process, we've provided a basic outline of the tasks that must be completed before you can run code on your Android device or in the 

Android emulator. However, the best thing to do is follow the instructions step-by-step from the Android developer portal.  

Access Android Functionality 

Unity Android provides a scripting APIs to access various input data and settings. You can find out more about the new scripting classes on 

the Android scripting page.  

Exposing Native C, C++ or Java Code to Scripts 

Unity Android allows you to call custom functions written in C/C++ directly (and Java indirectly) from C# scripts. To find out how to bind 

native functions, visit the plugins page.  

Occlusion Culling 

Unity Android includes support for occlusion culling, which is perfect for squeezing high performance out of complex scenes with many 

objects. To learn how occlusion culling works, visit the occlusion culling page.  

Splash Screen Customization 

If you want to customize the splash screen that appears when launching your game on the device, you should visit the splash screen 

customization page.  

Troubleshooting 

There are many reasons why your application may crash or fail to work as you expected. Look here to see how to troubleshoot on Android.  

Reporting Crash Bugs on Android 

Before submitting a bug report, please look through the Android troubleshooting page first. If this doesn't solve the problem, proceed to 

reporting an Android bug.  

How Unity Android Differs from Desktop Unity 

Strongly Typed JavaScript 

Dynamic typing in JavaScript is always turned off in Unity Android. This is the same as adding #pragma strict to your scripts, but it is done 

by default instead. This greatly improves performance (which is especially important on the iPhone/iPad devices). When you launch an 

existing Unity Project, you will receive compiler errors if you are using dynamic typing. You can easily fix them by either using static typing 

for the variables that are causing errors or taking advantage of type interface.  

Terrain Engine 

The terrain engine is not supported on Android devices yet. The terrain engine is built to work with modern PC GPUs and can't be scaled 

down to anything currently suitable for Android. Using custom low poly meshes and occlusion culling is the best way to create terrains on 

Android devices.  

ETC as Recommended Texture Compression 

While Unity Android does support DXT/PVRTC/ATC textures, Unity will decompress the textures into RGB(A) format at runtime if those 

compression methods are not supported by the actual hardware. This could have an impact on the GPU rendering speed and it is 

recommended to use the ETC format instead. The ETC compression is regarded as the standard compression format on Android, and 

should be supported on all post 2.0 devices. ETC however does not support the alpha channel and, depending on the use case for such a 

texture, RGBA 16-bit might be the best trade-off between size, quality and rendering speed.  

It's also possible to create separate android distribution archives (.apk) for each of the DXT/PVRTC/ATC formats, and let the Android 

Market filtering select the correct archive for the different devices (see Publishing Builds for Android).  

Movie Playback 
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Movie textures are not supported on Android, but a full-screen streaming playback is provided via scripting functions. To learn about 

supported file formats and scripting API, consult the movie page or the Android supported media formats page.  

Further Reading 

 Android SDK Setup  

 Android Remote  

 Trouble Shooting  

 Reporting crash bugs under Android  

 Features currently not supported by Unity Android  

 Player Settings  

 Android Scripting  

o Input  

o Mobile Keyboard  

o Advanced Unity Mobile Scripting  

o Using .NET API 2.0 compatibility level  

 Plugins - Pro/Mobile-Only Feature  

 Customizing your Mobile target's Splash screen  

 Devices That we Have Tested On  

 Integrating Unity with Eclipse  

o Launching an Android application from within unity  
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android-sdksetup 
There are some steps you must follow before you can build and run any code on your Android device. This is true regardless of whether 

you use Unity or write Android applications from scratch.  

1. Download the Android SDK 

Go to the Android Developer SDK webpage. Download and unpack the latest Android SDK.  

2. Installing the Android SDK 

Follow the instructions under Installing the SDK, feel free to skip the optional parts relating to Eclipse. In step 4 of Installing the SDK make 

sure to add at least one Android platform with API level equal to or higher than 9 (Platform 2.3 or greater), the Platform Tools, and the 

USB drivers if you're using Windows.  

3. Get the device recognized by your system 

This can be tricky, especially under Windows based systems where drivers tend to be a problem. Also, your device may come with 

additional information/specific drivers from the manufacturer.  

 For Windows: If the Android device is automatically recognized by the system you still might need to update the drivers with the ones that 

came with the Android SDK. This is done through the Windows Device Manager.  

If the device is not recognized automatically use the drivers from the Android SDK, or any specific drivers provided by the 

manufacturer.  

Additional info can be found here: USB Drivers for Windows  

 For Mac: If you're using Mac no additional drivers are usually required.  

Note: Don't forget to turn on "USB Debugging" on your device. You can do this from the home screen: press MENU, select Applications > 

Development, then enable USB debugging.  
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If you are unsure whether your device is propperly installed on your system, please read the trouble-shooting page for details.  

4. Add the Android SDK path to Unity 

The first time you build a project for Android (or if Unity later fails to locate the SDK) you will be asked to point out where you installed the 

Android SDK. Please point to the root-folder of the Android SDK. The location of the Android SDK can also be changed in the editor by 

accessing Edit then Preferences.  
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android-remote 
Android Remote is a software application that makes your Android device act as a remote control for your project in Unity. This is useful for 

rapid development when you don't want to compile and deploy your project to device for each change and prefer to use the Editor Game 

window instead.  

How to use Android remote? 

Please follow these steps to successfully use Android Remote.  

 Make sure you have the latest Android SDK installed. It is required to set-up port forwarding for your Android device.  

 Connect Android device to your computer with USB cable.  

 Launch Android Remote application on the device.  

 Hit "Play" in Unity editor. At this point you will be able to send accelerometer and touch input events from the device to the editor and 

receive a stream of compressed screenshots from the editor to the device.  

 When done, stop the game in the editor and Android Remote application will get back to its primary screen.  

Unity Remote 

Please also read about Unity Remote.  
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android-troubleshooting 
This section address common problems you can find when using Unity, please choose the platform you are having problems at.  

 

Desktop  
 

In MonoDevelop, the Debug button is greyed out! 

 This means that MonoDevelop was unable to find the Unity executable; in the MonoDevelop preferences go to the Unity/Debugger section, 

and then browse to where your Unity executable is located.  

Is there a way to get rid of the welcome page in Mono Develop? 

 Yes, there is. In the MonoDevelop preferences, go to the Visual Style section, and uncheck "Load welcome page on startup".  

Geforce 7300GT on OSX 10.6.4 
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 Deferred rendering is disabled because materials are not displayed correctly for Geforce 7300GT on OX 10.6.4; This happens because of 

buggy video drivers.  

On Windows x64, Unity crashes when my script throws a NullReferenceException 

 Please apply Windows Hotfix #976038.  

Graphics 

Slow framerate and/or visual artifacts. 

 This may occur if your video card drivers are not up to date. Make sure you have the latest official drivers from your card vendor.  

Shadows 

I see no shadows at all! 

 Shadows are a Unity Pro only feature, so without Unity Pro you won't get shadows. Simpler shadow methods, like using a Projector, are 

still possible of course.  

 Shadows also require certain graphics hardware support. See Shadows page for details.  

 Check if shadows are not completely disabled in Quality Settings.  

 Shadows are currently not supported for Android and iOS mobile platforms.  

Some of my objects do not cast or receive shadows 

First, the Renderer has to have Receive Shadows on to have shadows on itself; and Cast Shadows on to cast shadows on other objects 

(both are on by default).  

Next, only opaque objects cast and receive shadows; that means if you use built-in Transparent or Particle shaders then you'll get no 

shadows. In most cases it's possible to Transparent Cutout shaders (for objects like fences, vegetation etc.). If you use custom written 

Shaders, they have to be pixel-lit and use Geometry render queue. Objects using VertexLit shaders do not receive shadows either (but 

can cast shadows just fine).  

Finally, only Pixel lights cast shadows. If you want to make sure that some light always casts shadows, no matter how many other lights 

are in the scene, set it to Force Pixel render mode (see Light documentation).  

 

iOS 
 

Troubleshooting on iOS devices 
There are some known scenarios where your game works perfectly in the Unity iOS Editor but doesn't work or doesn't even start on the 

actual device. The problems are often related to code or content quality. This chapter describes the most common scenarios.  

Xcode 3.2.x fails to build application with error "libiPhone-lib.a, missing required architecture i386 in file 

Undefined symbols: "Register_UnityEngine_Input_GetMouseButtonDown()", referenced from: 

RegisterAllStrippedInternalCalls() in RegisterMonoModules.o 

This build error usually happens when originally non-simulator SDK is selected in Player Settings, but later in Xcode SDK is switched to 

simulator. To run a simulator build you should choose simulator SDK in Player Settings.  

Xcode 4.x fails to build application with error "No architectures to compile for (ARCHS=armv6, 

VALID_ARCHS=i386)." 

Currently Unity has limited support for Xcode 4.x and some manual effort is required to build final application. Build&Run action will open 

Unity iOS generated Xcode project, but it won't select proper build target and proper target device. If you are building for testing on device 
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you should select "Unity-iPhone" build target and some iOS devices, which is connected to your Mac. If you are building for testing on 

simulator (Note: this needs appropriate SDK selection in Player Settings) then you should select "Unity-iPhone-simulator" target and 

appropriate simulator device.  

Game stops responding after some time. Xcode shows "interrupted" in the status bar. 

There could be several causes for this. Typical causes include:  

1. Scripting errors, like : using initialized variables, etc.  

2. Using 3rd party Thumb compiled native libraries. Such libraries trigger known problem in iOS SDK linker and might cause random 

crashes.  

3. Using generic types with value types as parameter (like List<int>, List<SomeStruct>, List<SomeEnum>) for serializable script 

properties.  

4. Using reflection when managed code stripping is enabled.  

5. Errors in native plugin interface (managed code method signature does not match native code function signature).  

You need to review the XCode Debugger console for details. The Xcode Debugger console can be accessed from the Xcode menu Run-

>Console.  

Xcode console shows "Program received signal: “SIGBUS” or EXC_BAD_ACCESS error. 

This message typically appears on iOS devices when your application receives a NullReferenceException. There two ways to figure out 

where the fault happened:  

Managed stack traces 
Since version 3.4 Unity includes software based handling of NullReferenceException. AOT compiler includes tiny checks for null reference 

each time object method or field is accessed. This feature impacts your script performance that's why it is enabled only for development 

builds (for basic license users it is enough to enable "development build" option in Build Settings dialog, iOS pro license users additionally 

need to check "script debugging" option). If everything was done right and fault actually is happening in .NET code then you won't 

EXC_BAD_ACCESS anymore. Instead of it .NET exception text will be printed in Xcode console (or just your code will catch it in "catch" 

statement). Typical output might be:  

Unhandled Exception: System.NullReferenceException: A null value was found where an object instance was required. 

  at DayController+$handleTimeOfDay$121+$.MoveNext () [0x0035a] in DayController.js:122  

It tells that fault happened in DayController class handleTimeOfDay method, which works as coroutine. Also if that's script code you 

probably will get exact code line, like in this sample "DayController.js:122". Which corresponds to following code:  

 Instantiate(_imgwww.assetBundle.mainAsset); 

Usually this happens when script code doesn't properly check if WWW class successfully downloaded Asset Bundle, but blindly accesses 

its fields.  

Native stack traces 
Native stack traces are much more powerful tool for fault investigation, but it requires quite some expertise. Also usually you can't continue 

after these native (hardware memory access) faults happen. To get native stack trace type thread apply all bt into Xcode Debugger 

Console. Carefully inspect the printed stack traces - they may contain hints about where the error occurred. You might see something like:  

... 

Thread 1 (thread 11523):  

http://unity3d.com/support/documentation/Components/class-PlayerSettings.html


#0 0x006267d0 in OptionsMenu_Start ()  

#1 0x002e4160 in wrapper_runtime_invoke_object_runtime_invoke_void__this___object_intptr_intptr_intptr ()  

#2 0x00a1dd64 in mono_jit_runtime_invoke (method=0x18b63bc, obj=0x5d10cb0, params=0x0, exc=0x2fffdd34) at 

/Users/mantasp/work/unity/unity-mono/External/Mono/mono/mono/mini/mini.c:4487 

#3 0x0088481c in MonoBehaviour::InvokeMethodOrCoroutineChecked () 

... 

First of all you should find the stack trace for "Thread 1". This is the main thread. The very first lines of its stack trace will point to the place 

where error occurred. In this example, it indicates that the NullReferenceException happened inside the "OptionsMenu" script's "Start" 

method. Looking carefully at this method implementation would reveal the cause of the problem. Typically NullReferenceExceptions 

happen inside the Start method when wrong assumptions are made about initialization order. In some cases only a partial stack trace is 

seen on Debugger Console:  

Thread 1 (thread 11523):  

#0 0x0062564c in start () 

This indicates that native symbols were stripped during the Release build of your application. The full stack trace can be obtained by 

following these guidelines:  

 Select Debug configuration in Xcode project.  

 Clean all targets.  

 Build and run.  

 Get stack traces again as described above.  

EXC_BAD_ACCESS starts to happen only when external library is linked to Unity iOS application. 

That usually happens when external library is compiled with ARM Thumb instruction set. Currently such libraries are not compatible with 

Unity iOS. Problem could be easily solved by recompiling library without Thumb instructions. Detailed instructions for library's Xcode 

project:  

 in Xcode menu select "Project" -> "Edit active target"  

 in "Target Info" dialog select "Configuration: All Configurations"  

 in search field enter : "thumb"  

 "Compile for Thumb" setting will appear, uncheck it and rebuild the library.  

If library source is not available you should ask library provider for non-thumb version of the library.  

Xcode console shows "WARNING -> applicationDidReceiveMemoryWarning()" followed by immediate application crash. 

(Sometimes you might see a message like Program received signal: �0�.) This warning message is in many cases not fatal, and only 

indicates that iOS is low on memory and has asked applications to free some memory. Typically, some background processes like Mail will 

free some memory and your application can continue to run. However, if your application continues to use memory or ask for more, the OS 

will start killing applications at some point, and your application could be killed. Apple does not document what memory usage is safe, but 

empirical observations show that applications using less than 25 MB of RAM (80 MB for 3rd generation devices) do not have any memory 

usage problems. Applications using 40 MB of RAM may have memory problems on 1-2nd generation devices and may require a device 

restart to run properly. The primary metric on which you should rely is how much RAM your application uses. Your application memory 

usage consists of three major parts:  

 application code (the OS needs to load and keep your application code in RAM)  



 native heap (which is used by the engine to store its state, your assets, etc. in RAM)  

 managed heap (which is used by your Mono runtime to keep C# or JavaScript objects)  

Your application memory usage can be tracked by two Xcode Instruments tools: Activity Monitor and Object Allocations. You can start 

one or the other from the Xcode Run menu: Run->Start with Performance Tool->Activity Monitor and Run->Start with Performance 

Tool->Object Allocations. The first tool shows all process statistics, including Real memory, which can be considered the total amount of 

RAM used by your application.  

 

Note: The internal profiler shows only heap allocated by .NET scripts. Total memory usage could be obtained via Xcode Instruments as 

shown above. This figure includes the application binary, which will be loaded into memory and takes ~7 MB, some standard framework 

buffers, Unity engine internal state buffers, .NET runtime heap (number printed by internal profiler), and some other miscellaneous stuff. 

The other tool displays all allocations made by your application and includes native heap + managed heap statistics (don't forget to check 

the Created and still living box to get the current state of the application). You should look at the Net bytes value.  

 

Some hints about how to keep the memory usage low:  

 Reduce the application binary size by using the strongest iOS stripping options (Advanced license feature), and avoid unnecessary 

dependencies of various .NET libraries. Check for details in the player settings and player size optimization documentation  

 Reduce your content size: use PVRTC compression for textures, use low poly models. Check for details in the reducing filesize 

documentation  

 Don't allocate too much in your scripts. Track mono heap size and usage with the internal profiler  
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 Note: with Unity 3.0, the scene loading implementation has changed a lot, and now all scene assets are preloaded. This guarantees fewer 

hiccups while instantiating game objects. If you need more fine-grained control of asset loading and unloading during gameplay, you should 

use Resources.Load / Object.Destroy.  

Querying the OS for the amount of free memory may seem like a good idea to evaluate how well your application performs. However, this 

has very little relation to real life, because the OS uses a lot of dynamic buffers and caches. You should always track memory consumption 

for your application and use it as the main metric. That should be the only reliable method. Just asking how much free memory is left from 

the OS will lead you nowhere. Pay attention to how the graphs from the tools described above change over time, especially after loading 

new levels.  

Game runs fine when launched from Xcode and crashes on first level load when launched manually on the 

device. 

There could be several reasons for this. You need to inspect the device logs to get more details. Connect the device to your Mac, launch 

Xcode, go to the Xcode menu Window->Organizer, select your device in the Organizer's left toolbar, click on the "Console" tab and review 

the latest messages carefully. Additionally, you may need to investigate crash reports. You can find out how to obtain crash reports here: 

http://developer.apple.com/iphone/library/technotes/tn2008/tn2151.html.  

Xcode Organizer console contains "killed by SpringBoard". 

There is a not well documented time limit for an iOS application to render its first frames and process input. If your application misses this 

time limit, it gets killed by SpringBoard. A typical case is an application with a large first scene. To avoid this problem, it is recommended to 

create a small initial scene which just displays a splash screen, waits a frame or two with yield and starts loading the real scene. A code 

sample for this could be:  

  

function Start () { 

    yield; 

    Application.LoadLevel("Test"); 

} 

Type.GetProperty() / Type.GetValue() cause crashes on device 

Currently Type.GetProperty() and Type.GetValue() are supported only for .NET 2.0 Subset profile. You can select .NET API compatibility 

level in Player Settings.  

Note: Type.GetProperty() and Type.GetValue() might be incompatible with managed code stripping and might need to be exclude Types 

that you use from stripping by supplying custom non-strippable type list. You can find more details in iOS player size optimization guide.  

Game crashes with following error message "ExecutionEngineException: Attempting to JIT compile method 

'SometType`1<SomeValueType>:.ctor ()' while running with --aot-only." 

Mono .NET implementation for iOS is based on AOT (ahead of time compilation to native code) technology. This technology has own 

limitations. It compiles only these generic type methods (when value type is used as generic parameter), which are explicitly used by other 

code. When such methods are used only via reflection or from native code (i.e. serialization system) then they get skipped during AOT 

compilation. AOT compiler might be hinted to include code by adding mock method somewhere to the script code, which would touch 

missing methods and so get them compiled ahead of use time.  

void _unusedMethod() 

{ 

http://unity3d.com/support/documentation/ScriptReference/Resources.Load.html
http://unity3d.com/support/documentation/ScriptReference/Object.Destroy.html
http://developer.apple.com/iphone/library/technotes/tn2008/tn2151.html
http://unity3d.com/support/documentation/Components/class-PlayerSettings.html
http://unity3d.com/support/documentation/Manual/iphone-playerSizeOptimization.html


    var tmp = new SometType<SomeValueType>(); 

} 

Note: value types are basic types, enums and structs.  

Various crashes experienced on device in combination of System.Security.Cryptography and managed code 

stripping 

.NET Cryptography services heavily rely on reflection thus are not compatible with managed code stripping which relies on static code 

analysis. Sometimes easiest solution is to exclude whole System.Security.Crypography namespace from stripping process.  

Stripping process can be customized by adding custom link.xml file to your Unity iOS project Assets folder, which specifies what types or 

namespaces should be excluded from stripping. More details can be found in iOS player size optimization guide.  

link.xml 

<linker> 

       <assembly fullname="mscorlib"> 

               <namespace fullname="System.Security.Cryptography" preserve="all"/> 

       </assembly> 

</linker> 

 

"Ran out of trampolines of type 1/2" runtime error 

This error usually happens if you use lots of recursive generics. You can hint AOT compiler to allocate more trampolines of first or second 

type. Additional AOT compiler command line options could be specified in PlayerSettings other settings section. For type 1 trampolines 

specify nrgctx-trampolines=ABCD, where ABCD is new trampoline count (i.e. 4096). For type 2 trampolines specify nimt-

trampolines=ABCD.  

 

Android 
 

Troubleshooting Android development 

Unity fails to install your application to your device 

1. Verify that your computer can actually see and communicate with the device. More on this at Publishing Builds section.  

2. Please find the error (marked with red sign) in the Unity console. It should display a helpful error message.  

Your application crashes immediately after start. 

1. Ensure you're not trying to use NativeActivity with devices that do not support it.  

2. Try removing any native plugins you have.  

3. Try to disable stripping.  

4. Use adb logcat to obtain the crash report from your device.  
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Building DEX Failed 

This an error which will present itself similar to this  

Building DEX Failed! 

G:\Unity\JavaPluginSample\Temp/StagingArea> java -Xmx1024M  

-Djava.ext.dirs="G:/AndroidSDK/android-sdk_r09-windows\platform-tools/lib/"  

-jar "G:/AndroidSDK/android-sdk_r09-windows\platform-tools/lib/dx.jar"  

--dex --verbose --output=bin/classes.dex bin/classes.jar plugins 

Error occurred during initialization of VM 

Could not reserve enough space for object heap 

Could not create the Java virtual machine. 

This is usually caused by a bad version of Java being installed on your machine. Try updating your Java install to the latest version and this 

will generally solve this issue.  

My game quits when I press the sleep button 

Please change the <activity> tag in the AndroidManifest.xml to contain <android:configChanges> tag as described 

here.  

An example activity tag can look like this:  

<activity android:name=".AdMobTestActivity" 

                  android:label="@string/app_name" 

                  android:configChanges="keyboardHidden|orientation"> 

            <intent-filter> 

                <action android:name="android.intent.action.MAIN" /> 

                <category android:name="android.intent.category.LAUNCHER" /> 

            </intent-filter> 

        </activity> 

Page last updated: 2011-07-11 

 

 

http://developer.android.com/guide/topics/manifest/activity-element.html#config


android-bugreporting 
Before submitting a bug with just "it crashes" in the message body, please look through the Troubleshooting Android development page 

first.  

At this point there are no advanced debug tools to investigate on-device app crashes. However you can use adb application (found under 

Android-SDK/platform-tools) with logcat parameter. It prints status reports from your device. These reports may include information related 

to the occurred crash.  

If you are sure that the crash you're experiencing happens due to a bug in Unity software, please save the adb logcat output, conduct a 

repro project and use the bugreporter (Help/Report a bug) to inform us about it. We will get back to you as soon as we can.  

Page last updated: 2011-02-24 

 

 

android-unsupported 

Graphics 

 Non-square textures are not supported by the ETC format.  

 Movie Textures are not supported, use a full-screen streaming playback instead. Please see the Movie playback page for more information.  

 Terrain engine is not supported.  

Scripting 

 OnMouseEnter, OnMouseOver, OnMouseExit, OnMouseDown, OnMouseUp, and OnMouseDrag events are not supported on 

Android.  

 Dynamic features like Duck Typing are not supported. Use #pragma strict for your scripts to force the compiler to report dynamic features 

as errors.  

 Video streaming via WWW class is not supported.  

Page last updated: 2011-02-28 

 

 

Android Player Settings 
Player Settings is where you define various parameters (platform specific) for the final game that you will build in Unity. Some of these 

values for example are used in the Resolution Dialog that launches when you open a standalone game, others are used by XCode when 

building your game for the iOS devices, so it's important to fill them out correctly.  

To see the Player Settings choose Edit->Project Settings->Player from the menu bar.  

http://unity3d.com/support/documentation/Manual/TroubleShooting.html#AndroidTroubleShooting
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Global Settings that apply for any project you create. 

  

Cross-Platform Properties 

Company Name The name of your company. This is used to locate the preferences file. 

Product Name The name that will appear on the menu bar when your game is running and is used to locate the preferences 

file also. 

Default Icon Default icon the application will have on every platform (You can override this later for platform specific needs). 

Per-Platform Settings 
 

Desktop  
 

Web-Player 

Resolution And Presentation 

 

Resolution and presentation for web player builds. 

  
Resolution 

Default Screen Width Screen Width the player will be generated with. 

Default Screen Height Screen Height the plater will be generated with. 

Run in background Check this if you dont want to stop executing your game if the player looses focus. 

WebPlayer Template For more information you should check the "Using WebPlayer templates page", note that for each built-in and 

custom template there will be an icon in this section. 

Watermark 
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Always Display 

Watermark 

Check this if you want to display Unity's Watermark when the game is running.(This is a shared setting between 

the WebPlayer and StandAlone Executables) 

   

  

Other Settings 

 

Other general settings for Web Player builds. 

  Rendering 
 

Rendering Path This property is shared between Standalone and WebPlayer content. 

Vertex Lit Lowest lighting fidelity, no shadows support. Best used on old machines or limited mobile platforms. 

Forward with Shaders Good support for lighting features; limited support for shadows. 

Deferred Lighting Best support for lighting and shadowing features, but requires certain level of hardware support. Best used if 

you have many realtime lights. Unity Pro only. 

Static Batching Set this to use Static batching on your build (Inactive by default in webplayers). Unity Pro only. 

Dynamic Batching Set this to use Dynamic Batching on your build (Activated by default). 

Streaming 

First Streamed Level If you are publishing a Streamed Web Player, this is the index of the first level that will have access to all 

Resources.Load assets. 

Standalone (and OSX Widget) 

Resolution And Presentation 



 

Resolution and presentation for both windows/mac standalone builds. 

  
Resolution 

Default Screen Width Screen Width the stand alone game will be using by default. 

Default Screen Height Screen Height the plater will be using by default. 

Run in background Check this if you dont want to stop executing your game if it looses focus. 

Standalone Player Options 

Default is Full Screen Check this if you want to start your game by default in full screen mode. 

Capture Single Screen If enabled, standalone games in fullscreen mode will not darken the secondary monitor in multi-monitor setups. 

DisplayResolution Dialog 

Disabled No resolution dialog will appear when starting the game. 

Enabled Resolution dialog will always appear when the game is launched. 

Hidden by default The resolution player is possible to be opened only if you have pressed the "alt" key when starting the game. 

Use Player Log Write a log file with debugging information. 

Use Mac App Store 

Validation 

Enable receipt validation for the Mac App Store. 

Supported Aspect Ratios Aspect Ratios selectable in the Resolution Dialog will be monitor-supported resolutions of enabled items from 

this list. 

Dashboard Widget Options 

Use Alpha in Dashboard Enabling this will use the alpha channel rendered in Unity for the transparency of the OSX Dashboard Widget. 

This allows you to make a dashboard widget with the shape of a mesh for example. 

Watermark 

Always Display 

Watermark 

Check this if you want to display Unity's Watermark when the game is running.(This is a shared setting between 

the WebPlayer and StandAlone Executables) 

   

  

Icon 



 

Different icons that your project will have when built. 

  

Override for Standalone Check if you want to assign a custom icon you would like to be used for your standalone game. Different sizes 

of the icon should fill in the squares below. 

   

  

SplashImage 

 

Splash image that is going to be displayed when your project is loading all the resources when you execute it. 

  

Config Dialog Banner Add your custom splash image that will be displayed when the game is starting. 

   

  

Other Settings 



 

Other general settings for stand alone builds. 

Rendering 

Rendering Path This property is shared between Standalone and WebPlayer content. 

Vertex Lit Lowest lighting fidelity, no shadows support. Best used on old machines or limited mobile platforms. 

Forward with 

Shaders 

Good support for lighting features; limited support for shadows. 

Deferred Lighting Best support for lighting and shadowing features, but requires certain level of hardware support. Best used if you have 

many realtime lights. Unity Pro only. 

Static Batching Set this to use Static batching on your build (Inactive by default in webplayers). Unity Pro only. 

Dynamic Batching Set this to use Dynamic Batching on your build (Activated by default). 

API Compatibility Level 

.Net 2.0 .Net 2.0 libraries. Maximum .net compatibility, biggest file sizes 

.Net 2.0 Subset Subset of full .net compatibility, smaller file sizes 

 

iOS 
 

Resolution And Presentation 

 

''Orientation and presentation for iOS builds.'. 

  
Resolution 

Default Orientation (This setting is shared between iOS and Android devices) 

Portrait The device is in portrait mode, with the device held upright and the home button at the bottom. 

Portrait Upside Down 

(iOS Only) 

The device is in portrait mode but upside down, with the device held upright and the home button at the top. 

Landscape Right (iOS 

Only) 

The device is in landscape mode, with the device held upright and the home button on the left side. 
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Landscape Left The device is in landscape mode, with the device held upright and the home button on the right side. 

Auto Rotation The screen orientation is automatically set based on the physical device orientation. 

Auto Rotation settings 

Use Animated 

Autorotation 

When checked, orientation change is animated. This only applies when Default orientation is set to Auto 

Rotation. 

Allowed Orientations for Auto Rotation 

Portrait When checked, portrait orientation is allowed. This only applies when Default orientation is set to Auto Rotation. 

Portrait Upside Down When checked, portrait upside down orientation is allowed. This only applies when Default orientation is set to 

Auto Rotation. 

Landscape Right When checked, landscape right (home button on the left side) orientation is allowed. This only applies when 

Default orientation is set to Auto Rotation. 

Landscape Left When checked, landscape left (home button is on the right side) orientation is allowed. This only applies when 

Default orientation is set to Auto Rotation. 

Status Bar 

Status Bar Hidden Specifies whether the status bar is initially hidden when the application launches. 

Status Bar Style Specifies the style of the status bar as the application launches 

Default 

Black Translucent 

Black Opaque 

Use 32-bit Display Buffer Specifies if Display Buffer should be created to hold 32-bit color values (16-bit by default). Use it only if you see 

banding, as it has performance implications. 

   

  

Icon 

 

Different icons that your project will have when built. 

  

Override for iOS Check if you want to assign a custom icon you would like to be used for your iPhone/iPad game. Different sizes 

of the icon should fill in the squares below. 

Prerendered icon If unchecked iOS applies sheen and bevel effects to the application icon. 

   

  

SplashImage 



 

Splash image that is going to be displayed when your project is launched. 

  

Mobile Splash Screen 

(Pro-only feature) 

Specifies texture which should be used for iOS Splash Screen. Standard Splash Screen size is 320x480.(This 

is shared between Android and iOS) 

High Res. iPhone (Pro-

only feature) 

Specifies texture which should be used for iOS 4th gen device Splash Screen. Splash Screen size is 640x960. 

iPad Portrait (Pro-only 

feature) 

Specifies texture which should be used as iPad Portrait orientation Splash Screen. Standard Splash Screen 

size is 768x1024. 

iPad Landscape (Pro-only 

feature) 

Specifies texture which should be used as iPad Landscape orientation Splash Screen. Standard Splash Screen 

size is 1024x768. 

   

  

Other Settings 



 

Other general settings for iPhone/iPad builds. 

Rendering 

Static Batching Set this to use Static batching on your build (Activated by default). Pro-only feature. 

Dynamic Batching Set this to use Dynamic Batching on your build (Activated by default). 

Identification 

Bundle Identifier The string used in your provisioning certificate from your Apple Developer Network account(This is shared 

between iOS and Android) 

Bundle Version Specifies the build version number of the bundle, which identifies an iteration (released or unreleased) of 

the bundle. This is a monotonically increased string, comprised of one or more period-separated 

Configuration 
 

Target Device Specifies application target device type. 

iPhone Only Application is targeted for iPhone devices only. 

iPad Only Application is targeted for iPad devices only. 

iPhone + iPad Application is targeted for both iPad and iPhone devices. 

Target Platform Specifies the target arquitecture you are going to build for.(This setting is shared between iOS and 

Android Platforms) 

armv6 (OpenGL ES1.1) Application is optimized for armv6 chipsets 

Universal armv6+armv7 

(OpenGL ES1.1+2.0) 

Application supports both armv6 and armv7 chipsets. Note: increases application distribution size 

armv7 Application is optimized for armv7 chipsets. 1st-2nd gen. devices are not supported. There might be 

additional requirements for this build target imposed by Apple App Store. Defaults to OpenGL ES 2.0. 

Target Resolution Resolution you want to use on your deployed device.(This setting will not have any effect on devices with 



maximum resolution of 480x320) 

Native(Default Device 

Resolution) 

Will use the device native resolution. 

Standard(Medium or Low 

Resolution) 

Use the lowest resolution possible (480x320). 

HD(Highest available 

resolution) 

Use the maximum resolution allowed on the device (960x640). 

Override iPod Music If selected application will silence user's iPod music. Otherwise user's iPod music will continue playing in 

the background. 

UI Requires Persistent WiFi Specifies whether the application requires a Wi-Fi connection. iOS maintains the active Wi-Fi connection 

open while the application is running. 

Exit on Suspend Specifies whether the application should quit when suspended to background on iOS versions that 

support multitasking. 

Optimization 

Api Compatibility Level Specifies active .NET API profile 

.Net 2.0 .Net 2.0 libraries. Maximum .net compatibility, biggest file sizes 

.Net 2.0 Subset Subset of full .net compatibility, smaller file sizes 

AOT compilation options Additional AOT compiler options. 

SDK Version Specifies iPhone OS SDK version to use for building in Xcode 

iOS 4.0 iOS SDK 4.0. 

iOS Simulator 4.0 iOS Simulator 4.0. Application built for this version of SDK will be able to run only on Simulator from the 

SDK 4. 

iOS 4.1 iOS 4.1. 

iOS Simulator 4.1 iOS Simulator 4.1. Application built for this version of SDK will be able to run only on Simulator from the 

SDK 4.x. 

iOS 4.2 iOS 4.2. 

iOS Simulator 4.2 iOS Simulator 4.2. Application built for this version of SDK will be able to run only on Simulator from the 

SDK 4.x. 

iOS 4.3 iOS 4.3. 

iOS Simulator 4.3 iOS Simulator 4.3. Application built for this version of SDK will be able to run only on Simulator from the 

SDK 4.x. 

iOS latest Latest available iOS SDK. Available since iOS SDK 4.2. (default value) 

iOS Simulator latest Latest available iOS Simulator SDK. Available since iOS SDK 4.2. 

Unknown iOS SDK version is not managed by Unity Editor. 

Target iOS Version Specifies lowest iOS version where final application will able to run 

3.0 iPhone OS 3.0. (default value) 

3.1 iPhone OS 3.1. 

3.1.2 iPhone OS 3.1.2. 

3.1.3 iPhone OS 3.1.3. 

3.2 iPhone OS 3.2. 

4.0 iPhone OS 4.0. 

4.1 iPhone OS 4.1. 

4.2 iPhone OS 4.2. 

4.3 iPhone OS 4.3. 

Unknown iPhone OS SDK version is not managed by Unity Editor. 

Stripping Level (Pro-only 

feature) 

Options to strip out scripting features to reduce built player size(This setting is shared between iOS and 

Android Platforms) 

Disabled No reduction is done. 

Strip Assemblies Level 1 size reduction. 

Strip ByteCode Level 2 size reduction (includes reductions from Level 1). 

Use micro mscorlib Level 3 size reduction (includes reductions from Levels 1 and 2). 

Script Call Optimization Optionally disable exception handling for a speed boost at runtime 

Slow and Safe Full exception handling will occur with some performance impact on the device 

Fast but no Exceptions No data provided for exceptions on the device, but the game will run faster 

Note: If you build for example for iPhone OS 3.2, and then select Simulator 3.2 in Xcode you will get a ton of errors. So you MUST be sure 

to select a proper Target SDK in Unity Editor.  



 

Android 
 

Resolution And Presentation 

 

Resolution and presentation for your Android project builds. 

  
Resolution 

Default Orientation (This setting is shared between iOS and Android devices) 

Portrait The device is in portrait mode, with the device held upright and the home button at the bottom. 

Portrait Upside Down The device is in portrait mode but upside down, with the device held upright and the home button at the top. 

Landscape Right The device is in landscape mode, with the device held upright and the home button on the left side. 

Landscape Left The device is in landscape mode, with the device held upright and the home button on the right side. 

   

  

Icon 

 

Different icons that your project will have when built. 

  

Override for Android Check if you want to assign a custom icon you would like to be used for your Android game. Different sizes of 

the icon should fill in the squares below. 

   

  

SplashImage 
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Splash image that is going to be displayed when your project is launched. 

  

Mobile Splash Screen 

(Pro-only feature) 

Specifies texture which should be used by the iOS Splash Screen. Standard Splash Screen size is 

320x480.(This is shared between Android and iOS) 

Splash Scaling Specifies how will be the splash image scaling on the device. 

   

  

Other Settings 

 

Other general settings for Android builds. 

Rendering 

Static Batching Set this to use Static batching on your build (Activated by default). Pro-only feature. 

Dynamic Batching Set this to use Dynamic Batching on your build (Activated by default). 

Identification 



Bundle Identifier The string used in your provisioning certificate from your Apple Developer Network account(This is shared between 

iOS and Android) 

Bundle Version Specifies the build version number of the bundle, which identifies an iteration (released or unreleased) of the bundle. 

This is a monotonically increased string, comprised of one or more period-separated(This is shared between iOS and 

Android) 

Bundle Version 

Code 

An internal version number. This number is used only to determine whether one version is more recent than another, 

with higher numbers indicating more recent versions. This is not the version number shown to users; that number is set 

by the versionName attribute. The value must be set as an integer, such as "100". You can define it however you want, 

as long as each successive version has a higher number. For example, it could be a build number. Or you could 

translate a version number in "x.y" format to an integer by encoding the "x" and "y" separately in the lower and upper 

16 bits. Or you could simply increase the number by one each time a new version is released. 

Configuration 
 

Device Filter Specifies the target architecture you are going to build for. 

ARMv7 only Application optimized for ARMv7 CPU architecture. It will also enable correct Android Market device filtering, thus 

recommended for publishing to the Android Market (only devices supporting Unity Android will list the application on 

the Android Market). 

ARMv6 with VPF Application optimized for ARMv6 CPU architecture (requires VFP support). Use runtime detection of hardware 

capabilities rather than relying on the Android Market filtering mechanism. It means the application when published to 

the Android Market will be visible also to devices not supporting Unity Android. Obviously this is not recommended, 

especially for paid applications (though can be combined with other means of filtering instead, like OpenGLES 

version). 

Emulator Will create a combined build with support for the Android SDK Emulator. 

Graphics Level Select either ES 1.1 ('fixed function') or ES 2.0 ('shader based') Open GL level 

Force Internet 

Permission 

Will enable networking permissions even if your scripts are not using this. Automatically enabled for development 

builds. 

Force SD-Card 

Permission 

Will enable write access to external storage such as the SD-Card. Automatically enabled for development builds. 

Use NativeActivity Only enable this you intend to support devices with off-screen touch input capabilities, like Xperia Play. 

Optimization 

Api Compatibility 

Level 

Specifies active .NET API profile 

.Net 2.0 .Net 2.0 libraries. Maximum .net compatibility, biggest file sizes 

.Net 2.0 Subset Subset of full .net compatibility, smaller file sizes 

Stripping Level 

(Pro-only feature) 

Options to strip out scripting features to reduce built player size(This setting is shared between iOS and Android 

Platforms) 

Disabled No reduction is done. 

Strip Assemblies Level 1 size reduction. 

Strip ByteCode 

(iOS only) 

Level 2 size reduction (includes reductions from Level 1). 

Use micro 

mscorlib 

Level 3 size reduction (includes reductions from Levels 1 and 2). 

Enable "logcat" 

profiler 

Enable this if you want to get feedback from your device while testing your projects. So adb logcat prints logs from the 

device to the console (only available in development builds). 

Publishing Settings 



 

Publishing settings for Android Market 

  
Keystore 

Use Existing Keystore / 

Create new Keystore 

Use this if you are creating a new Keystore or using one you have already. 

Browse Keystore Lets you select a generated Keystore. 

Key 

Alias Key alias 

Password Password for key alias 

Android Market Licensing (LVL) 

Public Key Here goes the public key provided by the Android developer site. 

Details 
 

Desktop  
 

The Player Settings window is where many technical preference defaults are set. See also Quality Settings where the different graphics 

quality levels can be set up.  

Publishing a web player 

Default Web Screen Width and Default Web Screen Height determine the size used in the html file. You can modify the size in the html 

file later.  

Default Screen Width and Default Screen Height are used by the Web Player when entering fullscreen mode through the context menu 

in the Web Player at runtime.  

Customizing your Resolution Dialog 

http://developer.android.com/guide/publishing/licensing.html#account
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The Resolution Dialog, presented to end-users 

You have the option of adding a custom banner image to the Screen Resolution Dialog in the Standalone Player. The maximum image size 

is 432 x 163 pixels. The image will not be scaled up to fit the screen selector. Instead it will be centered and cropped.  

Publishing to Mac App Store 

Use Player Log enables writing a log file with debugging information. This is useful to find out what happened if there are problems with 

your game. When publishing games for Apple's Mac App Store, it is recommended to turn this off, because Apple may reject your 

submission otherwise.  

Use Mac App Store Validation enables receipt validation for the Mac App Store. If this is enabled, your game will only run when it 

contains a valid receipt from the Mac App Store. Use this when submitting games to Apple for publishing on the App Store. This prevents 

people from running the game on any computer then the one it was purchased on. Note that this feature does not implement any strong 

copy protection. In particular, any potential crack against one Unity game would work against any other Unity content. For this reason, it is 

recommended that you implement your own receipt validation code on top of this using Unity's plugin feature. However, since Apple 

requires plugin validation to initially happen before showing the screen setup dialog, you should still enable this check, or Apple might reject 

your submission.  



 

iOS 
 

Bundle Identifier 

The Bundle Identifier string must match the provisioning profile of the game you are building. The basic structure of the identifier is 

com.CompanyName.GameName. This structure may vary internationally based on where you live, so always default to the string provided 

to you by Apple for your Developer Account. Your GameName is set up in your provisioning certificates, that are manageable from the 

Apple iPhone Developer Center website. Please refer to the Apple iPhone Developer Center website for more information on how this is 

performed.  

Stripping Level (Pro-only) 

Most games don't use all necessary dlls. With this option, you can strip out unused parts to reduce the size of the built player on iOS 

devices. If your game is using classes that would normally be stripped out by the option you currently have selected, you'll be presented 

with a Debug message when you make a build.  

Script Call Optimization 

A good development practice on iOS is to never rely on exception handling (either internally or through the use of try/catch blocks). When 

using the default Slow and Safe option, any exceptions that occur on the device will be caught and a stack trace will be provided. When 

using the Fast but no Exceptions option, any exceptions that occur will crash the game, and no stack trace will be provided. However, the 

game will run faster since the processor is not diverting power to handle exceptions. When releasing your game to the world, it's best to 

publish with the Fast but no Exceptions option.  

 

Android 
 

Bundle Identifier 

The Bundle Identifier string is the unique name of your application when published to the Android Market and installed on the device. The 

basic structure of the identifier is com.CompanyName.GameName, and can be chosen arbitrarily. In Unity this field is shared with the iOS 

Player Settings for convenience.  

Stripping Level (Pro-only) 

Most games don't use all the functionality of the provided dlls. With this option, you can strip out unused parts to reduce the size of the built 

player on Android devices.  
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android-API 
Unity Android provides a number of scripting APIs unified with iOS APIs to access handheld device functionality. For cross-platform 

projects, UNITY_ANDROID is defined for conditionally compiling Android-specific C# code. The following scripting classes contain Android-

related changes (some of the API is shared between Android and iOS):  

Input Access to multi-touch screen, accelerometer and device orientation. 

iPhoneSettings  Some of the Android settings, such as screen orientation, dimming and information about device hardware. 

iPhoneKeyboard Support for native on-screen keyboard. 

iPhoneUtils Useful functions for movie playback, anti-piracy protection and vibration. 

Further Reading 
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 Input  

 Mobile Keyboard  

 Advanced Unity Mobile Scripting  

 Using .NET API 2.0 compatibility level  
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Android-Input 
 

Desktop  
 

Note: Keyboard, joystick and gamepad input works only on the desktop version of Unity.  

Unity supports keyboard, joystick and gamepad input.  

Virtual axes and buttons can be created in the Input Manager, and end users can configure Keyboard input in a nice screen configuration 

dialog.  

http://unity3d.com/support/documentation/Manual/Android-Input.html#AndroidInput
http://unity3d.com/support/documentation/Manual/Android-Keyboard.html#Android
http://unity3d.com/support/documentation/Manual/Android-Advanced.html#Android
http://unity3d.com/support/documentation/Manual/Android-DotNet.html#Android
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You can setup joysticks, gamepads, keyboard, and mouse, then access them all through one simple scripting interface.  

From scripts, all virtual axes are accessed by their name.  

Every project has the following default input axes when it's created:  

 Horizontal and Vertical are mapped to w, a, s, d and the arrow keys.  

 Fire1, Fire2, Fire3 are mapped to Control, Option (Alt), and Command, respectively.  

 Mouse X and Mouse Y are mapped to the delta of mouse movement.  

 Window Shake X and Window Shake Y is mapped to the movement of the window.  

Adding new Input Axes 

If you want to add new virtual axes go to the Edit->Project Settings->Input menu. Here you can also change the settings of each axis.  



 

You map each axis to two buttons on a joystick, mouse, or keyboard keys.  

  

Name The name of the string used to check this axis from a script. 

Descriptive Name Positive value name displayed in the input tab of the configuration dialog for standalone builds. 

Descriptive Negative 

Name 

Negative value name displayed in the Input tab of the Configuration dialog for standalone builds. 

Negative Button The button used to push the axis in the negative direction. 

Positive Button The button used to push the axis in the positive direction. 

Alt Negative Button Alternative button used to push the axis in the negative direction. 

Alt Positive Button Alternative button used to push the axis in the positive direction. 

Gravity Speed in units per second that the axis falls toward neutral when no buttons are pressed. 

Dead Size of the analog dead zone. All analog device values within this range result map to neutral. 

Sensitivity Speed in units per second that the the axis will move toward the target value. This is for digital devices only. 

Snap If enabled, the axis value will reset to zero when pressing a button of the opposite direction. 

Invert If enabled, the Negative Buttons provide a positive value, and vice-versa. 

Type The type of inputs that will control this axis. 

Axis The axis of a connected device that will control this axis. 

Joy Num The connected Joystick that will control this axis. 

Use these settings to fine tune the look and feel of input. They are all documented with tooltips in the Editor as well.  



Using Input Axes from Scripts 

You can query the current state from a script like this:  

value = Input.GetAxis ("Horizontal");  

An axis has a value between -1 and 1. The neutral position is 0. This is the case for joystick input and keyboard input.  

However, Mouse Delta and Window Shake Delta are how much the mouse or window moved during the last frame. This means it can be 

larger than 1 or smaller than -1 when the user moves the mouse quickly.  

It is possible to create multiple axes with the same name. When getting the input axis, the axis with the largest absolute value will be 

returned. This makes it possible to assign more than one input device to one axis name. For example, create one axis for keyboard input 

and one axis for joystick input with the same name. If the user is using the joystick, input will come from the joystick, otherwise input will 

come from the keyboard. This way you don't have to consider where the input comes from when writing scripts.  

Button Names 

To map a key to an axis, you have to enter the key's name in the Positive Button or Negative Button property in the Inspector.  

The names of keys follow this convention:  

 Normal keys: "a", "b", "c" ...  

 Number keys: "1", "2", "3", ...  

 Arrow keys: "up", "down", "left", "right"  

 Keypad keys: "[1]", "[2]", "[3]", "[+]", "[equals]"  

 Modifier keys: "right shift", "left shift", "right ctrl", "left ctrl", "right alt", "left alt", "right cmd", "left cmd"  

 Mouse Buttons: "mouse 0", "mouse 1", "mouse 2", ...  

 Joystick Buttons (from any joystick): "joystick button 0", "joystick button 1", "joystick button 2", ...  

 Joystick Buttons (from a specific joystick): "joystick button 0", "joystick button 1", "joystick 1 button 0", ...  

 Special keys: "backspace", "tab", "return", "escape", "space", "delete", "enter", "insert", "home", "end", "page up", "page down"  

 Function keys: "f1", "f2", "f3", ...  

The names used to identify the keys are the same in the scripting interface and the Inspector.  

value = Input.GetKey ("a");  

Mobile Input 
Unity iOS/Android offers you access to the iPhone, iPad and Android input systems via Input and iOS Input scripting interfaces.  

Input provides access to the multi-touch screen, accelerometer and device orientation. iOS Input provides access to geographical location.  

Access to keyboard on mobile devices is provided via the iOS keyboard.  

Multi-Touch Screen 

The iPhone and iPod Touch devices are capable of tracking up to five fingers touching the screen simultaneously. You can retrieve the 

status of each finger touching the screen during the last frame by accessing the Input.touches property array.  

Android devices don't have a unified limit on how many fingers they track. Instead, it varies from device to device and can be anything from 

two-touch on older devices to five fingers on some newer devices.  

Each finger touch is represented by an Input.Touch data structure:  

http://unity3d.com/support/documentation/ScriptReference/Input.html
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fingerId The unique index for a touch. 

position The screen position of the touch. 

deltaPosition The screen position change since the last frame. 

deltaTime Amount of time that has passed since the last state change. 

tapCount The iPhone/iPad screen is able to distinguish quick finger taps by the user. This counter will let you know how 

many times the user has tapped the screen without moving a finger to the sides. Android devices do not count 

number of taps, this field is always 1. 

phase Describes so called "phase" or the state of the touch. It can help you determine if the touch just began, if user 

moved the finger or if he just lifted the finger. 

Phase can be one of the following:  

Began A finger just touched the screen. 

Moved A finger moved on the screen. 

Stationary A finger is touching the screen but hasn't moved since the last frame. 

Ended A finger was lifted from the screen. This is the final phase of a touch. 

Canceled The system cancelled tracking for the touch, as when (for example) the user puts the device to her face or more than five 

touches happened simultaneously. This is the final phase of a touch. 

Following is an example script which will shoot a ray whenever the user taps on the screen:  

var particle : GameObject; 

function Update () { 

 for (var touch : Touch in Input.touches) { 

  if (touch.phase == TouchPhase.Began) { 

   // Construct a ray from the current touch coordinates 

   var ray = Camera.main.ScreenPointToRay (touch.position); 

   if (Physics.Raycast (ray)) { 

    // Create a particle if hit 

    Instantiate (particle, transform.position, transform.rotation); 

   } 

  } 

 } 

} 

Mouse Simulation 

On top of native touch support Unity iOS/Android provides a mouse simulation. You can use mouse functionality from the standard Input 

class.  

http://unity3d.com/support/documentation/ScriptReference/Input.html


Device Orientation 

Unity iOS/Android allows you to get discrete description of the device physical orientation in three-dimensional space. Detecting a change 

in orientation can be useful if you want to create game behaviors depending on how the user is holding the device.  

You can retrieve device orientation by accessing the Input.deviceOrientation property. Orientation can be one of the following:  

Unknown The orientation of the device cannot be determined. For example when device is rotate diagonally. 

Portrait The device is in portrait mode, with the device held upright and the home button at the bottom. 

PortraitUpsideDown The device is in portrait mode but upside down, with the device held upright and the home button at the top. 

LandscapeLeft The device is in landscape mode, with the device held upright and the home button on the right side. 

LandscapeRight The device is in landscape mode, with the device held upright and the home button on the left side. 

FaceUp The device is held parallel to the ground with the screen facing upwards. 

FaceDown The device is held parallel to the ground with the screen facing downwards. 

Accelerometer 

As the mobile device moves, a built-in accelerometer reports linear acceleration changes along the three primary axes in three-dimensional 

space. Acceleration along each axis is reported directly by the hardware as G-force values. A value of 1.0 represents a load of about +1g 

along a given axis while a value of -1.0 represents -1g. If you hold the device upright (with the home button at the bottom) in front of you, 

the X axis is positive along the right, the Y axis is positive directly up, and the Z axis is positive pointing toward you.  

You can retrieve the accelerometer value by accessing the Input.acceleration property.  

The following is an example script which will move an object using the accelerometer:  

var speed = 10.0; 

function Update () { 

 var dir : Vector3 = Vector3.zero; 

 

 // we assume that the device is held parallel to the ground 

 // and the Home button is in the right hand 

 

 // remap the device acceleration axis to game coordinates: 

 //  1) XY plane of the device is mapped onto XZ plane 

 //  2) rotated 90 degrees around Y axis 

 dir.x = -Input.acceleration.y; 

 dir.z = Input.acceleration.x; 

 

http://unity3d.com/support/documentation/ScriptReference/Input-deviceOrientation.html
http://unity3d.com/support/documentation/ScriptReference/Input-acceleration.html


 // clamp acceleration vector to the unit sphere 

 if (dir.sqrMagnitude > 1) 

  dir.Normalize(); 

 

 // Make it move 10 meters per second instead of 10 meters per frame... 

 dir *= Time.deltaTime; 

 

 // Move object 

 transform.Translate (dir * speed); 

} 

Low-Pass Filter 

Accelerometer readings can be jerky and noisy. Applying low-pass filtering on the signal allows you to smooth it and get rid of high 

frequency noise.  

The following script shows you how to apply low-pass filtering to accelerometer readings:  

var AccelerometerUpdateInterval : float = 1.0 / 60.0; 

var LowPassKernelWidthInSeconds : float = 1.0; 

 

private var LowPassFilterFactor : float = AccelerometerUpdateInterval / LowPassKernelWidthInSeconds; // tweakable 

private var lowPassValue : Vector3 = Vector3.zero; 

function Start () { 

 lowPassValue = Input.acceleration; 

} 

 

function LowPassFilterAccelerometer() : Vector3 { 

 lowPassValue = Mathf.Lerp(lowPassValue, Input.acceleration, LowPassFilterFactor); 



 return lowPassValue; 

} 

The greater the value of LowPassKernelWidthInSeconds, the slower the filtered value will converge towards the current input 

sample (and vice versa). You should be able to use the LowPassFilter() function instead of avgSamples().  

I'd like as much precision as possible when reading the accelerometer. What should I do? 

Reading the Input.acceleration variable does not equal sampling the hardware. Put simply, Unity samples the hardware at a frequency of 

60Hz and stores the result into the variable. In reality, things are a little bit more complicated -- accelerometer sampling doesn't occur at 

consistent time intervals, if under significant CPU loads. As a result, the system might report 2 samples during one frame, then 1 sample 

during the next frame.  

You can access all measurements executed by accelerometer during the frame. The following code will illustrate a simple average of all the 

accelerometer events that were collected within the last frame:  

var period : float = 0.0; 

var acc : Vector3 = Vector3.zero; 

for (var evnt : iPhoneAccelerationEvent  in iPhoneInput.accelerationEvents) { 

 acc += evnt.acceleration * evnt.deltaTime; 

 period += evnt.deltaTime; 

} 

if (period > 0) 

 acc *= 1.0/period; 

return acc; 

Further Reading 

The Unity mobile input API is originally based on Apple's API. It may help to learn more about the native API to better understand Unity's 

Input API. You can find the Apple input API documentation here:  

 Programming Guide: Event Handling (Apple iPhone SDK documentation)  

 UITouch Class Reference (Apple iOS SDK documentation)  

Note: The above links reference your locally installed iPhone SDK Reference Documentation and will contain native ObjectiveC code. It is 

not necessary to understand these documents for using Unity on mobile devices, but may be helpful to some!  

 

iOS 
 

Device geographical location 

http://unity3d.com/support/documentation/ScriptReference/Input-acceleration.html
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Device geographical location can be obtained via the iPhoneInput.lastLocation property. Before calling this property you should start 

location service updates using iPhoneSettings.StartLocationServiceUpdates() and check the service status via 

iPhoneSettings.locationServiceStatus. See the scripting reference for details.  
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Android-Keyboard 
Sometimes when developing your game you might need to have access to the keyboard Input that your target platform provides, this is 

done straight forward in unity just by calling some attributes via scripting.  

 

iOS 
 

Using the Keyboard 

GUI Elements 

The keyboard will appear automatically when a user taps on editable GUI elements. Currently, GUI.TextField, GUI.TextArea and 

GUI.PasswordField are capable of automatic handling of keyboard. Please read GUI documentation to find out how to use these.  

Manual Keyboard Handling 

Use the iPhoneKeyboard.Open function to open the keyboard. Please see the iPhoneKeyboard scripting reference for the parameters that 

this function takes.  

Keyboard Type Summary 

The Keyboard supports the following types:  

  
iPhoneKeyboardType.Default Letters. Can be switched to keyboard with numbers and punctuation. 

iPhoneKeyboardType.ASCIICapable Letters. Can be switched to keyboard with numbers and punctuation. 

iPhoneKeyboardType.NumbersAndPunctuation Numbers and punctuation. Can be switched to keyboard with letters. 

iPhoneKeyboardType.URL Letters with slash and .com buttons. Can be switched to keyboard with numbers and 

punctuation. 

iPhoneKeyboardType.NumberPad Only numbers from 0 to 9. 

iPhoneKeyboardType.PhonePad Keyboard used to enter phone numbers. 

iPhoneKeyboardType.NamePhonePad Letters. Can be switched to phone keyboard. 

iPhoneKeyboardType.EmailAddress Letters with @ sign. Can be switched to keyboard with numbers and punctuation. 

Text Preview 

By default, an edit box will be created and placed on top of the keyboard after it appears. This works as preview of the text that user is 

typing, so the text is always visible for the user. However, you can disable text preview by setting iPhoneKeyboard.hideInput to true. Note 

that this works only for certain keyboard types and input modes. For example, it will not work for phone keypads and multi-line text input. In 

such cases, the edit box will always appear. iPhoneKeyboard.hideInput is a global variable and will affect all keyboards.  

Keyboard Orientation 

By default, the keyboard automatically follows the device orientation. To disable or enable rotation to a certain orientation, use the following 

properties available in iPhoneKeyboard:  

  

autorotateToPortrait Enable or disable autorotation to portrait orientation (button at the bottom). 

autorotateToPortraitUpsideDown Enable or disable autorotation to portrait orientation (button at top). 

autorotateToLandscapeLeft Enable or disable autorotation to landscape left orientation (button on the right). 

http://unity3d.com/support/documentation/ScriptReference/iPhoneInput-lastLocation.html
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autorotateToLandscapeRight Enable or disable autorotation to landscape right orientation (button on the left). 

Visibility and Keyboard Size 

There are three keyboard properties in iPhoneKeyboard that determine keyboard visibility status and size on the screen.  

  

visible Returns true if the keyboard is fully visible on the screen and can be used to enter characters. 

area Returns the position and dimensions of the keyboard. 

active Returns true if the keyboard is activated. This property is not static property. You must have a keyboard 

instance to use this property. 

Note that iPhoneKeyboard.area will return a rect with position and size set to 0 until the keyboard is fully visible on the screen. You should 

not query this value immediately after iPhoneKeyboard.Open. The sequence of keyboard events is as follows:  

 iPhoneKeyboard.Open is called. iPhoneKeyboard.active returns true. iPhoneKeyboard.visible returns false. iPhoneKeyboard.area 

returns (0, 0, 0, 0).  

 Keyboard slides out into the screen. All properties remain the same.  

 Keyboard stops sliding. iPhoneKeyboard.active returns true. iPhoneKeyboard.visible returns true. iPhoneKeyboard.area returns real 

position and size of the keyboard.  

Secure Text Input 

It is possible to configure the keyboard to hide symbols when typing. This is useful when users are required to enter sensitive information 

(such as passwords). To manually open keyboard with secure text input enabled, use the following code:  

iPhoneKeyboard.Open("", iPhoneKeyboardType.Default, false, false, true); 

 

Hiding text while typing  

Alert keyboard 

To display the keyboard with a black semi-transparent background instead of the classic opaque, call iPhoneKeyboard.Open as follows:  

iPhoneKeyboard.Open("", iPhoneKeyboardType.Default, false, false, true, true); 

http://unity3d.com/support/documentation/ScriptReference/iPhoneKeyboard.html


 

Classic keyboard  

 

Alert keyboard  

 

Android 
 

Unity Android reuses the iOS API to display system keyboard. Even though Unity Android supports most of the functionality of its iPhone 

counterpart, there are two aspects which are not supported:  

 iPhoneKeyboard.hideInput  

 iPhoneKeyboard.area  

Please also note that the layout of a iPhoneKeyboardType can differ somewhat between devices.  
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Advanced iOS scripting 

Determining Device Generation 
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Different device generations support different functionality and widely varying performance. You should query the device for its generation 

and decide which functionality should be disabled to compensate for slower devices.  

You can retrieve device generation by accessing the iPhoneSettings.generation property. Generation can be one of the following:  

 iPhone  

 iPhone3G  

 iPhone3GS  

 iPhone4  

 iPodTouch1Gen  

 iPodTouch2Gen  

 iPodTouch3Gen  

 iPodTouch4Gen  

 iPad1Gen  

You can find more information about different device generations, performance and supported functionality in iPhone Hardware Guide.  

Device Properties 

There are a number of device specific properties that you can access:  

  

iPhoneSettings.uniqueIdentifier  Unique device identifier. 

iPhoneSettings.name User specified name for device. 

iPhoneSettings.model Is it iPhone or iPod Touch? 

iPhoneSettings.systemName  Operating system. 

SystemInfo.operatingSystem  Operating system version. 

Anti-Piracy Check 

It is not uncommon for pirates to hack applications from AppStore by removing Apple DRM protection and redistributing them for free. Unity 

iOS comes with anti-piracy check which allows you to determine if your application was altered after it was submitted to AppStore.  

You can check if your application is genuine (not-hacked) by accessing iPhoneUtils.isApplicationGenuine property. If this property returns 

false you're free to notify user that he is using hacked application or you can disable access to some functions of your application.  

Note: accessing iPhoneUtils.isApplicationGenuine property is reasonably expensive operation and you should never do it on a frame-to-

frame basis.  

Vibration Support 

You can trigger iOS vibration by calling iPhoneUtils.Vibrate. However iPod Touch devices lack vibration hardware and will just ignore this 

call.  

Standard Assets 

"Standard Assets" is a folder with special meaning (same as "Plugins" and "Editor) and its content is compiled before all other scripts. You 

should keep your scripts in folders without special name.  

 

Android 
 

Advanced iOS scripting 

Determining Device Generation 
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Different Android devices support different functionality and widely varying performance. You should target specific devices or device 

families and decide which functionality should be disabled to compensate for slower devices. There are a number of device specific 

properties that you can access to figure out the device.  

Note: Android Marketplace does some additional compatibility filtering, so you should not bother that your ARMv7 only app optimized for 

OGLES2 is offered to some old slow devices.  

Device Properties 

  

iPhoneSettings.uniqueIdentifier  Unique device identifier. 

iPhoneSettings.model Is it iPhone or iPod Touch? 

iPhoneSettings.systemName  Operating system. 

SystemInfo.operatingSystem  Operating system version. 

Anti-Piracy Check 

It is not uncommon for pirates to hack applications by removing Apple DRM protection and redistributing them for free. Unity Android comes 

with anti-piracy check which allows you to determine if your application was altered after it was submitted to AppStore.  

You can check if your application is genuine (not-hacked) by accessing iPhoneUtils.isApplicationGenuine property. If this property returns 

false you're free to notify user that he is using hacked application or you can disable access to some functions of your application.  

Note: iPhoneUtils.isApplicationGenuineAvailable should be used along with iPhoneUtils.isApplicationGenuine to verify that application 

integrity can actually be confirmed.  

Note: accessing iPhoneUtils.isApplicationGenuine property is reasonably expensive operation and you should never do it on a frame-to-

frame basis.  

Vibration Support 

You can trigger device vibration by calling iPhoneUtils.Vibrate. However devices lacking vibration hardware will just ignore this call.  

Standard Assets 

"Standard Assets" is a folder with special meaning (same as "Plugins" and "Editor) and its content is compiled before all other scripts. You 

should keep your scripts in folders without special name.  
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Android-DotNet 
 

iOS 
 

Now Unity iOS supports two .NET API compatibility levels: .NET 2.0 and a subset of .NET 2.0 You can select the appropriate level in 

PlayerSettings.  

.NET API 2.0 

Unity for iPhone/iPad targets supports the .NET 2.0 API profile; It is close to the full .NET 2.0 API and offers best compatibility with pre-

existing .NET code.  

Pros: 

1. Better code compatibility with desktop Unity and third party libraries  
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2. More features in standard the API set  

Cons: 

1. Application build size is bigger  

2. Slightly worse application startup time  

Note: Unity iOS does not support namespaces in the scripts. If you have third party library with the source, then the best practice is to 

compile this library outside Unity iOS Editor and drop library .dll file into Assets folder.  

.NET 2.0 Subset  

Unity iOS targets also support the .NET 2.0 Subset API profile. It is closest to the Mono "monotouch" profile, so many limitations that are 

applicable to the "monotouch" profile are also applicable for Unity iOS implementation of this .NET profile. More information on 

"monotouch" profile limitations can be found here.  

Pros: 

1. Smaller application distribution size especially when stripping is not used  

Cons: 

1. Worse compatibility with standard and third party libraries  

 

Android 
 

Unity Android supports two .NET API compatibility levels: .NET 2.0 and a subset of .NET 2.0 You can select the appropriate level in 

PlayerSettings.  

.NET API 2.0 

Unity Android targets supports the .NET 2.0 API profile; It is close to the full .NET 2.0 API and offers best compatibility with pre-existing 

.NET code.  

Pros: 

1. Better code compatibility with desktop Unity and third party libraries  

2. More features in standard the API set  

Cons: 

1. Application build size is bigger  

2. Slightly worse application startup time  

Note: Unity Android does not support namespaces in the scripts. If you have third party library with the source, then the best practice is to 

compile this library outside Unity Android Editor and drop library .dll file into Assets folder.  

.NET 2.0 Subset  

Unity Android targets also support the .NET 2.0 Subset API profile. It is closest to the Mono "monotouch" profile, so many limitations that 

are applicable to the "monotouch" profile are also applicable for Unity Android implementation of this .NET profile. More information on 

"monotouch" profile limitations can be found here.  

Pros: 

http://monotouch.net/Documentation/Limitations
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1. Smaller application distribution size especially when stripping is not used  

Cons: 

1. Worse compatibility with standard and third party libraries  
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Android-Plugins 
Unity has extensive support for C, C++ or Objective-C based Plugins. Plugins allow your game code (written in Javascript, C# or Boo) to 

call into native code libraries. This allows Unity to integrate with other middleware libraries or legacy game code.  

Note: Plugins are a Pro-only feature. For desktop builds, plugins will work in standalones only. They are disabled when building a Web 

Player for security reasons.  

In order to use a plugin you need to do two things:  

 Write a plugin in a C based language and compile it.  

 Create a C# script which calls functions in the plugin to do something.  

So the plugin provides a simple C interface. The script then invokes the functions exposed by the plugin.  

Here is a very simple example:  

The C File of a Minimal Plugin: 

float FooPluginFunction () { return 5.0F; }  

A C# Script that Uses the Plugin: 

 

Desktop  
 

using UnityEngine; 

using System.Runtime.InteropServices; 

 

class SomeScript : MonoBehaviour { 

   // This tells unity to look up the function FooPluginFunction 

   // inside the plugin named "PluginName" 

   [DllImport ("PluginName")] 

   private static extern float FooPluginFunction (); 
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   void Awake () { 

      // Calls the FooPluginFunction inside the PluginName plugin 

      // And prints 5 to the console 

      print (FooPluginFunction ()); 

   } 

}  

 

iOS 
 

using UnityEngine; 

using System.Runtime.InteropServices; 

 

class SomeScript : MonoBehaviour { 

   // This tells unity to look up the function FooPluginFunction 

   // inside the static binary 

   [DllImport ("__Internal")] 

   private static extern float FooPluginFunction (); 

 

   void Awake () { 

      // Calls the native FooPluginFunction 

      // And prints 5 to the console 

      print (FooPluginFunction ()); 

   } 

}  
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Android 
 

using UnityEngine; 

using System.Runtime.InteropServices; 

 

class SomeScript : MonoBehaviour { 

   // This tells unity to look up the function FooPluginFunction 

   // inside the plugin named "PluginName" 

   [DllImport ("PluginName")] 

   private static extern float FooPluginFunction (); 

 

   void Awake () { 

      // Calls the FooPluginFunction inside the PluginName plugin 

      // And prints 5 to the console 

      print (FooPluginFunction ()); 

   } 

}  

 

Desktop  
 

Building a Plugin for Mac OS X 

If you are building a plugin for Mac OS X, you have to create a bundle. The easiest way to do this is using XCode. Use File->NewProject... 

and select the Bundle - Carbon/Cocoa Loadable Bundle.  

If you are using C++ (.cpp) or Objective-C (.mm) to implement the plugin you have to make sure the functions are declared with C linkage 

to avoid name mangling issues.  

extern "C" { 

  float FooPluginFunction (); 
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}  

Building a Plugin for Windows 

Plugins on Windows are DLL files with exported functions. Practically any language or development environment that can create DLL files 

can be used to create plugins. 

Again, if you use C++, declare functions with C linkage to avoid name mangling issues.  

Using your plugin from C# 

Once you have built your bundle you have to copy it to Assets->Plugins folder. Unity will then find it by its name when you define a 

function like this:  

[DllImport ("PluginName")] 

private static extern float FooPluginFunction ();  

Please note that PluginName should not include the extension of the filename. Be aware that whenever you change code in the Plugin you 

will have to recompile scripts in your project or else the plugin will not have the latest compiled code.  

Deployment 

For cross platform plugins you have to include both .bundle (for Mac) and .dll (for Windows) files in Plugins folder. Once you have placed 

your plugins in the Plugins folder there is no more work required on your side. Unity automatically picks the right plugin for the right 

deployment platform and includes it with the player.  

 

iOS 
 

Building an Application with Native Plugin for iOS 

1. Define your extern method like:  

2. [DllImport ("__Internal")] 

private static extern float FooPluginFunction (); 

3. Switch the editor to iOS platform  

4. Add your native implementation to the generated XCode project's "Classes" folder (this folder is not overwritten when project is 

updated, but don't forget to backup your native code).  

If you are using C++ (.cpp) or Objective-C (.mm) to implement the plugin you have to make sure the functions are declared with C linkage 

to avoid name mangling issues.  

extern "C" { 

  float FooPluginFunction (); 

}  

Using Your Plugin from C# 
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iOS native plugins can be called only when deployed on the actual device, so it is recommended to wrap all native code methods with an 

additional C# code layer. This code could check Application.platform and call native methods only when running on the actual device and 

return mockup values when running in the Editor. Check the Bonjour browser sample application.  

Calling C# / JavaScript back from native code 

Unity iOS supports limited native->managed callback functionality via UnitySendMessage: 

UnitySendMessage("GameObjectName1", "MethodName1", "Message to send"); 

This function has three parameters : game object name, game object script method to call, message to pass to the called method. 

Limitations to know:  

1. only script methods that correspond to the following signature can be called from native code: function 

MethoName(message:string)  

2. calls to UnitySendMessage are asynchronous and have a one frame delay.  

Automated plugin integration 

Unity iOS supports limited automated plugin integration.  

1. All the .a,.m,.mm,.c,.cpp located in Assets/Plugins/iOS will be automatically merged into produced Xcode project.  

2. Merging is done by symlinking files from Assets/Plugins/iOS to the final destination and this might affect some workflows.  

3. .h files are not included into Xcode project tree, but they appear on final destination file system, thus allowing compilation of 

.m/.mm/.c/.cpp.  

Note: subfolders are not supported.  

iOS Tips 

1. Managed -> unmanaged calls are quite expensive on iOS. Try to avoid calling multiple native methods per frame.  

2. As mentioned above wrap your native methods with an additional C# layer that would call actual code on the device and return 

mockup values in the Editor.  

3. String values returned from a native method should be UTF-8 encoded and allocated on the heap. Mono marshaling calls are free 

for them.  

4. As mentioned above the XCode project's "Classes" folder is a good place to store your native code, because it is not overwritten 

when the project is updated.  

5. Another good place for storing native code is the Assets folder or one of its subfolders. Just add references from the XCode 

project to the native code files: right click on the "Classes" subfolder and choose "Add->Existing files...".  

 

Android 
 

Building a Plugin for Android 

To build a plugin for Android, you first need the Android NDK. Please familiarize yourself with the steps how to build a shared library.  

If you are using C++ (.cpp) to implement the plugin you have to make sure the functions are declared with C linkage to avoid name 

mangling issues.  

extern "C" { 

  float FooPluginFunction (); 

}  
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Using Your Plugin from C# 

Once you have built your shared library you have to copy it to Assets->Plugins->Android folder. Unity will then find it by its name when 

you define a function like this:  

[DllImport ("PluginName")] 

private static extern float FooPluginFunction ();  

Please note that PluginName should not include the prefix ('lib') nor the extension ('.so') of the filename. It is recommended to wrap all 

native code methods with an additional C# code layer. This code could check Application.platform and call native methods only when 

running on the actual device and return mockup values when running in the Editor. You can also use platform defines to control platform 

dependent code compilation.  

Deployment 

For cross platform plugins, your Plugins folder may include plugins for several different platforms (i.e. libPlugin.so for Android, 

Plugin.bundle for Mac and Plugin.dll for Windows). Unity automatically picks the right plugin for the right deployment platform and includes 

it with the player.  

Using Java Plugins 

The Android plugin mechanism also allows Java to be used to enable interaction with the Android OS. Java code can not be called directly 

from C#, so you'd need to write a native plugin to 'translate' the calls between C# and Java.  

Building a Java Plugin for Android 

There are several ways to create a Java plugin. What they have in common is that you will end up with a .jar file containing the .class files 

for your plugin. One way is to start off with downloading the JDK, then compile your .java files from command line with javac to create .class 

files and package them into a .jar with the jar command line tool. Another way is to use Eclipse IDE together with the ADT.  

Using Your Java Plugin from Native Code 

Once you have built your Java plugin (.jar) you have to copy it to Assets->Plugins->Android folder. Unity will package your .class files 

together with the rest of the Java code, and then call it through something called Java Native Interface (JNI). JNI works both ways; calling 

native code from Java, and interacting with Java (or the JavaVM) from native code.  

To find your Java code from the native side you need to have access to the Java VM. Fortunately that is quite easy; just add a function like 

this to your C(++) code:  

jint JNI_OnLoad(JavaVM* vm, void* reserved) { 

  JNIEnv* jni_env = 0; 

  vm->AttachCurrentThread(&jni_env, 0); 

}  

This is all that is needed to start using Java from C(++). Completely explaining JNI is somewhat beyond the scope of this document, but 

usually it includes finding the class definition, resolving the constructor (<init>) method and create a new object instance, as shown here:  

jobject createJavaObject(JNIEnv* jni_env) { 

  jclass cls_JavaClass = jni_env->FindClass("com/your/java/Class");   // find class definition 

http://unity3d.com/support/documentation/ScriptReference/Application-platform.html
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  jmethodID mid_JavaClass = jni_env->GetMethodID (cls_JavaClass, "<init>",  "()V");  // find constructor method 

  jobject obj_JavaClass = jni_env->NewObject(cls_JavaClass, mid_JavaClass);  // create object instance 

  return jni_env->NewGlobalRef(obj_JavaClass);      // return object with a 

global reference 

}  

Using Your Java Plugin with helper classes 

AndroidJNIHelper together with AndroidJNI can be used to ease a bit of pain with raw JNI.  

AndroidJavaObject and AndroidJavaClass automate a lot of things and also use caches to make calls to Java faster. The combination of 

AndroidJavaObject and AndroidJavaClass builds on top of AndroidJNI and AndroidJNIHelper, but also has a lot of logic in itself (to 

handle the automation). These classes also come in a 'static' version to access static members of Java class.  

You can opt for any approach you like, be it a raw JNI through AndroidJNI class methods, or AndroidJNIHelper together with AndroidJNI 

and eventually AndroidJavaObject/AndroidJavaClass for the maximum automation and convenience.  

 UnityEngine.AndroidJNI is a wrapper for the JNI calls available in C (as described above). All methods in this class are static and have a 

1:1 mapping to the Java Native Interface.  

 UnityEngine.AndroidJNIHelper provides helper functionality used by the next level, but is exposed as public methods because they may be 

useful for some special cases.  

 Instances of UnityEngine.AndroidJavaObject and UnityEngine.AndroidJavaClass have a 1:1 mapping to an instances of java.lang.Object 

and java.lang.Class (or subclasses thereof) on the Java side, correspondingly. They essentially provide 3 types of interaction with the Java 

side:  

o Call a method  

o Get the value of a field  

o Set the value of a field  

The Call is separated into two categories: Call to a 'void' method, and Call to a method with non-void return type. A generic type is used to 

represent the return type of those methods which return a non-void type.The Get/Set always take a generic type representing the field type.  

Example 1 

//The comments is what you would need to do if you use raw JNI 

 AndroidJavaObject jo = new AndroidJavaObject("java.lang.String", "some_string");  

 // jni.FindClass("java.lang.String");  

 // jni.GetMethodID(classID, "<init>", "(Ljava/lang/String;)V");  

 // jni.NewStringUTF("some_string");  

 // jni.NewObject(classID, methodID, javaString);  

 int hash = jo.Call<int>("hashCode");  

 // jni.GetMethodID(classID, "hashCode", "()I");  
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 // jni.CallIntMethod(objectID, methodID); 

Here we're creating an instance of java.lang.String, initialized with a of our choice and retrieving the hash value for that string.  

The AndroidJavaObject constructor takes at least one parameter: the name of class for which we want to construct an instance. 

Everything after the class name are parameters for the constructor call of the object, in this case a string "some_string". Then the Call to 

hashCode() that returns an 'int' which is why we use that as the generic type parameter to the Call method.  

Note: You cannot instantiate nested Java class using dotted notation. Inner classes must use $ separator, and it should work in both dotted 

and slash'd format. So android.view.ViewGroup$LayoutParams or android/view/ViewGroup$LayoutParams can be used, where 

LayoutParams class is nested in ViewGroup class.  

Example 2 

One of the plugin samples above shows how to get the cache dir for the current application. This is how you would to it from C# without any 

plugins:  

 AndroidJavaClass jc = new AndroidJavaClass("com.unity3d.player.UnityPlayer");  

 // jni.FindClass("com.unity3d.player.UnityPlayer");  

 AndroidJavaObject jo = jc.GetStatic<AndroidJavaObject>("currentActivity");  

 // jni.GetStaticFieldID(classID, "Ljava/lang/Object;");  

 // jni.GetStaticObjectField(classID, fieldID);  

 // jni.FindClass("java.lang.Object");  

 

 Debug.Log(jo.Call<AndroidJavaObject>("getCacheDir").Call<string>("getCanonicalPath"));  

 // jni.GetMethodID(classID, "getCacheDir", "()Ljava/io/File;"); // or any baseclass thereof!  

 // jni.CallObjectMethod(objectID, methodID);  

 // jni.FindClass("java.io.File");  

 // jni.GetMethodID(classID, "getCanonicalPath", "()Ljava/lang/String;");  

 // jni.CallObjectMethod(objectID, methodID);  

 // jni.GetStringUTFChars(javaString); 

Here we start with AndroidJavaClass instead of AndroidJavaObject, because we want access a static member of 

com.unity3d.player.UnityPlayer, not create a new object (there is already one created as part of the Android UnityPlayer). Then we 

access the static field "currentActivity" but this time we use AndroidJavaObject as the generic parameter. This is because the actual field 

type (android.app.Activity) is a subclass of java.lang.Object, and any non-primitive type must be accessed as AndroidJavaObject (strings 

are the exception to that rule; they can be accessed directly even though they don't represent a primitive type in Java).  
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After that it's just a matter of simply traversing the Activity through getCacheDir(), to get the File object representing the cache directory, 

and call getCanonicalPath() to get a string representation.  

Of course nowadays you don't need to do that to get the cache directory; we have provided access to the application's cache and file 

directory through Application.temporaryCachePath, Application.persistentDataPath.  

Example 3 

Finally a small trick to show how we can pass data from Java to script code using UnitySendMessage.  

using UnityEngine;  

public class NewBehaviourScript : MonoBehaviour {  

 

 void Start () {  

  JNIHelper.debug = true;  

  using (JavaClass jc = new JavaClass("com.unity3d.player.UnityPlayer")) {  

   jc.CallStatic("UnitySendMessage", "Main Camera", "JavaMessage", "whoowhoo");  

  }  

 }  

 

 void JavaMessage(string message) {  

  Debug.Log("message from java: " + message);  

 } 

}  

The Java class com.unity3d.player.UnityPlayer now has a static method UnitySendMessage, equivalent to the iOS' UnitySendMessage 

on the native side; it can be used in Java to pass data to script code.  

But here we call it directly from script code. That essentially relays the message on the Java side, which then calls back in the native/Unity 

to deliver the message to the object named "Main Camera", with a script attached to it which as a method called "Java Message".  

The best practices of using the Java plugins with Unity 

As this section is manly targeted at people who don't have comprehensive JNI, Java and Android experience, we assume that 

AndroidJavaObject/AndroidJavaClass approach has been taken to interact with Java code from Unity.  

http://developer.android.com/reference/android/content/Context.html#getCacheDir
http://developer.android.com/reference/java/io/File.html#getCanonicalPath
http://unity3d.com/support/documentation/ScriptReference/Application-temporaryCachePath.html
http://unity3d.com/support/documentation/ScriptReference/Application-persistentDataPath.html
http://unity3d.com/support/documentation/Manual/Plugins.html#iPhonePlugins


The very first thing that should be noted is that any operation you do on a AndroidJavaObject / AndroidJavaClass is expensive (as is a 

raw JNI approach though). It's very much recommended to keep the number of transitions between managed and native/java to a 

minimum. Both for the sake of performance and also complexity.  

Basically you could have a Java method to do all the actual work and then use AndroidJavaObject / AndroidJavaClass to communicate 

with that method and get the result. That's said, it may be beneficial to know, that with JNI helper classes we try to cache as much data as 

possible.  

//The first time you call a Java function like  

AndroidJavaObject jo = new AndroidJavaObject("java.lang.String", "some_string");  // somewhat expensive 

int hash = jo.Call<int>("hashCode");  // first time - expensive 

int hash = jo.Call<int>("hashCode");  // second time - not as expensive as we already know the java method and can call it straight 

It's the same way as a JIT: first time you call it, it will be slow because the code doesn't exist. Next time is much cheaper. In other words, 

you pay for every .Call /.Get / .Set, but you pay less after the first time you call it, per object. You pay for creating a AndroidJavaClass / 

AndroidJavaObject.  

Mono garbage collector should release all the created instances of AndroiJavaObject / AndroidJavaClass, yet it is strongly advised to 

keep them in a using(){} statement to ensure they are deleted as soon as possible. Otherwise there is no real guarantee when they will be 

destroyed. If you set AndroidJNIHelper.debug = true; you will see the debug output exposing the Garbage Collector behavior.  

//Getting the system language with the safe approach 

void Start () {  

 using (AndroidJavaClass cls = new AndroidJavaClass("java.util.Locale")) {  

  using(AndroidJavaObject locale = cls.CallStatic<AndroidJavaObject>("getDefault")) {  

   Debug.Log("current lang = " + locale.Call<string>("getDisplayLanguage"));  

 

  }  

 }  

} 

You can also call the .Dispose() method directly to ensure there are no Java objects lingering. The actual C# object might live a bit longer 

though, but will be garbage collected by mono eventually.  

Extending the UnityPlayerActivity Java Code 

With Unity Android it is also possible to extend the regular UnityPlayerActivity (primary Java class for the Unity Player on Android, similarly 

to AppController.mm on Unity iOS).  



An application can, by creating a new Activity which derives from UnityPlayerActivity (UnityPlayerActivity.java can be found at 

/Applications/Unity/Unity.app/Contents/PlaybackEngines/AndroidPlayer/src/com/unity3d/player on Mac and usually at C:\Program 

Files\Unity\Editor\Data\PlaybackEngines\AndroidPlayer\src\com\unity3d\player), override any and all of the basic interaction between 

Android OS and Unity Android.  

To do that first locate the classes.jar shipped with Unity Android. It is found under the installation folder (usually C:\Program 

Files\Unity\Editor\Data (on Windows) or /Applications/Unity (on Mac)) in a folder called PlaybackEngines/AndroidPlayer/bin. Then 

add that classes.jar file to the classpath used to compile the new activity. The resulting .class file(s) should be compressed into a .jar file 

and placed under Assets->Plugins->Android. As the manifest dictates which activity to launch it's also necessary to create a new 

AndroidManifest.xml. The AndroidManifest.xml should also be placed under Assets->Plugins->Android.  

The new activity could look like OverrideExample.java:  

package com.company.product; 

 

import com.unity3d.player.UnityPlayerActivity; 

 

import android.os.Bundle; 

import android.util.Log; 

 

public class OverrideExample extends UnityPlayerActivity { 

 

  protected void onCreate(Bundle savedInstanceState) { 

 

    // call UnityPlayerActivity.onCreate() 

    super.onCreate(savedInstanceState); 

 

    // print debug message to logcat 

    Log.d("OverrideActivity", "onCreate called!"); 

  } 

 

http://developer.android.com/reference/android/app/Activity.html
http://developer.android.com/guide/topics/manifest/manifest-intro.html


  public void onBackPressed() 

  { 

    // instead of calling UnityPlayerActivity.onBackPressed() we just ignore the back button event 

    // super.onBackPressed(); 

  } 

}  

And this is what the matching AndroidManifest.xml would look like:  

<?xml version="1.0" encoding="utf-8"?> 

<manifest xmlns:android="http://schemas.android.com/apk/res/android" package="com.company.product"> 

  <application android:icon="@drawable/app_icon" android:label="@string/app_name"> 

 <activity android:name=".OverrideExample" 

     android:label="@string/app_name"> 

        <intent-filter> 

   <action android:name="android.intent.action.MAIN" /> 

   <category android:name="android.intent.category.LAUNCHER" /> 

  </intent-filter> 

 </activity> 

  </application> 

</manifest>  

Examples 
 

Desktop  
 

Simplest Plugin 

This is a basic example of a project and a plugin that only do basic operations (prints a number, prints a string, adds two floats and adds 

two integers). Check this example if this is your first time learning plugins in Unity. 

The project can be found here.  

This project includes both Windows and Mac project files.  

javascript:ShowHideDiv('desktopRef','specific-desktop','Desktop');
javascript:ShowHideDiv('desktopRef','specific-desktop','Desktop');
http://unity3d.com/support/documentation/Images/manual/SimplestPluginExample.zip
javascript:ShowHideDiv('desktopRef','specific-desktop','Desktop');


Midi Plugin 

A complete example of the Plugin interface can be found here.  

This is a complete Midi plugin for OS X which uses Apple's CoreMidi API. It provides a simple C API and a C# class using the C API. The 

C# class contains a high level API, with easy access to NoteOn and NoteOff events and their velocity.  

Texture Plugin 

An example of how to assign image data to a texture from C++ directly to OpenGL (note that this will only work when Unity is using an 

OpenGL renderer). This example includes both XCode (for Mac) and Visual Studio (for Windows) project files. The plugin with 

accompanying Unity project can be found here.  

 

iOS 
 

Bonjour Browser Sample 

A simple example of the use of native code plugin can be found here  

This sample demonstrates how objective-C code can be invoked from a Unity iOS application. This application implements a very simple 

Bonjour client. The application consists of a Unity iOS project (Plugins/Bonjour.cs: C# interface to the native code, BonjourTest.js: JS script 

that implements application logic) and native code (Assets/Code) that should be added to built XCode project.  

 

Android 
 

Native Plugin Sample 

A simple example of the use of native code plugin can be found here  

This sample demonstrates how C code can be invoked from a Unity Android application. The package includes a scene which displays the 

sum to two values, calculated by the native plugin. Please note that you will need the Android NDK to compile the plugin.  

Java Plugin Sample 

An example of the use of Java code can be found here  

This sample demonstrates how Java code can be used to interact with the Android OS and how C++ creates a bridge between C# and 

Java. The package includes a scene which displays a button that when pressed fetches the application cache directory, as defined by the 

Android OS. Please note that you will need both the JDK and the Android NDK to compile the plugins.  

The same example but based on a prebuilt JNI library to wrap the native code into C# can be found here  

More Information 

Mono Interop with native libraries.  

P-invoke documentation on MSDN.  
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Android Splash Screen 
 

iOS 
 

How do I make a splash screen? 
As part of your game publishing process, you may want to customize the splash screen that appears when launching your game on the 

device. Unity iOS Basic users can choose between four different orientations of the included splash screen, and Unity iOS Advanced users 

can use any texture to create their own unique splash screens to be displayed.  

The splash screen can be customized in Player Settings. The desired splash orientation is specified via the "Default Screen Orientation" 

Player Settings (Resolution and Presentation section) property.  

Using one of the included splash screens 

You can choose one of four default splash screen orientations:  

1. Portrait - The user interface and splash screen are oriented vertically. The home button is on the bottom of the device.  

2. Portrait Upside Down - The user interface and splash screen are oriented vertically. The home button is on the top of the device.  

3. Landscape Right - The user interface and splash screen are oriented horizontally. The home button is on the left side of the 

device.  

4. Landscape Left - The user interface and splash screen are oriented horizontally. The home button is on the right side of the 

device.  

Using a unique splash screen (Pro License feature) 

Unity iOS Pro users can use any texture as a splash screen. The standard splash screen size varies with the device (320x480 pixels for 1-

3rd gen devices, 1024x768 for iPad, 640x960 for 4th gen devices). Textures not matching this size will be automatically re-sized. 

Instructions:  

1. Drop your splash screen texture anywhere in the Assets folder.  

2. In Player Settings (Splash Image section), select your texture for Mobile Splash Screen, High Res. iPhone or iPad 

Portrait/Landscape properties. You need to specify only the ones that are applicable for your target device.  

That's it! When your game is built, your custom image will be used.  

 

Android 
 

How do I make a Splash Screen? 
As part of your game publishing process, you may want to customize the splash screen that appears when launching your game on the 

device. Unity Android Basic users can choose between two orientations of the included splash screen, and Unity Android Advanced users 

can use any texture to create their own unique splash screen to be displayed.  

Customizing the splash screen is performed in Player Settings. The desired splash orientation is specified via "Default Screen Orientation" 

Player Settings (Resolution and Presentation section) property.  

Using One of the Included Splash Screens 

You can choose one of four default Splash Screen orientations:  

1. Portrait - user interface and Splash Screen is oriented vertically. Home button is on the bottom of device.  

2. Portrait Upside Down - falls back to Portrait.  

javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
http://unity3d.com/support/documentation/Components/class-PlayerSettings.html
javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
javascript:ShowHideDiv('iosRef','specific-ios', 'iOS');
javascript:ShowHideDiv('androidRef','specific-android', 'Android');


3. Landscape Left - user interface and Splash Screen is oriented horizontally. Home button is on right side of device.  

4. Landscape Right - falls back to Landscape Left.  

Using a Unique Splash Screen (Pro License feature) 

Unity Android Pro users can use any texture as a splash screen. Instructions:  

1. Drop your texture for Splash Screen anywhere in Assets folder.  

2. In Player Settings (Splash Image section) select your texture for Mobile Splash Screen property.  

3. Select a Splash scaling that best suit your needs.  

o Center (only scale down) will try to draw your image "pixel correct", with no scaling unless needed to fit it on screen.  

o Scale to fit (letter-boxed) will try to draw your image full screen, but without cropping it, an fill the empty space with black pixels.  

o Scale to fill (cropped) will draw your image full screen, and cut the parts which extend outside the screen.  

That's it! When your game is built, your custom image will be used.  
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Android-Devices That Have Been Tested 
Here is a list of what Android devices we test on and our users have informed us that they are able to develop on. If you are using a device 

that is not listed here and everything is working for you, then drop us an email at support@unity3d.com and tell us what the device is and 

what version of Android OS you are running on it. We will then update this list at the next update of unity. You can also find a list on our 

forum which will be updated more regularly.  

ARMv7 devices  

Device  Android OS Versions  

Google Nexus One  OS 2.1 and newer  

Google Nexus S  OS 2.3 and newer  

Motorola Droid X  OS 2.1 and newer  

Motorola Droid  OS 2.1 and newer  

Motorola XT701  OS 2.1  

HTC EVO 4G  OS 2.1 and newer  

HTC Droid Incredible  OS 2.1 and newer  

HTC Desire HD  OS 2.1 and newer  

HTC Desire Z  OS 2.1 and newer  

HTC Desire  OS 2.1 and newer  

http://unity3d.com/support/documentation/Components/class-PlayerSettings.html
http://forum.unity3d.com/threads/77388-Androids-that-work-with-Unity-Android


SE X10  OS 2.1 and newer  

Samsung Galaxy S  OS 2.2 and newer  

Samsung Galaxy S (Fascinate)  OS 2.1  

Samsung Galaxy Tab  OS 2.2  

ARMv6 w/ VFP Devices  

Device  Android OS Versions  

Orange San Francisco / ZTE Blade  OS 2.1 and newer  

SE X10 mini  OS 2.1 and newer  

Samsung Galaxy 580  OS 2.1 and newer  
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Android-Integrating Unity With Eclipse 
Please not that every care has been taken to make this guide as friendly as possible to new users. However it will be a lot simpler to follow 

if you are at least familiar with using eclipse, the java programming language and have some knowledge of the android sdk.  

To be able to use unity android with eclipse you will first need to have Eclipse configured for use with Android. There is great guide on how 

to do this in the android developer documentation.  

Unity as a Library 

Once you have eclipse installed and up to date you have to follow a few steps to get your unity project set up as a library in eclipse.  

 Create a new empty unity project and build it for android. It does not matter at this point if the unity project contains any code or other 

assets. This part of the process is in no way future proof and will be subject to change with future release of unity android.  

 Navigate to your new project folder and then into the Temp folder. In there is a folder called staging area.  

 Copy the staging area folder and place it somewhere in your file system that you can use as a holding area. This holding area should not 

be in your eclipse workspace as it will lead to errors.  

 Open Eclipse and create a new Android Project using File --> New --> Project.  

 Select Android Project then click next.  

 This will be the library part of your project so name the project accordingly to avoid any confusion.  

 You will also want to select the option to create project from an existing source. This source being the files you copied to the folder you are 

using as a holding area. If you select the Staging Area folder then click OK you will see that eclipse has filled in the relevant fields for you.  

 click finish on the project creation wizard.  

 Finally right click the root folder in the Package explorer tab in Eclipse and select the Properties option then the android tab. Check the "Is 

Library" check box, click Apply and then OK.  

This completes the steps that you need to carry out to have your unity project addressed as a library in eclipse.  

Java Project 

The next step is to create the eclipse project that will form the executable part of the project.  

http://developer.android.com/sdk/eclipse-adt.html#installing


 Create another new android project.  

 Name the project and select the Build Target and Min SDK Version to be the same as the Library project that you created.  

 Make sure that the package name is the same as the bundle identifier in your unity project otherwise you can get problems with conflicting 

files in the generated java files in your project.  

 Now the library you created needs to be added to the project, you do this by right clicking the JavaProject and selecting properties.  

 You then need to Select Android and click add. A window should then popup select the library project that was created and click ok. Once 

you are back in the main window click apply.  

 Now select Java Build Path from the list on the left and click add external jar. A window will now popup you need to navigate to your unity 

install directory and in Unity\Editor\Data\PlaybackEngines\androidplayer\bin there will be a file called classes.jar. Double click that and then 

click on ok.  

This sets up a basic Java Project that is now linked to your unity project and the relevant libraries that we will later need.  

Moving the Projects Assets 

This is the important part to get your unity content into the Java Project so that it will display when you later build and run your Java Project. 

You now need to move all the files in the assets folder in the library project into the new project. This is because Android does not allow 

assets to be used in libraries. The best way to do this is from within the Eclipse IDE. If you expand the assets files within both parts of the 

package explorer and simply drag the bin and libs folders from the library part of your project to the other. This last step needs to repeated 

everytime your unity project is rebuilt or maybe you could write a script to handle moving the files everytime you build the project 

automatically. This could also be achieved using symlinks or junctions. At this point when you run the from the eclipse ide you will be asked 

which type of project that you want to run. Select android and click ok. After eclipse builds the project it will deploy it to your connected 

android device and you should see a hello world style application running.  

Getting Your Unity Content Running 

To get your unity project you need to make a few changes to the java source code. In your eclipse project there will be one source file 

(.java) open this file. The contents of this file will resemble something like this.  

package com.Unity3D.EclipseIntegration; 

 

import android.app.Activity; 

import android.os.Bundle; 

 

public class EclipseIntegration extends Activity { 

    /** Called when the activity is first created. */ 

    @Override 

    public void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

        setContentView(R.layout.main); 

    } 



} 

We need to change this. The first thing is to change the base class of the object. It should now instead extend UnityPlayerActivity. You will 

notice that when you do this that it is red underlined proclaiming errors. This is simply missing import directives in the file. The eclipse 

shortcut to auto resolve this is ctrl+shift+o. The fiel should now have the import statement.  

import com.unity3d.player.UnityPlayerActivity; 

If you run in this state you will see that you now have a full screen hello world application. This is not what you want we need one more 

change to get your unity content running.  

In the onCreate function there is one line that is overriding the unity view in the android application. If you delete the line.  

setContentView(R.layout.main); 

The complete file should now look like this.  

package com.Unity3D.EclipseIntegration; 

 

import android.os.Bundle; 

 

import com.unity3d.player.UnityPlayerActivity; 

 

public class EclipseIntegration extends UnityPlayerActivity { 

    /** Called when the activity is first created. */ 

    @Override 

    public void onCreate(Bundle savedInstanceState) { 

        super.onCreate(savedInstanceState); 

    } 

} 

If you run it now you will see your unity content running on your android device.  
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Android-Launch an Android Application from a Unity Application 
If you have followed the guide on integrating unity with eclipse then you will have a basis for doing this. This example will show you how to 

launch your media gallery from your unity android application.  

Adding the launch control to Unity 

What you need to do is add some control into unity that will call into the Java project and launch the unity application. In this example a 

button will be used.  

Adding the button 

In your unity project create new script. Within the script add an OnGUi function. In this function we need to add the button and makes some 

calls to Java. The calls to Java are made using the AndroidJavaClass and AndroidJavaObject. What you need to do is get the 

currentActivity and then call a function in that to start an intent.  

 void OnGUI() 

 { 

  if(GUI.Button(new Rect(100,100,100,100) , "launch")) 

  { 

   AndroidJavaClass jc = new AndroidJavaClass("com.unity3d.player.UnityPlayer"); 

   AndroidJavaObject jo = jc.GetStatic<AndroidJavaObject>("currentActivity"); 

   jo.Call("Launch"); 

  } 

 } 

Now that is in place you need to build your project and move the contents of the assets folder in project directory over to the eclipse project.  

The Java Code 

Previously you had written the button to launch the activity on Android through an intent. You now need to write the Java Code that will 

actually do this.  

 You need to add an intent to your Java code.  

private Intent myIntent; 

 This intent then needs to be setup in the onCreate function. For more information on intents please consult the android sdk documentation  

        myIntent = new Intent(); 

 

        myIntent.setAction(Intent.ACTION_VIEW); 

http://unity3d.com/support/documentation/Manual/Android-Integrating%20Unity%20With%20Eclipse.html
http://unity3d.com/support/documentation/ScriptReference/AndroidJavaClass.html
http://unity3d.com/support/documentation/ScriptReference/AndroidJavaObject.html
http://developer.android.com/reference/android/app/Activity.html
http://developer.android.com/reference/android/content/Intent.html
http://developer.android.com/reference/android/content/Intent.html


        myIntent.setData(android.provider.MediaStore.Images.Media.INTERNAL_CONTENT_URI); 

 The final step is to create the function that you call from your unity application and within it make a call to startActivity. As the function 

earlier in this example was called launch that is what we will have to call it in this example.  

    public void Launch() 

    {      

     startActivity(myIntent); 

    } 

If you now build and run your application from Eclipse you should now have a Unity application that runs on your Android device with a 

button named launch that when pressed the media gallery on your device launches. You can then press the back button to go back to your 

Android device and repeat the process.  

Page last updated: 2011-02-21 

 

 

FAQ 
The following is a list of common tasks in Unity and how to accomplish them.  

 Upgrading your Unity Projects from 2.x to 3.x  

o Physics upgrade details  

o Mono Upgrade Details  

o Rendering upgrade details  

o Unity 3.x Shader Conversion Guide  

 What's New in Unity?  

 Activation  

 Game Code Questions  

o How to make a simple first person walkthrough  

 Graphics Questions  

o How do I Import Alpha Textures?  

o How do I Use Normal Maps?  

o How do I use Detail Textures?  

o How do I Make a Cubemap Texture?  

o How do I Make a Skybox?  

o How do I make a Mesh Particle Emitter?  

o How do I make a Splash Screen?  

o How do I make a Spot Light Cookie?  

o How do I fix the rotation of an imported model?  

o How do I use Water?  

 FBX export guide  

 How do I import objects from my 3D app?  

o Importing Objects From Maya  

o Importing Objects From Cinema 4D  

o Importing Objects From 3D Studio Max  

o Importing Objects From Cheetah3D  

o Importing Objects From Modo  

o Importing Objects From Lightwave  

o Importing Objects From Blender  

http://unity3d.com/support/documentation/Manual/HowToUpgradeFrom2xTo3x.html
http://unity3d.com/support/documentation/Manual/PhysicsUpgradeDetails.html
http://unity3d.com/support/documentation/Manual/MonoUpgradeDetails.html
http://unity3d.com/support/documentation/Manual/RenderingUpgradeDetails.html
http://unity3d.com/support/documentation/Manual/SL-V3Conversion.html
http://unity3d.com/support/documentation/Manual/WhatIsNewInCurrentVersion.html
http://unity3d.com/support/documentation/Manual/Activation.html
http://unity3d.com/support/documentation/Manual/Game%20Code%20How-to.html
http://unity3d.com/support/documentation/Manual/HOWTO-First%20Person%20Walkthrough.html
http://unity3d.com/support/documentation/Manual/Graphics%20how-tos.html
http://unity3d.com/support/documentation/Manual/HOWTO-alphamaps.html
http://unity3d.com/support/documentation/Manual/HOWTO-Normalmap.html
http://unity3d.com/support/documentation/Manual/HOWTO-UseDetailTexture.html
http://unity3d.com/support/documentation/Manual/HOWTO-MakeCubemap.html
http://unity3d.com/support/documentation/Manual/HOWTO-UseSkybox.html
http://unity3d.com/support/documentation/Manual/HOWTO-MeshParticleEmitter.html
http://unity3d.com/support/documentation/Manual/HOWTO-SplashScreen.html
http://unity3d.com/support/documentation/Manual/HOWTO-LightCookie.html
http://unity3d.com/support/documentation/Manual/HOWTO-FixZAxisIsUp.html
http://unity3d.com/support/documentation/Manual/HOWTO-Water.html
http://unity3d.com/support/documentation/Manual/HOWTO-exportFBX.html
http://unity3d.com/support/documentation/Manual/HOWTO-importObject.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectMaya.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectCinema4D.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectMax.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectCheetah3D.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectModo.html
http://unity3d.com/support/documentation/Manual/HOWTO-importObjectLightwave.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectBlender.html


 Workflow Questions  

o Getting started with Mono Develop  

o How do I reuse assets between projects?  

o How do I install or upgrade Standard Assets?  
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HowToUpgradeFrom2xTo3x 
In our regular point releases of Unity, we make sure that projects from previous minor versions of the same major version are automatically 

upgraded when opened in the new editor for the first time. New properties are given default values, formats are converted and so on. 

However for major version changes such as 2.x to 3.x, we introduce several backwards-compatibility breaking changes.  

While the primary visibility of this is the fact that content authored in the previous version will play back slightly differently when run in the 

new engine, some changes require more than a few property tweaks to play just like you want them to. These documents outlines those 

changes from 2.x to 3.x:  

 Physics upgrade details  

 Mono Upgrade Details  

 Rendering upgrade details  

 Unity 3.x Shader Conversion Guide  
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PhysicsUpgradeDetails 
For Unity 3.0, we upgraded the NVIDIA PhysX library from version 2.6 to 2.8.3, to give you access to many new features. Generally for 

existing projects, the behavior should be roughly the same as in Unity 2.x, but there may be slight differences in the outcome of physics 

simulation, so if your content depends on the exact behavior or on chain reactions of physical events, you may have to re-tweak your setup 

to work as expected in Unity 3.x.  

If you are using Configurable Joints, the JointDrive.maximumForce property will now also be taken into consideration when 

JointDrive.mode is JointDriveMode.Position. If you have set this value to the default value of zero, the joint will not apply any forces. We will 

automatically change all JointDrive properties imported from old versions if JointDrive.mode is JointDriveMode.Position, but when you set 

up a joint from code, you may have to manually change this. Also, note that we have changed the default value for 

JointDrive.maximumForce to infinity.  
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MonoUpgradeDetails 
In Unity 3 we upgraded the mono runtime from 1.2.5 to 2.6 and on top of that, JavaScript and Boo improvements. Aside from all bug fixes 

and improvements to mono between the two versions, this page lists some of the highlights.  

C# Improvements 

Basically the differences betweeen C# 3.5 and C# 2.0, including:  

 Variable type inference. More info here.  

http://unity3d.com/support/documentation/Manual/Workflow.html
http://unity3d.com/support/documentation/Manual/HOWTO-MonoDevelop.html
http://unity3d.com/support/documentation/Manual/HOWTO-exportpackage.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Manual/PhysicsUpgradeDetails.html
http://unity3d.com/support/documentation/Manual/MonoUpgradeDetails.html
http://unity3d.com/support/documentation/Manual/RenderingUpgradeDetails.html
http://unity3d.com/support/documentation/Manual/SL-V3Conversion.html
http://unity3d.com/support/documentation/Components/class-ConfigurableJoint.html
http://msdn.microsoft.com/en-us/library/bb383973.aspx


 Linq .  

 Lambdas. More info here.  

JavaScript Improvements 

 Compiler is now 4x faster;  

 'extends' no longer can be used with interfaces, unityscript now have 'implements' for that purpose (see below);  

 Added support for consuming generic types such as generic collections:  

  var list = new System.Collections.Generic.List.<String>(); 

  list.Add("foo"); 

 Added support for anonymous functions/closures:  

  list.Sort(function(x:String, y:String) { 

   return x.CompareTo(y); 

  }); 

 Which include a simplified lambda expression form with type inference for the parameters and return value:  

  list.Sort(function(x, y) x.CompareTo(y)); 

 Function types:  

  function forEach(items, action: function(Object)) { 

   for (var item in items) action(item); 

  } 

 Type inferred javascript array comprehensions:  

  function printArray(a: int[]) { 

   print("[" + String.Join(", ", [i.ToString() for (i in a)]) + "]"); 

  } 

 

  var doubles = [i*2 for (i in range(0, 3))]; 

  var odds = [i for (i in range(0, 6)) if (i % 2 != 0)]; 

  printArray(doubles); 

http://msdn.microsoft.com/en-us/library/bb397687.aspx


  printArray(odds); 

 Added support for declaring and implementing interfaces:  

  interface IFoo { 

   function bar(); 

  } 

 

  class Foo implements IFoo { 

   function bar() { 

    Console.WriteLine("Foo.bar"); 

   } 

  } 

 All functions are now implicitly virtual, as a result the 'virtual' keyword has been deprecated and the 'final' keyword has been introduced to 

allow for non virtual methods to be defined as:  

  final function foo() { 

  } 

 Value types (structs) can be defined as classes inheriting from System.ValueType:  

  class Pair extends System.ValueType { 

   var First: Object; 

   var Second: Object; 

 

   function Pair(fst, snd) { 

    First = fst; 

    Second = snd; 

   } 

 



   override function ToString() { 

    return "Pair(" + First + ", " + Second + ")"; 

   } 

  } 

Boo Improvements 

 Boo upgrade to version 0.9.4.  
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RenderingUpgradeDetails 
Unity 3 brings a lot of graphics related changes, and some things might need to be tweaked when you upgrade existing Unity 2.x projects. 

For changes related to shaders, see Shader Upgrade Guide.  

Forward Rendering Path changes 

Unity 2.x had one rendering path, which is called Forward in Unity 3. Major changes in it compared to Unity 2.x:  

 Most common case (one directional per-pixel light) is drawn in one pass now! (used to be two passes)  

 Point & Spot light shadows are not supported. Only one Directional light can cast shadows. Use Deferred Lighting path if you need more 

shadows.  

 Most "Vertex" lights replaced with Spherical Harmonics lighting.  

 Forward rendering path is purely shader based now, so it works on OpenGL ES 2.0, Xbox 360, PS3 (i.e. platforms that don't support fixed 

function rendering).  

Shader changes 

See Shader Upgrade Guide for more details. Largest change is: if you want to write shaders that interact with lighting, you should use 

Surface Shaders.  

Obscure Graphics Changes That No One Will Probably Notice 
TM

 

 Removed Mac Radeon 9200 pixel shader support (!!ATIfs assembly shaders).  

 Removed support for per-pixel lighting on pre-ShaderModel2.0 hardware. As a result, Diffuse Fast shader is just VertexLit now.  

 Removed non-attenuated lights. All point and spot lights are attenuated now.  

 Removed script callbacks: OnPreCullObject and RenderBeforeQueues attribute.  

 Removed p-buffer based RenderTextures. RenderTextures on OpenGL require FBO support now.  

 Most Pass LightMode tags are gone, and replaced with new tags. You should generally be using Surface Shaders for that stuff anyway.  

 Texture instanceIDs are not OpenGL texture names anymore. Might affect C++ Plugins that were relying on that; use 

texture.GetNativeTextureID() instead.  

 Rename shader keywords SHADOWS_NATIVE to SHADOWS_DEPTH; SHADOWS_PCF4 to SHADOWS_SOFT.  

 Removed ambient boost on objects that were affected by more than 8 vertex lights.  

 Removed _ObjectSpaceCameraPos and _ObjectSpaceLightPos0 (added _WorldSpaceCameraPos and 

_WorldSpaceLightPos0).  

 LightmapMode tag in shader texture property does nothing now.  

 Skybox shaders do not write into depth buffer.  

 GrabPass (i.e. refractive glass shader) now always grabs texture of the size of the screen.  

 #pragma multi_compile_vertex and #pragma multi_compile_fragment are gone.  

 Polygon offset in ShaderLab can't reference variables anymore (like Offset [_Var1], [_Var2]).  

http://unity3d.com/support/documentation/Manual/SL-V3Conversion.html
http://unity3d.com/support/documentation/Components/RenderTech-ForwardRendering.html
http://unity3d.com/support/documentation/Components/RenderTech-DeferredLighting.html
http://unity3d.com/support/documentation/Manual/SL-V3Conversion.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html
http://unity3d.com/support/documentation/Components/SL-PassTags.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html


 Renamed TRANSFER_EYEDEPTH/OUTPUT_EYEDEPTH to UNITY_TRANSFER_DEPTH/UNITY_OUTPUT_DEPTH. They also work 

on a float2 in Unity 3.  

 Removed special shader pass types: R2TPass, OffscreenPass.  

 Removed _Light2World0, _World2Light0 built-in shader matrices.  

 Removed _SceneAmbient, _MultiModelAmbient, _MultiAmbient, _ModelAmbient, _MultiplyFog, _LightHackedDiffuse0, 

_ObjectCenterModelLightColor0 built-in shader vectors.  

 Removed _FirstPass built-in shader float.  

 Fog mode in shader files can't come from variable (like Fog { Mode [_MyFogMode] }). To use global fog mode, write Fog { 

Mode Global }.  

 Removed BlendColor color from ShaderLab.  

 Removed support for declaring texture matrix by-value in shader property.  

 Removed support for "static" shader properties.  

 Removed support for texture border color (RenderTexture.SetBorderColor).  

 Removed ColorMaterial Ambient, Diffuse, Specular support (ColorMaterial AmbientAndDiffuse & Emission left). Support 

for the removed ones varied a lot depending on the platform causing confusion; and they didn't seem to be very useful anyway.  

 Built-in _CameraToWorld and _WorldToCamera matrices now do what you'd expect them to do. Previously they only contained the 

rotation part, and camera-to-world was flipped on Y axis. Yeah, we don't know how that happened either :)  

 Removed Shader.ClearAll(). Was deprecated since 2007, time to let it go.  

 Vertex shaders are compiled to Shader Model 2.0 now (before was 1.1). If you want to compile to SM1.1, add #pragma target 1.1 

in the shader.  
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SL-V3Conversion 
Unity 3 has many new features and changes to its rendering system, and ShaderLab did update accordingly. Some advanced shaders that 

were used in Unity 2.x, especially the ones that used per-pixel lighting, will need update for Unity 3. If you have trouble updating them - just 

ask for our help!  

For general graphics related Unity 3 upgrade details, see Rendering Upgrade Details.  

When you open your Unity 2.x project in Unity 3.x, it will automatically upgrade your shader files as much as possible. The document below 

lists all the changes that were made to shaders, and what to do when you need manual shader upgrade.  

Per-pixel lit shaders 

In Unity 2.x, writing shaders that were lit per-pixel was quite complicated. Those shaders would have multiple passes, with LightMode tags 

on each (usually PixelOrNone, Vertex and Pixel). With addition of Deferred Lighting in Unity 3.0 and changes in old forward rendering, we 

needed an easier, more robust and future proof way of writing shaders that interact with lighting. All old per-pixel lit shaders need to be 

rewritten to be Surface Shaders.  

Cg shader changes 

Built-in "glstate" variable renames 

In Unity 2.x, accessing some built-in variables (like model*view*projection matrix) was possible through built-in Cg names like 

glstate.matrix.mvp. However, that does not work on some platforms, so in Unity 3.0 we renamed those built-in variables. All these 

replacements will be done automatically when upgrading your project:  

 glstate.matrix.mvp to UNITY_MATRIX_MVP  

 glstate.matrix.modelview[0] to UNITY_MATRIX_MV  

 glstate.matrix.projection to UNITY_MATRIX_P  

 glstate.matrix.transpose.modelview[0] to UNITY_MATRIX_T_MV  

 glstate.matrix.invtrans.modelview[0] to UNITY_MATRIX_IT_MV  

 glstate.matrix.texture[0] to UNITY_MATRIX_TEXTURE0  

http://unity3d.com/support/documentation/Manual/RenderingUpgradeDetails.html
http://unity3d.com/support/documentation/Components/RenderTech-DeferredLighting.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html


 glstate.matrix.texture[1] to UNITY_MATRIX_TEXTURE1  

 glstate.matrix.texture[2] to UNITY_MATRIX_TEXTURE2  

 glstate.matrix.texture[3] to UNITY_MATRIX_TEXTURE3  

 glstate.lightmodel.ambient to UNITY_LIGHTMODEL_AMBIENT  

 glstate.matrix.texture to UNITY_MATRIX_TEXTURE  

Semantics changes 

Additionally, it is recommended to use SV_POSITION (instead of POSITION) semantic for position in vertex-to-fragment structures.  

More strict error checking 

Depending on platform, shaders might be compiled using a different compiler than Cg (e.g. HLSL on Windows) that has more strict error 

checking. Most common cases are:  

 All vertex/fragment shader inputs and outputs need to have "semantics" assigned to them. Unity 2.x allowed to not assign any semantics (in 

which case some TEXCOORD would be used); in Unity 3.0 semantic is required.  

 All shader output variables need to be written into. For example, if you have a float4 color : COLOR as your vertex shader output, 

you can't just write into rgb and leave alpha uninitialized.  

Other Changes 

RECT textures are gone 

In Unity 2.x, RenderTextures could be not power of two in size, so called "RECT" textures. They were designated by "RECT" texture type in 

shader properties and used as samplerRECT, texRECT and so on in Cg shaders. Texture coordinates for RECT textures were a 

special case in OpenGL: they were in pixels. In all other platforms, texture coordinates were just like for any other texture: they went from 

0.0 to 1.0 over the texture.  

In Unity 3.0 we have decided to remove this OpenGL special case, and treat non power of two RenderTextures the same everywhere. It is 

recommended to replace samplerRECT, texRECT and similar uses with regular sampler2D and tex2D. Also, if you were doing any 

special pixel adressing for OpenGL case, you need to remove that from your shader, i.e. just keep the non-OpenGL part (look for 

SHADER_API_D3D9 or SHADER_API_OPENGL macros in your shaders).  
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WhatIsNewInCurrentVersion 
Unity 3 is packed full of new features and improvements to existing features. Browse through the list, or click through to get more 

information about any of the new features.  

Unified Editor 

Unity is now the best editor for multi-platform projects. The new Build Settings window lets you set your primary Editor Mode or build to any 

of your target platforms. New Platform Defines let you include or exclude code for a specific platform at compile-time, so you can work with 

one project and one set of scripts.  

Editor Improvements 

Numerous Editor workflow improvements and enhancements have been added, including:  

 Redesigned Player Settings -- for customizing your game experience on multiple platforms  

 All-new Object Picker -- for quickly viewing and selecting object assignments  

 Smarter Texture Importer -- for optimizing your textures based on how they'll be used  

 Vertex Snapping -- for quickly designing levels and environments  

 Curve Editor -- for defining curves right inside the Inspector  

 Searching -- in scenes and your whole project  

http://unity3d.com/support/documentation/Components/class-RenderTexture.html
http://unity3d.com/support/documentation/Manual/Publishing%20Builds.html
http://unity3d.com/support/documentation/Manual/Platform%20Dependent%20Compilation.html
http://unity3d.com/support/documentation/Components/class-PlayerSettings.html
http://unity3d.com/support/documentation/Manual/Editing%20Reference%20Properties.html
http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/Manual/Positioning%20GameObjects.html
http://unity3d.com/support/documentation/Manual/Editing%20Value%20Properties.html
http://unity3d.com/support/documentation/Manual/Searching.html


Asset Store 

With over 250,000 users worldwide, the Asset Store gives you benefits of scale the world's largest game developers can only dream of. 

While developing, you can easily leverage the work of other Unity users in your productions. When you're done with your game, add an 

extra stream of revenue by putting your work up for sale.  

You access the Asset Store directly from within Unity. Select Window->Asset Store from the menu bar to open the Asset Store window.  

Lightmapping 

Beast by Illuminate Labs is fully integrated in Unity. Set up your lights in Unity and bake them into high-quality Lightmaps to give your game 

that extremely polished look.  

Deferred Rendering (Pro only) 

Render more real-time lights, faster. 'Nuff said.  

Occlusion Culling (Pro only) 

Occlusion Culling will disable rendering of objects that are not visible from the camera's view. In Unity you can precisely define occlusion 

settings and visualize baked occlusion data.  

Debugger (Pro only) 

Inspect all the dynamics of your code at runtime. Step through your code line-by-line and watch the state of properties. Fix script problems 

faster!  

Audio Features 

Design your environments with AudioReverbZone and Rolloff Curves. Apply real-time Audio Effect Filters (Pro only) to any playing sound. 

Precisely control playback with Audio API additions.  

Physics 

Tons of Physics additions have been added, including:  

 Interactive Cloth -- which simulates cloth behavior on any mesh  

 Skinned Cloth -- which brings cloth simulation to rigged characters  

 Continuous Collision Detection -- for handling collisions of fast moving objects  

 Layer-Based Collision Matrix -- define which layers of objects can collide with which others  

 SphereCasts and CapsuleCasts  

Tree Creator 

The Tree Creator allows you to create and edit trees procedurally using a powerful interface. These can be used in terrains or as regular 

GameObjects. Wind Zones give trees added behavioral realism.  

IME Text Input 

IME Input allows non-English characters such as Japanese or Traditional Chinese to be used as input in your games or the Editor.  

Native Font rendering 

Dynamic fonts are optimized for size, and rendered by the OS running the Unity Engine. This enables IME Input for huge character palettes 

like Japanese Kanji without needlessly increasing the size of game assets.  

Mono Update 

Several scripting improvements and additions have been made.  

Networking Update 

RakNet was upgraded to version 3.732, and improvements have been made to the Master Server and NAT Punchthrough.  

http://unity3d.com/support/documentation/Manual/Asset%20Store.html
http://unity3d.com/support/documentation/Manual/Lightmapping.html
http://unity3d.com/support/documentation/Manual/RenderingPaths.html
http://unity3d.com/support/documentation/Manual/Occlusion%20Culling.html
http://unity3d.com/support/documentation/Manual/Debugging.html
http://unity3d.com/support/documentation/Components/class-AudioSource.html
http://unity3d.com/support/documentation/Components/class-AudioReverbZone.html
http://unity3d.com/support/documentation/Components/class-AudioSource.html#rolloff
http://unity3d.com/support/documentation/Components/class-AudioEffect.html
http://unity3d.com/support/documentation/ScriptReference/AudioSource.html
http://unity3d.com/support/documentation/Components/class-InteractiveCloth.html
http://unity3d.com/support/documentation/Components/class-SkinnedCloth.html
http://unity3d.com/support/documentation/Components/class-Rigidbody.html
http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html
http://unity3d.com/support/documentation/ScriptReference/Physics.SphereCast.html
http://unity3d.com/support/documentation/ScriptReference/Physics.CapsuleCast.html
http://unity3d.com/support/documentation/Components/class-Tree.html
http://unity3d.com/support/documentation/Components/class-WindZone.html
http://unity3d.com/support/documentation/Manual/IME%20Input.html
http://unity3d.com/support/documentation/Components/class-Font.html
http://unity3d.com/support/documentation/Manual/MonoUpgradeDetails.html


Security Sandbox 

In Unity 3.0, the webplayer implements a new security model. This will affect you as a content developer if you use the WWW class to 

access data on a domain other than the one hosting your .unity3d file, or if your content uses sockets.  
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Activation 
The Unity application requires activation before it can be used. The version you download contains both Unity and Unity Pro. Upon 

launching Unity, you will be take to our online activation, where you can choose to get Unity, or do a 30 day Unity Pro Trial. No personal 

information is needed.  

If you've bought Unity, you will receive a serial number by email. This code is unique to each customer, and should not be lost or shared 

with others. An serial number is a string of characters and looks like XY-ABCD-1234-EFGH-5678-IJ90. When you activate Unity you need 

to enter this number. The licensing system will take a finger-print of your hardware and system software and send this finger-print to our 

servers. This locks your computer to your serial number. The end-user license agreement typically permits you to install Unity on up to two 

computers. If you attempt to activate Unity on a third computer you will be told that your activation limit has been exceeded. (Note that 

academic and/or discounted versions of Unity may be restricted to a single computer. Please check before purchasing what restrictions will 

apply to you.)  

Note: The finger-printing is affected by many things. For example, if you were to re-install your operating system, or re-format a hard drive, 

or change the network card, these things will cause the unique finger-print of your computer to change.  

When you attempt to re-activate Unity you may find that you are told you are unable to reactivate because your activation limit has been 

exceeded. This is not an error but reflects the fact that our server sees that your computer has changed. To help customers who have 

suffered from catastrophic computer failure we offer a Unity migration service. To take advantage of this service please email 

support@unity3d.com and provide as much information as possible about what has happened to your computer. Please also provide your 

Serial Number. We will then help you with the migration.  

Common Questions 

My computer cannot talk to your activation server. What can I do?  

We have created a webpage to allow customers who have had difficulty activating online or wish to activate on a machine that is not 

connected to the internet, to create the activation file for themselves. The page is:  

https://store.unity3d.com/manual/  

If you are using Unity (the free version) click the Free activation tickbox and upload your ILR file, then click Activate Unity. Otherwise type in 

your serial number in the field provided. Within a second or two an ILF file should be downloaded to your computer.  

When you restart Unity, please go to the Activation window (either it will start up on launch, or choose Help>Enter Serial Number (win) or 

Unity>Enter Serial Number (osx)). Select Manual Activation, click Next, then click "Read License" and choose the license file you 

downloaded above. Click Next, and Unity will read the file, and your activation should be complete!  

Please activate Unity using manual activation. To do this, please contact support who will guide you through the process.  

I need to migrate Unity from one machine to another. What do I need to do? Firstly, uninstall Unity from your "old" machine. Then 

contact support asking for assistance with migration. If you are mid-way through a critical period in your game development, please plan 

carefully for this migration. In addition to moving your project from your old machine to your new one, re-installing applications and so on, 

plan ahead for contacting support. Bear in mind that you can use Unity on two machines, so there should be no time when you are unable 

to continue development. The email will need to include the following:  

http://unity3d.com/support/documentation/Manual/Security%20Sandbox.html
https://store.unity3d.com/manual/


 The Serial number you are using  

 The name of the machine you are migrating from  

 The name of the machine you are migrating to  

 The name of the individual the Serial has been assigned to  

My hard drive has died. What do I need to do? If you cannot uninstall Unity because your hard drive has failed write and tell the support 

team who will try to help. Please remember that we can't back up your project and we can only help you installing Unity on a working 

computer :)  

How many activations can I make? Your serial number is good for 2 (two) activations.  

I have received an activation code when I upgraded to Unity iOS. Why does the old one no longer work? The iOS products are an 

extension to your Unity or Unity Pro license. When you upgrade to Unity iOS the serial number you receive replaces your original activation 

code. The new serial number will work for your existing Unity installation.  

Can I use the same serial number on a PC and a Mac? Yes, the same serial number can be used on a PC or a Mac. As per your end-

user license agreement you can use Unity on two machines that you own and have exclusive use of. These two machines could be two 

Macs, two PCs or one PC and one Mac, whatever works best for you.  

Can I use the same serial number on a laptop and a desktop? Yes, the serial number will work on laptops and desktops.  

Will uninstalling Unity from an old machine automatically allow for activation on my new machine? No, The Unity Support Team will 

have to allow for migration of your license, meaning you can then proceed to activate on your new machine.  

Can I use Unity3 with a 2.x Serial? No, in order to use Unity 3, youd need to upgrade to a 3.x license. You can do this Online, via our 

Website store. https://store.unity3d.com/shop/  

My license wont activate using the online activation procedure! This may be due to one of many things. The easiest way around this, 

is to activate using the Manual Activation procedure. You can find out how by following the link below: 

http://answers.unity3d.com/questions/205/manual-offline-activation-of-unity  

I have replaced an item of Hardware, now my copy of Unity needs to be re-registered. Unity creates a licensing file that takes 

information from a number of places within your machine, making the file unique. When an item of Hardware is replaced, our Licensing 

servers will see this as a request from a new machine. As with the migration procedure, you'll need to email the Support Team 

(support@unity3d.com) in order for them to reactivate your license.  

The Editor freezes when waiting for a response from the Activation Server. In some cases the Online Activation process seems to 

'Hang' and takes a little longer than expected, when waiting for a response from the Activation Server. We advise that you wait it out for 5-

10 minutes before exiting the Editor. Give the Manual activation process (Stated above) a try if the Online activation continues to hang!  

Please read the FAQ before contacting support@unity3d.com, as most Licensing cases are pretty trivial. Please let me know if you feel 

something that hasn't been covered here, ought to be.  
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Game Code How-to 

 How to make a simple first person walkthrough  

https://store.unity3d.com/shop/
http://answers.unity3d.com/questions/205/manual-offline-activation-of-unity
http://unity3d.com/support/documentation/Manual/HOWTO-First%20Person%20Walkthrough.html
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HOWTO-First Person Walkthrough 
Here's how you can make a simple first person walk-through with your own artwork:  

1. Import your level. See here on how to import geometry from your art package into Unity.  

2. Select the imported model file and enable Generate Colliders in the Import Settings in the Inspector.  

3. Locate the Standard Assets->Prefabs->First Person Controller in the Project View and drag it into the Scene View.  

4. Make sure that the scale of your level is correct. The First Person Controller is exactly 2 meters high, so if your level doesn't fit the 

size of the controller, you should adjust the scale of the level size within your modeling application. Getting scale right is critical for 

physical simulation, and other reasons documented at the bottom of this page. Using the wrong scale can make objects feel like 

they are floating or too heavy. If you can't change the scale in your modeling app, you can change the scale in the Import 

Settings... of the model file.  

5. Move the First Person Controller to be at the start location using the Transform handles. It is critical that the first person controller 

does not intersect any level geometry, when starting the game (otherwise it will be stuck!).  

6. Remove the default camera "Main Camera" in the hierarchy view. The First person controller already has its own camera.  

7. Hit Play to walk around in your own level.  
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Graphics how-tos 
The following is a list of common graphics-related questions in Unity and how to accomplish them.  

There is an excellent tutorial for creating textures, including color, bump, specular, and reflection mapping here.  

 How do I Import Alpha Textures?  

 How do I Use Normal Maps?  

 How do I use Detail Textures?  

 How do I Make a Cubemap Texture?  

 How do I Make a Skybox?  

 How do I make a Mesh Particle Emitter?  

 How do I make a Splash Screen?  

 How do I make a Spot Light Cookie?  

 How do I fix the rotation of an imported model?  

 How do I use Water?  
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HOWTO-alphamaps 
Unity uses straight alpha blending. Hence, you need to expand the color layers... The alpha channel in Unity will be read from the first 

alpha channel in the Photoshop file.  

Setting Up 

Before doing this, install these alpha utility photoshop actions: AlphaUtility.atn.zip  

After installing, your Action Palette should contain a folder called AlphaUtility:  

http://unity3d.com/support/documentation/Manual/HOWTO-importObject.html
http://unity3d.com/support/documentation/Components/class-Rigidbody.html
http://forums.cgsociety.org/showthread.php?t=373024
http://unity3d.com/support/documentation/Manual/HOWTO-alphamaps.html
http://unity3d.com/support/documentation/Manual/HOWTO-Normalmap.html
http://unity3d.com/support/documentation/Manual/HOWTO-UseDetailTexture.html
http://unity3d.com/support/documentation/Manual/HOWTO-MakeCubemap.html
http://unity3d.com/support/documentation/Manual/HOWTO-UseSkybox.html
http://unity3d.com/support/documentation/Manual/HOWTO-MeshParticleEmitter.html
http://unity3d.com/support/documentation/Manual/HOWTO-SplashScreen.html
http://unity3d.com/support/documentation/Manual/HOWTO-LightCookie.html
http://unity3d.com/support/documentation/Manual/HOWTO-FixZAxisIsUp.html
http://unity3d.com/support/documentation/Manual/HOWTO-Water.html
http://unity3d.com/support/documentation/Images/manual/AlphaUtility.atn.zip


 

Getting Alpha Right 

Let's assume you have your alpha texture on a transparent layer inside photoshop. Something like this:  

 

1. Duplicate the layer  

2. Select the lowest layer. This will be source for the dilation of the background.  

3. Select Layer->Matting->Defringe and apply with the default properties  



4. Run the "Dilate Many" action a couple of times. This will expand the background into a new layer. 

 

5. Select all the dilation layers and merge them with Command-E 

 

6. Create a solid color layer at the bottom of your image stack. This should match the general color of your document (in this case, 

greenish).  

Now we need to copy the transparency into the alpha layer.  

1. Set the selection to be the contents of your main layer by Command-clicking on it in the Layer Palette.  

2. Switch to the channels palette.  



3. Create a new channel from the transparency. 

 

Save your PSD file - you are now ready to go.  
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HOWTO-Normalmap 
Normal maps are grayscale images that you use as a height map on your objects in order to give an appearance of raised or recessed 

surfaces. Assuming you have a model that looks like this:  



 

The 3D Model 

 

The Texture 

We want to make the light parts of the object appear raised.  



1. Draw a grayscale height map of your texture in Photoshop. White is high, black is low. Something like this:  

 

2. Save the image next to your main texture.  

3. In Unity, select the image and select the 24 bit RGB format and enable Generate Normal Map in the Import Settings in the 

Inspector:  

 



 

 



1. In the Material Inspector of your model, select 'Bumped Diffuse' from the Shader drop-down:  

 

2. Drag your texture from the Project window to the 'Normalmap' texture slot:  

 

Your object now has a normal map applied:  



 

Hints 

 To make the bumps more noticable, either use the Bumpyness slider in the Texture Import Settings or blur the texture in Photoshop. 

Experiment with both approaches to get a feel for it.  
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HOWTO-UseDetailTexture 
A Detail texture is a small, fine pattern which is faded in as you approach a surface, for example wood grain, imperfections in stone, or 

earthly details on a terrain. They are explicitly used with the Diffuse Detail shader.  

Detail textures must tile in all directions. Color values from 0-127 makes the object it's applied to darker, 128 doesn't change anything, and 

lighter colors make the object lighter. It's very important that the image is centered around 128 - otherwise the object it's applied to will get 

lighter or darker as you approach.  

http://unity3d.com/support/documentation/Components/shader-NormalDiffuseDetail.html


1. Draw or find a grayscale image of the detail texture. 

 

The Detail Texture 

 

 

The Levels  

2. Save the image next to your main texture.  

3. In Unity, select the image and under "Generate Mip Maps", enable Fades Out and set the sliders to something like this in the 

Import Settings in the Inspector.  

4. The top slider determines how small the texture should before before beginning to fade out, and the bottom determines how far 

away it is before the detail texture completely disapear. 

 



 

s.  



5. In the Material Inspector on the right, select Diffuse Detail from the Shader drop-down: 

 

6. Drag your texture from the Project View to the Detail texture slot.  



7. Set the Tiling values to a high value 
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HOWTO-MakeCubemap 
Cubemaps are used by the Reflective built-in shaders. To build one, you either create six 2D textures and create a new Cubemap asset, or 

build the Cubemap from a single square texture. More details are in the Cubemap Texture documentation page.  

Static and dynamic cubemap reflections can also be rendered from scripts. Code example in Camera.RenderToCubemap page contains a 

simple wizard script for rendering cubemaps straight from the editor.  

http://unity3d.com/support/documentation/Components/shader-ReflectiveFamily.html
http://unity3d.com/support/documentation/Components/class-Cubemap.html
http://unity3d.com/support/documentation/ScriptReference/Camera.RenderToCubemap.html
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HOWTO-UseSkybox 
A Skybox is a 6-sided cube that is drawn behind all graphics in the game. Here are the steps to create one:  

1. Make 6 textures that correspond to each of the 6 sides of the skybox and put them into your project's Assets folder.  

2. For each texture you need to change the wrap mode from Repeat to Clamp. If you don't do this colors on the edges will not match 

up:  

 

3. Create a new Material by choosing Assets->Create->Material from the menu bar.  

4. Select the shader drop-down in the top of the Inspector, choose RenderFX->Skybox.  



5. Assign the 6 textures to each texture slot in the material. You can do this by dragging each texture from the Project View onto the 

corresponding slots.  

 

To Assign the skybox to the scene you're working on:  

1. Choose Edit->Render Settings from the menu bar.  



2. Drag the new Skybox Material to the Skybox Material slot in the Inspector.  

 

Note that Standard Assets package contains several ready-to-use skyboxes - this is the quickest way to get started!  
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HOWTO-MeshParticleEmitter 
Mesh Particle Emitters are generally used when you need high control over where to emit particles.  

For example, when you want to create a flaming sword:  

1. Drag a mesh into the scene.  

2. Remove the Mesh Renderer by right-clicking on the Mesh Renderer's Inspector title bar and choose Remove Component.  

3. Choose Mesh Particle Emitter from the Component->Particles menu.  

4. Choose Particle Animator from the Component->Particles menu.  

5. Choose Particle Renderer from the Component->Particles menu.  

You should now see particles emitting from the mesh.  

Play around with the values in the Mesh Particle Emitter.  

Especially enable Interpolate Triangles in the Mesh Particle Emitter Inspector and set Min Normal Velocity and Max Normal Velocity to 

1.  

To customize the look of the particles that are emitted:  

1. Choose Assets->Create->Material from the menu bar.  

2. In the Material Inspector, select Particles->Additive from the shader drop-down.  

3. Drag & drop a texture from the Project view onto the texture slot in the Material Inspector.  

4. Drag the Material from the Project View onto the Particle System in the Scene View.  

You should now see textured particles emitting from the mesh.  

See Also 

 Mesh Particle Emitter Component Reference page  
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HOWTO-SplashScreen 
 

Desktop  
 

Here's how to do a splash screen or any other type of full-screen image in Unity. This method works for multiple resolutions and aspect 

ratios.  

1. First you need a big texture. Ideally textures should be power of two in size. You might for example use 1024x512 as this fits most 

screens.  

2. Make a box using the GameObject->Create Other->Cube menubar item.  

3. Scale it to be in 16:9 format by entering 16 and 9 as the first two value in the Scale: 

 

4. Drag the texture onto the cube and make the Camera point at it. Place the camera at such a distance so that the cube is still 

visible on a 16:9 aspect ratio. Use the Aspect Ratio Selector in the Scene View menu bar to see the end result.  

 

iOS 
 

Customising IOS device Splash Screens  

 

Android 
 

Customising Android device Splash Screens  
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HOWTO-LightCookie 
Unity ships with a few Light Cookies in the Standard Assets. When the Standard Assets are imported to your project, they can be found in 

Standard Assets->Light Cookies. This page shows you how to create your own.  

javascript:ShowHideDiv('desktopRef','specific-desktop','Desktop');
javascript:ShowHideDiv('desktopRef','specific-desktop','Desktop');
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
http://unity3d.com/support/documentation/Manual/Android%20Splash%20Screen.html
javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
http://unity3d.com/support/documentation/Manual/Android%20Splash%20Screen.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
javascript:ShowHideDiv('desktopRef','specific-desktop','Desktop');
javascript:ShowHideDiv('iosRef','specific-ios', 'iOS');
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A great way to add a lot of visual detail to your scenes is to use cookies - grayscale textures you use to control the precise look of in-game 

lighting. This is fantastic for making moving clouds and giving an impression of dense foilage. The Light Component Reference page has 

more info on all this, but the main thing is that for textures to be usable for cookies, the following properties need to be set:  

To create a light cookie for a spot light:  

1. Paint a cookie texture in Photoshop. The image should be greyscale. White pixels means full lighting intensity, black pixels mean 

no lighting. The borders of the texture need to be completely black, otherwise the light will appear to leak outside of the spotlight.  

2. In the Texture Inspector change the Repeat Wrap mode to Clamp  

3. Select the Texture and edit the following Import Settings in the Inspector.  

4. Enable Border Mipmaps  

5. Enable Build Alpha From Grayscale (this way you can make a grayscale cookie and Unity converts it to an alpha map 

automatically)  

6. Set the Texture Format to Alpha 8 Bit  
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HOWTO-FixZAxisIsUp 
Some 3D art packages export their models so that the z-axis faces upward. Most of the standard scripts in Unity assume that the y-axis 

represents up in your 3D world. It is usually easier to fix the rotation in Unity than to modify the scripts to make things fit.  

http://unity3d.com/support/documentation/Components/class-Light.html


 

Your model with z-axis points upwards  

If at all possible it is recommended that you fix the model in your 3D modelling application to have the y-axis face upwards before exporting.  

If this is not possible, you can fix it in Unity by adding an extra parent transform:  

1. Create an empty GameObject using the GameObject->Create Empty menu  

2. Position the new GameObject so that it is at the center of your mesh or whichever point you want your object to rotate around.  

3. Drag the mesh onto the empty GameObject  

You have now made your mesh a Child of an empty GameObject with the correct orientation. Whenever writing scripts that make use of 

the y-axis as up, attach them to the Parent empty GameObject.  

 



The model with an extra empty transform  
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HOWTO-Water 
Note: The content on this page applies to the desktop editor mode only.  

Unity includes several water prefabs (including needed shaders, scripts and art assets) within the Standard Assets and Pro Standard 

Assets packages. Unity includes a basic water, while Unity Pro includes water with real-time reflections and refractions, and in both cases 

those are provided as separate daylight and nighttime water prefabs.  

 

Reflective daylight water (Unity Pro)  

http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Reflective/Refractive daylight water (Unity Pro)  

Water setup 

In most cases you just need to place one of the existing Prefabs into your scene (make sure to have the Standard Assets installed):  

 Unity has Daylight Simple Water and Nighttime Simple Water in Standard Assets->Water.  

 Unity Pro has Daylight Water and Nighttime Water in Pro Standard Assets->Water (but it needs some assets from Standard Assets-

>Water as well). Water mode (Simple, Reflective, Refractive) can be set in the Inspector.  

The prefab uses an oval-shaped mesh for the water. If you need to use a different Mesh the easiest way is to simply change it in the Mesh 

Filter of the water object:  

http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/class-Mesh.html


 

Creating water from scratch (Advanced) 

The simple water in Unity requires attaching a script to a plane-like mesh and using the water shader:  

1. Have mesh for the water. This should be a flat mesh, oriented horizontally. UV coordinates are not required. The water 

GameObject should use the Water layer, which you can set in the Inspector.  

2. Attach WaterSimple script (from Standard Assets/Water/Sources) to the object.  

3. Use FX/Water (simple) shader in the material, or tweak one of provided water materials (Daylight Simple Water or Nighttime 

Simple Water).  

The reflective/refractive water in Unity Pro requires similar steps to set up from scratch:  

1. Have mesh for the water. This should be a flat mesh, oriented horizontally. UV coordinates are not required. The water 

GameObject should use the Water layer, which you can set in the Inspector.  

2. Attach Water script (from Pro Standard Assets/Water/Sources) to the object.  

o Water rendering mode can be set in the Inspector: Simple, Reflective or Refractive.  

3. Use FX/Water shader in the material, or tweak one of provided water materials (Daylight Water or Nighttime Water).  

Properties in water materials 

These properties are used in Reflective & Refractive water shader. Most of them are used in simple water shader as well.  

  

Wave scale Scaling of waves normal map. The smaller the value, the larger water waves. 

Reflection/refraction 

distort 

How much reflection/refraction is distorted by the waves normal map. 

Refraction color Additional tint for refraction. 

Environment 

reflection/refraction 

Render textures for real-time reflection and refraction. 

Normalmap Defines the shape of the waves. The final waves are produced by combining two these normal maps, each 

scrolling at different direction, scale and speed. The second normal map is half as large as the first one. 

Wave speed Scrolling speed for first normal map (1st and 2nd numbers) and the second normal map (3rd and 4th numbers). 

Fresnel A texture with alpha channel controlling the Fresnel efffect - how much reflection vs. refraction is visible, based 

on viewing angle. 



The rest of properties are not used by Reflective & Refractive shader by itself, but need to be set up in case user's video card does not 

suppor it and must fallback to the simpler shader:  

  

Reflective color/cube and 

fresnel 

A texture that defines water color (RGB) and Fresnel effect (A) based on viewing angle. 

Horizon color The color of the water at horizon. (Used only in the simple water shader) 

Fallback texture Texture used to represent the water on really old video cards, if none of better looking shaders can't run on it. 

Hardware support 

 Reflective + Refractive water works on graphics cards with pixel shader 2.0 support (GeForce FX and up, Radeon 9500 and up, Intel 9xx). 

On older cards, Reflective water is used.  

 Reflective water works on graphics cards with pixel shader 1.4 support (GeForce FX and up, Radeon 8500 and up, Intel 9xx). On older 

cards, Simple water is used.  

 Simple water works about everywhere, with various levels of detail depending on hardware capabilities.  
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HOWTO-exportFBX 
Unity supports FBX files which can be generated from many popular 3D applications. Use this guideline to help ensure the most reliable 

results.  

Select > Prepare > Check Settings > Use 2011.3 > Verify > Import 

What do you want to export? - be aware of export scope e.g. meshes, cameras, lights, animation rigs, etc. 

Applications often let you export selected objects or a whole scene  

Make sure you are exporting only the objects you want to use from your scene by either exporting selected, or removing unwanted data from your scene.  

Good working practice often means keeping a working file with all lights, guides, control rigs etc. but only export the data you need with export selected an export 

preset or even a custom scene exporter.  

What do you need to include? - prepare your assets 

 Meshes - Remove construction history, convert to polygons and triangulate or quadrangulate if necessary  

 Animation - select the correct rig, check frame rate, animation length etc.  

 Textures - make sure your textures live in your unity project or within a folder \textures  

 Smoothing - check if you want smoothing groups and/or smooth mesh  

How do I include those elements? - check the FBX export settings 

Be aware of your settings in the export dialogue so that you know what to expect and can match up the fbx settings In Unity  

Which version of FBX are you using? if in doubt use 2011.3 

Autodesk update their FBX installer regularly and it can provide different results with different versions of their own software and other 3rd party 3D apps.  

See Advanced Options > FBX file format  

Will it work? - Verify your export 

 Check your file size - do a sanity check on the file size (e.g. >10kb?)  

 Re-import your FBX into a new scene in the 3D package you use to generate it - is it what you expected?  

Import! 

 Import into Unity  

 Check FBX import settings in inspector : texures, animations, smoothing, etc.  

http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=15765120


See below for Maya FBX dialogue example:  

\\ 
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HOWTO-importObject 
Unity supports importing from most popular 3D applications. Choose the one you're working with below:  

 Maya  

 Cinema 4D  

 3ds Max  

 Cheetah3D  

 Modo  

 Lightwave  

 Blender  

Other applications 

Unity can read .FBX, .dae, .3DS, .dxf and .obj files, so if your program can export to this format you're home free. FBX exporters for 

popular 3D packages can be found here. Many packages also have a Collada exporter available.  

Hints 

 Store textures in a folder called Textures next to the exported mesh. This will guarantee that Unity will always be able to find the Texture 

and automatically connect the Texture to the Material. For more information, see the Textures reference.  

See Also 

 Modeling Optimized Characters  

 How do I use normal maps?  

 Mesh Import Settings  

 How do I fix the rotation of an imported model?  
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HOWTO-ImportObjectMaya 
Unity natively imports Maya files. To get started, simply place your .mb or .ma file in your project's Assets folder. When you switch back 

into Unity, the scene is imported automatically and will show up in the Project view.  

To see your model in Unity, simply drag it from the Project View into the Scene View or Hierarchy View.  

Unity currently imports from Maya: 

1. All nodes with position, rotation and scale. Pivot points and Names are also imported.  

2. Meshes with vertex colors, normals and up to 2 UV sets.  

3. Materials with Texture and diffuse color. Multiple materials per mesh.  

4. Animations FK & IK  

5. Bone-based animations  

Unity does not import blend shapes. Use Bone-based animations instead. Unity automatically triangulates polygonal meshes when 

importing, thus there is no need to do this manually in Maya.  

If you are using IK to animate characters you have to select the imported .mb file in Project View and choose Bake IK & Simulation in the 

Import Settings dialog in the Inspector.  

http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectMaya.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectCinema4D.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectMax.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectCheetah3D.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectModo.html
http://unity3d.com/support/documentation/Manual/HOWTO-importObjectLightwave.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectBlender.html
http://autodesk.com/fbx
http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/Manual/Modeling%20Optimized%20Characters.html
http://unity3d.com/support/documentation/Manual/HOWTO-Normalmap.html
http://unity3d.com/support/documentation/Components/class-Mesh.html
http://unity3d.com/support/documentation/Manual/HOWTO-FixZAxisIsUp.html


Requirements 

In order to import Maya .mb and .ma files, you need to have Maya installed on the machine you are using Unity to import the .mb/.ma file. 

Maya 8.0 and up is supported.  

If you don't have Maya installed on your machine but want to import a Maya file from another machine, you can export to fbx format, which Unity imports natively. 

Please Install ->2011.3 for best results. To export see HOWTO_exportFBX.  

Once exported Place the fbx file in the Unity project folder. Unity will now automatically import the fbx file. Check the FBX import setting in the inspector as mentioned 

in HOWTO_exportFBX  

Behind the import process (Advanced) 

When Unity imports a Maya file it will launch Maya in the background. Unity then communicates with Maya to convert the .mb file into a 

format Unity can read. The first time you import a Maya file in Unity, Maya has to launch in a command line process, this can take around 

20 seconds, but subsequent imports will be very quick.  

Troubleshooting 

 Keep your scene simple, try and work with a file which only contains the objects you need in Unity  

 If your meshes cause problems, make sure you have converted any patches, nurbs surface etc into Polygons (Modify > Convert + also 

Mesh > Quadragulate/Triangulate) Unity only support Polygons.  

 Maya in some rare cases messes up the node history, which sometimes results in models not exporting correctly. Fortunately you can very 

easily fix this by selecting Edit->Delete All by Type->History.  

 Unity likes to keep up with the latest FBX where possible so if you have any issues with importing some models, check Autodesk latest 

version, or for fail-safe install 2011.3  

 Animation baking in Maya is now done with FBX instead of natively, which allows for more complex animations to be baked properly to FBX 

format. If you are using driven keys, then make sure to set at least one key on your drivers for the animation to bake properly  
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HOWTO-ImportObjectCinema4D 
Unity natively imports Cinema 4D files. To get started, simply place your .c4d file in your project's Assets folder. When you switch back into 

Unity, the scene is imported automatically and will show up in the Project View.  

To see your model in Unity, simply drag it from the Project View into the Scene View.  

If you modify your .c4d file, Unity will automatically update whenever you save.  

Unity currently imports 

1. All objects with position, rotation and scale. Pivot points and Names are also imported.  

2. Meshes with UVs and normals.  

3. Materials with Texture and diffuse color. Multiple materials per mesh.  

4. Animations FK (IK needs to be manually baked).  

5. Bone-based animations.  

Unity does not import Point Level Animations (PLA) at the moment. Use Bone-based animations instead.  

Animated Characters using IK 

If you are using IK to animate your characters in Cinema 4D, you have to bake the IK before exporting using the Plugins->Mocca-

>Cappucino menu. If you don't bake your IK prior to importing into Unity, you will most likely only get animated locators but no animated 

bones.  

http://unity3d.com/support/documentation/Manual/HOWTO-exportFBX.html
http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=15765120
http://unity3d.com/support/documentation/Manual/HOWTO-exportFBX.html
http://unity3d.com/support/documentation/Manual/HOWTO-exportFBX.html
http://usa.autodesk.com/adsk/servlet/pc/item?siteID=123112&id=15765120


Requirements 

 You need to have at least Cinema 4D version 8.5 installed to import .c4d files.  

If you don't have Cinema 4D installed on your machine but want to import a Cinema 4D file from another machine, you can export to the 

FBX format, which Unity imports natively:  

1. Open the Cinema 4D file  

2. In Cinema 4D choose File->Export->FBX 6.0  

3. Place the exported fbx file in the Unity project's Assets folder. Unity will now automatically import the fbx file.  

Hints 

1. To maximize import speed when importing Cinema 4D files: go to the Cinema 4D preferences (Edit->Preferences) and select the 

FBX 6.0 preferences. Now uncheck Embed Textures.  

Behind the import process (Advanced) 

When Unity imports a Cinema 4D file it will automatically install a Cinema 4D plugin and launch Cinema 4D in the background. Unity then 

communicates with Cinema 4D to convert the .c4d file into a format Unity can read. The first time you import a .c4d file and Cinema 4D is 

not open yet it will take a short while to launch it but afterwards importing .c4d files will be very quick.  

Cinema 4D 10 support 

When importing .c4d files directly, Unity behind the scenes lets Cinema 4D convert its files to FBX. When Maxon shipped Cinema 4D 10.0, 

the FBX exporter was severly broken. With Cinema 4D 10.1 a lot of the issues have been fixed. Thus we strongly recommend everyone 

using Cinema 4D 10 to upgrade to 10.1.  

Now there are still some issues left in Maxons FBX exporter. It seems that currently there is no reliable way of exporting animated 

characters that use the Joint's introduced in Cinema 4D 10. However the old bone system available in 9.6 exports perfectly fine. Thus when 

creating animated characters it is critical that you use the old bone system instead of joints.  
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HOWTO-ImportObjectMax 
If you make your 3D objects in 3dsMax, you can save your .max files directly into your Project or export them into Unity using the 

Autodesk .FBX format. Saving them in the original .max format is recommended.  

Unity currently imports from 3ds Max 

1. All nodes with position, rotation and scale. Pivot points and Names are also imported.  

2. Meshes with vertex colors, normals and one or two UV sets.  

3. Materials with diffuse texture and color. Multiple materials per mesh.  

4. Animations.  

5. Bone based animations.  

To manually export to FBX from 3DS Max 

1. Download the latest fbx exporter from Autodesk website and install it.  

2. Export your scene (File->Export or File->Export Selected) in .fbx format. Using default export options should be okay.  

3. Move the exported fbx file into your Unity project folder.  

4. When you switch back into Unity, the .fbx file is imported automatically.  

5. Drag the file from the Project View into the Scene View.  

http://unity3d.com/support/documentation/printable.html#twouvs
http://unity3d.com/support/documentation/printable.html#bones
http://autodesk.com/fbx


Exporter options 

Using default FBX exporter options (that basically export everything) should be okay in all cases.  

 

Default FBX exporter options (for fbx plugin version 2009.3)  

Exporting Bone-based Animations 

There is a procedure you should follow when you want to export bone-based animations:  



1. Set up the bone structure as you please.  

2. Create the animations you want, using FK and/or IK  

3. Select all bones and/or IK solvers  

4. Go to Motion->Trajectories and press Collapse. Unity makes a key filter, so the amount of keys you export is irrelevant  

5. "Export" or "Export selected" as newest FBX format  

6. Drop the FBX file into Assets as usual  

7. In Unity you must reassign the Texture to the Material in the root bone  

When exporting a bone hierarchy with mesh and animations from 3ds Max to Unity, the GameObject hierarchy produced will correspond to 

the hierarchy you can see in "Schematic view" in 3ds Max. One difference is Unity will place a GameObject as the new root, containing the 

animations, and will place the mesh and material information in the root bone.  

If you prefer to have animation and mesh information in the same Unity GameObject, go to the Hierarchy view in 3ds Max, and parent the 

mesh node to a bone in the bone hierarchy.  

Exporting Two UV Sets for Lightmapping 

3ds Max' Render To Texture and automatic unwrapping functionality can be used to create lightmaps. Note that Unity has built-in 

lightmapper, but you might prefer using 3dsmax if that fits your workflow better. Usually one UV set is used for main texture and/or normal 

maps, and another UV set is used for the lightmap texture. For both UV sets to come through properly, the material in 3ds Max has to be 

Standard and both Diffuse (for main texture) and Self-Illumination (for lightmap) map slots have to be set up:  

http://unity3d.com/support/documentation/Manual/Lightmapping.html


 

Material setup for Lightmapping in 3ds Max, using self-illumination map  

Note that if object uses a Shell material type, then current Autodesk's FBX exporter will not export UVs correctly.  

Alternatively, you can use Multi/Sub Object material type and setup two sub-materials, using the main texture and the lightmap in their 

diffuse map slots, like shown below. However, if faces in your model use different sub-material IDs, this will result in multiple materials 

being imported, which is not optimal for performance.  



 

Alternate Material setup for Lightmapping in 3ds Max, using multi/sub object material  

Troubleshooting 

If you have any issues with importing some models: ensure that you have the latest FBX plugin installed. It can be downloaded Autodesk 

website.  
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HOWTO-ImportObjectCheetah3D 
Unity natively imports Cheetah3D files. To get started, simply place your .jas file in your project's Assets folder. When you switch back into 

Unity, the scene is imported automatically and will show up in the Project View.  

To see your model in Unity, simply drag it from the Project View into the Scene View.  

If you modify your .jas file, Unity will automatically update whenever you save.  

Unity currently imports from Cheetah3D 

1. All nodes with position, rotation and scale. Pivot points and Names are also imported.  

2. Meshes with vertices, polygons, triangles, UV's and Normals.  

3. Animations.  

4. Materials with diffuse color and textures.  

Requirements 

 You need to have at least Cheetah3D 2.6 installed.  
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HOWTO-ImportObjectModo 
Unity natively imports modo files. This works under the hood by using the modo COLLADA exporter. Modo version 501 and later use this 

approach. To get started, save your .lxo file in the project's Assets folder. When you switch back into Unity, the file is imported automatically 

and will show up in the Project View.  

http://autodesk.com/fbx
http://autodesk.com/fbx


For older modo versions prior to 501, simply save your Modo scene as an FBX or COLLADA file into the Unity project folder. When you 

switch back into Unity, the scene is imported automatically and will show up in the Project View.  

To see your model in Unity, drag it from the Project View into the Scene View.  

If you modify the lxo file, Unity will automatically update whenever you save.  

Unity currently imports 

1. All nodes with position, rotation and scale. Pivot points and names are also imported.  

2. Meshes with vertices, normals and UVs.  

3. Materials with Texture and diffuse color. Multiple materials per mesh.  

4. Animations  

Requirements 

 modo 501 or later is required for native import of *.lxo files.  
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HOWTO-importObjectLightwave 
You can import meshes and animations from Lightwave using the FBX plugin for Lightwave.  

Unity currently imports 

1. All nodes with position, rotation and scale. Pivot points and Names are also imported.  

2. Meshes with UVs and normals.  

3. Materials with Texture and diffuse color. Multiple materials per mesh.  

4. Animations.  

5. Bone-based animations.  

Installation 

Download the latest Lightwave FBX exporter from:  

 OS X lighwave 8.2 and 9.0 plugin  

 OS X Lighwave 8.0 plugin  

 Windows Lighwave 8.2 and 9.0 plugin  

 Windows Lighwave 8.0 plugin  

By downloading these plugins you automatically agree to this licence.  

There are two versions of the plugin, one for LightWave 8.0 and one for LightWave 8.2 through 9.0. Make sure you install the correct 

version.  

The plugin for Mac comes in an OS X package. If you double-click the package to install it, the installer will try to put it in the correct folder. 

If it can't find your LightWave plugin folder, it will create its own LightWave folder in your Applications folder and dump it there. If the latter 

occurs you should move it to your LightWave plugin folder (or any sub-folder). Once there you have to add the plugin to LightWave via the 

"Edit Plugins" panel (Option-F11) - see the LightWave manual for more details on how to add plugins.  

http://unity3d.com/lightwave_plugins/mbr_FBX200508_LW82_MACOS.pkg.sit
http://unity3d.com/lightwave_plugins/mbr_FBX200508_LW80_MACOS.pkg.sit
http://unity3d.com/lightwave_plugins/mbr_FBX200508_LW82_WIN.zip
http://unity3d.com/lightwave_plugins/mbr_FBX200508_LW80_WIN.zip
http://unity3d.com/lightwave_plugins/License.txt


 

Once added to LightWave, the plugin is acessible via the Generics menu (on the Utiliies) tab. If the Generic menu is not present you will 

have to add it using the Config Menus panel. In the latter panel it can be found in the Plug-ins category and is called "Generic Plugins". Add 

it to any convenient menu (see the LightWave manual for more details on how to do this).  

More information about installation can also be found in the release notes that can downloaded with the installer.  

Exporting 

All objects and animations have to be exported from Layout (there is no Modeler FBX exporter).  

1. Select Export to FBX from the Generics menu 



 

2. Select the appropriate settings in the fbx export dialog 

 Select the fbx file name. Make sure to save the exported fbx file in the Assets folder of your current Unity project.  

 In the FBX dialogue panel you MUST select Embed Textures otherwise the exported object will have no UVs. This is a bug in the 

Lightwave fbx exporter and will be fixed in a future version according to Autodesk.  

 If you want to export animations into Unity you must have "Animations" checked. You also need to have "Lights" or "Cameras" checked.  

 To change the name of the exported animation clip in Unity, change the name from "LW Take 001" to your liking.  



 

3. Switch to Unity. 

 Unity will automatically import the fbx file and generate materials for the textures.  

 Drag the imported fbx file from the Project view into the Scene view.  

Important notes 

 You must select Embed Textures in the FBX panel when exporting or no UVs are exported  

 If you want to export animations you must enable Animations and either Camera or Lights.  

 It is strongly recommended to always place your textures in a folder called "Textures" next to the fbx file. This will guarantee that Unity can 

always find the Texture and automatically connect the texture to the material.  
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HOWTO-ImportObjectBlender 
Unity natively imports Blender files. This works under the hood by using the Blender FBX exporter, which was added to Blender in version 

2.45. For this reason, you must update to Blender 2.45 or later (but see Requirements below).  

To get started, save your .blend file in your project's Assets folder. When you switch back into Unity, the file is imported automatically and 

will show up in the Project View.  

To see your model in Unity, drag it from the Project View into the Scene View.  

If you modify your .blend file, Unity will automatically update whenever you save.  

Unity currently imports 

1. All nodes with position, rotation and scale. Pivot points and Names are also imported.  

2. Meshes with vertices, polygons, triangles, UVs, and normals.  

3. Bones  

4. Skinned Meshes  

5. Animations  



Requirements 

 You need to have Blender version 2.45-2.49 or 2.56 or later (versions 2.50-2.55 do not work, because FBX export was changed/broken in 

Blender).  

 Textures and diffuse color are not assigned automatically. Manually assign them by dragging the texture onto the mesh in the Scene View 

in Unity.  
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Workflow 

 Getting started with Mono Develop  

 How do I reuse assets between projects?  

 How do I install or upgrade Standard Assets?  
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HOWTO-MonoDevelop 
Mono Develop comes now with Unity 3.x, this IDE will help you out taking care of the scripting part of your game and the debugging o it.  

Setting Up Mono Develop. 
To set up Mono Develop to work with with Unity you just have to go to Unity Preferences and set it as your default editor.  

 

Setting Mono Develop as the Default Editor 

After this, create or open an existing project and make sure your project is synced with Mono Develop by clicking on Assets -> Sync Mono 

Develop Project.  

http://unity3d.com/support/documentation/Manual/HOWTO-MonoDevelop.html
http://unity3d.com/support/documentation/Manual/HOWTO-exportpackage.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Mono Develop Sync.  

This will open your project (Only The scripting files, no Assets) in Mono Develop. Now you are ready to start debugging.  

Also you might want to visit the troubleshooting page in case you have any problem setting your project.  
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HOWTO-exportpackage 
As you build your game, Unity stores a lot of metadata about your assets (import settings, links to other assets, etc.). If you want to take 

your assets into a different project, there is a specific way to do that. Here's how to easily move assets between projects and still preserve 

all this info.  

1. In the Project View, select all the asset files you want to export.  

2. Choose Assets->Export Package... from the menubar.  

3. Name and save the package anywhere you like.  

4. Open the project you want to bring the assets into.  

5. Choose Assets->Import Package... from the menubar.  

6. Select your package file saved in step 3.  

Hints 

 When exporting a package Unity can export all dependencies as well. So for example if you select a Scene and export a package with all 

dependencies, then all models, textures and other assets that appear in the scene will be exported as well. This can be a quick way of 

exporting a bunch of assets without manually locating them all.  

 If you store your Exported Package in the Standard Packages folder next to your Unity application, they will appear in the Create New 

Project dialog.  
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HOWTO-InstallStandardAssets 
Unity ships with multiple Standard Assets packages. These are collections of assets that are widely used by most Unity customers. When 

you create a new project from the Project Wizard you can optionally include these asset collections. These assets are copied from the Unity 

install folder into your new project. This means that if you upgrade Unity to a new version you will not get the new version of these assets 

and so upgrading them is needed. Also, consider that a newer version of e.g. an effect might behave differently for performance or quality 

reasons and thus requires retweaking of parameters. It's important to consider this before upgrading if you don't want your game to 

suddenly look or behave differently. Check with the package contents and Unity's release notes.  

Standard Assets contain useful things like a first person controller, skyboxes, lens flares, Water prefabs, Image Effects and so on.  

 

The Standard Assets packages listed when creating new project 

Upgrading 

Sometimes you might want to upgrade your Standard Assets, for example because a new version of Unity ships with new Standard Assets:  

1. Open your project.  

2. Choose package you want to update from Assets->Import Package submenu.  

3. A list of new or replaced assets will be presented, click Import.  

For the cleanest possible upgrade, it should be considered to remove the old package contents first, as some scripts, effects or prefabs 

might have become deprecated or unneeded and Unity packages don't have a way of deleting (unneeded) files (but make sure to have a 

security copy of the old version available).  
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Advanced 

 AssetBundles (Pro only)  

 AssetDatabase  

 Rendering Paths  

 Profiler (Pro only)  

 Lightmapping Quickstart  

o Lightmapping In-Depth  

o Custom Beast Settings  

o Lightmapping UVs  

 Occlusion Culling  

 Loading Resources at Runtime  

 Modifying Source Assets Through Scripting  

 Generating Mesh Geometry Procedurally  

o Anatomy of a Mesh  

o Using the Mesh Class  

o Example: Creating a Billboard Plane  

 Execution Order  

 Optimizing Graphics Performance  

o Modeling Optimized Characters  

o Rendering Statistics Window  

 Reducing File Size  

 Platform Dependent Compilation  

 Debugging  

o Console  

o Debugger  

o Log Files  

 Accessing hidden folders  

 Plugins - Pro/Mobile-Only Feature  

 Command line arguments  

 Shaders  

o Shaders: ShaderLab & Fixed Function shaders  

o Shaders: Vertex and Fragment Programs  

 Graphics Emulation  

 Network Emulation  

 Security Sandbox of the Webplayer  

 Overview of available .NET Class Libraries  

 Visual Studio C# Integration  

 Using External Version Control Systems with Unity  

 Analytics  

 Check For Updates  

 Trouble Shooting  

 IME in Unity  

 Shadows in Unity  

o Directional Shadow Details  

o Troubleshooting Shadows  

o Shadow Size Computation  

o Optimizing for integrated graphics cards  

 Web Player Streaming  

 Web Player Deployment  

o HTML code to load Unity content  

o Working with UnityObject  

http://unity3d.com/support/documentation/Manual/AssetBundles.html
http://unity3d.com/support/documentation/Manual/AssetDatabase.html
http://unity3d.com/support/documentation/Manual/RenderingPaths.html
http://unity3d.com/support/documentation/Manual/Profiler.html
http://unity3d.com/support/documentation/Manual/Lightmapping.html
http://unity3d.com/support/documentation/Manual/LightmappingInDepth.html
http://unity3d.com/support/documentation/Manual/LightmappingCustomSettings.html
http://unity3d.com/support/documentation/Manual/LightmappingUV.html
http://unity3d.com/support/documentation/Manual/Occlusion%20Culling.html
http://unity3d.com/support/documentation/Manual/Loading%20Resources%20at%20Runtime.html
http://unity3d.com/support/documentation/Manual/Modifying%20Source%20Assets%20Through%20Scripting.html
http://unity3d.com/support/documentation/Manual/Generating%20Mesh%20Geometry%20Procedurally.html
http://unity3d.com/support/documentation/Manual/Anatomy%20of%20a%20Mesh.html
http://unity3d.com/support/documentation/Manual/Using%20the%20Mesh%20Class.html
http://unity3d.com/support/documentation/Manual/Example:%20Creating%20a%20Billboard%20Plane.html
http://unity3d.com/support/documentation/Manual/Execution%20Order.html
http://unity3d.com/support/documentation/Manual/Optimizing%20Graphics%20Performance.html
http://unity3d.com/support/documentation/Manual/Modeling%20Optimized%20Characters.html
http://unity3d.com/support/documentation/Manual/RenderingStatistics.html
http://unity3d.com/support/documentation/Manual/Reducing%20File%20size.html
http://unity3d.com/support/documentation/Manual/Platform%20Dependent%20Compilation.html
http://unity3d.com/support/documentation/Manual/Debugging.html
http://unity3d.com/support/documentation/Manual/Console.html
http://unity3d.com/support/documentation/Manual/Debugger.html
http://unity3d.com/support/documentation/Manual/Log%20Files.html
http://unity3d.com/support/documentation/Manual/Accessing%20Hidden%20Folders.html
http://unity3d.com/support/documentation/Manual/Plugins.html
http://unity3d.com/support/documentation/Manual/Command%20Line%20Arguments.html
http://unity3d.com/support/documentation/Manual/Shaders.html
http://unity3d.com/support/documentation/Manual/ShaderTut1.html
http://unity3d.com/support/documentation/Manual/ShaderTut2.html
http://unity3d.com/support/documentation/Manual/GraphicsEmulation.html
http://unity3d.com/support/documentation/Manual/NetworkEmulation.html
http://unity3d.com/support/documentation/Manual/Security%20Sandbox.html
http://unity3d.com/support/documentation/ScriptReference/MonoCompatibility.html
http://unity3d.com/support/documentation/Manual/VisualStudioIntegration.html
http://unity3d.com/support/documentation/Manual/ExternalVersionControlSystemSupport.html
http://unity3d.com/support/documentation/Manual/Analytics.html
http://unity3d.com/support/documentation/Manual/Version%20Check.html
http://unity3d.com/support/documentation/Manual/TroubleShooting.html
http://unity3d.com/support/documentation/Manual/IME%20Input.html
http://unity3d.com/support/documentation/Manual/Shadows.html
http://unity3d.com/support/documentation/Manual/DirectionalShadowDetails.html
http://unity3d.com/support/documentation/Manual/Shadow%20Troubleshooting.html
http://unity3d.com/support/documentation/Manual/Shadow%20Size%20Details.html
http://unity3d.com/support/documentation/Manual/OptimizeForIntegratedCards.html
http://unity3d.com/support/documentation/Manual/Web%20Player%20Streaming.html
http://unity3d.com/support/documentation/Manual/Web%20Player%20Deployment.html
http://unity3d.com/support/documentation/Manual/HTML%20code%20to%20load%20Unity%20Web%20Player%20content.html
http://unity3d.com/support/documentation/Manual/Working%20with%20UnityObject.html


o Customizing the Unity Web Player loading screen  

o Customizing the Unity Web Player's Behavior  

o Unity Web Player and browser communication  

o Using web player templates  
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AssetBundles 

AssetBundles are files which you can export from Unity to contain assets of your choice. These files use a proprietary compressed format 

and can be loaded on demand in your application. This allows you to stream content like models, textures, audio clips and even entire 

scenes separately from the scene in which they will be used. They have been designed to make it easy to download content to your 

application.  

AssetBundles can contain any kind of asset type recognized by Unity, as determined by the filename extension. If you want to include files 

with custom binary data, then you must rename those files to have ".bytes" as the extension. Unity will import these files as TextAssets.  

For some sample code showing how to use asset bundles, see the AssetBundles Example Project  

Creating AssetBundles 

There are three class methods you can use to build AssetBundles: BuildPipeline.BuildAssetBundle, 

BuildPipeline.BuildStreamedSceneAssetBundle and BuildPipeline.BuildAssetBundleExplicitAssetNames..  

 BuildPipeline.BuildAssetBundle allows you to build AssetBundles of any type of asset.  

 BuildPipeline.BuildStreamedSceneAssetBundle is used when you want to include only scenes to be streamed and loaded as the data 

becomes available.  

 BuildPipeline.BuildAssetBundleExplicitAssetNames is the same as BuildPipeline.BuildAssetBundle but has an extra parameter to 

specify a custom string identifier (name) for each object.  

Downloading AssetBundles 

The recommended way to download AssetBundles is to use WWW.LoadFromCacheOrDownload. Once the download is complete you can 

retrieve the AssetBundle with the assetBundle property. For example:  

string url = "http://www.mywebsite.com/mygame/assetbundles/assetbundle1.unity3d"; 

IEnumerator Start () { 

    // Start a download of the given URL 

    WWW www = WWW.LoadFromCacheOrDownload (url, 1); 

 

    // Wait for download to complete 

    yield return www; 

 

http://unity3d.com/support/documentation/Manual/Customizing%20the%20Unity%20Web%20Player%20loading%20screen.html
http://unity3d.com/support/documentation/Manual/WebPlayerBehaviorTags.html
http://unity3d.com/support/documentation/Manual/Unity%20Web%20Player%20and%20browser%20communication.html
http://unity3d.com/support/documentation/Manual/Using%20Web%20Player%20templates.html
http://unity3d.com/support/resources/example-projects/assetbundles
http://unity3d.com/support/documentation/ScriptReference/BuildPipeline.BuildAssetBundle.html
http://unity3d.com/support/documentation/ScriptReference/BuildPipeline.BuildStreamedSceneAssetBundle.html
http://unity3d.com/support/documentation/ScriptReference/BuildPipeline.BuildAssetBundleExplicitAssetNames.html
http://unity3d.com/support/documentation/ScriptReference/WWW.LoadFromCacheOrDownload.html


    // Load and retrieve the AssetBundle 

    AssetBundle bundle = www.assetBundle; 

} 

When you access the .assetBundle property the downloaded data is extracted and the AssetBundle object is created. At this point, 

you are ready to load the objects contained in the bundle. The second parameter passed to LoadFromCacheOrDownload specifies which 

version of the AssetBundle to download. LoadFromCacheOrDownload will download the AssetBundle if it doesn't exist in the cache or if it 

exists but is associated with a version that is lower than the one requested. Otherwise the AssetBundle will be loaded from cache.  

Loading and unloading objects from an AssetBundle 

Having created an AssetBundle object from the downloaded data, you can load the objects contained in it using three different methods: 

AssetBundle.Load, AssetBundle.LoadAsync and AssetBundle.LoadAll.  

 AssetBundle.Load will load an object using its name identifier as a parameter. The name is the one visible in the Project view. You can 

optionally pass an object type as an argument to the Load method to make sure the object loaded is of a specific type.  

 AssetBundle.LoadAsync works the same as the Load method described above but it will not block the main thread while the asset is 

loaded. This is useful when loading large assets or many assets at once to avoid pauses in your application.  

 AssetBundle.LoadAll will load all the objects contained in your AssetBundle. As with AssetBundle.Load, you can optionally filter objects 

by their type.  

To unload assets you need to use AssetBundle.Unload. This method takes a boolean parameter which tells Unity whether to unload all 

data (including the loaded asset objects) or only the compressed data from the downloaded bundle. If your application is using some 

objects from the AssetBundle and you want to free some memory you can pass false to unload the compressed data from memory. If you 

want to completely unload everything from the AssetBundle you should pass true which will destroy the Assets loaded from the 

AssetBundle.  

Listing objects in an AssetBundle 

You can use AssetBundle.LoadAll to retrieve an array containing all objects from the AssetBundle. It is not possible to get a list of the 

identifiers directly. A common workaround is to keep a separate TextAsset with a known name to hold the names of the assets in the 

AssetBundle.  

Instantiating objects from AssetBundles 

Once you have loaded an object from your AssetBundle, you can instantiate it in your scene with the Instantiate function.  

string url = "http://www.mywebsite.com/mygame/assetbundles/assetbundle1.unity3d"; 

IEnumerator Start () { 

    // Start a download of the given URL 

    WWW www = WWW.LoadFromCacheOrDownload (url, 1); 

 

    // Wait for download to complete 

    yield return www; 

 

http://unity3d.com/support/documentation/ScriptReference/AssetBundle.Load.html
http://unity3d.com/support/documentation/ScriptReference/AssetBundle.LoadAsync.html
http://unity3d.com/support/documentation/ScriptReference/AssetBundle.LoadAll.html
http://unity3d.com/support/documentation/ScriptReference/AssetBundle.Unload.html
http://unity3d.com/support/documentation/ScriptReference/Object.Instantiate.html


    // Load and retrieve the AssetBundle 

    AssetBundle bundle = www.assetBundle; 

 

    // Load the TextAsset object 

    GameObject go = bundle.Load("myGameObject", typeof(GameObject)) as GameObject; 

 

    // Instantiate the GameObject 

    Instantiate(go); 

} 

Keeping track of downloaded AssetBundles 

Unity doesn't provide an automatic way to retrieve a list of AssetBundles that have been downloaded. You can keep track of this 

information from a script by storing references to the AssetBundle objects and their URLs, say.  

Storing and loading binary data in an AssetBundle 

The first step is to save your binary data file with the ".bytes" extension. Unity will treat this file as a TextAsset. As a TextAsset the file can 

be included when you build your AssetBundle. Once you have downloaded the AssetBundle in your application and loaded the TextAsset 

object, you can use the .bytes property of the TextAsset to retrieve your binary data.  

string url = "http://www.mywebsite.com/mygame/assetbundles/assetbundle1.unity3d"; 

IEnumerator Start () { 

    // Start a download of the given URL 

    WWW www = WWW.LoadFromCacheOrDownload (url, 1); 

 

    // Wait for download to complete 

    yield return www; 

 

    // Load and retrieve the AssetBundle 

    AssetBundle bundle = www.assetBundle; 

 

http://unity3d.com/support/documentation/ScriptReference/TextAsset.html


    // Load the TextAsset object 

    TextAsset txt = bundle.Load("myBinaryAsText", typeof(TextAsset)) as TextAsset; 

 

    // Retrieve the binary data as an array of bytes 

    byte[] bytes = txt.bytes; 

} 

Including scripts in AssetBundles 

AssetBundles can contain scripts as TextAssets but as such they will not be actual executable code. If you want to include code in your 

AssetBundles that can be executed in your application it needs to be pre-compiled into an assembly and loaded using the Mono Reflection 

class (Note: Reflection is not available on iOS). You can create your assemblies in any normal C# IDE (e.g. Monodevelop, Visual Studio) or 

any text editor using the mono/.net compilers.  

string url = "http://www.mywebsite.com/mygame/assetbundles/assetbundle1.unity3d"; 

IEnumerator Start () { 

    // Start a download of the given URL 

    WWW www = WWW.LoadFromCacheOrDownload (url, 1); 

 

    // Wait for download to complete 

    yield return www; 

 

    // Load and retrieve the AssetBundle 

    AssetBundle bundle = www.assetBundle; 

 

    // Load the TextAsset object 

    TextAsset txt = bundle.Load("myBinaryAsText", typeof(TextAsset)) as TextAsset; 

 

    // Load the assembly and get a type (class) from it 



    var assembly = System.Reflection.Assembly.Load(txt.bytes); 

    var type = assembly.GetType("MyClassDerivedFromMonoBehaviour"); 

 

    // Instantiate a GameObject and add a component with the loaded class 

    GameObject go = new GameObject(); 

    go.AddComponent(type); 

} 

Managing asset dependencies 

Any given asset in a bundle may depend on other assets. For example, a model may incorporate materials which in turn make use of 

textures and shaders. It is possible to include all an asset's dependencies along with it in its bundle. However, several assets from different 

bundles may all depend on a common set of other assets (eg, several different models of buildings may use the same brick texture). If a 

separate copy of a shared dependency is included in each bundle that has objects using it, then redundant instances of the assets will be 

created when the bundles are loaded. This will result in wasted memory.  

To avoid such wastage, it is possible to separate shared dependencies out into a separate bundle and simply reference them from any 

bundles with assets that need them. First, the referencing feature needs to be enabled with a call to 

BuildPipeline.PushAssetDependencies. Then, the bundle containing the referenced dependencies needs to be built. Next, another call to 

PushAssetDependencies should be made before building the bundles that reference the assets from the first bundle. Additional levels of 

dependency can be introduced using further calls to PushAssetDependencies. The levels of reference are stored on a stack, so it is 

possible to go back a level using the corresponding BuildPipeline.PopAssetDependencies function. The push and pop calls need to be 

balanced including the initial push that happens before building.  

At runtime, you need to load a bundle containing dependencies before any other bundle that references them. For example, you would 

need to load a bundle of shared textures before loading a separate bundle of materials that reference those textures.  

Can I reuse my AssetBundles in another game? 

AssetBundles allow you to share content between different games. The requirement is that any Assets which are referenced by 

GameObjects in your AssetBundle must either be included in the AssetBundle or exist in the application (loaded in the current scene). To 

make sure the referenced Assets are included in the AssetBundle when they are built you can pass the 

BuildAssetBundleOptions.CollectDependencies option.  

How are assets in AssetBundles identified? 

When you build AssetBundles the assets are identified internally by their filename without the extension. For example a Texture located in 

your Project folder at "Assets/Textures/myTexture.jpg" is identified and loaded using "myTexture" if you use the default method. You can 

have more control over this by supplying your own array of ids (strings) for each object when Building your AssetBundle with 

BuildPipeline.BuildAssetBundleExplicitAssetNames.  

Loading objects from an AssetBundles asynchronously 

You can use the AssetBundle.LoadAsync method to load objects Asynchronously and reduce the likelihood of having hiccups in your 

application.  

using UnityEngine; 

 

http://unity3d.com/support/documentation/ScriptReference/BuildPipeline.PushAssetDependencies.html
http://unity3d.com/support/documentation/ScriptReference/BuildPipeline.PopAssetDependencies.html
http://unity3d.com/support/documentation/ScriptReference/BuildAssetBundleOptions.CollectDependencies.html
http://unity3d.com/support/documentation/ScriptReference/BuildPipeline.BuildAssetBundleExplicitAssetNames.html
http://unity3d.com/support/documentation/ScriptReference/AssetBundle.LoadAsync.html


IEnumerator Start () { 

 // Start a download of the given URL 

 WWW www = WWW.LoadFromCacheOrDownload (url, 1); 

 

 // Wait for download to complete 

 yield return www; 

 

 // Load and retrieve the AssetBundle 

 AssetBundle bundle = www.assetBundle; 

 

 // Load the object asynchronously 

 AssetBundleRequest request = bundle.LoadAsync ("myObject", typeof(GameObject)); 

 

 // Wait for completion 

 yield return request; 

 

 // Get the reference to the loaded object 

 GameObject obj = request.asset as GameObject; 

} 

Are AssetBundles cross-platform? 

AssetBundles are compatible between some platforms. Use the following table as a guideline.  

Platform compatibility for AssetBundles 

  Standalone Webplayer iOS Android 

Editor Y Y Y Y 

Standalone Y Y     

Webplayer Y Y     

iOS     Y   

Android       Y 



How do I cache AssetBundles? 

You can use WWW.LoadFromCacheOrDownload which automatically takes care of saving your AssetBundles to disk. Be aware that on the 

Webplayer you are limited to 50MB in total (shared between all webplayers). You can buy a separate caching license for your game if you 

require more space.  

Protecting content 

Unity allows you to create an AssetBundle object from a byte[] array with AssetBundle.CreateFromMemory. You can use this as a way to 

enhance the security by encrypting your assetbundles before transmission and decrypt them at runtime.  

string url = "http://www.mywebsite.com/mygame/assetbundles/assetbundle1.unity3d"; 

IEnumerator Start () { 

    // Start a download of the given URL 

    WWW www = new WWW (url); 

 

    // Wait for download to complete 

    yield return www; 

 

    // Get the byte data 

    byte[] encryptedData = www.bytes; 

 

    // Load the TextAsset object 

    byte[] decryptedData = YourDecryptionMethod(encryptedData); 

 

    // Create an AssetBundle from the bytes array 

    AssetBundle bundle = AssetBundle.CreateFromMemory(decryptedData); 

 

    // You can now use your AssetBundle 

} 
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AssetDatabase 
AssetDatabase is an API which allows you to access the assets contained in your project. Among other things, it provides methods to find 

and load assets and also to create, delete and modify them. The Unity Editor uses the AssetDatabase internally to keep track of asset files 

and maintain the linkage between assets and objects that reference them. Since Unity needs to keep track of all changes to the project 

folder, you should always use the AssetDatabase API rather than the filesystem if you want to access or modify asset data.  

The AssetDatabase interface is only available in the editor and has no function in the built player. Like all other editor classes, it is only 

available to scripts placed in the Editor folder (just create a folder named �Editor� in the main Assets folder of your project if there isn't 

one already).  

Importing an Asset 

Unity normally imports assets automatically when they are dragged into the project but it is also possible to import them under script 

control. To do this you can use the AssetDatabase.ImportAsset method as in the example below.  

using UnityEngine; 

using UnityEditor; 

 

public class ImportAsset { 

 [MenuItem ("AssetDatabase/ImportExample")] 

 static void ImportExample () 

 { 

  AssetDatabase.ImportAsset("Assets/Textures/texture.jpg", ImportAssetOptions.Default); 

 } 

} 

You can also pass an extra parameter of type AssetDatabase.ImportAssetOptions to the AssetDatabase.ImportAsset call. The scripting 

reference page documents the different options and their effects on the function's behaviour.  

Loading an Asset 

The editor loads assets only as needed, say if they are added to the scene or edited from the Inspector panel. However, you can load and 

access assets from a script using AssetDatabase.LoadAssetAtPath, AssetDatabase.LoadMainAssetAtPath, 

AssetDatabase.LoadAllAssetRepresentationsAtPath and AssetDatabase.LoadAllAssetsAtPath. See the scripting documentation for further 

details.  

using UnityEngine; 

using UnityEditor; 

http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.ImportAsset.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.ImportAssetOptions.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.LoadAssetAtPath.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.LoadMainAssetAtPath.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.LoadAllAssetRepresentationsAtPath.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.LoadAllAssetsAtPath%20.html


 

public class ImportAsset { 

 [MenuItem ("AssetDatabase/LoadAssetExample")] 

 static void ImportExample () 

 { 

  Texture2D t = AssetDatabase.LoadAssetAtPath("Assets/Textures/texture.jpg", typeof(Texture2D)) as Texture2D; 

 } 

} 

File Operations using the AssetDatabase 

Since Unity keeps metadata about asset files, you should never create, move or delete them using the filesystem. Instead, you can use 

AssetDatabase.Contains, AssetDatabase.CreateAsset, AssetDatabase.CreateFolder, AssetDatabase.RenameAsset, 

AssetDatabase.CopyAsset, AssetDatabase.MoveAsset, AssetDatabase.MoveAssetToTrash and AssetDatabase.DeleteAsset.  

public class AssetDatabaseIOExample { 

 [MenuItem ("AssetDatabase/FileOperationsExample")] 

 static void Example () 

 { 

  string ret; 

 

  // Create 

  Material material = new Material (Shader.Find("Specular")); 

  AssetDatabase.CreateAsset(material, "Assets/MyMaterial.mat"); 

  if(AssetDatabase.Contains(material)) 

   Debug.Log("Material asset created"); 

 

  // Rename 

  ret = AssetDatabase.RenameAsset("Assets/MyMaterial.mat", "MyMaterialNew"); 

http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.Contains.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.CreateAsset.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.CreateFolder.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.RenameAsset.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.CopyAsset.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.MoveAsset.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.MoveAssetToTrash.html
http://unity3d.com/support/documentation/ScriptReference/AssetDatabase.DeleteAsset.html


  if(ret == "") 

   Debug.Log("Material asset renamed to MyMaterialNew"); 

  else 

   Debug.Log(ret); 

 

  // Create a Folder 

  ret = AssetDatabase.CreateFolder("Assets", "NewFolder"); 

  if(AssetDatabase.GUIDToAssetPath(ret) != "") 

   Debug.Log("Folder asset created"); 

  else 

   Debug.Log("Couldn't find the GUID for the path"); 

 

  // Move 

  ret = AssetDatabase.MoveAsset(AssetDatabase.GetAssetPath(material), "Assets/NewFolder/MyMaterialNew.mat"); 

  if(ret == "") 

   Debug.Log("Material asset moved to NewFolder/MyMaterialNew.mat"); 

  else 

   Debug.Log(ret); 

 

  // Copy 

  if(AssetDatabase.CopyAsset(AssetDatabase.GetAssetPath(material), "Assets/MyMaterialNew.mat")) 

   Debug.Log("Material asset copied as Assets/MyMaterialNew.mat"); 

  else 

   Debug.Log("Couldn't copy the material"); 



  // Manually refresh the Database to inform of a change 

  AssetDatabase.Refresh(); 

  Material MaterialCopy = AssetDatabase.LoadAssetAtPath("Assets/MyMaterialNew.mat", typeof(Material)) as 

Material; 

 

  // Move to Trash 

  if(AssetDatabase.MoveAssetToTrash(AssetDatabase.GetAssetPath(MaterialCopy))) 

   Debug.Log("MaterialCopy asset moved to trash"); 

 

  // Delete 

  if(AssetDatabase.DeleteAsset(AssetDatabase.GetAssetPath(material))) 

   Debug.Log("Material asset deleted"); 

  if(AssetDatabase.DeleteAsset("Assets/NewFolder")) 

   Debug.Log("NewFolder deleted"); 

 

  // Refresh the AssetDatabase after all the changes 

  AssetDatabase.Refresh(); 

 } 

} 

Using AssetDatabase.Refresh 

When you have finished modifying assets, you should call AssetDatabase.Refresh to commit your changes to the database and make them 

visible in the project.  
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RenderingPaths 
Unity supports different Rendering Paths. You should choose which one you use depending on your game content and target platform / 

hardware. Different rendering paths have different features and performance characteristics that mostly affect Lights and Shadows.  



The rendering Path used by your project is chosen in Player Settings. Additionally, you can override it for each Camera.  

If the graphics card can't handle a selected rendering path, Unity will automatically use a lower fidelity one. So on a GPU that can't handle 

Deferred Lighting, Forward Rendering will be used. If Forward Rendering is not supported, Vertex Lit will be used.  

Deferred Lighting 

Deferred Lighting is the rendering path with the most lighting and shadow fidelity. It is best used if you have many realtime lights. It 

requires a certain level of hardware support, is for Unity Pro only and is not supported on Mobile Devices.  

For more details see the Deferred Lighting page.  

Forward Rendering 

Forward is a shader-based rendering path. It supports per-pixel lighting (including normal maps & light Cookies) and realtime shadows 

from one directional light. In the default settings, a small number of the brightest lights are rendered in per-pixel lighting mode. The rest of 

the lights are calculated at object vertices.  

For more details see the Forward Rendering page.  

Vertex Lit 

Vertex Lit is the rendering path with the lowest lighting fidelity and no support for realtime shadows. It is best used on old machines or 

limited mobile platforms.  

For more details see the Vertex Lit page.  

Rendering Paths Comparison 

  Deferred Lighting Forward Rendering Vertex Lit 

Features       

Per-pixel lighting (normal maps, light 

cookies) 

Yes Yes - 

Realtime shadows Yes 1 Directional Light - 

Dual Lightmaps Yes - - 

Depth&Normals Buffers Yes Additional render passes - 

Soft Particles Yes - - 

Semitransparent objects - Yes Yes 

Anti-Aliasing - Yes Yes 

Light Culling Masks Limited Yes Yes 

Lighting Fidelity All per-pixel Some per-pixel All per-vertex 

Performance       

Cost of a per-pixel Light Number of pixels it 

illuminates 

Number of pixels * Number of objects it 

illuminates 

- 

Platform Support       

PC (Windows/Mac) Shader Model 3.0+ Shader Model 2.0+ Anything 

Mobile (iOS/Android) - OpenGL ES 2.0 OpenGL ES 2.0 & 

1.1 

Consoles 360, PS3 360, PS3 - 
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Profiler 
The Unity Profiler helps you to optimize your game. It reports for you how much time is spent in the various areas of your game. For 

example, it can report the percentage of time spent rendering, animating or in your game logic.  

http://unity3d.com/support/documentation/Components/class-PlayerSettings.html
http://unity3d.com/support/documentation/Components/class-Camera.html
http://unity3d.com/support/documentation/Components/RenderTech-DeferredLighting.html
http://unity3d.com/support/documentation/Components/RenderTech-ForwardRendering.html
http://unity3d.com/support/documentation/Components/RenderTech-VertexLit.html


You can play your game in the Editor with Profiling on, and it will record performance data. The Profiler window then displays the data in a 

timeline, so you can see the frames or areas that spike (take more time) than others. By clicking anywhere in the timeline, the bottom 

section of the Profiler window will display detailed information for the selected frame.  

Note that profiling has to instrument your code. This instrumentation has a small impact on the performance of your game. Typically this 

overhead is small enough to not affect the game framerate. When using profiling it is typical to consider only the ratio (or percentage) of 

time spent in certain areas. Also, to improve performance focus on those parts of the game that consume the most time. Compare profiling 

results before and after code changes and determine the improvements you measure. Sometimes changes you make to improve 

performance might have a negative effect on frame rate; unexpected consequences of code optimization should be expected.  

 

Profiler window 

Attaching to Unity players 

To profile your game running on an other device or a player running on another computer, it is possible to connect the editor to that other 

player. The dropdown Active Profiler will show all players running on the local network. These players are identified by player type and the 

host name running the player "iPhonePlayer (Toms iPhone)". To be able to connect to a player, the player must be launched with the 

Development Build checkbox found in the Build Settings dialog. From here it is also possible to tick a checkbox to make the Editor and 

Player Autoconnect at startup.  

Profiler Controls 

 

Profiler controls are in the toolbar at the top of the window. Use these to turn profiling on and off, navigate through profiled frames and so 

on. The transport controls are at the far right end of the toolbar. Note that when the game is running and the profiler is collecting data 

clicking on any of these transport controls will pause the game. The controls go to the first recorded frame, step one frame back, step one 

frame forward and go to the last frame respectively. The profiler does not keep all recorded frames, so the notion of the first frame should 

really be though of as the oldest frame that is still kept in memory. The "current" transport button causes the profile statistics window to 

display data collected in real-time.  



Deep Profiling 

When you turn on Deep Profile, all your script code is profiled - that is, all function calls are recorded. This is useful to know where exactly 

time is spent in your game code.  

Note that Deep Profiling incurs a very large overhead and uses a lot of memory, and as a result your game will run significantly slower 

while profiling. If you are using complex script code, Deep Profiling might not be possible at all. Deep profiling should work fast enough for 

small games with simple scripting. If you find that Deep Profiling for your entire game causes the frame rate to drop so much that the game 

barely runs, you should consider not using this approach, and instead use the approach described below. You may find deep profiling more 

helpful as you are designing your game and deciding how to best implement key features. Note that for large games deep profil ing may 

cause Unity to run out of memory and so for this reason deep profiling may not be possible.  

Manually profiling blocks of your script code will have a smaller overhead than using Deep Profiling. Use Profiler.BeginSample and 

Profiler.EndSample scripting functions to enable and disable profiling around sections of code.  

View SyncTime 

When running at a fixed framerate or running in sync with the vertical blank, unity records to waiting time in "Wait For Target FPS", By 

default this amount of time is not shown in the profiler. To wiev how much time is spent waiting, you can toggle "View SyncTime". This is 

also a measure of how much headroom you have before loosing frames.  

Profiler Timeline 

 

The upper part of the Profiler window displays performance data over time. When you run a game, data is recorded each frame, and the 

history of the last several hundred frames is displayed. Clicking on a particular frame will display it's details in the lower part of the window. 

Different details are displayed depending on which timeline area is currently selected.  

The vertical scale of the timeline is managed automatically and will attempt to fill the vertical space of the window. Note that to get more 

detail in say the CPU Usage area you can remove the Memory and Rendering areas. Also, the splitter between the timeline and the 

statistics area can be selected and dragged downward to increase the screen area used for the timeline chart.  

The timeline consists of several areas: CPU Usage, Rendering and Memory. These areas can be removed by clicking the close button in 

the panel, and re-added again using the Add Area drop down in the Profile Controls bar.  

CPU Usage Area 

http://unity3d.com/support/documentation/ScriptReference/Profiler.BeginSample.html
http://unity3d.com/support/documentation/ScriptReference/Profiler.EndSample.html


 

The CPU Usage area displays where time is spent in your game. When it is selected, the lower pane displays hierarchical time data for the 

selected frame.  

 Hierarchy mode: Displays hierarchical time data.  

 Group Hierarchy mode: Groups time data into logical groups (Rendering, Physics, Scripts etc.). Because children of any group can be in 

different group (e.g. some script might call rendering functions), the percentages of group times often add up to more than 100%. (This is 

not a bug.)  

The way the CPU chart is stacked can be reordered by simply dragging chart labels up & down.  

When an item is selected in the lower pane, it's contribution to the CPU chart is highlighted (and the rest are dimmed). Clicking on an item 

again de-selects it.  

 

Shader.SetPass is selected and it's contribution is highlighted in the chart. 

In the hierarchical time data the self time refers to the amount of time spent in a particular function not including the time spent calling sub-

functions. In the screenshot above, for example 51.2% of time is spent in the Camera.Render function. This function does a lot of work and 



calls the various drawing and culling functions. Excluding all these functions only 0.8% of time is spent actually in the Camera.Render 

function.  

Rendering Area 

 

The Rendering area displays rendering statistics. The Number of Draw Calls, Triangles and Vertices rendered is displayed graphical in the 

timeline. The Lower pane displays more rendering statistics and these more closely match the ones shown in the GameView Rendering 

Statistics window.  

Memory Area 

 

The Memory area displays some memory usage data:  

 Total Allocated is the total RAM used by the application. Note that in the Unity Editor this is memory used by everything in the editor; 

game builds will use much less.  

 Texture Memory is the amount of video memory used by the textures in the current frame.  

 Object Count is the total number of Objects that are created. If this number rises over time then it means your game is creating some 

objects that are never destroyed.  

http://unity3d.com/support/documentation/Manual/RenderingStatistics.html
http://unity3d.com/support/documentation/Manual/RenderingStatistics.html


Audio Area 

 

The Audio area displays audio statistic:  

 Playing Sources is the total playing sources in the scene at a specific frame. Monitor this to see if audio is overloaded.  

 Paused Sources is the total paused sources in the scene at a specific frame.  

 Audio Voice is the actually number of audio (FMOD channels) voices used. PlayOneShot is using voices not shown in Playing Sources.  

 Audio Memory is the total RAM used by the audio engine.  

CPU usage can be seen in the bottom. Monitor this to see if Audio alone is taking up too much CPU.  

See Also 

 Optimizing Graphics Performance page.  

iOS 

Remote profiling can be enabled on iOS devices by following these steps:  

1. Connect your iOS device to your WiFi network (local/adhoc WiFi network is used by profiler to send profiling data from device to 

the Unity Editor).  

2. Check "Autoconnect Profiler" checkbox in Unity's build settings dialog.  

3. Attach your device to your Mac via cable and hit "Build & Run" in Unity Editor.  

4. When app launches on device open profiler window in Unity Editor (Window->Profiler)  

Note: Sometimes Unity Editor might not autoconnect to the device. In such cases profiler connection might be initiated from Profiler 

Window Active Profiler drop down menu by select appropriate device.  
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Lightmapping 
This an introductory description of lightmapping in Unity. For more advanced topics see in-depth description of lightmapping in Unity  

http://unity3d.com/support/documentation/Manual/Optimizing%20Graphics%20Performance.html
http://unity3d.com/support/documentation/Manual/LightmappingInDepth.html


Unity has a built-in lightmapper: it's Beast by Illuminate Labs. Lightmapping is fully integrated in Unity. This means that Beast will bake 

lightmaps for your scene based on how your scene is set up within Unity, taking into account meshes, materials, textures and lights. It also 

means that lightmapping is now an integral part of the rendering engine - once your lightmaps are created you don't need to do anything 

else, they will be automatically picked up by the objects.  

 

Preparing the scene and baking the lightmaps 

Selecting Window – Lightmapping from the menu will open the Lightmapping window:  

1. Make sure any mesh you want to be lightmapped has proper UVs for lightmapping. The easiest way is to choose the Generate 

Lightmap UVs option in mesh import settings.  

http://www.illuminatelabs.com/products/beast
http://unity3d.com/support/documentation/Components/class-Mesh.html


2. In the Object pane mark any Mesh Renderer or Terrain as static – this will tell Unity, that those objects won't move nor change 

and they can be lightmapped. 

 

3. To control the resolution of the lightmaps, go to the Bake pane and adjust the Resolution value. (To have a better understanding 

on how you spend your lightmap texels, look at the small Lightmap Display window within the Scene View and select Show 



Resolution). 

 

4. Press Bake  

5. A progress bar appears in Unity Editor's status bar, in the bottom right corner.  

6. When baking is done, you can see all the baked lightmaps at the bottom of the Lightmap Editor window.  

Scene and game views will update - your scene is now lightmapped!  

Tweaking Bake Settings 

Final look of your scene depends a lot on your lighting setup and bake settings. Let's take a look at an example of some basic settings that 

can improve lighting quality.  



This is a basic scene with a couple of cubes and one point light in the centre. The light is casting hard shadows and the effect is quite dull 

and artificial. 

 

Selecting the light and opening the Object pane of the Lightmapping window exposes Shadow Radius and Shadow Samples properties. 

Setting Shadow Radius to 1.2, Shadow Samples to 100 and re-baking produces soft shadows with wide penumbra - our image already 

looks much better. 



 

With Unity Pro we can take the scene one step further by enabling Global Illumination and adding a Sky Light. In the Bake pane we set the 

number of Bounces to 1 and the Sky Light Intensity to 0.5. The result is much softer lighting with subtle diffuse interreflection effects 

(color bleeding from the green and blue cubes) - much nicer and it's still only 3 cubes and a light!  



 

Lightmapping In-Depth 

For more information about the various lightmapping-related settings, please refer to the in-depth description of lightmapping in Unity.  
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LightmappingInDepth 
If you are about to lightmap your first scene in Unity, this Quickstart Guide might help you out.  

Lightmapping is fully integrated in Unity, so that you can build entire levels from within the Editor, lightmap them and have your materials 

automatically pick up the lightmaps without you having to worry about it. Lightmapping in Unity means that all your lights' properties will be 

mapped directly to the Beast lightmapper and baked into textures for great performance. Unity Pro extends this functionality by Global 

http://unity3d.com/support/documentation/Manual/LightmappingInDepth.html
http://unity3d.com/support/documentation/Manual/Lightmapping.html


Illumination, allowing for baking realistic and beautiful lighting, that would otherwise be impossible in realtime. Additionally Unity Pro brings 

you sky lights and emissive materials for even more interesting scene lighting.  

In this page you will find a more in-depth description of all the attributes that you can find in the Lightmapping window. To open the 

Lightmapping window select Window – Lightmapping.  

 

Object 

Per-object bake settings for lights, mesh renderers and terrains - depending on the current selection.  

Mesh Renderers and Terrains:  

  

Static Mesh Renderers and Terrains have to marked as static to be lightmapped. 

Scale In Lightmap (Mesh Renderers only) Bigger value will result in more resolution to be dedicated to the give mesh renderer. 

The final resolution will be proportional (Scale in lightmap)*(Object's word-space surface area)*(Global bake 

settings Resolution value). A value of 0 will result in the object not being lightmapped (it will still affect other 

lightmapped objects). 

Lightmap Size (Terrains only) Lightmap size for this terrain instance. Terrains are not atlased as other objects - they get their 

individual lightmaps instead. 

Atlas Atlasing information – will be updated automatically, if Lock Atlas is disabled. If Lock Atlas is enabled, those 

parameters won't be modified automatically and can be edited manually. 

Lightmap Index An index into the lightmap array. 

Tiling (Mesh Renderers only) Tiling of object's lightmap UVs. 

Offset (Mesh Renderers only) Offset of object's lightmap UVs. 

Lights:  

  

Lightmapping The Lightmapping mode: Realtime Only, Auto or Baked Only. See Dual Lightmaps description below. 

Color The color of the light. Same property is used for realtime rendering. 

Intensity The intensity of the light. Same property is used for realtime rendering. 

Bounce Intensity A multiplier to the intensity of indirect light emitted from this particular light source. 

Baked Shadows Controls whether shadows are casted from objects lit by this light (controls realtime shadows at the same time 

in case of Auto lights). 

Shadow Radius (Point and Spot lights only) Increase this value for soft direct shadows - it increases the size of the light for the 

http://unity3d.com/support/documentation/printable.html#DualLightmaps


shadowing (but not lighting) calculations. 

Shadow Angle (Directional lights only) Increase this value for soft direct shadows - it increases the angular coverage of the 

light for the shadowing (but not lighting) calculations. 

Shadow Samples If you've set Shadow Radius or Angle above zero, increase the number of Shadow Samples as well. Higher 

sample numbers remove noise from the shadow penumbra, but might increase rendering times. 

Bake 

Global bake settings.  

  

Mode Controls both offline lightmap baking and runtime lightmap rendering modes. In Dual Lightmaps mode both 

near and far lightmaps will be baked; only deferred rendering path supports rendering dual lightmaps. Single 

Lightmaps mode results in only the far lightmap being baked; can also be used to force single lightmaps mode 

for the deferred rendering path. 

Quality Presets for high (good-looking) and low (but fast) quality bakes. They affect the number of final gather rays, 

contrast threshold and some other final gather and anti-aliasing settings. 

Bounces The number of light bounces in the Global Illumination simulation. At least one bounce is needed to give a soft, 

realistic indirect lighting. 0 means only direct light will be computed. 

Sky Light Color Sky light simulates light emitted from the sky from all the directions - great for outdoor scenes. 

Sky Light Intensity The intensity of the sky light - a value of 0 disables the sky light. 

Bounce Boost Boosts indirect light, can be used to increase the amount of bounced light within the scene without burning out 

the render too quickly. 

Bounce Intensity A multiplier to the intensity of the indirect light. 

Final Gather Rays The number of rays shot from every final gather point - higher values give better quality. 

Contrast Threshold Color contrast threshold, above which new final gather points will be created by the adaptive sampling 

algorithm. Higher values make Beast be more tolerant about illumination changes on the surface, thus 

producing smoother but less-detailed lightmaps. Lower numbers of final gather rays might need higher contrast 

threshold values not to force additional final gather points to be created. 

Interpolation Controls the way the color from final gather points will be interpolated. 0 for linear interpolation, 1 for advanced, 

gradient-based interpolation. In some cases the latter might introduce artifacts. 

Interpolation Points The number of final gather points to interpolate between. Higher values give more smooth results, but can also 

smooth out details in the lighting. 

Ambient Occlusion The amount of ambient occlusion to be baked into the lightmaps. Ambient occlusion is the visibility function 

integrated over the local hemisphere of size Max Distance, so doesn't take into account any lighting 

information. 

Max Distance Beyond this distance a ray is considered to be unoccluded. 0 stands for infinitely long rays. 

Contrast Controls the transition between fully occluded to not occluded. 

Lock Atlas When Lock Atlas is enabled, automatic atlasing won't be run and lightmap index, tiling and offset on the objects 

won't be modified. 

Resolution The resolution of the lightmaps in texels per world unit, so a value of 50 and a 10unit by 10unit plane will result 

in the plane occupying 500x500 pixels in the lightmap. 

Maps 

The editable array of all the lightmaps.  

  

Compressed Toggles compression on all lightmap assets for this scene. 

Array Size Size of the lightmaps array (0 to 254). 

Lightmaps Array The editable array of all the lightmaps in the current scene. Unassigned slots are treated as black lightmaps. 

Indices correspond to the Lightmap Index value on Mesh Renderers and Terrains. Unless Lock Atlas is 

enabled, this array will get auto-resized and populated whenever you bake lightmaps. 

Lightmap Display 

Utilities for controlling how lightmaps are displayed in the editor. Lightmap Display is a sub window of the Scene View, visible whenever the 

Lightmapping window is visible.  

  

Use Lightmaps Whether to use the lightmaps during the rendering or not. 

Shadow Distance The distance at which Auto lights and Close By lightmaps fade out to just Far Away lightmaps. This setting 



overrides but not overwrites the QualitySettings.shadowDistance setting. 

Show Resolution Toggles the scene view Lightmap Resolution mode, which allows you to preview how you spend your lightmap 

texels on objects marked as static. 

Details 

Dual Lightmaps 

Dual lightmaps is Unity's approach to make lightmapping work with specular, normal mapping and proper blending of baked and realtime 

shadows. It's also a way to make your lightmaps look good even if the lightmap resolution is low.  

Dual lightmaps by default can only be used in the Deferred Lighting rendering path. In Forward rendering path, it's possible to enable Dual 

Lightmaps by writing custom shaders (use dualforward surface shader directive).  

Dual lightmaps use two sets of lightmaps:  

 Far: Contains full illumination  

 Near: Contains indirect illumination from lights marked as Auto, full illumination from lights marked as Bake Only, emissive materials and 

sky lights.  

Realtime Only lights are never baked. The Near lightmap set is used within the distance from the camera smaller than the Shadow 

Distance quality setting. 

Within this distance Auto lights are rendered as realtime lights with specular bump and realtime shadows (this makes their shadows blend 

correctly with shadows from Realtime Only lights) and their indirect light is taken from the lightmap. Outside Shadow Distance Auto lights 

no longer render in realtime and full illumination is taken from the Far lightmap (Realtime Only lights are still there, but with disabled 

shadows).  

The scene below contains one directional light with lightmapping mode set to the default Auto, a number of static lightmapped objects 

(buildings, obstacles, immovable details) and some dynamic moving or movable objects (dummies with guns, barrels). The scene is baked 

and rendered in dual lightmaps mode: behind the shadow distance buildings are fully lit only by lightmaps, while the two dummies are 

dynamically lit but don't cast shadows anymore; in front of the shadow distance both the dummy and static lightmapped buildings and 

ground are lit in realtime and cast realtime shadows, but the soft indirect light comes from the near lightmap.  

http://unity3d.com/support/documentation/Manual/RenderingPaths.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html


 



 

Single Lightmaps 

Single Lightmaps is a much simpler technique, but it can be used in any rendering path. All static illumination (i.e. from baked only and auto 

lights, sky lights and emissive materials) gets baked into one set of lightmaps. These lightmaps are used on all lightmapped objects 

regardless of shadow distance.  

To match the strength of dynamic shadows to baked shadows, you need to manually adjust the Shadow Strength property of your light:  

 

Adjusting Shadow Strength of a light from the original value of 1.0 to 0.7. 

Lightmapped Materials 

Unity doesn't require you to select special materials to use lightmaps. Any shader from the built-in shaders (and any Surface Shader you 

write, for that matter) already supports lightmaps out of box, without you having to worry about it - it just works.  

http://unity3d.com/support/documentation/Manual/RenderingPaths.html


Lightmap Resolution 

With the Resolution bake setting you control how many texels per unit are needed for your scene to look good. If there's a 1x1 unit plane in 

your scene and the resolution is set to 10 texels per unit, your plane will take up 10x10 texels in the lightmap. Resolution bake setting is a 

global setting. If you want to modify it for a special object (make it very small or very big in the lightmap) you can use Scale in Lightmap 

property of Mesh Renderers. Setting Scale in Lightmap to 0 will result in the object not being lightmapped at all (it will still influence 

lightmaps on other objects). Use the Lightmap Resolution scene view render mode to preview how you spend your lightmap texels.  

 

Lightmap Resolution scene view mode visualising how the lightmap texels are spent (each square is one texel). 

UVs 

A mesh that you're about to lightmap needs to have UVs suitable for lightmapping. The easiest way to ensure that is to enable the 

Generate Lightmap UVs option in Mesh Import Settings for a given mesh.  

For more information see the Lightmap UVs page.  

Material Properties 

The following material properties are mapped to Beast's internal scene representation:  

 Color  

 Main Texture  

 Specular Color  

 Shininess  

 Transparency  

o Alpha-based: when using a transparent shader, main texture's alpha channel will control the transparency  

o Color-based: Beast's RGB transparency can be enabled by adding a texture property called _TransparencyLM to the shader. Bear in mind 

that this transparency is defined in the opposite way compared to the alpha-based transparency: here a pixel with value (1, 0, 0) will be fully 

transparent to red light component and fully opaque to green and blue component, which will result in a red shadow; for the same reason 

white texture will be fully transparent, while black texture - fully opaque.  

 Emission  

o Self Illuminated materials will emit light tinted by the Color and Main Texture and masked by the Illum texture. The intensity of emitted light 

is proportional to the Emission property (0 disables emission).  

o Generally large and dim light sources can be modeled as objects with emissive materials. For small and intense lights normal light types 

should be used, since emissive materials might introduce noise in the rendering.  

Note: When mapping materials to Beast, Unity detects the 'kind' of the shader by the shader's properties and path/name keywords such as: 

'Specular', 'Transparent', 'Self-Illumin', etc.  

http://unity3d.com/support/documentation/Manual/LightmappingUV.html


Advanced 

Automatic Atlasing 

Atlasing (UV-packing) is performed automatically every time you perform a bake and normally you don't have to worry about it - it just 

works.  

Object's world-space surface area is multiplied by the per-object Scale In Lightmap value and by the global Resolution and the result 

determines the size of the object's UV set (more precisely: the size of the [0,1]x[0,1] UV square) in the lightmap. Next, all objects are 

packed into as few lightmaps as possible, while making sure each of them occupies the amount of space calculated in the previous step. If 

a UV set for a given object occupies only part of the [0,1]x[0,1] square, in many cases atlasing will move neighboring UV sets closer, to 

make use of the empty space.  

As a result of atlasing, every object to be lightmapped has it's place in one of the lightmaps and that space doesn't overlap with any other 

object's space. The atlasing information is stored as three values: Lightmap Index, Tiling (scale) and Offset in Mesh Renderers and as one 

value: Lightmap Index in Terrains and can be viewed and modified via the Object pane of the lightmapping window.  

 

Right-clicking a lightmap allows to select all game objects, that are using the chosen lightmap. Lightmaps of the active object from the current selection will be 

highlighted in yellow. 

Atlasing can only modify per-object data which is Lightmap Index, Tiling and Offset and can not modify the UV set of an object, as the UV 

set is stored as part of the shared mesh. Lightmap UVs for a mesh can only be created at import time using Unity's built-in auto-unwrapper 

or in an external 3D package before importing to Unity.  

Lock Atlas 

When Lock Atlas is enabled, automatic atlasing won't be run and Lightmap Index, Tiling and Offset on the objects won't be modified. Beast 

will rely on whatever is the current atlasing, so it's the user's responsibility to maintain correct atlasing (e.g. no overlapping objects in the 

lightmaps, no objects referencing a lightmap slot past the lightmap array end, etc.).  

Lock Atlas opens up the possibility for alternative workflows when sending your object's for lightmapping. You can then perform atlasing 

manually or via scripting to fit you specific needs; you can also lock the automatically generated atlasing if you are happy with the current 

atlasing, have baked more sets of lightmaps for your scene and want to make sure, that after adding one more object to the scene the 

atlasing won't change making the scene incompatible with other lightmap sets.  

Remember that Lock Atlas locks only atlasing, not the mesh UVs. If you change your source mesh and the mesh importer is set to generate 

lightmap UVs, the UVs might be generated differently and your current lightmap will look incorrectly on the object - to fix this you will need 

to re-bake the lightmap.  

Custom Beast bake settings 

If you need even more control over the bake process, see the custom Beast settings page.  

http://unity3d.com/support/documentation/Manual/LightmappingCustomSettings.html
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LightmappingCustomSettings 
If you need a different baking setup than the one Unity is using by default, you can specify it by using custom Beast settings.  

Beast reads bake settings defined in xml format. Normally Unity generates the xml file based on the configuration you have chosen in Bake 

pane of the Lightmap Editor window and a number of other internal settings. You can override those settings by specifying your own 

settings in Beast's xml format.  

To have Unity automatically generate the xml file for you, click the tab menu in the upper-right corner of the Lightmap Editor window and 

select Generate Beast settings file. You will notice that the BeastSettings.xml file appeared in the project next to your lightmaps and that 

the Lightmap Editor informs you, that your xml settings will override Unity's settings during the next bake. Click the open button to edit your 

custom settings.  

 

Adaptive Sampling 

Beast uses an adaptive sampling scheme when sampling light maps. The light must differ more than a user set contrast threshold for Beast 

to place additional samples in an area. The sample area is defined by a Min and Max sample rate. The user sets the rate in the -4..4 range 

which means that Beast samples from 1/256 sample per pixel to 256 samples per pixel (the formula is 4^samplerate). It is recommended to 



use at least one sample per pixel for production use (Min sample rate = 0). Undersampling is most useful when doing camera renders or 

baking textures with big UV-patches. When Beast has taken all necessary samples for an area, the final pixel value is weighed together 

using a filter. The look the filter produces is dependent on the filter type used and the size of the filter kernel. The available filters are:  

 Box: Each sample is treated as equally important. The fastest filter to execute but it gives blurry results.  

 Triangle: The filter kernel is a tent which means that distant samples are consideredless important.  

 Gauss: Uses the Gauss function as filter kernel. This gives the best results (removes noise, preserves details).  

There are more filters available, but these three are the most useful. The kernel (filter) size is given in pixels in the range 1..3. Beast 

actually uses all sub pixels when filtering, which yields better results than doing it afterwards in Photoshop.  

  

AASettings 

samplingMode The sampling strategy to use. Default is Adaptive.� Adaptive: Adaptive anti-aliasing scheme for under/over 

sampling (from 1/256 up to 256 samples per pixel).� SuperSampling: Anti-aliasing scheme for super sampling 

(from 1 up to 128 samples per pixel). 

minSampleRate Sets the min sample rate, default is 0 (ie one sample per pixel). 

maxSampleRate Sets the max sample rate, the formula used is 4^maxSampleRate (1, 4, 16, 64, 256 samples per pixel) 

contrast The contrast value which controls if more samples are necessary - a lower value forces more samples. 

filter Sets which filter type to use. Most useful ones for Baking are Box, Triangle and Gauss. 

filterSize Sets the filter size in pixels, from 1 to 3. 

Texture Bake 

These settings help getting rid of any artifacts that are purely related to how lightmaps are rasterized and read from a texture.  

  

TextureBakeSettings 

edgeDilation Expands the rendered region with the number of pixels specified. This is needed to prevent the artifacts 

occurring when GPU filters in empty pixels from around the rendered region. 

bilinearFilter Is used to make sure that the data in the lightmap is "correct" when the GPU applies bilinear filtering. This is 

most noticable when the atlases are tightly packed. If there is only one pixel between two different UV patches, 

the bilinear functionality in Beast will make sure the that pixel is filled with the color from the correct patch. This 

minimizes light seams. 

conservativeRasterization Is used when the UV-chart does not cover the entire pixel. If such a layout is used, Beast may miss the texel by 

mistake. If conservative rasterization is used Beast will guarantee that it will find a UV-layout if present. Note 

that Beast will pick any UV-layout in the pixel. Conservative Rasterization often needs to be turned on if the UV 

atlases are tightly packed in low resolutions or if there are very thin objects present. 

bgColor The background color of the lightmap. 

Environment 

The environment settings in Beast control what happens if a ray misses all geometry in the scene. The environment can either be a 

constant color or an HDR image in lat-long format for Image Based Lighting (IBL). Note that environments should only be used for effects 

that can be considered to be infinitely far away, meaning that only the directional component matters.  

Defining an environment is usually a very good way to get very pleasing outdoor illumination results, but might also increase bake times.  

  
EnvironmentSettings 

giEnvironment The type of Environment: None, Skylight or IBL. 

giEnvironmentIntensity A scale factor for the intensity, used for avoiding gamma correction errors and to scale HDR textures to 

something that fits your scene. (in Unity: Sky Light Intensity) 

skyLightColor A constant environment color. Used if type is Skylight. It is often a good idea to keep the color below 1.0 in 

intensity to avoid boosting by gamma correction. Boost the intensity instead with the giEnvironmentIntensity 

setting. (in Unity: Sky Light Color) 

iblImageFile High-dynamic range IBL background image in Long-Lat format, .HDR or .EXR, absolute path. 

Shadows 

Settings for ray-traced shadows.  



  
RenderSettings 

bias An error threshold to avoid double intersections of shadow rays. For example, a shadow ray should not 

intersect the same triangle as the primary ray did, but because of limited numerical precision this can happen. 

The bias value moves the intersection point to eliminate this problem. If set to zero this value is computed 

automatically depending on the scene size. 

maxShadowRays The maximum number of shadow rays per point that will be used to generate a soft shadow for any light 

source. Use this to shorten render times at the price of soft shadow quality. This will lower the maximum 

number of rays sent for any light sources that have a shadowSamples setting higher than this value, but will not 

raise the number if shadowSamples is set to a lower value. 

maxRayDepth The maximum amount of bounces a ray can have before being considered done. A bounce can be a reflection 

or a refraction. Increase the value if a ray goes through many transparent triangles before hitting an opaque 

object and you get light in areas that should be in the shadow. Common failure case: trees with alpha-tested 

leaves placed in a shadow of a mountain. 

Global Illumination 

The Global Illumination system allows you to use two separate algorithms to calculate indirect lighting. You can for instance calculate 

multiple levels of light bounces with a fast algorithm like the Path Tracer, and still calculate the final bounce with Final Gather to get a fast 

high-quality global illumination render. Both subsystems have individual control of Intensity and Saturation to boost the effects if necessary.  

It's recommended to use FinalGather as the primary integrator and either None or PathTracer as the secondary integrator. Unity uses the 

first option (so final gather only) as the default, since it produces the best quality renders in most cases. Path Tracer should be used if many 

indirect bounces are needed and Final Gather-only solution with acceptable quality would take to much time to render.  

  

GISettings 

enableGI Setting to true enables Global Illumination. 

primaryIntegrator The integrator used for the final calculations of indirect light. FinalGather is default. 

secondaryIntegrator The integrator used for initial bounces of indirect light. Default is None, PathTracer is optional. 

primaryIntensity As a post process, converts the color of the primary integrator result from RGB to HSV and scales the V value. 

(in Unity: Bounce Intensity) 

primarySaturation As a post process, converts the color of the primary integrator result from RGB to HSV and scales the V value. 

secondaryIntensity As a post process, converts the color of the secondary integrator result from RGB to HSV and scales the S 

value. 

secondarySaturation As a post process, converts the color of the secondary integrator result from RGB to HSV and scales the S 

value. 

diffuseBoost This setting can be used to exaggerate light bouncing in dark scenes. Setting it to a value larger than 1 will 

push the diffuse color of materials towards 1 for GI computations. The typical use case is scenes authored with 

dark materials, this happens easily when doing only direct lighting since it's easy to compensate dark materials 

with strong light sources. Indirect light will be very subtle in these scenes since the bounced light will fade out 

quickly. Setting a diffuse boost will compensate for this. Note that values between 0 and 1 will decrease the 

diffuse setting in a similar way making light bounce less than the materials says, values below 0 is invalid. The 

actual computation taking place is a per component pow(colorComponent, (1.0 / diffuseBoost)). (in Unity: 

Bounce Boost) 

Final Gather 

The settings below control the quality or correctness of the Final Gather solution. The normal usage scenario is this:  

1. For each baking set up Contrast Threshold and Number of Rays may be adjusted. There are no perfect settings for these since 

they depend on the complexity of the geometry and light setup.  

2. Check Visibility and Light Leakage reduction are expensive operations and should only be used to remedy actual light leakage 

problems. These settings will only help if the light leakage is caused by the Global Illumination calculations. A very common light 

leakage situation occurs with a wall as a single plane with no thickness. The light leaking through in that situation does not come 

from GI.  

3. Gradient threshold should only be changed if there are white halos around corners.  

Steps 2 and 3 should not need much tweaking in most scenes.  



  
GISettings 

fgContrastThreshold Controls how sensitive the final gather should be for contrast differences between the points during 

precalculation. If the contrast difference is above this threshold for neighbouring points, more points will be 

created in that area. This tells the algorithmto place points where they are really needed, e.g. at shadow 

boundaries or in areas where the indirect light changes quickly. Hence this threshold controls the number of 

points created in the scene adaptively. Note that if a low number of final gather rays are used, the points will 

have high variance and hence a high contrast difference. In that the case contrast threshold needs to be raised 

to prevent points from clumping together or using more rays per sample. (in Unity: Contrast Threshold) 

fgRays The maximum number of rays taken in each Final Gather sample. More rays gives better results but take longer 

to evaluate. (in Unity: Final Gather Rays) 

fgCheckVisibility Turn this on to reduce light leakage through walls. When points are collected to interpolate between, some of 

them can be located on the other side of geometry. As a result light will bleed through the geometry. To prevent 

this Beast can reject points that are not visible. 

fgCheckVisibilityDepth Controls for how many bounces the visibility checks should be performed. Adjust this only if experiencing light 

leakage when using multi bounce Final Gather. 

fgLightLeakReduction This setting can be used to reduce light leakage through walls when using final gather as primary GI and path 

tracing as secondary GI. Leakage, which can happen when e.g. the path tracer filters in values on the other 

side of a wall, is reduced by using final gather as a secondary GI fallback when sampling close to walls or 

corners. When this is enabled a final gather depth of 3 will be used automatically, but the higher depths will only 

be used close to walls or corners. Note that this is only usable when path tracing is used as secondary GI. 

fgLightLeakRadius Controls how far away from walls the final gather will be called again, instead of the secondary GI. If 0.0 is used 

Beast will try to estimate a good value. If this does not eliminate the leakage it can be set to a higher value 

manually. 

fgGradientThreshold Controls how the irradiance gradient is used in the interpolation. Each point stores its irradiance gradient which 

can be used to improve the interpolation. In some situations using the gradient can result in white "halos" and 

other artifacts. This threshold can be used to reduce those artifacts (set it low or to 0). (in Unity: Interpolation) 

fgInterpolationPoints Sets the number of final gather points to interpolate between. A higher value will give a smoother result, but can 

also smooth out details. If light leakage is introduced through walls when this value is increased, checking the 

sample visibility solves that problem. (in Unity: Interpolation Points) 

fgNormalThreshold Controls how sensitive the final gather should be for differences in the points normals. A lower value will give 

more points in areas of high curvature. 

fgDepth Controls the number of indirect light bounces. A higher value gives a more correct result, but the cost is 

increased rendering time. For cheaper multi bounce GI, use Path Tracer as the secondary integrator instead of 

increasing depth. (in Unity: Bounces) 

fgAttenuationStart The distance where attenuation is started. There is no attenuation before this distance. This can be used to add 

a falloff effect to the final gather lighting. When fgAttenuationStop is set higher than 0.0 this is enabled. 

fgAttenuationStop Sets the distance where attenuation is stopped (fades to zero). There is zero intensity beyond this distance. To 

enable attenuation set this value higher than 0.0. The default value is 0.0. 

fgFalloffExponent This can be used to adjust the rate by which lighting falls off by distance. A higher exponent gives a faster 

falloff. 

fgAOInfluence Blend the Final Gather with Ambient Occlusion. Range between 0..1. 0 means no occlusion, 1 is full occlusion. 

If Final Gather is used with multiple depths or with Path Tracing as Secondary GI the result can become a bit 

"flat". A great way to get more contrast into the lighting is to factor in a bit of ambient occlusion into the 

calculation. This Ambient Occlusion algorithm affects only final gather calculations. The Ambient Occlusion 

exposed in the Lightmapping window is calculated differently - by a separate, geometry-only pass. 

fgAOMaxDistance Max distance for the occlusion rays. Beyond this distance a ray is considered to be unoccluded. Can be used to 

avoid full occlusion for closed scenes such as rooms or to limit the AO contribution to creases. 

fgAOContrast Can be used to adjust the contrast for ambient occlusion. 

fgAOScale A scaling of the occlusion values. Can be used to increase or decrease the shadowing effect. 

Path Tracer 

Use path tracing to get fast multi bounce global illumination. It should not be used as primary integrator for baking since the results are 

quite noisy which does not look good in light maps. It can be used as primary integrator to adjust the settings, to make sure the cache 

spacing and accuracy is good. The intended usage is to have it set as secondary integrator and have single bounce final gather as primary 

integrator. Accuracy and Point Size can be adjusted to make sure that the cache is sufficiently fine grained.  

  

GISettings 



ptAccuracy Sets the number of paths that are traced for each sample element (pixel, texel or vertex). For preview 

renderings, a low value like 0.5 to 0.1 can be used. This means that 1/2 to 1/10 of the pixels will generate a 

path. For production renderings values above 1.0 may be used, if necessary to get good quality. 

ptPointSize Sets the maximum distance between the points in the path tracer cache. If set to 0 a value will be calculated 

automatically based on the size of the scene. The automatic value will be printed out during rendering, which is 

a good starting value if the point size needs to be adjusted. 

ptCacheDirectLight When this is enabled the path tracer will also cache direct lighting from light sources. This increases 

performance since fewer direct light calculations are needed. It gives an approximate result, and hence can 

affect the quality of the lighting. For instance indirect light bounces from specular highlights might be lost. 

ptCheckVisibility Turn this on to reduce light leakage through walls. When points are collected to interpolate between, some of 

them can be located on the other side of geometry. As a result light will bleed through the geometry. To prevent 

this Beast can reject points that are not visible. Note: If using this turn off light leakage reduction for Final 

Gather. 
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LightmappingUV 
Unity will use UV2 for lightmaps, if the channel is present. Otherwise it will use primary UVs.  

Unity can unwrap your mesh for you to generate lightmap UVs. Just use the Generate Lightmap UVs setting in Mesh Import Settings.  

Advanced Options for Generate Lightmap UVs:  

  
Pack Margin The margin between neighboring patches, assuming the mesh will take entire 1024x1024 lightmap measured in 

pixels. That has great effect: to allow filtering, Lightmap will contain lighting information in texels near patch 

border. So to avoid light bleeding when applying Lightmap there should be some margin between patches. 

Hard Angle The angle between neighboring triangles, after which the edge between them will be considered hard edge and 

seam will be created. If you set it to 180 degrees all edges will be considered smooth: this is useful for organic 

models. The default value 88 degrees: this is useful for mechanical models 

Angle Error Maximum possible deviation of UVs angles from source geometry angles, in percentage. Basically it controls 

how similar triangles in uv space will be to triangles in original geometry (the value, the more similar triangles 

will be). Usually you wants it pretty low to avoid artifacts when applying Lightmap. Default is 8 percent. (This 

value goes from 0 to 100) 

Area Error Maximum possible deviation of UVs areas from source geometry areas, in percentage. Basically it controls how 

good relative triangle areas are preserved. Usually that is not very critical, and moving that up can allow to 

create less patches; although you should recheck that distortion do not deteriorate Lightmap quality, as that 

way triangles may have different resolution. Default is 15 percent. (This value goes from 0 to 100) 

If you prefer to provide your own UVs for lightmapping, remember that a good UV set for lightmapping:  

 Is contained within the [0,1]x[0,1] space  

 Has no overlapping faces.  

 Has low angle distortion, that is deviation of angles in UVs and in source geometry.  

 Has low area distortion, that is, relative scale of triangles is mostly preserved, unless you really want some areas to have bigger Lightmap 

Resolution.  

 Has enough margin between individual patches.  

Some examples of the hints suggested above:  

Angle distortion  

These screenshots were made for equal resolution, but with different uvs. Look at artefacts, and how the shape of light was slightly 

changed. There are only 4 triangles, actually, so shape distortion can be far uglier.  





 

Area distortion  

There are 2 spotlight with same parameters, the difference being only pointing to areas with different lightmap resolution, due to relative 

triangle scale being not preserved  
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Occlusion Culling 
Occlusion Culling is a feature that disables rendering of objects when they are not currently seen by the camera because they are obscured 

by other objects. This does not happen automatically in 3D computer graphics since most of the time objects farthest away from the camera 

are drawn first and closer objects are drawn over the top of them (this is called "overdraw"). Occlusion Culling is different from Frustum 

Culling. Frustum Culling only disables the renderers for objects that are outside the camera's viewing area but does not disable anything 

hidden from view by overdraw. Note that when you use Occlusion Culling you will still benefit from Frustum Culling.  



 

To the left, a scene with occlusion culling. To the right, the same scene without occlusion culling. 

The occlusion culling process will go through the scene using a virtual camera to build a hierarchy of potentially visible sets of objects. This 

data is used at runtime by each camera to identify what is visible and what is not. Equipped with this information, Unity will ensure only 

visible objects get sent to be rendered. This reduces the number of draw calls and increases the performance of the game.  

The data for occlusion culling is composed of cells. Each cell is a subdivision of the entire bounding volume of the scene. More specifically 

the cells form a binary tree. Occlusion Culling uses two trees, one for View Cells (Static Objects) and the other for Target Cells (Moving 

Objects). View Cells map to a list of indices that define the visible static objects which gives more accurate culling results for static objects.  

It is important to keep this in mind when creating your objects because you need a good balance between the size of your objects and the 

size of the cells. Ideally, you shouldn't have cells that are too small in comparison with your objects but equally you shouldn't have objects 

that cover many cells. You can sometimes improve the culling by breaking large objects into smaller pieces. However, you can still merge 

small objects together to reduce draw calls and, as long as they all belong to the same cell, occlusion culling will not be affected. The 

collection of cells and the visibility information that determines which cells are visible from any other cell is known as a PVS (Potentially 

Visible Set).  

Setting up Occlusion Culling 

In order to use Occlusion Culling, there is some manual setup involved. First, your level geometry must be broken into sensibly sized 

pieces. It is also helpful to lay out your levels into small, well defined areas that are occluded from each other by large objects such as 

walls, buildings, etc. The idea here is that each individual mesh will be turned on or off based on the occlusion data. So if you have one 

object that contains all the furniture in your room then either all or none of the entire set of furniture will be culled. This doesn't make nearly 

as much sense as making each piece of furniture its own mesh, so each can individually be culled based on the camera's view point.  

You need to tag all scene objects that you want to be part of the occlusion to Static in the Inspector. The fastest way to do this is to parent 

the objects you want to be Static to an Empty GameObject and set the parent as Static, choosing to affect children also when the option 

dialog appears on the screen. After they are tagged as Static you can unparent them from the Empty GameObject.  



 

The Static checkbox in the Inspector 

Next, open the Occlusion Culling inspector by clicking in Tools->Occlusion Culling.  

In the Inspector, you will find several values to tweak. These values are described below:-  

Occlusion Culling - Object 

 

Occlusion culling inspector object tab. 

The Object tab lets you create Occlusion Areas GameObjects. These areas let you specify where you want to use Occlusion culling.  

NOTE: By default if you don't create any occlusion areas, occlusion culling will be applied to the whole scene.  

Properties 

  

Quick Select Lets you select/create an Occlusion Area and quickly modify it. 

None This is the default value. 

Create New Creates a new Occlusion Area GameObject. 

When you hit Create New in the Quick Select drop down, Unity will automatically create an Occlusion Area and will remove the default area 

(the whole scene). Now you can start tweaking your Occlusion Area(s) to suit your needs.  



 

Occlusion Area inspector. 

Properties 

  
Size Defines the size of the Occlusion Area. 

Center Sets the center of the Occlusion Area. By default it is 0,0,0 and is located at the center of the box. 

Is View Volume Defines where the camera can be. Check this in order to occlude static objects that are inside this Occlusion 

Area. 

Is Target Volume Select this if you want to occlude moving objects. 

Target Resolution Determines how accurate the Occlusion Culling inside the area will be. This affects the size of the cells in an 

Occlusion Area. NOTE: This only affects Target Areas. 

Low This takes less time to calculate but is less accurate. 

Medium This gives a balance between accuracy and time taken to process the Occlusion culling data. 

High This takes longer time to calculate but has the better accuracy. 

Very High Use this value when you want to have more accuracy than high resolutions. Be aware that it takes more time. 

Extremely High Use this value when you want to have almost exact occlusion culling on your moveable objects. Note: This 

setting takes a lot of time to calculate. 

If the camera is out of a given occlusion area or any objects are outside the area, these objects will not be occluded.  

Occlusion Culling - Bake 

 

Occlusion culling inspector bake tab. 

Properties 

  

View Cell Size Size of each view area cell. A smaller value produces more accurate occlusion culling. The value is a tradeoff 

between occlusion accuracy and storage size 



Near Clip Plane Near clip plane should be set to the smallest near clip plane that will be used in the game of all the cameras. 

Far Clip Plane Far Clip Plane used to cull the objects. Any object whose distance is greater than this value will be occluded 

automatically.(Should be set to the largest far clip planed that will be used in the game of all the cameras) 

Quality Determines the quality/accuracy when occluding objects. 

Preview Use this during development (ie, it is inaccurate but will give you an idea of how the occlusion culling will 

behave in your game) 

Production Use this when you are deploying your game (it takes more time but is more accurate) 

When you have finished tweaking these values you can click on the Bake Button to start processing the Occlusion Culling data. If you are 

not satisfied with the results, you can click on the Clear button to remove previously calculated data.  

Occlusion Culling - Visualization 

 

Occlusion culling inspector visualization tab. 

Properties 

  
Quick Select Lets you quickly select any camera in the scene to see how its Occlusion Culling will behave. 

The near and far planes define a virtual camera that is used to calculate the occlusion data. If you have several cameras with different near 

or far planes, you should use the smallest near plane and the largest far plane distance of all cameras for correct inclusion of objects.  

All the objects in the scene affect the size of the bounding volume so try to keep them all within the visible bounds of the scene.  

When you're ready to generate the occlusion data, click the Bake button. Remember to decide between Preview and Production on the 

Quality selection box in the Bake tab. Preview is the quickest way to generate data and should be used to test your view areas in the 

authoring tool. Production should be used for a test run on your target platfrom (e.g. iPhone) when are you ready to release.  

Bear in mind that the time taken to build the occlusion data will depend on the cell levels, the data size and the quality you have chosen. 

Unity will show the status of the PVS generation at the bottom of the main window.  

After the processing is done, you should see some colorful cubes in the View Area. The colored areas are regions that share the same 

occlusion data.  

Click on Clear if you want to remove all the pre-calculated data for Occlusion Culling.  

Moving Objects 

To apply occlusion culling to moving objects you have to create an Occlusion Area and then modify its size to fit the space where the 

moving objects will be located (of course the moving objects cannot be marked as static).  

After creating the Occlusion Area, just check the Is Target Volume checkbox to occlude moving objects.  



 

Occlusion Area properties for moving objects. 

  

Size Defines the size of the Occlusion Area. 

Center Sets the center of the Occlusion Area. By default this is 0,0,0 and is located in the center of the box. 

Is View Volume Defines where the camera can be. Check this in order to occlude static objects that are inside this Occlusion 

Area. 

Is Target Volume Select this when you want to occlude moving objects. 

Target Resolution Determines how accurate the occlusion culling inside the area will be. This affects the size of the cells in an 

Occlusion Area. NOTE: This only affects Target Areas. 

Low This takes less time to calculate but is less accurate. 

Medium This gives a balance between accuracy and time taken to process the occlusion culling data. 

High This takes longer to calculate but has better accuracy. 

Very High Use this value when you want to have more accuracy than high resolutions, be aware it takes more time. 

Extremely High Use this value when you want to have almost exact occlusion culling on your moveable objects. Note: This 

setting takes a lot of time to calculate. 

After you have added the Occlusion Area, you need to see how it divides the box into cells. To see how the occlusion area will be 

calculated on moving objects, you must select the Target and deselect the View button in the Scene View while you have the Occlusion 

Culling Inspector open.  

 

Selecting Target (moving objects) or View (static objects) lets you preview how the calculated data behaves. 

Testing the generated occlusion 

After your occlusion is set up, you can test it by enabling the Cull Geometry option (in the Occlusion Culling window) and moving the Main 

Camera around in the scene view.  

 

The Occlusion View mode in Scene View 

As you move the Main Camera around (whether or not you are in Play mode), you'll see various objects disable themselves. The thing you 

are looking for here is any error in the occlusion data. You'll recognize an error if you see objects suddenly popping into view as you move 

around. If this happens, your options for fixing the error are either to change the resolution (if you are playing with target volumes) or to 

move objects around to cover up the error. To debug problems with occlusion, you can move the Main Camera to the problematic position 

for spot-checking.  



When the processing is done, you should see some colorful cubes in the View Area. The blue cubes represent the cell divisions for Target 

Volumes. The white cubes represent cell divisions for View Volumes. If the parameters were set correctly you should see some objects 

not being rendered. This will be because they are either outside of the view frustum of the camera or else occluded from view by other 

objects.  

After occlusion is completed, if you don't see anything being occluded in your scene then try breaking your objects into smaller pieces so 

they can be completely contained inside the cells.  
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Loading Resources at Runtime 
There are a number of scenarios where you want to include some kind of asset in your finished game that is not included inside the primary 

game executable: standalone, web player or your iOS/Android application. For example, one scenario is to slim down a web player's 

download size, and dynamically download and instantiate individual objects or items. This way only the necessary objects are loaded by 

the end-user. Another scenario might be for downloadable content like additional weapons, environments, characters, or even full levels.  

In Unity Pro/iOS Advanced/Android Advanced, you can choose between two options for accomplishing these tasks: Asset Bundles, and 

Resource Folders. Non-Pro/Advanced license holders can use Resource Folders only.  

Asset Bundles (Unity Pro-only/iOS Advanced/Android Advanced licenses only) 

An Asset Bundle is an external collection of assets. You can have many Asset Bundles and therefore many different external collections of 

assets. These files exist outside of the built Unity player, usually sitting on a web server for end-users to access dynamically.  

To build an Asset Bundle, you call BuildPipeline.BuildAssetBundle() from inside an Editor script. In the arguments, you specify an array of 

Objects to be included in the built file, along with some other options. This will build a file that you can later load dynamically in the runtime 

by using AssetBundle.Load().  

Resource Folders 

Resource Folders are collections of assets that are included in the built Unity player, but are not necessarily linked to any GameObject in 

the Inspector.  

To put anything into a Resource Folder, you simply create a new folder inside the Project View, and name the folder "Resources". You can 

have multiple Resource Folders organized differently in your Project. Whenever you want to load an asset from one of these folders, you 

call Resources.Load().  

If your target deployable is a Streaming Web Player, you can define which scene will include everything in your Resource Folders. You do 

this in the Player Settings, accessible via Edit->Project Settings->Player. Set the First Streamed Level With Resources parameter, 

and all assets in your Resource Folders will be loaded when this level streams in to the end-user.  

Note: 

All assets found in the Resources folders and their dependencies are stored in a file called resources.assets. If an asset is already used by 

another level it is stored in the .sharedAssets file for that level. The Edit -> PlayerSettings 'First Streamed Level' setting determines the 

level at which the resources.assets will be collected and included in the build.  

If a level prior to "First streamed Level" is including an asset in a Resource folder, the asset will be stored in assets for that level. if it is 

included afterwards, the level will reference the asset from the "resources.assets" file.  

Only assets that are in the Resources folder can be accessed through Resources.Load. However many more assets might end up in the 

"resources.assets" file since they are dependencies. (For example a Material in the Resources folder might reference a Texture outside of 

the Resources folder)  

http://unity3d.com/support/documentation/ScriptReference/BuildPipeline.BuildAssetBundle.html
http://unity3d.com/support/documentation/ScriptReference/AssetBundle.Load.html
http://unity3d.com/support/documentation/ScriptReference/Resources.Load.html


Resource Unloading 

You can unload resources of an AssetBundle by calling AssetBundle.Unload(). If you pass true for the unloadAllLoadedObjects 

parameter, both the objects held internally by the AssetBundle and the ones loaded from the AssetBundle using AssetBundle.Load() will be 

destroyed and memory used by the bundle will be released.  

Sometimes you may prefer to load an AssetBundle, instantiate the objects desired and release the memory used up by the bundle while 

keeping the objects around. The benefit is that you free up memory for other tasks, for instance loading another AssetBundle. In this 

scenario you would pass false as the parameter. After the bundle is destroyed you will not be able to load objects from it any more.  

If you want to destroy scene objects loaded using Resources.Load() prior to loading another level, call Object.Destroy() on them. To 

release assets, use Resources.UnloadUnusedAssets().  
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Modifying Source Assets Through Scripting 

Automatic Instantiation 

Usually when you want to make a modification to any sort of game asset, you want it to happen at runtime and you want it to be temporary. 

For example, if your character picks up an invincibility power-up, you might want to change the shader of the material for the player 

character to visually demonstrate the invincible state. This action involves modifying the material that's being used. This modification is not 

permanent because we don't want the material to have a different shader when we exit Play Mode.  

However, it is possible in Unity to write scripts that will permanently modify a source asset. Let's use the above material example as a 

starting point.  

To temporarily change the material's shader, we change the shader property of the material component.  

 private var invincibleShader = Shader.Find ("Specular"); 

 

 function StartInvincibility { 

  renderer.material.shader = invincibleShader; 

 } 

When using this script and exiting Play Mode, the state of the material will be reset to whatever it was before entering Play Mode initially. 

This happens because whenever renderer.material is accessed, the material is automatically instantiated and the instance is returned. This 

instance is simultaneously and automatically applied to the renderer. So you can make any changes that your heart desires without fear of 

permanence.  

Direct Modification 

IMPORTANT NOTE 

The method presented below will modify actual source asset files used within Unity. These modifications are not undoable. Use them with 

caution.  

Now let's say that we don't want the material to reset when we exit play mode. For this, you can use renderer.sharedMaterial. The 

sharedMaterial property will return the actual asset used by this renderer (and maybe others).  

The code below will permanently change the material to use the Specular shader. It will not reset the material to the state it was in before 

Play Mode.  

 private var invincibleShader = Shader.Find ("Specular"); 

http://unity3d.com/support/documentation/ScriptReference/AssetBundle.Unload.html
http://unity3d.com/support/documentation/ScriptReference/AssetBundle.Load.html
http://unity3d.com/support/documentation/ScriptReference/Resources.Load.html
http://unity3d.com/support/documentation/ScriptReference/Object.Destroy.html
http://unity3d.com/support/documentation/ScriptReference/Resources.UnloadUnusedAssets.html
http://unity3d.com/support/documentation/ScriptReference/Renderer.html
http://unity3d.com/support/documentation/ScriptReference/Renderer-material.html
http://unity3d.com/support/documentation/ScriptReference/Material.html
http://unity3d.com/support/documentation/ScriptReference/Renderer-sharedMaterial.html


 

 function StartInvincibility { 

  renderer.sharedMaterial.shader = invincibleShader; 

 } 

As you can see, making any changes to a sharedMaterial can be both useful and risky. Any change made to a sharedMaterial will be 

permanent, and not undoable.  

Applicable Class Members 

The same formula described above can be applied to more than just materials. The full list of assets that follow this convention is as 

follows:  

 Materials: renderer.material and renderer.sharedMaterial  

 Meshes: meshFilter.mesh and meshFilter.sharedMesh  

 Physic Materials: collider.material and collider.sharedMaterial  

Direct Assignment 

If you declare a public variable of any above class: Material, Mesh, or Physic Material, and make modifications to the asset using that 

variable instead of using the relevant class member, you will not receive the benefits of automatic instantiation before the modifications are 

applied.  

Assets that are not automatically instantiated 

 

Desktop  
 

There are two different assets that are never automatically instantiated when modifying them.  

 Texture2D  

 TerrainData  

Any modifications made to these assets through scripting are always permanent, and never undoable. So if you're changing your terrain's 

heightmap through scripting, you'll need to account for instantiating and assigning values on your own. Same goes for Textures. If you 

change the pixels of a texture file, the change is permanent.  

 

iOS 
 

Texture2D assets are never automatically instantiated when modifying them. Any modifications made to these assets through scripting are 

always permanent, and never undoable. So if you change the pixels of a texture file, the change is permanent.  

 

Android 
 

Texture2D assets are never automatically instantiated when modifying them. Any modifications made to these assets through scripting are 

always permanent, and never undoable. So if you change the pixels of a texture file, the change is permanent.  
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Generating Mesh Geometry Procedurally 
The Mesh class gives script access to an object's mesh geometry, allowing meshes to be created or modified at runtime. This technique is 

useful for graphical effects (eg, stretching or squashing an object) but can also be useful in level design and optimisation. The following 

sections explain the basic details of how a mesh is constructed along with an exploration of the API and an example.  

 Anatomy of a Mesh  

 Using the Mesh Class  

 Example: Creating a Billboard Plane  
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Anatomy of a Mesh 
A mesh consists of triangles arranged in 3D space to create the impression of a solid object. A triangle is defined by its three corner points 

or vertices. In the Mesh class, the vertices are all stored in a single array and each triangle is specified using three integers that correspond 

to indices of the vertex array. The triangles are also collected together into a single array of integers; the integers are taken in groups of 

three from the start of this array, so elements 0, 1 and 2 define the first triangle, 3, 4 and 5 define the second, and so on. Any given vertex 

can be reused in as many triangles as desired but there are reasons why you may not want to do this, as explained below.  

Lighting and Normals 

The triangles are enough to define the basic shape of the object but extra information is needed to display the mesh in most cases. To 

allow the object to be shaded correctly for lighting, a normal vector must be supplied for each vertex. A normal is a vector that points 

outward, perpendicular to the mesh surface at the position of the vertex it is associated with. During the shading calculation, each vertex 

normal is compared with the direction of the incoming light, which is also a vector. If the two vectors are perfectly aligned, then the surface 

is receiving light head-on at that point and the full brightness of the light will be used for shading. A light coming exactly side-on to the 

normal vector will give no illumination to the surface at that position. Typically, the light will arrive at an angle to the normal and so the 

shading will be somewhere in between full brightness and complete darkness, depending on the angle.  

 

Since the mesh is made up of triangles, it may seem that the normals at corners will simply be perpendicular to the plane of their triangle. 

However, normals are actually interpolated across the triangle to give the surface direction of the intermediate positions between the 

corners. If all three normals are pointing in the same direction then the triangle will be uniformly lit all over. The effect of having separate 

triangles uniformly shaded is that the edges will be very crisp and distinct. This is exactly what is required for a model of a cube or other 

sharp-edged solid but the interpolation of the normals can be used to create smooth shading to approximate a curved surface.  

To get crisp edges, it is necessary to double up vertices at each edge since both of the two adjacent triangles will need their own separate 

normals. For curved surfaces, vertices will usually be shared along edges but a bit of intuition is often required to determine the best 

http://unity3d.com/support/documentation/Manual/Anatomy%20of%20a%20Mesh.html
http://unity3d.com/support/documentation/Manual/Using%20the%20Mesh%20Class.html
http://unity3d.com/support/documentation/Manual/Example:%20Creating%20a%20Billboard%20Plane.html


direction for the shared normals. A normal might simply be the average of the normals of the planes of the surrounding triangles. However, 

for an object like a sphere, the normals should just be pointing directly outward from the sphere's centre.  

By calling Mesh.RecalculateNormals, you can get Unity to work out the normals' directions for you by making some assumptions about the 

"meaning" of the mesh geometry; it assumes that vertices shared between triangles indicate a smooth surface while doubled-up vertices 

indicate a crisp edge. While this is not a bad approximation in most cases, RecalculateNormals will be tripped up by some texturing 

situations where vertices must be doubled even though the surface is smooth.  

Texturing 

In addition to the lighting, a model will also typically make use of texturing to create fine detail on its surface. A texture is a bit like an image 

printed on a stretchable sheet of rubber. For each mesh triangle, a triangular area of the texture image is defined and that texture triangle is 

stretched and "pinned" to fit the mesh triangle. To make this work, each vertex needs to store the coordinates of the image position that will 

be pinned to it. These coordinates are two dimensional and scaled to the 0..1 range (0 means the bottom/left of the image and 1 means the 

right/top). To avoid confusing these coordinates with the Cartesian coordinates of the 3D world, they are referred to as U and V rather than 

the more familiar X and Y, and so they are commonly called UV coordinates.  

Like normals, texture coordinates are unique to each vertex and so there are situations where you need to double up vertices purely to get 

different UV values across an edge. An obvious example is where two adjacent triangles use discontinuous parts of the texture image 

(eyes on a face texture, say). Also, most objects that are fully enclosed volumes will need a "seam" where an area of texture wraps around 

and joins together. The UV values at one side of the seam will be different from those at the other side.  
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Using the Mesh Class 
The Mesh class is the basic script interface to an object's mesh geometry. It uses arrays to represent the vertices, triangles, normals and 

texture coordinates and also supplies a number of other useful properties and functions to assist mesh generation.  

Accessing an Object's Mesh 

The mesh data is attached to an object using the Mesh Filter component (and the object will also need a Mesh Renderer to make the 

geometry visible). This component is accessed using the familiar GetComponent function:-  

var mf: MeshFilter = GetComponent(MeshFilter); 

// Use mf.mesh to refer to the mesh itself. 

Adding the Mesh Data 

The Mesh object has properties for the vertices and their associated data (normals and UV coordinates) and also for the triangle data. The 

vertices may be supplied in any order but the arrays of normals and UVs must be ordered so that the indices all correspond with the 

vertices (ie, element 0 of the normals array supplies the normal for vertex 0, etc). The vertices are Vector3s representing points in the 

object's local space. The normals are normalised Vector3s representing the directions, again in local coordinates. The UVs are specified as 

Vector2s, but since the Vector2 type doesn't have fields called U and V, you must mentally convert them to X and Y respectively.  

The triangles are specified as triples of integers that act as indices into the vertex array. Rather than use a special class to represent a 

triangle the array is just a simple list of integer indices. These are taken in groups of three for each triangle, so the first three elements 

define the first triangle, the next three define the second triangle, and so on. An important detail of the triangles is the ordering of the corner 

vertices. They should be arranged so that the corners go around clockwise as you look down on the visible outer surface of the triangle, 

although it doesn't matter which corner you start with.  
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Example: Creating a Billboard Plane 
Unity comes with a Plane primitive object but a simpler plane may be useful in 2D games or GUI, and in any case makes a good starting 

example. A minimal plane will consist of four vertices to define the corners along with two triangles.  

The first thing is to set the vertices array. We'll assume that the plane lies in the X and Y axes and let its width and height be determined by 

parameter variables. We'll supply the vertices in the order bottom-left, bottom-right, top-left, top-right.  

 

var vertices: Vector3[] = new Vector3[4]; 

 

vertices[0] = new Vector3(0, 0, 0); 

vertices[1] = new Vector3(width, 0, 0); 

vertices[2] = new Vector3(0, height, 0); 

vertices[3] = new Vector3(width, height, 0); 

 

mesh.vertices = vertices; 

(Since the Mesh data properties execute code behind the scenes, it is much more efficient to set up the data in your own array and then 

assign this to a property rather than access the property array element by element.)  

Next come the triangles. Since we want two triangles, each defined by three integers, the triangles array will have six elements in total. 

Remembering the clockwise rule for ordering the corners, the lower left triangle will use 0, 2, 1 as its corner indices, while the upper right 

one will use 2, 3, 1.  

var tri: int[] = new int[6]; 

 

// Lower left triangle. 

tri[0] = 0; 

tri[1] = 2; 

tri[2] = 1; 

 

// Upper right triangle.  



tri[3] = 2; 

tri[4] = 3; 

tri[5] = 1; 

 

mesh.triangles = tri; 

A mesh with just the vertices and triangles set up will be visible in the editor but will not look very convincing since it is not correctly shaded 

without the normals. The normals for the flat plane are very simple - they are all identical and point in the negative Z direction in the plane's 

local space. With the normals added, the plane will be correctly shaded but remember that you need a light in the scene to see the effect.  

var normals: Vector3[] = new Vector3[4]; 

 

normals[0] = -Vector3.forward; 

normals[1] = -Vector3.forward; 

normals[2] = -Vector3.forward; 

normals[3] = -Vector3.forward; 

 

mesh.normals = normals; 

Finally, adding texture coordinates to the mesh will enable it to display a material correctly. Assuming we want to show the whole image 

across the plane, the UV values will all be 0 or 1, corresponding to the corners of the texture.  

var uv: Vector2[] = new Vector2[4]; 

 

uv[0] = new Vector2(0, 0); 

uv[1] = new Vector2(1, 0); 

uv[2] = new Vector2(0, 1); 

uv[3] = new Vector2(1, 1); 

 

mesh.uv = uv; 



The complete script might look a bit like this:-  

var width: float; 

var height: float; 

 

function Start() {  

 var mf: MeshFilter = GetComponent(MeshFilter); 

 var mesh = new Mesh(); 

 mf.mesh = mesh; 

 

 var vertices: Vector3[] = new Vector3[4]; 

 

 vertices[0] = new Vector3(0, 0, 0); 

 vertices[1] = new Vector3(width, 0, 0); 

 vertices[2] = new Vector3(0, height, 0); 

 vertices[3] = new Vector3(width, height, 0); 

 

 mesh.vertices = vertices; 

 

 var tri: int[] = new int[6]; 

 

 tri[0] = 0; 

 tri[1] = 2; 

 tri[2] = 1; 

 



 tri[3] = 2; 

 tri[4] = 3; 

 tri[5] = 1; 

 

 mesh.triangles = tri; 

 

 var normals: Vector3[] = new Vector3[4]; 

 

 normals[0] = -Vector3.forward; 

 normals[1] = -Vector3.forward; 

 normals[2] = -Vector3.forward; 

 normals[3] = -Vector3.forward; 

 

 mesh.normals = normals; 

 

 var uv: Vector2[] = new Vector2[4]; 

 

 uv[0] = new Vector2(0, 0); 

 uv[1] = new Vector2(1, 0); 

 uv[2] = new Vector2(0, 1); 

 uv[3] = new Vector2(1, 1); 

 

 mesh.uv = uv; 

} 



Note that the if the code is executed once in the Start function then the mesh will stay the same throughout the game. However, you can 

just as easily put the code in the Update function to allow the mesh to be changed each frame (although this will increase the CPU 

overhead considerably).  
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Execution Order 
In Unity scripting, there are a number of event functions that get executed in a predetermined order as a script executes. This execution 

order is described below:  

First Scene Load 
These functions get called when a scene starts (once for each object in the scene).  

 Awake: This function is always called before any Start functions and also just after a prefab is instantiated.  

 OnEnable: (only called if the Object is active): This function is called just after the object is enabled.  

Before the first frame update 

 Start: Start is called before the first frame update only if the script instance is enabled.  

Update Order 
When you're keeping track of game logic and interactions, animations, camera positions, etc., there are a few different events you can use. 

The common pattern is to perform most tasks inside the Update() function, but there are also other functions you can use.  

 FixedUpdate: FixedUpdate() is often called more frequently than Update(). It can be called multiple times per frame, if the frame rate is 

low and it may not be called between frames at all if the frame rate is high. All physics calculations and updates occur immediately after 

FixedUpdate(). When applying movement calculations inside FixedUpdate(), you do not need to multiply your values by Time.deltaTime. 

This is because FixedUpdate() is called on a reliable timer, independent of the frame rate.  

 Update: Update() is called once per frame. It is the main workhorse function for frame updates.  

 LateUpdate: LateUpdate() is called once per frame, after Update() has finished. Any calculations that are performed in Update() will have 

completed when LateUpdate() begins. A common use for LateUpdate() would be a following third-person camera. If you make your 

character move and turn inside Update(), you can perform all camera movement and rotation calculations in LateUpdate(). This will ensure 

that the character has moved completely before the camera tracks its position.  

Rendering 

 OnPreCull: Called before the camera culls the scene. Culling determines which objects are visible to the camera. OnPreCull is called just 

before culling takes place.  

 OnBecameVisible/OnBecameInvisible: Called when an object becomes visible/invisible to any camera.  

 OnWillRenderObject: Called once for each camera if the object is visible.  

 OnPreRender: Called before the camera starts rendering the scene.  

 OnRenderObject: Called after all regular scene rendering is done. You can use GL class or Graphics.DrawMeshNow to draw custom 

geometry at this point.  

 OnPostRender: Called after a camera finishes rendering the scene.  

 OnRenderImage(Pro only): Called after scene rendering is complete to allow postprocessing of the screen image.  

 OnGUI: Called multiple times per frame in response to GUI events. The Layout and Repaint events are processed first, followed by a 

Layout and keyboard/mouse event for each input event.  

 OnDrawGizmos Used for drawing Gizmos in the scene view for visualisation purposes.  

Coroutine 



Normal coroutine updates are run after the Update function returns. A coroutine is function that can suspend its execution (yield) until the 

given given YieldInstruction finishes. Different uses of Coroutines:  

 yield; The coroutine will continue after all Update functions have been called on the next frame.  

 yield WaitForSeconds(2); Continue after a specified time delay, after all Update functions have been called for the frame  

 yield WaitForFixedUpdate(); Continue after all FixedUpdate has been called on all scripts  

 yield WWW Continue after a WWW download has completed.  

 yield StartCoroutine(MyFunc); Chains the coroutine, and will wait for the MyFunc coroutine to complete first.  

When Quitting 
These functions get called on all the active objects in your scene, :  

 OnApplicationQuit: This function is called on all game objects before the application is quit. In the editor it is called when the user stops 

playmode. In the web player it is called when the web view is closed.  

 OnDisable: This function is called when the behaviour becomes disabled or inactive.  

So in conclusion, this is the execution order for any given script: 

 All Awake calls  

 All Start Calls  

 while (stepping towards variable delta time)  

o All FixedUpdate functions  

o Physics simulation  

o OnEnter/Exit/Stay trigger functions  

o OnEnter/Exit/Stay collision functions  

 Rigidbody interpolation applies transform.position and rotation  

 OnMouseDown/OnMouseUp etc. events  

 All Update functions  

 Animations are advanced, blended and applied to transform  

 All LateUpdate functions  

 Rendering  

Hints 

 If you start a coroutine in LateUpdate it will also be called after LateUpdate just before rendering.  

 Coroutines are executed after all Update functions.  
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Optimizing Graphics Performance 
 

Desktop  
 

Making your game run smoothly is critical to its success. Thankfully Unity is there for you! We have spent a lot of time and energy making 

Unity iOS run fast on a wide variety of hardware. Below are some simple guidelines to maximizing the speed of your game.  

In Summary - Combine, Combine, Combine 

 If you care about performance, combine meshes.  

 If you care about performance, make sure all of your combined meshes also share the same material and texture.  
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 The Profiler and Rendering Statistics window are very helpful!  

In Detail: 

Modern graphics cards are really good at pushing a lot of polygons, but they have quite a bit of overhead for every batch that you submit to 

the graphics card. So if you have a 100-triangle object it is going to be just as expensive to render as a 1500-triangle object. The "sweet 

spot" for optimal rendering performance is somewhere around 1500-4000 triangles per mesh.  

You only pay a rendering cost for objects that have a Mesh Renderer attached. And you only pay for those that are within the view 

frustum. There is no rendering cost from having a lot of empty GameObjects in your scene.  

 The best way to improve rendering performance is to combine objects together so each mesh has around 1500 or more triangles and uses 

only one Material for the entire mesh.  

It is important to understand that just combining two objects which don't share a material does not give you any performance increase at all. 

If you want to combine effectively, you need to make sure your mesh uses only one material after you have combined it.  

There is, however, one thing to be aware of when combining objects: if you use a lot of small lights in your scene, it might make sense to 

combine only objects that are close to each other.  

The rendering cost for a mesh that has multiple materials is the same as having multiple renderers for each material. The most common 

reason why you have multiple materials is that two meshes don't share the same textures. So, if you want to optimize rendering 

performance, you need to make sure that the objects you combine share textures.  

 Unity is very good at pushing lots of polygons. Unity uploads all geometry to the graphics card for good cache utilization and optimal data 

alignment.  

 You simply have to make sure that the graphics card doesn't have to handle large numbers of batches.  

 If you use Forward rendering path, the number of Pixel Lights affecting an object heavily affects performance.  

Pixel Lights in Forward Rendering Path 

Note: this applies only to Forward rendering path.  

If you use pixel lighting, then each GameObject has to be rendered as many times as there are pixel lights that affect the object. If you 

combine two objects that are very far apart, it might increase the size of the object and now you have a lot of lights affecting this big object. 

If your objects were separate however, the light won't have to be applied on the part of the mesh which is far away. This can result in 

rendering the combined mesh as many times as the uncombined mesh (thus not saving anything). For this reason, you should keep 

GameObjects that are very far away as individual Meshes.  

When rendering a mesh, Unity finds all lights surrounding the mesh. It then figures out what lights affect the mesh the most. The 

QualitySettings are used to modify how many of the lights end up as pixel lights and how many as vertex lights.  

Every light calculates its importance based on how far away it is from the mesh and how intense it is.  

Some lights are more important than others depending on the game context. For this reason, every light has a Render Mode setting which 

can be set to Important or Not Important.  

Imagine the player's car with head lights driving through the night. The head lights are the most important light in the game. For this reason, 

the head lights Render Mode should be set to Important.  

If you have a light that is not very important and also visually doesn't gain much from being a pixel light, set the lights Render Mode to Not 

Important. This way, you don't waste rendering performance or lose any visual quality.  

Per-Layer Cull Distances 
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You might want to cull small objects earlier to reduce number of draw calls. For example, small rocks and debris could be made invisible at 

much smaller distance than large buildings. To do that, put small objects into a separate layer and setup per-layer cull distances using the 

Camera.layerCullDistances script function.  

Shadows 

If you are deploying for Desktop platforms then you should pay attention to shadows; shadows are generally expensive. They can add a lot 

of performance overhead to your game if they are not used correctly. For more details about shadows, please read the Shadows page.  

Note: Remember that shadows are not currently supported on iOS or Android devices.  

See Also 

 Modeling Optimized Characters  

 Rendering Statistics Window  

 

iOS 
 

If you want to optimize your content for iOS, then it is beneficial for you to learn more about iOS hardware devices.  

Alpha-Testing 

Contrary to the desktop, alpha-testing (or use of discard / clip operation in pixel shader) is very expensive on iOS. If you can replace your 

alpha-test shader with alpha-blend, do so. If you absolutely need to use alpha-testing, then you should keep areas of visible alpha-tested 

pixels to a minimum.  

Vertex Performance 

Generally you should aim at 40K or less vertices visible per frame when targeting iPhone 3GS or newer devices. You should aim at 10K or 

less vertices visible per frame when targeting older devices equipped with MBX GPU, such as: iPhone, iPhone 3G, iPod Touch 1st and 2nd 

Generation.  

Lighting Performance 

Per-pixel dynamic lighting will add significant cost to every affected pixel and can lead to rendering object in multiple passes. Avoid having 

more than one Pixel Light affecting any single object, prefer it to be a directional light. Note that Pixel Light is a light which has a Render 

Mode setting set to Important.  

Per-vertex dynamic lighting can add significant cost to vertex transformations. Avoid multiple lights affecting single objects. Bake lighting for 

static objects.  

Optimize Model Geometry 

When optimizing the geometry of a model, there are two basic rules:  

 Don't use excessive amount of faces if you don't have to  

 Keep the number of UV mapping seams and hard edges as low as possible  

Note that the actual number of vertices that graphics hardware has to process is usually not the same as what is displayed in a 3D 

application. Modeling applications usually display the geometric vertex count, i.e. number of points that make up a model.  

For a graphics card however, some vertices have to be split into separate ones. If a vertex has multiple normals (it's on a "hard edge"), or 

has multiple UV coordinates, or has multiple vertex colors, it has to be split. So the vertex count you see in Unity is almost always different 

from the one displayed in 3D application.  

http://unity3d.com/support/documentation/Components/Layers.html
http://unity3d.com/support/documentation/ScriptReference/Camera-layerCullDistances.html
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Texture Compression 

Use iOS native PVRT compression formats. They will not only decrease the size of your textures (resulting in faster load times and smaller 

memory footprint), but also can dramatically increase your rendering performance! Compressed texture requires only a fraction of memory 

bandwidth compared to full blown 32bit RGBA textures. For performance comparison check iOS Hardware Guide.  

Some images are prone to visual artifacts in alpha channels of PVRT compressed textures. In such case you might want to tweak PVRT 

compression parameters directly in your imaging software. You can do that by installing PVR export plugin or using PVRTexTool from 

Imagination Tech -- creators of PVRT format. Resulting compressed image with .pvr extension will be imported by Unity Editor as is and 

manually specified compression parameters will be preserved.  

If PVRT compression formats do not deliver enough visual quality and you need extra crisp imaging (for example UI textures), then you 

should consider using 16bit texture over full 32bit RGBA texture. At least you will reduce memory bandwidth by half.  

Tips for writing well performing shaders 

Although GPUs fully support pixel and vertex shaders since iPhone 3GS, do not expect to grab a desktop shader with complex per-pixel 

functionality and run it on iOS device at 30 frames per second. Most often shaders will have to be hand optimized, calculations and texture 

reads kept to a minimum in order to achieve good frame rates.  

Complex arithmetic operations 

Arithmetic operations such as pow, exp, log, cos, sin, tan etc heavily tax GPU. Rule of thumb is to have not more than one such operation 

per fragment. Consider that sometimes lookup textures could be a better alternative.  

Do NOT try to roll your own normalize, dot, inversesqrt operations however. Always use built-in ones -- this was driver will generate much 

better code for you.  

Keep in mind that discard operation will make your fragments slower.  

Floating point operations 

Always specify precision of the floating point variables while writing custom shaders. It is crucial to pick smallest possible format in order to 

achieve best performance.  

If shader is written in GLSL ES, then precision is specified as following:  

 highp - full 32 bits floating point format, well suitable for vertex transformations, slowest  

 mediump - reduced 16 bits floating point format, well suitable for texture UV coordinates, roughly x2 faster than highp  

 lowp - 10 bits fixed point format, well suitable for colors, lighting calculation and other high performant operations, roughly x4 faster than 

highp  

If shader is written in CG or it is a surface shader, then precision is specified as following:  

 float - analogous to highp in GLSL ES, slowest  

 half - analogous to mediump in GLSL ES, roughly x2 faster than float  

 fixed - analogous to lowp in GLSL ES, roughly x4 faster than float  

For more details about general shader performance, please read the Shader Performance page.  

Hardware documentation 

Take your time to study Apple documentations on hardware and best practices for writing shaders. Note that we would suggest to be more 

aggressive with floating point precision hints however.  

Bake Lighting into Lightmaps 

http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/Manual/iphone-Hardware.html
http://www.imgtec.com/powervr/insider/powervr-pvrtextool.asp
http://unity3d.com/support/documentation/Components/SL-ShaderPerformance.html
http://developer.apple.com/library/ios/#documentation/3DDrawing/Conceptual/OpenGLES_ProgrammingGuide/OpenGLESPlatforms/OpenGLESPlatforms.html%23//apple_ref/doc/uid/TP40008793-CH106-SW6
http://developer.apple.com/library/ios/#documentation/3DDrawing/Conceptual/OpenGLES_ProgrammingGuide/BestPracticesforShaders/BestPracticesforShaders.html


Bake your scene static lighting into textures using Unity built-in Lightmapper. The process of generating a lightmapped environment takes 

only a little longer than just placing a light in the scene in Unity, but:  

 It is going to run a lot faster (2-3 times for eg. 2 pixel lights)  

 And look a lot better since you can bake global illumination and the lightmapper can smooth the results  

Share Materials 

If a number of objects being rendered by the same camera uses the same material, then Unity iOS will be able to employ a large variety of 

internal optimizations such as:  

 Avoiding setting various render states to OpenGL ES.  

 Avoiding calculation of different parameters required to setup vertex and pixel processing  

 Batching small moving objects to reduce draw calls  

 Batching both big and small objects with enabled "static" property to reduce draw calls  

All these optimizations will save you precious CPU cycles. Therefore, putting extra work to combine textures into single atlas and making 

number of objects to use the same material will always pay off. Do it!  

Simple Checklist to make Your Game Faster 

 Keep vertex count below:  

o 40K per frame when targeting iPhone 3GS and newer devices (with SGX GPU)  

o 10K per frame when targeting older devices (with MBX GPU)  

 If you're using built-in shaders, peek ones from Mobile category. Keep in mind that Mobile/VertexLit is currently the fastest shader.  

 Keep the number of different materials per scene low - share as many materials between different objects as possible.  

 Set Static property on a non-moving objects to allow internal optimizations.  

 Use PVRTC formats for textures when possible, otherwise choose 16bit textures over 32bit.  

 Use combiners or pixel shaders to mix several textures per fragment instead of multi-pass approach.  

 If writing custom shaders, always use smallest possible floating point format:  

o fixed / lowp -- perfect for color, lighting information and normals,  

o half / mediump -- for texture UV coordinates,  

o float / highp -- avoid in pixel shaders, fine to use in vertex shader for vertex position calculations.  

 Minimize use of complex mathematical operations such as pow, sin, cos etc in pixel shaders.  

 Do not use Pixel Lights when it is not necessary -- choose to have only a single (preferably directional) pixel light affecting your geometry.  

 Do not use dynamic lights when it is not necessary -- choose to bake lighting instead.  

 Choose to use less textures per fragment.  

 Avoid alpha-testing, choose alpha-blending instead.  

 Do not use fog when it is not necessary.  

 Learn benefits of Occlusion culling and use it to reduce amount of visible geometry and draw-calls in case of complex static scenes with 

lots of occlusion. Plan your levels to benefit from Occlusion culling.  

 Use skyboxes to "fake" distant geometry.  

See Also 

 Optimizing iOS Performance  

 iOS Hardware Guide  

 iOS Automatic Draw Call Batching  

 Modeling Optimized Characters  

 Rendering Statistics  

 

Android 
 

http://unity3d.com/support/documentation/Manual/Lightmapping.html
http://unity3d.com/support/documentation/Manual/iphone-performance.html
http://unity3d.com/support/documentation/Manual/iphone-Hardware.html
http://unity3d.com/support/documentation/Manual/iphone-DrawCall-Batching.html
http://unity3d.com/support/documentation/Manual/Modeling%20Optimized%20Characters.html
http://unity3d.com/support/documentation/Manual/RenderingStatistics.html#RenderingStatisticsIPhone
javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
javascript:ShowHideDiv('androidRef','specific-android', 'Android');


Lighting Performance 

Per-pixel dynamic lighting will add significant cost to every affected pixel and can lead to rendering object in multiple passes. Avoid having 

more than one Pixel Light affecting any single object, prefer it to be a directional light. Note that Pixel Light is a light which has a Render 

Mode setting set to Important.  

Per-vertex dynamic lighting can add significant cost to vertex transformations. Avoid multiple lights affecting single objects. Bake lighting for 

static objects.  

Optimize Model Geometry 

When optimizing the geometry of a model, there are two basic rules:  

 Don't use excessive amount of faces if you don't have to  

 Keep the number of UV mapping seams and hard edges as low as possible  

Note that the actual number of vertices that graphics hardware has to process is usually not the same as what is displayed in a 3D 

application. Modeling applications usually display the geometric vertex count, i.e. number of points that make up a model.  

For a graphics card however, some vertices have to be split into separate ones. If a vertex has multiple normals (it's on a "hard edge"), or 

has multiple UV coordinates, or has multiple vertex colors, it has to be split. So the vertex count you see in Unity is almost always different 

from the one displayed in 3D application.  

Texture Compression 

All Android devices with support for OpenGL ES 2.0 also support the ETC1 compression format; it's therefore encouraged to whenever 

possible use ETC1 as the prefered texture format. Using compressed textures is important not only to decrease the size of your textures 

(resulting in faster load times and smaller memory footprint), but can also increase your rendering performance dramatically! Compressed 

textures require only a fraction of memory bandwidth compared to full blown 32bit RGBA textures.  

If targeting a specific graphics architecture, such as the Nvidia Tegra or Qualcomm Snapdragon, it may be worth considering using the 

proprietary compression formats available on those architectures. The Android Market also allows filtering based on supported texture 

compression format, meaning a distribution archive (.apk) with for example DXT compressed textures can be prevented for download on a 

device which doesn't support it.  

Enable Mip Maps 

As a rule of thumb, always have Generate Mip Maps enabled. In the same way Texture Compression can help limit the amount of texture 

data transfered when the GPU is rendering, a mip mapped texture will enable the GPU to use a lower-resolution texture for smaller 

triangles. The only exception to this rule is when a texel (texture pixel) is known to map 1:1 to the rendered screen pixel, as with UI 

elements or in a pure 2D game.  

Tips for writing well performing shaders 

Although all Android OpenGL ES 2.0 GPUs fully support pixel and vertex shaders, do not expect to grab a desktop shader with complex 

per-pixel functionality and run it on Android device at 30 frames per second. Most often shaders will have to be hand optimized, 

calculations and texture reads kept to a minimum in order to achieve good frame rates.  

Complex arithmetic operations 

Arithmetic operations such as pow, exp, log, cos, sin, tan etc heavily tax GPU. Rule of thumb is to have not more than one such operation 

per fragment. Consider that sometimes lookup textures could be a better alternative.  

Do NOT try to roll your own normalize, dot, inversesqrt operations however. Always use built-in ones -- this was driver will generate much 

better code for you.  

Keep in mind that discard operation will make your fragments slower.  

http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/Components/class-Texture2D.html


Floating point operations 

Always specify precision of the floating point variables while writing custom shaders. It is crucial to pick smallest possible format in order to 

achieve best performance.  

If shader is written in GLSL ES, then precision is specified as following:  

 highp - full 32 bits floating point format, well suitable for vertex transformations, slowest  

 mediump - reduced 16 bits floating point format, well suitable for texture UV coordinates, roughly x2 faster than highp  

 lowp - 10 bits fixed point format, well suitable for colors, lighting calculation and other high performant operations, roughly x4 faster than 

highp  

If shader is written in CG or it is a surface shader, then precision is specified as following:  

 float - analogous to highp in GLSL ES, slowest  

 half - analogous to mediump in GLSL ES, roughly x2 faster than float  

 fixed - analogous to lowp in GLSL ES, roughly x4 faster than float  

For more details about general shader performance, please read the Shader Performance page. Quoted performance figures are based on 

the PowerVR graphics architecture, available in devices such as the Samsung Nexus S. Other hardware architectures may experience less 

(or more) benefit from using reduced register precision.  

Bake Lighting into Lightmaps 

Bake your scene static lighting into textures using Unity built-in Lightmapper. The process of generating a lightmapped environment takes 

only a little longer than just placing a light in the scene in Unity, but:  

 It is going to run a lot faster (2-3 times for eg. 2 pixel lights)  

 And look a lot better since you can bake global illumination and the lightmapper can smooth the results  

Share Materials 

If a number of objects being rendered by the same camera uses the same material, then Unity Android will be able to employ a large 

variety of internal optimizations such as:  

 Avoiding setting various render states to OpenGL ES.  

 Avoiding calculation of different parameters required to setup vertex and pixel processing  

 Batching small moving objects to reduce draw calls  

 Batching both big and small objects with enabled "static" property to reduce draw calls  

All these optimizations will save you precious CPU cycles. Therefore, putting extra work to combine textures into single atlas and making 

number of objects to use the same material will always pay off. Do it!  

Simple Checklist to make Your Game Faster 

 If you're using built-in shaders, peek ones from Mobile category. Keep in mind that Mobile/VertexLit is currently the fastest shader.  

 Keep the number of different materials per scene low - share as many materials between different objects as possible.  

 Set Static property on a non-moving objects to allow internal optimizations.  

 Use ETC1 format for textures when possible, otherwise choose 16bit textures over 32bit for uncompressed texture data.  

 Use mipmaps.  

 Use combiners or pixel shaders to mix several textures per fragment instead of multi-pass approach.  

 If writing custom shaders, always use smallest possible floating point format:  

o fixed / lowp -- perfect for color, lighting information and normals,  

o half / mediump -- for texture UV coordinates,  

o float / highp -- avoid in pixel shaders, fine to use in vertex shader for vertex position calculations.  

 Minimize use of complex mathematical operations such as pow, sin, cos etc in pixel shaders.  

 Do not use Pixel Lights when it is not necessary -- choose to have only a single (preferably directional) pixel light affecting your geometry.  

http://unity3d.com/support/documentation/Components/SL-ShaderPerformance.html
http://unity3d.com/support/documentation/Manual/Lightmapping.html


 Do not use dynamic lights when it is not necessary -- choose to bake lighting instead.  

 Choose to use less textures per fragment.  

 Avoid alpha-testing, choose alpha-blending instead.  

 Do not use fog when it is not necessary.  

 Learn benefits of Occlusion culling and use it to reduce amount of visible geometry and draw-calls in case of complex static scenes with 

lots of occlusion. Plan your levels to benefit from Occlusion culling.  

 Use skyboxes to "fake" distant geometry.  

See Also 

 iPhone Optimizing Graphics Performance (for when the graphics architecture is known to be Imagination Tech's PowerVR.)  
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Modeling Optimized Characters 

Use one Skinned Mesh Renderer 

Your character should use only a single skinned mesh renderer. There is usually no reason to use multiple meshes for a character. Unity 

also has optimizations related to visibility culling and bounding volume updating which only kick in if you use one animation component and 

one skinned mesh renderer in conjunction. If you care about performance, multiple skinned meshes per character is not an option. If you 

use two skinned mesh renderers for one character instead of one, the time spent on rendering the character will most likely double!  

Don't Use Many Materials 

You also want to keep the number of materials on that mesh as low as possible. There is only one reason why you might want to have 

more than one material on the character: when you need to use a different shader (e.g. if you want to use a special shader for the eyes). 

However, 2-3 materials per character should be sufficient in almost all cases. If your character is carrying a gun, it might be useful to have 

the gun a separate object, simply because it might get detached.  

Reduce Amount of Bones 

Medium Desktop games use bone hierarchies with 15-60 bones. The fewer bones you use the faster; with 30 bones you can achieve very 

good quality on Desktop platforms and fairly good quality on Mobile Platforms. Unless you really have to, we strongly recommend you 

use fewer than 30 bones if you are developing for Mobile Platforms and around 30 bones per character on Desktop platforms.  

Polygon Count 

How many polygons you should use depends on the quality you require and the platform you are targeting. Anything between 300-1500 

triangles on Mobile Platforms and 500-6000 triangles on Desktop Platforms is reasonable. If you want lots of characters on screen or 

want the game to run on old machines, you will have to reduce the polygon count for each character. As an example: Half Life 2 characters 

used 2500-5000 triangles per character. Next-gen AAA games running on PS3 or Xbox 360 usually have characters with 5000-7000 

triangles.  

Separate Out IK and FK 

Separate out inverse kinematics (IK) and forward kinematics (FK). When animations are imported, the IK nodes are baked into FK, thus 

Unity doesn't need the IK nodes at all. You can either kill the GameObjects in Unity or the nodes in the modelling tool. By removing them, 

the IK nodes don't need to be animated every frame anymore. For this reason it is a very bad idea to intermix IK and FK hierarchies. 

Instead, you should create two hierarchies: one strictly for IK and one for FK. This way you can very easily select the whole IK hierarchy 

and delete it.  

Use Reusable Rigs 

Create a rig which you can reuse. This allows you to share animations between different characters.  

Name Bones Correctly 

http://unity3d.com/support/documentation/Manual/Optimizing%20Graphics%20Performance.html#iPhoneOptimizingGraphicsPerformance
http://unity3d.com/support/documentation/Components/class-SkinnedMeshRenderer.html
http://unity3d.com/support/documentation/Components/class-Animation.html
http://unity3d.com/support/documentation/Components/class-Material.html


Name the bones correctly (left hip, left ankle, left foot etc.). Especially with characters, naming your bones correctly is very important. For 

example if you want to turn a character into a Ragdoll you will have to find the right bones for each body part. If they are not named 

correctly, finding all the body parts will take much longer.  

Page last updated: 2010-09-24 

 

 

RenderingStatistics 
The Game View has a Stats button top right. When this Stats button is pressed, an overlay window is displayed with realtime rendering 

statistics. This is very useful for helping to optimize your game. The statistics displayed vary depending on your build target.  

 

Rendering Statistics Window. 

Statistics window contains the following information:  

Time per frame 

and FPS 

How much time it takes to process and render one game frame (and resulting FPS). Note that this number only includes 

frame update and rendering of the game view; and does not include time taken in the editor to draw the scene view, 

inspector and other editor-only processing. 

Draw Calls How many objects are drawn in total. This accumulates objects that are drawn multiple times as well, for example some 

object that is affected by pixel lights will add several draw calls. 

Batched (Draw 

Calls) 

Number of draw calls that where batched together. Batching means that engine will be able to combine rendering of 

multiple objects into one draw-call which leads to lower CPU overhead. To ensure good batching you should share as 

many materials between different objects as possible. 

Tris and Verts Number of triangles and vertices drawn. This is mostly important when optimizing for low-end hardware 

Used Textures Count and memory size of textures used when drawing this frame. 

Render 

Textures 

Count and memory size of Render Textures that are created. Also displays how many times active Render Texture was 

switched during this frame. 

Screen Size, anti-aliasing level and memory taken by the screen itself. 

VRAM usage Approximate bounds of current video memory (VRAM) usage. Also shows how much video memory your graphics card 

has. 

VBO total Number of unique meshes (vertex buffers) that are uploaded to the graphics card. Each different model will cause new 

VBO to be created. In some cases scaled objects will cause additional VBOs to be created. In case of a static batching 

however number of objects can share same VBO. 

http://unity3d.com/support/documentation/Manual/OptimizeForIntegratedCards.html
http://unity3d.com/support/documentation/Components/class-RenderTexture.html


Visible Skinned 

Meshes 

How many skinned meshes are rendered. 

Animations How many animations are playing. 

 

Desktop  
 

See Optimizing Graphics Performance for more advice.  

 

iOS 
 

See Optimizing iOS Graphics Performance for more advice.  

 

Android 
 

See Optimizing Android Graphics Performance for more advice.  

Also, the Profiler shows additional rendering statistics.  
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Reducing File size 

Unity post-processes all imported assets 

Unity always post-processes imported files, thus storing a file as a multi-layered psd file instead of a jpg will make absolutely zero 

difference in the size of the player you will deploy. Save your files in the format you are working with (eg. .mb files, .psd files, .tiff files) to 

make your life easier.  

Unity strips out unused assets 

The amount of assets in your project folder does not influence the size of your built player. Unity is very smart about detecting which assets 

are used in your game and which are not. Unity follows all references to assets before building a game and generates a list of assets that 

need to be included in the game. Thus you can safely keep unused assets in your project folder.  

Unity prints an overview of the used file size 

After Unity has completed building a player, it prints an overview of what type of asset took up the most file size, and it prints which assets 

were included in the build.  

 

Desktop  
 

To see it just open the editor console log: Open Editor Log button in the Console window (Window -> Console).  

 

iOS 
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To see it just open the console log: Help -> Open Editor console log menu.  

 

Android 
 

To see it just open the editor console log: Open Editor Log button in the Console window (Window -> Console).  

 

An overview of what took up space  

Optimizing texture size 

Often textures take up most space in the build. The first to do is to use compressed texture formats (DXT(Desktop platforms) or PVRTC) 

where you can.  

If that doesn't get the size down, try to reduce the size of the textures. The trick here is that you don't need to modfiy the actual source 

content. Simply select the texture in the Project view and set Max Texture Size in Import Settings. It is a good idea to zoom in on an object 

that uses the texture, then adjust the Max Texture Size until it starts looking worse in the Scene View.  
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Changing the Maximum Texture Size will not affect your texture asset, just its resolution in the game 

How much memory does my texture take up? 

 

Desktop  
 

Compression Memory consumption 

RGB Compressed DXT1 0.5 bpp (bytes/pixel) 

RGBA Compressed DXT5 1 bpp 

RGB 16bit 2 bpp 

RGB 24bit 3 bpp 

Alpha 8bit 1 bpp 

RGBA 16bit 2 bpp 

RGBA 32bit 4 bpp 
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iOS 
 

Compression Memory consumption 

RGB Compressed PVRTC 2 bits 0.25 bpp (bytes/pixel) 

RGBA Compressed PVRTC 2 bits 0.25 bpp 

RGB Compressed PVRTC 4 bits 0.5 bpp 

RGBA Compressed PVRTC 4 bits 0.5 bpp 

RGB 16bit 2 bpp 

RGB 24bit 3 bpp 

Alpha 8bit 1 bpp 

RGBA 16bit 2 bpp 

RGBA 32bit 4 bpp 

 

Android 
 

Compression Memory consumption 

RGB Compressed DXT1 0.5 bpp (bytes/pixel) 

RGBA Compressed DXT5 1 bpp 

RGB Compressed ETC1 0.5 bpp 

RGB Compressed PVRTC 2 bits 0.25 bpp (bytes/pixel) 

RGBA Compressed PVRTC 2 bits 0.25 bpp 

RGB Compressed PVRTC 4 bits 0.5 bpp 

RGBA Compressed PVRTC 4 bits 0.5 bpp 

RGB 16bit 2 bpp 

RGB 24bit 3 bpp 

Alpha 8bit 1 bpp 

RGBA 16bit 2 bpp 

RGBA 32bit 4 bpp 

To figure out total texture size: width * height * bpp. Add 33% if you have Mipmaps.  

By default Unity compresses all textures when importing. This can be turned off in the Preferences for faster workflow. But when building a 

game, all not-yet-compressed textures will be compressed.  

Optimizing mesh and animation size 

Meshes and imported Animation Clips can be compressed so they take up less space in your game file. Compression can be turned on in 

Mesh Import Settings.  

Mesh and Animation compression uses quantization, which means it takes less space but the compression can introduce some 

inaccuracies. Experiment with what level of compression is still acceptable for your models.  

Note that mesh compression only produces smaller data files, and does not use less memory at run time. Animation Keyframe reduction 

produces smaller data files and uses less memory at run time, and generally you should always use keyframe reduction.  

Additionally, you can choose not to store normals and/or tangents in your Meshes, to save space both in the game builds and memory at 

run time. This can be set in Tangent Space Generation drop down in Mesh Import Settings. Rules of thumb:  

 Tangents are used for normal-mapping. If you don't use normal-mapping, you probably don't need to store tangents in those meshes.  

 Normals are used for lighting. If you don't use realtime lighting on some of your meshes, you probably don't need to store normals in them.  

Reducing included dlls in the Players 
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When building a player (Desktop, Android or iOS) it is important to not depend on System.dll or System.Xml.dll. Unity does not include 

System.dll or System.Xml.dll in the players installation. That means, if you want to use Xml or some Generic containers which live in 

System.dll then the required dlls will be included in the players. This usually adds 1mb to the download size, obviously this is not very 

good for the distribution of your players and you should really avoid it. If you need to parse some Xml files, you can use a smaller xml 

library like this one Mono.Xml.zip. While most Generic containers are contained in mscorlib, Stack<> and few others are in System.dll. So 

you really want to avoid those.  

 

As you can see, Unity is including System.Xml.dll and System.dll, when building a player 

Unity includes the following DLLs with the players distribution mscorlib.dll, Boo.Lang.dll, UnityScript.Lang.dll and UnityEngine.dll.  
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Platform Dependent Compilation 
Unity includes a feature named "Platform Dependent Compilation". This consists of some preprocessor directives that let you divide your 

scripts to compile and execute a section of code exclusively for one of the supported platforms.  

Furthermore, you can run this code within the Editor, so you can compile the code specifically for your mobile/console and test it in the 

Editor!  

Platform Defines 
The platform defines that Unity supports for your scripts are:  

  

UNITY_EDITOR Define for calling Unity Editor scripts from your game code. 

UNITY_STANDALONE_OSX Platform define for compiling/executing code specifically for Mac OS (This includes Universal, PPC and 

Intel architectures). 

UNITY_DASHBOARD_WIDGET Platform define when creating code for Mac OS dashboard widgets. 

UNITY_STANDALONE_WIN Use this when you want to compile/execute code for Windows stand alone applications. 

UNITY_WEBPLAYER Platform define for web player content (this includes Windows and Mac Web player executables). 

UNITY_WII Platform define for compiling/executing code for the Wii console. 

UNITY_IPHONE Platform define for compiling/executing code for the iPhone platform. 

UNITY_ANDROID Platform define for the Android platform. 

UNITY_PS3 Platform define for running Play Station 3 code. 

UNITY_XBOX360 Platform define for executing XBbox 360 code. 

Note: These defines were introduced at version 3.0.  

http://unity3d.com/support/documentation/Images/manual/Mono.Xml.zip


Also you can compile code selectively depending on the version of the engine you are working on. Currently the supported ones are:  

UNITY_2_6 Platform define for the major version of Unity 2.6. 

UNITY_2_6_1 Platform define for specific version 1 from the major release 2.6. 

UNITY_3_0 Platform define for the major version of Unity 3.0. 

UNITY_3_0_0 Platform define for the specific version 0 of Unity 3.0. 

UNITY_3_1 Platform define for the specific version 0 of Unity 3.1. 

UNITY_3_2 Platform define for the specific version 0 of Unity 3.2. 

UNITY_3_3 Platform define for the specific version 0 of Unity 3.3. 

UNITY_3_4 Platform define for the specific version 0 of Unity 3.4. 

Note: For versions before 2.6.0 there are no platform defines as this feature was first introduced in that version.  

Testing precompiled code. 
We are going to show a small example of how to use the precompiled code. This will simply print a message that depends on the platform 

you have selected to build your target.  

First of all, select the platform you want to test your code against by clicking on File -> Build Settings. This will bring the build settings 

window to select your target platform.  

 

Build Settings window with the WebPlayer Selected as Target platform. 

Select the platform you want to test your precompiled code against and press the Switch Editor button to tell Unity which platform you are 

targeting.  



Create a script and copy/paste this code:  

JavaScript Example:  

function Awake() { 

  #if UNITY_EDITOR 

    Debug.Log("Unity Editor"); 

  #endif 

 

  #if UNITY_IPHONE 

    Debug.Log("Iphone"); 

  #endif 

 

  #if UNITY_STANDALONE_OSX 

    Debug.Log("Stand Alone OSX"); 

  #endif 

 

  #if UNITY_STANDALONE_WIN 

    Debug.Log("Stand Alone Windows"); 

  #endif  

} 

C# Example:  

using UnityEngine; 

using System.Collections; 

 

public class PlatformDefines : MonoBehaviour { 



  void Start () { 

 

    #if UNITY_EDITOR 

      Debug.Log("Unity Editor"); 

    #endif 

 

    #if UNITY_IPHONE 

      Debug.Log("Iphone"); 

    #endif 

 

    #if UNITY_STANDALONE_OSX 

 Debug.Log("Stand Alone OSX"); 

    #endif 

 

    #if UNITY_STANDALONE_WIN 

      Debug.Log("Stand Alone Windows"); 

    #endif 

 

  }       

} 

Boo Example:  

import UnityEngine 

 

class PlatformDefines (MonoBehaviour):  



 

 def Start (): 

  ifdef UNITY_EDITOR: 

   Debug.Log("Unity Editor") 

 

  ifdef UNITY_IPHONE: 

   Debug.Log("IPhone") 

 

  ifdef UNITY_STANDALONE_OSX: 

   Debug.Log("Stand Alone OSX") 

 

  ifdef not UNITY_IPHONE: 

   Debug.Log("not an iPhone") 

 

Then, depending on which platform you selected, one of the messages will get printed on the Unity console when you press play.  
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Debugging 
When creating a game, unplanned and undesired behaviors can (and inevitably will) appear due to errors in scripts or scene setup. Such 

undesired behaviors are commonly referred to as bugs, and the process of fixing them as debugging. Unity offers several methods you 

can use to debug your game. Read about them on the following pages.  

 Console  

 Debugger  

 Log Files  

o Accessing hidden folders  
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Console 
Double-clicking an error in the Status Bar or choosing Window->Console will bring up the Console.  

 

Console in the editor. 

The Console shows messages, warnings, errors, or debug output from your game. You can define your own messages to be sent to the 

Console using Debug.Log(), Debug.LogWarning, or Debug.LogError(). You can double-click any message to be taken to the script that 

caused the message. You also have a number of options on the Console Toolbar.  

 

Console control toolbar helps your filter your debug output.  

 Pressing Clear will remove all current messages from the Console.  

 When Collapse is enabled, identical messages will only be shown once.  

 When Clear on play is enabled, all messages will be removed from the Console every time you go into Play mode.  

 When Error Pause is enabled, Debug.LogError() will cause the pause to occur but Debug.Log() will not.  

 Pressing Open Player Log will open the Player Log in a text editor (or using the Console app on Mac).  

 Pressing Open Player Log will open the Editor Log in a text editor (or using the Console app on Mac).  
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Debugger 
The Unity Debugger lets you inspect your code at runtime. For example, it can help you determine when a function is called and with which 

values. Furthermore, it allows you to look at the value of scripts' variables at a given time while running your game. You can locate bugs or 

logic problems in your scripts by executing them step by step.  

Unity uses the MonoDevelop IDE to debug the scripts in your game. You can debug all the languages supported by the engine (JavaScript, 

C#, and Boo).  

Note that the debugger has to load all your code and all symbols, so bear in mind that this can have a small impact on the performance of 

your game during execution. Typically, this overhead is not large enough to affect the game framerate.  

 

 



 

 

MonoDevelop window debugging a script in unity.  

 

 

 

Debugging in Unity. 

On Windows, users must choose to install MonoDevelop as part of the Unity installation (selected by default).  

 If you haven't used MonoDevelop with your project before, synchronize your MonoDevelop project. This will open your project inside 

MonoDevelop.  

 

 

 

 



 Set the necessary breakpoints on your scripts by clicking the lines that you want to analyze.  

 

 

 

 

 Launch Unity or your player.  

o Unity: Ensure you have "Allow attached debugging" checked in the Preferences window.  

o Players: Ensure that you have built your player with the "Development build" and "Allow script debugging" options enabled.  

 Open your project in MonoDevelop.  

 In MonoDevelop, click the Attach button in the toolbar, or choose Attach from the Run menu.  

 From the dialog that appears, choose the item you wish to debug.  

 Notes:  

o Currently supported debugging targets: Unity editors, desktop standalone players, Android and iOS players  

o If your player is set not to run in the background (the default), you may need to focus your player for a few seconds in order for it to appear 

in the list.  

o Android and iOS players need to have networking enabled when script debugging is enabled. All players need to be on the same network 

subnet as the computer running MonoDevelop.  

 

 



 

 

 

 

 

 

 

 When you enter play mode, your script code will execute in the debugger.  

 When a breakpoint occurs, script execution will stop, and you will be able to use MonoDevelop to step over, into, and out of your 

script methods, inspect your variables, examine the call stack, etc.  

o Note: When you're done debugging a toplevel method (e.g. Update()), or you just want to jump to the next breakpoint, you will 

experience better debugger performance by using the Continue command instead of stepping out or over the end of your 

function.  

 



 

 

 

 

 When you're done debugging, click the Detach or Stop buttons in the toolbar, or choose Detach or Stop from the Run menu.  

Hints. 

 If you add a watch to the this object, you can inspect the internal values (position, scale, rotation...) of the GameObject to which the script 

is attached.  

 

 

 

iOS remote debugging instructions 

In addition to the instructions described above, Unity iOS applications require some additional steps for successful debugging:  

1. Attach your iDevice to your WiFi network (the same requirement as for remote profiling).  

2. Hit build & run in the Unity editor.  

3. When the application builds, installs & launches via Xcode, click Stop in Xcode.  

4. Manually find & launch your application on your iDevice. (Note: if the application is launched via Xcode you won't be able to 

resume after reaching a breakpoint).  

5. When the app is running on the device, switch to MonoDevelop and click on the attach icon in the debugging toolbar. Select your 

device from the available instances list (if there are several instances shown, then select the bottom one).  
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Log Files 



There might be times during the development when you need to obtain information from the logs of the webplayer you've built, your 

standalone player, the target device or the editor. Usually you need to see these files when you have experienced a problem and you have 

to know where exactly the problem occurred.  

On Mac the webplayer, player and editor logs can be accessed uniformly through the standard Console.app utility.  

On Windows the webplayer and editor logs are place in folders there are not shown in the Windows Explorer by default. Please see the 

Accessing hidden folders page to resolve that situation.  

Editor 

Editor log can be brought up through the Open Editor Log button in Unity's Console window.  

Mac OS X ~/Library/Logs/Unity/Editor.log 

Windows XP * C:\Documents and Settings\username\Local Settings\Application Data\Unity\Editor\Editor.log 

Windows Vista/7 * C:\Users\username\AppData\Local\Unity\Editor\Editor.log 

(*) On Windows the Editor log file is stored in the local application data folder: %LOCALAPPDATA%\Unity\Editor\Editor.log, where 

LOCALAPPDATA is defined by CSIDL_LOCAL_APPDATA.  

 

Desktop  
 

On Mac all the logs can be accessed uniformly through the standard Console.app utility.  

Webplayer 

Mac OS X ~/Library/Logs/Unity/WebPlayer.log 

Windows XP * C:\Documents and Settings\username\Local Settings\Temp\UnityWebPlayer\log\log_UNIQUEID.txt 

Windows Vista/7 * C:\Users\username\AppData\Local\Temp\UnityWebPlayer\log\log_UNIQUEID.txt 

Windows Vista/7 + IE7 + UAC * C:\Users\username\AppData\Local\Temp\Low\UnityWebPlayer\log\log_UNIQUEID.txt 

(*) On Windows the webplayer log is stored in a temporary folder: %TEMP%\UnityWebPlayer\log\log_UNIQUEID.txt, where TEMP is 

defined by GetTempPath.  

Player 

Mac OS X ~/Library/Logs/Unity/Player.log 

Windows * EXECNAME_Data\output_log.txt 

(*) EXECNAME_Data is a folder next to the executable with your game.  

 

iOS 
 

The device log can be accessed in XCode via GDB console or the Organizer Console. The latter is useful for getting crashlogs when your 

application was not running through the XCode debugger.  

Please see Debugging Applications in the iOS Development Guide. Also our Troubleshooting and Bugreporting guides may be useful for 

you.  

 

Android 
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The device log can be viewed by using the logcat console. Use the adb application found in Android SDK/platform-tools directory with a 

trailing logcat parameter:  

$ adb logcat  

Another way to inspect the LogCat is to use the Dalvik Debug Monitor Server (DDMS). DDMS can be started either from Eclipse or from 

inside the Android SDK/tools. DDMS also provides a number of other debug related tools.  
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Accessing Hidden Folders 
On Windows the logs are stored in locations that are hidden by default. To enable navigating to them in the Windows Explorer please 

perform the steps below.  

Show hidden folders on Windows XP 

The Local Settings folder is hidden by default. In order to see it, you have to enable viewing of hidden folders in Windows Explorer from 

Tools->Folder Options...->View (tab).  

 

Enabling viewing of hidden folders in Windows XP 

Show hidden folders on Windows Vista/7 

The AppData folder is hidden by default. In order to see it, you have to enable viewing of hidden folders in Windows Explorer from Tools-

>Folder Options...->View (tab). The Tools menu is hidden by default, but can be displayed by pressing the Alt key once.  

http://developer.android.com/guide/developing/tools/adb.html#logcat
http://developer.android.com/guide/developing/debugging/ddms.html


 

Enabling viewing of hidden folders in Windows Vista 
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Plugins 
Unity has extensive support for C, C++ or Objective-C based Plugins. Plugins allow your game code (written in Javascript, C# or Boo) to 

call into native code libraries. This allows Unity to integrate with other middleware libraries or legacy game code.  

Note: Plugins are a Pro-only feature. For desktop builds, plugins will work in standalones only. They are disabled when building a Web 

Player for security reasons.  

In order to use a plugin you need to do two things:  

 Write a plugin in a C based language and compile it.  

 Create a C# script which calls functions in the plugin to do something.  

So the plugin provides a simple C interface. The script then invokes the functions exposed by the plugin.  

Here is a very simple example:  

The C File of a Minimal Plugin: 

float FooPluginFunction () { return 5.0F; }  

A C# Script that Uses the Plugin: 



 

Desktop  
 

using UnityEngine; 

using System.Runtime.InteropServices; 

 

class SomeScript : MonoBehaviour { 

   // This tells unity to look up the function FooPluginFunction 

   // inside the plugin named "PluginName" 

   [DllImport ("PluginName")] 

   private static extern float FooPluginFunction (); 

 

   void Awake () { 

      // Calls the FooPluginFunction inside the PluginName plugin 

      // And prints 5 to the console 

      print (FooPluginFunction ()); 

   } 

}  

 

iOS 
 

using UnityEngine; 

using System.Runtime.InteropServices; 

 

class SomeScript : MonoBehaviour { 

   // This tells unity to look up the function FooPluginFunction 

   // inside the static binary 
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   [DllImport ("__Internal")] 

   private static extern float FooPluginFunction (); 

 

   void Awake () { 

      // Calls the native FooPluginFunction 

      // And prints 5 to the console 

      print (FooPluginFunction ()); 

   } 

}  

 

Android 
 

using UnityEngine; 

using System.Runtime.InteropServices; 

 

class SomeScript : MonoBehaviour { 

   // This tells unity to look up the function FooPluginFunction 

   // inside the plugin named "PluginName" 

   [DllImport ("PluginName")] 

   private static extern float FooPluginFunction (); 

 

   void Awake () { 

      // Calls the FooPluginFunction inside the PluginName plugin 

      // And prints 5 to the console 

      print (FooPluginFunction ()); 
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   } 

}  

 

Desktop  
 

Building a Plugin for Mac OS X 

If you are building a plugin for Mac OS X, you have to create a bundle. The easiest way to do this is using XCode. Use File->NewProject... 

and select the Bundle - Carbon/Cocoa Loadable Bundle.  

If you are using C++ (.cpp) or Objective-C (.mm) to implement the plugin you have to make sure the functions are declared with C linkage 

to avoid name mangling issues.  

extern "C" { 

  float FooPluginFunction (); 

}  

Building a Plugin for Windows 

Plugins on Windows are DLL files with exported functions. Practically any language or development environment that can create DLL files 

can be used to create plugins. 

Again, if you use C++, declare functions with C linkage to avoid name mangling issues.  

Using your plugin from C# 

Once you have built your bundle you have to copy it to Assets->Plugins folder. Unity will then find it by its name when you define a 

function like this:  

[DllImport ("PluginName")] 

private static extern float FooPluginFunction ();  

Please note that PluginName should not include the extension of the filename. Be aware that whenever you change code in the Plugin you 

will have to recompile scripts in your project or else the plugin will not have the latest compiled code.  

Deployment 

For cross platform plugins you have to include both .bundle (for Mac) and .dll (for Windows) files in Plugins folder. Once you have placed 

your plugins in the Plugins folder there is no more work required on your side. Unity automatically picks the right plugin for the right 

deployment platform and includes it with the player.  

 

iOS 
 

Building an Application with Native Plugin for iOS 

1. Define your extern method like:  
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2. [DllImport ("__Internal")] 

private static extern float FooPluginFunction (); 

3. Switch the editor to iOS platform  

4. Add your native implementation to the generated XCode project's "Classes" folder (this folder is not overwritten when project is 

updated, but don't forget to backup your native code).  

If you are using C++ (.cpp) or Objective-C (.mm) to implement the plugin you have to make sure the functions are declared with C linkage 

to avoid name mangling issues.  

extern "C" { 

  float FooPluginFunction (); 

}  

Using Your Plugin from C# 

iOS native plugins can be called only when deployed on the actual device, so it is recommended to wrap all native code methods with an 

additional C# code layer. This code could check Application.platform and call native methods only when running on the actual device and 

return mockup values when running in the Editor. Check the Bonjour browser sample application.  

Calling C# / JavaScript back from native code 

Unity iOS supports limited native->managed callback functionality via UnitySendMessage: 

UnitySendMessage("GameObjectName1", "MethodName1", "Message to send"); 

This function has three parameters : game object name, game object script method to call, message to pass to the called method. 

Limitations to know:  

1. only script methods that correspond to the following signature can be called from native code: function 

MethoName(message:string)  

2. calls to UnitySendMessage are asynchronous and have a one frame delay.  

Automated plugin integration 

Unity iOS supports limited automated plugin integration.  

1. All the .a,.m,.mm,.c,.cpp located in Assets/Plugins/iOS will be automatically merged into produced Xcode project.  

2. Merging is done by symlinking files from Assets/Plugins/iOS to the final destination and this might affect some workflows.  

3. .h files are not included into Xcode project tree, but they appear on final destination file system, thus allowing compilation of 

.m/.mm/.c/.cpp.  

Note: subfolders are not supported.  

iOS Tips 

1. Managed -> unmanaged calls are quite expensive on iOS. Try to avoid calling multiple native methods per frame.  

2. As mentioned above wrap your native methods with an additional C# layer that would call actual code on the device and return 

mockup values in the Editor.  

3. String values returned from a native method should be UTF-8 encoded and allocated on the heap. Mono marshaling calls are free 

for them.  

4. As mentioned above the XCode project's "Classes" folder is a good place to store your native code, because it is not overwritten 

when the project is updated.  

http://en.wikipedia.org/wiki/Name_mangling


5. Another good place for storing native code is the Assets folder or one of its subfolders. Just add references from the XCode 

project to the native code files: right click on the "Classes" subfolder and choose "Add->Existing files...".  

 

Android 
 

Building a Plugin for Android 

To build a plugin for Android, you first need the Android NDK. Please familiarize yourself with the steps how to build a shared library.  

If you are using C++ (.cpp) to implement the plugin you have to make sure the functions are declared with C linkage to avoid name 

mangling issues.  

extern "C" { 

  float FooPluginFunction (); 

}  

Using Your Plugin from C# 

Once you have built your shared library you have to copy it to Assets->Plugins->Android folder. Unity will then find it by its name when 

you define a function like this:  

[DllImport ("PluginName")] 

private static extern float FooPluginFunction ();  

Please note that PluginName should not include the prefix ('lib') nor the extension ('.so') of the filename. It is recommended to wrap all 

native code methods with an additional C# code layer. This code could check Application.platform and call native methods only when 

running on the actual device and return mockup values when running in the Editor. You can also use platform defines to control platform 

dependent code compilation.  

Deployment 

For cross platform plugins, your Plugins folder may include plugins for several different platforms (i.e. libPlugin.so for Android, 

Plugin.bundle for Mac and Plugin.dll for Windows). Unity automatically picks the right plugin for the right deployment platform and includes 

it with the player.  

Using Java Plugins 

The Android plugin mechanism also allows Java to be used to enable interaction with the Android OS. Java code can not be called directly 

from C#, so you'd need to write a native plugin to 'translate' the calls between C# and Java.  

Building a Java Plugin for Android 

There are several ways to create a Java plugin. What they have in common is that you will end up with a .jar file containing the .class files 

for your plugin. One way is to start off with downloading the JDK, then compile your .java files from command line with javac to create .class 

files and package them into a .jar with the jar command line tool. Another way is to use Eclipse IDE together with the ADT.  

Using Your Java Plugin from Native Code 

Once you have built your Java plugin (.jar) you have to copy it to Assets->Plugins->Android folder. Unity will package your .class files 

together with the rest of the Java code, and then call it through something called Java Native Interface (JNI). JNI works both ways; calling 

native code from Java, and interacting with Java (or the JavaVM) from native code.  
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To find your Java code from the native side you need to have access to the Java VM. Fortunately that is quite easy; just add a function like 

this to your C(++) code:  

jint JNI_OnLoad(JavaVM* vm, void* reserved) { 

  JNIEnv* jni_env = 0; 

  vm->AttachCurrentThread(&jni_env, 0); 

}  

This is all that is needed to start using Java from C(++). Completely explaining JNI is somewhat beyond the scope of this document, but 

usually it includes finding the class definition, resolving the constructor (<init>) method and create a new object instance, as shown here:  

jobject createJavaObject(JNIEnv* jni_env) { 

  jclass cls_JavaClass = jni_env->FindClass("com/your/java/Class");   // find class definition 

  jmethodID mid_JavaClass = jni_env->GetMethodID (cls_JavaClass, "<init>",  "()V");  // find constructor method 

  jobject obj_JavaClass = jni_env->NewObject(cls_JavaClass, mid_JavaClass);  // create object instance 

  return jni_env->NewGlobalRef(obj_JavaClass);      // return object with a 

global reference 

}  

Using Your Java Plugin with helper classes 

AndroidJNIHelper together with AndroidJNI can be used to ease a bit of pain with raw JNI.  

AndroidJavaObject and AndroidJavaClass automate a lot of things and also use caches to make calls to Java faster. The combination of 

AndroidJavaObject and AndroidJavaClass builds on top of AndroidJNI and AndroidJNIHelper, but also has a lot of logic in itself (to 

handle the automation). These classes also come in a 'static' version to access static members of Java class.  

You can opt for any approach you like, be it a raw JNI through AndroidJNI class methods, or AndroidJNIHelper together with AndroidJNI 

and eventually AndroidJavaObject/AndroidJavaClass for the maximum automation and convenience.  

 UnityEngine.AndroidJNI is a wrapper for the JNI calls available in C (as described above). All methods in this class are static and have a 

1:1 mapping to the Java Native Interface.  

 UnityEngine.AndroidJNIHelper provides helper functionality used by the next level, but is exposed as public methods because they may be 

useful for some special cases.  

 Instances of UnityEngine.AndroidJavaObject and UnityEngine.AndroidJavaClass have a 1:1 mapping to an instances of java.lang.Object 

and java.lang.Class (or subclasses thereof) on the Java side, correspondingly. They essentially provide 3 types of interaction with the Java 

side:  

o Call a method  

o Get the value of a field  

o Set the value of a field  

The Call is separated into two categories: Call to a 'void' method, and Call to a method with non-void return type. A generic type is used to 

represent the return type of those methods which return a non-void type.The Get/Set always take a generic type representing the field type.  
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Example 1 

//The comments is what you would need to do if you use raw JNI 

 AndroidJavaObject jo = new AndroidJavaObject("java.lang.String", "some_string");  

 // jni.FindClass("java.lang.String");  

 // jni.GetMethodID(classID, "<init>", "(Ljava/lang/String;)V");  

 // jni.NewStringUTF("some_string");  

 // jni.NewObject(classID, methodID, javaString);  

 int hash = jo.Call<int>("hashCode");  

 // jni.GetMethodID(classID, "hashCode", "()I");  

 // jni.CallIntMethod(objectID, methodID); 

Here we're creating an instance of java.lang.String, initialized with a of our choice and retrieving the hash value for that string.  

The AndroidJavaObject constructor takes at least one parameter: the name of class for which we want to construct an instance. 

Everything after the class name are parameters for the constructor call of the object, in this case a string "some_string". Then the Call to 

hashCode() that returns an 'int' which is why we use that as the generic type parameter to the Call method.  

Note: You cannot instantiate nested Java class using dotted notation. Inner classes must use $ separator, and it should work in both dotted 

and slash'd format. So android.view.ViewGroup$LayoutParams or android/view/ViewGroup$LayoutParams can be used, where 

LayoutParams class is nested in ViewGroup class.  

Example 2 

One of the plugin samples above shows how to get the cache dir for the current application. This is how you would to it from C# without any 

plugins:  

 AndroidJavaClass jc = new AndroidJavaClass("com.unity3d.player.UnityPlayer");  

 // jni.FindClass("com.unity3d.player.UnityPlayer");  

 AndroidJavaObject jo = jc.GetStatic<AndroidJavaObject>("currentActivity");  

 // jni.GetStaticFieldID(classID, "Ljava/lang/Object;");  

 // jni.GetStaticObjectField(classID, fieldID);  

 // jni.FindClass("java.lang.Object");  

 

 Debug.Log(jo.Call<AndroidJavaObject>("getCacheDir").Call<string>("getCanonicalPath"));  

http://developer.android.com/reference/java/lang/String.html
http://developer.android.com/reference/java/lang/String.html#hashCode


 // jni.GetMethodID(classID, "getCacheDir", "()Ljava/io/File;"); // or any baseclass thereof!  

 // jni.CallObjectMethod(objectID, methodID);  

 // jni.FindClass("java.io.File");  

 // jni.GetMethodID(classID, "getCanonicalPath", "()Ljava/lang/String;");  

 // jni.CallObjectMethod(objectID, methodID);  

 // jni.GetStringUTFChars(javaString); 

Here we start with AndroidJavaClass instead of AndroidJavaObject, because we want access a static member of 

com.unity3d.player.UnityPlayer, not create a new object (there is already one created as part of the Android UnityPlayer). Then we 

access the static field "currentActivity" but this time we use AndroidJavaObject as the generic parameter. This is because the actual field 

type (android.app.Activity) is a subclass of java.lang.Object, and any non-primitive type must be accessed as AndroidJavaObject (strings 

are the exception to that rule; they can be accessed directly even though they don't represent a primitive type in Java).  

After that it's just a matter of simply traversing the Activity through getCacheDir(), to get the File object representing the cache directory, 

and call getCanonicalPath() to get a string representation.  

Of course nowadays you don't need to do that to get the cache directory; we have provided access to the application's cache and file 

directory through Application.temporaryCachePath, Application.persistentDataPath.  

Example 3 

Finally a small trick to show how we can pass data from Java to script code using UnitySendMessage.  

using UnityEngine;  

public class NewBehaviourScript : MonoBehaviour {  

 

 void Start () {  

  JNIHelper.debug = true;  

  using (JavaClass jc = new JavaClass("com.unity3d.player.UnityPlayer")) {  

   jc.CallStatic("UnitySendMessage", "Main Camera", "JavaMessage", "whoowhoo");  

  }  

 }  

 

 void JavaMessage(string message) {  

http://developer.android.com/reference/android/app/Activity.html
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http://unity3d.com/support/documentation/ScriptReference/Application-persistentDataPath.html


  Debug.Log("message from java: " + message);  

 } 

}  

The Java class com.unity3d.player.UnityPlayer now has a static method UnitySendMessage, equivalent to the iOS' UnitySendMessage 

on the native side; it can be used in Java to pass data to script code.  

But here we call it directly from script code. That essentially relays the message on the Java side, which then calls back in the native/Unity 

to deliver the message to the object named "Main Camera", with a script attached to it which as a method called "Java Message".  

The best practices of using the Java plugins with Unity 

As this section is manly targeted at people who don't have comprehensive JNI, Java and Android experience, we assume that 

AndroidJavaObject/AndroidJavaClass approach has been taken to interact with Java code from Unity.  

The very first thing that should be noted is that any operation you do on a AndroidJavaObject / AndroidJavaClass is expensive (as is a 

raw JNI approach though). It's very much recommended to keep the number of transitions between managed and native/java to a 

minimum. Both for the sake of performance and also complexity.  

Basically you could have a Java method to do all the actual work and then use AndroidJavaObject / AndroidJavaClass to communicate 

with that method and get the result. That's said, it may be beneficial to know, that with JNI helper classes we try to cache as much data as 

possible.  

//The first time you call a Java function like  

AndroidJavaObject jo = new AndroidJavaObject("java.lang.String", "some_string");  // somewhat expensive 

int hash = jo.Call<int>("hashCode");  // first time - expensive 

int hash = jo.Call<int>("hashCode");  // second time - not as expensive as we already know the java method and can call it straight 

It's the same way as a JIT: first time you call it, it will be slow because the code doesn't exist. Next time is much cheaper. In other words, 

you pay for every .Call /.Get / .Set, but you pay less after the first time you call it, per object. You pay for creating a AndroidJavaClass / 

AndroidJavaObject.  

Mono garbage collector should release all the created instances of AndroiJavaObject / AndroidJavaClass, yet it is strongly advised to 

keep them in a using(){} statement to ensure they are deleted as soon as possible. Otherwise there is no real guarantee when they will be 

destroyed. If you set AndroidJNIHelper.debug = true; you will see the debug output exposing the Garbage Collector behavior.  

//Getting the system language with the safe approach 

void Start () {  

 using (AndroidJavaClass cls = new AndroidJavaClass("java.util.Locale")) {  

  using(AndroidJavaObject locale = cls.CallStatic<AndroidJavaObject>("getDefault")) {  

   Debug.Log("current lang = " + locale.Call<string>("getDisplayLanguage"));  

http://unity3d.com/support/documentation/Manual/Plugins.html#iPhonePlugins


 

  }  

 }  

} 

You can also call the .Dispose() method directly to ensure there are no Java objects lingering. The actual C# object might live a bit longer 

though, but will be garbage collected by mono eventually.  

Extending the UnityPlayerActivity Java Code 

With Unity Android it is also possible to extend the regular UnityPlayerActivity (primary Java class for the Unity Player on Android, similarly 

to AppController.mm on Unity iOS).  

An application can, by creating a new Activity which derives from UnityPlayerActivity (UnityPlayerActivity.java can be found at 

/Applications/Unity/Unity.app/Contents/PlaybackEngines/AndroidPlayer/src/com/unity3d/player on Mac and usually at C:\Program 

Files\Unity\Editor\Data\PlaybackEngines\AndroidPlayer\src\com\unity3d\player), override any and all of the basic interaction between 

Android OS and Unity Android.  

To do that first locate the classes.jar shipped with Unity Android. It is found under the installation folder (usually C:\Program 

Files\Unity\Editor\Data (on Windows) or /Applications/Unity (on Mac)) in a folder called PlaybackEngines/AndroidPlayer/bin. Then 

add that classes.jar file to the classpath used to compile the new activity. The resulting .class file(s) should be compressed into a .jar file 

and placed under Assets->Plugins->Android. As the manifest dictates which activity to launch it's also necessary to create a new 

AndroidManifest.xml. The AndroidManifest.xml should also be placed under Assets->Plugins->Android.  

The new activity could look like OverrideExample.java:  

package com.company.product; 

 

import com.unity3d.player.UnityPlayerActivity; 

 

import android.os.Bundle; 

import android.util.Log; 

 

public class OverrideExample extends UnityPlayerActivity { 

 

  protected void onCreate(Bundle savedInstanceState) { 

 

http://developer.android.com/reference/android/app/Activity.html
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    // call UnityPlayerActivity.onCreate() 

    super.onCreate(savedInstanceState); 

 

    // print debug message to logcat 

    Log.d("OverrideActivity", "onCreate called!"); 

  } 

 

  public void onBackPressed() 

  { 

    // instead of calling UnityPlayerActivity.onBackPressed() we just ignore the back button event 

    // super.onBackPressed(); 

  } 

}  

And this is what the matching AndroidManifest.xml would look like:  

<?xml version="1.0" encoding="utf-8"?> 

<manifest xmlns:android="http://schemas.android.com/apk/res/android" package="com.company.product"> 

  <application android:icon="@drawable/app_icon" android:label="@string/app_name"> 

 <activity android:name=".OverrideExample" 

     android:label="@string/app_name"> 

        <intent-filter> 

   <action android:name="android.intent.action.MAIN" /> 

   <category android:name="android.intent.category.LAUNCHER" /> 

  </intent-filter> 

 </activity> 



  </application> 

</manifest>  

Examples 
 

Desktop  
 

Simplest Plugin 

This is a basic example of a project and a plugin that only do basic operations (prints a number, prints a string, adds two floats and adds 

two integers). Check this example if this is your first time learning plugins in Unity. 

The project can be found here.  

This project includes both Windows and Mac project files.  

Midi Plugin 

A complete example of the Plugin interface can be found here.  

This is a complete Midi plugin for OS X which uses Apple's CoreMidi API. It provides a simple C API and a C# class using the C API. The 

C# class contains a high level API, with easy access to NoteOn and NoteOff events and their velocity.  

Texture Plugin 

An example of how to assign image data to a texture from C++ directly to OpenGL (note that this will only work when Unity is using an 

OpenGL renderer). This example includes both XCode (for Mac) and Visual Studio (for Windows) project files. The plugin with 

accompanying Unity project can be found here.  

 

iOS 
 

Bonjour Browser Sample 

A simple example of the use of native code plugin can be found here  

This sample demonstrates how objective-C code can be invoked from a Unity iOS application. This application implements a very simple 

Bonjour client. The application consists of a Unity iOS project (Plugins/Bonjour.cs: C# interface to the native code, BonjourTest.js: JS script 

that implements application logic) and native code (Assets/Code) that should be added to built XCode project.  

 

Android 
 

Native Plugin Sample 

A simple example of the use of native code plugin can be found here  

This sample demonstrates how C code can be invoked from a Unity Android application. The package includes a scene which displays the 

sum to two values, calculated by the native plugin. Please note that you will need the Android NDK to compile the plugin.  

Java Plugin Sample 

An example of the use of Java code can be found here  
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This sample demonstrates how Java code can be used to interact with the Android OS and how C++ creates a bridge between C# and 

Java. The package includes a scene which displays a button that when pressed fetches the application cache directory, as defined by the 

Android OS. Please note that you will need both the JDK and the Android NDK to compile the plugins.  

The same example but based on a prebuilt JNI library to wrap the native code into C# can be found here  

More Information 

Mono Interop with native libraries.  

P-invoke documentation on MSDN.  
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Command Line Arguments 
It is possible to start the Unity Editor with command line arguments to make it run certain tasks upon opening. This allows automated game 

builds, test suites and so on. See below.  

Additionally, standalone games built with Unity accept some command line parameters as well, see below.  

Unity Editor command line arguments 

-batchmode 

Run Unity in batch mode. This should always be used in conjunction with the other command line arguments as it ensures no pop up 

windows appear and eliminates the need for any human intervention. When an exception occurs during execution of script code, asset 

server updates fail or other operations fail Unity will immediately exit with return code 1.  

Note that in batch mode, Unity will write a stripped version of it's log output to the console. For full debug information, look at Unity's Log 

Files.  

-quit 

Quit Unity cleanly upon finishing execution of other command line arguments.  

-buildWindowsPlayer 

Build a standalone Windows player (eg, -buildWindowsPlayer path/to/your/build.exe).  

-buildOSXPlayer 

Build a standalone Mac OSX player (eg, -buildOSXPlayer path/to/your/build.app).  

-importPackage packagepath 

Import the given package. No import dialog is shown.  

-createProject pathname 

Create an empty project at the given path.  

-projectPath pathname 

Open the project at the given path.  

-assetServerUpdate IP[:port] projectName username password [r <revision>] 

http://developer.android.com/sdk/ndk/index.html
http://unity3d.com/support/documentation/Images/manual/AndroidJavaPluginProject.zip
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Force an update of the project in the Asset Server given by IP:port. The port is optional and if not given it is assumed to be the standard 

one (10733). It is advisable to use this command in conjunction with the -projectPath argument to ensure you are working with the correct 

project. In no project name is given then the last project opened by Unity is used. If no project exists at the path given by -projectPath then 

one is created automatically.  

-executeMethod ClassName.MethodName 

Execute the static method as soon as Unity is started and the project folder has been opened and after the optional asset server update 

has been performed. This can be used to do continous integration: perform Unit Tests, make builds, prepare some data. If you want to 

return an error from the commandline process you can either throw an exception which will cause Unity to exit with 1. Or call 

EditorApplication.Exit with a non-zero code.  

To use -executeMethod you need to have a script in an Editor folder and a static function in the class.  

// C# example 

using UnityEditor; 

class MyEditorScript 

{ 

     static void PerformBuild () 

     { 

         string[] scenes = { "Assets/MyScene.unity" }; 

         BuildPipeline.BuildPlayer(scenes, ...); 

     } 

} 

// JavaScript example 

static void PerformBuild () 

{ 

    string[] scenes = { "Assets/MyScene.unity" }; 

    BuildPipeline.BuildPlayer(scenes, ...); 

} 

-exportPackage 

Exports a package given a path. Usage: -exportPackage exportAssetPath exportFileName 

Where: exportAssetPath: is the folder to export in the unity project 

http://unity3d.com/support/documentation/Manual/Asset%20Server.html
http://unity3d.com/support/documentation/ScriptReference/EditorApplication.Exit.html


exportFileName: is the package name 

Currently it only supports exporting only whole folders.  

-nographics (Windows only) 

When running in batch mode, do not initialize graphics device at all. This makes it possible to run your automated workflows on machines 

that don't even have a GPU.  

Example usage 

Execute Unity in batch mode, execute MyEditorScript.MyMethod method, and quit upon completion.  

Windows: 

C:\program files\Unity\Editor>Unity.exe -quit -batchmode -executeMethod 

MyEditorScript.MyMethod  

Mac OS: 

/Applications/Unity/Unity.app/Contents/MacOS/Unity -quit -batchmode -executeMethod 

MyEditorScript.MyMethod  

Execute Unity in batch mode. Use the project path given and update from the asset server. Execute the given method after all assets have 

been downloaded and imported from the asset server. After the method has finished execution, automatically quit Unity.  

/Applications/Unity/Unity.app/Contents/MacOS/Unity -batchmode -projectPath 

~/UnityProjects/AutobuildProject -assetServerUpdate 192.168.1.1 MyGame AutobuildUser 

l33tpa33 -executeMethod MyEditorScript.PerformBuild -quit  

Unity Standalone Player command line arguments 

Standalone players built with Unity also understand some command line arguments:  

-batchmode 

Run the game in "headless" mode. The game will not display anything and won't accept user input. This is mostly useful for running servers 

of networked games.  

-force-opengl (Windows only) 

Make the game use OpenGL for rendering, even if Direct3D is availabe. Normally Direct3D is used; and OpenGL is used only if Direct3D 

9.0c is not available.  

-single-instance (Windows only) 

Allow only one instance of the game to run at the time. If another game is already running, then launching it again with -single-

instance will focus the existing one.  

-nolog (Windows only) 

Do not produce output log. Normally output_log.txt is written in the *_Data folder next to the game executable, where Debug.Log 

output is printed.  

-force-d3d9-ref (Windows only) 

Make the game run using Direct3D's "Reference" software renderer. DirectX SDK has to be installed for this to work. This is mostly useful 

for building automated test suites, where you want to ensure rendering is exactly the same no matter what's the graphics card.  

-adapterN (Windows only) 

Allows the game to run full-screen on another display, where N denotes the display number.  

http://unity3d.com/support/documentation/Components/Network%20Reference%20Guide.html
http://unity3d.com/support/documentation/ScriptReference/Debug.Log.html
http://msdn.microsoft.com/en-us/directx/default.aspx


-popupwindow (Windows only) 

The window will be created as a a pop-up window (without a frame).  
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Shaders 
All rendering in Unity is done with Shaders - small scripts that let you configure the how the graphics hardware is set up for rendering. Unity 

ships with 60+ built-in shaders but you can extend this by making more yourself. The built-in shaders are documented in the Built-in Shader 

Guide.  

Shaders in Unity can be written in one of three different ways:  

 Surface Shaders will probably be your best bet. Write your shader as a surface shader if it needs to interact properly with lighting, 

shadows, projectors, etc. Surface shaders also make it easy to write complex shaders in a compact way - it's a higher level of abstraction. 

Lighting for most surface shaders can be calculated in a deferred manner (the exception is some very custom lighting models), which 

allows your shader to efficiently interact with many realtime lights. You write surface shaders in a couple of lines of Cg/HLSL and a lot more 

code gets auto-generated from that.  

 Vertex and Fragment Shaders will be required, if you need some very exotic effects that the surface shaders can't handle, if your shader 

doesn't need to interact with lighting or if it's an image effect. Shader programs written this way are the most flexible way to create the effect 

you need (even surface shaders are automatically converted to a bunch of vertex and fragment shaders), but that comes at a price: you 

have to write more code and it's harder to make it interact with lighting. These shaders are written in Cg/HLSL as well.  

 Fixed Function Shaders need to be written for old hardware that doesn't support programmable shaders. You will probably want to write 

fixed function shaders as an n-th fallback to your fancy fragment or surface shaders, to make sure your game still renders something 

sensible when run on old hardware or simpler mobile platforms. Fixed function shaders are entirely written in a language called 

ShaderLab, which is similar to Microsoft's .FX files or NVIDIA's CgFX.  

Regardless of which type you choose, the actual meat of the shader code will always be wrapped in ShaderLab, which is used to organize 

the shader structure. It looks like this:  

Shader "MyShader" { 

    Properties { 

        _MyTexture ("My Texture", 2D) = "white" { } 

        // other properties like colors or vectors go here as well 

    } 

    SubShader { 

        // here goes the 'meat' of your 

        //  - surface shader or 

        //  - vertex and fragment shader or 

        //  - fixed function shader 

http://unity3d.com/support/documentation/Components/Built-in%20Shader%20Guide.html
http://unity3d.com/support/documentation/Components/Built-in%20Shader%20Guide.html


    } 

    SubShader { 

        // here goes a simpler version of the SubShader above that can run on older graphics cards 

    } 

}  

We recommend that you start by reading about some basic concepts of the ShaderLab syntax in the ShaderLab reference and then move 

on to the tutorials listed below.  

The tutorials include plenty of examples for the different types of shaders. For even more examples of surface shaders in particular, you 

can get the source of Unity's built-in shaders from the Resources section. Unity's Image Effects package contains a lot of interesting vertex 

and fragment shaders.  

Read on for an introduction to shaders, and check out the shader reference!  

 Tutorial: ShaderLab & Fixed Function Shaders  

 Tutorial: Vertex and Fragment Shaders  

 Tutorial: Surface Shaders  
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ShaderTut1 
This tutorial will teach you how you can create your own shaders and make your game look a lot better!  

Unity is equipped with a powerful shading and material language called ShaderLab. In style it is similar to CgFX and Direct3D Effects (.FX) 

languages - it describes everything needed to display a Material.  

Shaders describe properties that are exposed in Unity's Material Inspector and multiple shader implementations (SubShaders) targeted at 

different graphics hardware capabilities, each describing complete graphics hardware rendering state, fixed function pipeline setup or 

vertex/fragment programs to use. Vertex and fragment programs are written in the high-level Cg/HLSL programming language.  

In this tutorial we describe how to write shaders in using both fixed function and programmable pipelines. We assume that the reader has a 

basic understanding of OpenGL or Direct3D render states, fixed function and programmable pipelines and has some knowledge of Cg, 

HLSL or GLSL programming languages. Some shader tutorials and documentation can be found on NVIDIA and AMD developer sites.  

Getting started 

To create a new shader, either choose Assets->Create->Shader from the menubar, or duplicate an existing shader, and work from that. 

The new shader can be edited by double-clicking it in the Project View.  

We'll start with a very basic shader:  

Shader "Tutorial/Basic" { 

    Properties { 

http://unity3d.com/support/documentation/Components/SL-Shader.html
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        _Color ("Main Color", Color) = (1,0.5,0.5,1) 

    } 

    SubShader { 

        Pass { 

            Material { 

                Diffuse [_Color] 

            } 

            Lighting On 

        } 

    } 

}  

This simple shader demonstrates one of the most basic shaders possible. It defines a color property called Main Color and assigns it a 

default value of rose-like color (red=100% green=50% blue=50% alpha=100%). It then renders the object by invoking a Pass and in that 

pass setting the diffuse material component to the property _Color and turning on per-vertex lighting.  

To test this shader, create a new material, select the shader from the drop-down menu (Tutorial->Basic) and assign the Material to some 

object. Tweak the color in the Material Inspector and watch the changes. Time to move onto more complex things!  

Basic Vertex Lighting 

If you open an existing complex shader, it can be a bit hard to get a good overview. To get you started, we will dissect the built-in VertexLit 

shader that ships with Unity. This shader uses fixed function pipeline to do standard per-vertex lighting.  

Shader "VertexLit" { 

    Properties { 

        _Color ("Main Color", Color) = (1,1,1,0.5) 

        _SpecColor ("Spec Color", Color) = (1,1,1,1) 

        _Emission ("Emmisive Color", Color) = (0,0,0,0) 

        _Shininess ("Shininess", Range (0.01, 1)) = 0.7 

        _MainTex ("Base (RGB)", 2D) = "white" { } 

    } 



 

    SubShader { 

        Pass { 

            Material { 

                Diffuse [_Color] 

                Ambient [_Color] 

                Shininess [_Shininess] 

                Specular [_SpecColor] 

                Emission [_Emission] 

            } 

            Lighting On 

            SeparateSpecular On 

            SetTexture [_MainTex] { 

                constantColor [_Color] 

                Combine texture * primary DOUBLE, texture * constant 

            } 

        } 

    } 

}  

All shaders start with the keyword Shader followed by a string that represents the name of the shader. This is the name that is shown in the 

Inspector. All code for this shader must be put within the curly braces after it: { } (called a block).  

 The name should be short and descriptive. It does not have to match the .shader file name.  

 To put shaders in submenus in Unity, use slashes - e.g. MyShaders/Test would be shown as Test in a submenu called MyShaders, or 

MyShaders->Test.  

The shader is composed of a Properties block followed by SubShader blocks. Each of these is described in sections below.  

Properties 

http://unity3d.com/support/documentation/Components/SL-Shader.html


At the beginning of the shader block you can define any properties that artists can edit in the Material Inspector. In the VertexLit example 

the properties look like this:  

 

The properties are listed on separate lines within the Properties block. Each property starts with the internal name (Color, MainTex). After 

this in parentheses comes the name shown in the inspector and the type of the property. After that, the default value for this property is 

listed:  

 

The list of possible types are in the Properties Reference. The default value depends on the property type. In the example of a color, the 

default value should be a four component vector.  

We now have our properties defined, and are ready to start writing the actual shader.  

The Shader Body 

Before we move on, let's define the basic structure of a shader file.  

Different graphic hardware has different capabilities. For example, some graphics cards support fragment programs and others don't; some 

can lay down four textures per pass while the others can do only two or one; etc. To allow you to make full use of whatever hardware your 

user has, a shader can contain multiple SubShaders. When Unity renders a shader, it will go over all subshaders and use the first one that 

the hardware supports.  

http://unity3d.com/support/documentation/Components/class-Material.html
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Shader "Structure Example" { 

    Properties { /* ...shader properties... } 

    SubShader { 

     // ...subshader that uses vertex/fragment programs... 

    } 

    SubShader { 

     // ...subshader that uses four textures per pass... 

    } 

    SubShader { 

     // ...subshader that uses two textures per pass... 

    } 

    SubShader { 

     // ...subshader that might look ugly but runs on anything :) 

    } 

}  

This system allows Unity to support all existing hardware and maximize the quality on each one. It does, however, result in some long 

shaders.  

Inside each SubShader block you set the rendering state shared by all passes; and define rendering passes themselves. A complete list of 

available commands can be found in the SubShader Reference.  

Passes 

Each subshader is a collection of passes. For each pass, the object geometry is rendered, so there must be at least one pass. Our 

VertexLit shader has just one pass:  

// ...snip... 

Pass { 

    Material { 

        Diffuse [_Color] 

http://unity3d.com/support/documentation/Components/SL-SubShader.html


        Ambient [_Color] 

        Shininess [_Shininess] 

        Specular [_SpecColor] 

        Emission [_Emission] 

    } 

    Lighting On 

    SeparateSpecular On 

    SetTexture [_MainTex] { 

        constantColor [_Color] 

        Combine texture * primary DOUBLE, texture * constant 

    } 

} 

// ...snip...  

Any commands defined in a pass configures the graphics hardware to render the geometry in a specific way.  

In the example above we have a Material block that binds our property values to the fixed function lighting material settings. The command 

Lighting On turns on the standard vertex lighting, and SeparateSpecular On enables the use of a separate color for the specular 

highlight.  

All of these command so far map very directly to the fixed function OpenGL/Direct3D hardware model. Consult OpenGL red book for more 

information on this.  

The next command, SetTexture, is very important. These commands define the textures we want to use and how to mix, combine and 

apply them in our rendering. SetTexture command is followed by the property name of the texture we would like to use (_MainTex here) 

This is followed by a combiner block that defines how the texture is applied. The commands in the combiner block are executed for each 

pixel that is rendered on screen.  

Within this block we set a constant color value, namely the Color of the Material, _Color. We'll use this constant color below.  

In the next command we specify how to mix the texture with the color values. We do this with the Combine command that specifies how to 

blend the texture with another one or with a color. Generally it looks like this:  

    Combine ColorPart, AlphaPart 

Here ColorPart and AlphaPart define blending of color (RGB) and alpha (A) components respectively. If AlphaPart is omitted, then it uses 

the same blending as ColorPart.  

http://unity3d.com/support/documentation/Components/SL-Material.html
http://opengl.org/documentation/red_book
http://unity3d.com/support/documentation/Components/SL-SetTexture.html


In our VertexLit example:  

    Combine texture * primary DOUBLE, texture * constant 

Here texture is the color coming from the current texture (here _MainTex). It is multiplied (*) with the primary vertex color. Primary color is 

the vertex lighting color, calculated from the Material values above. Finally, the result is multiplied by two to increase lighting intensity 

(DOUBLE). The alpha value (after the comma) is texture multiplied by constant value (set with constantColor above). Another often used 

combiner mode is called previous (not used in this shader). This is the result of any previous SetTexture step, and can be used to 

combine several textures and/or colors with each other.  

Summary 

Our VertexLit shader configures standard vertex lighting and sets up the texture combiners so that the rendered lighting intensity is 

doubled.  

We could put more passes into the shader, they would get rendered one after the other. For now, though, that is not nessesary as we have 

the desired effect. We only need one SubShader as we make no use of any advanced features - this particular shader will work on any 

graphics card that Unity supports.  

The VertexLit shader is one of the most basic shaders that we can think of. We did not use any hardware specific operations, nor did we 

utilize any of the more special and cool commands that ShaderLab and Cg has to offer.  

In the next chapter we'll proceed by explaining how to write custom vertex & fragment programs using Cg language.  
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ShaderTut2 
This tutorial will teach you how to write custom vertex and fragment programs in Unity shaders. For a basic introduction to ShaderLab see 

the Getting Started tutorial. If you want to write shaders that interact with lighting, read about Surface Shaders instead.  

Lets start with a small recap of the general structure of a shader:  

Shader "MyShaderName" { 

    Properties { 

        // ... properties here ... 

    } 

    SubShader { 

        // ... subshader for graphics hardware A ... 

        Pass { 

            // ... pass commands ... 

        } 

http://unity3d.com/support/documentation/Manual/ShaderTut2.html
http://unity3d.com/support/documentation/Manual/ShaderTut1.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html


        // ... more passes if needed ... 

    } 

    SubShader { 

        // ... subshader for graphics hardware B ... 

    } 

    // ... Optional fallback ... 

    FallBack "VertexLit" 

}  

Here at the end we introduce a new command:  

    FallBack "VertexLit" 

The Fallback command can be used at the end of the shader; it tells which shader should be used if no SubShaders from the current 

shader can run on user's graphics hardware. The effect is the same as including all SubShaders from the fallback shader at the end. For 

example, if you were to write a normal-mapped shader, then instead of writing a very basic non-normal-mapped subshader for old graphics 

cards you can just fallback to built-in VertexLit shader.  

The basic building blocks of the shader are introduced in the first shader tutorial while the full documentation of Properties, SubShaders 

and Passes are also available.  

A quick way of building SubShaders is to use passes defined in other shaders. The command UsePass does just that, so you can reuse 

shader code in a neat fashion. As an example the following command uses the pass with the name "BASE" from the built-in Specular 

shader:  

    UsePass "Specular/BASE" 

In order for UsePass to work, a name must be given to the pass one wishes to use. The Name command inside the pass gives it a name:  

    Name "MyPassName" 

Vertex and fragment programs 

We described a pass that used just a single texture combine instruction in the first tutorial. Now it is time to demonstrate how we can use 

vertex and fragment programs in our pass.  

When you use vertex and fragment programs (the so called "programmable pipeline"), most of the hardcoded functionality ("fixed function 

pipeline") in the graphics hardware is switched off. For example, using a vertex program turns off standard 3D transformations, lighting and 

texture coordinate generation completely. Similarly, using a fragment program replaces any texture combine modes that would be defined 

in SetTexture commands; thus SetTexture commands are not needed.  

Writing vertex/fragment programs requires a thorough knowledge of 3D transformations, lighting and coordinate spaces - because you 

have to rewrite the fixed functionality that is built into API's like OpenGL yourself. On the other hand, you can do much more than what's 

built in!  

http://unity3d.com/support/documentation/Components/SL-Fallback.html
http://unity3d.com/support/documentation/Manual/ShaderTut1.html
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http://unity3d.com/support/documentation/Components/SL-Pass.html
http://unity3d.com/support/documentation/Components/SL-UsePass.html
http://unity3d.com/support/documentation/Components/SL-Name.html
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Using Cg in ShaderLab 

Shaders in ShaderLab are usually written in Cg programming language by embedding "Cg snippets" in the shader text. Cg snippets are 

compiled into low-level shader assembly by the Unity editor, and the final shader that is included in your game's data files only contains this 

low-level assembly. When you select a shader in the Project View, the Inspector shows shader text after Cg compilation, which might help 

as a debugging aid. Unity automatically compiles Cg snippets for both OpenGL and Direct3D, so your shaders that use Cg will just work on 

both. Note that because Cg code is compiled by the editor, you can't create Cg shaders from scripts at runtime.  

In general, Cg snippets are placed inside Pass blocks. They look like this:  

  Pass { 

      // ... the usual pass state setup ... 
 

      CGPROGRAM 

      // compilation directives for this snippet, e.g.: 
      #pragma vertex vert 

      #pragma fragment frag 

 

      // the Cg code itself 
 

      ENDCG 

      // ... the rest of pass setup ... 
  } 

The following example demonstrates a complete shader with Cg programs that renders object normals as colors:  

Shader "Tutorial/Display Normals" { 

SubShader { 

    Pass { 

 

CGPROGRAM 

#pragma vertex vert 

#pragma fragment frag 

#include "UnityCG.cginc" 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    float3 color : COLOR0; 

}; 

http://developer.nvidia.com/page/cg_main.html


 

v2f vert (appdata_base v) 

{ 

    v2f o; 

    o.pos = mul (UNITY_MATRIX_MVP, v.vertex); 

    o.color = v.normal * 0.5 + 0.5; 

    return o; 

} 

 

half4 frag (v2f i) : COLOR 

{ 

    return half4 (i.color, 1); 

} 

ENDCG 

 

    } 

} 

Fallback "VertexLit" 

}  

When applied on an object it will result in an image like this (if your graphics card supports vertex & fragment programs of course):  



 

Our "Display Normals" shader does not have any properties, contains a single SubShader with a single Pass that is empty except for the 

Cg code. Finally, a fallback to the built-in VertexLit shader is defined. Let's dissect the Cg code part by part:  

    CGPROGRAM 

    #pragma vertex vert 

    #pragma fragment frag 

    // ... snip ... 
    ENDCG 

The whole Cg snippet is written between CGPROGRAM and ENDCG keywords. At the start compilation directives are given as #pragma 

statements:  

 #pragma vertex name tells that the code contains a vertex program in the given function (vert here).  

 #pragma fragment name tells that the code contains a fragment program in the given function (frag here).  



Following the compilation directives is just plain Cg code. We start by including a builtin Cg file:  

    #include UnityCg.cginc 

The UnityCg.cginc file contains commonly used declarations and functions so that the shaders can be kept smaller. The file itself is found 

inside Unity application ({unity install path}/Data/CGIncludes/UnityCG.cginc on Windows, 

/Applications/Unity/Unity.app/Contents/CGIncludes/UnityCG.cginc on Mac). Here we'll use appdata_base structure from that file. We 

could just define them directly in the shader and not include the file of course.  

Next we define a "vertex to fragment" structure (here named v2f) - what information is passed from the vertex to the fragment program. We 

pass the position and color parameters. The color will be computed in the vertex program and just output in the fragment program.  

We proceed by defining the vertex program - vert function. Here we compute the position and output input normal as a color:  

    o.color = v.normal * 0.5 + 0.5; 

Normal components are in -1..1 range, while colors are in 0..1 range, so we scale and bias the normal in the code above. Next we define a 

fragment program - frag function that just outputs the calculated color and 1 as the alpha component:  

    half4 frag (v2f i) : COLOR 

    { 

        return half4 (i.color, 1); 

    } 

That's it, our shader is finished! Even this simple shader is very useful to visualize mesh normals.  

Of course, this shader does not respond to lights at all, and that's where things get a bit more interesting; read about Surface Shaders for 

details.  

Using shader properties in Cg code 

When you define properties in the shader, you give them a name like _Color or _MainTex. To use them in Cg you just have to define a 

variable of a matching name and type. Unity will automatically set Cg variables that have names matching with shader properties.  

Here is a complete shader that displays a texture modulated by a color. Of course, you could easily do the same in a texture combiner call, 

but the point here is just to show how to use properties in Cg:  

Shader "Tutorial/Textured Colored" { 

Properties { 

    _Color ("Main Color", Color) = (1,1,1,0.5) 

    _MainTex ("Texture", 2D) = "white" { } 

} 

SubShader { 

    Pass { 

 

http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html


CGPROGRAM 

#pragma vertex vert 

#pragma fragment frag 

 

#include "UnityCG.cginc" 

 

float4 _Color; 

sampler2D _MainTex; 

 

struct v2f { 

    float4  pos : SV_POSITION; 

    float2  uv : TEXCOORD0; 

}; 

 

float4 _MainTex_ST; 

 

v2f vert (appdata_base v) 

{ 

    v2f o; 

    o.pos = mul (UNITY_MATRIX_MVP, v.vertex); 

    o.uv = TRANSFORM_TEX (v.texcoord, _MainTex); 

    return o; 

} 

 



half4 frag (v2f i) : COLOR 

{ 

    half4 texcol = tex2D (_MainTex, i.uv); 

    return texcol * _Color; 

} 

ENDCG 

 

    } 

} 

Fallback "VertexLit" 

}  

The structure of this shader is the same as in the previous example. Here we define two properties, namely _Color and _MainTex. Inside 

Cg code we define corresponding variables:  

    float4 _Color; 

    sampler2D _MainTex; 

See Accessing Shader Properties in Cg for more information.  

The vertex and fragment programs here don't do anything fancy; vertex program uses the TRANSFORM_TEX macro from UnityCG.cginc 

to make sure texture scale&offset is applied correctly, and fragment program just samples the texture and multiplies by the color property.  

Note that because we're writing our own fragment program here, we don't need any SetTexture commands. How the textures are applied in 

the shader is entirely controlled by the fragment program.  

Summary 

We have shown how custom shader programs can be generated in a few easy steps. While the examples shown here are very simple, 

there's nothing preventing you to write arbitrarily complex shader programs! This can help you to take the full advantage of Unity and 

achieve optimal rendering results.  

The complete ShaderLab reference manual is here. We also have a forum for shaders at forum.unity3d.com so go there to get help with 

your shaders! Happy programming, and enjoy the power of Unity and Shaderlab.  
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GraphicsEmulation 
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You can choose to emulate less capable graphics hardware when working in the Unity editor. This is very handy when writing custom 

shaders and rendering effects, and is a quick way to test how your game will look on that eight year old graphics card that someone might 

have.  

To enable Graphics emulation, go to Edit->Graphics Emulation, and choose your desired emulation level.  

Note: The available graphic emulation options change depending on the platform you are currently targeting. More information can be 

found on the Publishing builds page.  

 

Enabling Graphics Emulation 

Technical Details 

Graphics emulation limits the graphics capabilities that are supported, but it does not emulate the performance of graphics hardware. Your 

game in the editor will still be rendered by your graphics card, more and more features will be disabled as you reduce emulation quality.  

While emulation is a quick way to check out graphics capabilities, you should still test your game on actual hardware. This will reveal real 

performance and any peculiarities of the specific graphics card, operating system or driver version.  

Emulation Levels 

Graphics emulation levels are the following:  

http://unity3d.com/support/documentation/Manual/Publishing%20Builds.html


 

Desktop  
 

No Emulation No emulation is performed. 

SM3.0 Emulates graphics card with Shader Model 3.0 level capabilities. Long vertex & fragment shader programs and support for 

built-in shadows. 

SM2.0 

(Radeon 

9500) 

Shader Model 2.0 capabilities, ATI Radeon style. Vertex & fragment programs, support for built-in shadows, ATI text 

fragment shader extension, 8 texture units. 

SM2.0 

(GeForce FX) 

Shader Model 2.0 capabilities, NVIDIA GeForce style. Vertex & fragment programs, support for built-in shadows, 4 texture 

units. 

SM1.4 

(Radeon 

8500) 

Shader Model 1.4 capabilities. Vertex programs, ATI text fragment shader extension, 6 texture units. Not supported: 

fragment programs, built-in shadows. 

SM1.1 

(GeForce 3) 

Shader Model 1.1 capabilities. Vertex programs, 4 texture units. Not supported: fragment programs, built-in shadows. 

DX7 (Radeon 

7500) 

DirectX 7 level capabilities. Vertex programs (usually in software mode), 3 texture units. Not supported: fragment programs, 

built-in shadows. 

DX7 

(GeForce 2) 

DirectX 7 level capabilities. Vertex programs (usually in software mode), 2 texture units, texture size limited to 2048, 

cubemap size limited to 512. Not supported: fragment programs, built-in shadows, volume textures, some complex texture 

combine modes. 

DX6 DirectX 6 level capabilities. 2 texture units, texture size limited to 1024. Not supported: vertex & fragment programs, built-in 

shadows, cubemaps, volume textures, rectangle textures, three argument texture combine modes, DOT3 texture combine 

modes, projected textures. 

Dinosaur Emulates graphics cards everyone already forgot about! One texture unit, texture size limited to 512, vertex light count 

limited to 4. Not supported: vertex & fragment programs, built-in shadows, cubemaps, RenderTextures, volume textures, 

rectangle textures, three argument texture combine modes, DOT3 texture combine modes, projected textures. 

 

iOS 
 

No Emulation No emulation is performed. 

iPhone 4, 3GS, iPad OpenGL 

ES2.0 

Emulates iPhone 3GS or newer iOS hardware running OpenGL ES 2.0. 

iPhone 4, 3GS, iPad OpenGL 

ES1.1 

Emulates iPhone 3GS or newer iOS hardware running OpenGL ES 1.1. 

Generic OpenGLES1.1 (4 

texture stages) 

Partially emulates iOS hardware running OpenGL ES 1.1. Useful for running Unity Editor on older 

cards/drivers which had support for only 4 texture combiners. 

iPhone (MBXlite) Emulates iPhone/iPod Touch hardware older than iPhone 3GS. Supports 2 texture combiners. 

 

Android 
 

No Emulation No emulation is performed. 

Generic OpenGL ES2.0 Emulates hardware running OpenGL ES 2.0. 

Generic OpenGLES1.1 (4 

texture stages) 

Partially emulates Android hardware running OpenGL ES 1.1. Useful for running Unity Editor on older 

cards/drivers which had support for only 4 texture combiners. 

When your graphics card does not support all the capabilities of some emulation level, that level will be disabled. For example, the Intel 

GMA950 (Intel 915/945/3000) card does not support Shader Model 3.0, so there's no way to emulate that level.  
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NetworkEmulation 
As part of Unity's Networking feature set, you can choose to emulate slower internet connection speeds to test out your game experience 

for users in low-bandwidth areas.  

To enable Network emulation, go to Edit->Network Emulation, and choose your desired connection speed emulation.  

 

Enabling Network Emulation 

Technical Details 

Network emulation delays the sending of packets in networking traffic for the Network and NetworkView classes. The ping is artificially 

inflated for all options, the inflation value increasing as emulated connection speed gets slower. On the Dial-Up setting, packet dropping 

and variance is also introduced to simulate the worst possible connection ever. Emulation will persist whether you are serving the role of 

Server or Client.  

Network emulation only affects the Network and NetworkView classes, and will not alter or emulate specialized networking code written 

using .NET sockets.  
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Security Sandbox 
 

Desktop  
 

In Unity 3.0, the webplayer implements a security model very similar to the one used by the Adobe Flash player�. This security restrictions 

apply only to the webplayer, and to the editor when the active build target is WebPlayer. The security model has several parts:  
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 Restrictions on accessing data on a domain other than the one hosting your .unity3d file.  

 Some limitation on the usage of the Sockets.  

 Disallowing invocation of any method we deemed off limits. (things like File.Delete, etc).  

 Disallowing the usage of System.Reflection.* to call private/internal methods in classes you did not write yourself.  

Currently only the first two parts of the security model are emulated in the Editor. Look here for a detailed list of which methods / classes 

are available in the webplayer.  

The builtin mutiplayer networking functionality of Unity (UnityEngine.Network, UnityEngine.NetworkView classes etc) is not 

affected.  

This document describes how to make sure your content keeps working with version 3.0 of the Unity 

webplayer. 

 See the Unity API reference for information about the WWW class.  

 See the .NET API reference for information about the .NET Socket class.  

The WWW class and sockets use the same policy schema but besides that they are completely separate systems. The WWW policy only 

defines permissions on the web service where the policy is hosted but socket policies apply to all TCP/UDP socket connections.  

The Unity editor comes with an "Emulate Web Security" feature, that imposes the webplayer's security model. This makes it easy to detect 

problems from the comfort of the editor. You can find this setting in Edit->Project Settings->Editor.  

Implications for usage of the WWW class 
The Unity webplayer expects a http served policy file named "crossdomain.xml" to be available on the domain you want to access with the 

WWW class, (although this is not needed if it is the same domain that is hosting the unity3d file).  

For example, imagine a tetris game, hosted at the following url:  

http://gamecompany.com/games/tetris.unity3d  

needs to access a highscore list from the following url:  

http://highscoreprovider.net/gethighscore.php  

In this case, you would need to place a crossdomain.xml file at the root of the highscoreprovider.net domain like this: 

http://highscoreprovider.net/crossdomain.xml  

The contents of the crossdomain.xml file are in the format used by the Flash player. It is very likely that you'll find the crossdomain.xml 

file already in place. The policy in the file look like this:  

<?xml version="1.0"?> 

<cross-domain-policy> 

<allow-access-from domain="*"/> 

</cross-domain-policy> 

http://unity3d.com/support/documentation/ScriptReference/MonoCompatibility.html
http://unity3d.com/support/documentation/ScriptReference/MonoCompatibility.html
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http://highscoreprovider.net/gethighscore.php
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When this file is placed at http://highscoreprovider.net/crossdomain.xml, the owner of that domain declares that the contents of the 

webserver may be accessed by any webplayer coming from any domain.  

The Unity webplayer does not support the <allow-http-request-headers-from domain> and <site-control 

permitted-cross-domain-policies> tags. Note that crossdomain.xml should be an ASCII file.  

Implications for usage of Sockets: 
A Unity webplayer needs a socket served policy in order to connect to a particular host. This policy is by default hosted by the target host 

on port 843 but it can be hosted on other ports as well. The functional difference with a non-default port is that it must be manually fetched 

with Security.PrefetchSocketPolicy() API call and if it is hosted on a port higher than 1024 the policy can only give access to other ports 

higher than 1024.  

When using the default port it works like this: A Unity webplayer tries to make a TCP socket connection to a host, it first checks that the 

host server will accept the connection. It does this by opening a TCP socket on port 843 and expects to receive a socket policy over the 

new connection. The Unity webplayer then checks that the host's policy permits the connection to go ahead and it will proceed without error 

if so. This process happens transparently to the user's code, which does not need to be modified to use this security model. An example of 

a socket policy look like this:  

<?xml version="1.0"?> 

<cross-domain-policy> 

   <allow-access-from domain="*" to-ports="1200-1220"/>  

</cross-domain-policy>" 

This policy effectively says "Content from any domain is free to make socket connections at ports 1200-1220". The Unity webplayer will 

respect this, and reject any attempted socket connection using a port outside that range (a SecurityException will be thrown).  

When using UDP connections the policy can also be auto fetched when they need to be enforced in a similar manner as with TCP. The 

difference is that auto fetching with TCP happens when you Connect to something (ensures you are allowed to connect to a server), but 

with UDP, since it's connectionless, it also happens when you call any API point which sends or receives data (ensures you are allowed to 

send/receive traffic to/from a server).  

The format used for the socket policy is the same as that used by the Flash player except some tags are not supported. The Unity 

webplayer only supports "*" as a valid value for the domain setting and the "to-ports" setting is mandatory.  

<?xml version="1.0" encoding="ISO-8859-1"?> 

 

<!ELEMENT cross-domain-policy (allow-access-from*)> 

 

<!ELEMENT allow-access-from EMPTY> 

<!ATTLIST allow-access-from domain CDATA #REQUIRED> 

http://highscoreprovider.net/crossdomain.xml
http://unity3d.com/support/documentation/ScriptReference/Security.PrefetchSocketPolicy.html


<!ATTLIST allow-access-from to-ports CDATA #REQUIRED> 

The socket policy applies to both TCP and UDP connection types so both UDP and TCP traffic can be controlled by one policy server.  

For your convenience, we provide a small program which simply listens at port 843; when it receives a connection, it will reply with a valid 

socket policy. The server code can be found inside the Unity install folder, in Tools/SocketPolicyServer. Note that the pre-built executable 

can be run on Mac since it is a Mono executable. Just type "mono sockpol.exe" to run it.  

Third party networking libraries, commonly used for multiplayer game networking, should be able to work with these requirements as long 

as they do not depend on peer 2 peer functionality (see below) but utilize dedicated servers. These sometimes even come out of the box 

with support for hosting policies.  

Listening sockets 

You cannot create listening sockets in the webplayer, it cannot act as a server. Therefore webplayers cannot communicate with each other 

directly (peer 2 peer). When using TCP sockets you can only connect to remote endpoints provided it is allowed through the socket policy 

system. For UDP it works the same but the concept is a little bit different as it is a connectionless protocol, you don't have to connect/listen 

to send/receive packets. It works by enforcing that you can only receive packets from a server if he has responded first with a valid policy 

with the allow-access-from domain tag.  

This is all just so annoying, why does all this stuff exist? 

The socket and WWW security features exist to protect people who install the Unity Web Player. Without these restrictions, an attack such 

as the following would be possible:  

 Bob works at the white house.  

 Frank is evil. He writes a unity webgame that pretends to be a game, but in the background does a WWW request to 

http://internal.whitehouse.gov/LocationOfNuclearBombs.pdf. internal.whitehouse.gov is a server that is not reachable from the internet, but 

is reachable from Bob's workstation because he works at the white house.  

 Frank sends those pdf bytes to http://frank.com/secretDataUploader.php  

 Frank places this game on http://www.frank.com/coolgame.unity3d  

 Frank somehow convinces Bob to play the game.  

 Bob plays the game.  

 Game silently downloads the secret document, and sends it to Frank.  

With the WWW and socket security features, this attack will fail, because before downloading the pdf, unity checks 

http://internal.whitehouse.gov/crossdomain.xml, with the intent to ask that server: "is the data you have on your server available for public 

usage?". Placing a crossdomain.xml on a webserver can be seen as the response to that question. In the case of this example, the system 

operator of internal.whitehouse.gov will not place a crossdomain.xml on its server, which will lead Unity to not download the pdf.  

Unfortunately, in order to protect the people who install the Unity Web Player, people who develop in Unity need to take these security 

measures into account when developing content. The same restrictions are present in all major plugin technologies. (Flash, Silverlight, 

Shockwave)  

Exceptions 

In order to find the right balance between protecting Web Player users and making life of content developers easy, we have implemented 

an exception to the security mechanism described above:  

- You are allowed to download images from servers that do not have a crossdomain.xml file. However, the only thing you are allowed to do 

with these images is use them as textures in your scene. You are not allowed to use GetPixel() on them. You are also no longer allowed to 

read back from the screen. Both attempts will result in a SecurityException being thrown. The reasoning is here is that it's okay to download 

the image, as long as the content developer gets no access to it. So you can display it to the user, but you cannot send the bytes of the 

image back to some other server.  
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VisualStudioIntegration 

What does this feature get me? 

A more sophisticated C# code writing environment. 

Think smart autocompletion, computer assisted changes to your codefiles, smart syntax highlighting and more.  

What's the difference between Express and Pro? 

VisualStudio C# 2008 is a product from Microsoft. It comes in an Express and a Profesional edition. 

The Express edition is free, and you can download it from here: http://www.microsoft.com/express/vcsharp/  

The Professional edition is not free, you can find out more information about it here: http://www.microsoft.com/visualstudio/en-

us/products/professional/default.mspx  

Unity's VisualStudio integration has two components: 

1) Unity creating and maintaining VisualStudio project files. Works with Express and with Profesional. 

2) Unity automatically opening VisualStudio when you doubleclick on a script, or error in Unity. Works with Profesional only.  

I've got Visual Studio Express, how do I use it? 

 In Unity, select from the menu Assets->Sync VisualStudio Project  

 Find the newly created .sln file in your Unity project (one folder up from your Assets folder)  

 Open that file with Visual Studio Express.  

 You can now edit all your script files, and switch back to Unity to use them.  

I've got Visual Studio Profesional, how do I use it? 

 In Unity, go to Edit->Preferences, and make sure that Visual Studio is selected as your preferred external editor.  

 Doubleclick a C# file in your project. Visual Studio should automatically open that file for you.  

 You can edit the file, save, and switch back to Unity.  

Does this work with other versions than Visual Studio C# 2008? 

We've tested against Visual Studio 2008 and a prerelease version of Visual Studio 2010. At the time of this release, Visual Studio 2010 was 

not yet released, so we're not sure if Unity will work nicely with Visual Studio 2010 once it is released.  

A few things to watch out for: 

 Even though Visual Studio comes with its own C# compiler, and you can use it to check if you have errors in your c# scripts, Unity still uses 

its own C# compiler to compile your scripts. Using the Visual Studio compiler is still quite useful, because it means you don't have to switch 

to Unity all the time to check if you have any errors or not.  

 Visual Studio's C# compiler has some more features than Unity's C# compiler currently has. This means that some code (especially newer 

c# features) will not give an error in Visual Studio but will give an error in Unity.  

 Unity automatically creates and maintains a Visual Studio .sln and .csproj file. Whenever somebody adds/renames/moves/deletes a file 

from within Unity, Unity regenerates the .sln and .csproj files. You can add files to your solution from Visual Studio as well. Unity will then 

import those new files, and the next time Unity creates the project files again, it will create them with this new file included.  

 Unity does not regenerate the Visual Studio project files after an AssetServer update, or a SVN update. You can manually ask Unity to 

regenerate the Visual Studio project files trough the menu: Assets->Sync VisualStudio Project  
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ExternalVersionControlSystemSupport 
Unity offers an Asset Server add-on product for easy integrated versioning of your projects. If you for some reason are not able use the 

Unity Asset Server, it is possible to store your project in any other version control system, such as Subversion, Perforce or Bazaar, 

although this requires some manual initial setup of your project and moving and renaming of assets has to be performed using your version 

control client and not inside Unity.  

External Version Control is a Unity Pro feature.  

Before checking your project in, you have to tell Unity to modify the project structure slightly to make it compatible with storing assets in an 

external version control system. This is done by selecting Edit->Project Settings->Editor in the application menu and enabling External 

Version Control support by clicking the Enable button. This will create a text file for every asset in the Assets directory containing the 

necessary bookkeeping information required by Unity. The files will have a .meta file extension with the first part being the full file name of 

the asset it is associated with. When moving or renaming assets in the version control system, make sure you also move or rename the 

.meta file accordingly.  

When checking the project into a version control system, you should at least add the Assets directory to the system. In case you want to 

track project and build settings as well you also need to add the Library folder and these files inside the folder:  

 EditorBuildSettings.asset  

 InputManager.asset  

 ProjectSettings.asset  

 QualitySettings.asset  

 TagManager.asset  

 TimeManager.asset  

 AudioManager.asset  

 DynamicsManager.asset  

 NetworkManager.asset  

Do not add any other files or directories located inside the Library directory. When creating new assets, make sure both the asset itself 

and the associated .meta file is added to version control.  

Example: Creating a new project and importing it to a Subversion repository. 

First, let's assume that we have a subversion repository at svn://my.svn.server.com/ and want to create a project at 

svn://my.svn.server.com/MyUnityProject. Then follow these steps to create the initial import in the system:  

1. Create a new project inside Unity and lets call it InitialUnityProject. You can add any initial assets here or add them 

later on.  

2. Enable Meta files in Edit->Project Settings->Editor  

3. Quit Unity (We do this to assure that all the files are saved).  

4. Delete the contents of the Library directory inside your project folder except.  

o EditorBuildSettings.asset  

o InputManager.asset  

o ProjectSettings.asset  

o QualitySettings.asset  

o TagManager.asset  

o TimeManager.asset  

o AudioManager.asset  

o DynamicsManager.asset  

o NetworkManager.asset  

5. Import the project folder into Subversion. If you are using the command line client, this is done like this from the directory where 

your initial project is located: 

svn import -m"Initial project import" InitialUnityProject 

svn://my.svn.server.com/MyUnityProject 

http://unity3d.com/support/documentation/Manual/Asset%20Server.html


If successful, the project should now be imported into subversion and you can delete the InitialUnityProject directory if 

you wish.  

6. Check out the project back from subversion 

svn co svn://my.svn.server.com/MyUnityProject 

And check that the asset files inside the Library folder are versioned (Step 4).  

7. Optional: Set up an ignore filter for the unversioned files inside the Library directory: 

svn propedit svn:ignore MyUnityProject/Library 

Subversion will open a text editor. Add every file in the Library folder, except these ones:  

o EditorBuildSettings.asset  

o InputManager.asset  

o ProjectSettings.asset  

o QualitySettings.asset  

o TagManager.asset  

o TimeManager.asset  

o AudioManager.asset  

o DynamicsManager.asset  

o NetworkManager.asset  

8. Open the checked out project with Unity by launching it while holding down the Option or the left Alt key. Opening the project will 

recreate the missing files deleted from the Library directory in step 4 above.  

9. Finally commit the changes. The project should now be set up and ready: 

svn ci -m"Finishing project import" MyUnityProject  
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Analytics 
The Unity editor is configured to send anonymous usage data back to Unity. This information is used to help improve the features of the 

editor. The analytics are collected using Google Analytics. Unity makes calls to a URI hosted by Google. The URN part of the URI contains 

details that describe what editor features or events have been used.  

Examples of collected data 

The following are examples of data that Unity might collect.  

Which menu items have been used. If some menu items are used rarely or not at all we could in the future simplify the menuing system.  

Build times. By collecting how long builds take to make we can focus engineering effort on optimizing the correct code.  

Lightmap baking. Again, timing and reporting how long it takes for light maps to bake can help us decide how much effort to spend on 

optimizing this area.  

Disabling Analytics 

If you do not want to send anonymous data to Unity then the sending of Analytics can be disabled. To do this untick the box in the Unity 

Preferences General tab.  



 

Editor analytics in the preferences pane. 
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Version Check 
Unity checks whether updates are available. This check happens either when Unity is started, or when you choose the Help->Check for 

Updates menu item. The update check sends the current Unity revision number (the five digit number that appears in brackets after the 

version name in the About Unity dialog) to the update server where is it compared with the most-up-to-date released version. If a newer 

version of Unity is available the following dialog is shown:  

 

Window displayed when there is a newer version of Unity available for download. 

If the version in use is the most up-to-date then the following dialog is shown:  



 

Window displayed when Unity is updated to the latest version. 

Click the Download new version button to be taken to the website where you can download the new version.  

Update Check Frequency 

The response from the server also contains a time interval which suggests when the next update check should be made. This allows the 

update check to be made less frequently when Unity is not expecting updates to be made available.  

Skipping Update Versions 

If you are in the middle of a project you may not want to update to a new version of Unity. Ticking the Skip this version button on the Unity 

Editor Update Check dialog will prevent Unity from telling you about this update.  

Disabling the Update Check 

It is not possible to disable the check for updates. The Check For Updates tick box on the dialog controls whether you are notified of 

updates (if they are available) when Unity starts. Even if you have unticked the Check for Updates option you can still check for updates by 

using the Help->Check for Updates menu item.  
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TroubleShooting 
This section address common problems you can find when using Unity, please choose the platform you are having problems at.  

 

Desktop  
 

In MonoDevelop, the Debug button is greyed out! 

 This means that MonoDevelop was unable to find the Unity executable; in the MonoDevelop preferences go to the Unity/Debugger section, 

and then browse to where your Unity executable is located.  

Is there a way to get rid of the welcome page in Mono Develop? 

 Yes, there is. In the MonoDevelop preferences, go to the Visual Style section, and uncheck "Load welcome page on startup".  

Geforce 7300GT on OSX 10.6.4 
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 Deferred rendering is disabled because materials are not displayed correctly for Geforce 7300GT on OX 10.6.4; This happens because of 

buggy video drivers.  

On Windows x64, Unity crashes when my script throws a NullReferenceException 

 Please apply Windows Hotfix #976038.  

Graphics 

Slow framerate and/or visual artifacts. 

 This may occur if your video card drivers are not up to date. Make sure you have the latest official drivers from your card vendor.  

Shadows 

I see no shadows at all! 

 Shadows are a Unity Pro only feature, so without Unity Pro you won't get shadows. Simpler shadow methods, like using a Projector, are 

still possible of course.  

 Shadows also require certain graphics hardware support. See Shadows page for details.  

 Check if shadows are not completely disabled in Quality Settings.  

 Shadows are currently not supported for Android and iOS mobile platforms.  

Some of my objects do not cast or receive shadows 

First, the Renderer has to have Receive Shadows on to have shadows on itself; and Cast Shadows on to cast shadows on other objects 

(both are on by default).  

Next, only opaque objects cast and receive shadows; that means if you use built-in Transparent or Particle shaders then you'll get no 

shadows. In most cases it's possible to Transparent Cutout shaders (for objects like fences, vegetation etc.). If you use custom written 

Shaders, they have to be pixel-lit and use Geometry render queue. Objects using VertexLit shaders do not receive shadows either (but 

can cast shadows just fine).  

Finally, only Pixel lights cast shadows. If you want to make sure that some light always casts shadows, no matter how many other lights 

are in the scene, set it to Force Pixel render mode (see Light documentation).  

 

iOS 
 

Troubleshooting on iOS devices 
There are some known scenarios where your game works perfectly in the Unity iOS Editor but doesn't work or doesn't even start on the 

actual device. The problems are often related to code or content quality. This chapter describes the most common scenarios.  

Xcode 3.2.x fails to build application with error "libiPhone-lib.a, missing required architecture i386 in file 

Undefined symbols: "Register_UnityEngine_Input_GetMouseButtonDown()", referenced from: 

RegisterAllStrippedInternalCalls() in RegisterMonoModules.o 

This build error usually happens when originally non-simulator SDK is selected in Player Settings, but later in Xcode SDK is switched to 

simulator. To run a simulator build you should choose simulator SDK in Player Settings.  

Xcode 4.x fails to build application with error "No architectures to compile for (ARCHS=armv6, 

VALID_ARCHS=i386)." 

Currently Unity has limited support for Xcode 4.x and some manual effort is required to build final application. Build&Run action will open 

Unity iOS generated Xcode project, but it won't select proper build target and proper target device. If you are building for testing on device 

http://support.microsoft.com/kb/976038
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you should select "Unity-iPhone" build target and some iOS devices, which is connected to your Mac. If you are building for testing on 

simulator (Note: this needs appropriate SDK selection in Player Settings) then you should select "Unity-iPhone-simulator" target and 

appropriate simulator device.  

Game stops responding after some time. Xcode shows "interrupted" in the status bar. 

There could be several causes for this. Typical causes include:  

1. Scripting errors, like : using initialized variables, etc.  

2. Using 3rd party Thumb compiled native libraries. Such libraries trigger known problem in iOS SDK linker and might cause random 

crashes.  

3. Using generic types with value types as parameter (like List<int>, List<SomeStruct>, List<SomeEnum>) for serializable script 

properties.  

4. Using reflection when managed code stripping is enabled.  

5. Errors in native plugin interface (managed code method signature does not match native code function signature).  

You need to review the XCode Debugger console for details. The Xcode Debugger console can be accessed from the Xcode menu Run-

>Console.  

Xcode console shows "Program received signal: “SIGBUS” or EXC_BAD_ACCESS error. 

This message typically appears on iOS devices when your application receives a NullReferenceException. There two ways to figure out 

where the fault happened:  

Managed stack traces 
Since version 3.4 Unity includes software based handling of NullReferenceException. AOT compiler includes tiny checks for null reference 

each time object method or field is accessed. This feature impacts your script performance that's why it is enabled only for development 

builds (for basic license users it is enough to enable "development build" option in Build Settings dialog, iOS pro license users additionally 

need to check "script debugging" option). If everything was done right and fault actually is happening in .NET code then you won't 

EXC_BAD_ACCESS anymore. Instead of it .NET exception text will be printed in Xcode console (or just your code will catch it in "catch" 

statement). Typical output might be:  

Unhandled Exception: System.NullReferenceException: A null value was found where an object instance was required. 

  at DayController+$handleTimeOfDay$121+$.MoveNext () [0x0035a] in DayController.js:122  

It tells that fault happened in DayController class handleTimeOfDay method, which works as coroutine. Also if that's script code you 

probably will get exact code line, like in this sample "DayController.js:122". Which corresponds to following code:  

 Instantiate(_imgwww.assetBundle.mainAsset); 

Usually this happens when script code doesn't properly check if WWW class successfully downloaded Asset Bundle, but blindly accesses 

its fields.  

Native stack traces 
Native stack traces are much more powerful tool for fault investigation, but it requires quite some expertise. Also usually you can't continue 

after these native (hardware memory access) faults happen. To get native stack trace type thread apply all bt into Xcode Debugger 

Console. Carefully inspect the printed stack traces - they may contain hints about where the error occurred. You might see something like:  

... 

Thread 1 (thread 11523):  

http://unity3d.com/support/documentation/Components/class-PlayerSettings.html


#0 0x006267d0 in OptionsMenu_Start ()  

#1 0x002e4160 in wrapper_runtime_invoke_object_runtime_invoke_void__this___object_intptr_intptr_intptr ()  

#2 0x00a1dd64 in mono_jit_runtime_invoke (method=0x18b63bc, obj=0x5d10cb0, params=0x0, exc=0x2fffdd34) at 

/Users/mantasp/work/unity/unity-mono/External/Mono/mono/mono/mini/mini.c:4487 

#3 0x0088481c in MonoBehaviour::InvokeMethodOrCoroutineChecked () 

... 

First of all you should find the stack trace for "Thread 1". This is the main thread. The very first lines of its stack trace will point to the place 

where error occurred. In this example, it indicates that the NullReferenceException happened inside the "OptionsMenu" script's "Start" 

method. Looking carefully at this method implementation would reveal the cause of the problem. Typically NullReferenceExceptions 

happen inside the Start method when wrong assumptions are made about initialization order. In some cases only a partial stack trace is 

seen on Debugger Console:  

Thread 1 (thread 11523):  

#0 0x0062564c in start () 

This indicates that native symbols were stripped during the Release build of your application. The full stack trace can be obtained by 

following these guidelines:  

 Select Debug configuration in Xcode project.  

 Clean all targets.  

 Build and run.  

 Get stack traces again as described above.  

EXC_BAD_ACCESS starts to happen only when external library is linked to Unity iOS application. 

That usually happens when external library is compiled with ARM Thumb instruction set. Currently such libraries are not compatible with 

Unity iOS. Problem could be easily solved by recompiling library without Thumb instructions. Detailed instructions for library's Xcode 

project:  

 in Xcode menu select "Project" -> "Edit active target"  

 in "Target Info" dialog select "Configuration: All Configurations"  

 in search field enter : "thumb"  

 "Compile for Thumb" setting will appear, uncheck it and rebuild the library.  

If library source is not available you should ask library provider for non-thumb version of the library.  

Xcode console shows "WARNING -> applicationDidReceiveMemoryWarning()" followed by immediate application crash. 

(Sometimes you might see a message like Program received signal: �0�.) This warning message is in many cases not fatal, and only 

indicates that iOS is low on memory and has asked applications to free some memory. Typically, some background processes like Mail will 

free some memory and your application can continue to run. However, if your application continues to use memory or ask for more, the OS 

will start killing applications at some point, and your application could be killed. Apple does not document what memory usage is safe, but 

empirical observations show that applications using less than 25 MB of RAM (80 MB for 3rd generation devices) do not have any memory 

usage problems. Applications using 40 MB of RAM may have memory problems on 1-2nd generation devices and may require a device 

restart to run properly. The primary metric on which you should rely is how much RAM your application uses. Your application memory 

usage consists of three major parts:  

 application code (the OS needs to load and keep your application code in RAM)  



 native heap (which is used by the engine to store its state, your assets, etc. in RAM)  

 managed heap (which is used by your Mono runtime to keep C# or JavaScript objects)  

Your application memory usage can be tracked by two Xcode Instruments tools: Activity Monitor and Object Allocations. You can start 

one or the other from the Xcode Run menu: Run->Start with Performance Tool->Activity Monitor and Run->Start with Performance 

Tool->Object Allocations. The first tool shows all process statistics, including Real memory, which can be considered the total amount of 

RAM used by your application.  

 

Note: The internal profiler shows only heap allocated by .NET scripts. Total memory usage could be obtained via Xcode Instruments as 

shown above. This figure includes the application binary, which will be loaded into memory and takes ~7 MB, some standard framework 

buffers, Unity engine internal state buffers, .NET runtime heap (number printed by internal profiler), and some other miscellaneous stuff. 

The other tool displays all allocations made by your application and includes native heap + managed heap statistics (don't forget to check 

the Created and still living box to get the current state of the application). You should look at the Net bytes value.  

 

Some hints about how to keep the memory usage low:  

 Reduce the application binary size by using the strongest iOS stripping options (Advanced license feature), and avoid unnecessary 

dependencies of various .NET libraries. Check for details in the player settings and player size optimization documentation  

 Reduce your content size: use PVRTC compression for textures, use low poly models. Check for details in the reducing filesize 

documentation  

 Don't allocate too much in your scripts. Track mono heap size and usage with the internal profiler  
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 Note: with Unity 3.0, the scene loading implementation has changed a lot, and now all scene assets are preloaded. This guarantees fewer 

hiccups while instantiating game objects. If you need more fine-grained control of asset loading and unloading during gameplay, you should 

use Resources.Load / Object.Destroy.  

Querying the OS for the amount of free memory may seem like a good idea to evaluate how well your application performs. However, this 

has very little relation to real life, because the OS uses a lot of dynamic buffers and caches. You should always track memory consumption 

for your application and use it as the main metric. That should be the only reliable method. Just asking how much free memory is left from 

the OS will lead you nowhere. Pay attention to how the graphs from the tools described above change over time, especially after loading 

new levels.  

Game runs fine when launched from Xcode and crashes on first level load when launched manually on the 

device. 

There could be several reasons for this. You need to inspect the device logs to get more details. Connect the device to your Mac, launch 

Xcode, go to the Xcode menu Window->Organizer, select your device in the Organizer's left toolbar, click on the "Console" tab and review 

the latest messages carefully. Additionally, you may need to investigate crash reports. You can find out how to obtain crash reports here: 

http://developer.apple.com/iphone/library/technotes/tn2008/tn2151.html.  

Xcode Organizer console contains "killed by SpringBoard". 

There is a not well documented time limit for an iOS application to render its first frames and process input. If your application misses this 

time limit, it gets killed by SpringBoard. A typical case is an application with a large first scene. To avoid this problem, it is recommended to 

create a small initial scene which just displays a splash screen, waits a frame or two with yield and starts loading the real scene. A code 

sample for this could be:  

  

function Start () { 

    yield; 

    Application.LoadLevel("Test"); 

} 

Type.GetProperty() / Type.GetValue() cause crashes on device 

Currently Type.GetProperty() and Type.GetValue() are supported only for .NET 2.0 Subset profile. You can select .NET API compatibility 

level in Player Settings.  

Note: Type.GetProperty() and Type.GetValue() might be incompatible with managed code stripping and might need to be exclude Types 

that you use from stripping by supplying custom non-strippable type list. You can find more details in iOS player size optimization guide.  

Game crashes with following error message "ExecutionEngineException: Attempting to JIT compile method 

'SometType`1<SomeValueType>:.ctor ()' while running with --aot-only." 

Mono .NET implementation for iOS is based on AOT (ahead of time compilation to native code) technology. This technology has own 

limitations. It compiles only these generic type methods (when value type is used as generic parameter), which are explicitly used by other 

code. When such methods are used only via reflection or from native code (i.e. serialization system) then they get skipped during AOT 

compilation. AOT compiler might be hinted to include code by adding mock method somewhere to the script code, which would touch 

missing methods and so get them compiled ahead of use time.  

void _unusedMethod() 

{ 
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    var tmp = new SometType<SomeValueType>(); 

} 

Note: value types are basic types, enums and structs.  

Various crashes experienced on device in combination of System.Security.Cryptography and managed code 

stripping 

.NET Cryptography services heavily rely on reflection thus are not compatible with managed code stripping which relies on static code 

analysis. Sometimes easiest solution is to exclude whole System.Security.Crypography namespace from stripping process.  

Stripping process can be customized by adding custom link.xml file to your Unity iOS project Assets folder, which specifies what types or 

namespaces should be excluded from stripping. More details can be found in iOS player size optimization guide.  

link.xml 

<linker> 

       <assembly fullname="mscorlib"> 

               <namespace fullname="System.Security.Cryptography" preserve="all"/> 

       </assembly> 

</linker> 

 

"Ran out of trampolines of type 1/2" runtime error 

This error usually happens if you use lots of recursive generics. You can hint AOT compiler to allocate more trampolines of first or second 

type. Additional AOT compiler command line options could be specified in PlayerSettings other settings section. For type 1 trampolines 

specify nrgctx-trampolines=ABCD, where ABCD is new trampoline count (i.e. 4096). For type 2 trampolines specify nimt-

trampolines=ABCD.  

 

Android 
 

Troubleshooting Android development 

Unity fails to install your application to your device 

1. Verify that your computer can actually see and communicate with the device. More on this at Publishing Builds section.  

2. Please find the error (marked with red sign) in the Unity console. It should display a helpful error message.  

Your application crashes immediately after start. 

1. Ensure you're not trying to use NativeActivity with devices that do not support it.  

2. Try removing any native plugins you have.  

3. Try to disable stripping.  

4. Use adb logcat to obtain the crash report from your device.  
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Building DEX Failed 

This an error which will present itself similar to this  

Building DEX Failed! 

G:\Unity\JavaPluginSample\Temp/StagingArea> java -Xmx1024M  

-Djava.ext.dirs="G:/AndroidSDK/android-sdk_r09-windows\platform-tools/lib/"  

-jar "G:/AndroidSDK/android-sdk_r09-windows\platform-tools/lib/dx.jar"  

--dex --verbose --output=bin/classes.dex bin/classes.jar plugins 

Error occurred during initialization of VM 

Could not reserve enough space for object heap 

Could not create the Java virtual machine. 

This is usually caused by a bad version of Java being installed on your machine. Try updating your Java install to the latest version and this 

will generally solve this issue.  

My game quits when I press the sleep button 

Please change the <activity> tag in the AndroidManifest.xml to contain <android:configChanges> tag as described 

here.  

An example activity tag can look like this:  

<activity android:name=".AdMobTestActivity" 

                  android:label="@string/app_name" 

                  android:configChanges="keyboardHidden|orientation"> 

            <intent-filter> 

                <action android:name="android.intent.action.MAIN" /> 

                <category android:name="android.intent.category.LAUNCHER" /> 

            </intent-filter> 

        </activity> 
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IME Input 

What is Input Method Editor (IME)? 

An input method is an operating system component or program that allows users to enter characters and symbols not found on their input 

device. For instance, on the computer, this allows the user of 'Western' keyboards to input Chinese, Japanese, Korean and Indic 

characters. On many hand-held devices, such as mobile phones, it enables using the numeric keypad to enter Latin alphabet characters.  

The term input method generally refers to a particular way to use the keyboard to input a particular language, for example the Cangjie 

method, the pinyin method, or the use of dead keys.  

IME and Unity 
 

Desktop  
 

 

Since Unity 3.x we have added IME support on the engine, this means that you can write non-ASCII characters in all your graphical user 

interfaces. This Input Method is fully integrated with the engine so you dont need to do anything to activate it. If you want to test it just 

change your keyboard language to a non-ASCII language i.e Japanese and just start writing your interface.  

For more info and optimization when writting non-ASCII characters, check the character option in the font properties.  

Note: IME on Unity is not supported on mac webplayers at the moment.  

 

iOS 
 

This feature is not supported on iOS devices yet.  

 

Android 
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This feature is not supported on Android devices yet.  
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Unity Pro makes it possible to use real-time shadows on any light. Objects can cast shadows onto each other and onto parts of themselves 

("self shadowing"). All types of Lights - Directional, Spot and Point - support shadows.  

Using shadows can be as simple as choosing Hard Shadows or Soft Shadows on a Light. However, if you want optimal shadow quality 

and performance, there are some additional things to consider.  

The Shadow Troubleshooting page contains solutions to common shadowing problems.  

Curiously enough, the best shadows are non-realtime ones! Whenever your game level geometry and lighting is static, just precompute 

lightmaps in your 3D application. Computing shadows offline will always result in better quality and performance than displaying them in 

real time. Now onto the realtime ones...  

Tweaking shadow quality 

Unity uses so called shadow maps to display shadows. Shadow mapping is a texture based approach, it's easiest to think of it as "shadow 

textures" projecting out from lights onto the scene. Thus much like regular texturing, quality of shadow mapping mostly depends on two 

factors:  

 The resolution (size) of the shadow maps. The larger the shadow maps, the better the shadow quality.  

 The filtering of the shadows. Hard shadows take the nearest shadow map pixel. Soft shadows average several shadow map pixels, 

resulting in smoother looking shadows (but soft shadows are more expensive to render).  

Different Light types use different algorithms to calculate shadows.  

 For Directional lights, the crucial settings for shadow quality are Shadow Distance and Shadow Cascades, found in Quality Settings. 

Shadow Resolution is also taken into account, but the first thing to try to improve directional shadow quality is reducing shadow distance. 

All the details about directional light shadows can be found here: Directional Shadow Details.  

 For Spot and Point lights, Shadow Resolution determines shadow map size. Additionally, for lights that cover small area on the screen, 

smaller shadow map resolutions are used.  

Details on how shadow map sizes are computed are in Shadow Size Details page.  

Shadow performance 

Realtime shadows are quite performance hungry, so use them sparingly. For each light to render its shadows, first any potential shadow 

casters must be rendered into the shadow map, then all shadow receivers are rendered with the shadow map. This makes shadow casting 

lights even more expensive than Pixel lights, but hey, computers are getting faster as well!  

Soft shadows are more expensive to render than Hard shadows. The cost is entirely on the graphics card though (it's only longer 

shaders), so Hard vs. Soft shadows don't make any impact on the CPU or memory.  
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Quality Settings contains a setting called Shadow Distance - this is how far from the camera shadows are drawn. Often it makes no sense 

to calculate and display shadows that are 500 meters away from the camera, so use as low shadow distance as possible for your game. 

This will help performance (and will improve quality of directional light shadows, see above).  

Hardware support for shadows 

Built-in shadows require a fragment program (pixel shader 2.0) capable graphics card. This is the list of supported cards:  

 On Windows:  

o ATI Radeon 9500 and up, Radeon X series, Radeon HD series.  

o NVIDIA GeForce 6xxx, 7xxx, 8xxx, 9xxx, GeForce GT, GTX series.  

o Intel GMA X3000 (965) and up.  

 On Mac OS X:  

o Mac OS X 10.4.11 or later.  

o ATI Radeon 9500 and up, Radeon X, Radeon HD series.  

o NVIDIA GeForce FX, 6xxx, 7xxx, 8xxx, 9xxx, GT, GTX series.  

o Intel GMA 950 and later.  

 Soft shadows are disabled because of driver bugs (hard shadows will be used instead).  

Notes 

 Forward rendering path supports only one directional shadow casting light. Vertex Lit rendering path does not support realtime shadows.  

 Vertex-lit lights don't have shadows.  

 Vertex-lit materials won't receive shadows (but do cast shadows).  

 Transparent objects don't cast or receive shadows. Transparent Cutout objects do cast and receive shadows.  

 

iOS 
 

This feature is currently not supported for iOS targets.  

 

Android 
 

This feature is currently not supported for Android targets.  
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This page explains shadows from Directional lights in detail.  

Directional lights are mostly used as a key light - sunlight or moonlight - in an outdoor game. Viewing distances can be huge, especially in 

first and third person games, and shadows often require some tuning to get the best quality vs. performance balance for your situation.  

Let's start out with a good looking shadow setup for a 3rd person game:  
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Shadows here look pretty good! 

Here, visible distance is about 50 game units, so Shadow Distance was set to 50 in Quality Settings. Also, Shadow Cascades was set to 

4, Shadow Resolution to High, and the light uses Soft Shadows.  

Chapters below dissect each aspect of directional light shadows:  

 Hard versus Soft shadows  

 Shadow Cascade count  

 Shadow Distance is Important!  

Hard versus Soft shadows 

Using the same light setup, if we switch Shadow Type to Hard Shadows, then the transition from lit to shadowed regions is "hard" - either 

something is 100% in shadow, or 100% lit. Hard shadows are faster to render but often they look less realistic.  

http://unity3d.com/support/documentation/Components/class-QualitySettings.html
http://unity3d.com/support/documentation/printable.html#hardvssoft
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Hard shadows with distance of 50 and four cascades. 

Shadow Cascade count 

For Directional lights Unity can use so called Cascaded Shadow Maps (alternatively called "Parallel Split Shadow Maps") which give very 

good shadow quality, especially for long viewing distances. Cascaded shadows work by dividing viewing area into progressively larger 

portions and using the same size shadow map on each. The result is that objects close to the viewer get more shadow map pixels than 

objects far away.  

In the images below we'll use Hard shadows because shadow pixels are better visible there.  

If no cascaded shadow maps were used, the entire shadow distance (still 50 units in our case) must be covered by the shadow texture 

uniformly. Hard shadows would look like this with no cascades:  



 

Hard shadows with distance of 50 and no cascades. 

The pixels of the shadow texture are the same size everywhere, and while they look good in distance, the quality is not stellar up close. The 

shadow texture covers the entire viewing area, and if visualized it would look like this:  

 

With no cascades, shadow texture covers viewing area uniformly. 

When two shadow cascades are used, the entire shadow distance is divided into a smaller chunk near the viewer and a larger chunk far 

away. Hard shadows would look like this with two cascades:  



 

Hard shadows with distance of 50 and two cascades. 

In exchange for some performance, we get better shadow resolution up close.  

 

With two cascades, two shadow textures cover different sized portions of viewing area. 

And finally when four shadow cascades are used, the shadow distance is divided into four progressively larger portions. Hard shadows 

would look like this with four cascades:  



 

Hard shadows with distance of 50 and four cascades. Hey, we've seen this already! 

 

With four cascades, four shadow textures cover different sized portions of viewing area. 

Shadow Distance is Important! 

Shadow Distance is extremely important for both quality and performance of directional light shadows. Just like shadow cascade count, 

shadow distance can be set in Quality Settings and allows an easy way to scale shadows down on less performant hardware.  

Shadows fade out at the end of shadow distance, and further than that objects are not shadowed. In most situations shadows further than 

some distance in the game would not be noticeable anyway!  

With no shadow cascades, hard shadows and shadow distance set to 20 units our shadows look like picture below. Note that shadows do 

fade out in the distance, but at the same time shadow quality is much better than it was with no cascades and a distance of 50 units.  

http://unity3d.com/support/documentation/Components/class-QualitySettings.html


 

Hard shadows with distance of 20 and no cascades.  

If on the other hand we set shadow distance too high, shadows won't look good at all. Setting distance to 100 here only decreases both 

performance and quality and does not make much sense - no objects in the scene are further than about 50 meters anyway!  

 

Hard shadows with distance of 100 and no cascades. Ouch!  



Shadow maps with cascades scale with distance much better. For example, four cascade soft shadows with covering 300 units in front of 

the camera look like picture below. It's somewhat worse than the picture at the top of this page, but not very bad either for a 6x increase in 

shadowing distance (of course in this scene that high shadow distance does not make much sense).  

 

Soft shadows with distance of 300 and four cascades.  

 

iOS 
 

This feature is currently not supported on iOS targets.  

 

Android 
 

This feature is currently not supported on Android targets.  
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Shadow Troubleshooting 
This page lists solutions to common shadow problems.  
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I see no shadows at all! 

 Shadows are a Unity Pro only feature, so without Unity Pro you won't get shadows. Simpler shadow methods, like using a Projector, are 

still possible of course.  

 Shadows also require certain graphics hardware support. See Shadows page for details.  

 Check if shadows are not completely disabled in Quality Settings.  

 Shadows are currently not supported for iOS and Android mobile platforms.  

Some of my objects do not cast or receive shadows 

First, the Renderer has to have Receive Shadows on to have shadows on itself; and Cast Shadows on to cast shadows on other objects 

(both are on by default).  

Next, only opaque objects cast and receive shadows; that means if you use built-in Transparent or Particle shaders then you'll get no 

shadows. In most cases it's possible to Transparent Cutout shaders (for objects like fences, vegetation etc.). If you use custom written 

Shaders, they have to be pixel-lit and use Geometry render queue. Objects using VertexLit shaders do not receive shadows either (but 

can cast shadows just fine).  

Finally, in Forward rendering path, only the brightest directional light can cast shadows. If you want to have many shadow casting lights, 

you need to use Deferred Lighting rendering path.  

 

iOS 
 

This feature is currently not supported on iOS devices.  

 

Android 
 

This feature is currently not supported on Android devices.  
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Unity computes shadow map sizes this way:  

First light's "coverage box" on the screen is computed. This is what rectangle on the screen the light possibly illuminates:  

 For Directional lights that is the whole screen.  

 For Spot lights it's the bounding rectangle of light's pyramid projected on the screen.  

 For Point lights it's the bounding rectangle of light's sphere projected on the screen.  

Then the larger value of this box' width & height is chosen; call that pixel size.  

At "High" shadow resolution, the size of the shadow map then is:  
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 Directional lights: NextPowerOfTwo( pixel size * 1.9 ), but no more than 2048.  

 Spot lights: NextPowerOfTwo( pixel size ), but no more than 1024.  

 Point lights: NextPowerOfTwo( pixel size * 0.5 ), but no more than 512.  

When graphics card has 512MB or more video memory, the upper shadow map limits are increased (4096 for Directional, 2048 for Spot, 

1024 for Point lights).  

At "Medium" shadow resolution, shadow map size is 2X smaller than at "High" resolution. And at "Low" resolution, it's 4X smaller than at 

"High" resolution.  

The seemingly low limit on Point lights is because they use cubemaps for shadows. That means six cubemap faces at this resolution must 

be in video memory. They are also quite expensive to render, as potential shadow casters must be rendered into up to six cubemap faces.  

Shadow size computation when running close to memory limits 

When running close to video memory limits, Unity will automatically drop shadow map resolution computed above.  

Generally memory for the screen (backbuffer, frontbuffer, depth buffer) has to be in video memory; and memory for render textures has to 

be in video memory, Unity will use both to determine allowed memory usage of shadow maps. When allocating a shadow map according to 

size computed above, it's size will be reduced until it fits into (TotalVideoMemory - ScreenMemory - 

RenderTextureMemory) / 3.  

Assuming all regular textures, vertex data and other graphics objects can be swapped out of video memory, maximum VRAM that could be 

used by a shadow map would be (TotalVideoMemory-ScreenMemory-RenderTextureMemory). But exact amounts of 

memory taken by screen and render textures can never be determined, and some objects can not be swapped out, and performance would 

be horrible if all textures would be constantly swapping in and out. So Unity does not allow a shadow map to exceed one third of "generally 

available" video memory, which works quite well in practice.  

 

iOS 
 

This is currently not supported on the iOS platform.  

 

Android 
 

This is currently not supported on the Android Platform.  
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Polygon count matters 

On most graphics cards today, polygon count does not really matter. The common knowledge is that object count and fillrate is much more 

important. Unfortunately, not so on the majority of older integrated chips (Intel 945 / GMA 950 and similar). How much it matters depends 
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on the complexity of the vertex shaders or lighting and the speed of the CPU (thats right, most integrated cards transform & light vertices on 

the CPU).  

Big Bang Brain Games never went above 25 thousand triangles in a scene using 1-2 per-vertex lights and no pixel lights (essentially a 

VertexLit rendering path). Quality Settings were used to speed up performance automatically when frame rate drops. So on higher end 

machines a higher quality setting was used which had pixel lights enabled.  

What slows things down is drawing objects multiple times, using complex vertex shaders and lots of polygons. This means:  

 Use VertexLit rendering path if possible. This will draw each object just once, no matter how many lights are in the scene.  

 Try not to use lights at all, even vertex lights. Lights make sense if your geometry moves, or if your lights move. Otherwise bake the 

illumination using Lightmapper, it will run faster and look better.  

 Optimize your geometry (see section below).  

 Use Rendering Statistics window and Profiler!  

Optimize model geometry 

When optimizing the geometry of a model, there are two basic rules:  

 Don't use excessive amount of faces if you don't have to.  

 Keep the number of UV mapping seams and hard edges as low as possible.  

Note that the actual number of vertices that graphics hardware has to process is usually not the same as displayed in a 3D application. 

Modeling applications usually display the geometric vertex count, i.e. number of points that make up a model.  

For a graphics card however, some vertices have to be split into separate ones. If a vertex has multiple normals (it's on a "hard edge"), or 

has multiple UV coordinates, or multiple vertex colors, it has to be split. So the vertex count you see in Unity is almost always different from 

the one displayed in 3D application.  

Bake lighting. 

Bake ligthing either into lightmaps or vertex colors. Unity has a great Lightmapper built-in; also you can bake lightmaps in many 3D 

modeling packages.  

The process of generating a lightmapped environment takes only a little longer than just placing a light in the scene in Unity, but:  

 It usually will run a lot faster; especially if you have many lights.  

 And look a lot better since you can bake global illumination.  

Even next-gen games still rely on lightmapping a lot. Usually they use lightmapped environments and only use one or two realtime dynamic 

lights.  
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Web Player Streaming is critical for providing a great web gaming experience for the end user. The idea behind web games is that the user 

can view your content almost immediately and start playing the game as soon as possible instead of making him wait for a progress bar. 

This is very achievable, and we will explain how.  
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Tuning for Portals 

This section will focus on publishing to online game portals. Streaming is useful for all kinds of contents, and it can easily be applied to 

many other situations.  

Online game portals expect that some form of game play really starts after downloading at most 1 MB of data. If you don't reach this makes 

it that much less likely for a portal to accept your content. From the user's perspective, the game needs to start quickly. Otherwise his time 

is being wasted and he might as well close the window.  

On a 128 kilobit cable connection you can download 16 KB per second or 1 MB per minute. This is the low end of bandwidth online portals 

target.  

The game would optimally be set up to stream something like this:  

1. 50 KB display the logo and menu (4 seconds)  

2. 320 KB let the user play a tiny tutorial level or let him do some fun interaction in the menu (20 seconds)  

3. 800 KB let the user play the first small level (50 seconds)  

4. Finish downloading the entire game within 1-5 MB (1-5 minutes)  

The key point to keep in mind is to think in wait times for a user on a slow connection. Never let him wait.  

Now, don't panic if your web player currently is 10 MB. It seems daunting to optimize it, but it turns out that with a little effort it is usually 

quite easy to structure your game in this fashion. Think of each above step as an individual scene. If you've made the game, you've done 

the hard part already. Structuring some scenes around this loading concept is a comparative breeze!  

If you open the console log (Open Editor Log button in the Console window(Desktop Platforms); Help -> Open Editor console log 

menu OSX) after or during a build, you can see the size of each individual scene file. The console will show something like this:  

***Player size statistics*** 

Level 0 'Main Menu' uses 95.0 KB compressed. 

Level 1 'Character Builder' uses 111.5 KB compressed. 

Level 2 'Level 1' uses 592.0 KB compressed. 

Level 3 'Level 2' uses 2.2 MB compressed. 

Level 4 'Level 3' uses 2.3 MB compressed. 

Total compressed size 5.3 MB. Total decompressed size 9.9 MB. 

This game could use a little more optimization! For more information, we recommend you read the reducing file size page.  

The Most Important Steps 

1. Load the menu first. Showing an animated logo is a great way to make time go by unnoticed, thus letting the download progress 

further.  

2. Make the first level be short and not use a lot of assets. This way, the first level can be loaded quickly, and by keeping the player 

occupied playing it for a minute or two you can be sure that the download of all remaining assets can be completed in the 

background. Why not have a mini tutorial level where the user can learn the controls of the game? No reason for high-res textures 

http://unity3d.com/support/documentation/Manual/Reducing%20File%20size.html


here or loads of objects, or having all your enemies in the first level. Use the one with the lowest poly-count. And yes, this means 

you might have to design your game with the web player experience in mind.  

3. There is no reason why all music must be available when the game starts. Externalize the music and load it via the WWW class. 

Unity compresses audio with the high quality codec, Ogg Vorbis. However even when compressed, audio takes up a lot of space, 

and if you have to fit things into 3 MB, if you have 5 minutes of music all the compression in the world won't save you. Sacrifices 

are needed. Load a very short track that you can loop until more music has been downloaded. Only load more music when the 

player is hooked on the first level.  

4. Optimize your textures using their Import Settings. After you externalize music, textures easily take up 90% of the game. Typical 

texture sizes are too big for web deployment. In a small browser window, sometimes big textures don't even increase the visual 

fidelity at all. Make sure you use textures that are only as big as they must be (and be ready for more sacrifices here). Halving the 

texture resolution actually makes the texture size a quarter of what it was. And of course all textures should be DXT compressed.  

5. Generally reduce the size of your web players. There is a manual page committed to the utilities Unity offers for optimizing file size 

here. Although Unity uses cutting edge LZMA-based compression which usually compresses game data to anywhere from one 

half to a third of the uncompressed size, you'll need to try everything you can.  

6. Try to avoid Resources.Load. While Resources.Load can be very handy, Unity will not be able to order your assets by when they 

are first used when you use Resources.Load, because any script could attempt to load the Resource. You can set which level will 

include all assets that can be loaded through Resources.Load in the Edit->Project Settings->Player using the First Streamed 

Level With Resources property. Obviously you want to move Resources.Load assets as late as possible into the game or not use 

the feature at all.  

Publishing Streaming Web Players 

Streaming in Unity is level based, and there is an easy workflow to set this up. Internally, Unity does all the dirty work of tracking assets and 

organizing them in the compressed data files optimally, ordering it by the first scene that uses them. You simply have to ensure that the first 

levels in the Build Settings use as few assets as possible. This comes naturally for a "menu level", but for a good web experience you really 

need make sure that the first actual game levels the player is going to play are small too.  

In order to use streaming in Unity, you select Web Player Streamed in the Build Settings. Then the content automatically starts as soon as 

all assets used by the first level are loaded. Try to keep the "menu level" to something like 50-100 KB. The stream continues to load as fast 

as it can, and meanwhile live decompresses. When you look at the Console during/after a build, you can see how large  

You can query the progress of the stream by level, and once a level is available it can be loaded. Use GetStreamProgressForLevel for 

displaying a progress bar and CanStreamedLevelBeLoaded to check if all the data is available to load a specific level.  

This form of streaming is of course linear, which matches how games work in most cases. Sometimes that's not enough. Therefore Unity 

also provides you with API's to load a .unity3d file manually using the WWW class. Video and audio can be streamed as well, and can start 

playing almost immediately, without requiring the movie to be downloaded first. Finally Textures can easily be downloaded via the WWW 

class, as can any textual or binary data your game might depend on.  
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When building a Web Player, Unity automatically generates an HTML file next to the player data file. It contains the default HTML code to 

load the web player data file.  

It is possible to further tweak and customize the generated HTML file to make it fit better with the containing site's design, to add more 

HTML content, etc. The following pages discuss the related subjects in depth:  

http://unity3d.com/support/documentation/ScriptReference/WWW.html
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 HTML code to load Unity content  

 Working with UnityObject  

 Customizing the Unity Web Player loading screen  

 Customizing the Unity Web Player's Behavior  

 Unity Web Player and browser communication  

 Using web player templates  
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Unity content is loaded in the browser by the Unity Web Player plugin. HTML code usually does not communicate with this plugin directly 

but through the help of a script called UnityObject. Its primary task is to make Unity content embedding a very simple task by shielding the 

user from various browser and platform specific issues. It also enables easy Web Player installation.  

The HTML file generated by Unity when building a web player contains all the commonly required functionality. In most cases you don't 

have to modify the HTML file at all. The rest of the document explains the inner workings of this file.  

The UnityObject script has to be loaded before it can be used. This is done at the top of the <head> section.  

<script type="text/javascript" src="http://webplayer.unity3d.com/download_webplayer-3.x/3.0/uo/UnityObject.js"></script> 

The global unityObject variable can now be used to perform various Unity related tasks. The most important one is to embed Unity 

content. This is performed by invoking the embedUnity method that accepts several parameters. The first one specifies the id of the HTML 

element that will be replaced by Unity content. It could be any HTML element with <div> being the most common. Think of it as a 

temporary placeholder where Unity should be placed. The second parameter specifies the path to the web player data file to be displayed. 

The next two parameters specify the width and height of the display for the web player content. The values provided can be pixel values 

(e.g. 600, "450") or percentage values (e.g. "50%", "100%").  

unityObject.embedUnity("unityPlayer", "WebPlayer.unity3d", 600, 450); 

Finally, the HTML placeholder is placed inside the <body> section. It could be as simple as <div id="unityPlayer" />. However for 

maximum compatibility it's best to place some warning message in case the browser doesn't support JavaScript and the placeholder isn't 

replaced by UnityObject.  

<div id="unityPlayer"> 

 <div class="missing"> 

  <a href="http://unity3d.com/webplayer/" title="Unity Web Player. Install now!"> 

   <img alt="Unity Web Player. Install now!" 

src="http://webplayer.unity3d.com/installation/getunity.png" width="193" height="63" /> 

  </a> 

http://unity3d.com/support/documentation/Manual/HTML%20code%20to%20load%20Unity%20Web%20Player%20content.html
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 </div> 

</div> 
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UnityObject is a JavaScript script that simplifies Unity content embedding into HTML. It has functions to detect the Unity Web Player 

plugin, initiate Web Player installation and embed Unity content. Although it's possible to deploy UnityObject.js file on the web server 

alongside the HTML file it's best to load it directly from the Unity server at http://webplayer.unity3d.com/download_webplayer-

3.x/3.0/uo/UnityObject.js. That way you will always reference the most up to date version of UnityObject. Please note that the 

UnityObject.js file hosted on the Unity server is minified to make it smaller and save traffic. If you want to explore the source code you can 

find the original file in the Data\Resources folder on Windows and the Contents/Resources folder on Mac OS X. UnityObject by defaults 

sends anonymous data to GoogleAnalytics which is used to help us identify installation type and conversion rate.  

Functions 

embedUnity 

Embeds Unity content into HTML.  

Parameters:  

 id - HTML element (placeholder) to be replaced by Unity content.  

 src - Path to the web player data file. Can be relative or absolute.  

 width - Width of Unity content. Can be specified in pixel values (i.e. 600, "450") or in percentage values (i.e. "50%", "100%").  

 height - Height of Unity content. Can be specified in pixel values (i.e. 600, "450") or in percentage values (i.e. "50%", "100%").  

 params - Optional. Object containing list of parameters. See Customizing the Unity Web Player loading screen and Customizing the Unity 

Web Player's Behavior for possible values.  

 attributes - Optional. Object containing list of attributes. These will be added to underlying <object> or <embed> tag depending on the 

browser.  

 callback - Optional. Function that will be called once Web Player is loaded. Function must accept single argument that contains following 

properties:  

o success - Boolean value indicating whether operation has succeeded.  

o id - Identifier of the Web Player object that has been loaded (same as placeholder).  

o ref - Web Player object that has been loaded.  

Notes:  

This function usually returns before the operation fully completes. Thus it is not safe to access the Web Player object immediately. A 

callback function can be provided to get notification on completion. Alternatively call getObjectById repeatedly until it doesn't return a null 

value.  

Example:  

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd"> 
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<html xmlns="http://www.w3.org/1999/xhtml"> 

 <head> 

  <title>Unity Web Player | Example</title> 

  <script type="text/javascript" 

src="http://webplayer.unity3d.com/download_webplayer/3.0/uo/UnityObject.js"></script> 

  <script type="text/javascript"> 

  <!-- 

  if (typeof unityObject != "undefined") { 

   unityObject.embedUnity("unityPlayer", "Example.unity3d", 600, 450, null, null, unityLoaded); 

  } 

  function unityLoaded(result) { 

   if (result.success) { 

    var unity = result.ref; 

    var version = unity.GetUnityVersion("3.x.x"); 

    alert("Unity Web Player loaded!\nId: " + result.id + "\nVersion: " + version); 

   } 

   else { 

    alert("Please install Unity Web Player!"); 

   } 

  } 

  --> 

  </script> 

 </head> 

 <body> 

  <!-- This will be replaced by Unity content. --> 



  <div id="unityPlayer">Unity content can't be played. Make sure you are using compatible browser with JavaScript 

enabled.</div> 

 </body> 

</html> 

getObjectById 

Retrieves the Web Player object.  

Parameters:  

 id - Identifier of the Web Player object.  

 callback - Optional. Function that will be called once Web Player is retrieved. This function must accept a single parameter that contains 

the Web Player object.  

Returns the Web Player object or null if the Web Player is not loaded yet.  

Example:  

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtml1-strict.dtd"> 

<html xmlns="http://www.w3.org/1999/xhtml"> 

 <head> 

  <title>Unity Web Player | Example</title> 

  <script type="text/javascript" 

src="http://webplayer.unity3d.com/download_webplayer/3.0/uo/UnityObject.js"></script> 

  <script type="text/javascript"> 

  <!-- 

  if (typeof unityObject != "undefined") { 

   unityObject.embedUnity("unityPlayer", "Example.unity3d", 600, 450, null, null, function(result) { 

    if (result.success) { 

     var versionButton = document.getElementById("versionButton"); 

     versionButton.disabled = false; 

    } 

   }); 



  } 

  function versionButtonClick() { 

   var unity = unityObject.getObjectById("unityPlayer"); 

   var version = unity.GetUnityVersion("3.x.x"); 

   alert(version); 

  } 

  --> 

  </script> 

 </head> 

 <body> 

  <!-- This will be replaced by Unity content. --> 

  <div id="unityPlayer">Unity content can't be played. Make sure you are using compatible browser with JavaScript 

enabled.</div> 

  <div> 

   <input id="versionButton" type="button" value="Version" disabled="disabled" 

onclick="versionButtonClick();" /> 

  </div> 

 </body> 

</html> 

enableFullInstall 

Installs the full Web Player if not available. Normally only a small part of the Web Player is installed and the remaining files are 

automatically downloaded later. The default value is false.  

Parameters:  

 value - Boolean value that enables or disables the feature.  

enableAutoInstall 

Automatically starts Web Player installation if not available. Some platforms don't support this feature. Default value is false.  

Parameters:  



 value - Boolean value that enables or disables the feature.  

enableJavaInstall 

Enables Java based installation. Some platforms doesn't support this feature. Default value is true.  

Parameters:  

 value - Boolean value that enables or disables the feature.  

enableClickOnceInstall 

Enables ClickOnce based installation. Some platforms doesn't support this feature. Default value is true.  

Parameters:  

 value - Boolean value that enables or disables the feature.  

enableGoogleAnalytics 

Notifies Unity about Web Player installation. This doesn't do anything if the Web Player is already installed. Default value is true.  

Parameters:  

 value - Boolean value that enables or disables the feature.  

addLoadEvent 

Registers a function that will be called once the web page is loaded.  

Parameters:  

 event - Function that will be called once the web page is loaded. This function does not expect any parameters.  

addDomLoadEvent 

Registers a function that will be called once the web page's DOM is loaded.  

Parameters:  

 event - Function that will be called once web page's DOM is loaded. This function does not expect any parameters.  
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Customizing the Unity Web Player loading screen 
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By default the Unity Web Player displays a small Unity logo and a progress bar while loading web player content. It is possible to 

customize the appearance of that loading screen, including both the logo and progress bar display.  

Please note that modifying the loader images is only possible with Unity Pro.  
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There are six optional parameters that can be used to customize the appearance of the Unity Web Player loading screen. Those optional 

parameters are:  

 backgroundcolor: The background color of the web player content display region during loading, the default is white.  

 bordercolor: The color of the one pixel border drawn around the web player content display region during loading, the default is white.  

 textcolor: The color of error message text (when data file fails to load for example). The default is black or white, depending on the 

background color.  

 logoimage: The path to a custom logo image, the logo image is drawn centered within the web player content display region during 

loading.  

 progressbarimage: The path to a custom image used as the progress bar during loading. The progress bar image's width is clipped based 

on the amount of file loading completed, therefore it starts with a zero pixel width and animates to its original width when the loading is 

complete. The progress bar is drawn beneath the logo image.  

 progressframeimage: The path to a custom image used to frame the progress bar during loading.  

All color values provided must be 6-digit hexidecimal colors, (eg. FFFFFF, 020F16, etc.). The image paths provided can be either relative or 

absolute links and all image files must be RGB (without transparency) or RGBA (with transparency) 8-bit/channel PNG files. Finally, the 

progressframeimage and the progressbarimage should be the same height.  

Here is an example script that customizes the appearance of the Unity Web Player loading screen. The background color is set to light gray 

(A0A0A0), border color to black (000000), text color to white (FFFFFF) and loader images to MyLogo.png, MyProgressBar.png and 

MyProgressFrame.png. All parameters are grouped into single params object and passed to unityObject.embedUnity method.  

var params = { 

 backgroundcolor: "A0A0A0", 

 bordercolor: "000000", 

 textcolor: "FFFFFF", 

 logoimage: "MyLogo.png", 

 progressbarimage: "MyProgressBar.png", 

 progressframeimage: "MyProgressFrame.png" 

}; 

 

unityObject.embedUnity("unityPlayer", "WebPlayer.unity3d", 600, 450, params); 
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The Unity Web Player allows developers to use a few optional parameters to easily control its behavior in a few ways:  

 disableContextMenu: This parameter controls whether or not the Unity Web Player displays a context menu when the user right- or 

control-clicks on the content. Setting it to true prevents the context menu from appearing and allows content to utilize right-mouse behavior. 

To enable the context menu don't include this parameter.  

 disableExternalCall: This parameter controls whether or not the Unity Web Player allows content to communicate with browser-based 

JavaScript. Setting it to true prevents browser communication and so content cannot call or execute JavaScript in the browser, the default 

is false.  

 disableFullscreen: This parameter controls whether or not the Unity Web Player allows content to be viewed in fullscreen mode. Setting it 

to true prevents fullscreen viewing and removes the "Go Fullscreen" entry from the context menu, the default is false.  

Here is an example script that limits the behavior of the Unity Web Player, the context menu will not be shown. Although there is only one 

parameter it still must be placed inside params object and passed to unityObject.embedUnity method.  

var params = { 

 disableContextMenu: true 

}; 

 

unityObject.embedUnity("unityPlayer", "WebPlayer.unity3d", 600, 450, params); 

In the above example you'll notice that neither disableExternalCall nor disableFullscreen are specified, therefore their default values are 

used.  
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The HTML page that contains Unity Web Player content can communicate with that content and vice versa. Basically there are two 

communication directions:  

 The web page calls functions inside the Unity web player content.  

 The Unity web player content calls functions in the web page.  

Each of these communication directions is described in more detail below.  

Calling Unity web player content functions from the web page 

The Unity Web Player object has a function, SendMessage(), that can be called from a web page in order to call functions within Unity web 

player content. This function is very similar to the GameObject.SendMessage function in the Unity scripting API. When called from a web 

page you pass an object name, a function name and a single argument, and SendMessage() will call the given function in the given game 

object.  
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In order to call the Unity Web Player's SendMessage() function you must first get a reference to the Unity web player object. You can use 

unityObject.getObjectById() function to obtain a reference to the object. Here is an example JavaScript function that would execute the 

SendMessage() function on the Unity web player content with placeholder id value of UnityContent; in turn SendMessage() will then call 

the function MyFunction() on the game object named MyObject, passing a piece of string data as an argument:  

<script type="text/javascript" language="javascript"> 

<!-- 

function SaySomethingToUnity() 

{ 

 var unity = unityObject.getObjectById("UnityContent"); 

 unity.SendMessage("MyObject", "MyFunction", "Hello from a web page!"); 

} 

--> 

</script> 

Inside of the Unity web player content you need to have a script attached to the GameObject named MyObject, and that script needs to 

implement a function named MyFunction:  

function MyFunction(param : String) 

{ 

    Debug.Log(param); 

} 

Note: keep in mind that if the function doesn't have any arguments, then an empty string ("") should be passed as an argument.  

A single string, integer or float argument must be passed when using SendMessage(), the parameter is required on the calling side. If you 

don't need it then just pass a zero or other default value and ignore it on the Unity side. Additionally, the game object specified by the name 

can be given in the form of a path name. For example, /MyObject/SomeChild where SomeChild must be a child of MyObject and 

MyObject must be at the root level due to the '/' in front of its name.  

Calling web page functions from Unity web player content 

In order to call a web page function from within your Unity web player content you must use the Application.ExternalCall() function. Using 

that function you can call any JavaScript function defined in the web page, passing any number of parameters to it. Here is an example 

Unity script that uses the Application.ExternalCall() function to call a function named SayHello() found within the web page, passing a 

piece of string data as an argument:  

Application.ExternalCall( "SayHello", "The game says hello!" ); 

http://unity3d.com/support/documentation/ScriptReference/Application.ExternalCall.html


The web page would need to define the SayHello() function, for example:  

<script type="text/javascript" language="javascript"> 

<!-- 

function SayHello( arg ) 

{ 

    // show the message 

    alert( arg ); 

} 

--> 

</script> 

Executing arbitrary browser code from Unity web player content 

You don't even have to define functions in the embedding web page, instead you can use the Application.ExternalEval() function to 

execute arbitrary browser code from the web player content.  

The following example checks that the page embedding the web player content is fetched from a certain host (unity3d.com), if that's not the 

case then it will redirect to another URL. This technique can be used to prevent deep linking to your web player content:  

Application.ExternalEval( 

    "if(document.location.host != 'unity3d.com') { document.location='http://unity3d.com'; }" 

); 
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To ease rapid deployment as well as testing of your web player in its intended setup, Unity comes with a selection of different templates 

and support for custom templates.  

A template is a folder containing an index file (this could just as easily be a php file as an html file) with some special tags in it and an 

optional thumbnail image. The name of the folder names the template and it can contain any resources that might be used in the 

presentation of it - such as subfolders, images, JavaScripts, server-side scripts and so forth.  
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Built in templates, accessible for all projects, are located in the WebPlayerTemplates folder in the Resources folder of the Unity editor 

application and custom templates are picked up from a folder named WebPlayerTemplates in your projects Assets folder.  

Templates are selectable in the player settings. You will find all available templates listed there with each their thumbnail (or the default one 

if no thumbnail file was provided) and name. Some templates have additional properties, which can be tweaked in the text fields 

immediately below the template selector.  

Template index file tags translation table:  

Tag Meaning 

%UNITY_WEB_NAME% Name of the webplayer. 

%UNITY_WIDTH% Width of the webplayer. 

%UNITY_HEIGHT% Height of the webplayer. 

%UNITY_WEB_PATH% Path to the unity3d file. 

%UNITY_UNITYOBJECT_LOCAL% Path to the local UnityObject.js file. 

%UNITY_UNITYOBJECT_URL% URL UnityObject.js hosted on unity3d.com. 

%UNITY_BETA_WARNING% Location for the Unity beta build warning message. 

%UNITY_CUSTOM_SOME_TAG% Custom template tag "Some tag" - can be set from player settings. 
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Refer to the information on these pages for details on working in-depth with various aspects of Unity.  

The Unity Manual Guide contains sections that apply only to certain platforms. Please select which platforms you want to see. Platform-

specific information can always be seen by clicking on the disclosure triangles on each page. 
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class-Animation 

 

The Animation Inspector 

Properties 

  

Animation The default animation that will be played when Play Automatically is enabled. 

Animations A list of animations that can be accessed from scripts. 

Play Automatically Should the animation be played automatically when starting the game? 

Animate Physics Should the animation interact with physics. 

Animate Only If Visible When enabled, the currently playing animation will not play if the object is not visible on the screen. 
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See the Animation View Guide for more information on how to create animations inside Unity. See the Animation Import page on how to 

import animated characters, or the Animation Scripting page on how to create animated behaviors for your game.  
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class-AnimationClip 

 

An imported animation selected in the Project View 

Animation Clips store all animation data that can be used for animated characters or simple animations.  

They contain only one property which can not be modified: the sample rate. This is the sample rate at which the clip was created. Note that 

Unity performs keyframe reduction when importing animations, thus this is not the number of keys.  

For details on the various import settings for an individual Animation Clip, please see the Mesh Component Reference page.  

Note: Imported animations can't be edited in the Animation View, but if you make a duplicate of the imported animation inside Unity, the 

duplicate can be edited.  
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comp-AssetsGroup 
Assets are the models, textures, sounds and all other "content" files from which you make your game.  

This section describes Components for all asset types. For a general overview of assets, see Assets overview page.  

 Audio Clip  

 Cubemap Texture  

 Flare  

 Font  

 Material  

 Meshes  

 Movie Texture  

 Procedural Material Assets  

 Render Texture  

 Text Asset  

 Texture 2D  

http://unity3d.com/support/documentation/Components/AnimationEditorGuide.html
http://unity3d.com/support/documentation/Manual/Animations.html
http://unity3d.com/support/documentation/Manual/Animation%20Scripting.html
http://unity3d.com/support/documentation/Components/class-Mesh.html
http://unity3d.com/support/documentation/Manual/Asset%20Import%20and%20Creation.html
http://unity3d.com/support/documentation/Components/class-AudioClip.html
http://unity3d.com/support/documentation/Components/class-Cubemap.html
http://unity3d.com/support/documentation/Components/class-Flare.html
http://unity3d.com/support/documentation/Components/class-Font.html
http://unity3d.com/support/documentation/Components/class-Material.html
http://unity3d.com/support/documentation/Components/class-Mesh.html
http://unity3d.com/support/documentation/Components/class-MovieTexture.html
http://unity3d.com/support/documentation/Components/class-ProceduralMaterial.html
http://unity3d.com/support/documentation/Components/class-RenderTexture.html
http://unity3d.com/support/documentation/Components/class-TextAsset.html
http://unity3d.com/support/documentation/Components/class-Texture2D.html
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class-AudioClip 
Audio Clips are audio data used by Audio Sources. Unity supports mono, stereo and multi (up to 8) channels audio assets. Unity supports 

importing the following audio file formats: .aif, .wav, .mp3, and .ogg, and the following tracker module file formats: .xm, .mod, .it, and 

.s3m. The tracker module assets works the same way as any other audio assets in Unity except no waveform preview can be rendered to 

the asset import inspector.  

 

The Audio Clip Inspector 

Properties 

  
Audio Format The specific format that will be used for the sound at runtime. 

Native Larger file size, higher quality. Best for very short sound effects. 

Compressed Smaller file size, lower/variable quality. Best for medium length sound effects and music. 

3D Sound If enabled, the sound will play back in 3D space. Both Mono and Stereo sounds can be played in 3D. 

http://unity3d.com/support/documentation/Components/class-AudioSource.html
http://unity3d.com/support/documentation/Manual/TrackerModules.html
http://unity3d.com/support/documentation/Manual/TrackerModules.html


Force to mono If enabled, the audio clip will be down-mixed to a single channel sound. 

Load Type The way Unity load audio assets runtime. 

Decompress on load Decompress sounds upon load. Use this for smaller compressed sounds to avoid the performance overhead of 

decompressing on the fly. Beware that decompressing sounds on load will use ~10x more memory than 

keeping them compressed in memory, so don't use this for large files. 

Compressed in memory Keep sounds compressed in memory and decompress while playing. This have a slight performance overhead 

(esp. for Ogg/Vorbis compressed files) so only use this for bigger files. 

Stream from disc Stream audio data directly from disc. This uses a fraction of the original sounds size of memory. Use this for 

your music or very long tracks. Depending on the hardware, a general advice is to keep this down to 1-2 

simultaneously streams. 

Compression Amount of Compression to be applied to a Compressed clip. Statistics about file size can be seen beneath the 

slider. It is suggested to drag the slider to a place that leaves the playback "good enough" but still at a small 

enough size to meet your file size/distribution needs. 

Hardware 

Decoding 

(iOS ONLY) Available for compressed audio on iOS devices. Uses Apple's hardware decoder for less CPU intensive 

decompression. Check out Platform Specific details for more info. 

Gapless 

looping 

(Android/iOS ONLY) Use this when compressing a perfect looping audio source file (in a non-compressed PCM format) to 

preserve the loop. Standard MPEG encoders introduce silence around the loop point, which will play as little "click" or "pop". 

Unity handles this smoothly for you. 

Importing Audio Assets 

Unity supports both Compressed and Native Audio. Any type of file (except MP3/Ogg Vorbis) will be initially imported as Native. 

Compressed audio files must be decompressed by the CPU while the game is running, but are smaller in file size. If Stream is checked the 

audio is decompressed on the fly, or else the audio is decompressed entirely upon load. Native PCM formats (WAV, AIFF) have the benefit 

of being higher fidelity without increasing CPU taxation, but create much larger files. Module files (.mod,.it,.s3m..xm) can deliver very high 

quality with an extremely low footprint.  

As a general rule of thumb, Compressed audio(or modules) are best for long files like background music or dialog, and uncompressed is 

better for short sound effects. Tweak the amount of Compression with the compression slider to just before the difference in sound quality 

is noticeable.  

Using 3D Audio 

If an audio clip is marked as a 3D Sound then it will be played back to simulate its position in the game world's 3D space. 3D sounds 

emulate distance and location of sounds by attenuating volume and panning across speakers. Both mono and multiple channel sounds can 

be positioned in 3D. For multiple channel audio, use the spread option on the Audio Source to spread and split out the discrete channels in 

speaker space. Unity offers a variety of options to control and fine-tune the audio behavior in 3D space. Take a look at Audio Source.  

Platform specific details 

 

iOS 
 

On mobile platforms compressed audio is encoded as MP3 for less CPU intensive decompression.  

For performance reasons audio clips can be played back using the Apple hardware codec. To enable this check the "Hardware Decoding" 

checkbox in the Audio Importer. Note that only one hardware audio stream can be decompressed at a time, including the background iPod 

audio.  

If the hardware decoder is not available, the decompression will fall back on the software decoder (on iPhone 3GS or newer Apple's 

software decoder is used over Unity's(FMOD) own decoder).  

 

Android 
 

On mobile platforms compressed audio is encoded as MP3 for less CPU intensive decompression.  

http://unity3d.com/support/documentation/Components/class-AudioSource.html
http://unity3d.com/support/documentation/Components/class-AudioSource.html
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
javascript:ShowHideDiv('iosRef','specific-ios', 'iOS');
javascript:ShowHideDiv('androidRef','specific-android', 'Android');
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class-Cubemap 
A Cubemap Texture is a collection of six separate square Textures that are put onto the faces of an imaginary cube. Most often they are 

used to display infinitely faraway reflections on objects, similar to how Skybox displays faraway scenery in the background. The Reflective 

built-in shaders in Unity use Cubemaps to display reflection.  

 

A mountain scene Cubemap displayed as a reflection on this sphere 

You create Cubemap in one of several ways:  

1. Use Assets->Create->Cubemap, set its properties, and drag six Texture assets onto corresponding Cubemap "faces". Note that 

the textures must be re-applied if changed because the textures are baked into the Cubemap Asset and are in no way linked to 

the textures.  

2. Use the Texture Import Settings to create a Cubemap from a single imported texture asset.  

3. Render your scene into a cubemap from script. Code example in Camera.RenderToCubemap page contains a script for rendering 

cubemaps straight from the editor.  

Properties 

  
Right (+X) Texture for the right global side of the Cubemap face. 

Left (-X) Texture for the up global side of the Cubemap face. 

Top (+Y) Texture for the top global side of the Cubemap face. 

Bottom (-Y) Texture for the bottom global side of the Cubemap face. 

Front (+Z) Texture for the forward global side of the Cubemap face. 

Back (-Z) Texture for the rear global side of the Cubemap face. 

Face Size Width and Height in pixels across each individual Cubemap face. Textures will be internally scaled to fit this 

size, there is no need to manually scale the assets. 

Mipmap Enable to create mipmaps. 

Format Format of the created cubemap. 
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class-Flare 
Flare objects are the source assets that are used by Lens Flare Components. The Flare itself is a combination of a texture file and specific 

information that determines how the Flare behaves. Then when you want to use the Flare in a Scene, you reference the specific Flare from 

inside a LensFlare Component attached to a GameObject.  

http://unity3d.com/support/documentation/Components/class-Skybox.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveFamily.html
http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/ScriptReference/Camera.RenderToCubemap.html
http://unity3d.com/support/documentation/Components/class-LensFlare.html


There are some sample Flares in the Standard Assets package. If you want to add one of these to your scene, attach a Lens Flare 

Component to a GameObject, and drag the Flare you want to use into the Flare property of the Lens Flare, just like assigning a Material to 

a Mesh Renderer.  

 

The Flare Inspector 

Flares work by containing several Flare Elements on a single Texture. Within the Flare, you pick & choose which Elements you want to 

include from any of the Textures.  

Properties 

  

Elements The number of Flare images included in the Flare. 

Image Index Which Flare image to use from the Flare Texture for this Element. See the Flare Textures section below for 

more information. 

Position The Element's offset along a line running from the containing GameObject's position through the screen center. 

0 = GameObject position, 1 = screen center. 

Size The size of the element. 

Color Color tint of the element. 

Use Light Color If the Flare is attached to a Light, enabling this will tint the Flare with the Light's color. 

Rotate If enabled, bottom of the Element will always face the center of the screen, making the Element spin as the 

Lens Flare moves around on the screen. 

Zoom If enabled, the Element will scale up when it becomes visible and scale down again when it isn't. 

Fade If enabled, the Element will fade in to full strength when it becomes visible and fade out when it isn't. 

Flare Texture A texture containing images used by this Flare's Elements. It must be arranged according to one of the 

TextureLayout options. 

Texture Layout How the individual Flare Element images are laid out inside the Flare Texture. 

 

Use Fog If enabled, the Flare will fade away with distance fog. This is used commonly for small Flares. 

Details 

A Flare consists of multiple Elements, arranged along a line. The line is calculated by comparing the position of the GameObject containing 

the Lens Flare to the center of the screen. The line extends beyond the containing GameObject and the screen center. All Flare Elements 

are strung out on this line.  

Flare Textures 

For performance reasons, all Elements of one Flare must share the same Texture. This Texture contains a collection of the different 

images that are available as Elements in a single Flare. The Texture Layout defines how the Elements are laid out in the Flare Texture.  

http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/class-LensFlare.html
http://unity3d.com/support/documentation/printable.html#FlareTextures


Texture Layouts 

These are the options you have for different Flare Texture Layouts. The numbers in the images correspond to the Image Index property 

for each Element.  

  

1 Large 4 Small 

 

Designed for large sun-style Flares where you need one of the Elements to have a higher fidelity than the 

others. This is designed to be used with Textures that are twice as high as they are wide. 

1 Large 2 Medium 8 Small 

 

Designed for complex flares that require 1 high-definition, 2 medium & 8 small images. This is used in the 

standard assets "50mm Zoom Flare" where the two medium Elements are the rainbow-colored circles. This is 

designed to be used with textures that are twice as high as they are wide. 

1 Texture 

 

A single image. 

2x2 grid 

 

A simple 2x2 grid. 

3x3 grid 

 

A simple 3x3 grid. 

4x4 grid 

 

A simple 4x4 grid. 

Hints 

 If you use many different Flares, using a single Flare Texture that contains all the Elements will give you best rendering performance.  

 Lens Flares are blocked by Colliders. A Collider in-between the Flare GameObject and the Camera will hide the Flare, even if the Collider 

does not have a Mesh Renderer.  
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class-Font 
Fonts can be created or imported for use in either the GUI Text or the Text Mesh Components.  

http://unity3d.com/support/documentation/Components/class-GuiText.html
http://unity3d.com/support/documentation/Components/class-TextMesh.html


Importing True Type Font files (.ttf) 

To add a font to your project you need to place the .ttf file in your Assets folder. Unity will then automatically import it. You have to make 

sure that the font has a .ttf extension otherwise Unity will not recognize it.  

To change the Size of the font, highlight it in the Project View and you have a number of options in the Import Settings in the Inspector.  

 

Import Settings for a font 

  

Font Size The size of the font, based on the sizes set in any word processor 

Character The text encoding of the font. You can force the font to display only upper- or lower-case characters here 

  Setting this mode to Dynamic causes Unity to use the underlying OS font rendering routines (see below). 

2.x font placing Unity 3.x uses a more typographically correct vertical font placement compared to 2.x. We now use the font 

ascent stored in the truetype font data rather than computing it when we render the font texture. Ticking this 

Property causes the 2.x vertical positioning to be used. 

Import Settings specific to non-dynamic fonts  

  

Font Rendering The amount of anti-aliasing applied to the font. 

Import Settings specific to dynamic fonts  

  
Style The styling applied to the font, one of Normal, Bold, Italic or BoldAndItalic. 

Include Font Data This setting controls the packaging of the font when used with Dynamic font property. When selected the TTF is 

included in the output of the build. When not selected it is assumed that the end user will have the font already 

installed on their machine. Note that fonts are subject to copyright and you should only include fonts that you 

have licensed or created for yourself. 

Font Names Only available when Include Font Data is not selected. Enter a comma-separated list of font names. These 

fonts will be tried in turn from left to right and the first one found on the gamers machine will be used. 

After you import the font, you can expand the font in Project View to see that it has auto-generated some assets. Two assets are created 

during import: "font material" and "font texture".  

Dynamic fonts 

Unity 3.0 adds support for dynamic font rendering. When you set the Characters drop-down in the Import Settings to Dynamic, Unity will 

not pre-generate a texture with all font characters. Instead, it will use the OS built-in font rendering to create the texture on the fly. This has 

the advantage that it can save in download size and texture memory, especially when you are using a font which is commonly included in 

user systems, so you don't have to include the font data, or when you need to support asian languages or large font sizes (which would 

make the font textures very large using normal font textures). It has the disadvantage that font rendering may not look exactly the same on 

all user machines (especially between mac and windows machines, or when a font is not installed and a fallback font is used), and that it 

can occasionally cause slowdowns as the font textures are generated for the characters needed on screen.  

Dynamic fonts are currently only supported on Desktop platforms (Mac and Windows).  



Unicode support 

Unity has full unicode support. Unicode text allows you to display German, French, Danish or Japanese characters that are usually not 

supported in an ASCII character set. You can also enter a lot of different special purpose characters like arrow signs or the option key sign, 

if your font supports it.  

To use unicode characters, choose either Unicode or Dynamic from the Characters drop-down in the Import Settings. You can now 

display unicode characters with this font. If you are using a GUIText or Text Mesh, you can enter unicode characters into the Component's 

Text field in the Inspector. Note that the Inspector on Mac may not show the unicode characters correctly.  

You can also use unicode characters if you want to set the displayed text from scripting. The Javascript and C# compilers fully support 

Unicode based scripts. You simply have to save your scripts with UTF-16 encoding. In Unitron, this can be done by opening the script and 

choosing Text->Text Encoding->Unicode (UTF 16). Now you can add unicode characters to a string in your script and they will display as 

expected in UnityGUI, a GUIText, or a Text Mesh. On the PC where UniSciTE is used for script editing save scripts using the UCS-2 Little 

Endian encoding.  

Changing Font Color 

There are different ways to change the color of your displayed font, depending on how the font is used.  

GUIText & Text Mesh 

If you are using a GUIText or a Text Mesh, you can change its color by using a custom Material for the font. In the Project View, click on 

Create->Material, and select and set up the newly created Material in the Inspector. Make sure you assign the texture from the font asset 

to the material. If you use the built-in GUI/Text Shader shader for the font material, you can choose the color in the Text Color property of 

the material.  

UnityGUI 

If you are using UnityGUI scripting to display your font, you have much more control over the font's color under different circumstances. To 

change the font's color, you create a GUISkin from Assets->Create->GUI Skin, and define the color for the specific control state, e.g. 

Label->Normal->Text Color. For more details, please read the GUI Skin page.  

Hints 

 To display an imported font select the font and choose GameObject->Create Other->3D Text.  

 Using only lower or upper case characters reduces generated texture size.  

 The default font that Unity supplies is Arial. This font is always available and does not appear in the Project window. On the editor this font 

is treated as a Dynamic font so all characters it contains can be used. When used on a mobile device, however, this default font is treated 

as an ASCII Default Set font. This means that only ASCII characters can be displayed using this font on the mobile devices. To display, for 

example, CJK characters on the mobile devices please use your own font and mark it as Unicode.  
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class-Material 
Materials are used in conjunction with Mesh or Particle Renderers attached to the GameObject. They play an essential part in defining how 

your object is displayed. Materials include a reference to the Shader used to render the Mesh or Particles, so these Components can not 

be displayed without some kind of Material.  

http://unity3d.com/support/documentation/Components/class-GUISkin.html
http://unity3d.com/support/documentation/Components/class-MeshRenderer.html
http://unity3d.com/support/documentation/Components/class-ParticleRenderer.html


 

A Diffuse Shader Material has only two properties - a color and a texture. 

Properties 

The properties of any Material will change depending on the selected Shader. These are the most often used properties:  

  

Shader The Shader that will be used by the Material. For more information, read the Built-in Shader Guide. 

Main Color Any kind of color tint can be applied. Use white for no tint. 

Base The Texture that will be displayed. 

Details 

Materials are used to place Textures onto your GameObjects. You cannot add a Texture directly without a Material, and doing so will 

implicitly create a new Material. The proper workflow is to create a Material, select a Shader, and choose the Texture asset(s) to display 

along with it. For more information on Materials, take a look at the Manual's page about Materials.  

Choosing Shaders 

After you create your material, the first thing you should decide is which Shader to use. You choose it from the drop-down Shader menu.  

http://unity3d.com/support/documentation/Components/Built-in%20Shader%20Guide.html
http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/Manual/Materials.html


 

The Shader drop-down menu  

You can choose any Shader that exists in your project's assets folder or one of the built-in Shaders. You can also create your own Shaders. 

For more information on using the built-in Shaders, view the Built-in Shader Guide. For information on writing your own shaders, take a look 

at the Shaders section of the Manual and ShaderLab Reference.  

Setting shader properties 

Depending on the type of shader selected, a number of different properties can appear in the Inspector.  

 

Properties of a Specular shader 

http://unity3d.com/support/documentation/Components/Built-in%20Shader%20Guide.html
http://unity3d.com/support/documentation/Manual/Shaders.html
http://unity3d.com/support/documentation/Components/SL-Reference.html


 

Properties of a Normal mapped shader 

 

Properties of a Normal mapped Specular shader 

The different types of Shader properties are:  

  

Color pickers Used to choose colors. 

Sliders Used to tweak a number value across the allowed range. 

Textures Used to select textures. 

Texture placement 

The placement of the textures can be altered by changing the Offset and Tiling properties.  



 

This texture is tiled 2x2 times by changing the Tiling properties 

  

Offset Slides the Texture around. 

Tiling Tiles the Texture along the different axes. 

Hints 

 It is a good practice to share a single Material across as many GameObjects as possible. This has great performance benefits.  
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class-Mesh 
Meshes make up a large part of your 3D worlds. You don't build your meshes in Unity, but in another application.  

In Unity, we have done everything in our power to make this process as simple as possible. There are a lot of details, but the following 

pages should address all specificities of the common 3D art packages:  

 Maya  

 Cinema 4D  

 3ds Max  

 Cheetah3D  

 Modo  

 Lightwave  

 Blender  

Other applications 

Unity can read .FBX, .dae (Collada), .3DS, .dxf and .obj files, so if your program can export to this format you're home free. FBX exporters 

for popular 3D packages can be found here. Many packages also have a Collada exporter available.  

Textures 

Unity will attempt to hook up materials to your imported scenes automatically. To take advantage of this, place your textures in a folder 

called "Textures" next to the scene file, or in any folder above it.  

http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectMaya.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectCinema4D.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectMax.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectCheetah3D.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectModo.html
http://unity3d.com/support/documentation/Manual/HOWTO-importObjectLightwave.html
http://unity3d.com/support/documentation/Manual/HOWTO-ImportObjectBlender.html
http://autodesk.com/fbx


 

Place your textures in a Textures folder at or above the asset's level 

Import settings. 

To access the Import Settings for a 3D mesh file, select it and the relevant options will appear in the Inspector.  



 

The Mesh Import Settings dialog 

  Meshes 
 

Scale Factor Unity's physics system expects 1 meter in the game world to be 1 unit in the imported file. If you like to model at 

a different scale, this is the place to fix it. 



Use File Units This option is available only for 3dsMax files. If enabled it imports 3dsMax file as 1FileUnit=1UnityUnit, 

otherwise it imports as 1cm=1UnityUnit. 

Mesh Compression Turning this up will reduce the file size of the mesh, but might introduce irregularities. It's best to turn it up as 

high as possible without the mesh looking too different from the uncompressed version. This is useful for 

optimizing game size. 

Generate Colliders If this is enabled, your meshes will be imported with Mesh Colliders automatically attached. This is useful for 

quickly generating a collision mesh for environment geometry, but should be avoided for geometry you will be 

moving. For more info see Colliders below. 

Swap UVs Use this if lightmapped objects pick up wrong UV channels. This will swap your primary and secondary UV 

channels. 

Generate Lightmap UVs Use this to create UV2 to be used for Lightmapping. 

Advanced Options See Lightmapping UVs document. 

Normals & Tangents 
 

Normals Defines if and how normals should be calculated. This is useful for optimizing game size. 

Import Default option. Imports normals from the file. 

Calculate Calculates normals based on Smoothing angle. If selected, the Smoothing Angle becomes enabled. 

None Disables normals. Use this option if the mesh is neither normal mapped nor affected by realtime lighting. 

Tangents Defines if and how tangents and binormals should be calculated. This is useful for optimizing game size. 

Import Imports tangents and binormals from the file. This option is available only for FBX, Maya and 3dsMax files and 

only when normals are imported from the file. 

Calculate Default option. Calculates tangents and binormals. This option is available only when normals are either 

imported or calculated. 

None Disables tangents and binormals. The mesh will have no Tangents, so won't work with normal-mapped 

shaders. 

Smoothing Angle Sets how sharp an edge has to be to be treated as a hard edge. It is also used to split normal map tangents. 

Split Tangents Enable this if normal map lighting is broken by seams on your mesh. This usually only applies to characters. 

Materials 
 

Generation Controls how materials are generated: 

Off This will not generate materials at all. 

Per Texture Enable this to generate material files near the found texture files. When enabled, different scenes will share the 

same material settings when they use the same textures. For the precise rules, see Material Generation below. 

Per Material This will generate materials per scene, so only this scene uses them. 

Animations 
 

Generation Controls how animations are imported: 

Don't Import No animation or skinning is imported. 

Store in Original Roots Animations are stored in root objects of your animation package (these might be different from root objects in 

Unity). 

Store in Nodes Animations are stored together with the objects they animate. Use this when you have a complex animation 

setup and want full scripting control. 

Store in Root Animations are stored in the scene's transform root objects. Use this when animating anything that has a 

hierarchy. 

Bake Animations When using IK or simulation in your animation package, enable this. Unity will convert to FK on import. This 

option is available only for Maya, 3dsMax and Cinema4D files. 

Animation Wrap mode The default Wrap Mode for the animation in the mesh being imported 

Split Animations If you have multiple animations in a single file, here you can split it into multiple clips. 

Name Name of the split animation clip 

Start First frame of this clip in the model file 

End Last frame of this clip in the model file 

WrapMode What the split clip does when the end of the animation is reached 

Loop Depending on how the animation was created, one extra frame of animation may be required for the split clip to 

loop properly. If your looping animation doesn't look correct, try enabling this option. 

Animation Compression 
 

Anim. Compression What type of compression will be applied to this mesh's animation(s) 

Off Disables animation compression. This means that Unity doesn't reduce keyframe count on import, which leads 

to the highest precision animations, but slower performance and bigger file and runtime memory size. It's not 

recommended to use this option - if you need higher precision animation, you should enable keyframe 

reduction and lower allowed Animation Compression Error values instead. 

http://unity3d.com/support/documentation/Manual/Reducing%20File%20size.html
http://unity3d.com/support/documentation/printable.html#colliders
http://unity3d.com/support/documentation/Manual/LightmappingUV.html
http://unity3d.com/support/documentation/Manual/Reducing%20File%20size.html
http://unity3d.com/support/documentation/Manual/Reducing%20File%20size.html


Keyframe Reduction Reduces keyframes on import. If selected, the Animation Compression Errors options are displayed. 

Keyframe Reduction and 

Compression 

Reduces keyframes on import and compresses keyframes when storing animations in files. This affects only file 

size - the runtime memory size is the same as Keyframe Reduction. If selected, the Animation Compression 

Errors options are displayed. 

Animation Compression 

Errors 

These options are available only when keyframe reduction is enabled. 

Rotation Error Defines how much rotation curves should be reduced. The smaller value you use - the higher precision you get. 

Position Error Defines how much position curves should be reduced. The smaller value you use - the higher precision you get. 

Scale Error Defines how much scale curves should be reduced. The smaller value you use - the higher precision you get. 

Material Generation 

Materials are found based on the following rules:  

 Unity gets the name of the main diffuse material bound to the objects in the scene.  

 Unity looks for a material with this name in a Folder called Materials next to the scene.  

 Unity goes up the project folders, looking for the Material in each Materials folder along the way.  

If Unity can't find the Material, it tries to create one from the texture:  

 Unity checks for a texture with the correct name in the same folder as the scene.  

 Unity checks for a texture with the correct name in a folder called Textures next to the scene.  

 Unity goes up the project folders, looking for the correct texture in each Textures folder along the way.  

 If Unity finds the texture, it creates a Materials folder next to it and creates a material in there.  

Colliders 

Unity features two primary types of colliders: Mesh Colliders and Primitive Colliders. Mesh colliders are components that use imported 

mesh data and can be used for environment collision. When you enable Generate Colliders in the Import Settings, a Mesh collider is 

automatically added when the mesh is added to the Scene. It will be considered solid as far as the physics system is concerned.  

If you are moving the object around (a car for example), you can not use Mesh colliders. Instead, you will have to use Primitive colliders. In 

this case you should disable the Generate Colliders setting.  

Animations 

Animations are automatically imported from the scene. For more details about animation import options see the Animation Import chapter.  

Normal mapping and characters 

If you have a character with a normal map that was generated from a high-polygon version of the model, you should import the game-

quality version with a Smoothing angle of 180 degrees. This will prevent odd-looking seams in lighting due to tangent splitting. If the 

seams are still present with these settings, enable Split tangents across UV seams.  

If you are converting a greyscale image into a normal map, you don't need to worry about this.  

Hints 

 Merge your meshes together as much as possible. Make them share materials and textures. This has a huge performance benefit.  

 If you need to set up your objects further in Unity (adding physics, scripts or other coolness), save yourself a world of pain and name your 

objects properly in your 3D application. Working with lots of pCube17 or Box42-like objects is not fun.  

 Make your meshes be centered on the world origin in your 3D app. This will make them easier to place in Unity.  

The Unity Editor shows too many triangles (compared to what my 3D app says) 

This is correct. What you are looking at is the amount of triangles actually being sent to OpenGLES for rendering. In addition to case where 

something like the material requires them to be sent twice, other things like hard-normals and non contiguous UV increase vertex/triangle 

counts significantly compared to what a modeling app or Unity tells you. Triangles need to be contiguous in both 3D and UV space to form 

a strip, so when you have UV seams, degenerate triangles have to be made to form strips - this bumps up the count. Previously Unity 

http://unity3d.com/support/documentation/Manual/Animations.html


would report triangle counts incorrectly. This was fixed first in the run-time, and recently in the Editor. Now both will report the correct 

amount of triangles *actually* being sent to OpenGLES for rendering.  

See Also 

 Modeling Optimized Characters  

 How do I use normal maps?  

 How do I fix the rotation of an imported model?  
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class-MovieTexture 
Note: This is a Pro/Advanced feature only.  

 

Desktop  
 

Movie Textures are animated Textures that are created from a video file. By placing a video file in your project's Assets Folder, you can 

import the video to be used exactly as you would use a regular Texture.  

Video files are imported via Apple QuickTime. Supported file types are what your QuickTime installation can play (usually .mov, .mpg, 

.mpeg, .mp4, .avi, .asf). On Windows movie importing requires Quicktime to be installed (download here).  

Properties 

The Movie Texture Inspector is very similar to the regular Texture Inspector.  

http://unity3d.com/support/documentation/Manual/Modeling%20Optimized%20Characters.html
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Video files are Movie Textures in Unity 

  

Aniso Level Increases Texture quality when viewing the texture at a steep angle. Good for floor and ground textures 

Filtering Mode Selects how the Texture is filtered when it gets stretched by 3D transformations 

Loop If enabled, the movie will loop when it finishes playing 

Quality Compression of the Ogg Theora video file. A higher value means higher quality, but larger file size 

Details 

When a video file is added to your Project, it will automatically be imported and converted to Ogg Theora format. Once your Movie Texture 

has been imported, you can attach it to any GameObject or Material, just like a regular Texture.  

Playing the Movie 

Your Movie Texture will not play automatically when the game begins running. You must use a short script to tell it when to play.  

// this line of code will make the Movie Texture begin playing 

renderer.material.mainTexture.Play(); 

Attach the following script to toggle Movie playback when the space bar is pressed:  

function Update () { 

 if (Input.GetButtonDown ("Jump")) { 

  if (renderer.material.mainTexture.isPlaying) { 



   renderer.material.mainTexture.Pause(); 

  } 

  else { 

   renderer.material.mainTexture.Play(); 

  } 

 } 

} 

For more information about playing Movie Textures, see the Movie Texture Script Reference page  

Movie Audio 

When a Movie Texture is imported, the audio track accompanying the visuals are imported as well. This audio appears as an AudioClip 

child of the Movie Texture.  

 

The video's audio track appears as a child of the Movie Texture in the Project View 

To play this audio, the Audio Clip must be attached to a GameObject, like any other Audio Clip. Drag the Audio Clip from the Project View 

onto any GameObject in the Scene or Hierarchy View. Usually, this will be the same GameObject that is showing the Movie. Then use 

audio.Play() to make the the movie's audio track play along with its video.  

 

iOS 
 

Movie Textures are not supported on iOS. Instead a full-screen streaming playback is provided using iPhoneUtils.PlayMovie and 

iPhoneUtils.PlayMovieURL.  

You can import your video file just like a regular asset or alternatively you can specify a network-based URL to play a movie located on a 

remote server.  

You need to keep your videos inside of the StreamingAssets folder located in your Project directory. 

Unity iOS supports any movies that already play correctly on an iPod or iPhone, usually that means files with the extensions .mov, .mp4, 

.mpv, and .3gp and using one of the following compression standards:  

http://unity3d.com/support/documentation/ScriptReference/MovieTexture.html
http://unity3d.com/support/documentation/ScriptReference/%20GameObject-audio.html
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 H.264 Baseline Profile Level 3.0 video  

 MPEG-4 Part 2 video  

For more information about supported compression standards consult with iPhone SDK MPMoviePlayerController Class Reference.  

As soon as you call iPhoneUtils.PlayMovie or iPhoneUtils.PlayMovieURL, the screen will fade from your current content to the designated 

background color. It might take some time while movie is ready for playing, meanwhile the player will continue displaying the background 

color and may also display a progress indicator to let the user know the movie is loading. When playback finishes, the screen will fade back 

to your content.  

Video player does not respect switching to mute while playing videos 

As written above, video files are being played using Apple's embedded player (as of SDK 3.2 and iPhone OS 3.1.2 and earlier), so basically 

we cannot do anything about this, since it is a bug in Apple's software. So yes, mute switch is not respected here.  

Video player does not respect device orientation 

Apple video player and iPhone SDK do not provide a way to adjust the orientation of the video. Common approach is to manually create 

two copies of each movie in landscape and portrait orientations, then to determine the orientation of the device before playback and choose 

one of two movies.  

 

Android 
 

Movie Textures are not supported on Android. Instead a full-screen streaming playback is provided using iPhoneUtils.PlayMovie and 

iPhoneUtils.PlayMovieURL.  

You can import your video file just like a regular asset or alternatively you can specify a network-based URL to play a movie located on a 

remote server.  

You need to keep your videos inside of the StreamingAssets folder located in your Project directory. 

Unity Android supports any movies that already Android platform supports, usually that means files with the extensions .mp4 and .3gp and 

using one of the following compression standards:  

 H.263  

 H.264 AVC  

 MPEG-4 SP  

However device vendors are keen on expanding this list, so some Android devices are able to play HD videos and other than listed file 

formats.  

For more information about supported compression standards consult with Android SDK Core Media Formats documentation.  

As soon as you call iPhoneUtils.PlayMovie or iPhoneUtils.PlayMovieURL, the screen will fade from your current content to the designated 

background color. It might take some time while movie is ready for playing, meanwhile the player will continue displaying the background 

color and may also display a progress indicator to let the user know the movie is loading. When playback finishes, the screen will fade back 

to your content.  
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class-ProceduralMaterial 
Procedural Material Assets are textures that are generated for you at run-time. See Procedural Materials in the User Guide for more 

information. A Procedural Material asset can contain one or more procedural materials. These can be viewed in the Inspector just like 

regular materials. Note however that often procedural materials have many tweakable parameters. As with Material assets the Inspector 

shows a preview of the Procedural Material at the bottom of the window.  

http://unity3d.com/support/documentation/Manual/Procedural%20Materials.html


 

A Procedural Material viewed in the Inspector. 

The Inspector window has 4 main panes.  

1. Substance Archive Manager.  

2. Properties.  

3. Generated Textures.  



4. Preview.  

Substance Archive Manager 

The archive view shows you all the procedural materials that the Procedural Material asset contains. Select the procedural material you are 

interested in from the row of previews. Procedural Materials can be Added and Deleted to the Procedural Material Asset archive using the 

plus and minus buttons. Adding a procedural material will create a new material using the prototype encoded in the archive. The third, 

Duplicate button will create a new procedural material that is a copy of the currently selected one, including all its settings. Procedural 

materials can be renamed by typing in a new name in the material header name field.  

Properties 

Material Properties 

These are the regular properties of the material, which are dependent on which shader is chosen. They work the same as for regular 

materials.  

Procedural Properties 

The properties of any Procedural Material will change according to how the procedural material was created.  

  

Generate at Load Generate the substance when the scene loads. If disabled, it will only be generated when prompted from 

scripting. 

Random Seed Procedural materials often need some randomness. The Random Seed can be used to vary the generated 

appearance. Often this will be zero. Just click the Randomize button to get a different seed and observe how 

the material changes. 

Generated Textures 

 

The Generated Textures pane. 

This area allows you to visualize textures that the procedural material generates. The dropdown below each of the generated textures 

allows you to choose which texture map should supply the alpha channel for that texture. You could, for example, specify that the base 

alpha comes from the Transparency image, or from the Specular image. The screen-shot below shows the base alpha channel coming 

from the Specular image.  

Per-Platform Overrides 

When you are building for different platforms, you have to think on the resolution of your textures for the target platform, the size and the 

quality. You can override these options and assign specific values depending on the platform you are deploying to. Note that if you don't 

select any value to override, the Editor will pick the default values when building your project.  



Target Size The targeted size of the generated textures. Most procedural textures are designed to be resolution independent and will 

respect the chosen target size, but in rare cases they will use a fixed size instead, or have the possible sizes limited to within 

a certain range. The actual size of the generated textures can be read in the preview at the bottom of the Inspector. 

Texture 

Format 

What internal representation is used for the texture in memory, once it is generated. This is a tradeoff between size and 

quality: 

Compressed Compressed RGB texture. This will result in considerably less memory used. 

RAW Uncompressed truecolor, this is the highest quality. At 256 KB for a 256x256 texture. 

Preview 

The procedural material preview operates in an identical manner to the material preview. However, unlike the regular material preview it 

shows the pixel dimensions of the generated textures.  
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class-RenderTexture 
Render Textures are special types of Textures that are created and updated at runtime. To use them, you first create a new Render 

Texture and designate one of your Cameras to render into it. Then you can use the Render Texture in a Material just like a regular Texture. 

The Water prefabs in Unity Standard Assets are an example of real-world use of Render Textures for making real-time reflections and 

refractions.  

Render Textures are a Unity Pro feature.  

Properties 

The Render Texture Inspector is different from most Inspectors, but very similar to the Texture Inspector.  

 

The Render Texture Inspector is almost identical to the Texture Inspector 

http://unity3d.com/support/documentation/Components/class-Camera.html
http://unity3d.com/support/documentation/Manual/HOWTO-Water.html
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The Render Texture inspector displays the current contents of Render Texture in realtime and can be an invaluable debugging tool for 

effects that use render textures.  

  

Size The size of the Render Texture in pixels. Observe that only power-of-two values sizes can be chosen. 

Aniso Level Increases Texture quality when viewing the texture at a steep angle. Good for floor and ground textures 

Filter Mode Selects how the Texture is filtered when it gets stretched by 3D transformations: 

No Filtering The Texture becomes blocky up close 

Bilinear The Texture becomes blurry up close 

Trilinear Like Bilinear, but the Texture also blurs between the different mip levels 

Wrap Mode Selects how the Texture behaves when tiled: 

Repeat The Texture repeats (tiles) itself 

Clamp The Texture's edges get stretched 

Example 

A very quick way to make a live arena-camera in your game:  

1. Create a new Render Texture asset using Assets->Create->Render Texture.  

2. Create a new Camera using GameObject->Create Other->Camera.  

3. Assign the Render Texture to the Target Texture of the new Camera.  

4. Create a wide, tall and thin box  

5. Drag the Render Texture onto it to create a Material that uses the render texture.  

6. Enter Play Mode, and observe that the box's texture is updated in real-time based on the new Camera's output.  

 

Render Textures are set up as demonstrated above 

Hints 

 Unity renders everything in the texture assigned to RenderTexture.active.  
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class-TextAsset 
Text Assets are a format for imported text files. When you drop a text file into your Project Folder, it will be converted to a Text Asset. The 

supported text formats are:  

 .txt  

 .html  

 .htm  

 .xml  

 .bytes  



 

The Text Asset Inspector 

Properties 

  

Text The full text of the asset as a single string. 

Details 

The Text Asset is a very specialized use case. It is extremely useful for getting text from different text files into your game while you are 

building it. You can write up a simple .txt file and bring the text into your game very easily. It is not intended for text file generation at 

runtime. For that you will need to use traditional Input/Output programming techniques to read and write external files.  

Consider the following scenario. You are making a traditional text-heavy adventure game. For production simplicity, you want to break up 

all the text in the game into the different rooms. In this case you would make one text file that contains all the text that will be used in one 

room. From there it is easy to make a reference to the correct Text Asset for the room you enter. Then with some customized parsing logic, 

you can manage a large amount of text very easily.  



Binary data 

A special feature of the text asset is that it can be used to store binary data. By giving a file the extension .bytes it can be loaded as a text 

asset and the data can be accessed through the bytes property.  

For example put a jpeg file into the Resources folder and change the extension to .bytes, then use the following script code to read the 

data at runtime:  

//Load texture from disk 

TextAsset bindata= Resources.Load("Texture") as TextAsset; 

Texture2D tex = new Texture2D(1,1); 

tex.LoadImage(bindata.bytes);  

Hints 

 Text Assets are serialized like all other assets in a build. There is no physical text file included when you publish your game.  

 Text Assets are not intended to be used for text file generation at runtime.  
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class-Texture2D 
Textures bring your Meshes, Particles, and interfaces to life! They are image or movie files that you lay over or wrap around your objects. 

As they are so important, they have a lot of properties. If you are reading this for the first time, jump down to Details, and return to the 

actual settings when you need a reference.  

The shaders you use for your objects put specific requirements on which textures you need, but the basic principle is that you can put any 

image file inside your project. If it meets the size requirements (specified below), it will get imported and optimized for game use. This 

extends to multi-layer Photoshop or TIFF files - they are flattened on import, so there is no size penalty for your game.  

Properties 

http://unity3d.com/support/documentation/printable.html#details


The Texture Inspector looks a bit different from most others:  

 

The top section contains a few settings, and the bottom part contains the Texture Importer and the texture preview.  

  

Aniso Level Increases texture quality when viewing the texture at a steep angle. Good for floor and ground textures, see 

below. 

Filter Mode Selects how the Texture is filtered when it gets stretched by 3D transformations: 

http://unity3d.com/support/documentation/printable.html#anisotropy


Point The Texture becomes blocky up close 

Bilinear The Texture becomes blurry up close 

Trilinear Like Bilinear, but the Texture also blurs between the different mip levels 

Wrap Mode Selects how the Texture behaves when tiled: 

Repeat The Texture repeats (tiles) itself 

Clamp The Texture's edges get stretched 

Texture Importer 

Textures all come from image files in your Project Folder. How they are imported is specified by the Texture Importer. You change these 

by selecting the file texture in the Project View and modifying the Texture Importer in the Inspector.  

In Unity 3 we simplified for you all the settings, now you just need to select what are you going to use the texture for and Unity will set 

default parameters for the type of texture you have selected. Of course if you want to have total control of your texture and do specific 

tweaks, you can set the Texture Type to Advanced. This will present the full set of options that you have available.  

  
Texture Type Select this to set basic parameters depending on the purpose of your texture. 

Texture This is the most common setting used for all the textures in general. 

Normal Map Select this to turn the color channels into a format suitable for real-time normal mapping. For more info, see 

Normal Maps 

GUI Use this if your texture is going to be used on any HUD/GUI Controls. 

Reflection Also known as Cube Maps, used to create reflections on textures. check Cubemap Textures for more info. 

Cookie This sets up your texture with the basic parameters used for the Cookies of your lights 

Advanced Select this when you want to have specific parameters on your texture and you want to have total control over 

your texture. 

 

Basic Texture Settings Selected 

Generate Alpha From 

Grayscale 

If enabled, an alpha transparency channel will be generated by the image's existing values of light & 

dark. 

 

Normal Map Settings in the Texture Importer 

Generate from Greyscale 

Bumpiness Control the amount of bumpiness. 

Filtering Determine how the bumpiness is calculated: 

Smooth This generates normal maps that are quite smooth. 

Sharp Also known as a Sobel filter. this generates normal maps that are sharper than Standard. 

 

GUI Settings for the Texture Importer 

You dont need to set any values in this case, Unity will set all the values for you.  

 

Reflection Settings in the Texture Importer 

Mapping This determines how the texture will be mapped to a cubemap. 

Sphere Mapped Maps the texture to a "sphere like" cubemap. 

http://unity3d.com/support/documentation/printable.html#normalmaps
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Cylindrical Maps the texture to a cylinder, use this when you want to use reflections on objects that are like cylinders. 

Simple Sphere Maps the texture to a simple sphere, deforming the reflection when you rotate it. 

Nice Sphere Maps the texture to a sphere, deforming it when you rotate but you still can see the texture's wrap 

An interesting way to add a lot of visual detail to your scenes is to use Cookies - greyscale textures you use to control the precise look of 

in-game lighting. This is fantastic for making moving clouds and giving an impression of dense foliage. The Light page has more info on all 

this, but the main thing is that for textures to be usable for cookies you just need to set the Texture Type to Cookie.  

 

Cookie Settings in the Texture Importer 

Light Type Type of light that the texture will be applied to. (This can be Spotlight, Point or Directional lights). For Directional Lights 

this texture will tile, so in the texture inspector, you must set the Edge Mode to Repeat; for SpotLights You should keep 

the edges of your cookie texture solid black in order to get the proper effect. In the Texture Inspector, set the Edge Mode 

to Clamp. 

Generate Alpha 

from Greyscale 

If enabled, an alpha transparency channel will be generated by the image's existing values of light & dark. 

 

The Advanced Texture Importer Settings dialog 

Non Power of 

2 

If texture has non-power-of-two size, this will define a scaling behavior at import time (for more info see the Texture Sizes 

section below): 

None Texture will be padded to the next larger power-of-two size for use with GUITexture component. 

To nearest Texture will be scaled to the nearest power-of-two size at import time. For instance 257x511 texture will become 256x512. 

Note that PVRTC formats require textures to be square (width equal to height), therefore final size will be upscaled to 

512x512. 

To larger Texture will be scaled to the next larger power-of-two size at import time. For instance 257x511 texture will become 

512x512. 

To smaller Texture will be scaled to the next smaller power-of-two size at import time. For instance 257x511 texture will become 

256x256. 

Generate 

Cube Map 

Generates a cubemap from the texture using different generation methods. 

Read/Write 

Enabled 

Select this to enable access to the texture data from scripts (GetPixels, SetPixels and other Texture2D functions). Note 

however that a copy of the texture data will be made, doubling the amount of memory required for texture asset. Use only if 

absolutely necessary. This is only valid for uncompressed and DTX compressed textures, other types of compressed 

textures cannot be read from. Disabled by default. 

Generate Mip 

Maps 

Select this to enable mip-map generation. Mip maps are smaller versions of the texture that get used when the texture is 

very small on screen. For more info, see Mip Maps below. 

http://unity3d.com/support/documentation/Components/class-Light.html
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Correct 

Gamma 

Select this to enable per-mip-level gamma correction. 

Border Mip 

Maps 

Select this to avoid colors seeping out to the edge of the lower Mip levels. Used for light cookies (see below). 

Mip Map 

Filtering 

Two ways of mip map filtering are available to optimize image quality: 

Box The simplest way to fade out the mipmaps - the mip levels become smoother and smoother as they go down in size. 

Kaiser A sharpening Kaiser algorithm is run on the mip maps as they go down in size. If your textures are too blurry in the distance, 

try this option. 

Fade Out 

Mips 

Enable this to make the mipmaps fade to gray as the mip levels progress. This is used for detail maps. The left most scroll 

is the first mip level to begin fading out at. The rightmost scroll defines the mip level where the texture is completely grayed 

out 

Generate 

Normal Map 

Enable this to turn the color channels into a format suitable for real-time normal mapping. For more info, see Normal Maps, 

below. 

Bumpiness Control the amount of bumpiness. 

Filtering Determine how the bumpiness is calculated: 

Smooth This generates normal maps that are quite smooth. 

Sharp Also known as a Sobel filter. this generates normal maps that are sharper than Standard. 

Normal Map Select this if you want to see how the normal map will be applied to your texture. 

Lightmap Select this if you want to use the texture as a lightmap. 

Per-Platform Overrides 

When you are building for different platforms, you have to think on the resolution of your textures for the target platform, the size and the 

quality. With Unity 3 you can override these options and assign specific values depending on the platform you are deploying to. Note that if 

you don't select any value to override, the Editor will pick the default values when building your project.  

 

Default settings for all platforms. 

Max Texture 

Size 

The maximum imported texture size. Artists often prefer to work with huge textures - scale the texture down to a suitable 

size with this. 

Texture Format What internal representation is used for the texture. This is a tradeoff between size and quality. In the examples below we 

show the final size of a in-game texture of 256 by 256 pixels: 

Compressed Compressed RGB texture. This is the most common format for diffuse textures. 4 bits per pixel (32 KB for a 256x256 

texture). 

16 bit Low-quality truecolor. Has 16 levels of red, green, blue and alpha. 

Truecolor Truecolor, this is the highest quality. At 256 KB for a 256x256 texture. 

If you have set the Texture Type to Advanced then the Texture Format has different values.  

 

Desktop  
 

Texture Format What internal representation is used for the texture. This is a tradeoff between size and quality. In the examples below 

we show the final size of an in-game texture of 256 by 256 pixels: 

RGB 

Compressed 

DXT1 

Compressed RGB texture. This is the most common format for diffuse textures. 4 bits per pixel (32 KB for a 256x256 

texture). 

RGBA 

Compressed 

DXT5 

Compressed RGBA texture. This is the main format used for diffuse & specular control textures. 1 byte/pixel (64 KB for 

a 256x256 texture). 

RGB 16 bit 65 thousand colors with no alpha. Compressed DXT formats use less memory and usually look better. 128 KB for a 

256x256 texture. 
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RGB 24 bit Truecolor but without alpha. 192 KB for a 256x256 texture. 

Alpha 8 bit High quality alpha channel but without any color. 64 KB for a 256x256 texture. 

RGBA 16 bit Low-quality truecolor. Has 16 levels of red, green, blue and alpha. Compressed DXT5 format uses less memory and 

usually looks better. 128 KB for a 256x256 texture. 

RGBA 32 bit Truecolor with alpha - this is the highest quality. At 256 KB for a 256x256 texture, this one is expensive. Most of the 

time, DXT5 offers sufficient quality at a much smaller size. The main way this is used is for normal maps, as DXT 

compression there often carries a visible quality loss. 

 

iOS 
 

Texture Format What internal representation is used for the texture. This is a tradeoff between size and quality. In the examples 

below we show the final size of a in-game texture of 256 by 256 pixels: 

RGB Compressed 

PVRTC 4 bits 

Compressed RGB texture. This is the most common format for diffuse textures. 4 bits per pixel (32 KB for a 

256x256 texture) 

RGBA Compressed 

PVRTC 4 bits 

Compressed RGBA texture. This is the main format used for diffuse & specular control textures or diffuse 

textures with transparency. 4 bits per pixel (32 KB for a 256x256 texture) 

RGB Compressed 

PVRTC 2 bits 

Compressed RGB texture. Lower quality format suitable for diffuse textures. 2 bits per pixel (16 KB for a 256x256 

texture) 

RGBA Compressed 

PVRTC 2 bits 

Compressed RGBA texture. Lower quality format suitable for diffuse & specular control textures. 2 bits per pixel 

(16 KB for a 256x256 texture) 

RGB Compressed DXT1 Compressed RGB texture. This format is not supported on iOS, but kept for backwards compatibility with desktop 

projects. 

RGBA Compressed 

DXT5 

Compressed RGBA texture. This format is not supported on iOS, but kept for backwards compatibility with 

desktop projects. 

RGB 16 bit 65 thousand colors with no alpha. Uses more memory than PVRTC formats, but could be more suitable for UI or 

crisp textures without gradients. 128 KB for a 256x256 texture. 

RGB 24 bit Truecolor but without alpha. 192 KB for a 256x256 texture. 

Alpha 8 bit High quality alpha channel but without any color. 64 KB for a 256x256 texture. 

RGBA 16 bit Low-quality truecolor. Has 16 levels of red, green, blue and alpha. Uses more memory than PVRTC formats, but 

can be handy if you need exact alpha channel. 128 KB for a 256x256 texture. 

RGBA 32 bit Truecolor with alpha - this is the highest quality. At 256 KB for a 256x256 texture, this one is expensive. Most of 

the time, PVRTC formats offers sufficient quality at a much smaller size. 

 

Android 
 

Texture Format What internal representation is used for the texture. This is a tradeoff between size and quality. In the examples 

below we show the final size of a in-game texture of 256 by 256 pixels: 

RGB Compressed 

DXT1 

Compressed RGB texture. Supported by Nvidia Tegra. 4 bits per pixel (32 KB for a 256x256 texture). 

RGBA Compressed 

DXT5 

Compressed RGBA texture. Supported by Nvidia Tegra. 6 bits per pixel (64 KB for a 256x256 texture). 

RGB Compressed 

ETC 4 bits 

Compressed RGB texture. This is the default texture format for Android projects. ETC1 is part of OpenGL ES 2.0 

and is supported by all OpenGL ES 2.0 GPUs. It does not support alpha. 4 bits per pixel (32 KB for a 256x256 

texture) 

RGB Compressed 

PVRTC 2 bits 

Compressed RGB texture. Supported by Imagination PowerVR GPUs. 2 bits per pixel (16 KB for a 256x256 

texture) 

RGBA Compressed 

PVRTC 2 bits 

Compressed RGBA texture. Supported by Imagination PowerVR GPUs. 2 bits per pixel (16 KB for a 256x256 

texture) 

RGB Compressed 

PVRTC 4 bits 

Compressed RGB texture. Supported by Imagination PowerVR GPUs. 4 bits per pixel (32 KB for a 256x256 

texture) 

RGBA Compressed 

PVRTC 4 bits 

Compressed RGBA texture. Supported by Imagination PowerVR GPUs. 4 bits per pixel (32 KB for a 256x256 

texture) 

RGB Compressed 

ATC 4 bits 

Compressed RGB texture. Supported by Qualcomm Snapdragon. 4 bits per pixel (32 KB for a 256x256 texture). 

RGBA Compressed Compressed RGBA texture. Supported by Qualcomm Snapdragon. 6 bits per pixel (64 KB for a 256x256 texture). 
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ATC 8 bits 

RGB 16 bit 65 thousand colors with no alpha. Uses more memory than the compressed formats, but could be more suitable for 

UI or crisp textures without gradients. 128 KB for a 256x256 texture. 

RGB 24 bit Truecolor but without alpha. 192 KB for a 256x256 texture. 

Alpha 8 bit High quality alpha channel but without any color. 64 KB for a 256x256 texture. 

RGBA 16 bit Low-quality truecolor. The default compression for the textures with alpha channel. 128 KB for a 256x256 texture. 

RGBA 32 bit Truecolor with alpha - this is the highest quality compression for the textures with alpha. 256 KB for a 256x256 

texture. 

Unless you're targeting a specific hardware, like Tegra, we'd recommend using ETC1 compression. If needed you could store an external 

alpha channel and still benefit from lower texture footprint. If you absolutely want to store an alpha channel in a texture, RGBA16 bit is the 

compression supported by all hardware vendors.  

If your app utilizes an unsupported texture compression, the textures will be uncompressed to RGBA 32 and stored in memory along with 

the compressed ones. So in this case you lose time decompressing textures and lose memory storing them twice. It may also have a very 

negative impact on rendering performance.  

Details 

Supported Formats 

Unity can read the following file formats: PSD, TIFF, JPG, TGA, PNG, GIF, BMP, IFF, PICT. It should be noted that Unity can import multi-

layer PSD & TIFF files just fine. They are flattened automatically on import but the layers are maintained in the assets themselves, so you 

don't lose any of your work when using these file types natively. This is important as it allows you to just have one copy of your textures that 

you can use from Photoshop, through your 3D modelling app and into Unity.  

Texture Sizes 

Ideally texture sizes should be powers of two on the sides. These sizes are as follows: 2, 4, 8, 16, 32, 64, 128, 256, 512, 1024 or 2048 

pixels. The textures do not have to be square, i.e. width can be different from height.  

It is possible to use other (non power of two) texture sizes with Unity. Non power of two texture sizes work best when used on GUI 

Textures, however if used on anything else they will be converted to an uncompressed RGBA 32 bit format. That means they will take up 

more video memory (compared to PVRT(iOS)/DXT(Desktop) compressed textures), will be slower to load and slower to render (if you are 

on iOS mode). In general you'll use non power of two sizes only for GUI purposes.  

Non power of two texture assets can be scaled up at import time using the Non Power of 2 option in the advanced texture type in the 

import settings. Unity will scale texture contents as requested, and in the game they will behave just like any other texture, so they can still 

be compressed and very fast to load.  

UV Mapping 

When mapping a 2D texture onto a 3D model, some sort of wrapping is done. This is called UV mapping and is done in your 3D modelling 

app. Inside Unity, you can scale and move the texture using Materials. Scaling normal & detail maps is especially useful.  

Mip Maps 

Mip Maps are a list of progressively smaller versions of an image, used to optimise performance on real-time 3D engines. Objects that are 

far away from the camera use the smaller texture versions. Using mip maps uses 33% more memory, but not using them can be a huge 

performance loss. You should always use mipmaps for in-game textures; the only exceptions are textures that will never be minified (e.g. 

GUI textures).  

Normal Maps 

Normal maps are used by normal map shaders to make low-polygon models look as if they contain more detail. Unity uses normal maps 

encoded as RGB images. You also have the option to generate a normal map from a grayscale height map image.  

Detail Maps 

http://unity3d.com/support/documentation/Components/class-GuiTexture.html
http://unity3d.com/support/documentation/Components/class-GuiTexture.html
http://unity3d.com/support/documentation/Components/class-Material.html


If you want to make a terrain, you normally use your main texture to show where there are areas of grass, rocks sand, etc... If your terrain 

has a decent size, it will end up very blurry. Detail textures hide this fact by fading in small details as your main texture gets up close.  

When drawing detail textures, a neutral gray is invisible, white makes the main texture twice as bright and black makes the main texture 

completely black.  

Reflections (Cube Maps) 

If you want to use texture for reflection maps (e.g. use the Reflective builtin shaders), you need to use Cubemap Textures.  

Anisotropic filtering 

Anisotropic filtering increases texture quality when viewed from a grazing angle, at some expense of rendering cost (the cost is entirely on 

the graphics card). Increasing anisotropy level is usually a good idea for ground and floor textures. In Quality Settings anisotropic filtering 

can be forced for all textures or disabled completely.  

 

No anisotropy (left) / Maximum anisotropy (right) used on the ground texture 
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comp-AudioGroup 
These Components implement sound in Unity.  

 Audio Listener - Add this to a Camera to get 3D positional sound.  

 Audio Source - Add this Component to a GameObject to make it play a sound.  
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class-AudioListener 
The Audio Listener acts as a microphone-like device. It receives input from any given Audio Source in the scene and plays sounds 

through the computer speakers. For most applications it makes the most sense to attach the listener to the Main Camera. If an audio 

http://unity3d.com/support/documentation/Manual/HOWTO-UseDetailTexture.html
http://unity3d.com/support/documentation/Components/class-Cubemap.html
http://unity3d.com/support/documentation/Components/class-QualitySettings.html
http://unity3d.com/support/documentation/Components/class-AudioListener.html
http://unity3d.com/support/documentation/Components/class-AudioSource.html
http://unity3d.com/support/documentation/Components/class-AudioSource.html
http://unity3d.com/support/documentation/Components/class-Camera.html


listener is within the boundaries of a Reverb Zone reverberation is applied to all audible sounds in the scene. (PRO only) Furthermore, 

Audio Effects can be applied to the listener and it will be applied to all audible sounds in the scene.  

 

The Audio Listener, attached to the Main Camera 

Properties 

The Audio Listener has no properties. It simply must be added to work. It is always added to the Main Camera by default.  

Details 

The Audio Listener works in conjunction with Audio Sources, allowing you to create the aural experience for your games. When the Audio 

Listener is attached to a GameObject in your scene, any Sources that are close enough to the Listener will be picked up and output to the 

computer's speakers. Each scene can only have 1 Audio Listener to work properly.  

If the Sources are 3D (see import settings in Audio Clip), the Listener will emulate position, velocity and orientation of the sound in the 3D 

world (You can tweak attenuation and 3D/2D behavior in great detail in Audio Source) . 2D will ignore any 3D processing. For example, if 

your character walks off a street into a night club, the night club's music should probably be 2D, while the individual voices of characters in 

the club should be mono with their realistic positioning being handled by Unity.  

You should attach the Audio Listener to either the Main Camera or to the GameObject that represents the player. Try both to find what suits 

your game best.  

Hints 

 Each scene can only have one Audio Listener.  

 You access the project-wide audio settings using the Audio Manager, found in the Edit->Project Settings->Audio menu.  

 View the Audio Clip Component page for more information about Mono vs Stereo sounds.  
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class-AudioSource 
The Audio Source plays back an Audio Clip in the scene. If the Audio Clip is a 3D clip, the source is played back at a given position and 

will attenuate over distance. The audio can be spread out between speakers (stereo to 7.1) (Spread) and morphed between 3D and 2D 

(PanLevel). This can be controlled over distance with falloff curves. Also, if the listener is within 1 or multiple Reverb Zones, reverberations 

is applied to the source. (PRO only) Individual filters can be applied to each audio source for an even richer audio experience. See Audio 

Effects for more details.  

http://unity3d.com/support/documentation/Components/class-AudioReverbZone.html
http://unity3d.com/support/documentation/Components/class-AudioEffect.html
http://unity3d.com/support/documentation/Components/class-AudioSource.html
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http://unity3d.com/support/documentation/Components/class-AudioEffect.html
http://unity3d.com/support/documentation/Components/class-AudioEffect.html


 

The Audio Source gizmo in the Scene View and its settings in the inspector. 

Properties 

  

Audio Clip Reference to the sound clip file that will be played. 

Mute If enabled the sound will be playing but muted. 

Bypass Effects This Is to quickly "by-pass" filter effects applied to the audio source. An easy way to turn all effects on/off. 

Play On Awake If enabled, the sound will start playing the moment the scene launches. If disabled, you need to start it using 

the Play() command from scripting. 

Loop Enable this to make the Audio Clip loop when it reaches the end. 

Priority Determines the priority of this audio source among all the ones that coexist in the scene. (Priority: 0 = most 

important. 256 = least important. Default = 128.). Use 0 for music tracks to avoid it getting occasionally 

swapped out. 

Volume How loud the sound is at a distance of 1 world unit (1 meter) from the Audio Listener. 

Pitch Amount of change in pitch due to slowdown/speed up of the Audio Clip. Value 1 is normal playback speed. 

3D Sound Settings Settings that are applied to the audio source if the is a 3D Sound. 

Pan Level Sets how much the 3d engine has an effect on the audio source. 

Spread Sets the spread angle to 3d stereo or multichannel sound in speaker space. 

Doppler Level Determines how much doppler effect will be applied to this audio source (if is set to 0, then no effect is applied). 

Min Distance Within the MinDistance, the sound will stay at loudest possible. Outside MinDistance it will begin to attenuate. 

Increase the MinDistance of a sound to make it 'louder' in a 3d world, and decrease it to make it 'quieter' in a 3d 

world. 

Max Distance The distance where the sound stops attenuating at. Beyond this point it will stay at the volume it would be at 

MaxDistance units from the listener and will not attenuate any more. 

Rolloff Mode How fast the sound fades. The higher the value, the closer the Listener has to be before hearing the 

sound.(This is determined by a Graph). 

Logarithmic Rolloff The sound is loud when you are close to the audio source, but when you get away from the object it decreases 

significantly fast. 

Linear Rolloff The more far away from the audio source you go, the less you can hear it. 

Custom Rolloff The sound from the audio source behaves accordingly to how you set the graph of roll offs. 

2D Sound Settings Settings that are applied to the audio source if the is a 3D Sound. 

Pan 2D Sets how much the engine has an effect on the audio source. 



Types of Rolloff 

There are three Rolloff modes: Logarithmic, Linear and Custom Rolloff. The Custom Rolloff can be modified by modifying the volume 

distance curve as described below. If you try to modify the volume distance function when it is set to Logarithmic or Linear, the type will 

automatically change to Custom Rolloff.  

 

Rolloff Modes that an audio source can have. 

Distance Functions 

There are several properties of the audio that can be modified as a function of the distance between the audio source and the audio 

listener.  

Volume: Amplitude(0.0 - 1.0) over distance. 

Pan: Left(-1.0) to Right(1.0) over distance. 

Spread: Angle (degrees 0.0 - 360.0) over distance. 

Low-Pass (only if LowPassFilter is attached to the AudioSource): Cutoff Frequency (22000.0-10.0) over distance.  

 

Distance functions for Volume, Pan, Spread and Low-Pass audio filter. The current distance to the Audio Listener is marked in the graph. 

To modify the distance functions, you can edit the curves directly. For more information, see the guide to Editing Curves.  

Creating Audio Sources 

Audio Sources don't do anything without an assigned Audio Clip. The Clip is the actual sound file that will be played back. The Source is 

like a controller for starting and stopping playback of that clip, and modifying other audio properties.  

To create a new Audio Source:  

1. Import your audio files into your Unity Project. These are now Audio Clips.  

2. Go to GameObject->Create Empty from the menubar.  

3. With the new GameObject selected, select Component->Audio->Audio Source.  

http://unity3d.com/support/documentation/Components/EditingCurves.html


4. Assign the Audio Clip property of the Audio Source Component in the Inspector.  

Note: If you want to create an audio source just for one Audio Clip that you have in the Assets folder, you can drag and drop that Audio 

Clip to the scene view and an Audio Source game object will be created automatically for it.  

Platform specific details 

 

iOS 
 

On mobile platforms compressed audio is encoded as MP3 for speedier decompression. Beware that this compression can remove 

samples at the end of the clip and potentially break a "perfect-looping" clip. Make sure the clip is right on a specific MP3 sample boundary 

to avoid sample clipping (Tools to perform this is widely available). For performance reasons audio clips can be played back using the 

Apple hardware codec. To enable this check the "Use Hardware" checkbox in the import settings. See the Audio Clip documentation for 

more details.  

 

Android 
 

On mobile platforms compressed audio is encoded as MP3 for speedier decompression. Beware that this compression can remove 

samples at the end of the clip and potentially break a "perfect-looping" clip. Make sure the clip is right on a specific MP3 sample boundary 

to avoid sample clipping (Tools to perform this is widely available).  
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class-AudioEffect 
AudioSources and the AudioListener can have filter components applied, by adding the filter components to the same GameObject the 

AudioSource or AudioListener is on. Filter effects are serialized in the component order as seen here:  
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Enabling/Disabling a filter component will bypass the filter. Though highly optimized, some filters are still CPU intensive. Audio CPU usage 

can monitored in the profiler under the Audio Tab.  

See these pages for more information on each filter type:  

 Low Pass Filter  

 High Pass Filter  

 Echo Filter  

 Distortion Filter  

 Reverb Filter  

 Chorus Filter  
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class-AudioLowPassFilter 
The Audio Low Pass Filter filter passes low frequencies of an AudioSource, or all sound reaching an AudioListener, and cuts frequencies 

higher than the Cutoff Frequency. 

The Lowpass Resonance Q (known as Lowpass Resonance Quality Factor) determines how much the filter's self-resonance is 

dampened. Higher Lowpass Resonance Q indicates a lower rate of energy loss i.e. the oscillations die out more slowly. 

The Audio Low Pass Filter has a Rolloff curve associated with it, making it possible to set Cutoff Frequency over distance between the 

AudioSource and the AudioListener.  

http://unity3d.com/support/documentation/Manual/Profiler.html#Audio
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The Audio Low Pass filter properties in the inspector. 

Properties 

  
Cutoff Frequency Lowpass cutoff frequency in hz. 10.0 to 22000.0. Default = 5000.0. 

Lowpass Resonance Q Lowpass resonance Q value. 1.0 to 10.0. Default = 1.0. 

Adding a low pass filter 

To add a low pass filter to a given audio source just select the object in the inspector and then select Component->Audio->Audio Low 

Pass Filter.  

Hints 

 Sounds propagates very differently given the environment. E.g. to compliment a visual fog effect is to add a subtle low-pass to the Audio 

Listener.  

 The high frequencies of a sound being emitted from behind a door will not reach the listener. To simulate this, simply change the Cutoff 

Frequency when opening the door.  
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class-AudioHighPassFilter 
The Audio High Pass Filter passes high frequencies of an AudioSource and cuts off signals with frequencies lower than the Cutoff 

Frequency. 

The Highpass resonance Q (known as Highpass Resonance Quality Factor) determines how much the filter's self-resonance is 

dampened. Higher Highpass resonance Q indicates a lower rate of energy loss i.e. the oscillations die out more slowly.  

 

The Audio high Pass filter properties in the inspector. 

Properties 

  
Cutoff Frequency Highpass cutoff frequency in hz. 10.0 to 22000.0. Default = 5000.0. 

Highpass Resonance Q Highpass resonance Q value. 1.0 to 10.0. Default = 1.0. 

Adding a high pass filter 

To add a high pass filter to a given audio source just select the object in the inspector and then select Component->Audio->Audio High 

Pass Filter.  
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class-AudioEchoFilter 
The Audio Echo Filter repeats a sound after a given Delay, attenuating the repetitions based on the Decay Ratio. 

The Wet Mix determines the amplitude of the filtered signal, where the Dry Mix determines the amplitude of the unfiltered sound output.  

 

The Audio Echo Filter properties in the inspector. 

Properties 

  
Delay Echo delay in ms. 10 to 5000. Default = 500. 

Decay Ratio Echo decay per delay. 0 to 1. 1.0 = No decay, 0.0 = total decay (ie simple 1 line delay). Default = 0.5.L 

Wet Mix Volume of echo signal to pass to output. 0.0 to 1.0. Default = 1.0. 

Dry Mix Volume of original signal to pass to output. 0.0 to 1.0. Default = 1.0. 

Adding an Echo filter 

To add an Echo filter to a given audio source just select the object in the inspector and then select Component->Audio->Audio Echo 

Filter.  

Hints 

 Hard surfaces reflects the propagation of sound. E.g. large canyon can be made more convincing with the Audio Echo Filter.  

 Sound propagates slower than light - we all know that from lightning and thunder. To simulate this, add an Audio Echo Filter to an event 

sound, set the Wet Mix to 0.0 and modulate the Delay to the distance between AudioSource and AudioListener.  
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class-AudioDistorionFilter 
The Audio Distortion Filter distorts the sound from an AudioSource or sounds reaching the AudioListener.  

 

The Audio Distortion Pass filter properties in the inspector. 

Properties 

  
Distortion Distortion value. 0.0 to 1.0. Default = 0.5. 

Adding a Distortion filter 

To add an Audio Distortion Filter to a selected AudioSource or AudioListener select the object in the inspector and then select 

Component->Audio->Audio Distortion Filter.  

Hints 

 Apply the Audio Distortion Filter to simulate the sound of a low quality radio transmission.  

http://unity3d.com/support/documentation/Components/class-AudioSource.html
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class-AudioReverbFilter 
The Audio Reverb Filter takes an Audio Clip and distortionates it in a way to create a personalized reverb effect.  

 

The Audio Reverb filter properties in the inspector. 

Properties 

  

Reverb Preset Custom reverb presets, select user to create your own customized reverbs. 

Dry Level Mix level of dry signal in output in mB. Ranges from -10000.0 to 0.0. Default is 0. 

Room Room effect level at low frequencies in mB. Ranges from -10000.0 to 0.0. Default is 0.0. 

Room HF Room effect high-frequency level re. low frequency level in mB. Ranges from -10000.0 to 0.0. Default is 0.0. 

Room LF Room effect low-frequency level in mB. Ranges from -10000.0 to 0.0. Default is 0.0. 

Decay Time Reverberation decay time at low-frequencies in seconds. Ranges from 0.1 to 20.0. Default is 1.0. 

Decay HFRatio Decay HF Ratio : High-frequency to low-frequency decay time ratio. Ranges from 0.1 to 2.0. Default is 0.5. 

Reflections Level Early reflections level relative to room effect in mB. Ranges from -10000.0 to 1000.0. Default is -10000.0. 

Reflections Delay Late reverberation level relative to room effect in mB. Ranges from -10000.0 to 2000.0. Default is 0.0. 

Reverb Level Late reverberation level relative to room effect in mB. Ranges from -10000.0 to 2000.0. Default is 0.0. 

Reverb Delay Late reverberation delay time relative to first reflection in seconds. Ranges from 0.0 to 0.1. Default is 0.04. 

HFReference Reference high frequency in Hz. Ranges from 20.0 to 20000.0. Default is 5000.0. 

LFReference Reference low-frequency in Hz. Ranges from 20.0 to 1000.0. Default is 250.0. 

Reflections Delay Late reverberation level relative to room effect in mB. Ranges from -10000.0 to 2000.0. Default is 0.0. 

Diffusion Reverberation diffusion (echo density) in percent. Ranges from 0.0 to 100.0. Default is 100.0. 

Density Reverberation density (modal density) in percent. Ranges from 0.0 to 100.0. Default is 100.0. 

Note: These values can only be modified if your Reverb Preset is set to User, else these values will be grayed out and they will have 

default values for each preset.  

Adding a reverb pass filter 

To add a reverb pass filter to a given audio source just select the object in the inspector and then select Component->Audio->Audio 

reverb Filter.  
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class-AudioChorusFilter 
The Audio Chorus Filter takes an Audio Clip and processes it creating a chorus effect.  

The chorus effect modulates the original sound by a sinusoid low frequency oscillator (LFO). The output sounds like there are multiple 

sources emitting the same sound with slight variations - resembling a choir.  

 

The Audio high Pass filter properties in the inspector. 

Properties 

  

Dry Mix Volume of original signal to pass to output. 0.0 to 1.0. Default = 0.5. 

Wet Mix 1 Volume of 1st chorus tap. 0.0 to 1.0. Default = 0.5. 

Wet Mix 2 Volume of 2nd chorus tap. This tap is 90 degrees out of phase of the first tap. 0.0 to 1.0. Default = 0.5. 

Wet Mix 3 Volume of 3rd chorus tap. This tap is 90 degrees out of phase of the second tap. 0.0 to 1.0. Default = 0.5. 

Delay The LFOs' delay in ms. 0.1 to 100.0. Default = 40.0 ms 

Rate The LFOs' modulation rate in Hz. 0.0 to 20.0. Default = 0.8 Hz. 

Depth Chorus modulation depth. 0.0 to 1.0. Default = 0.03. 

Feed Back Chorus feedback. Controls how much of the wet signal gets fed back into the filter's buffer. 0.0 to 1.0. Default = 

0.0. 

Adding a chorus filter 

To add a chorus filter to a given audio source just select the object in the inspector and then select Component->Audio->Audio Chorus 

Filter.  

Hints 

 You can tweak the chorus filter to create a flanger effect by lowering the feedback and decreasing the delay, as the flanger is a variant of 

the chorus.  

 Creating a simple, dry echo can be done by setting Rate and Depth to 0 and tweaking the mixes and Delay  
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class-AudioReverbZone 
Reverb Zones take an Audio Clip and distortionates it depending where the audio listener is located inside the reverb zone. They are used 

when you want to gradually change from a point where there is no ambient effect to a place where there is one. For example when you are 

entering a cavern.  
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The Audio Reverb Zone gizmo seen in the inspector.. 

Properties 

  
Min Distance Represents the radius of the inner circle in the gizmo, this determines the zone where there is a gradually 

reverb effect and a full reverb zone. 

Max Distance Represents the radius of the outer circle in the gizmo, this determines the zone where there is no effect and 

where the reverb starts to get applied gradually. 

Reverb Preset Determines the reverb effect that will be used by the reverb zone. 

To understand better the properties of the reverb zone, check the next image.  

 

How the sound works in a reverb zone 

Adding a Reverb Zone 

To add a Reverb Zone to a given audio source just select the object in the inspector and then select Component->Audio->Audio Reverb 

Zone.  

Hints. 

 You can mix reverb zones to create combined effects  
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comp-DynamicsGroup 
Unity has NVIDIA PhysX physics engine built-in. This allows for unique emergent behaviour and is generally very cool.  



Basics 

To put an object under physics control, simply add a Rigidbody to it. When you do this, the object will be affected by gravity, and can 

collide with other objects in the world.  

Rigidbodies 

Rigidbodies are physically simulated objects. You use Rigidbodies for things that the player can push around, eg. crates or loose objects, 

or you can move Rigidbodies around directly by adding forces to it by scripting.  

If you move the Transform of a non-Kinematic Rigidbody directly it may not collide correctly with other objects. Instead you should move a 

Rigidbody by applying forces and torque to it. You can also add Joints to rigidbodies to make the behavior more complex. For example, you 

could make a physical door or a crane with a swinging chain.  

You also use Rigidbodies to bring vehicles to life, for example you can make cars using a Rigidbody, 4 Wheel Colliders and a script 

applying wheel forces based on the user's Input.  

You can make airplanes by applying forces to the Rigidbody from a script. Or you can create special vehicles or robots by adding various 

Joints and applying forces via scripting.  

Rigidbodies are most often used in combination with primitive colliders.  

Tips:  

 You should never have a parent and child rigidbody together  

 You should never scale the parent of a rigidbody  

Kinematic Rigidbodies 

A Kinematic Rigidbody is a Rigidbody that has the isKinematic option enabled. Kinematic Rigidbodies are not affected by forces, gravity 

or collisions. They are driven explicitly by setting the position and rotation of the Transform or animating them, yet they can interact with 

other non-Kinematic Rigidbodies.  

Kinematic Rigidbodies correctly wake up other Rigidbodies when they collide with them, and they apply friction to Rigidbodies placed on 

top of them.  

These are a few example uses for Kinematic Rigidbodies:  

1. Sometimes you want an object to be under physics control but in another situation to be controlled explicitly from a script or 

animation. For example you could make an animated character whose bones have Rigidbodies attached that are connected with 

joints for use as a Ragdoll. Most of the time the character is under animation control, thus you make the Rigidbody Kinematic. But 

when he gets hit you want him to turn into a Ragdoll and be affected by physics. To accomplish this, you simply disable the 

isKinematic property.  

2. Sometimes you want a moving object that can push other objects yet not be pushed itself. For example if you have an animated 

platform and you want to place some Rigidbody boxes on top, you should make the platform a Kinematic Rigidbody instead of just 

a Collider without a Rigidbody.  

3. You might want to have a Kinematic Rigidbody that is animated and have a real Rigidbody follow it using one of the available 

Joints.  

Static Colliders 

A Static Collider is a GameObject that has a Collider but not a Rigidbody. Static Colliders are used for level geometry which always stays 

at the same place and never moves around. You can add a Mesh Collider to your already existing graphical meshes (even better use the 

Import Settings Generate Colliders check box), or you can use one of the other Collider types.  

http://unity3d.com/support/documentation/Components/class-Rigidbody.html
http://unity3d.com/support/documentation/Components/class-HingeJoint.html
http://unity3d.com/support/documentation/Components/class-WheelCollider.html
http://unity3d.com/support/documentation/Components/class-InputManager.html
http://unity3d.com/support/documentation/Components/class-BoxCollider.html
http://unity3d.com/support/documentation/Components/RigidbodySleeping.html


You should never move a Static Collider on a frame by frame basis. Moving Static Colliders will cause an internal recomputation in PhysX 

that is quite expensive and which will result in a big drop in performance. On top of that the behaviour of waking up other Rigidbodies 

based on a Static Collider is undefined, and moving Static Colliders will not apply friction to Rigidbodies that touch it. Instead, Colliders that 

move should always be Kinematic Rigidbodies.  

Character Controllers 

You use Character Controllers if you want to make a humanoid character. This could be the main character in a third person platformer, 

FPS shooter or any enemy characters.  

These Controllers don't follow the rules of physics since it will not feel right (in Doom you run 90 miles per hour, come to halt in one frame 

and turn on a dime). Instead, a Character Controller performs collision detection to make sure your characters can slide along walls, walk 

up and down stairs, etc.  

Character Controllers are not affected by forces but they can push Rigidbodies by applying forces to them from a script. Usually, all 

humanoid characters are implemented using Character Controllers.  

Character Controllers are inherently unphysical, thus if you want to apply real physics - Swing on ropes, get pushed by big rocks - to your 

character you have to use a Rigidbody, this will let you use joints and forces on your character. Character Controllers are always aligned 

along the Y axis, so you also need to use a Rigidbody if your character needs to be able to change orientation in space (for example under 

a changing gravity). However, be aware that tuning a Rigidbody to feel right for a character is hard due to the unphysical way in which 

game characters are expected to behave. Another difference is that Character Controllers can slide smoothly over steps of a specified 

height, while Rigidbodies will not.  

If you parent a Character Controller with a Rigidbody you will get a "Joint" like behavior.  

Component Details 

Physics Control 

 Rigidbody - Rigidbodies put objects under physics control.  

 Constant Force - A utility component that adds a constant force to a rigidbody. Great for rockets and other quick functionality.  

Colliders 

 Sphere Collider - use for sphere-shaped objects.  

 Box Collider - use for box-shaped objects.  

 Capsule Collider - use for capsule-like (a cylinder with hemisphere ends) objects.  

 Mesh Collider - takes the graphical mesh and uses it as a collision shape.  

 Physic Material - contains settings allowing you to fine-tune your object's physical properties (friction, bounce, etc).  

Joints 

 Hinge Joint - Used to make door hinges.  

 Spring Joint - A spring-like joint.  

 Fixed Joint - Use to "lock" objects together.  

 Configurable Joint - Use create complex joint behaviors of virtually any kind  

Special Function 

 Character Controller and Character Joint - Used to make character controllers.  

 Wheel Collider - A special collider for grounded vehicles.  

 Skinned Cloth - Used to create Skinned cloth  

 Interactive Cloth - Used to create Interactive cloths, this is just normal cloth being simulated.  

http://unity3d.com/support/documentation/Components/class-CharacterController.html
http://unity3d.com/support/documentation/Components/class-Rigidbody.html
http://unity3d.com/support/documentation/Components/class-ConstantForce.html
http://unity3d.com/support/documentation/Components/class-SphereCollider.html
http://unity3d.com/support/documentation/Components/class-BoxCollider.html
http://unity3d.com/support/documentation/Components/class-CapsuleCollider.html
http://unity3d.com/support/documentation/Components/class-MeshCollider.html
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class-BoxCollider 
The Box Collider is a basic cube-shaped collision primitive.  

 

A pile of Box Colliders 

Properties 

  

Material Reference to the Physic Material that determines how this Collider interacts with others. 

Is Trigger If enabled, this Collider is used for triggering events, and is ignored by the physics engine. 

Size The size of the Collider in the X, Y, Z directions. 

Center The position of the Collider in the object's local space. 

Details 

The Box Collider can be resized into different shapes of rectangular prisms. It works great for doors, walls, platforms, etc. It is also effective 

as a human torso in a ragdoll or as a car hull in a vehicle. Of course, it works perfectly for just boxes and crates as well!  

 

A standard Box Collider 

Colliders work with Rigidbodies to bring physics in Unity to life. Whereas Rigidbodies allow objects to be controlled by physics, Colliders 

allow objects to collide with each other. Colliders must be added to objects independently of Rigidbodies. A Collider does not necessarily 

need a Rigidbody attached, but a Rigidbody must be attached in order for the object to move as a result of collisions.  

When a collision between two Colliders occurs and if at least one of them has a Rigidbody attached, three collision messages are sent out 

to the objects attached to them. These events can be handled in scripting, and allow you to create unique behaviors with or without making 

use of the built-in NVIDIA PhysX engine.  

http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionStay.html


Triggers 

An alternative way of using Colliders is to mark them as a Trigger, just check the IsTrigger property checkbox in the Inspector. Triggers are 

effectively ignored by the physics engine, and have a unique set of three trigger messages that are sent out when a collision with a Trigger 

occurs. Triggers are useful for triggering other events in your game, like cutscenes, automatic door opening, displaying tutorial messages, 

etc. Use your imagination!  

Be aware that in order for two Triggers to send out trigger events when they collide, one of them must include a Rigidbody as well. For a 

Trigger to collide with a normal Collider, one of them must have a Rigidbody attached. For a detailed chart of different types of collisions, 

see the collision action matrix in the Advanced section below.  

Friction and bouncyness 

Friction, bouncyness and softness are defined in the Physic Material. The Standard Assets contain the most common physics materials. To 

use one of them click on the Physic Material drop-down and select one, eg. Ice. You can also create your own physics materials and tweak 

all friction values.  

Compound Colliders 

Compound Colliders are combinations of primitive Colliders, collectively acting as a single Collider. They come in handy when you have a 

complex mesh to use in collisions but cannot use a Mesh Collider. To create a Compound Collider, create child objects of your colliding 

object, then add a primitive Collider to each child object. This allows you to position, rotate, and scale each Collider easily and 

independently of one another.  

 

A real-world Compound Collider setup 

In the above picture, the environment has a Mesh Collider attached. Mesh Colliders work the best for terrain or environments made from 

irregular shapes. The gun_model GameObject has a Rigidbody attached, and multiple primitive Colliders as child GameObjects. When the 

Rigidbody parent is moved around by forces, the child Colliders move along with it. The primitive Colliders will collide with the 

environment's Mesh Collider, and the parent Rigidbody will alter the way it moves based on forces being applied to it and how its child 

Colliders interact with other Colliders in the Scene.  

Mesh Colliders can't normally collide with each other. If a Mesh Collider is marked as Convex, then it can collide with another Mesh 

Collider. The typical solution is to use primitive Colliders for any objects that move, and Mesh Colliders for static background objects.  

Hints 

 To add multiple Colliders for an object, create child GameObjects and attach a Collider to each one. This allows each Collider to be 

manipulated independently.  

 You can look at the gizmos in the Scene View to see how the Collider is being calculated on your object.  

 Colliders do their best to match the scale of an object. If you have a non-uniform scale (a scale which is different in each direction), only the 

Mesh Collider can match completely.  

 If you are moving an object through its Transform component but you want to receive Collision/Trigger messages, you must attach a 

Rigidbody to the object that is moving.  

Advanced 

http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerStay.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html


Collider combinations 

There are numerous different combinations of collisions that can happen in Unity. Each game is unique, and different combinations may 

work better for different types of games. If you're using physics in your game, it will be very helpful to understand the different basic Collider 

types, their common uses, and how they interact with other types of objects.  

Static Collider 
These are GameObjects that do not have a Rigidbody attached, but do have a Collider attached. These objects should remain still, or 

move very little. These work great for your environment geometry. They will not move if a Rigidbody collides with them.  

Rigidbody Collider 
These GameObjects contain both a Rigidbody and a Collider. They are completely affected by the physics engine through scripted forces 

and collisions. They might collide with a GameObject that only contains a Collider. These will likely be your primary type of Collider in 

games that use physics.  

Kinematic Rigidbody Collider 
This GameObject contains a Collider and a Rigidbody which is marked IsKinematic. To move this GameObject, you modify its Transform 

Component, rather than applying forces. They're similar to Static Colliders but will work better when you want to move the Collider around 

frequently. There are some other specialized scenarios for using this GameObject.  

This object can be used for circumstances in which you would normally want a Static Collider to send a trigger event. Since a Trigger must 

have a Rigidbody attached, you should add a Rigidbody, then enable IsKinematic. This will prevent your Object from moving from physics 

influence, and allow you to receive trigger events when you want to.  

Kinematic Rigidbodies can easily be turned on and off. This is great for creating ragdolls, when you normally want a character to follow an 

animation, then turn into a ragdoll when a collision occurs, prompted by an explosion or anything else you choose. When this happens, 

simply turn all your Kinematic Rigidbodies into normal Rigidbodies through scripting.  

If you have Rigidbodies come to rest so they are not moving for some time, they will "fall asleep". That is, they will not be calculated during 

the physics update since they are not going anywhere. If you move a Kinematic Rigidbody out from underneath normal Rigidbodies that are 

at rest on top of it, the sleeping Rigidbodies will "wake up" and be correctly calculated again in the physics update. So if you have a lot of 

Static Colliders that you want to move around and have different object fall on them correctly, use Kinematic Rigidbody Colliders.  

Collision action matrix 

Depending on the configurations of the two colliding Objects, a number of different actions can occur. The chart below outlines what you 

can expect from two colliding Objects, based on the components that are attached to them. Some of the combinations only cause one of 

the two Objects to be affected by the collision, so keep the standard rule in mind - physics will not be applied to objects that do not have 

Rigidbodies attached.  

Collision detection occurs and messages are sent upon collision 

  Static Collider Rigidbody Collider Kinematic  

Rigidbody Collider 

Static  

Trigger Collider 

Rigidbody  

Trigger Collider 

Kinematic Rigidbody  

Trigger Collider 

Static Collider   Y         

Rigidbody Collider Y Y Y       

Kinematic Rigidbody Collider   Y         

Static Trigger Collider             

Rigidbody Trigger Collider             

Kinematic Rigidbody Trigger Collider             

Trigger messages are sent upon collision 

  Static Collider Rigidbody Collider Kinematic  

Rigidbody Collider 

Static  

Trigger Collider 

Rigidbody  

Trigger Collider 

Kinematic Rigidbody  

Trigger Collider 

Static Collider         Y Y 

Rigidbody Collider       Y Y Y 

Kinematic Rigidbody Collider       Y Y Y 

Static Trigger Collider   Y Y   Y Y 

http://unity3d.com/support/documentation/Components/class-Transform.html


Rigidbody Trigger Collider Y Y Y Y Y Y 

Kinematic Rigidbody Trigger Collider Y Y Y Y Y Y 

Layer-Based Collision Detection 

In Unity 3.x we introduce something called Layer-Based Collision Detection, and is that you can now selectively tell Unity GameObjects 

to collide with specific layers they are attached to. For more info, you can click here  

Page last updated: 2009-07-16 

 

 

class-CapsuleCollider 
The Capsule Collider is made of two half-spheres joined together by a cylinder. It is the same shape as the Capsule primitive.  

 

A pile of Capsule Colliders 

Properties 

  

Material Reference to the Physic Material that determines how this Collider interacts with others. 

Is Trigger If enabled, this Collider is used for triggering events, and is ignored by the physics engine. 

Radius The radius of the Collider's local width. 

Height The total height of the Collider. 

Direction The axis of the capsule's lengthwise orientation in the object's local space. 

Center The position of the Collider in the object's local space. 

Details 

You can adjust the Capsule Collider's Radius and Height independently of each other. It is used in the Character Controller and works 

great for poles, or can be combined with other Colliders for unusual shapes.  

 

A standard Capsule Collider  

http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html
http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/Components/class-CharacterController.html


Colliders work with Rigidbodies to bring physics in Unity to life. Whereas Rigidbodies allow objects to be controlled by physics, Colliders 

allow objects to collide with each other. Colliders must be added to objects independently of Rigidbodies. A Collider does not necessarily 

need a Rigidbody attached, but a Rigidbody must be attached in order for the object to move as a result of collisions.  

When a collision between two Colliders occurs and if at least one of them has a Rigidbody attached, three collision messages are sent out 

to the objects attached to them. These events can be handled in scripting, and allow you to create unique behaviors with or without making 

use of the built-in NVIDIA PhysX engine.  

Triggers 

An alternative way of using Colliders is to mark them as a Trigger, just check the IsTrigger property checkbox in the Inspector. Triggers are 

effectively ignored by the physics engine, and have a unique set of three trigger messages that are sent out when a collision with a Trigger 

occurs. Triggers are useful for triggering other events in your game, like cutscenes, automatic door opening, displaying tutorial messages, 

etc. Use your imagination!  

Be aware that in order for two Triggers to send out trigger events when they collide, one of them must include a Rigidbody as well. For a 

Trigger to collide with a normal Collider, one of them must have a Rigidbody attached. For a detailed chart of different types of collisions, 

see the collision action matrix in the Advanced section below.  

Friction and bouncyness 

Friction, bouncyness and softness are defined in the Physic Material. The Standard Assets contain the most common physics materials. To 

use one of them click on the Physic Material drop-down and select one, eg. Ice. You can also create your own physics materials and tweak 

all friction values.  

Compound Colliders 

Compound Colliders are combinations of primitive Colliders, collectively acting as a single Collider. They come in handy when you have a 

complex mesh to use in collisions but cannot use a Mesh Collider. To create a Compound Collider, create child objects of your colliding 

object, then add a primitive Collider to each child object. This allows you to position, rotate, and scale each Collider easily and 

independently of one another.  

 

A real-world Compound Collider setup 

In the above picture, the environment has a Mesh Collider attached. Mesh Colliders work the best for terrain or environments made from 

irregular shapes. The gun_model GameObject has a Rigidbody attached, and multiple primitive Colliders as child GameObjects. When the 

Rigidbody parent is moved around by forces, the child Colliders move along with it. The primitive Colliders will collide with the 

environment's Mesh Collider, and the parent Rigidbody will alter the way it moves based on forces being applied to it and how its child 

Colliders interact with other Colliders in the Scene.  

Mesh Colliders can't normally collide with each other. If a Mesh Collider is marked as Convex, then it can collide with another Mesh 

Collider. The typical solution is to use primitive Colliders for any objects that move, and Mesh Colliders for static background objects.  

Hints 

http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionStay.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerStay.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html


 To add multiple Colliders for an object, create child GameObjects and attach a Collider to each one. This allows each Collider to be 

manipulated independently.  

 You can look at the gizmos in the Scene View to see how the Collider is being calculated on your object.  

 Colliders do their best to match the scale of an object. If you have a non-uniform scale (a scale which is different in each direction), only the 

Mesh Collider can match completely.  

 If you are moving an object through its Transform component but you want to receive Collision/Trigger messages, you must attach a 

Rigidbody to the object that is moving.  

Advanced 

Collider combinations 

There are numerous different combinations of collisions that can happen in Unity. Each game is unique, and different combinations may 

work better for different types of games. If you're using physics in your game, it will be very helpful to understand the different basic Collider 

types, their common uses, and how they interact with other types of objects.  

Static Collider 
These are GameObjects that do not have a Rigidbody attached, but do have a Collider attached. These objects should remain still, or 

move very little. These work great for your environment geometry. They will not move if a Rigidbody collides with them.  

Rigidbody Collider 
These GameObjects contain both a Rigidbody and a Collider. They are completely affected by the physics engine through scripted forces 

and collisions. They might collide with a GameObject that only contains a Collider. These will likely be your primary type of Collider in 

games that use physics.  

Kinematic Rigidbody Collider 
This GameObject contains a Collider and a Rigidbody which is marked IsKinematic. To move this GameObject, you modify its Transform 

Component, rather than applying forces. They're similar to Static Colliders but will work better when you want to move the Collider around 

frequently. There are some other specialized scenarios for using this GameObject.  

This object can be used for circumstances in which you would normally want a Static Collider to send a trigger event. Since a Trigger must 

have a Rigidbody attached, you should add a Rigidbody, then enable IsKinematic. This will prevent your Object from moving from physics 

influence, and allow you to receive trigger events when you want to.  

Kinematic Rigidbodies can easily be turned on and off. This is great for creating ragdolls, when you normally want a character to follow an 

animation, then turn into a ragdoll when a collision occurs, prompted by an explosion or anything else you choose. When this happens, 

simply turn all your Kinematic Rigidbodies into normal Rigidbodies through scripting.  

If you have Rigidbodies come to rest so they are not moving for some time, they will "fall asleep". That is, they will not be calculated during 

the physics update since they are not going anywhere. If you move a Kinematic Rigidbody out from underneath normal Rigidbodies that are 

at rest on top of it, the sleeping Rigidbodies will "wake up" and be correctly calculated again in the physics update. So if you have a lot of 

Static Colliders that you want to move around and have different object fall on them correctly, use Kinematic Rigidbody Colliders.  

Collision action matrix 

Depending on the configurations of the two colliding Objects, a number of different actions can occur. The chart below outlines what you 

can expect from two colliding Objects, based on the components that are attached to them. Some of the combinations only cause one of 

the two Objects to be affected by the collision, so keep the standard rule in mind - physics will not be applied to objects that do not have 

Rigidbodies attached.  

Collision detection occurs and messages are sent upon collision 

  Static Collider Rigidbody Collider Kinematic  

Rigidbody Collider 

Static  

Trigger Collider 

Rigidbody  

Trigger Collider 

Kinematic Rigidbody  

Trigger Collider 

Static Collider   Y         

Rigidbody Collider Y Y Y       

Kinematic Rigidbody Collider   Y         

http://unity3d.com/support/documentation/Components/class-Transform.html


Static Trigger Collider             

Rigidbody Trigger Collider             

Kinematic Rigidbody Trigger Collider             

Trigger messages are sent upon collision 

  Static Collider Rigidbody Collider Kinematic  

Rigidbody Collider 

Static  

Trigger Collider 

Rigidbody  

Trigger Collider 

Kinematic Rigidbody  

Trigger Collider 

Static Collider         Y Y 

Rigidbody Collider       Y Y Y 

Kinematic Rigidbody Collider       Y Y Y 

Static Trigger Collider   Y Y   Y Y 

Rigidbody Trigger Collider Y Y Y Y Y Y 

Kinematic Rigidbody Trigger Collider Y Y Y Y Y Y 

Layer-Based Collision Detection 

In Unity 3.x we introduce something called Layer-Based Collision Detection, and is that you can now selectively tell Unity GameObjects 

to collide with specific layers they are attached to. For more info, you can click here  
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class-CharacterController 
The Character Controller is mainly used for third-person or first-person player control that does not make use of Rigidbody physics.  

 

The Character Controller 

Properties 

  
Height The Character's Capsule Collider height. Changing this will scale the collider along the Y axis in both positive 

and negative directions. 

Radius Length of the Capsule Collider's radius. This is essentially the width of the collider. 

Slope Limit Limits the collider to only climb slopes that are equal to or less than the indicated value. 

Step Offset The character will step up a stair only if it is closer to the ground than the indicated value. 

Min Move Distance If the character tries to move below the indicated value, it will not move at all. This can be used to reduce jitter. 

In most situations this value should be left at 0. 

Skin width Two colliders can penetrate each other as deep as their Skin Width. Larger Skin Widths reduce jitter. Low Skin 

Width can cause the character to get stuck. A good setting is to make this value 10% of the Radius. 

Center This will offset the Capsule Collider in world space, and won't affect how the Character pivots. 

Details 

The traditional Doom-style first person controls are not physically realistic. The character runs 90 miles per hour, comes to a halt 

immediately and turns on a dime. Because it is so unrealistic, use of Rigidbodies and physics to create this behavior is impractical and will 

feel wrong. The solution is the specialized Character Controller. It is simply a capsule shaped Collider which can be told to move in some 

http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html
http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html


direction from a script. The Controller will then carry out the movement but be constrained by collisions. It will slide along walls, walk up 

stairs (if they are lower than the Step Offset) and walk on slopes within the Slope Limit.  

The Controller does not react to forces on its own and it does not automatically push Rigidbodies away.  

If you want to push Rigidbodies or objects with the Character Controller, you can apply forces to any object that it collides with via the 

OnControllerColliderHit() function through scripting.  

On the other hand, if you want your player character to be affected by physics then you might be better off using a Rigidbody instead of the 

Character Controller.  

Fine-tuning your character 

You can modify the Height and Radius to fit your Character's mesh. It is recommended to always use around 2 meters for a human-like 

character. You can also modify the Center of the capsule in case your pivot point is not at the exact center of the Character.  

Step Offset can affect this too, make sure that this value is between 0.1 and 0.4 for a 2 meter sized human.  

Slope Limit should not be too small. Often using a value of 90 degrees works best. The Character Controller will not be able to climb up 

walls due to the capsule shape.  

Don't get stuck 

The Skin Width is one of the most critical properties to get right when tuning your Character Controller. If your character gets stuck it is 

most likely because your Skin Width is too small. The Skin Width will let objects slightly penetrate the Controller but it removes jitter and 

prevents it from getting stuck.  

It's good practice to keep your Skin Width at least greater than 0.01 and more than 10% of the Radius.  

We recommend keeping Min Move Distance at 0.  

See the Character Controller script reference here  

You can download an example project showing pre-setup animated and moving character controllers from the Resources area on our 

website.  

Hints 

 Try adjusting your Skin Width if you find your character getting stuck frequently.  

 The Character Controller can affect objects using physics if you write your own scripts.  

 The Character Controller can not be affected by objects through physics.  
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class-CharacterJoint 
Character Joints are mainly used for Ragdoll effects. They are an extended ball-socket joint which allows you to limit the joint on each 

axis.  

If you just want to set up a ragdoll read about Ragdoll Wizard.  

http://unity3d.com/support/documentation/Components/class-Rigidbody.html
http://unity3d.com/support/documentation/ScriptReference/CharacterController.html
http://www.unity3d.com/support/resources
http://unity3d.com/support/documentation/Components/wizard-RagdollWizard.html


 

The Character Joint on a Ragdoll 

Properties 

  

Connected Body Optional reference to the Rigidbody that the joint is dependent upon. If not set, the joint connects to the world. 

Anchor The point in the GameObject's local space where the joint rotates around. 

Axis The twist axes. Visualized with the orange gizmo cone. 

Swing Axis The swing axis. Visualized with the green gizmo cone. 

Low Twist Limit The lower limit of the joint. 

High Twist Limit The higher limit of the joint. 

Swing 1 Limit Lower limit around the defined Swing Axis 

Swing 2 Limit Upper limit around the defined Swing Axis 

Break Force The force that needs to be applied for this joint to break. 

Break Torque The torque that needs to be applied for this joint to break. 

Details 

Character joint's give you a lot of possibilities for constraining motion like with a universal joint.  

The twist axis (visualized with the orange gizmo) gives you most control over the limits as you can specify a lower and upper limit in 

degrees (the limit angle is measured relative to the starting position). A value of -30 in Low Twist Limit->Limit and 60 in High Twist Limit-

>Limit limits the rotation around the twist axis (orange gizmo) between -30 and 60 degrees.  

The Swing 1 Limit limits the rotation around the swing axis (green axis). The limit angle is symmetric. Thus a value of eg. 30 will limit the 

rotation between -30 and 30.  

The Swing 2 Limit axis doesn't have a gizmo but the axis is orthogonal to the 2 other axes. Just like the previous axis the limit is 

symmetric, thus a value of eg. 40 will limit the rotation around that axis between -40 and 40 degrees.  

Breaking joints 

You can use the Break Force and Break Torque properties to set limits for the joint's strength. If these are less than infinity, and a 

force/torque greater than these limits are applied to the object, its Fixed Joint will be destroyed and will no longer be confined by its 

restraints.  

Hints 

 You do not need to assign a Connected Body to your joint for it to work.  

 Character Joints require your object to have a Rigidbody attached.  
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class-ConfigurableJoint 
Configurable Joints are extremely customizable. They expose all joint-related properties of PhysX, so they are capable of creating 

behaviors similar to all other joint types.  

 

Properties of the Configurable Joint 

Details 

There are two primary functions that the Configurable Joint can perform: movement/rotation restriction and movement/rotation acceleration. 

These functions depend on a number of inter-dependent properties. It may require some experimentation to create the exact behavior 

you're trying to achieve. We'll now give you an overview of the Joint's functionality to make your experimentation as simple as possible.  

Movement/Rotation Restriction 

You specify restriction per axis and per motion type. XMotion, YMotion, and ZMotion allow you to define translation along that axis. 

Angular XMotion, Angular YMotion, and Angular ZMotion allow you to define rotation around that axis. Each one of these properties 

can be set to Free (unrestricted), Limited (restricted based on limits you can define), or Locked (restricted to zero movement).  

Limiting Motion 

When you have any of the "Motion" properties set to Limited, you can define the limitations of movement for that axis. You do this by 

changing the values of one of the "Limit" properties.  

For translation of movement (non-angular), the Linear Limit property will define the maximum distance the object can move from its origin. 

Translation on any "Motion" properties set to Limited will be restricted according to Linear Limit->Limit. Think of this Limit property as 

setting a border around the axis for the object.  



Bouncyness, Spring, and Damper will define the behavior of the object when it reaches the Limit on any of the Limited "Motion" axes. If 

all of these values are set to 0, the object will instantly stop moving when it reaches the border. Bouncyness will make the object bounce 

back away from the border. Spring and Damper will use springing forces to pull the object back to the border. This will soften the border, 

so the object will be able to pass through the border and be pulled back instead of stopping immediately.  

Limiting Rotation 

Limiting rotation works almost the same as limiting motion. The difference is that the three "Angular Motion" properties all correspond to 

different "Angular Limit" properties. Translation restriction along all 3 axes are defined by the Linear Limit property, and rotation 

restriction along each of the 3 axes is defined by a separate "Angular Limit" property per axis.  

Angular XMotion limitation is the most robust, as you can define a Low Angular XLimit and a High Angular XLimit. Therefore if you 

want to define a low rotation limit of -35 degrees and a high rotation limit of 180 degrees, you can do this. For the Y and Z axes, the low and 

high rotation limits will be identical, set together by the Limit property of Angular YLimit or Angular ZLimit.  

The same rules about object behavior at the rotation limits from the Limiting Motion section applies here.  

Movement/Rotation Acceleration 

You specify object movement or rotation in terms of moving the object toward a particular position/rotation, or velocity/angular velocity. This 

system works by defining the "Target" value you want to move toward, and using a "Drive" to provide acceleration which will move the 

object toward that target. Each "Drive" has a Mode, which you use to define which "Target" the object is moving toward.  

Translation Acceleration 

The XDrive, YDrive, and ZDrive properties are what start the object moving along that axis. Each Drive's Mode will define whether the 

object should be moving toward the Target Position or Target Velocity or both. For example, when XDrive's mode is set to Position, 

then the object will try to move to the value of Target Position->X.  

When a Drive is using Position in its Mode, its Position Spring value will define how the object is moved toward the Target Position. 

Similarly, when a Drive is using Velocity in its Mode, its Maximum Force value will define how the object is accelerated to the Target 

Velocity.  

Rotation Acceleration 

Rotation acceleration properties: Angular XDrive, Angular YZDrive, and Slerp Drive function the same way as the translation Drives. 

There is one substantial difference. Slerp Drive behaves differently from the Angular Drive functionality. Therefore you can choose to use 

either both Angular Drives or Slerp Drive by choosing one from the Rotation Drive Mode. You cannot use both at once.  

Properties 

  
Anchor The point where the center of the joint is defined. All physics-based simulation will use this point as the center 

in calculations 

Axis The local axis that will define the object's natural rotation based on physics simulation 

Secondary Axis Together, Axis and Secondary Axis define the local coordinate system of the joint. The third axis is set to be 

orthogonal to the other two. 

XMotion Allow movement along the X axis to be Free, completely Locked, or Limited according to Linear Limit 

YMotion Allow movement along the Y axis to be Free, completely Locked, or Limited according to Linear Limit 

ZMotion Allow movement along the Z axis to be Free, completely Locked, or Limited according to Linear Limit 

Angular XMotion Allow rotation around the X axis to be Free, completely Locked, or Limited according to Low and High Angular 

XLimit 

Angular YMotion Allow rotation around the Y axis to be Free, completely Locked, or Limited according to Angular YLimit 

Angular ZMotion Allow rotation around the Z axis to be Free, completely Locked, or Limited according to Angular ZLimit 

Linear Limit Boundary defining movement restriction, based on distance from the joint's origin 

Limit The distance in units from the origin to the wall of the boundary 

Bouncyness Amount of bounce-back force applied to the object when it reaches the Limit 

Spring Strength of force applied to move the object back to the Limit. Any value other than 0 will implicitly soften the 

boundary 

Damper Resistance strength against the Spring 



Low Angular XLimit Boundary defining lower rotation restriction, based on delta from original rotation 

Limit The rotation in degrees that the object's rotation should not drop below 

Bouncyness Amount of bounce-back torque applied to the object when its rotation reaches the Limit 

Spring Strength of force applied to move the object back to the Limit. Any value other than 0 will implicitly soften the 

boundary 

Damper Resistance strength against the Spring 

High Angular XLimit Boundary defining upper rotation restriction, based on delta from original rotation. 

Limit The rotation in degrees that the object's rotation should not exceed 

Bouncyness Amount of bounce-back torque applied to the object when its rotation reaches the Limit 

Spring Strength of force applied to move the object back to the Limit. Any value other than 0 will implicitly soften the 

boundary 

Damper Resistance strength against the Spring 

Angular YLimit Boundary defining rotation restriction, based on delta from original rotation 

Limit The rotation in degrees that the object's rotation should not exceed 

Bouncyness Amount of bounce-back torque applied to the object when its rotation reaches the Limit 

Spring Strength of torque applied to move the object back to the Limit. Any value other than 0 will implicitly soften the 

boundary 

Damper Resistance strength against the Spring 

Angular ZLimit Boundary defining rotation restriction, based on delta from original rotation 

Limit The rotation in degrees that the object's rotation should not exceed 

Bouncyness Amount of bounce-back torque applied to the object when its rotation reaches the Limit 

Spring Strength of force applied to move the object back to the Limit. Any value other than 0 will implicitly soften the 

boundary 

Damper Resistance strength against the Spring 

Target Position The desired position that the joint should move into 

Target Velocity The desired velocity that the joint should move along 

XDrive Definition of how the joint's movement will behave along its local X axis 

Mode Set the following properties to be dependent on Target Position, Target Velocity, or both 

Position Spring Strength of a rubber-band pull toward the defined direction. Only used if Mode includes Position 

Position Damper Resistance strength against the Position Spring. Only used if Mode includes Position 

Maximum Force Amount of strength applied to push the object toward the defined direction. Only used if Mode includes 

Velocity 

YDrive Definition of how the joint's movement will behave along its local Y axis 

Mode Set the following properties to be dependent on Target Position, Target Velocity, or both 

Position Spring Strength of a rubber-band pull toward the defined direction. Only used if Mode includes Position. 

Position Damper Resistance strength against the Position Spring. Only used if Mode includes Position. 

Maximum Force Amount of strength applied to push the object toward the defined direction. Only used if Mode includes 

Velocity. 

ZDrive Definition of how the joint's movement will behave along its local Z axis 

Mode Set the following properties to be dependent on Target Position, Target Velocity, or both. 

Position Spring Strength of a rubber-band pull toward the defined direction. Only used if Mode includes Position 

Position Damper Resistance strength against the Position Spring. Only used if Mode includes Position 

Maximum Force Amount of strength applied to push the object toward the defined direction. Only used if Mode includes 

Velocity 

Target Rotation This is a Quaternion. It defines the desired rotation that the joint should rotate into 

Target Angular Velocity This is a Vector3. It defines the desired angular velocity that the joint should rotate into 

Rotation Drive Mode Control the object's rotation with either X & YZ or Slerp Drive by itself 

Angular XDrive Definition of how the joint's rotation will behave around its local X axis. Only used if Rotation Drive Mode is 

Swing & Twist 

Mode Set the following properties to be dependent on Target Rotation, Target Angular Velocity, or both 

Position Spring Strength of a rubber-band pull toward the defined direction. Only used if Mode includes Position 

Position Damper Resistance strength against the Position Spring. Only used if Mode includes Position 

Maximum Force Amount of strength applied to push the object toward the defined direction. Only used if Mode includes 

Velocity. 

Angular YZDrive Definition of how the joint's rotation will behave around its local Y and Z axes. Only used if Rotation Drive 

Mode is Swing & Twist 

Mode Set the following properties to be dependent on Target Rotation, Target Angular Velocity, or both 



Position Spring Strength of a rubber-band pull toward the defined direction. Only used if Mode includes Position 

Position Damper Resistance strength against the Position Spring. Only used if Mode includes Position 

Maximum Force Amount of strength applied to push the object toward the defined direction. Only used if Mode includes 

Velocity 

Slerp Drive Definition of how the joint's rotation will behave around all local axes. Only used if Rotation Drive Mode is 

Slerp Only 

Mode Set the following properties to be dependent on Target Rotation, Target Angular Velocity, or both 

Position Spring Strength of a rubber-band pull toward the defined direction. Only used if Mode includes Position 

Position Damper Resistance strength against the Position Spring. Only used if Mode includes Position 

Maximum Force Amount of strength applied to push the object toward the defined direction. Only used if Mode includes 

Velocity 

Projection Mode Properties to track to snap the object back to its constrained position when it drifts off too much 

Projection Distance Distance from the Connected Body that must be exceeded before the object snaps back to an acceptable 

position 

Projection Angle Difference in angle from the Connected Body that must be exceeded before the object snaps back to an 

acceptable position 

Congfigure in World 

Space 

If enabled, all Target values will be calculated in World Space instead of the object's Local Space 

Break Force Applied Force values above this number will cause the joint to be destroyed 

Break Torque Applied Torque values above this number will cause the joint to be destroyed 
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class-ConstantForce 
Constant Force is a quick utility for adding constant forces to a Rigidbody. This works great for one shot objects like rockets, if you don't 

want it to start with a large velocity but instead accelerate.  

 

A rocket propelled forward by a Constant Force 

Properties 

  

Force The vector of a force to be applied in world space. 

Relative Force The vector of a force to be applied in the object's local space. 

Torque The vector of a torque, applied in world space. The object will begin spinning around this vector. The longer the 

vector is, the faster the rotation. 

Relative Torque The vector of a torque, applied in local space. The object will begin spinning around this vector. The longer the 

vector is, the faster the rotation. 

Details 

To make a rocket that accelerates forward set the Relative Force to be along the positive z-axis. Then use the Rigidbody's Drag property 

to make it not exceed some maximum velocity (the higher the drag the lower the maximum velocity will be). In the Rigidbody, also make 

sure to turn off gravity so that the rocket will always stay on its path.  

Hints 



 To make an object flow upwards, add a Constant Force with the Force property having a positive Y value.  

 To make an object fly forwards, add a Constant Force with the Relative Force property having a positive Z value.  
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class-FixedJoint 
Fixed Joints restricts an object's movement to be dependent upon another object. This is somewhat similar to Parenting but is 

implemented through physics rather than Transform hierarchy. The best scenarios for using them are when you have objects that you 

want to easily break apart from each other, or connect two object's movement without parenting.  

 

The Fixed Joint Inspector 

Properties 

  

Connected Body Optional reference to the Rigidbody that the joint is dependent upon. If not set, the joint connects to the world. 

Break Force The force that needs to be applied for this joint to break. 

Break Torque The torque that needs to be applied for this joint to break. 

Details 

There may be scenarios in your game where you want objects to stick together permanently or temporarily. Fixed Joints may be a good 

Component to use for these scenarios, since you will not have to script a change in your object's hierarchy to achieve the desired effect. 

The trade-off is that you must use Rigidbodies for any objects that use a Fixed Joint.  

For example, if you want to use a "sticky grenade", you can write a script that will detect collision with another Rigidbody (like an enemy), 

and then create a Fixed Joint that will attach itself to that Rigidbody. Then as the enemy moves around, the joint will keep the grenade 

stuck to them.  

Breaking joints 

You can use the Break Force and Break Torque properties to set limits for the joint's strength. If these are less than infinity, and a 

force/torque greater than these limits are applied to the object, its Fixed Joint will be destroyed and will no longer be confined by its 

restraints.  

Hints 

 You do not need to assign a Connected Body to your joint for it to work.  

 Fixed Joints require a Rigidbody.  
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class-HingeJoint 
The Hinge Joint groups together two Rigidbodies, constraining them to move like they are connected by a hinge. It is perfect for doors, but 

can also be used to model chains, pendulums, etc.  

 

The Hinge Joint Inspector 

Properties 

  
Connected Body Optional reference to the Rigidbody that the joint is dependent upon. If not set, the joint connects to the world. 

Anchor The position of the axis around which the body swings. The position is defined in local space. 

Axis The direction of the axis around which the body swings. The direction is defined in local space. 

Use Spring Spring makes the Rigidbody reach for a specific angle compared to its connected body. 

Spring Properties of the Spring that are used if Use Spring is enabled. 

Spring The force the object asserts to move into the position. 

Damper The higher this value, the more the object will slow down. 

Target Position Target angle of the spring. The spring pulls towards this angle measured in degrees. 

Use Motor The motor makes the object spin around. 

Motor Properties of the Motor that are used if Use Motor is enabled. 

Target Velocity The speed the object tries to attain. 

Force The force applied in order to attain the speed. 

Free Spin If enabled, the motor is never used to brake the spinning, only accelerate it. 

Use Limits If enabled, the angle of the hinge will be restricted within the Min & Max values. 

Limits  Properties of the Limits that are used if Use Limits is enabled. 

Min The lowest angle the rotation can go. 

Max The highest angle the rotation can go. 

Min Bounce How much the object bounces when it hits the minimum stop. 

Max Bounce How much the object bounces when it hits the maximum stop. 

Break Force The force that needs to be applied for this joint to break. 

Break Torque The torque that needs to be applied for this joint to break. 

http://unity3d.com/support/documentation/Components/class-Rigidbody.html


Details 

A single Hinge Joint should be applied to a GameObject. The hinge will rotate at the point specified by the Anchor property, moving 

around the specified Axis property. You do not need to assign a GameObject to the joint's Connected Body property. You should only 

assign a GameObject to the Connected Body property if you want the joint's Transform to be dependent on the attached object's 

Transform.  

Think about how the hinge of a door works. The Axis in this case is up, positive along the Y axis. The Anchor is placed somewhere at the 

intersection between door and wall. You would not need to assign the wall to the Connected Body, because the joint will be connected to 

the world by default.  

Now think about a doggy door hinge. The doggy door's Axis would be sideways, positive along the relative X axis. The main door should 

be assigned as the Connected Body, so the doggy door's hinge is dependent on the main door's Rigidbody.  

Chains 

Multiple Hinge Joints can also be strung together to create a chain. Add a joint to each link in the chain, and attach the next link as the 

Connected Body.  

Hints 

 You do not need to assign a Connected Body to your joint for it to work.  

 Use Break Force in order to make dynamic damage systems. This is really cool as it allows the player to break a door off its hinge by 

blasting it with a rocket launcher or running into it with a car.  

 The Spring, Motor, and Limits properties allow you to fine-tune your joint's behaviors.  
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class-MeshCollider 
The Mesh Collider takes a Mesh Asset and builds its Collider based on that mesh. It is far more accurate for collision detection than using 

primitives for complicated meshes. Mesh Colliders that are marked as Convex can collide with other Mesh Colliders.  

 

A Mesh Collider used on level geometry 

Properties 

  

Material Reference to the Physic Material that determines how this Collider interacts with others. 

Is Trigger If enabled, this Collider is used for triggering events, and is ignored by the physics engine. 

Mesh Reference to the Mesh to use for collisions. 

Smooth Sphere 

Collisions 

When this is enabled, collision mesh normals are smoothed. You should enable this on smooth surfaces eg. 

rolling terrain without hard edges to make sphere rolling smoother. 

Convex If enabled, this Mesh Collider will collide with other Mesh Colliders. Convex Mesh Colliders are limited to 255 

http://unity3d.com/support/documentation/Components/class-Mesh.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html


triangles. 

Details 

The Mesh Collider builds its collision representation from the Mesh attached to the GameObject, and reads the properties of the attached 

Transform to set its position and scale correctly.  

Collision meshes use backface culling. If an object collides with a mesh that will be backface culled graphically it will also not collide with it 

physically.  

There are some limitations when using the Mesh Collider. Usually, two Mesh Colliders cannot collide with each other. All Mesh Colliders 

can collide with any primitive Collider. If your mesh is marked as Convex, then it can collide with other Mesh Colliders.  

Colliders work with Rigidbodies to bring physics in Unity to life. Whereas Rigidbodies allow objects to be controlled by physics, Colliders 

allow objects to collide with each other. Colliders must be added to objects independently of Rigidbodies. A Collider does not necessarily 

need a Rigidbody attached, but a Rigidbody must be attached in order for the object to move as a result of collisions.  

When a collision between two Colliders occurs and if at least one of them has a Rigidbody attached, three collision messages are sent out 

to the objects attached to them. These events can be handled in scripting, and allow you to create unique behaviors with or without making 

use of the built-in NVIDIA PhysX engine.  

Triggers 

An alternative way of using Colliders is to mark them as a Trigger, just check the IsTrigger property checkbox in the Inspector. Triggers are 

effectively ignored by the physics engine, and have a unique set of three trigger messages that are sent out when a collision with a Trigger 

occurs. Triggers are useful for triggering other events in your game, like cutscenes, automatic door opening, displaying tutorial messages, 

etc. Use your imagination!  

Be aware that in order for two Triggers to send out trigger events when they collide, one of them must include a Rigidbody as well. For a 

Trigger to collide with a normal Collider, one of them must have a Rigidbody attached. For a detailed chart of different types of collisions, 

see the collision action matrix in the Advanced section below.  

Friction and bouncyness 

Friction, bouncyness and softness are defined in the Physic Material. The Standard Assets contain the most common physics materials. To 

use one of them click on the Physic Material drop-down and select one, eg. Ice. You can also create your own physics materials and tweak 

all friction values.  

Hints 

 Mesh Colliders cannot collide with each other unless they are marked as Convex. Therefore, they are most useful for background objects 

like environment geometry.  

 Convex Mesh Colliders must be fewer than 255 triangles.  

 Primitive Colliders are less costly for objects under physics control.  

 When you attach a Mesh Collider to a GameObject, its Mesh property will default to the mesh being rendered. You can change that by 

assigning a different Mesh.  

 To add multiple Colliders for an object, create child GameObjects and attach a Collider to each one. This allows each Collider to be 

manipulated independently.  

 You can look at the gizmos in the Scene View to see how the Collider is being calculated on your object.  

 Colliders do their best to match the scale of an object. If you have a non-uniform scale (a scale which is different in each direction), only the 

Mesh Collider can match completely.  

 If you are moving an object through its Transform component but you want to receive Collision/Trigger messages, you must attach a 

Rigidbody to the object that is moving.  

Advanced 

Collider combinations 

http://unity3d.com/support/documentation/Components/class-Mesh.html
http://unity3d.com/support/documentation/Components/class-Transform.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionStay.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerStay.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html


There are numerous different combinations of collisions that can happen in Unity. Each game is unique, and different combinations may 

work better for different types of games. If you're using physics in your game, it will be very helpful to understand the different basic Collider 

types, their common uses, and how they interact with other types of objects.  

Static Collider 
These are GameObjects that do not have a Rigidbody attached, but do have a Collider attached. These objects should remain still, or 

move very little. These work great for your environment geometry. They will not move if a Rigidbody collides with them.  

Rigidbody Collider 
These GameObjects contain both a Rigidbody and a Collider. They are completely affected by the physics engine through scripted forces 

and collisions. They might collide with a GameObject that only contains a Collider. These will likely be your primary type of Collider in 

games that use physics.  

Kinematic Rigidbody Collider 
This GameObject contains a Collider and a Rigidbody which is marked IsKinematic. To move this GameObject, you modify its Transform 

Component, rather than applying forces. They're similar to Static Colliders but will work better when you want to move the Collider around 

frequently. There are some other specialized scenarios for using this GameObject.  

This object can be used for circumstances in which you would normally want a Static Collider to send a trigger event. Since a Trigger must 

have a Rigidbody attached, you should add a Rigidbody, then enable IsKinematic. This will prevent your Object from moving from physics 

influence, and allow you to receive trigger events when you want to.  

Kinematic Rigidbodies can easily be turned on and off. This is great for creating ragdolls, when you normally want a character to follow an 

animation, then turn into a ragdoll when a collision occurs, prompted by an explosion or anything else you choose. When this happens, 

simply turn all your Kinematic Rigidbodies into normal Rigidbodies through scripting.  

If you have Rigidbodies come to rest so they are not moving for some time, they will "fall asleep". That is, they will not be calculated during 

the physics update since they are not going anywhere. If you move a Kinematic Rigidbody out from underneath normal Rigidbodies that are 

at rest on top of it, the sleeping Rigidbodies will "wake up" and be correctly calculated again in the physics update. So if you have a lot of 

Static Colliders that you want to move around and have different object fall on them correctly, use Kinematic Rigidbody Colliders.  

Collision action matrix 

Depending on the configurations of the two colliding Objects, a number of different actions can occur. The chart below outlines what you 

can expect from two colliding Objects, based on the components that are attached to them. Some of the combinations only cause one of 

the two Objects to be affected by the collision, so keep the standard rule in mind - physics will not be applied to objects that do not have 

Rigidbodies attached.  

Collision detection occurs and messages are sent upon collision 

  Static Collider Rigidbody Collider Kinematic  

Rigidbody Collider 

Static  

Trigger Collider 

Rigidbody  

Trigger Collider 

Kinematic Rigidbody  

Trigger Collider 

Static Collider   Y         

Rigidbody Collider Y Y Y       

Kinematic Rigidbody Collider   Y         

Static Trigger Collider             

Rigidbody Trigger Collider             

Kinematic Rigidbody Trigger Collider             

Trigger messages are sent upon collision 

  Static Collider Rigidbody Collider Kinematic  

Rigidbody Collider 

Static  

Trigger Collider 

Rigidbody  

Trigger Collider 

Kinematic Rigidbody  

Trigger Collider 

Static Collider         Y Y 

Rigidbody Collider       Y Y Y 

Kinematic Rigidbody Collider       Y Y Y 

Static Trigger Collider   Y Y   Y Y 

Rigidbody Trigger Collider Y Y Y Y Y Y 

http://unity3d.com/support/documentation/Components/class-Transform.html


Kinematic Rigidbody Trigger Collider Y Y Y Y Y Y 

Layer-Based Collision Detection 

In Unity 3.x we introduce something called Layer-Based Collision Detection, and is that you can now selectively tell Unity GameObjects 

to collide with specific layers they are attached to. For more info, you can click here  
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class-PhysicMaterial 
The Physic Material is used to adjust friction and bouncing effects of colliding objects.  

To create a Physic Material select Assets->Create->Physic Material from the menu bar. Then drag the Physic Material from the Project 

View onto a Collider in the scene.  

 

The Physic Material Inspector 

Properties 

  

Dynamic Friction The friction used when already moving. Usually a value from 0 to 1. A value of zero feels like ice, a value of 1 

will make it come to rest very quickly unless a lot of force or gravity pushes the object. 

Static Friction The friction used when an object is laying still on a surface. Usually a value from 0 to 1. A value of zero feels 

like ice, a value of 1 will make it very hard to get the object moving. 

Bouncyness How bouncy is the surface? A value of 0 will not bounce. A value of 1 will bounce without any loss of energy. 

Friction Combine Mode How the friction of two colliding objects is combined. 

Average The two friction values are averaged. 

Min The smallest of the two values is used. 

Max The largest of the two values is used. 

Multiply The friction values are multiplied with each other. 

Bounce Combine How the bouncyness of two colliding objects is combined. It has the same modes as Friction Combine Mode 

Friction Direction 2 The direction of anisotropy. Anisotropic friction is enabled if this direction is not zero. Dynamic Friction 2 and 

Static Friction 2 will be applied along Friction Direction 2. 

Dynamic Friction 2 If anisotropic friction is enabled, DynamicFriction2 will be applied along Friction Direction 2. 

Static Friction 2 If anisotropic friction is enabled, StaticFriction2 will be applied along Friction Direction 2. 

Details 

Friction is the quantity which prevents surfaces from sliding off each other. This value is critical when trying to stack objects. Friction comes 

in two forms, dynamic and static. Static friction is used when the object is lying still. It will prevent the object from starting to move. If a 

large enough force is applied to the object it will start moving. At this point Dynamic Friction will come into play. Dynamic Friction will 

now attempt to slow down the object while in contact with another.  

Hints 

http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html
http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html


 Don't try to use a standard physic material for the main character. Make a customized one and get it perfect.  

Page last updated: 2007-11-16 

 

 

class-Rigidbody 
Rigidbodies enable your GameObjects to act under the control of physics. The Rigidbody can receive forces and torque to make your 

objects move in a realistic way. Any GameObject must contain a Rigidbody to be influenced by gravity, act under added forces via scripting, 

or interact with other objects through the NVIDIA PhysX physics engine.  

 

Rigidbodies allow GameObjects to act under physical influence 

Properties 

  

Mass The weight of the object in kilograms. It is recommended to make masses not more or less than 100 times that 

of other Rigidbodies. 

Drag How much air resistance affects the object when moving from forces. 0 means no air resistance, and infinity 

makes the object stop moving immediately. 

Angular Drag How much air resistance affects the object when rotating from torque. 0 means no air resistance, and infinity 

makes the object stop rotating immediately. 

Use Gravity If enabled, the object is affected by gravity. 

Is Kinematic If enabled, the object will not be driven by the physics engine, and can only be manipulated by its Transform. 

This is useful for moving platforms or if you want to animate a Rigidbody that has a HingeJoint attached. 

Interpolate Try one of the options only if you are seeing jerkiness in your Rigidbody's movement. 

None No Interpolation is applied. 

Interpolate Transform is smoothed based on the Transform of the previous frame. 

Extrapolate Transform is smoothed based on the estimated Transform of the next frame. 

Freeze Rotation If enabled, this GameObject will never rotate based on collisions or forces added via script -- it will only rotate 

when using transform.Rotate(). 

Collision Detection Used to prevent fast moving objects from passing through other objects without detecting collisions. 

Discrete Use Discreet collision detection against all other colliders in the scene. Other colliders will use Discreet collision 

detection when testing for collision against it. Used for normal collisions (This is the default value). 

Continuous Use Discrete collision detection against dynamic colliders (with a rigidbody) and continuous collision detection 

against static MeshColliders (without a rigidbody). Rigidbodies set to Continuous Dynamic will use continuous 

collision detection when testing for collision against this rigidbody. Other rigidbodies will use Discreet Collision 

detection. Used for objects which the Continuous Dynamic detection needs to collide with. (This has a big 

impact on physics performance, leave it set to Discrete, if you don't have issues with collisions of fast objects) 

Continuous Dynamic Use continuous collision detection against objects set to Continuous and Continuous Dynamic Collision. It will 

also use continuous collision detection against static MeshColliders (without a rigidbody). For all other colliders 

it uses discreet collision detection. Used for fast moving objects. 

Constraints Restrictions on the Rigidbody's motion:- 

Freeze Position Stops the Rigidbody moving in the world X, Y and Z axes selectively. 



Freeze Rotation Stops the Rigidbody rotating around the world X, Y and Z axes selectively. 

Details 

Rigidbodies allow your GameObjects to act under control of the physics engine. This opens the gateway to realistic collisions, varied types 

of joints, and other very cool behaviors. Manipulating your GameObjects by adding forces to a Rigidbody creates a very different feel and 

look than adjusting the Transform Component directly. Generally, you shouldn't manipulate the Rigidbody and the Transform of the same 

GameObject - only one or the other.  

The biggest difference between manipulating the Transform versus the Rigidbody is the use of forces. Rigidbodies can receive forces and 

torque, but Transforms cannot. Transforms can be translated and rotated, but this is not the same as using physics. You'll notice the 

distinct difference when you try it for yourself. Adding forces/torque to the Rigidbody will actually change the object's position and rotation of 

the Transform component. This is why you should only be using one or the other. Changing the Transform while using physics could cause 

problems with collisions and other calculations.  

Rigidbodies must be explicitly added to your GameObject before they will be affected by the physics engine. You can add a Rigidbody to 

your selected object from Components->Physics->Rigidbody in the menubar. Now your object is physics-ready; it will fall under gravity 

and can receive forces via scripting, but you may need to add a Collider or a Joint to get it to behave exactly how you want.  

Parenting 

When an object is under physics control, it moves semi-independently of the way its transform parents move. If you move any parents, they 

will pull the Rigidbody child along with them. However, the Rigidbodies will still fall down due to gravity and react to collision events.  

Scripting 

To control your Rigidbodies, you will primarily use scripts to add forces or torque. You do this by calling AddForce() and AddTorque() on 

the object's Rigidbody. Remember that you shouldn't be directly altering the object's Transform when you are using physics.  

Animation 

For some situations, mainly creating ragdoll effects, it is neccessary to switch control of the object between animations and physics. For this 

purpose Rigidbodies can be marked isKinematic. While the Rigidbody is marked isKinematic, it will not be affected by collisions, forces, 

or any other part of physX. This means that you will have to control the object by manipulating the Transform component directly. Kinematic 

Rigidbodies will affect other objects, but they themselves will not be affected by physics. For example, Joints which are attached to 

Kinematic objects will constrain any other Rigidbodies attached to them and Kinematic Rigidbodies will affect other Rigidbodies through 

collisions.  

Colliders 

Colliders are another kind of component that must be added alongside the Rigidbody in order to allow collisions to occur. If two Rigidbodies 

bump into each other, the physics engine will not calculate a collision unless both objects also have a Collider attached. Collider-less 

Rigidbodies will simply pass through each other during physics simulation.  

 

Colliders define the physical boundaries of a Rigidbody 

Add a Collider with the Component->Physics menu. View the Component Reference page of any individual Collider for more specific 

information:  

http://unity3d.com/support/documentation/ScriptReference/Rigidbody.AddForce.html
http://unity3d.com/support/documentation/ScriptReference/Rigidbody.AddTorque.html
http://unity3d.com/support/documentation/ScriptReference/Rigidbody-isKinematic.html
http://unity3d.com/support/documentation/Components/class-Transform.html


 Box Collider - primitive shape of a cube  

 Sphere Collider - primitive shape of a sphere  

 Capsule Collider - primitive shape of a capsule  

 Mesh Collider - creates a collider from the object's mesh, cannot collide with another Mesh Collider  

 Wheel Collider - specifically for creating cars or other moving vehicles  

Compound Colliders 

Compound Colliders are combinations of primitive Colliders, collectively acting as a single Collider. They come in handy when you have a 

complex mesh to use in collisions but cannot use a Mesh Collider. To create a Compound Collider, create child objects of your colliding 

object, then add a primitive Collider to each child object. This allows you to position, rotate, and scale each Collider easily and 

independently of one another.  

 

A real-world Compound Collider setup 

In the above picture, the environment has a Mesh Collider attached. Mesh Colliders work the best for terrain or environments made from 

irregular shapes. The gun_model GameObject has a Rigidbody attached, and multiple primitive Colliders as child GameObjects. When the 

Rigidbody parent is moved around by forces, the child Colliders move along with it. The primitive Colliders will collide with the 

environment's Mesh Collider, and the parent Rigidbody will alter the way it moves based on forces being applied to it and how its child 

Colliders interact with other Colliders in the Scene.  

Mesh Colliders can't normally collide with each other. If a Mesh Collider is marked as Convex, then it can collide with another Mesh 

Collider. The typical solution is to use primitive Colliders for any objects that move, and Mesh Colliders for static background objects.  

Continuous Collision Detection 

Continuous collision detection is a feature to prevent fast-moving colliders from passing each other. This may happen when using normal 

(Discrete) collision detection, when an object is one side of a collider in one frame, and already passed the collider in the next frame. To 

solve this, you can enable continuous collision detection on the rigidbody of the fast-moving object. Set the collision detection mode to 

Continuous to prevent the rigidbody from passing through any static (ie, non-rigidbody) MeshColliders. Set it to Continuous Dynamic to 

also prevent the rigidbody from passing through any other supported rigidbodies with collision detection mode set to Continuous or 

Continuous Dynamic. Continuous collision detection is supported for Box-, Sphere- and CapsuleColliders.  

Use the right size 

The size of the your GameObject's mesh is much more important than the mass of the Rigidbody. If you find that your Rigidbody is not 

behaving exactly how you expect - it moves slowly, floats, or doesn't collide correctly - consider adjusting the scale of your mesh asset. 

Unity's default unit scale is 1 unit = 1 meter, so the scale of your imported mesh is maintained, and applied to physics calculations. For 

example, a crumbling skyscraper is going to fall apart very differently than a tower made of toy blocks, so objects of different sizes should 

be modeled to accurate scale.  

If you are modeling a human make sure he is around 2 meters tall in Unity. To check if your object has the right size compare it to the 

default cube. You can create a cube using GameObject->Create Other->Cube. The cube's height will be exactly 1 meter, so your human 

should be twice as tall.  

http://unity3d.com/support/documentation/Components/class-BoxCollider.html
http://unity3d.com/support/documentation/Components/class-SphereCollider.html
http://unity3d.com/support/documentation/Components/class-CapsuleCollider.html
http://unity3d.com/support/documentation/Components/class-MeshCollider.html
http://unity3d.com/support/documentation/Components/class-WheelCollider.html


If you aren't able to adjust the mesh itself, you can change the uniform scale of a particular mesh asset by selecting it in Project View and 

choosing Assets->Import Settings... from the menubar. Here, you can change the scale and re-import your mesh.  

If your game requires that your GameObject needs to be instantiated at different scales, it is okay to adjust the values of your Transform's 

scale axes. The downside is that the physics simulation must do more work at the time the object is instantiated, and could cause a 

performance drop in your game. This isn't a terrible loss, but it is not as efficient as finalizing your scale with the other two options. Also 

keep in mind that non-uniform scales can create undesirable behaviors when Parenting is used. For these reasons it is always optimal to 

create your object at the correct scale in your modeling application.  

Hints 

 The relative Mass of two Rigidbodies determines how they react when they collide with each other.  

 Making one Rigidbody have greater Mass than another does not make it fall faster in free fall. Use Drag for that.  

 A low Drag value makes an object seem heavy. A high one makes it seem light. Typical values for Drag are between .001 (solid block of 

metal) and 10 (feather).  

 If you are directly manipulating the Transform component of your object but still want physics, attach a Rigidbody and make it Kinematic.  

 If you are moving a GameObject through its Transform component but you want to receive Collision/Trigger messages, you must attach a 

Rigidbody to the object that is moving.  
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class-SphereCollider 
The Sphere Collider is a basic sphere-shaped collision primitive.  

 

A pile of Sphere Colliders 

Properties 

  

Material Reference to the Physic Material that determines how this Collider interacts with others. 

Is Trigger If enabled, this Collider is used for triggering events, and is ignored by the physics engine. 

Radius The size of the Collider. 

Center The position of the Collider in the object's local space. 

Details 

The Sphere Collider can be resized to uniform scale, but not along individual axes. It works great for falling boulders, ping pong balls, 

marbles, etc.  

http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html


 

A standard Sphere Collider  

Colliders work with Rigidbodies to bring physics in Unity to life. Whereas Rigidbodies allow objects to be controlled by physics, Colliders 

allow objects to collide with each other. Colliders must be added to objects independently of Rigidbodies. A Collider does not necessarily 

need a Rigidbody attached, but a Rigidbody must be attached in order for the object to move as a result of collisions.  

When a collision between two Colliders occurs and if at least one of them has a Rigidbody attached, three collision messages are sent out 

to the objects attached to them. These events can be handled in scripting, and allow you to create unique behaviors with or without making 

use of the built-in NVIDIA PhysX engine.  

Triggers 

An alternative way of using Colliders is to mark them as a Trigger, just check the IsTrigger property checkbox in the Inspector. Triggers are 

effectively ignored by the physics engine, and have a unique set of three trigger messages that are sent out when a collision with a Trigger 

occurs. Triggers are useful for triggering other events in your game, like cutscenes, automatic door opening, displaying tutorial messages, 

etc. Use your imagination!  

Be aware that in order for two Triggers to send out trigger events when they collide, one of them must include a Rigidbody as well. For a 

Trigger to collide with a normal Collider, one of them must have a Rigidbody attached. For a detailed chart of different types of collisions, 

see the collision action matrix in the Advanced section below.  

Friction and bouncyness 

Friction, bouncyness and softness are defined in the Physic Material. The Standard Assets contain the most common physics materials. To 

use one of them click on the Physic Material drop-down and select one, eg. Ice. You can also create your own physics materials and tweak 

all friction values.  

Compound Colliders 

Compound Colliders are combinations of primitive Colliders, collectively acting as a single Collider. They come in handy when you have a 

complex mesh to use in collisions but cannot use a Mesh Collider. To create a Compound Collider, create child objects of your colliding 

object, then add a primitive Collider to each child object. This allows you to position, rotate, and scale each Collider easily and 

independently of one another.  

 

A real-world Compound Collider setup 

http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnCollisionStay.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerEnter.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerExit.html
http://unity3d.com/support/documentation/ScriptReference/Collider.OnTriggerStay.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html


In the above picture, the environment has a Mesh Collider attached. Mesh Colliders work the best for terrain or environments made from 

irregular shapes. The gun_model GameObject has a Rigidbody attached, and multiple primitive Colliders as child GameObjects. When the 

Rigidbody parent is moved around by forces, the child Colliders move along with it. The primitive Colliders will collide with the 

environment's Mesh Collider, and the parent Rigidbody will alter the way it moves based on forces being applied to it and how its child 

Colliders interact with other Colliders in the Scene.  

Mesh Colliders can't normally collide with each other. If a Mesh Collider is marked as Convex, then it can collide with another Mesh 

Collider. The typical solution is to use primitive Colliders for any objects that move, and Mesh Colliders for static background objects.  

Hints 

 To add multiple Colliders for an object, create child GameObjects and attach a Collider to each one. This allows each Collider to be 

manipulated independently.  

 You can look at the gizmos in the Scene View to see how the Collider is being calculated on your object.  

 Colliders do their best to match the scale of an object. If you have a non-uniform scale (a scale which is different in each direction), only the 

Mesh Collider can match completely.  

 If you are moving an object through its Transform component but you want to receive Collision/Trigger messages, you must attach a 

Rigidbody to the object that is moving.  

 If you make an explosion, it can be very effective to add a rigidbody with lots of drag and a sphere collider to it in order to push it out a bit 

from the wall it hits.  

Advanced 

Collider combinations 

There are numerous different combinations of collisions that can happen in Unity. Each game is unique, and different combinations may 

work better for different types of games. If you're using physics in your game, it will be very helpful to understand the different basic Collider 

types, their common uses, and how they interact with other types of objects.  

Static Collider 
These are GameObjects that do not have a Rigidbody attached, but do have a Collider attached. These objects should remain still, or 

move very little. These work great for your environment geometry. They will not move if a Rigidbody collides with them.  

Rigidbody Collider 
These GameObjects contain both a Rigidbody and a Collider. They are completely affected by the physics engine through scripted forces 

and collisions. They might collide with a GameObject that only contains a Collider. These will likely be your primary type of Collider in 

games that use physics.  

Kinematic Rigidbody Collider 
This GameObject contains a Collider and a Rigidbody which is marked IsKinematic. To move this GameObject, you modify its Transform 

Component, rather than applying forces. They're similar to Static Colliders but will work better when you want to move the Collider around 

frequently. There are some other specialized scenarios for using this GameObject.  

This object can be used for circumstances in which you would normally want a Static Collider to send a trigger event. Since a Trigger must 

have a Rigidbody attached, you should add a Rigidbody, then enable IsKinematic. This will prevent your Object from moving from physics 

influence, and allow you to receive trigger events when you want to.  

Kinematic Rigidbodies can easily be turned on and off. This is great for creating ragdolls, when you normally want a character to follow an 

animation, then turn into a ragdoll when a collision occurs, prompted by an explosion or anything else you choose. When this happens, 

simply turn all your Kinematic Rigidbodies into normal Rigidbodies through scripting.  

If you have Rigidbodies come to rest so they are not moving for some time, they will "fall asleep". That is, they will not be calculated during 

the physics update since they are not going anywhere. If you move a Kinematic Rigidbody out from underneath normal Rigidbodies that are 

http://unity3d.com/support/documentation/Components/class-Transform.html


at rest on top of it, the sleeping Rigidbodies will "wake up" and be correctly calculated again in the physics update. So if you have a lot of 

Static Colliders that you want to move around and have different object fall on them correctly, use Kinematic Rigidbody Colliders.  

Collision action matrix 

Depending on the configurations of the two colliding Objects, a number of different actions can occur. The chart below outlines what you 

can expect from two colliding Objects, based on the components that are attached to them. Some of the combinations only cause one of 

the two Objects to be affected by the collision, so keep the standard rule in mind - physics will not be applied to objects that do not have 

Rigidbodies attached.  

Collision detection occurs and messages are sent upon collision 

  Static Collider Rigidbody Collider Kinematic  

Rigidbody Collider 

Static  

Trigger Collider 

Rigidbody  

Trigger Collider 

Kinematic Rigidbody  

Trigger Collider 

Static Collider   Y         

Rigidbody Collider Y Y Y       

Kinematic Rigidbody Collider   Y         

Static Trigger Collider             

Rigidbody Trigger Collider             

Kinematic Rigidbody Trigger Collider             

Trigger messages are sent upon collision 

  Static Collider Rigidbody Collider Kinematic  

Rigidbody Collider 

Static  

Trigger Collider 

Rigidbody  

Trigger Collider 

Kinematic Rigidbody  

Trigger Collider 

Static Collider         Y Y 

Rigidbody Collider       Y Y Y 

Kinematic Rigidbody Collider       Y Y Y 

Static Trigger Collider   Y Y   Y Y 

Rigidbody Trigger Collider Y Y Y Y Y Y 

Kinematic Rigidbody Trigger Collider Y Y Y Y Y Y 

Layer-Based Collision Detection 

In Unity 3.x we introduce something called Layer-Based Collision Detection, and is that you can now selectively tell Unity GameObjects 

to collide with specific layers they are attached to. For more info, you can click here  
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class-SpringJoint 
The Spring Joint groups together two Rigidbodies, constraining them to move like they are connected by a spring.  

http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html
http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html


 

The Spring Joint Inspector 

Properties 

  

Connected Body Optional reference to the Rigidbody that the joint is dependent upon. 

Anchor Position in the object's local space (at rest) that defines the center of the joint. This is not the point that the 

object will be drawn toward. 

X Position of the joint's local center along the X axis. 

Y Position of the joint's local center along the Y axis. 

Z Position of the joint's local center along the Z axis. 

Spring Strength of the spring. 

Damper Amount that the spring is reduced when active. 

Min Distance Distances greater than this will not cause the Spring to activate. 

Max Distance Distances less than this will not cause the Spring to activate. 

Break Force The force that needs to be applied for this joint to break. 

Break Torque The torque that needs to be applied for this joint to break. 

Details 

Spring Joints allows a Rigidbodied GameObject to be pulled toward a particular "target" position. This position will either be another 

Rigidbodied GameObject or the world. As the GameObject travels further away from this "target" position, the Spring Joint applies forces 

that will pull it back to its original "target" position. This creates an effect very similar to a rubber band or a slingshot.  

The "target" position of the Spring is determined by the relative position from the Anchor to the Connected Body (or the world) when the 

Spring Joint is created, or when Play mode is entered. This makes the Spring Joint very effective at setting up Jointed characters or objects 

in the Editor, but is harder to create push/pull spring behaviors in runtime through scripting. If you want to primarily control a GameObject's 

position using a Spring Joint, it is best to create an empty GameObject with a Rigidbody, and set that to be the Connected Rigidbody of 

the Jointed object. Then in scripting you can change the position of the Connected Rigidbody and see your Spring move in the ways you 

expect.  

Connected Rigidbody 

You do not need to use a Connected Rigidbody for your joint to work. Generally, you should only use one if your object's position and/or 

rotation is dependent on it. If there is no Connected Rigidbody, your Spring will connect to the world.  

Spring & Damper 

Spring is the strength of the force that draws the object back toward its "target" position. If this is 0, then there is no force that will pull on 

the object, and it will behave as if no Spring Joint is attached at all.  

Damper is the resistance encountered by the Spring force. The lower this is, the springier the object will be. As the Damper is increased, 

the amount of bounciness caused by the Joint will be reduced.  



Min & Max Distance 

If the position of your object falls in-between the Min & Max Distances, then the Joint will not be applied to your object. The position must 

be moved outside of these values for the Joint to activate.  

Hints 

 You do not need to assign a Connected Body to your Joint for it to work.  

 Set the ideal positions of your Jointed objects in the Editor prior to entering Play mode.  

 Spring Joints require your object to have a Rigidbody attached.  
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class-InteractiveCloth 
The Interactive Cloth class is a Component that simulates a "cloth-like" behavior on a mesh. Use this Component if you want to use cloth in 

your scene.  

 

Interactive cloth in the scene view and its properties in the inspector. 

Properties 

Interactive Cloth 

  

Bending Stiffness Bending stiffness of the cloth. 

Stretching Stiffness Stretching Stiffness of the cloth. 

Damping Damp cloth motion. 

Use Gravity Should Gravity affect the cloth simulation?. 

External Acceleration A constant, external acceleration applied to the cloth 

Random Acceleration A random, external acceleration applied to the cloth 

Mesh Mesh that will be used by the interactive cloth for the simulation 

Thickness The thickness of the cloth surface. 

Friction The friction of the cloth. 

Density The density of the cloth. 

Pressure The pressure inside the cloth/ 

Collision Response How much force will be applied to colliding rigidbodies?. 

Attachment Tear Factor How far attached rigid bodies need to be stretched, before they will tear off. 

Attachment Response How much force will be applied to attached rigidbodies?. 

Tear Factor How far cloth vertices need to be stretched, before the cloth will tear. 

Attached Colliders Array that contains the attached colliders to this cloth 

Self Collision Will the cloth collide with itself?. 



The Interactive Cloth Component depends of the Cloth Renderer Component, this means that this component cannot be removed if the 

Cloth Renderer is present in the Game Object.  

Cloth Renderer 

Cast Shadows If selected the cloth will cast shadows 

Receive Shadows The cloth can receive Shadows if enabled 

Lightmap Index The index of the lightmap applied to this renderer. 

Lightmap Tiling Offset The tiling & offset used for lightmap. 

Materials Materials that the cloth will use. 

Pause When Not Visible If selected, the simulation will not be calculated when the cloth is not being rendered by the camera. 

Adding an Interactive Cloth Game Object 

To add an Interactive Cloth in the scene just select GameObject->Create Other->Cloth.  

Hints. 

 Using lots of clothes in your game will reduce exponentially the performance of your game.  

 If you want to simulate clothing on characters, check out the Skinned Cloth component instead, which interacts with the 

SkinnedMeshRenderer component and is much faster then InteractiveCloth.  

 To attach the cloth to other objects, use the Attached Colliders property to assign other objects to attach to. The colliders must overlap 

some vertices of the cloth mesh for this to work.  

 Attached Colliders' objects must intersect with the cloth you are attaching to.  
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class-SkinnedCloth 

 

Skinned cloth in the scene view and in the inspector. 

The SkinnedCloth component works together with the SkinnedMeshRenderer to simulate clothing on a character. If you have an 

animated character which uses the SkinnedMeshRenderer, you can add a SkinnedCloth component to the game object with the 

SkinnedMeshRenderer to make him appear more life-like. Just select the GameObject with the SkinnedMeshRender, and add a 

SkinnedCloth component using Component->Physics->Skinned Cloth.  

What the SkinnedCloth component does, is to take the vertex output from the SkinnedMeshRenderer and apply clothing simulation to that. 

The SkinnedCloth component has a set of per-vertex coefficients, which define how free the simulated cloth can move with respect to the 

skinned mesh.  

These coefficients can be visually edited using the scene view and the inspector, when the game object with the SkinnedCloth component 

is selected. There are two editing modes, selection and vertex painting. In selection mode, you click on vertices in the scene view to select 

http://unity3d.com/support/documentation/Components/class-SkinnedCloth.html


them, and then edit their coefficients in the inspector. In vertex paining mode, you set the coefficient values you want in the inspector, 

enable the "paint" button next to those coefficients you want to change, and click on the vertices to apply the values to those.  

Note that skinned cloth simulation is only driven by the vertices skinned by the SkinnedMeshRenderer, and will not otherwise interact with 

any colliders. This makes skinned cloth simulation much faster then the fully physical Interactive Cloth component, as it does not need to be 

simulated on the same frame rate and the same thread as the rest of the physics simulation.  

You can disable or enable the skinned cloth component at any time to turn it on or off. Turning it off will switch rendering to the normal 

SkinnedMeshRenderer, so you can switch between these whenever needed to dynamically adjust for varying performance. You can also 

smoothly cross-fade between the two modes from a script using the SkinnedCloth.SetEnabledFading() method, to make the transition 

unnoticeable to the player.  

Cloth Coefficients 

There a four coefficients per vertex, which define how cloth vertices can move with respect to the skinned vertices and normals. These are:  

Max Distance Distance a vertex is allowed to travel from the skinned mesh vertex position. The SkinnedCloth component makes 

sure that the cloth vertices stay within maxDistance from the skinned mesh vertex positions. If maxDistance is zero, 

the vertex is not simulated but set to the skinned mesh vertex position. This behavior is useful for fixing the cloth 

vertex to the skin of an animated character - you will want to do that for any vertices which shouldn't be skinned, or 

for parts which are somehow fixed to the character's body (such as the waist of trousers, fixed by a belt). However, if 

you have large parts of the character which should not use cloth simulation (such as the face or hands), for best 

performance, set those up as a separate skinned mesh, which does not have a SkinnedCloth component. 

Distance Bias Distorts the sphere defined by the maxDistance based on skinned mesh normals. The feature is disabled for a value 

of 0.0 (default). In this case the max distance sphere is undistorted. Decreasing the maxDistanceBias towards -1.0 

reduces the distance the vertex is allowed to travel in the tangential direction. For -1.0 the vertex has to stay on the 

normal through the skinned mesh vertex position and within maxDistance to the skinned mesh vertex position. 

Increasing maxDistanceBias towards 1.0 reduces the discance the vertex is allowed to travel in the normal direction. 

At 1.0 the vertex can only move inside the tangental plane within maxDistance from the skinned mesh vertex position. 

Collision Sphere 

Radius and 

Collision Sphere 

Distance 

Definition of a sphere a vertex is not allowed to enter. This allows collision against the animated cloth. The pair 

(collisionSphereRadius, collisionSphereDistance) define a sphere for each cloth vertex. The sphere's center is 

located at the position constrainPosition - constrainNormal * (collisionSphereRadius + collisionSphereDistance) and 

its radius is collisionSphereRadius, where constrainPosition and constrainNormal are the vertex positions and 

normals generated by the SkinnedMeshRenderer. The SkinnedCloth makes sure that the cloth vertex does not enter 

this sphere. This means that collisionSphereDistance defines how deeply the skinned mesh may be penetrated by 

the cloth. It is typically set to zero. collisionSphereRadius should be set to a value larger then the distance between 

the neighboring vertices to make sure the cloth vertices will not be able to slip around the collision spheres. In such a 

setup, the cloth will appear to collides against the skinned mesh. 

Refer to this image for a visual representation on how these coefficients work with respect to a skinned vertex and normal for different 

values of maxDistanceBias. The red area is the collision sphere defined by collisionSphereRadius and collisionSphereDistance, which the 

cloth vertex cannot enter. Thus, the green area, defined by maxDistance and maxDistanceBias subtracted by the red area defines the 

space in which the cloth vertex can move.  

 

http://unity3d.com/support/documentation/Components/class-InteractiveCloth.html


The SkinnedCloth inspector 

When you select a GameObject with a SkinnedCloth component, you can use the SkinnedCloth inspector to edit cloth vertex coefficients, 

and other properties. The inspector has three tabs:  

Vertex Selection Tool 

 

In this mode you can select vertices in the scene view, and the set their coefficients in the inspector (see the previous section for an 

explanation on how the cloth coefficients work). It is possible to set multiple coefficients by holding the shift key, or by dragging a rectangle 

with the mouse. When multiple vertices are selected, the inspector will display average values for the vertices coefficients. When you 

change the values, however, that coefficient will be set to the same value for all vertices. If you switch the scene view to wireframe mode, 

you will also be able to see and to select back-facing vertices, this can be useful when you want to select full parts of the character.  

To help you understand which values the coefficients have for all the vertices, you can click the eye icon next to a coefficient field, to make 

the editor visualize that coefficient in the scene view. This shows the vertices with the lowest value of that coefficient in a green tint, mid-

range values will be yellow, and the highest values get a blue tint. The colors scale is always chosen relative to the used value range of that 

coefficient, and is independent of absolute values.  

Vertex Painting Tool 

 

Similar to the vertex selection, this is a tool to help you configure the vertex coefficient values. Unlike vertex selection, you don't need to 

click on a vertex before changing a value - in this mode, you just enter the values you want to set, enable the paintbrush toggle next to the 

coefficients you want to change, and then click on all vertices you want to set that value for.  

Configuration 

 

The third tab lets you configure various properties of the skinned cloth:  



Bending 

Stiffness 

Bending stiffness of the cloth. 

Stretching 

Stiffness 

Streching stiffness of the cloth. 

Damping Damp cloth motion 

Use Gravity Should gravity affect the cloth simulation? 

External 

Acceleration 

A constant, external acceleration applied to the cloth. 

Random 

Acceleration 

A random, external acceleration applied to the cloth. 

World Velocity 

Scale 

How much world-space movement of the character will affect cloth vertices. The higher this value is, the more the cloth 

will move as a reaction to world space movement of the GameObject. Basically, this defines the air friction of the 

SkinnedCloth. 

World 

Acceleration 

Scale 

How much world-space acceleration of the character will affect cloth vertices. The higher this value is, the more the cloth 

will move as a reaction to world space acceleration of the GameObject. If the cloth appears lifeless, try increasing this 

value. If it appears to get unstable when the character accelerates, try decreasing the value. 
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class-WheelCollider 
The Wheel Collider is a special collider for grounded vehicles. It has built-in collision detection, wheel physics, and a slip-based tire friction 

model. It can be used for objects other than wheels, but it is specifically designed for vehicles with wheels.  

 

The Wheel Collider Component. Car model courtesy of ATI Technologies Inc. 

Properties 

  
Center Center of the wheel in object local space. 

Radius Radius of the wheel. 

Suspension Distance Maximum extension distance of wheel suspension, measured in local space. Suspension always extends 

downwards through the local Y-axis. 

Suspension Spring The suspension attempts to reach a Target Position by adding spring and damping forces. 

Spring Spring force attempts to reach the Target Position. A larger value makes the suspension reach the Target 

Position faster. 

Damper Dampens the suspension velocity. A larger value makes the Suspension Spring move slower. 

Target Position The suspension's rest distance along Suspension Distance. 0 maps to fully extended suspension, and 1 maps 

to fully compressed suspension. Default value is zero, which matches the behavior of a regular car's 

suspension. 

Mass The Mass of the wheel. 

Forward/Sideways 

Friction 

Properties of tire friction when the wheel is rolling forward and sideways. See Wheel Friction Curves section 

below. 

Details 

http://unity3d.com/support/documentation/printable.html#Friction


The wheel's collision detection is performed by casting a ray from Center downwards through the local Y-axis. The wheel has a Radius 

and can extend downwards according to the Suspension Distance. The vehicle is controlled from scripting using different properties: 

motorTorque, brakeTorque and steerAngle. See the Wheel Collider scripting reference for more information.  

The Wheel Collider computes friction separately from the rest of physics engine, using a slip-based friction model. This allows for more 

realistic behaviour but also causes Wheel Colliders to ignore standard Physic Material settings.  

Wheel collider setup 

You do not turn or roll WheelCollider objects to control the car - the objects that have WheelCollider attached should always be fixed 

relative to the car itself. However, you might want to turn and roll the graphical wheel representations. The best way to do this is to setup 

separate objects for Wheel Colliders and visible wheels:  

 

Wheel Colliders are separate from visible Wheel Models 

Collision geometry 

Because cars can achieve large velocities, getting race track collision geometry right is very important. Specifically, the collision mesh 

should not have small bumps or dents that make up the visible models (e.g. fence poles). Usually a collision mesh for the race track is 

made separately from the visible mesh, making the collision mesh as smooth as possible. It also should not have thin objects - if you have 

a thin track border, make it wider in a collision mesh (or completely remove the other side if the car can never go there).  

 

Visible geometry (left) is much more complex than collision geometry (right) 

Wheel Friction Curves  

Wheel Friction Curves 

http://unity3d.com/support/documentation/ScriptReference/WheelCollider.html
http://unity3d.com/support/documentation/Components/class-PhysicMaterial.html
http://unity3d.com/support/documentation/Components/class-MeshCollider.html
http://unity3d.com/support/documentation/printable.html#Friction


Tire friction can be described by the Wheel Friction Curve shown below. There are separate curves for the wheel's forward (rolling) 

direction and sideways direction. In both directions it is first determined how much the tire is slipping (based on the speed difference 

between the tire's rubber and the road). Then this slip value is used to find out tire force exerted on the contact point.  

The curve takes a measure of tire slip as an input and gives a force as output. The curve is approximated by a two-piece spline. The first 

section goes from (0 , 0) to (ExtremumSlip , ExtremumValue), at which point the curve's tangent is zero. The second section goes from 

(ExtremumSlip , ExtremumValue) to (AsymptoteSlip , AsymptoteValue), where curve's tangent is again zero:  

 

Typical shape of a wheel friction curve 

The property of real tires is that for low slip they can exert high forces, since the rubber compensates for the slip by stretching. Later when 

the slip gets really high, the forces are reduced as the tire starts to slide or spin. Thus, tire friction curves have a shape like in the image 

above.  

  

Extremum Slip/Value Curve's extremum point. 

Asymptote Slip/Value Curve's asymptote point. 

Stiffness Multiplier for the Extremum Value and Asymptote Value (default is 1). Changes the stiffness of the friction. 

Setting this to zero will completely disable all friction from the wheel. Usually you modify stiffness at runtime to 

simulate various ground materials from scripting. 

Hints 

 You might want to decrease physics timestep length in Time Manager to get more stable car physics, especially if it's a racing car that can 

achieve high velocities.  

 To keep a car from flipping over too easily you can lower its Rigidbody center of mass a bit from script, and apply "down pressure" force 

that depends on car velocity.  
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comp-GameObjectGroup 
GameObjects are containers for all other Components. All objects in your game are GameObjects that contain different Components. 

Technically you can create a Component without GameObject, but you won't be able to use it until you apply it to a GameObject.  

 GameObject  
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class-GameObject 
GameObjects are containers for all other Components. All objects in your game are inherently GameObjects.  

http://unity3d.com/support/documentation/Components/class-TimeManager.html
http://unity3d.com/support/documentation/Components/class-Rigidbody.html
http://unity3d.com/support/documentation/Components/Components.html
http://unity3d.com/support/documentation/Components/class-GameObject.html
http://unity3d.com/support/documentation/Components/Components.html


 

An empty GameObject 

Creating GameObjects 

GameObjects do not add any characteristics to the game by themselves. Rather, they are containers that hold Components, which 

implement actual functionality. For example, a Light is a Component which is attached to a GameObject.  

If you want to create a Component from script, you should create and empty GameObject and then add required Component using 

gameObject.AddComponent(ClassName) function. You can't create Component and then make a reference from object to it.  

From scripts, Components can easily communicate with each other through message sending or the GetComponent(TypeName) function. 

This allows you to write small, reusable scripts that can be attached to multiple GameObjects and reused for different purposes.  

Details 

Aside from being a container for the components, GameObjects have a Tag, a Layer and a Name.  

Tags are used to quickly find objects, utilizing the Tag name. Layers can be used to cast rays, render, or apply lighting to certain groups of 

objects only. Tags and Layers can be set with the Tag Manager, found in Edit->Project Settings->Tags.  

Static Checkbox 

In Unity, there is a new checkbox in the GameObject called Static. This checkbox is used for:  

 preparing static geometry for automatic batching  

 calculating Occlusion Culling  

 

The Static checkbox is used when generating Occlusion data 

When generating Occlusion data, marking a GameObject as Static will enable it to cull (or disable) mesh objects that cannot be seen 

behind the Static object. Therefore, any environmental objects that are not going to be moving around in your scene should be marked as 

Static.  

For more information about how Occlusion Culling works in Unity please read the Occlusion Culling page.  

Hints 

 For more information see the GameObject scripting reference page.  

http://unity3d.com/support/documentation/Components/class-Light.html
http://unity3d.com/support/documentation/Components/class-TagManager.html
http://unity3d.com/support/documentation/Manual/Occlusion%20Culling.html
http://unity3d.com/support/documentation/Manual/Occlusion%20Culling.html
http://unity3d.com/support/documentation/ScriptReference/GameObject.html


 More information about how to use layers can be found here.  

 More information about how to use tags can be found here.  
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comp-ImageEffects 
This group handles all Render Texture-based fullscreen image postprocessing effects. They are only available with Unity Pro. They add a 

lot to the look and feel of your game without spending much time on artwork.  

 Antialiasing (PostEffect)  

 Bloom and Lens Flares  

 Color Correction Curves  

 Contrast Enhance  

 Crease  

 Depth of Field 3.4  

 Edge Detect Effect Normals  

 Fisheye image effect  

 Global Fog  

 Sun Shafts  

 Tilt Shift  

 Vignetting  

 Blur image effect  

 Color Correction image effect  

 Contrast Stretch image effect  

 Edge Detection image effect  

 Glow image effect  

 Grayscale image effect  

 Motion Blur image effect  

 Noise image effect  

 Sepia Tone image effect  

 Screen Space Ambient Occlusion (SSAO) image effect  

 Twirl image effect  

 Vortex image effect  

The scene used in above pages looks like this without any image effects applied:  

http://unity3d.com/support/documentation/Components/Layers.html
http://unity3d.com/support/documentation/Components/Tags.html
http://unity3d.com/support/documentation/Components/script-AntialiasingAsPostEffect.html
http://unity3d.com/support/documentation/Components/script-BloomAndLensFlares.html
http://unity3d.com/support/documentation/Components/script-ColorCorrectionCurves.html
http://unity3d.com/support/documentation/Components/script-ContrastEnhance.html
http://unity3d.com/support/documentation/Components/script-Crease.html
http://unity3d.com/support/documentation/Components/script-DepthOfField34.html
http://unity3d.com/support/documentation/Components/script-EdgeDetectEffectNormals.html
http://unity3d.com/support/documentation/Components/script-Fisheye.html
http://unity3d.com/support/documentation/Components/script-GlobalFog.html
http://unity3d.com/support/documentation/Components/script-SunShafts.html
http://unity3d.com/support/documentation/Components/script-TiltShift.html
http://unity3d.com/support/documentation/Components/script-Vignetting.html
http://unity3d.com/support/documentation/Components/script-BlurEffect.html
http://unity3d.com/support/documentation/Components/script-ColorCorrectionEffect.html
http://unity3d.com/support/documentation/Components/script-ContrastStretchEffect.html
http://unity3d.com/support/documentation/Components/script-EdgeDetectEffect.html
http://unity3d.com/support/documentation/Components/script-GlowEffect.html
http://unity3d.com/support/documentation/Components/script-GrayscaleEffect.html
http://unity3d.com/support/documentation/Components/script-MotionBlur.html
http://unity3d.com/support/documentation/Components/script-NoiseEffect.html
http://unity3d.com/support/documentation/Components/script-SepiaToneEffect.html
http://unity3d.com/support/documentation/Components/script-SSAOEffect.html
http://unity3d.com/support/documentation/Components/script-TwirlEffect.html
http://unity3d.com/support/documentation/Components/script-VortexEffect.html


 

Scene with no image postprocessing effects. 

Multiple image effects can be "stacked" on the same camera. Just add them and it will work.  

 

Blur and Noise applied to the same camera. Yay for noisy blur! 
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script-AntialiasingAsPostEffect 
Antialiasing (PostEffect) is a collection of image based algorithms reduce aliasing (e.g. smoothen edges). This is very useful for deferred 

rendering where traditional multisampling is not properly supported. Current supported algorithms are NVIDIA's FXAA and FXAA II, simpler 

luminance based edge blurs (NFAA, SSAA) that blur local edges only and an adaption of the DLAA algorithm that also addresses long 

edges. SSAA is the fastest technique, followed by NFAA, FXAA II, DLAA and the the other FXAA's. The image quality is typically but not 

always in reversed order.  

As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

Properties 

  
AA Technique The algorithm to be used. 

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


Hardware support 

This effect requires a graphics card with pixel shaders (3.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2004 (GeForce 6), AMD cards 

since 2005 (Radeon X1300), Intel cards since 2006 (GMA X3000); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-BloomAndLensFlares 
The Bloom and Lens Flares image effect adds image based bloom and automatically generates lens flares (Image based lens flares 

should be cast based on bright parts of the color buffer, so it's very performant to provide a built in lens flare system here). It can drastically 

enhance the feel and look of your scene. This effect is a more modern version of the older Glow image effect with a more fine grain control 

over various glow parameters.  

 

Example use of Bloom and Lens Flares demonstration a very soft glow using the new Screen blend mode and how the new anamorphic lens flares can easily create 

a more cinematic feeling. 

As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

Properties 

  
Mode Choose complex mode fore more tweaking options such as enabling lens flare. 

Blend mode How to add the bloom to the color buffer. The softer Screen blend is better at keeping bright image parts alive. 

Intensity The global light intensity of the added light (affects both, bloom and lens flares). 

Threshhold The global light intensity threshhold that defines which image parts are being considered for blooming (and lens 

flares creation). 

Blur iterations The smoothness of the bloom and flares. Remember that more iterations result in a more expensive effect. 

Blur spread The global, resolution independent spread (width) of the effect. 

Use alpha mask How much you want to have the alpha channel act as a mask for the bloom effect. 

Cast lens flares Enable or disable lens flares. 

Mode The kind of lens flares that should be cast. Chose between Ghosting, Anamorphic or a combination of both. 

Local intensity Additional intensity for all lens flares. 

Local threshhold The additional light intensity threshhold that defines which image parts are being considered for lens flares. 

Stretch width The width for anamorphic lens flares. 

Blur iterations Defines the smoothness for anamorphic lens flares. 

Tint Color Color modulation for the anamorphic flare type. 

http://unity3d.com/support/documentation/Components/script-GlowEffect.html
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


1st-4th Color Color modulation for all additional lens flares when Ghosting or Combined is chosen. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-ColorCorrectionCurves 
Color Correction Curves change the color buffer simply by tweaking curves for each color channel. Depth based and selective color 

correction is also available.  

As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

Properties 

  

Mode Chose between advanced or simple configuration modes. 

Red The red channel curve. 

Green The green channel curve. 

Blue The blue channel curve. 

Red (Depth) The red channel curve for depth based correction. 

Green (Depth) The green channel curve for depth based correction. 

Blue (Depth) The blue channel curve for depth based correction. 

Blend Curve Defines how blending between foreground and background color correction is performed. 

Selective Color Correction 

Enable Enables the optional selective color correction. 

Key The key color for selective color correction. 

Target The target color for selective color correction. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. Additionally, depth texture support is required. PC: NVIDIA 

cards since 2004 (GeForce 6), AMD cards since 2004 (Radeon 9500), Intel cards since 2006 (GMA X3000); Mobile: OpenGL ES 2.0 with 

depth texture support; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-ContrastEnhance 
The Contrast Enhance image effect enhances the overall contrast of the current color buffer. It uses a technique that is usually known as 

Unsharp Mask.  

As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

No Contrast Enhance 

 

Contrast enhance enabled 

Properties 

  

Intensity The intensity of the contrast enhance. 

Threshhold The threshhold that defines where contrast enhancing is applied. 

Blur Spread The blur radius that also defines the contrast enhance radius. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-Crease 
The Crease is a common NPR (non photo realistic) rendering technique that enhances the visibility of objects by creating variably sized 

outlines.  

As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

 

Crease shading creates depth distance based outlines. 

Properties 

  

Intensity The intensity of the crease shading. 

Softness The smoothness and softness of the applied crease shading. 

Spread The blur radius that also defines the crease radius. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. Additionally, depth texture support is required. PC: NVIDIA 

cards since 2004 (GeForce 6), AMD cards since 2004 (Radeon 9500), Intel cards since 2006 (GMA X3000); Mobile: OpenGL ES 2.0 with 

depth texture support; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-DepthOfField34 
The Depth of Field 3.4 image effect is a common post effect simulating camera lens systems. It has been updated with new features and 

faster execution for Unity 3.4, hence the name. An example for the new Depth of Field effect can be seen in the following images, 

displaying the results of a defocused foreground and a defocused background. Notice how the foreground blur overlaps with the rest while 

the background doesn't. You might also consider the Tilt Shift effect for a simpler to use but less powerful depth of field effect.  

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/script-TiltShift.html


 

Only the nearby pipes are in the focal area 

 

Foreground vs. Background blurring with Depth of Field 

As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

Properties 

  
General Settings 

Resolution Determines the internal render target sizes. The lower the resolution the faster the effect and the lower the 

memory requirements will be. 

Quality The quality level. Chose between the faster OnlyBackground or the slower BackgroundAndForeground 

options which calculates the Depth of Field defocus for both areas seperately. 

Simple tweak Switches to a simpler focal model. 

Visualize focus Visualizes the focal areas in the game view. 

Enable bokeh This will generate more realistic lens blurs where very bright parts are scaled and overlap. 

Focal Settings 

Focal distance The distance to the focal point from the camera position in world space. 

Object Focus Instead of setting the distance manually you can always autofocus on this Transform. 

Smoothness The smoothness when transitioning from out-of-focus to in-focus areas. 

Focal size The size of the in-focus area. 

Blur 

Blurriness How many iterations are taken for defocusing the various buffers. 

Blur spread The blur distance (resolution independent, you might have to re-tweak if the resolution changes drastically). 

Bokeh Settings 

Destination Enabling foreground and background blur will be a lot slower but gives more realistic results. 

Intensity Blend intensity when all bokeh shapes are being accumulated. This is a critical value that always needs to be carefully 

adjusted. 

Min 

luminance 

The luminance threshhold for all pixels that should be considered. 

Min contrast The contrast threshhold for all pixels that should be considered (this is important as usually, you only need bokeh shapes in 

areas of high frequency. They would be close to invisible otherwise. It also helps performance as it can save a lot of fillrate.). 

Downsample The size of the internal render target used for accumulating bokeh shapes. 

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


Size The maximum bokeh size. Will be modulated by the amount of defocus (Circle of Confusion). 

Bokeh 

Texture 

The texture defining the bokeh shapes. 

Note about the Bokeh effect: as it is based on drawing triangles per pixel it can drastically affect your framerate, especially if it's not 

properly tweaked. Adjust the Size, Min luminance, Min contrast, Downsample and Resolution for highest performance. Also, as it pre-

darkens the screen before applying the bokeh shapes, one should take care of using an apropriately high Blurriness level to remove 

possible artefacts.  

Hardware support 

This effect requires a graphics card with pixel shaders (3.0) or OpenGL ES 2.0. Additionally, depth texture support is required. PC: NVIDIA 

cards since 2004 (GeForce 6), AMD cards since 2005 (Radeon X1300), Intel cards since 2006 (GMA X3000); Mobile: OpenGL ES 2.0 with 

depth texture support; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-EdgeDetectEffectNormals 
This Edge Detect image effect creates outlines around edges. Note that this version of the image effect actually works on real geometry 

i.e. scene depth and normals to detect edges.  

As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

 

Scene without edge detection 

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Detected edges of the same scene 

Properties 

  

Mode Chose between Thin and Thick. Thick will take more samples into consideration to construct outlines. 

Edge Sensitivity 

Depth The depth sensitivity that defines the needed depth difference when identifying edges. 

Normals The normals sensitivity that defines the needed difference between neighbouring normals when identifying edges. 

Background options 

Edges only Blend the background with a fixed color. 

Background The color used when Edges only is > 0. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. Additionally, depth texture support is required. PC: NVIDIA 

cards since 2004 (GeForce 6), AMD cards since 2004 (Radeon 9500), Intel cards since 2006 (GMA X3000); Mobile: OpenGL ES 2.0 with 

depth texture support; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  

Page last updated: 2011-05-12 

 

 

script-Fisheye 
The Fisheye image effect creates distorts the image like a (fisheye) lens would do.  

As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Fisheye distorts the image at its corners. The use of image antialiasing techniques is highly recommended because of sampling artefacts. 

Properties 

  
Strength X The horizontal distortion. 

Strength Y The vertical distortion. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-GlobalFog 
The Global Fog image effect creates camera based exponential fog. All calculations are done in world space which makes it possible to 

have height based fog modes that can be used for more interesting effects (see example).  

http://unity3d.com/support/documentation/Components/script-AntialiasingAsPostEffect.html


 

Global fog example demonstrating both distance and height based fog 

 

Example for cheating athmospheric effects using the global fog effect 

As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

Properties 

  

Fog Mode Chose the type of fog: distance, height based or both 

Start Distance In world space units, the distance when fog starts fading in. 

Global Density The fog density that fades between the color buffer and the Fog Color. 

Height Scale How the fog density fades when height based fog is chosen. 

Height The y world space position when the fog starts fading in. 

Global Fog Color The fog color the color buffer will be blended to. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. Additionally, depth texture support is required. PC: NVIDIA 

cards since 2004 (GeForce 6), AMD cards since 2004 (Radeon 9500), Intel cards since 2006 (GMA X3000); Mobile: OpenGL ES 2.0 with 

depth texture support; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-SunShafts 
The Sun Shafts image effect is a powerful technique to create radial light scattering such as god rays or light beams that are originating 

from a very bright light source.  

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

 

Example for Sun Shafts. 

Properties 

  

Rely on Z Buffer This option can be used when no depth textures are available or too expensive to calculate (e.g. in forward 

rendering with plenty of objects). Note that if this option is disabled it is required that the Sun Shafts effect is the 

very first image effect of a camera. 

Resolution The used resolution. Lower resolutions are faster to calculate and create softer results. 

Blend Mode Chose between the softer Screen or a simple Add operation. 

Sun Transform The transform of the light source that casts the Sun Shafts. Only the position is important. 

Center on ... Move the Sun Transform along a ray from the center of the game view camera. 

Shafts color The tint color of the shafts. 

Distance falloff The intensity falloff speed that lessens the sun shafts intensity the further away from the Sun Transform. 

Blur size The blur length 

Blur 

iterations 

The iterations for creating sun shafts. More iterations will generate smoother and longer light beams but are also more 

expensive to calculate. 

Intensity The brightness of the added Sun Shafts. 

Use alpha 

mask 

Defines how much the alpha channel of the color buffer should be used when generating Sun Shafts. This is useful e.g. when 

your skybox has a proper alpha channel that defines a mask (e.g. for clouds blocking the sun shafts). 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. Additionally, depth texture support is required. PC: NVIDIA 

cards since 2004 (GeForce 6), AMD cards since 2004 (Radeon 9500), Intel cards since 2006 (GMA X3000); Mobile: OpenGL ES 2.0 with 

depth texture support; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-TiltShift 

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


The Tilt Shift image effect is a specialized Depth of Field effect that demonstrates how to enable very smooth transitions between focused 

and defocused areas. It is also is easier to use and has generally less possible image artefacts. However, as it is among other things 

relying on dependent texture lookups, it can also be more expensive.  

 

Tilt shift example. Observe the overall achieved smoothness of the effect. 

As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

Properties 

  

Focal Settings 

Visualize Visualizes the focal areas in the game view with a green tint. 

Distance The distance to the focal point from the camera position in world space. 

Smoothness The smoothness when transitioning from out-of-focus to in-focus areas. 

Background Blur 

Downsample Downsamples most internal buffers (Makes the effect faster and more blurry). 

Iterations Number of iterations for blurring the background areas (all things behind the focal area). 

Max Blur spread The maximum blur distance for the defocused areas. Makes out of focus areas proceedingly more blurry. 

Foreground Blur 

Enable Enables foreground blurring. This will make the effect more expensive. 

Iterations Number of iterations for blurring the foreground areas (all things in front of the focal area). 

Hardware support 

This effect requires a graphics card with pixel shaders (3.0) or OpenGL ES 2.0. Additionally, depth texture support is required. PC: NVIDIA 

cards since 2004 (GeForce 6), AMD cards since 2005 (Radeon X1300), Intel cards since 2006 (GMA X3000); Mobile: OpenGL ES 2.0 with 

depth texture support; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-Vignetting 
The Vignetting image effect creates darkened, blurred or color shifted (chromatic aberration) image outlines. This is usually simulating 

common camera lens effects but can also be used as for dynamic special effects.  

http://unity3d.com/support/documentation/Components/script-DepthOfField34.html
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Example for Vignetting. Notice how the screen corners get darker, more blurry and have shifted color offsets. 

As with the other image effects, this effect is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

Properties 

  

Intensity The intensity of the applied vignette that is effectively darkening the screen corners. 

Chromatic Aberration The intensity of the used chromatic aberration. Choose 0.0 to disable chromatic aberration entirely. 

Blur The amount of blur that is added to the screen corners. 

Blur Spread The blur width used when Blur is added. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-BlurEffect 
Blur image effect blurs the rendered image in real-time.  

As with the other image effects, Blur is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Blur effect applied to the scene 

Properties 

  
Iterations The amount of blurriness desired. Higher iteration count makes the image more blurry, but each additional 

iteration has some performance cost. 

Blur Spread Higher values will spread out the blur more at the same iteration count, but at some expense in quality. Usually 

values from 0.6 to 0.7 are a good compromise between quality and speed. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-ColorCorrectionEffect 
Color Correction allows you apply arbitrary color correction to your scene as a postprocessing effect (just like the Curves tool in 

Photoshop or Gimp). This page explains how to setup color correction in Photoshop and then apply exactly the same color correction at 

runtime in Unity.  

Like all image effects, Color Correction is only available in Pro version of Unity. Make sure to have the Pro Standard Assets installed.  

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Color correction applied to the scene. Color ramp used (magnified) is shown at the right. 

 

Color ramp used for the image above. 

Getting color correction from Photoshop into Unity 

1. Take a screenshot of a typical scene in your game  

2. Open it in Photoshop and color correct using the Image->Adjustments->Curves  

3. Save the .acv file file from the dialog using Save...  

4. Open Pro Standard Assets->Image Based->color correction ramp.png in Photoshop  

5. Now apply color correction to the ramp image: open Image->Adjustments->Curves again and load your saved .acv file  

6. Select your camera in Unity and select Component->Image Effects->Color Correction to add color correction effect. Select your 

modified color ramp.  

7. Hit Play to see the effect in action!  

Details 

Color correction works by remapping the original image colors through the color ramp image (sized 256x1):  

1. result.red = pixel's red value in ramp image at (original.red + RampOffsetR) index  

2. result.green = pixel's green value in ramp image at (original.green + RampOffsetG) index  

3. result.blue = pixel's blue value in ramp image at (original.blue + RampOffsetB) index  

So for example, to invert the colors in the image you only need to flip the original color ramp horizontally (so that it goes from white to black 

instead of from black to white).  

A simpler version of color remapping that only remaps based on luminance can be achieved with Grayscale image effect.  

Tips: 

 The color correction ramp image should not have mip-maps. Turn them off in Import Settings. It should also be set to Clamp mode.  

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  

http://unity3d.com/support/documentation/Components/script-GrayscaleEffect.html
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script-ContrastStretchEffect 
Contrast Stretch dynamically adjusts contrast of the image based on its brightness. It does that with a delay, so when going out of a dark 

tunnel the player can be almost blinded by bright outdoor light. And vice versa - when changing from a bright scene to a dark one, the eye 

takes some time to adapt.  

Like all image effects, Contrast Stretch is only available in Pro version of Unity. Make sure to have the Pro Standard Assets installed.  

 

No Contrast Stretch applied. 

 

Contrast stretch applied with a dark skybox. Note that buildings get brighter. 

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Contrast stretch applied with a very bright skybox. Note that buildings get darker. 

Properties 

  
Adaptation Speed The speed of the transition. The lower this number, the slower the transition 

Limit Minimum The darkest overall contrast value that the Camera will be adjusted to 

Limit Maximum The brightest overall contrast value that the Camera will be adjusted to 

Tips: 

 Contrast Stretch only works while in play mode because it's time based.  

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-EdgeDetectEffect 
Edge Detect image effect adds black edges to the image where color differences exceed some threshold.  

If proper geometry based edge detection is needed, the Standard Assets also provide a more complex normal-based edge detection.  

Like all image effects, Edge Detection is available in Unity Pro only. Make sure to have the Pro Standard Assets installed.  

http://unity3d.com/support/documentation/Components/script-EdgeDetectEffectNormals.html
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Edge Detect image effect applied to the scene 

  

Threshold Edges will be displayed whenever color difference in neighboring pixels exceeds this amount. Increase this 

value to make edges less sensitive to texture or lighting changes. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-GlowEffect 
Glow (sometimes called "Bloom") can dramatically enhance the rendered image by making overbright parts "glow" (e.g. sun, light sources, 

strong highlights). The Bloom and Lens Flares effect is a more complex and powerful but also more expensive version of the Glow effect.  

Unity includes a Glow image postprocessing effect, and all built-in shaders are made to support it nicely. Like all image effects, Glow is 

available in Unity Pro only. Make sure to have the Pro Standard Assets installed.  

http://unity3d.com/support/documentation/Components/script-BloomAndLensFlares.html
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Glow effect applied to the scene 

Properties 

  
Glow Intensity Total brightness at the brightest spots of the glowing areas. 

Blur Iterations Number of times the glow is blurred when being drawn. 

Blur Spread Multiple of the glow's residual reach. 

Glow Tint Color tint applied to the visible glow. 

Downsample Shader The shader used for the glow. You generally should not have to change this. 

Details 

Glow uses the alpha channel of the final image to represent "color brightness". All colors are treated as RGB, multiplied by the alpha 

channel. You can view the contents of the alpha channel in Scene View.  

All built-in shaders write the following information to alpha:  

 Main texture's alpha multiplied by main color's alpha (not affected by lighting).  

 Specular shaders add specular highlight multiplied by specular color's alpha.  

 Transparent shaders do not modify alpha channel at all.  

 Particle shaders do not modify alpha channel, except for Particles/Multiply which darkens anything that is in alpha.  

 Skybox shaders write alpha of the texture multiplied by tint alpha  

Most of the time you'll want to do this to get reasonable glow:  

 Set material's main color alpha to zero or use a texture with zero alpha channel. In the latter case, you can put non-zero alpha in the texture 

to cause these parts to glow.  

 Set the specular color alpha for Specular shaders to be 100%.  

 Keep in mind what alpha the camera clears to (if it clears to a solid color), or what alpha the skybox material uses.  

 Add the Glow image effect to the camera. Tweak Glow Intensity and Blur Iterations values, you can also take a look at the comments in the 

shader script source.  

 The alpha channel on the Skybox can be used to great effect to add more glow when looking at the sun  

Tips: 

 Use the alpha rendering mode in the scene view toolbar to quickly see which objects output different values to the alpha channel.  

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  



All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-GrayscaleEffect 
Grayscale is a simple image effect that changes colors to grayscale by default. It can also use a Texture Ramp texture to remap 

luminance to arbitrary colors.  

Like all image effects, Grayscale is available in Unity Pro only. Make sure to have the Pro Standard Assets installed.  

 

Grayscale image effect applied to the scene  

Remapping colors 

Grayscale can do a simple version of color correction, i.e. remap grayscale image into arbitrary colors. This can be used for effects like heat 

vision.  

The process of color remapping is very similar to ColorCorrection effect:  

1. Take a screenshot of a typical scene in your game.  

2. Open it in Photoshop and convert to grayscale.  

3. Color correct it using the Image->Adjustments->Curves.  

4. Save the .acv file file from the dialog using Save...  

5. Open Pro Standard Assets->Image Based->color correction ramp.png in Photoshop  

6. Now apply color correction to the ramp image: open Image->Adjustments->Curves again and load your saved .acv file  

7. Select your camera in Unity and select Component->Image Effects->Grayscale to add the effect. Select your modified color 

ramp.  

8. Hit Play to see the effect in action!  

Details 

Color remapping works by remapping the original image luminance through the color ramp image (sized 256x1):  

 result color = pixel's color in the ramp image at (OriginalLuminance + RampOffset) index. For example, to invert the colors in the image 

you only need to flip the original color ramp horizontally (so that it goes from white to black instead of from black to white):  

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html
http://unity3d.com/support/documentation/Components/script-ColorCorrectionEffect.html


 

Grayscale applied to the scene with color ramp that goes from white to black.  

A more complex version of color remapping that does arbitrary color correction can be achieved with ColorCorrection image effect.  

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-MotionBlur 
Motion Blur image effect enhances fast-moving scenes by leaving "motion trails" of previously rendered frames.  

Like all image effects, Motion Blur is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

http://unity3d.com/support/documentation/Components/script-ColorCorrectionEffect.html
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Motion Blur effect applied to the rotating scene 

  

Blur Amount How much of the previous frames to leave in the image. Higher values make longer motion trails. 

Extra Blur If checked, this makes motion trails more blurry, by applying some extra blur to previous frames. 

Tips: 

 Motion Blur only works while in play mode because it's time based.  

Hardware support 

Motion Blur effect works all graphics cards that support rendering to a texture. E.g. GeForce2, Radeon 7000 and up. All image effects 

automatically disable themselves when they can not run on an end-users graphics card.  
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script-NoiseEffect 
Noise is an image postprocessing effect that can simulate both TV and VCR noise.  

Like all image effects, Noise is only available in Unity Pro. Make sure to have the Pro Standard Assets installed.  

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Noise effect with high intensity applied to the scene 

  

Monochrome If enabled, Noise is more similar to TV noise. If disabled, it more resembles VCR noise - it distorts color values 

in YUV space, so you also get hue changes, mostly towards magenta/green gues. 

Grain Intensity Min/Max The intensity of noise takes random values between Min and Max. 

Grain Size The size of a single grain texture pixel in screen pixels. Increasing this will make noise grains larger. 

Scratch Intensity Min/Max The intensity of additional scratch/dust takes random values between Min and Max. 

Scratch FPS Scratches jump to different positions on the screen at this frames per second. 

Scratch Jitter While being in the same position, scratches can still jitter a bit. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-SepiaToneEffect 
Sepia Tone is a simple image effects that changes image colors.  

Like all image effects, Sepia Tone is available in Unity Pro only. Make sure to have the Pro Standard Assets installed.  

http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Sepia Tone image effect applied to the scene 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-SSAOEffect 
Screen Space Ambient Occlusion (SSAO) approximates Ambient Occlusion in realtime, as an image post-processing effect. It darkens 

creases, holes and surfaces that are close to each other.  

Like all image effects, SSAO is only available in Pro version of Unity. Make sure to have the Pro Standard Assets installed. 

If you want to include the SSAO image effect, then click on Component -> Image Effects -> Screen Space Ambient Occlusion.  

 

SSAO applied to the scene. 

http://en.wikipedia.org/wiki/Ambient_occlusion
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

For comparison, no SSAO. Note differences where structures or grass meet the ground. 

Properties 

  
Radius Occlusion radius. 

Sample Count Number of ambient occlusion samples. The higher the same count, the better the quality (but more expensive 

to compute). 

Occlusion Intensity Intensity of ambient occlusion. 

Blur Amount of blur to apply to ambient occlusion. No blur (0) is much faster, but the image will be noisy. 

Downsampling At what resolution calculations should be performed. Downsampling value of 2 will perform them at 2x2 smaller 

resolution than screen; value of 1 will perform at screen resolution; etc. More downsampling is faster to 

compute. 

Occlusion Attenuation How fast occlusion should attenuate with distance. 

Min Z Try increasing this value if there are artifacts. 

Details 

SSAO computes ambient occlusion purely in image space. It's cost only depends on screen resolution and SSAO parameters, and does 

not depend on scene complexity. However, because it is an image effect, it has some artifacts: objects that are outside of the screen do not 

contribute to occlusion; computed occlusion is dependent on viewing angle and camera's position and so on.  

Note that SSAO is quite expensive effect and generally should only be used on high-end graphics cards. Using SSAO will cause Unity to 

render depth+normals texture of the camera, which increases number of draw calls and is a cost on the CPU. However, that depth+normals 

texture then can be used for other effects as well (like Depth of Field). SSAO effect itself is only a cost on the graphics card.  

Hardware support 

SSAO works on graphics cards with Shader Model 3.0 support. E.g. GeForce 6 and later, Radeon X1300 and later. All image effects 

automatically disable themselves when they can not run on an end-users graphics card.  

Note: Support differs on the hardware basis; SSAO is anyway too expensive for any real use on mobile devices - so noone should bother 

thinking if it supported on this or that device.  
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script-TwirlEffect 
Twirl image effect distorts the rendered image. Similar to Vortex, it distorts the image in a circular region.  

Like all image effects, Twirl is available in Unity Pro only. Make sure to have the Pro Standard Assets installed.  

http://unity3d.com/support/documentation/Components/script-VortexEffect.html
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Twirl image effect applied to the scene 

  

Radius The radii of the ellipse where image distortion takes place. Radius of 0.5 is half the size of the screen. 

Angle Controls the amount of distortion applied. 

Center Position the distortion area on the screen. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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script-VortexEffect 
Vortex image effect distorts the rendered image. Similar to Twirl, it distorts the image in a circular region.  

Like all image effects, Vortex is available in Unity Pro only. Make sure to have the Pro Standard Assets installed.  

http://unity3d.com/support/documentation/Components/script-TwirlEffect.html
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Vortex image effect applied to the scene 

  

Radius The radii of the ellipse where image distortion takes place. Radius of 0.5 is half the size of the screen. 

Angle Controls the amount of distortion applied. 

Center Position the distortion area on the screen. 

Hardware support 

This effect requires a graphics card with pixel shaders (2.0) or OpenGL ES 2.0. PC: NVIDIA cards since 2003 (GeForce FX), AMD cards 

since 2004 (Radeon 9500), Intel cards since 2005 (GMA 900); Mobile: OpenGL ES 2.0; Consoles: Xbox 360, PS3.  

All image effects automatically disable themselves when they can not run on end-users graphics card.  
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comp-ManagerGroup 

 Audio Manager  

 Input Manager  

 Network Manager  

 Physics Manager  

 Player Settings  

 Quality Settings  

 Render Settings  

 Tag Manager  

 Time Manager  
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class-AudioManager 
The Audio Manager allows you to tweak the maximum volume of all sounds playing in the scene. To see it choose Edit->Project 

Settings->Audio.  

http://unity3d.com/support/documentation/Components/class-AudioManager.html
http://unity3d.com/support/documentation/Components/class-InputManager.html
http://unity3d.com/support/documentation/Components/class-NetworkManager.html
http://unity3d.com/support/documentation/Components/class-PhysicsManager.html
http://unity3d.com/support/documentation/Components/class-PlayerSettings.html
http://unity3d.com/support/documentation/Components/class-QualitySettings.html
http://unity3d.com/support/documentation/Components/class-RenderSettings.html
http://unity3d.com/support/documentation/Components/class-TagManager.html
http://unity3d.com/support/documentation/Components/class-TimeManager.html


 

The Audio Manager 

Properties 

  
Volume The volume of all sounds playing. 

Speed of Sound The speed of sound. 343 is the real world speed of sound, if you are using a meters as your units. You can 

adjust this value to make your objects have more or less Doppler effect with larger or smaller speed. 

Doppler Factor How audible the Doppler effect is. When it is zero it is turned off. 1 means it should be quite audible for fast 

moving objects. 

Default Speaker Mode Defines which speaker mode should be the default for your project. Default is 2 for stereo speaker setups (see 

AudioSpeakerMode in the scripting API reference for a list of modes). 

Rolloff Scale Sets the global attenuation rolloff factor for Logarithmic rolloff based sources (see Audio Source). The higher 

the value the faster the volume will attenuate, conversely the lower the value, the slower it attenuate (value of 1 

will simulate the "real world"). 

Details 

If you want to use Doppler Effect set Doppler Factor to 1. Then tweak both Speed of Sound and Doppler Factor until you are satisfied. 

Speaker mode can be changed runtime from your application through scripting. See Audio Settings.  
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class-InputManager 
 

Desktop  
 

The Input Manager is where you define all the different input axes and game actions for your project.  

http://unity3d.com/support/documentation/ScriptReference/AudioSpeakerMode.html
http://unity3d.com/support/documentation/Components/class-AudioSource.html
http://unity3d.com/support/documentation/ScriptReference/AudioSettings.html
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The Input Manager 

To see the Input Manager choose: Edit->Project Settings->Input.  

Properties 

  

Axes Contains all the defined input axes for the current project: Size is the number of different input axes in this 

project, Element 0, 1, ... are the particular axes to modify. 

Name The string that refers to the axis in the game launcher and through scripting. 

Descriptive Name A detailed definition of the Positive Button function that is displayed in the game launcher. 

Descriptive Negative 

Name 

A detailed definition of the Negative Button function that is displayed in the game launcher. 

Negative Button The button that will send a negative value to the axis. 

Positive Button The button that will send a positive value to the axis. 

Alt Negative Button The secondary button that will send a negative value to the axis. 

Alt Positive Button The secondary button that will send a positive value to the axis. 

Gravity How fast will the input recenter. Only used when the Type is key / mouse button. 

Dead Any positive or negative values that are less than this number will register as zero. Useful for joysticks. 

Sensitivity For keyboard input, a larger value will result in faster response time. A lower value will be more smooth. For 

Mouse delta the value will scale the actual mouse delta. 



Snap If enabled, the axis value will be immediately reset to zero after it receives opposite inputs. Only used when the 

Type is key / mouse button. 

Invert If enabled, the positive buttons will send negative values to the axis, and vice versa. 

Type Use Key / Mouse Button for any kind of buttons, Mouse Movement for mouse delta and scrollwheels, 

Joystick Axis for analog joystick axes and Window Movement for when the user shakes the window. 

Axis Axis of input from the device (joystick, mouse, gamepad, etc.) 

Joy Num Which joystick should be used. By default this is set to retrieve the input from all joysticks. This is only used for 

input axes and not buttons. 

Details 

All the axes that you set up in the Input Manager serve two purposes:  

 They allow you to reference your inputs by axis name in scripting  

 They allow the players of your game to customize the controls to their liking  

All defined axes will be presented to the player in the game launcher, where they will see its name, detailed description, and default 

buttons. From here, they will have the option to change any of the buttons defined in the axes. Therefore, it is best to write your scripts 

making use of axes instead of individual buttons, as the player may want to customize the buttons for your game.  



 

The game launcher's Input window is displayed when your game is run 

See also: Input.  

Hints 

 Axes are not the best place to define "hidden" or secret functions, as they will be displayed very clearly to the player in the game launcher.  

 

iOS 
 

This section is not supported on iOS devices.  

For more info on how to work with input on iOS devices, please refer to the iOS Input page.  

 

http://unity3d.com/support/documentation/Manual/Android-Input.html
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Android 
 

This section is not supported on Android devices.  

For more info on how to work with input on Android devices, please refer to the Android Input page.  

Page last updated: 2010-09-07 

 

 

class-NetworkManager 
The Network Manager contains two very important properties for making Networked multiplayer games.  

 

The Network Manager 

You can access the Network Manager by selecting Edit->Project Settings->Network from the menu bar.  

Properties 

  

Debug Level The level of messages that are printed to the console 

Off Only errors will be printed 

Informational Significant networking events will be printed 

Full All networking events will be printed 

Sendrate Number of times per second that data is sent over the network 

Details 

Adjusting the Debug Level can be enormously helpful in fine-tuning or debugging your game's networking behaviors. At first, setting it to 

Full will allow you to see every single network action that is performed. This will give you an overall sense of how frequently you are using 

network communication and how much bandwidth you are using as a result.  

When you set it to Informational, you will see major events, but not every individual activity. Assigning unique Network IDs and buffering 

RPC calls will be logged here.  

When it is Off, only errors from networking will be printed to the console.  

The data that is sent at the Sendrate intervals (1 second / Sendrate = interval) will vary based on the Network View properties of each 

broadcasting object. If the Network View is using Unreliable, its data will be send at each interval. If the Network View is using Reliable 

Delta Compressed, Unity will check to see if the Object being watched has changed since the last interval. If it has changed, the data will 

be sent.  

Page last updated: 2007-09-15 

 

 

class-PhysicsManager 
You can access the Physics Manager by selecting Edit->Project Settings->Physics from the menu bar.  
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The Physics Manager 

Properties 

  
Gravity The amount of gravity applied to all Rigidbodies. Usually gravity acts only on the Y-axis (negative is down). 

Gravity is meters/(seconds^2). 

Default Material The default Physic Material that will be used if none has been assigned to an individual Collider. 

Bounce Threshold Two colliding objects with a relative velocity below this value will not bounce. This value also reduces jitter so it 

is not recommended to set it to a very low value. 

Sleep Velocity The default linear velocity, below which objects start going to sleep. 

Sleep Angular Velocity The default angular velocity, below which objects start going to sleep. 

Max Angular Velocity The default maximimum angular velocity permitted for any Rigidbodies. The angular velocity of Rigidbodies is 

clamped to stay within Max Angular Velocity to avoid numerical instability with quickly rotating bodies. 

Because this may prevent intentional fast rotations on objects such as wheels, you can override this value for 

any Rigidbody by scripting Rigidbody.maxAngularVelocity. 

Min Penetration For 

Penalty 

How deep in meters are two objects allowed to penetrate before the collision solver pushes them apart. A 

higher value will make objects penetrate more but reduces jitter. 

Solver Iteration Count Determines how accurately joints and contacts are resolved. Usually a value of 7 works very well for almost all 

situations. 

Raycasts Hit Triggers If enabled, any Raycast that intersects with a Collider marked as a Trigger will return a hit. If disabled, these 

intersections will not return a hit. 

Layer Collision Matrix Defines how the layer-based collision detection system will behave. 

Details 

The Physics Manager is where you define the default behaviors of your world. For an explanation of Rigidbody Sleeping, read this page 

about sleeping.  

Hints 

 If you are having trouble with connected bodies oscillating and behaving eratically, setting a higher Solver Iteration Count may improve 

their stability, but will require more processing power.  

http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html
http://unity3d.com/support/documentation/Components/RigidbodySleeping.html
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class-PlayerSettings 
Player Settings is where you define various parameters (platform specific) for the final game that you will build in Unity. Some of these 

values for example are used in the Resolution Dialog that launches when you open a standalone game, others are used by XCode when 

building your game for the iOS devices, so it's important to fill them out correctly.  

To see the Player Settings choose Edit->Project Settings->Player from the menu bar.  

 

Global Settings that apply for any project you create. 

  

Cross-Platform Properties 

Company Name The name of your company. This is used to locate the preferences file. 

Product Name The name that will appear on the menu bar when your game is running and is used to locate the preferences 

file also. 

Default Icon Default icon the application will have on every platform (You can override this later for platform specific needs). 

Per-Platform Settings 
 

Desktop  
 

Web-Player 

Resolution And Presentation 
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Resolution and presentation for web player builds. 

  
Resolution 

Default Screen Width Screen Width the player will be generated with. 

Default Screen Height Screen Height the plater will be generated with. 

Run in background Check this if you dont want to stop executing your game if the player looses focus. 

WebPlayer Template For more information you should check the "Using WebPlayer templates page", note that for each built-in and 

custom template there will be an icon in this section. 

Watermark 

Always Display 

Watermark 

Check this if you want to display Unity's Watermark when the game is running.(This is a shared setting between 

the WebPlayer and StandAlone Executables) 

   

  

Other Settings 

 

Other general settings for Web Player builds. 

  

http://unity3d.com/support/documentation/Manual/Using%20Web%20Player%20templates.html


Rendering 
 

Rendering Path This property is shared between Standalone and WebPlayer content. 

Vertex Lit Lowest lighting fidelity, no shadows support. Best used on old machines or limited mobile platforms. 

Forward with Shaders Good support for lighting features; limited support for shadows. 

Deferred Lighting Best support for lighting and shadowing features, but requires certain level of hardware support. Best used if 

you have many realtime lights. Unity Pro only. 

Static Batching Set this to use Static batching on your build (Inactive by default in webplayers). Unity Pro only. 

Dynamic Batching Set this to use Dynamic Batching on your build (Activated by default). 

Streaming 

First Streamed Level If you are publishing a Streamed Web Player, this is the index of the first level that will have access to all 

Resources.Load assets. 

Standalone (and OSX Widget) 

Resolution And Presentation 

 

Resolution and presentation for both windows/mac standalone builds. 

  
Resolution 

Default Screen Width Screen Width the stand alone game will be using by default. 

Default Screen Height Screen Height the plater will be using by default. 

Run in background Check this if you dont want to stop executing your game if it looses focus. 

Standalone Player Options 

Default is Full Screen Check this if you want to start your game by default in full screen mode. 

Capture Single Screen If enabled, standalone games in fullscreen mode will not darken the secondary monitor in multi-monitor setups. 

DisplayResolution Dialog 

Disabled No resolution dialog will appear when starting the game. 

Enabled Resolution dialog will always appear when the game is launched. 

Hidden by default The resolution player is possible to be opened only if you have pressed the "alt" key when starting the game. 

Use Player Log Write a log file with debugging information. 

Use Mac App Store 

Validation 

Enable receipt validation for the Mac App Store. 

Supported Aspect Ratios Aspect Ratios selectable in the Resolution Dialog will be monitor-supported resolutions of enabled items from 

this list. 

Dashboard Widget Options 

Use Alpha in Dashboard Enabling this will use the alpha channel rendered in Unity for the transparency of the OSX Dashboard Widget. 



This allows you to make a dashboard widget with the shape of a mesh for example. 

Watermark 

Always Display 

Watermark 

Check this if you want to display Unity's Watermark when the game is running.(This is a shared setting between 

the WebPlayer and StandAlone Executables) 

   

  

Icon 

 

Different icons that your project will have when built. 

  

Override for Standalone Check if you want to assign a custom icon you would like to be used for your standalone game. Different sizes 

of the icon should fill in the squares below. 

   

  

SplashImage 

 

Splash image that is going to be displayed when your project is loading all the resources when you execute it. 

  

Config Dialog Banner Add your custom splash image that will be displayed when the game is starting. 

   

  

Other Settings 



 

Other general settings for stand alone builds. 

Rendering 

Rendering Path This property is shared between Standalone and WebPlayer content. 

Vertex Lit Lowest lighting fidelity, no shadows support. Best used on old machines or limited mobile platforms. 

Forward with 

Shaders 

Good support for lighting features; limited support for shadows. 

Deferred Lighting Best support for lighting and shadowing features, but requires certain level of hardware support. Best used if you have 

many realtime lights. Unity Pro only. 

Static Batching Set this to use Static batching on your build (Inactive by default in webplayers). Unity Pro only. 

Dynamic Batching Set this to use Dynamic Batching on your build (Activated by default). 

API Compatibility Level 

.Net 2.0 .Net 2.0 libraries. Maximum .net compatibility, biggest file sizes 

.Net 2.0 Subset Subset of full .net compatibility, smaller file sizes 

 

iOS 
 

Resolution And Presentation 

 

''Orientation and presentation for iOS builds.'. 

  
Resolution 

Default Orientation (This setting is shared between iOS and Android devices) 

Portrait The device is in portrait mode, with the device held upright and the home button at the bottom. 

Portrait Upside Down 

(iOS Only) 

The device is in portrait mode but upside down, with the device held upright and the home button at the top. 

Landscape Right (iOS 

Only) 

The device is in landscape mode, with the device held upright and the home button on the left side. 

javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
javascript:ShowHideDiv('iosRef','specific-ios', 'iOS');


Landscape Left The device is in landscape mode, with the device held upright and the home button on the right side. 

Auto Rotation The screen orientation is automatically set based on the physical device orientation. 

Auto Rotation settings 

Use Animated 

Autorotation 

When checked, orientation change is animated. This only applies when Default orientation is set to Auto 

Rotation. 

Allowed Orientations for Auto Rotation 

Portrait When checked, portrait orientation is allowed. This only applies when Default orientation is set to Auto Rotation. 

Portrait Upside Down When checked, portrait upside down orientation is allowed. This only applies when Default orientation is set to 

Auto Rotation. 

Landscape Right When checked, landscape right (home button on the left side) orientation is allowed. This only applies when 

Default orientation is set to Auto Rotation. 

Landscape Left When checked, landscape left (home button is on the right side) orientation is allowed. This only applies when 

Default orientation is set to Auto Rotation. 

Status Bar 

Status Bar Hidden Specifies whether the status bar is initially hidden when the application launches. 

Status Bar Style Specifies the style of the status bar as the application launches 

Default 

Black Translucent 

Black Opaque 

Use 32-bit Display Buffer Specifies if Display Buffer should be created to hold 32-bit color values (16-bit by default). Use it only if you see 

banding, as it has performance implications. 

   

  

Icon 

 

Different icons that your project will have when built. 

  

Override for iOS Check if you want to assign a custom icon you would like to be used for your iPhone/iPad game. Different sizes 

of the icon should fill in the squares below. 

Prerendered icon If unchecked iOS applies sheen and bevel effects to the application icon. 

   

  

SplashImage 



 

Splash image that is going to be displayed when your project is launched. 

  

Mobile Splash Screen 

(Pro-only feature) 

Specifies texture which should be used for iOS Splash Screen. Standard Splash Screen size is 320x480.(This 

is shared between Android and iOS) 

High Res. iPhone (Pro-

only feature) 

Specifies texture which should be used for iOS 4th gen device Splash Screen. Splash Screen size is 640x960. 

iPad Portrait (Pro-only 

feature) 

Specifies texture which should be used as iPad Portrait orientation Splash Screen. Standard Splash Screen 

size is 768x1024. 

iPad Landscape (Pro-only 

feature) 

Specifies texture which should be used as iPad Landscape orientation Splash Screen. Standard Splash Screen 

size is 1024x768. 

   

  

Other Settings 



 

Other general settings for iPhone/iPad builds. 

Rendering 

Static Batching Set this to use Static batching on your build (Activated by default). Pro-only feature. 

Dynamic Batching Set this to use Dynamic Batching on your build (Activated by default). 

Identification 

Bundle Identifier The string used in your provisioning certificate from your Apple Developer Network account(This is shared 

between iOS and Android) 

Bundle Version Specifies the build version number of the bundle, which identifies an iteration (released or unreleased) of 

the bundle. This is a monotonically increased string, comprised of one or more period-separated 

Configuration 
 

Target Device Specifies application target device type. 

iPhone Only Application is targeted for iPhone devices only. 

iPad Only Application is targeted for iPad devices only. 

iPhone + iPad Application is targeted for both iPad and iPhone devices. 

Target Platform Specifies the target arquitecture you are going to build for.(This setting is shared between iOS and 

Android Platforms) 

armv6 (OpenGL ES1.1) Application is optimized for armv6 chipsets 

Universal armv6+armv7 

(OpenGL ES1.1+2.0) 

Application supports both armv6 and armv7 chipsets. Note: increases application distribution size 

armv7 Application is optimized for armv7 chipsets. 1st-2nd gen. devices are not supported. There might be 

additional requirements for this build target imposed by Apple App Store. Defaults to OpenGL ES 2.0. 

Target Resolution Resolution you want to use on your deployed device.(This setting will not have any effect on devices with 



maximum resolution of 480x320) 

Native(Default Device 

Resolution) 

Will use the device native resolution. 

Standard(Medium or Low 

Resolution) 

Use the lowest resolution possible (480x320). 

HD(Highest available 

resolution) 

Use the maximum resolution allowed on the device (960x640). 

Override iPod Music If selected application will silence user's iPod music. Otherwise user's iPod music will continue playing in 

the background. 

UI Requires Persistent WiFi Specifies whether the application requires a Wi-Fi connection. iOS maintains the active Wi-Fi connection 

open while the application is running. 

Exit on Suspend Specifies whether the application should quit when suspended to background on iOS versions that 

support multitasking. 

Optimization 

Api Compatibility Level Specifies active .NET API profile 

.Net 2.0 .Net 2.0 libraries. Maximum .net compatibility, biggest file sizes 

.Net 2.0 Subset Subset of full .net compatibility, smaller file sizes 

AOT compilation options Additional AOT compiler options. 

SDK Version Specifies iPhone OS SDK version to use for building in Xcode 

iOS 4.0 iOS SDK 4.0. 

iOS Simulator 4.0 iOS Simulator 4.0. Application built for this version of SDK will be able to run only on Simulator from the 

SDK 4. 

iOS 4.1 iOS 4.1. 

iOS Simulator 4.1 iOS Simulator 4.1. Application built for this version of SDK will be able to run only on Simulator from the 

SDK 4.x. 

iOS 4.2 iOS 4.2. 

iOS Simulator 4.2 iOS Simulator 4.2. Application built for this version of SDK will be able to run only on Simulator from the 

SDK 4.x. 

iOS 4.3 iOS 4.3. 

iOS Simulator 4.3 iOS Simulator 4.3. Application built for this version of SDK will be able to run only on Simulator from the 

SDK 4.x. 

iOS latest Latest available iOS SDK. Available since iOS SDK 4.2. (default value) 

iOS Simulator latest Latest available iOS Simulator SDK. Available since iOS SDK 4.2. 

Unknown iOS SDK version is not managed by Unity Editor. 

Target iOS Version Specifies lowest iOS version where final application will able to run 

3.0 iPhone OS 3.0. (default value) 

3.1 iPhone OS 3.1. 

3.1.2 iPhone OS 3.1.2. 

3.1.3 iPhone OS 3.1.3. 

3.2 iPhone OS 3.2. 

4.0 iPhone OS 4.0. 

4.1 iPhone OS 4.1. 

4.2 iPhone OS 4.2. 

4.3 iPhone OS 4.3. 

Unknown iPhone OS SDK version is not managed by Unity Editor. 

Stripping Level (Pro-only 

feature) 

Options to strip out scripting features to reduce built player size(This setting is shared between iOS and 

Android Platforms) 

Disabled No reduction is done. 

Strip Assemblies Level 1 size reduction. 

Strip ByteCode Level 2 size reduction (includes reductions from Level 1). 

Use micro mscorlib Level 3 size reduction (includes reductions from Levels 1 and 2). 

Script Call Optimization Optionally disable exception handling for a speed boost at runtime 

Slow and Safe Full exception handling will occur with some performance impact on the device 

Fast but no Exceptions No data provided for exceptions on the device, but the game will run faster 

Note: If you build for example for iPhone OS 3.2, and then select Simulator 3.2 in Xcode you will get a ton of errors. So you MUST be sure 

to select a proper Target SDK in Unity Editor.  



 

Android 
 

Resolution And Presentation 

 

Resolution and presentation for your Android project builds. 

  
Resolution 

Default Orientation (This setting is shared between iOS and Android devices) 

Portrait The device is in portrait mode, with the device held upright and the home button at the bottom. 

Portrait Upside Down The device is in portrait mode but upside down, with the device held upright and the home button at the top. 

Landscape Right The device is in landscape mode, with the device held upright and the home button on the left side. 

Landscape Left The device is in landscape mode, with the device held upright and the home button on the right side. 

   

  

Icon 

 

Different icons that your project will have when built. 

  

Override for Android Check if you want to assign a custom icon you would like to be used for your Android game. Different sizes of 

the icon should fill in the squares below. 

   

  

SplashImage 
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Splash image that is going to be displayed when your project is launched. 

  

Mobile Splash Screen 

(Pro-only feature) 

Specifies texture which should be used by the iOS Splash Screen. Standard Splash Screen size is 

320x480.(This is shared between Android and iOS) 

Splash Scaling Specifies how will be the splash image scaling on the device. 

   

  

Other Settings 

 

Other general settings for Android builds. 

Rendering 

Static Batching Set this to use Static batching on your build (Activated by default). Pro-only feature. 

Dynamic Batching Set this to use Dynamic Batching on your build (Activated by default). 

Identification 



Bundle Identifier The string used in your provisioning certificate from your Apple Developer Network account(This is shared between 

iOS and Android) 

Bundle Version Specifies the build version number of the bundle, which identifies an iteration (released or unreleased) of the bundle. 

This is a monotonically increased string, comprised of one or more period-separated(This is shared between iOS and 

Android) 

Bundle Version 

Code 

An internal version number. This number is used only to determine whether one version is more recent than another, 

with higher numbers indicating more recent versions. This is not the version number shown to users; that number is set 

by the versionName attribute. The value must be set as an integer, such as "100". You can define it however you want, 

as long as each successive version has a higher number. For example, it could be a build number. Or you could 

translate a version number in "x.y" format to an integer by encoding the "x" and "y" separately in the lower and upper 

16 bits. Or you could simply increase the number by one each time a new version is released. 

Configuration 
 

Device Filter Specifies the target architecture you are going to build for. 

ARMv7 only Application optimized for ARMv7 CPU architecture. It will also enable correct Android Market device filtering, thus 

recommended for publishing to the Android Market (only devices supporting Unity Android will list the application on 

the Android Market). 

ARMv6 with VPF Application optimized for ARMv6 CPU architecture (requires VFP support). Use runtime detection of hardware 

capabilities rather than relying on the Android Market filtering mechanism. It means the application when published to 

the Android Market will be visible also to devices not supporting Unity Android. Obviously this is not recommended, 

especially for paid applications (though can be combined with other means of filtering instead, like OpenGLES 

version). 

Emulator Will create a combined build with support for the Android SDK Emulator. 

Graphics Level Select either ES 1.1 ('fixed function') or ES 2.0 ('shader based') Open GL level 

Force Internet 

Permission 

Will enable networking permissions even if your scripts are not using this. Automatically enabled for development 

builds. 

Force SD-Card 

Permission 

Will enable write access to external storage such as the SD-Card. Automatically enabled for development builds. 

Use NativeActivity Only enable this you intend to support devices with off-screen touch input capabilities, like Xperia Play. 

Optimization 

Api Compatibility 

Level 

Specifies active .NET API profile 

.Net 2.0 .Net 2.0 libraries. Maximum .net compatibility, biggest file sizes 

.Net 2.0 Subset Subset of full .net compatibility, smaller file sizes 

Stripping Level 

(Pro-only feature) 

Options to strip out scripting features to reduce built player size(This setting is shared between iOS and Android 

Platforms) 

Disabled No reduction is done. 

Strip Assemblies Level 1 size reduction. 

Strip ByteCode 

(iOS only) 

Level 2 size reduction (includes reductions from Level 1). 

Use micro 

mscorlib 

Level 3 size reduction (includes reductions from Levels 1 and 2). 

Enable "logcat" 

profiler 

Enable this if you want to get feedback from your device while testing your projects. So adb logcat prints logs from the 

device to the console (only available in development builds). 

Publishing Settings 



 

Publishing settings for Android Market 

  
Keystore 

Use Existing Keystore / 

Create new Keystore 

Use this if you are creating a new Keystore or using one you have already. 

Browse Keystore Lets you select a generated Keystore. 

Key 

Alias Key alias 

Password Password for key alias 

Android Market Licensing (LVL) 

Public Key Here goes the public key provided by the Android developer site. 

Details 
 

Desktop  
 

The Player Settings window is where many technical preference defaults are set. See also Quality Settings where the different graphics 

quality levels can be set up.  

Publishing a web player 

Default Web Screen Width and Default Web Screen Height determine the size used in the html file. You can modify the size in the html 

file later.  

Default Screen Width and Default Screen Height are used by the Web Player when entering fullscreen mode through the context menu 

in the Web Player at runtime.  

Customizing your Resolution Dialog 

http://developer.android.com/guide/publishing/licensing.html#account
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The Resolution Dialog, presented to end-users 

You have the option of adding a custom banner image to the Screen Resolution Dialog in the Standalone Player. The maximum image size 

is 432 x 163 pixels. The image will not be scaled up to fit the screen selector. Instead it will be centered and cropped.  

Publishing to Mac App Store 

Use Player Log enables writing a log file with debugging information. This is useful to find out what happened if there are problems with 

your game. When publishing games for Apple's Mac App Store, it is recommended to turn this off, because Apple may reject your 

submission otherwise.  

Use Mac App Store Validation enables receipt validation for the Mac App Store. If this is enabled, your game will only run when it 

contains a valid receipt from the Mac App Store. Use this when submitting games to Apple for publishing on the App Store. This prevents 

people from running the game on any computer then the one it was purchased on. Note that this feature does not implement any strong 

copy protection. In particular, any potential crack against one Unity game would work against any other Unity content. For this reason, it is 

recommended that you implement your own receipt validation code on top of this using Unity's plugin feature. However, since Apple 

requires plugin validation to initially happen before showing the screen setup dialog, you should still enable this check, or Apple might reject 

your submission.  



 

iOS 
 

Bundle Identifier 

The Bundle Identifier string must match the provisioning profile of the game you are building. The basic structure of the identifier is 

com.CompanyName.GameName. This structure may vary internationally based on where you live, so always default to the string provided 

to you by Apple for your Developer Account. Your GameName is set up in your provisioning certificates, that are manageable from the 

Apple iPhone Developer Center website. Please refer to the Apple iPhone Developer Center website for more information on how this is 

performed.  

Stripping Level (Pro-only) 

Most games don't use all necessary dlls. With this option, you can strip out unused parts to reduce the size of the built player on iOS 

devices. If your game is using classes that would normally be stripped out by the option you currently have selected, you'll be presented 

with a Debug message when you make a build.  

Script Call Optimization 

A good development practice on iOS is to never rely on exception handling (either internally or through the use of try/catch blocks). When 

using the default Slow and Safe option, any exceptions that occur on the device will be caught and a stack trace will be provided. When 

using the Fast but no Exceptions option, any exceptions that occur will crash the game, and no stack trace will be provided. However, the 

game will run faster since the processor is not diverting power to handle exceptions. When releasing your game to the world, it's best to 

publish with the Fast but no Exceptions option.  

 

Android 
 

Bundle Identifier 

The Bundle Identifier string is the unique name of your application when published to the Android Market and installed on the device. The 

basic structure of the identifier is com.CompanyName.GameName, and can be chosen arbitrarily. In Unity this field is shared with the iOS 

Player Settings for convenience.  

Stripping Level (Pro-only) 

Most games don't use all the functionality of the provided dlls. With this option, you can strip out unused parts to reduce the size of the built 

player on Android devices.  

Page last updated: 2011-07-04 

 

 

class-QualitySettings 
You can tune Quality Settings by choosing Edit->Project Settings->Quality.  
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The Quality Settings 

Properties 

  
Default Standalone 

Quality 

Default quality setting used for standalone players. 

Default Web Player 

Quality 

Default quality setting used for web players. 

Editor Quality The current quality setting used in the editor for previewing. 

Fastest, Fast, Simple, ... The quality setting details for different global quality settings. 

Pixel Light 

Count 

The maximum number of per-pixel lights used in Forward rendering path. 

Shadows Which type of Shadows is allowed. 

Shadow 

Resolution 

Global shadow detail level. This is used by default on all Lights that do not specify per-light shadow resolution. 

Shadow 

Cascades 

Number of "shadow cascades" for directional light shadows. Higher cascade count results in better looking, but slower 

shadows. See directional shadow details page. 

Shadow 

Distance 

Distance in world units where shadows are visible. Beyond this distance from the camera, shadows are not drawn. See 

Shadows page for details. 

Blend 

Weights 

The number of blend weights Unity will use on a skinned mesh. 2 Bones is usually a very good tradeoff between speed and 

quality. 

Texture 

Quality 

Should Unity decrease the resolution of all textures. 

Anisotropic 

Textures 

Anisotropic filtering increases texture quality when viewing the texture at a steep angle, but incurs a performance cost. You 

can modify Anisotropic filter level per texture, see Texture2D. 

Soft 

Vegetation 

A Unity Terrain optimization feature. When enabled, all vegetation's edges will be properly alpha blended. When disabled, 

grass and trees are drawn in one pass using alpha testing, but no alpha blending, so vegetation is either fully opaque or 

fully transparent. This is less realistic, but faster to render on older hardware. Custom shaders can also hook up to this 

option, by using RequireOptions tag. 

Anti Aliasing Should anti-aliasing be used. This removes blocky edges but incurs a performance cost, see below. 

VBlank Sync 

Count 

Synchronize to screen refresh rate. This will slow down the game but avoid any tearing artifacts. 

http://unity3d.com/support/documentation/Components/RenderTech-ForwardRendering.html
http://unity3d.com/support/documentation/Manual/Shadows.html
http://unity3d.com/support/documentation/Components/class-Light.html
http://unity3d.com/support/documentation/Manual/DirectionalShadowDetails.html
http://unity3d.com/support/documentation/Manual/Shadows.html
http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/Components/SL-PassTags.html
http://unity3d.com/support/documentation/printable.html#fsaa


You can adjust each of the 6 quality settings individually to fit your game. The end-user can then choose the Quality Setting in the Screen 

Selector of the standalone player. You can also access and modify it from scripting.  

The Quality Settings are by default initialized to some good values that work across a wide range of games.  

Anti-aliasing 

Anti aliasing improves the appearance of polygon edges, so they are not "jagged", but smoothed out on the screen. However, it incurs a 

performance cost for the graphics card and uses more video memory (there's no cost on the CPU though). The level of anti-aliasing 

determines how smooth polygon edges are (and how much video memory does it consume).  

 

Without anti-aliasing, polygon edges are "jagged". 

http://unity3d.com/support/documentation/ScriptReference/QualitySettings.html


 

With 6x anti-aliasing, polygon edges are smoothed out. 
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class-RenderSettings 
The Render Settings contain default values for a range of visual elements in your scene, like Lights and Skyboxes.  

To see the Render Settings choose Edit->Render Settings from the menu bar.  

 

The Render Settings 

Properties 

  

Fog If enabled, fog will be drawn throughout your scene. 

Fog Color Color of the fog. 

Fog Mode Fog mode: Linear, Exponential (Exp) or Exponential Squared (Exp2). This controls the way fog fades in with 



distance. 

Fog Density Density of the fog; only used by Exp and Exp2 fog modes. 

Linear Fog Start/End Start and End distances of the fog; only used by Linear fog mode. 

Ambient Light Color of the scene's ambient light. 

Skybox Material Default skybox that will be rendered for cameras that have no skybox attached. 

Halo Strength Size of all light halos in relation to their Range. 

Flare Strength Intensity of all flares in the scene. 

Halo Texture Reference to a Texture that will appear as the glow for all Halos in lights. 

Spot Cookie Reference to a Texture2D that will appear as the cookie mask for all Spot lights. 

Details 

The Render Settings is used to define some basic visual commonalities of any individual scene in your project. Maybe you have two levels 

in the same environment: one at daytime and one at nighttime. You can use the same meshes and Prefabs to populate the scene, but you 

can change the Ambient Light to be much brighter at daytime, and much darker at night.  

Fog 

Enabling Fog will give a misty haze to your scene. You can adjust the look and color of the Fog with Fog Density and Fog Color, 

respectively.  

Adding fog is often used to optimize performance by making sure that far away objects fade out and are not drawn. Please note that 

enabling fog is not enough to enable this performance optimization. To do that you also need to adjust your Camera's Far Clip Plane, so 

that geometry far away will not be drawn. It is best to tweak the fog to look correct first. Then make the Camera's far clip plane smaller until 

you see the geometry being clipped away before the fog fades it out.  

 

A scene with Fog turned off 

http://unity3d.com/support/documentation/Components/class-Texture2D.html
http://unity3d.com/support/documentation/Components/class-Camera.html
http://unity3d.com/support/documentation/Components/class-Camera.html


 

The same scene with Fog turned on 

Note that fog is rendered uniformly in orthographic camera mode. This is because in our shaders, we output post-perspective space Z 

coordinate as the fog coordinate. But post-perspective Z is not really suitable for fog in orthographic cameras. Why do we do this? Because 

it's fast and does not need any extra computations; handling orthographic cameras would make all shaders be a bit slower.  

Hints 

 Don't under-estimate the visual impact your game can make by thoughtfully tweaking the Render Settings!  

 Render Settings are per-scene: each scene in your game can have different Render Settings.  
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class-TagManager 
The Tag Manager allows you to set up Layers and Tags. To see it choose Edit->Project Settings->Tags.  



 

The Tag Manager 

Properties 

  

Tags You can add new elements by typing in the last element. 

User Layer 8-31 You can add custom named User Layers 

Details 

Layers can be used to cast rays, render, or apply lighting to certain groups of objects only. You can choose the Layer in the GameObject 

inspector. More information about how to use Layers can be found here, while Tags are covered here.  

Tags are used to quickly find objects from scripts, utilizing the Tag name. When a new tag is added, you can choose it from the 

GameObject tag popup.  
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class-TimeManager 

http://unity3d.com/support/documentation/Components/class-GameObject.html
http://unity3d.com/support/documentation/Components/class-GameObject.html
http://unity3d.com/support/documentation/Components/Layers.html
http://unity3d.com/support/documentation/Components/Tags.html
http://unity3d.com/support/documentation/Components/class-GameObject.html


 

The Time Manager 

Properties 

  
Fixed Timestep A framerate-independent interval that dictates when physics calculations and FixedUpdate() events are 

performed. 

Maximum Allowed 

Timestep 

A framerate-independent interval that caps the worst case scenario when frame-rate is low. Physics 

calculations and FixedUpdate() events will not be performed for longer time than specified. 

Time Scale The speed at which time progress. Change this value to simulate bullet-time effects. A value of 1 means real-

time. A value of .5 means half speed; a value of 2 is double speed. 

Details 

Fixed Timestep 

Fixed time stepping is very important for stable physics simulation. Not all computers are made equal, and different hardware configurations 

will run Unity games with varying performance. Therefore, physics must be calculated independently of the game's frame rate. Physics 

calculations like collision detection and Rigidbody movement are performed in discrete fixed time steps that are not dependent on frame 

rate. This makes the simulation more consistent across different computers or when changes in the frame rate occur. For example, the 

frame rate can drop due to an appearance of many game onscreen, or because the user launched another application in the background.  

Here's how the fixed time step is calculated. Before every frame is drawn onscreen, Unity advances the fixed time by fixed delta time and 

performs physics calculations until it reaches the current time. This directly correlates to the Fixed Timestep property. The smaller the 

value of Fixed Timestep, the more frequently physics will be calculated. The number of Fixed frames per second can be calculated by 

dividing 1 by Fixed Timestep. Therefore, 1 / 0.02 = 50 fixed frames per second and 1 / 0.05 = 20 fixed frames per second.  

Simply put, a smaller fixed update value leads to more accurate physics simulation but is heavier on the CPU.  

Maximum Allowed Timestep 

Fixed time stepping ensures stable physics simulation. However it can cause negative impact on performance if game is heavy on physics 

and is already running slow or occasionally dips to low frame rate. Longer the frame takes to process - more fixed update steps will have to 

be executed for the next frame. This results in performance degradation. To prevent such scenario Unity iOS introduced Maximum 

Allowed Timestep which ensures that physics calculations will not run longer than specified threshold.  

If frame takes longer to process than time specified in Maximum Allowed Timestep, then physics will "pretend" that frame took only 

Maximum Allowed Timestep seconds. In other words if frame rate drops below some threshold, then rigid bodies will slow down a bit 

allowing CPU to catch up.  

Maximum Allowed Timestep affects both physics calculation and FixedUpdate() events.  

Maximum Allowed Timestep is specified in seconds as Fixed Timestep. Therefore setting 0.1 will make physics and FixedUpdate() 

events to slow down, if frame rate dips below 1 / 0.1 = 10 frames per second.  

Typical scenario 

1. Let's assume Fixed Timestep is 0.01, which means that physx, fixedUpdate and animations should be processed every 10 ms.  

2. When your frame time is ~33 ms then fixed loop is executed 3 times per visual frame on average.  

3. But frametime isn't fixed constant and depends on many factors including your scene state, OS background taks, etc.  

4. Because of 3. reasons frametime sometimes can reach 40-50 ms, which means that fixed step loop will be executed 4-5 times.  

5. When your fixed timestep tasks are pretty heavy then time spent on physx, fixedUpdates and animations extend your frametime 

by another 10 ms, which means one more additional iteration of all these fixed timestep tasks.  

6. In some unlucky cases process described in 5. could extend to 10 and more times of processing fixed step loop.  



7. That's why Maximum Allowed Timestep was introduced, it is the method to limit how much times physx, fixedUpdates and 

animations can be processed during single visual frame. If you have Maximum Allowed Timestep set to 100 ms and your Fixed 

Timestep is 10 ms, then for fixed step tasks will be executed up to 10 times per visual frame. So sometimes small performance 

hitch could trigger big performance hitch because of increased fixed timestep iteration count. By decreasing Maximum Allowed 

Timestep to 30 ms, you are limiting max fixed step iteration count to 3 and this means that your physx, fixedUpdate and animation 

won't blow your frametime up very much, but there is some negative effect of this limiting. Your animations and physics will slow 

down a bit when performance hitch occurs.  

Hints 

 Give the player control over time by changing Time Scale dynamically through scripting.  

 If your game is physics heavy or spends significant amount of time in FixedUpdate() events, then set Maximum Allowed Timestep to 0.1. 

This will prevent physics from driving your game below 10 frames per second.  
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comp-MeshGroup 
3D Meshes are the main graphics primitive of Unity. Various components exist in Unity to render regular or skinned meshes, trails or 3D 

lines.  

 Mesh Filter  

 Mesh Renderer  

 Skinned Mesh Renderer  

 Text Mesh  
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class-MeshFilter 
The Mesh Filter takes a mesh from your assets and passes it to the Mesh Renderer for rendering on the screen.  

http://unity3d.com/support/documentation/Components/class-MeshFilter.html
http://unity3d.com/support/documentation/Components/class-MeshRenderer.html
http://unity3d.com/support/documentation/Components/class-SkinnedMeshRenderer.html
http://unity3d.com/support/documentation/Components/class-TextMesh.html
http://unity3d.com/support/documentation/Components/class-MeshRenderer.html


 

A Mesh Filter combined with a Mesh Renderer makes the model appear on screen.  

Properties 

  

Mesh Reference to a mesh that will be rendered. The Mesh is located in your Project Folder. 

Details 

When importing mesh assets, Unity automatically creates a Skinned Mesh Renderer if the mesh is skinned, or a Mesh Filter along with a 

Mesh Renderer, if it is not.  

To see the Mesh in your scene, add a Mesh Renderer to the GameObject. It should be added automatically, but you will have to manually 

re-add it if you remove it from your object. If the Mesh Renderer is not present, the Mesh will still exist in your scene (and computer 

memory) but it will not be drawn.  
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class-MeshRenderer 
The Mesh Renderer takes the geometry from the Mesh Filter and renders it at the position defined by the object's Transform component.  

http://unity3d.com/support/documentation/Components/class-Mesh.html
http://unity3d.com/support/documentation/Components/class-SkinnedMeshRenderer.html
http://unity3d.com/support/documentation/Components/class-MeshRenderer.html
http://unity3d.com/support/documentation/Components/class-MeshFilter.html
http://unity3d.com/support/documentation/Components/class-Transform.html


 

A Mesh Renderer together with Mesh Filter makes the model appear on screen. 

Properties 

  

Cast Shadows (Pro only) If enabled, this Mesh will create shadows when a shadow-creating Light shines on it 

Receive Shadows (Pro 

only) 

If enabled, this Mesh will display any shadows being cast upon it 

Materials A list of Materials to render model with. 

Details 

Meshes imported from 3D packages can use multiple Materials. For each Material there is an entry in Mesh Renderer's Materials list.  
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class-SkinnedMeshRenderer 
The Skinned Mesh Renderer is automatically added to imported meshes when the imported mesh is skinned.  

http://unity3d.com/support/documentation/Components/class-Light.html
http://unity3d.com/support/documentation/Manual/Materials.html


 

An animated character rendered using the Skinned Mesh Renderer 

Properties 

  
Cast Shadows (Pro only) If enabled, this Mesh will create shadows when a shadow-creating Light shines on it 

Receive Shadows (Pro 

only) 

If enabled, this Mesh will display any shadows being cast upon it 

Materials A list of Materials to render model with. 

Update When Offscreen If enabled, the Skinned Mesh will be updated when offscreen. If disabled, this also disables updating 

animations. 

Quality The maximum amount of bones affecting every vertex. 

Skin Normals If enabled, geometry normals will be updated with the bone animation. 

Animation The current animation (which can be changed via scripting). 

Details 

Skinned Meshes are used for rendering characters. Characters are animated using bones, and every bone affects a part of the mesh. 

Multiple bones can affect the same vertex and are weighted. The main advantage to using boned characters in Unity is you can enable the 

bones to be affected by physics, making your characters into ragdolls. You can enable/disable bones via scripting, so your character 

instantly goes ragdoll when it is hit by an explosion.  

http://unity3d.com/support/documentation/Components/class-Light.html


 

A Skinned Mesh enabled as a Ragdoll 

Skin Normals 

When Skin Normals is enabled, normals will be correctly animated with the bones. This makes your character correctly react to lights. If it is 

disabled the normals from the character in bind pose will be used.  

Skinning Normals comes at a slight performance cost. In some situations correct lighting is not necessary and you can get away with 

disabling this option. Play with it and see if it makes difference in your particular situation. If you can't see a difference, disable Skin 

Normals.  

Quality 

Unity can skin every vertex with either 1, 2, or 4 bones. 4 bone weights look nicest and are most expensive. 2 Bone weights is a good 

compromise and can be commonly used in games.  

If Quality is set to Automatic, the Quality Settings Blend Weights value will be used. This allows end-users to choose a quality setting 

that gives them optimum performance.  

Update When Offscreen 

By default, skinned meshes that are not visible are not updated. The skinning is not updated until the mesh comes back on screen. This is 

an important performance optimization - it allows you to have a lot of characters running around not taking up any processing power when 

they are not visible.  

However, visibility is determined from the Mesh's bounding volume, which is calculated from skinning. Sometimes, the bounding volume will 

change a lot based on the animation. In those few cases you need to enable Update When Offscreen to prevent object from suddenly 

appearing on screen.  

For characters you should always check this option off in order to gain performance. This optimization will calculate a bounding volume 

relative to the transform on the first frame and then only move the bounding volume along with the transform but never update it based on 

the bones of the character.  

http://unity3d.com/support/documentation/Components/class-QualitySettings.html


There are some cases where you might want to turn off this optimization  

1. A large character that changes shape. Eg. a moving crane, where the bounding volume can change a lot.  

2. When the SkinnedMeshRenderer is not a child of the root bone. Eg. if you have a ragdoll and your skinned mesh renderer is not 

assigned to the root bone.  

In order to make SkinnedMeshes work better with Ragdolls Unity will automatically remap the SkinnedMeshRenderer to the rootbone on 

import. However Unity only does this if there is a single SkinnedMeshRenderer in the model file. So if you can't attach all 

SkinnedMeshRenderers to the root bone or a child and you use ragdolls, you should turn off this optimization.  

Hints 

 Skinned Meshes currently can be imported from:  

o Maya  

o Cinema4D  

o 3D Studio Max  

o Blender  

o Cheetah 3D  

o XSI  

o Any other tool that supports the FBX format  
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class-TextMesh 
The Text Mesh generates 3D geometry that displays text strings.  

 

The Text Mesh Inspector 

You can create a new Text Mesh from GameObject->Create Other->3D Text.  

Properties 

  

Text The text that will be rendered 

Offset Z How far should the text be offset from the transform.position.z when drawing 

Character Size The size of each character (This scales the whole text) 

Line Spacing How much space will be in-between lines of text. 



Anchor Which point of the text shares the position of the Transform. 

Alignment How lines of text are aligned (Left, Right, Center). 

Tab Size How much space will be inserted for a tab '\t' character. This is a multiplum of the 'spacebar' character offset. 

Font The TrueType Font to use when rendering the text. 

Details 

Text Meshes can be used for rendering road signs, graffiti etc. The Text Mesh places text in the 3D scene. To make generic 2D text for 

GUIs, use a GUI Text component instead.  

Follow these steps to create a Text Mesh with a custom Font:  

1. Import a font by dragging a TrueType Font - a .ttf file - from the Explorer (Windows) or Finder (OS X) into the Project View.  

2. Select the imported font in the Project View.  

3. Choose GameObject->Create Other->3D Text.  

You have now created a text mesh with your custom TrueType Font. You can scale the text and move it around using the Scene View's 

Transform controls.  

Note: you need to change both the Font and the material of the GUIText component so you can see the right font, if you dont do it, your 

text mesh is going to look weird.  

Hints 

 When entering text into the Text property, you can create a line break by holding Alt and pressing Return.  

 You can download free TrueType Fonts from 1001freefonts.com (download the Windows fonts since they contain TrueType Fonts).  

 If you are scripting the Text property, you can add line breaks by inserting the escape character "\n" in your strings.  
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comp-NetworkGroup 
This group contains all the Components that relate to Networked Multiplayer games.  

 Network View  
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class-NetworkView 
Network Views are the gateway to creating networked multiplayer games in Unity. They are simple to use, but they are extremely 

powerful. For this reason, it is recommended that you understand the fundamental concepts behind networking before you start 

experimenting with Network Views. You can learn and discover the fundamental concepts in the Network Reference Guide.  

http://unity3d.com/support/documentation/Components/class-Font.html
http://unity3d.com/support/documentation/Components/class-GuiText.html
http://www.1001freefonts.com/fonts/afonts.htm
http://unity3d.com/support/documentation/Components/class-NetworkView.html
http://unity3d.com/support/documentation/Components/Network%20Reference%20Guide.html


 

The Network View Inspector 

In order to use any networking capabilities, including State Synchronization or Remote Procedure Calls, your GameObject must have a 

Network View attached.  

Properties 

  
State Synchronization The type of State Synchronization used by this Network View 

Off No State Synchronization will be used. This is the best option if you only want to send RPCs 

Reliable Delta 

Compressed 

The difference between the last state and the current state will be sent, if nothing has changed nothing will be 

sent. This mode is ordered. In the case of packet loss, the lost packet is re-sent automatically 

Unreliable The complete state will be sent. This uses more bandwidth, but the impact of packet loss is minimized 

Observed The Component data that will be sent across the network 

View ID The unique identifier for this Network View. These values are read-only in the Inspector 

Scene ID The number id of the Network View in this particular scene 

Type Either saved to the Scene or Allocated at runtime 

Details 

When you add a Network View to a GameObject, you must decide two things  

1. What kind of data you want the Network View to send  

2. How you want to send that data  

Choosing data to send 

The Observed property of the Network View can contain a single Component. This can be a Transform, an Animation, a RigidBody, or a 

script. Whatever the Observed Component is, data about it will be sent across the network. You can select a Component from the drop-

down, or you can drag any Component header directly to the variable. If you are not directly sending data, just using RPC calls, then you 

can turn off synchronization (no data directly sent) and nothing needs to be set as the Observed property. RPC calls just need a single 

network view present so you don't need to add a view specifically for RPC if a view is already present.  

How to send the data 

You have 2 options to send the data of the Observed Component: State Synchronization and Remote Procedure Calls.  

To use State Synchronization, set State Synchronization of the Network View to Reliable Delta Compressed or Unreliable. The data of 

the Observed Component will now be sent across the network automatically.  

Reliable Delta Compressed is ordered. Packets are always received in the order they were sent. If a packet is dropped, that packet will be 

re-sent. All later packets are queued up until the earlier packet is received. Only the difference between the last transmissions values and 

the current values are sent and nothing is sent if there is no difference.  

If it is observing a Script, you must explicitly Serialize data within the script. You do this within the OnSerializeNetworkView() function.  

http://unity3d.com/support/documentation/Components/net-StateSynchronization.html
http://unity3d.com/support/documentation/Components/net-RPCDetails.html


function OnSerializeNetworkView (stream : BitStream, info : NetworkMessageInfo) { 

 var horizontalInput : float = Input.GetAxis ("Horizontal"); 

 stream.Serialize (horizontalInput); 

} 

The above function always writes (an update from the stream) into horizontalInput, when receiving an update and reads from the variable 

writing into the stream otherwise. If you want to do different things when receiving updates or sending you can use the isWriting attribute of 

the BitStream class.  

function OnSerializeNetworkView (stream : BitStream, info : NetworkMessageInfo) { 

 var horizontalInput : float = 0.0; 

 if (stream.isWriting) { 

  // Sending 

  horizontalInput = Input.GetAxis ("Horizontal"); 

  stream.Serialize (horizontalInput); 

 } else { 

 

  // Receiving 

  stream.Serialize (horizontalInput); 

  // ... do something meaningful with the received variable 

 } 

} 

OnSerializeNetworkView is called according to the sendRate specified in the network manager project settings. By default this is 15 times 

per second.  

If you want to use Remote Procedure Calls in your script all you need is a NetworkView component present in the same GameObject the 

script is attached to. The NetworkView can be used for something else, or in case it's only used for sending RPCs it can have no script 

observed and state synchronization turned off. The function which is to be callable from the network must have the @RPC attribute. Now, 

from any script attached to the same GameObject, you call networkView.RPC() to execute the Remote Procedure Call.  

var playerBullet : GameObject; 

http://unity3d.com/support/documentation/ScriptReference/NetworkView.RPC.html


 

function Update () { 

 if (Input.GetButtonDown ("Fire1")) { 

  networkView.RPC ("PlayerFire", RPCMode.All); 

 } 

} 

 

@RPC 

function PlayerFire () { 

 Instantiate (playerBullet, playerBullet.transform.position, playerBullet.transform.rotation); 

} 

RPCs are transmitted reliably and ordered. For more information about RPCs, see the RPC Details page.  

Hints 

 Read through the Network Reference Guide if you're still unclear about how to use Network Views  

 State Synchronization does not need to be disabled to use Remote Procedure Calls  

 If you have more than one Network View and want to call an RPC on a specific one, use GetComponents(NetworkView)[i].RPC().  
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comp-ParticlesGroup 

 Ellipsoid Particle Emitter  

 Line Renderer  

 Mesh Particle Emitter  

 Particle Animator  

 Particle Renderer  

 Trail Renderer  

 Particle Collider  

Particle Systems 

Particle Systems in Unity are used to make clouds of smoke, steam, fire and other atmospheric effects. Particle Systems work by using 

one or two Textures & drawing them many times, creating a chaotic effect.  

http://unity3d.com/support/documentation/Components/net-RPCDetails.html
http://unity3d.com/support/documentation/Components/Network%20Reference%20Guide.html
http://unity3d.com/support/documentation/Components/class-EllipsoidParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-LineRenderer.html
http://unity3d.com/support/documentation/Components/class-MeshParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-ParticleAnimator.html
http://unity3d.com/support/documentation/Components/class-ParticleRenderer.html
http://unity3d.com/support/documentation/Components/class-TrailRenderer.html
http://unity3d.com/support/documentation/Components/class-WorldParticleCollider.html


 

A Particle System included in the Standard Assets 

A typical Particle System in Unity is an object that contains a Particle Emitter, a Particle Animator and a Particle Renderer. The Particle 

Emitter generates the particles, the Particle Animator moves them over time, and the Particle Renderer draws them on the screen.  

If you want your particles to interact with the world, add a Particle Collider Component to the GameObject.  
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class-EllipsoidParticleEmitter 
The Ellipsoid Particle Emitter spawns particles inside a sphere. Use the Ellipsoid property below to scale & stretch the sphere.  

 

The Ellipsoid Particle Emitter Inspector 

http://unity3d.com/support/documentation/Components/class-EllipsoidParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-EllipsoidParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-ParticleAnimator.html
http://unity3d.com/support/documentation/Components/class-ParticleRenderer.html
http://unity3d.com/support/documentation/Components/class-WorldParticleCollider.html


Properties 

  

Emit If enabled, the emitter will emit particles. 

Min Size The minimum size each particle can be at the time when it is spawned. 

Max Size The maximum size each particle can be at the time when it is spawned. 

Min Energy The minimum lifetime of each particle, measured in seconds. 

Max Energy The maximum lifetime of each particle, measured in seconds. 

Min Emission The minimum number of particles that will be spawned every second. 

Max Emission The maximum number of particles that will be spawned every second. 

World Velocity The starting speed of particles in world space, along X, Y, and Z. 

Local Velocity The starting speed of particles along X, Y, and Z, measured in the object's orientation. 

Rnd Velocity A random speed along X, Y, and Z that is added to the velocity. 

Emitter Velocity Scale The amount of the emitter's speed that the particles inherit. 

Tangent Velocity The starting speed of particles along X, Y, and Z, across the Emitter's surface. 

Simulate In World Space If enabled, the particles don't move when the emitter moves. If false, when you move the emitter, the particles 

follow it around. 

One Shot If enabled, the particle numbers specified by min & max emission is spawned all at once. If disabled, the 

particles are generated in a long stream. 

Ellipsoid Scale of the sphere along X, Y, and Z that the particles are spawned inside. 

MinEmitterRange Determines an empty area in the center of the sphere - use this to make particles appear on the edge of the 

sphere. 

Details 

Ellipsoid Particle Emitters (EPEs) are the basic emitter, and are included when you choose to add a Particle System to your scene from 

Components->Particles->Particle System. You can define the boundaries for the particles to be spawned, and give the particles an initial 

velocity. From here, use the Particle Animator to manipulate how your particles will change over time to achieve interesting effects.  

Particle Emitters work in conjunction with Particle Animators and Particle Renderers to create, manipulate, and display Particle Systems. All 

three Components must be present on an object before the particles will behave correctly. When particles are being emitted, all different 

velocities are added together to create the final velocity.  

Spawning Properties 

Spawning properties like Size, Energy, Emission, and Velocity will give your particle system distinct personality when trying to achieve 

different effects. Having a small Size could simulate fireflies or stars in the sky. A large Size could simulate dust clouds in a musky old 

building.  

Energy and Emission will control how long your particles remain onscreen and how many particles can appear at any one time. For 

example, a rocket might have high Emission to simulate density of smoke, and high Energy to simulate the slow dispersion of smoke into 

the air.  

Velocity will control how your particles move. You might want to change your Velocity in scripting to achieve interesting effects, or if you 

want to simulate a constant effect like wind, set your X and Z Velocity to make your particles blow away.  

Simulate in World Space 

If this is disabled, the position of each individual particle will always translate relative to the Position of the emitter. When the emitter 

moves, the particles will move along with it. If you have Simulate in World Space enabled, particles will not be affected by the translation 

of the emitter. For example, if you have a fireball that is spurting flames that rise, the flames will be spawned and float up in space as the 

fireball gets further away. If Simulate in World Space is disabled, those same flames will move across the screen along with the fireball.  

Emitter Velocity Scale 

This property will only apply if Simulate in World Space is enabled.  

If this property is set to 1, the particles will inherit the exact translation of the emitter at the time they are spawned. If it is set to 2, the 

particles will inherit double the emitter's translation when they are spawned. 3 is triple the translation, etc.  

http://unity3d.com/support/documentation/Components/class-ParticleAnimator.html
http://unity3d.com/support/documentation/Components/class-ParticleAnimator.html
http://unity3d.com/support/documentation/Components/class-ParticleRenderer.html


One Shot 

One Shot emitters will create all particles within the Emission property all at once, and cease to emit particles over time. Here are some 

examples of different particle system uses with One Shot Enabled or Disabled:  

Enabled:  

 Explosion  

 Water splash  

 Magic spell  

Disabled:  

 Gun barrel smoke  

 Wind effect  

 Waterfall  

Min Emitter Range 

The Min Emitter Range determines the depth within the ellipsoid that particles can be spawned. Setting it to 0 will allow particles to spawn 

anywhere from the center core of the ellipsoid to the outer-most range. Setting it to 1 will restrict spawn locations to the outer-most range of 

the ellipsoid.  

 

Min Emitter Range of 0 



 

Min Emitter Range of 1 

Hints 

 Be careful of using many large particles. This can seriously hinder performance on low-level machines. Always try to use the minimum 

number of particles to attain an effect.  

 The Emit property works in conjunction with the AutoDestruct property of the Particle Animator. Through scripting, you can cease the 

emitter from emitting, and then AutoDestruct will automatically destroy the Particle System and the GameObject it is attached to.  
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class-LineRenderer 
The Line Renderer takes an array of two or more points in 3D space and draws a straight line between each one. A single Line Renderer 

Component can thus be used to draw anything from a simple straight line, to a complex spiral. The line is always continuous; if you need to 

draw two or more completely separate lines, you should use multiple GameObjects, each with its own Line Renderer.  

The Line Renderer does not render one pixel thin lines. It renders billboard lines that have width and can be textured. It uses the same 

algorithm for line rendering as the Trail Renderer.  

http://unity3d.com/support/documentation/Components/class-TrailRenderer.html


 

The Line Renderer Inspector 

Properties 

  
Materials The first material from this list is used to render the lines. 

Positions Array of Vector3 points to connect. 

Size The number of segments in this line. 

Parameters List of parameters for each line: 

StartWidth Width at the first line position. 

EndWidth Width at the last line position. 

Start Color Color at the first line position. 

End Color Color at the last line position. 

Use World Space If enabled, the object's position is ignored, and the lines are rendered around world origin. 

Details 

To create a line renderer:  

1. Choose GameObject->Create Empty  

2. Choose Component->Miscellaneous->Line Renderer  

3. Drag a texture or Material on the Line Renderer. It looks best if you use a particle shader in the Material.  

Hints 

 Line Renderers are good to use for effects when you need to lay out all the vertices in one frame.  

 The lines may seem to rotate as you move the Camera. This is intentional.  

 The Line Renderer should be the only Renderer on a GameObject.  
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class-MeshParticleEmitter 
The Mesh Particle Emitter emits particles around a mesh. Particles are spawned from the surface of the mesh, which can be necessary 

when you want to make your particles interact in a complex way with objects.  



 

The Mesh Particle Emitter Inspector 

Properties 

  

Emit If enabled, the emitter will emit particles. 

Min Size The minimum size each particle can be at the time when it is spawned. 

Max Size The maximum size each particle can be at the time when it is spawned. 

Min Energy The minimum lifetime of each particle, measured in seconds. 

Max Energy The maximum lifetime of each particle, measured in seconds. 

Min Emission The minimum number of particles that will be spawned every second. 

Max Emission The maximum number of particles that will be spawned every second. 

World Velocity The starting speed of particles in world space, along X, Y, and Z. 

Local Velocity The starting speed of particles along X, Y, and Z, measured in the object's orientation. 

Rnd Velocity A random speed along X, Y, and Z that is added to the velocity. 

Emitter Velocity Scale The amount of the emitter's speed that the particles inherit. 

Tangent Velocity The starting speed of particles along X, Y, and Z, across the Emitter's surface. 

Simulate In World Space If enabled, the particles don't move when the emitter moves. If false, when you move the emitter, the particles 

follow it around. 

One Shot If enabled, the particle numbers specified by min & max emission is spawned all at once. If disabled, the 

particles are generated in a long stream. 

Interpolate Triangles If enabled, particles are spawned all over the mesh's surface. If disabled, particles are only spawned from the 

mesh's vertrices. 

Systematic If enabled, particles are spawned in the order of the vertices defined in the mesh. Although you seldom have 

direct control over vertex order in meshes, most 3D modelling applications have a very systematic setup when 

using primitives. It is important that the mesh contains no faces in order for this to work. 

Min Normal Velocity Minimum amount that particles are thrown away from the mesh. 

Max Normal Velocity Maximum amount that particles are thrown away from the mesh. 

Details 

Mesh Particle Emitters (MPEs) are used when you want more precise control over the spawn position & directions than the simpler 

Ellipsoid Particle Emitter gives you. They can be used for making advanced effects.  

MPEs work by emitting particles at the vertices of the attached mesh. Therefore, the areas of your mesh that are more dense with polygons 

will be more dense with particle emission.  



Particle Emitters work in conjunction with Particle Animators and Particle Renderers to create, manipulate, and display Particle Systems. All 

three Components must be present on an object before the particles will behave correctly. When particles are being emitted, all different 

velocities are added together to create the final velocity.  

Spawning Properties 

Spawning properties like Size, Energy, Emission, and Velocity will give your particle system distinct personality when trying to achieve 

different effects. Having a small Size could simulate fireflies or stars in the sky. A large Size could simulate dust clouds in a musky old 

building.  

Energy and Emission will control how long your particles remain onscreen and how many particles can appear at any one time. For 

example, a rocket might have high Emission to simulate density of smoke, and high Energy to simulate the slow dispersion of smoke into 

the air.  

Velocity will control how your particles move. You might want to change your Velocity in scripting to achieve interesting effects, or if you 

want to simulate a constant effect like wind, set your X and Z Velocity to make your particles blow away.  

Simulate in World Space 

If this is disabled, the position of each individual particle will always translate relative to the Position of the emitter. When the emitter 

moves, the particles will move along with it. If you have Simulate in World Space enabled, particles will not be affected by the translation 

of the emitter. For example, if you have a fireball that is spurting flames that rise, the flames will be spawned and float up in space as the 

fireball gets further away. If Simulate in World Space is disabled, those same flames will move across the screen along with the fireball.  

Emitter Velocity Scale 

This property will only apply if Simulate in World Space is enabled.  

If this property is set to 1, the particles will inherit the exact translation of the emitter at the time they are spawned. If it is set to 2, the 

particles will inherit double the emitter's translation when they are spawned. 3 is triple the translation, etc.  

One Shot 

One Shot emitters will create all particles within the Emission property all at once, and cease to emit particles over time. Here are some 

examples of different particle system uses with One Shot Enabled or Disabled:  

Enabled:  

 Explosion  

 Water splash  

 Magic spell  

Disabled:  

 Gun barrel smoke  

 Wind effect  

 Waterfall  

Interpolate Triangles 

Enabling your emitter to Interpolate Triangles will allow particles to be spawned between the mesh's vertices. This option is off by default, 

so particles will only be spawned at the vertices.  

http://unity3d.com/support/documentation/Components/class-ParticleAnimator.html
http://unity3d.com/support/documentation/Components/class-ParticleRenderer.html


 

A sphere with Interpolate Triangles off (the default) 

Enabling this option will spawn particles on and in-between vertices, essentially all over the mesh's surface (seen below).  



 

A sphere with Interpolate Triangles on 

It bears repeating that even with Interpolate Triangles enabled, particles will still be denser in areas of your mesh that are more dense 

with polygons.  

Systematic 

Enabling Systematic will cause your particles to be spawned in your mesh's vertex order. The vertex order is set by your 3D modeling 

application.  



 

An MPE attached to a sphere with Systematic enabled 

Normal Velocity 

Normal Velocity controls the speed at which particles are emitted along the normal from where they are spawned.  

For example, create a Mesh Particle System, use a cube mesh as the emitter, enable Interpolate Triangles, and set Normal Velocity Min 

and Max to 1. You will now see the particles emit from the faces of the cube in a straight line.  

See Also 

 How to make a Mesh Particle Emitter  

Hints 

 Be careful of using many large particles. This can seriously hinder performance on low-level machines. Always try to use the minimum 

number of particles to attain an effect.  

 The Emit property works in conjunction with the AutoDestruct property of the Particle Animator. Through scripting, you can cease the 

emitter from emitting, and then AutoDestruct will automatically destroy the Particle System and the GameObject it is attached to.  

 MPEs can also be used to make glow from a lot of lamps placed in a scene. Simply make a mesh with one vertex in the center of each 

lamp, and build an MPE from that with a halo material. Great for evil sci-fi worlds.  
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class-ParticleAnimator 

http://unity3d.com/support/documentation/Manual/HOWTO-MeshParticleEmitter.html


Particle Animators move your particles over time, you use them to apply wind, drag & color cycling to your particle systems.  

 

The Particle Animator Inspector 

Properties 

  

Does Animate Color If enabled, particles cycle their color over their lifetime. 

Color Animation The 5 colors particles go through. All particles cycle over this - if some have a shorter life span than others, they 

will animate faster. 

World Rotation Axis An optional world-space axis the particles rotate around. Use this to make advanced spell effects or give 

caustic bubbles some life. 

Local Rotation Axis An optional local-space axis the particles rotate around. Use this to make advanced spell effects or give caustic 

bubbles some life. 

Size Grow Use this to make particles grow in size over their lifetime. As randomized forces will spread your particles out, it 

is often nice to make them grow in size so they don't fall apart. Use this to make smoke rise upwards, to 

simulate wind, etc. 

Rnd Force A random force added to particles every frame. Use this to make smoke become more alive. 

Force The force being applied every frame to the particles, measure relative to the world. 

Damping How much particles are slowed every frame. A value of 1 gives no damping, while less makes them slow down. 

Autodestruct If enabled, the GameObject attached to the Particle Animator will be destroyed when all particles disappear. 

Details 

Particle Animators allow your particle systems to be dynamic. They allow you to change the color of your particles, apply forces and 

rotation, and choose to destroy them when they are finished emitting. For more information about Particle Systems, reference Mesh 

Particle Emitters, Ellipsoid Particle Emitters, and Particle Renderers.  

Animating Color 

If you would like your particles to change colors or fade in/out, enable them to Animate Color and specify the colors for the cycle. Any 

particle system that animates color will cycle through the 5 colors you choose. The speed at which they cycle will be determined by the 

Emitter's Energy value.  

If you want your particles to fade in rather than instantly appear, set your first or last color to have a low Alpha value.  

http://unity3d.com/support/documentation/Components/class-MeshParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-MeshParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-EllipsoidParticleEmitter.html
http://unity3d.com/support/documentation/Components/class-ParticleRenderer.html


 

An Animating Color Particle System 

Rotation Axes 

Setting values in either the Local or World Rotation Axes will cause all spawned particles to rotate around the indicated axis (with the 

Transform's position as the center). The greater the value is entered on one of these axes, the faster the rotation will be.  

Setting values in the Local Axes will cause the rotating particles to adjust their rotation as the Transform's rotation changes, to match its 

local axes.  

Setting values in the World Axes will cause the particles' rotation to be consistent, regardless of the Transform's rotation.  

Forces & Damping 

You use force to make particles accelerate in the direction specified by the force.  

Damping can be used to decelerate or accelerate without changing their direction:  

 A value of 1 means no Damping is applied, the particles will not slow down or accelerate.  

 A value of 0 means particles will stop immediately.  

 A value of 2 means particles will double their speed every second.  

Destroying GameObjects attached to Particles 

You can destroy the Particle System and any attached GameObject by enabling the AutoDestruct property. For example, if you have an 

oil drum, you can attach a Particle System that has Emit disabled and AutoDestruct enabled. On collision, you enable the Particle Emitter. 

The explosion will occur and after it is over, the Particle System and the oil drum will be destroyed and removed from the scene.  

Note that automatic destruction takes effect only after some particles have been emitted. The precise rules for when the object is destroyed 

when AutoDestruct is on:  

 If there have been some particles emitted already, but all of them are dead now, or  

 If the emitter did have Emit on at some point, but now Emit is off.  

Hints 

http://unity3d.com/support/documentation/Components/class-EllipsoidParticleEmitter.html


 Use the Color Animation to make your particles fade in & out over their lifetime - otherwise, you will get nasty-looking pops.  

 Use the Rotation Axes to make whirlpool-like swirly motions.  
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class-ParticleRenderer 
The Particle Renderer renders the Particle System on screen.  

 

The Particle Renderer Inspector 

Properties 

  

Materials Reference to a list of Materials that will be displayed in the position of each individual particle. 

Camera Velocity Scale The amount of stretching that is applied to the Particles based on Camera movement. 

Stretch Particles Determines how the particles are rendered. 

Billboard The particles are rendered as if facing the camera. 

Stretched The particles are facing the direction they are moving. 

SortedBillboard The particles are sorted by depth. Use this when using a blending material. 

VerticalBillboard All particles are aligned flat along the X/Z axes. 

HorizontalBillboard All particles are aligned flat along the X/Y axes. 

Length Scale If Stretch Particles is set to Stretched, this value determines how long the particles are in their direction of 

motion. 

Velocity Scale If Stretch Particles is set to Stretched, this value determines the rate at which particles will be stretched, 

based on their movement speed. 

http://unity3d.com/support/documentation/Components/class-Camera.html


UV Animation If either of these are set, the UV coordinates of the particles will be generated for use with a tile animated 

texture. See the section on Animated Textures below. 

X Tile Number of frames located across the X axis. 

Y Tile Number of frames located across the Y axis. 

Cycles How many times to loop the animation sequence. 

Details 

Particle Renderers are required for any Particle Systems to be displayed on the screen.  

 

A Particle Renderer makes the Gunship's engine exhaust appear on the screen 

Choosing a Material 

When setting up a Particle Renderer it is very important to use an appropriate material and shader that renders both sides of the material. 

Most of the time you want to use a Material with one of the built-in Particle Shaders. There are some premade materials in the Standard 

Assets->Particles->Sources folder that you can use.  

Creating a new material is easy:  

1. Select Assets->Create Other->Material from the menu bar.  

2. The Material has a shader popup, choose one of the shaders in the Particles group. Eg. Particles->Multiply.  

3. Now assign a Texture. The different shaders use the alpha channel of the textures slightly differently, but most of the time a value 

of black will make it invisible and white in the alpha channel will display it on screen.  

Distorting particles 

By default particles are rendered billboarded. That is simple square sprites. This is good for smoke and explosions and most other particle 

effects.  

Particles can be made to either stretch with the velocity. This is useful for sparks, lightning or laser beams. Length Scale and Velocity 

Scale affects how long the stretched particle will be.  

Sorted Billboard can be used to make all particles sort by depth. Sometimes this is necessary, mostly when using Alpha Blended particle 

shaders. This can be expensive and should only be used if it really makes a quality difference when rendering.  

http://unity3d.com/support/documentation/printable.html#AnimatedTextures
http://unity3d.com/support/documentation/Components/class-Material.html


Animated textures 

Particle Systems can be rendered with an animated tile texture. To use this feature, make the texture out of a grid of images. As the 

particles go through their life cycle, they will cycle through the images. This is good for adding more life to your particles, or making small 

rotating debris pieces.  

Hints 

 Use Particle Shaders with the Particle Renderer.  
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class-TrailRenderer 
The Trail Renderer is used to make trails behind objects in the scene as they move about.  

 

The Trail Renderer Inspector 

Properties 

  
Materials An array of materials used for rendering the trail. Particle shaders work the best for trails. 

Size The total number of elements in the Material array. 

Element 0 Reference to the Material used to render the trail. The total number of elements is determined by the Size 

property. 

Time Length of the trail, measured in seconds. 

Start Width Width of the trail at the object's position. 

End Width Width of the trail at the end. 

Colors Array of colors to use over the length of the trail. You can also set alpha transparency with the colors. 

Color0 to Color4 The trail's colors, initial to final. 

Min Vertex Distance The minimum distance between anchor points of the trail. 

AutoDestruct Enable this to make the object be destroyed when the object has been idle for Time seconds. 

Details 

The Trail Renderer is great for a trail behind a projectile, or contrails from the tip of a plane's wings. It is good when trying to add a general 

feeling of speed.  

When using a Trail Renderer, no other renderers on the GameObject are used. It is best to create an empty GameObject, and attach a 

Trail Renderer as the only renderer. You can then parent the Trail Renderer to whatever object you would like it to follow.  

Materials 



Trail Renderers should use a material that has a Particle Shader. The Texture used for the Material should be of square dimensions (e.g. 

256x256 or 512x512).  

Trail Width 

By setting the Trail's Start and End Width, along with the Time property, you can tune the way it is displayed and behaves. For example, 

you could create the wake behind a boat by setting the Start Width to 1, and the End Width to 2. These values would probably need to be 

fine-tuned for your game.  

Trail Colors 

You can cycle your trail through 5 different color/opacity combinations. Using colors could make a bright green plasma trail gradually dim 

down to a dull grey dissipation, or cycle through the other colors of the rainbow. If you don't want to change the color, it can be very 

effective to change only the opacity of each color to make your trail fade in and out at the head and/or tail.  

Min Vertex Distance 

The Min Vertex Distance value determines how far the object that contains the trail must travel before a segment of the trail is solidified. 

Low values like 0.1 will create trail segments more often, creating smoother trails. Higher values like 1.5 will create segments that are more 

jagged in appearance. There is a slight performance trade off when using lower values/smoother trails, so try to use the largest possible 

value to achieve the effect you are trying to create.  

Hints 

 Use Particle Materials with the Trail Renderer.  

 Trail Renderers must be laid out over a sequence of frames, they can't appear instantaneously.  

 Trail Renderers rotate to display the face toward the camera, similar to other Particle Systems.  
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class-WorldParticleCollider 
The World Particle Collider is used to collide particles against other Colliders in the scene.  

 

A Particle System colliding with a Mesh Collider 

Properties 

  

Bounce Factor Particles can be accelerated or slowed down when they collide against other objects. This factor is similar to 



the Particle Animator's Damping property. 

Collision Energy Loss Amount of energy (in seconds) a particle should lose when colliding. If the energy goes below 0, the particle is 

killed. 

Min Kill Velocity If a particle's Velocity drops below Min Kill Velocity because of a collision, it will be eliminated. 

Collides with Which Layers the particle will collide against. 

Send Collision Message If enabled, every particle sends out a collision message that you can catch through scripting. 

Details 

To create a Particle System with Particle Collider:  

1. Create a Particle System using GameObject->Create Other->Particle System  

2. Add the Particle Collider using Component->Particles->World Particle Collider  

Messaging 

If Send Collision Message is enabled, any particles that are in a collision will send the message OnParticleCollision() to both the 

particle's GameObject and the GameObject the particle collided with.  

Hints 

 Send Collision Message can be used to simulate bullets and apply damage on impact.  

 Particle Collision Detection is slow when used with a lot of particles. Use Particle Collision Detection wisely.  

 Message sending introduces a large overhead and shouldn't be used for normal Particle Systems.  
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comp-RenderingGroup 
This group contains all Components that have to do with rendering in-game and user interface elements. Lighting and special effects are 

also included in this group.  

 Camera  

 Flare Layer  

 GUI Layer  

 GUI Text  

 GUI Texture  

 Halo  

 Lens Flare  

 Light  

 Projector  

 Skybox  
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class-Camera 
Cameras are the devices that capture and display the world to the player. By customizing and manipulating cameras, you can make the 

presentation of your game truly unique. You can have an unlimited number of cameras in a scene. They can be set to render in any order, 

at any place on the screen, or only certain parts of the screen.  

http://unity3d.com/support/documentation/Components/Layers.html
http://unity3d.com/support/documentation/Components/class-Camera.html
http://unity3d.com/support/documentation/Components/class-FlareLayer.html
http://unity3d.com/support/documentation/Components/class-GUILayer.html
http://unity3d.com/support/documentation/Components/class-GuiText.html
http://unity3d.com/support/documentation/Components/class-GuiTexture.html
http://unity3d.com/support/documentation/Components/class-Halo.html
http://unity3d.com/support/documentation/Components/class-LensFlare.html
http://unity3d.com/support/documentation/Components/class-Light.html
http://unity3d.com/support/documentation/Components/class-Projector.html
http://unity3d.com/support/documentation/Components/class-Skybox.html


 

Unity's flexible Camera object 

Properties 

  

Clear Flags Determines which parts of the screen will be cleared. This is handy when using multiple Cameras to draw 

different game elements. 

Background Color applied to the remaining screen after all elements in view have been drawn and there is no skybox. 

Culling Mask Include or omit layers of objects to be rendered by the Camera. Assign layers to your objects in the Inspector. 

Projection Toggles the camera's capability to simulate perspective. 

Perspective Camera will render objects with perspective intact. 

Orthographic Camera will render objects uniformly, with no sense of perspective. 

Size (when Orthographic is 

selected) 

The viewport size of the Camera when set to Orthographic. 

Field of view Width of the Camera's view angle, measured in degrees along the local Y axis. 

Clipping Planes Distances from the camera to start and stop rendering. 

Near The closest point relative to the camera that drawing will occur. 

Far The furthest point relative to the camera that drawing will occur. 

Normalized View Port 

Rect 

Four values that indicate where on the screen this camera view will be drawn, in Screen Coordinates (values 0-

1). 

X The beginning horizontal position that the camera view will be drawn. 

Y The beginning vertical position that the camera view will be drawn. 

W (Width) Width of the camera output on the screen. 

H (Height) Height of the camera output on the screen. 

Depth The camera's position in the draw order. Cameras with a larger value will be drawn on top of cameras with a 

smaller value. 

Rendering Path Options for defining what rendering methods will be used by the camera. 

Use Player Settings This camera will use whichever Rendering Path is set in the Player Settings. 

Vertex Lit All objects rendered by this camera will be rendered as Vertex-Lit objects. 

Forward All objects will be rendered with one pass per material, as was standard in Unity 2.x. 

Deferred Lighting (Unity 

Pro only) 

All objects will be drawn once without lighting, then lighting of all objects will be rendered together at the end of 

the render queue. 

Target Texture (Unity 

Pro/Advanced only) 

Reference to a Render Texture that will contain the output of the Camera view. Making this reference will 

disable this Camera's capability to render to the screen. 

Details 

Cameras are essential for displaying your game to the player. They can be customized, scripted, or parented to achieve just about any kind 

of effect imaginable. For a puzzle game, you might keep the Camera static for a full view of the puzzle. For a first-person shooter, you 

would parent the Camera to the player character, and place it at the character's eye level. For a racing game, you'd likely want to have the 

Camera follow your player's vehicle.  

http://unity3d.com/support/documentation/Components/class-RenderTexture.html


You can create multiple Cameras and assign each one to a different Depth. Cameras are drawn from low Depth to high Depth. In other 

words, a Camera with a Depth of 2 will be drawn on top of a Camera with a depth of 1. You can adjust the values of the Normalized View 

Port Rectangle property to resize and position the Camera's view onscreen. This can create multiple mini-views like missile cams, map 

views, rear-view mirrors, etc.  

Render Path 

Unity supports different Rendering Paths. You should choose which one you use depending on your game content and target platform / 

hardware. Different rendering paths have different features and performance characteristics that mostly affect Lights and Shadows. 

The rendering Path used by your project is chosen in Player Settings. Additionally, you can override it for each Camera.  

For more info on rendering paths, check the rendering paths page.  

Clear Flags 

Each Camera stores color and depth information when it renders its view. The portions of the screen that are not drawn in are empty, and 

will display the skybox by default. When you are using multiple Cameras, each one stores its own color and depth information in buffers, 

accumulating more data as each Camera renders. As any particular Camera in your scene renders its view, you can set the Clear Flags to 

clear different collections of the buffer information. This is done by choosing one of the four options:  

Skybox 
This is the default setting. Any empty portions of the screen will display the current Camera's skybox. If the current Camera has no skybox 

set, it will default to the skybox chosen in the Render Settings (found in Edit->Render Settings). It will then fall back to the Background 

Color. Alternatively a Skybox component can be added to the camera. If you want to create a new Skybox, you can use this guide.  

Solid Color 
Any empty portions of the screen will display the current Camera's Background Color.  

Depth Only 
If you wanted to draw a player's gun without letting it get clipped inside the environment, you would set one Camera at Depth 0 to draw the 

environment, and another Camera at Depth 1 to draw the weapon alone. The weapon Camera's Clear Flags should be set to to depth 

only. This will keep the graphical display of the environment on the screen, but discard all information about where each object exists in 3-

D space. When the gun is drawn, the opaque parts will completely cover anything drawn, regardless of how close the gun is to the wall.  

 

The gun is drawn last, after clearing the depth buffer of the cameras before it 

Don't Clear 

http://unity3d.com/support/documentation/Manual/RenderingPaths.html
http://unity3d.com/support/documentation/Components/class-RenderSettings.html
http://unity3d.com/support/documentation/Components/class-Skybox.html
http://unity3d.com/support/documentation/Manual/HOWTO-UseSkybox.html


This mode does not clear either the color or the depth buffer. The result is that each frame is drawn over the next, resulting in a smear-

looking effect. This isn't typically used in games, and would likely be best used with a custom shader.  

Clip Planes 

The Near and Far Clip Plane properties determine where the Camera's view begins and ends. The planes are laid out perpendicular to the 

Camera's direction and are measured from the its position. The Near plane is the closest location that will be rendered, and the Far plane 

is the furthest.  

The clipping planes also determine how depth buffer precision is distributed over the scene. In general, to get better precision you should 

move the Near plane as far as possible.  

Note that the near and far clip planes together with the planes defined by the field of view of the camera describe what is popularly known 

as the camera frustum. Unity ensures that when rendering your objects those which are completely outside of this frustum are not 

displayed. This is called Frustum Culling. Frustum Culling happens irrespective of whether you use Occlusion Culling in your game.  

For performance reasons, you might want to cull small objects earlier. For example, small rocks and debris could be made invisible at much 

smaller distance than large buildings. To do that, put small objects into a separate layer and setup per-layer cull distances using 

Camera.layerCullDistances script function.  

Culling Mask 

The Culling Mask is used for selectively rendering groups of objects using Layers. More information on using layers can be found here.  

Commonly, it is good practice to put your User Interface on a different layer, then render it by itself with a separate Camera set to render 

the UI layer by itself.  

In order for the UI to display on top of the other Camera views, you'll also need to set the Clear Flags to Depth only and make sure that 

the UI Camera's Depth is higher than the other Cameras.  

Normalized Viewport Rectangle 

Normalized Viewport Rectangles are specifically for defining a certain portion of the screen that the current camera view will be drawn 

upon. You can put a map view in the lower-right hand corner of the screen, or a missile-tip view in the upper-left corner. With a bit of design 

work, you can use Viewport Rectangle to create some unique behaviors.  

It's easy to create a two-player split screen effect using Normalized Viewport Rectangle. After you have created your two cameras, 

change both camera H value to be 0.5 then set player one's Y value to 0.5, and player two's Y value to 0. This will make player one's 

camera display from halfway up the screen to the top, and player two's camera will start at the bottom and stop halfway up the screen.  

http://unity3d.com/support/documentation/Components/Layers.html
http://unity3d.com/support/documentation/ScriptReference/Camera-layerCullDistances.html
http://unity3d.com/support/documentation/Components/Layers.html


 

Two-player display created with Normalized Viewport Rectangle 

Orthographic 

Marking a Camera as Orthographic removes all perspective from the Camera's view. This is mostly useful for making isometric or 2D 

games.  

Note that fog is rendered uniformly in orthographic camera mode and may therefore not appear as expected. Read more about why in the 

component reference on Render Settings.  

 

Perspective camera. 

http://unity3d.com/support/documentation/ScriptReference/class-RenderSettings.html


 

Orthographic camera. Objects do not get smaller with distance here! 

Render Texture  

This feature is only available for Unity Advanced licenses . It will place the camera's view onto a Texture that can then be applied to another 

object. This makes it easy to create sports arena video monitors, surveillance cameras, reflections etc.  

 

A Render Texture used to create a live arena-cam 

Hints 

 Cameras can be instantiated, parented, and scripted just like any other GameObject.  

 To increase the sense of speed in a racing game, use a high Field of View.  

 Cameras can be used in physics simulation if you add a Rigidbody Component.  

 There is no limit to the number of Cameras you can have in your scenes.  

 Orthographic cameras are great for making 3D user interfaces  

 If you are experiencing depth artifacts (surfaces close to each other flickering), try setting Near Plane to as large as possible.  

 Cameras cannot render to the Game Screen and a Render Texture at the same time, only one or the other.  

http://unity3d.com/support/documentation/Components/class-RenderTexture.html


 Pro license holders have the option of rendering a Camera's view to a texture, called Render-to-Texture, for even more unique effects.  

 Unity comes with pre-installed Camera scripts, found in Components->Camera Control. Experiment with them to get a taste of what's 

possible.  
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class-FlareLayer 
The Flare Layer Component can be attached to Cameras to make Lens Flares appear in the image. By default, Cameras have a Flare 

Layer already attached.  
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class-GUILayer 
A GUI Layer Component is attached to a Camera to enable rendering of 2D GUIs.  

When a GUI Layer is attached to a Camera it will render all GUI Textures and GUI Texts in the scene. GUI Layers do not affect UnityGUI in 

any way.  

You can enable and disable rendering GUI in a single camera by clicking on the check box of the GUI Layer in the Inspector.  
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class-GuiText 
GUI Text displays text of any font you import in screen coordinates.  

 

The GUI Text Inspector 

Please Note: Unity 2.0 introduced UnityGUI, a GUI Scripting system. You may prefer creating user interface elements with UnityGUI 

instead of GUI Texts. Read more about how to use UnityGUI in the GUI Scripting Guide.  

Properties 

  

Text The string to display. 

Anchor The point at which the Text shares the position of the Transform. 

Alignment How multiple lines are aligned within the GUIText. 

Pixel Offset Offset of the text relative to the position of the GUIText in the screen. 

http://unity3d.com/support/documentation/Components/class-Camera.html
http://unity3d.com/support/documentation/Components/class-LensFlare.html
http://unity3d.com/support/documentation/Components/class-GuiTexture.html
http://unity3d.com/support/documentation/Components/class-GuiText.html
http://unity3d.com/support/documentation/Components/GUI%20Scripting%20Guide.html
http://unity3d.com/support/documentation/Components/GUI%20Scripting%20Guide.html


Line Spacing How much space will be in-between lines of Text. 

Tab Size How much space will be inserted for a tab ('\t') character. As a multiplum of the space character offset. 

Font The Font to use when rendering the text. 

Material Reference to the Material containing the characters to be drawn. If set, this property overrides the one in the 

Font asset. 

Pixel Correct If enabled, all Text characters will be drawn in the size of the imported font texture. If disabled, the characters 

will be resized based on the Transform's Scale. 

Details 

GUI Texts are used to print text onto the screen in 2D. The Camera has to have a GUI Layer attached in order to render the text. Cameras 

include a GUI Layer by default, so don't remove it if you want to display a GUI Text. GUI Texts are positioned using only the X and Y axes. 

Rather than being positioned in World Coordinates, GUI Texts are positioned in Screen Coordinates, where (0,0) is the bottom-left and 

(1,1) is the top-right corner of the screen  

To import a font see the Font page.  

Pixel Correct 

By default, GUI Texts are rendered with Pixel Correct enabled. This makes them look crisp and they will stay the same size in pixels 

independent of the screen resolution.  

Hints 

 When entering text into the Text property, you can create a line break by holding Alt and pressing Return.  

 If you are scripting the Text property, you can add line breaks by inserting the escape character "\n" in your strings.  

 You can download free true type fonts from 1001freefonts.com (download the Windows fonts since they contain TrueType fonts).  
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class-GuiTexture 
GUI Textures are displayed as flat images in 2D. They are made especially for user interface elements, buttons, or decorations. Their 

positioning and scaling is performed along the x and y axes only, and they are measured in Screen Coordinates, rather than World 

Coordinates.  

 

The GUI Texture Inspector 

Please Note: Unity 2.0 introduced UnityGUI, a GUI Scripting system. You may prefer creating user interface elements with UnityGUI 

instead of GUI Textures. Read more about how to use UnityGUI in the GUI Scripting Guide.  

Properties 

  
Texture Reference to the Texture that will be used as the texture's display. 

http://unity3d.com/support/documentation/Components/class-Font.html
http://unity3d.com/support/documentation/Components/class-Font.html
http://unity3d.com/support/documentation/Components/class-GUILayer.html
http://unity3d.com/support/documentation/Components/class-Font.html
http://www.1001freefonts.com/fonts/afonts.htm
http://unity3d.com/support/documentation/Components/GUI%20Scripting%20Guide.html
http://unity3d.com/support/documentation/Components/class-Texture2D.html


Color Color that will tint the Texture drawn on screen. 

Pixel Inset Used for pixel-level control of the scaling and positioning of the GUI Texture. All values are measured relative to 

the position of the GUI Texture's Transform. 

X Left-most pixel position of the texture. 

Y Bottom-most pixel position of the texture. 

Width Right-most pixel position of the texture. 

Height Top-most pixel position of the texture. 

Left Border Number of pixels from the left that are not affected by scale. 

Right Border Number of pixels from the right that are not affected by scale. 

Top Border Number of pixels from the top that are not affected by scale. 

Bottom Border Number of pixels from the bottom that are not affected by scale. 

Details 

To create a GUITexture:  

1. Select a Texture in the Project View  

2. Choose GameObject->Create Other->GUI Texture from the menu bar  

GUI Textures are perfect for presenting game interface backgrounds, buttons, or other elements to the player. Through scripting, you can 

easily provide visual feedback for different "states" of the texture -- when the mouse is hovering over the texture, or is actively clicking it for 

example. Here is the basic breakdown of how the GUI Texture is calculated:  

 

GUI Textures are laid out according to these rules 



 

The GUI elements seen here were all created with GUI Textures 

Borders 

The number of pixels that will not scale with the texture at each edge of the image. As you rarely know the resolution your game runs in, 

chances are your GUI will get scaled. Some GUI textures have a border at the edge that is meant to be an exact number of pixels. In order 

for this to work, set the border sizes to match those from the texture.  

Pixel Inset 

The purpose of the Pixel Inset is to prevent textures from scaling with screen resolution, and keeping thim in a fixed pixel size. This allows 

you to render a texture without any scaling. This means that players who run your game in higher resolutions will see your textures in 

smaller areas of the screen, allowing them to have more screen real-estate for your gameplay graphics.  

To use it effectively, you need to set the scale of the GUI Texture's Transform to (0, 0, 0). Now, the Pixel Inset is in full control of the 

texture's size and you can set the Pixel Inset values to be the exact pixel size of your Texture.  

Hints 

 The depth of each layered GUI Texture is determined by its individual Z Transform position, not the global Z position.  

 GUI Textures are great for making menu screens, or pause/escape menu screens.  

 You should use Pixel Inset on any GUI Textures that you want to be a specific number of pixels for the width and height.  
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class-Halo 
Halos are light areas around light sources, used to give the impression of small dust particles in the air.  



 

A Light with a separate Halo Component 

Properties 

Halos use the Halo Texture set up in the Render Settings. If none is assigned, it uses a default one. A Light component can be setup to 

automatically show halo, without a separate Halo component.  

  
Color Color of the Halo. 

Size Size of the Halo. 

Hints 

 To see Halos in the scene view, check Fx button in the Scene View Toolbar.  
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class-LensFlare 
Lens Flares simulate the effect of lights refracting inside camera lens. They are used to represent really bright lights or, more subtly, just to 

add a bit more atmosphere to your scene.  

 

The Lens Flare Inspector 

The easiest way to setup a Lens Flare is just to assign the Flare property of the Light. Unity contains a couple of pre-configured Flares in 

the Standard Assets package.  

Otherwise, create an empty GameObject with GameObject->Create Empty from the menu bar and add the Lens Flare Component to it 

with Component->Rendering->Lens Flare. Then and choose the Flare in the Inspector.  

To see the effect of Lens Flare in the Scene View, check the Fx button in the Scene View toolbar:  

http://unity3d.com/support/documentation/Components/class-RenderSettings.html
http://unity3d.com/support/documentation/Components/class-Light.html
http://unity3d.com/support/documentation/Components/class-Light.html
http://unity3d.com/support/documentation/Manual/HOWTO-InstallStandardAssets.html


 

Enable the Fx button to view Lens Flares in the Scene View 

Properties 

  

Flare The Flare to render. The flare defines all aspects of the lens flare's appearance. 

Color Some flares can be colorized to better fit in with your scene's mood. 

Brightness How large and bright the Lens Flare is. 

Directional If set, the flare will be oriented along positive Z axis of the game object. It will appear as if it was infinitely far 

away, and won't track object's position, only the direction of Z axis. 

Details 

You can directly set flares as a property of a Light Component, or set them up separately as Lens Flare component. If you attach them to a 

light, they will automatically track the position and direction of the light. To get more precise control, use this Component.  

A Camera has to have a Flare Layer Component attached to make Flares visible (this is true by default, so you don't have to do any set-

up).  

Hints 

 Be discrete about your usage of Lens Flares.  

 If you use a very bright Lens Flare, make sure its direction fits with your scene's primary light source.  

 To design your own Flares, you need to create some Flare Assets. Start by duplicating some of the ones we provided in the the Lens 

Flares folder of the Standard Assets, then modify from that.  

 Lens Flares are blocked by Colliders. A Collider in-between the Flare GameObject and the Camera will hide the Flare, even if the Collider 

does not have a Mesh Renderer.  
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class-Light 
Lights will bring personality and flavor to your game. You use lights to illuminate the scenes and objects to create the perfect visual mood. 

Lights can be used to simulate the sun, burning match light, flashlights, gun-fire, or explosions, just to name a few.  

http://unity3d.com/support/documentation/Components/class-Flare.html
http://unity3d.com/support/documentation/Components/class-Light.html
http://unity3d.com/support/documentation/Components/class-Camera.html
http://unity3d.com/support/documentation/Components/class-FlareLayer.html


 

The Light Inspector 

There are three types of lights in Unity:  

 Point lights shine from a location equally in all directions, like a light bulb.  

 Directional lights are placed infinitely far away and affect everything in the scene, like the sun.  

 Spot lights shine from a point in a direction and only illuminate objects within a cone - like the headlights of a car.  

Lights can also cast Shadows. Shadows are a Pro-only feature. Shadow properties can be adjusted on a per-light basis.  

Properties 

  

Type The current type of light object: 

Directional A light placed infinitely far away. It affects everything in the scene. 

Point A light that shines equally in all directions from its location, affecting all objects within its Range. 

Spot A light that shines everywhere within a cone defined by Spot Angle and Range. Only objects within this region 

are affected by the light. 

Range How far light is emitted from the center of the object. Point/Spot light only. 

Spot Angle Determines the angle of the cone in degrees. Spot light only. 

Color The color of the light emitted. 

Intensity Brightness of the light. Default value for a Point/Spot light is 1. Default value for a Directional light is 0.5 

Cookie The alpha channel of this texture is used as a mask that determines how bright the light is at different places. If 

the light is a Spot or a Directional light, this must be a 2D texture. If the light is a Point light, it must be a 

Cubemap. 

Cookie Size Scales the projection of a Cookie. Directional light only. 

Shadow Type (Pro only) No, Hard or Soft shadows that will be cast by this light. Only applicable to desktop build targets. Soft shadows 

are more expensive. 

Strength The darkness of the shadows. Values are between 0 and 1. 

Resolution Detail level of the shadows. 

Bias Offset used when comparing the pixel position in light space with the value from the shadow map. When the 

value is too small the surfaces start to self-shadow themselves ("shadow acne"), when too big - casters are 

disconnected from receivers ("peter panning"). 

Softness Scales the penumbra region (the offset of blur samples). Directional light only. 

Softness Fade Shadow softness fade based on the distance from the camera. Directional light only. 

Draw Halo If checked, a spherical halo of light will be drawn with a radius equal to Range. 

Flare Optional reference to the Flare that will be rendered at the light's position. 

Render Mode Importance of this light. This can affect lighting fidelity and performance, see Performance Considerations 

below. Options include: 

Auto The rendering method is determined at runtime depending on the brightness of nearby lights and current 

Quality Settings for desktop build target. 

http://unity3d.com/support/documentation/Manual/Shadows.html
http://unity3d.com/support/documentation/Components/class-Flare.html
http://unity3d.com/support/documentation/Components/class-QualitySettings.html


Important This light is always rendered at per-pixel quality. Use this for very important effects only (e.g. headlights of a 

player's car). 

Not Important This light is always rendered in a faster, vertex/object light mode. 

Culling Mask Use to selectively exclude groups of objects from being affected by the light; see Layers. 

Lightmapping The Lightmapping mode: RealtimeOnly, Auto or BakedOnly; see the Dual Lightmaps description. 

Details 

There are three basic light types in Unity. Each type can be customized to fit your needs.  

You can create a texture that contains an alpha channel and assign it to the Cookie variable of the light. The Cookie will be projected from 

the light. The Cookie's alpha mask modulates the light amount, creating light and dark spots on surfaces. They are a great way af adding 

lots of complexity or atmosphere to a scene.  

All built-in shaders in Unity seamlessly work with any type of light. VertexLit shaders cannot display Cookies or Shadows, however.  

In Unity Pro with a build target of webplayer or standalone, all Lights can optionally cast Shadows. This is done by selecting either Hard 

Shadows or Soft Shadows for the Shadow Type property of each individual Light. For more information about shadows, please read the 

Shadows page.  

Point Lights 

 

Point lights shine out from a point in all directions. They are the most common lights in computer games - typically used for explosions, light 

bulbs, etc. They have an average cost on the graphics processor (though point light shadows are the most expensive).  

http://unity3d.com/support/documentation/Components/Layers.html
http://unity3d.com/support/documentation/Manual/LightmappingInDepth.html#DualLightmaps
http://unity3d.com/support/documentation/Components/Built-in%20Shader%20Guide.html
http://unity3d.com/support/documentation/Manual/Shadows.html
http://unity3d.com/support/documentation/Manual/Shadows.html


 

Point Light 

Point lights can have cookies - Cubemap texture with alpha channel. This Cubemap gets projected out in all directions.  

 

Point Light with a Cookie 

Spot Lights 

http://unity3d.com/support/documentation/Components/class-Cubemap.html


 

Spot lights only shine in one direction, in a cone. They are perfect for flashlights, car headlights or lamp posts. They are the most expensive 

on the graphics processor.  

 

Spot Light 

Spot lights can also have cookies - a texture projected down the cone of the light. This is good for creating an effect of light shining through 

the window. It is very important that the texture is black at the edges, has Border Mipmaps option on and its wrapping mode is set to 

Clamp. For more info on this, see Textures.  

http://unity3d.com/support/documentation/Components/class-Texture2D.html


 

Spot Light with a Cookie 

Directional Lights 

 

Directional lights are used mainly in outdoor scenes for sun & moonlight. The light affect all surfaces of objects in your scene. They are the 

least expensive on the graphics processor. Shadows from directional lights (for platforms that support shadows) are explained in depth on 

this page.  

http://unity3d.com/support/documentation/Manual/DirectionalShadowDetails.html


 

Directional Light 

When directional light has a cookie, it is projected down the center of the light's Z axis. The size of the cookie is controlled with Cookie Size 

property. Set the cookie texture's wrapping mode to Repeat in the Inspector.  

 

Directional Light projecting a cloud-like cookie texture 

A cookie is a great way to add some quick detail to large outdoor scenes. You can even slide the light slowly over the scene to give the 

impression of moving clouds.  

Performance considerations 



Lights can be rendered in one of two methods: vertex lighting and pixel lighting. Vertex lighting only calculates the lighting at the vertices of 

the game models and interpolates the lighting over the surfaces of the models. Pixel lights are calculated at every screen pixel, and hence 

are much more expensive. Some older graphics cards only support vertex lighting.  

While pixel lighting is slower to render, it does allow some effects that are not possible with vertex lighting. Normal-mapping, light cookies 

and realtime shadows are only rendered for pixel lights. Spotlight shapes and Point light highlights are much better when rendered in pixel 

mode as well. The three light types above would look like this when rendered in vertex light mode:  

 

Point light in Vertex lighting mode. 

 

Spot light in Vertex lighting mode. 



 

Directional light in Vertex lighting mode. 

Lights have a big impact on rendering speed - therefore a tradeoff has to be made betwen lighting quality and game speed. Since pixel 

lights are much more expensive than vertex lights, Unity will only render the brightest lights at per-pixel quality. The actual number of pixel 

lights can be set in the Quality Settings for webplayer and standalone build targets.  

You can explicitly control if a light should be rendered as a vertex or pixel light using the Render Mode property. By default Unity will 

classify the light automatically based on how much the object is affected by the light.  

The actual lights that are rendered as pixel lights are determined on an object-by-object case. This means:  

 Huge objects with bright lights could use all the pixel lights (depending on the quality settings). If the player is far from these, nearby lights 

will be rendered as vertex lights. Therefore, it is better to split huge objects up in a couple of small ones.  

See Optimizing Graphics performance on Desktop, iOS or Android page for more information.  

Creating Cookies 

For more information on creating cookies, please see the tutorial on how to create a Spot light cookie.  

Hints 

 Spot lights with cookies can be extremely effective for making light coming in from windows.  

 Low-intensity point lights are good for providing depth to a scene.  

 For maximum performance, use a VertexLit shader. This shader only does per-vertex lighting, giving a much higher throughput on low-end 

cards.  
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class-Projector 

http://unity3d.com/support/documentation/Components/class-QualitySettings.html
http://unity3d.com/support/documentation/Manual/Optimizing%20Graphics%20Performance.html#DesktopOptimizingGraphicsPerformance
http://unity3d.com/support/documentation/Manual/Optimizing%20Graphics%20Performance.html#iPhoneOptimizingGraphicsPerformance
http://unity3d.com/support/documentation/Manual/Optimizing%20Graphics%20Performance.html#AndroidOptimizingGraphicsPerformance
http://unity3d.com/support/documentation/Manual/HOWTO-LightCookie.html
http://unity3d.com/support/documentation/Components/Built-in%20Shader%20Guide.html


A Projector allows you to project a Material onto all objects that intersect its frustum. The material must use a special type of shader for 

the projection effect to work correctly - see the projector prefabs in Unity's standard assets for examples of how to use the supplied 

Projector/Light and Projector/Multiply shaders.  

 

The Projector Inspector 

Properties 

  

Near Clip Plane Objects in front of the near clip plane will not be projected upon. 

Far Clip Plane Objects beyond this distance will not be affected. 

Field Of View The field of view in degrees. This is only used if the Projector is not Ortho Graphic. 

Aspect Ratio The Aspect Ratio of the Projector. This allows you to tune the height vs width of the Projector. 

Is Ortho Graphic If enabled, the Projector will be Ortho Graphic instead of perspective. 

Ortho Graphic Size The Ortho Graphic size of the Projection. this is only used if Is Ortho Graphic is turned on. 

Material The Material that will be Projected onto Objects. 

Ignore Layers Objects that are in one of the Ignore Layers will not be affected. By default, Ignore Layers is none so all 

geometry that intersects the Projector frustum will be affected. 

Details 

With a projector you can:  

1. Create shadows.  

2. Make a real world projector on a tripod with another Camera that films some other part of the world using a Render Texture.  

3. Create bullet marks.  

4. Funky lighting effects.  

http://unity3d.com/support/documentation/Components/class-Camera.html


 

A Projector is used to create a Blob Shadow for this Robot 

If you want to create a simple shadow effect, simply drag the StandardAssets->Blob-Shadow->Blob shadow projector Prefab into your 

scene. You can modify the Material to use a different Blob shadow texture.  

Note: When creating a projector, always be sure to set the wrap mode of the texture's material of the projector to clamp. else the projector's 

texture will be seen repeated and you will not achieve the desired effect of shadow over your character.  

Hints 

 Projector Blob shadows can create very impressive Splinter Cell-like lighting effects if used to shadow the environment properly.  

 When no Falloff Texture is used in the projector's Material, it can project both forward and backward, creating "double projection". To fix 

this, use an alpha-only Falloff texture that has a black leftmost pixel column.  
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class-Skybox 
Skyboxes are a wrapper around your entire scene that display the vast beyond of your world.  



 

One of the default Skyboxes found under Standard Assets->Skyboxes 

Properties 

  

Material The Material used to render the Skybox, which contains 6 Textures. This Material should use the Skybox 

Shader, and each of the textures should be assigned to the proper global direction. 

Details 

Skyboxes are rendered before anything else in the scene in order to give the impression of complex scenery at the horizon. They are a box 

of 6 textures, one for each primary direction (+/-X, +/-Y, +/-Z).  

You have two options for implementing Skyboxes. You can add them to an individual Camera (usually the main Camera) or you can set up 

a default Skybox in Render Settings's Skybox Material property. The Render Settings is most useful if you want all Cameras in your scene 

to share the same Skybox.  

Adding the Skybox Component to a Camera is useful if you want to override the default Skybox set up in the Render Settings. E.g. You 

might have a split screen game using two Cameras, and want the Second camera to use a different Skybox. To add a Skybox Component 

to a Camera, click to highlight the Camera and go to Component->Rendering->Skybox.  

Unity's Standard Assets contain 2 pre-setup Skybox materials in Standard Assets->Skyboxes.  

If you want to create a new Skybox, use this guide.  

Hints 

 If you have a Skybox assigned to a Camera, make sure to set the Camera's Clear mode to Skybox.  

 It's a good idea to match your Fog color to the skybox's color. Fog color can be set in Render Settings.  
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comp-TransformationGroup 
This group is for all Components that handle object positioning outside of Physics.  

 Transform  
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class-Transform 
The Transform Component determines the actual Position, Rotation, and Scale of all objects in the scene. Every object has a 

Transform.  

 

The Transform Component is viewable and editable in the Inspector 

Properties 

  
Position Position of the Transform in X, Y, and Z coordinates. 

Rotation Rotation of the Transform around the X, Y, and Z axes, measured in degrees. 

Scale Scale of the Transform along X, Y, and Z axes. Value "1" is the original size (size at which the object was 

imported). 

All properties of a Transform are measured relative to the Transform's parent. If the Transform has no parent, the properties are measured 

relative to World Space.  

Using Transforms 

Transforms are always manipulated in 3D space using X, Y, and Z axes. In Unity, these axes are represented by the colors red, green, and 

blue respectively. Remember: XYZ = RGB.  

 

Color-coded relationship between 3 axes and Transform properties 

Transform Components can be directly manipulated using the Scene View or the Inspector. The Inspector will list the properties stated 

above for easy editing. You can also modify Transforms in your Scene by interacting with them, using the Move, Rotate, and Scale tools. 

These tools are located in the upper left-hand corner of the Unity Editor.  

http://unity3d.com/support/documentation/Components/class-Transform.html


 

The View, Translate, Rotate, and Scale tools 

The tools will be usable on any object in your scene. Click on the object, and you will see the tool gizmo appear around it. Depending on 

the current tool, the gizmo will look slightly different. Clicking the object will also cause the Transform component to become visible in the 

Inspector. If the Inspector does not display the Transform component or its properties, then you do not have an object highlighted in the 

Scene View.  

 

 

All three Gizmos can be directly edited in Scene View. 

To manipulate the Transform, click and drag on one of the 3 gizmo axes, you'll notice its color changes. As you drag the mouse, you will 

see the object translate, rotate, or scale along the axis. When you release the mouse button, you'll notice that the axis remains selected. 

You can click the middle mouse button and drag the mouse to manipulate the Transform along the selected axis. To access all 3 axes at 

once click and drag the center point of all 3 gizmos.  

 

Any individual axis will become selected when you click on it 

Parenting 

Parenting is one of the most important concepts to understand when using Unity. When a GameObject is a Parent of another GameObject, 

the Child GameObject will move, rotate, and scale exactly as its Parent does. Just like your arms are attached to your body, when you turn 

your body, your arms move because they're attached. Any object can have multiple children, but only one parent.  

You can create a Parent by dragging any GameObject in the Hierarchy View onto another. This will create a Parent-Child relationship 

between the two GameObjects.  



 

A real-world example of a Parent-Child hierarchy. All the GameObjects with arrows to the left are Parents. 

In the above example, we say that the arms are parented to the body, and the hands are parented to the arms. The scenes you make in 

Unity will contain collections of these Transform hierarchies. The topmost parent object is called the Root object. When you move, scale, 

or rotate a parent, all the changes in its Transform are applied to its children as well.  

It is worth pointing out that the Transform values in the Inspector of any Child GameObject are displayed relative to the Parent's Transform 

values. These are also called the Local Coordinates. Through scripting, you can access the Global Coordinates as well as the Local 

Coordinates.  

You can build compound objects by parenting multiple separate objects together, like the skeletal structure of a human ragdoll. You can 

also create small yet effective objects with single parents. For example, if you have a horror game that takes place at night, you can create 

an effective atmosphere with a flashlight. To create this object, you would parent a spotlight Transform to the flashlight Transform. Then, 

any alteration of the flashlight Transform will affect the spotlight, creating a convincing flashlight effect.  

Importance of Scale 

The scale of the Transform determines the difference between the size of your mesh in your modeling application, and the size of your 

mesh in Unity. The mesh's size in Unity (and therefore the Transform's scale) is very important, especially during physics simulation. There 

are 3 factors that can determine the Scale of your object:  

 The size of your mesh in your 3D modeling application.  

 The Mesh Scale Factor setting in the object's Import Settings.  

 The Scale values of your Transform Component.  

Ideally, you should not adjust the Scale of your object in the Transform Component. The best option is to create your models at real-life 

scale, so you won't have to change your Transform's scale. The second-best option is to adjust the scale at which your mesh is imported in 

the Import Settings for your individual mesh. Certain optimizations occur based on the import size, and instantiating an object that has an 

adjusted scale value can decrease performance. For more information, read through the Rigidbody component's section on optimizing 

scale.  

Hints 

 When parenting Transforms, put the parent's location at 0,0,0 before applying the child. This will save you many headaches later.  

 Particle Systems are not affected by the Transforms Scale. In order to scale a Particle System, you need to modify the properties in the 

System's Particle Emitter, Animator and Renderer.  

http://unity3d.com/support/documentation/Components/class-Rigidbody.html


 If you are using Rigidbodies for physics simulation, there is some important information about the Scale property to be read on the 

Rigidbody page.  

 You can change the colors of the Transform axes (and other UI elements) from the Unity Menu->Preferences->Colors & keys.  

 If you can avoid scaling, do so. Try to have the scales of your object finalized in your 3D modeling application, or in the Import Settings of 

your mesh.  
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comp-UnityGUIGroup 
UnityGUI is the GUI creation system built into Unity. It consists of creating different Controls, and defining the content and appearance of 

those controls.  

The Components of UnityGUI allow you to define the appearance of Controls.  

 GUI Skin  

 GUI Style  

For information about using UnityGUI to create Controls and define their content, please read the GUI Scripting Guide.  
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class-GUISkin 
GUISkins are a collection of GUIStyles that can be applied to your GUI. Each Control type has its own Style definition. Skins are intended 

to allow you to apply style to an entire UI, instead of a single Control by itself.  
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A GUI Skin as seen in the Inspector 

To create a GUISkin, select Assets->Create->GUI Skin from the menubar.  

GUISkins are part of the UnityGUI system. For more detailed information about UnityGUI, please take a look at the GUI Scripting Guide.  

Properties 

All of the properties within a GUI Skin are an individual GUIStyle. Please read the GUIStyle page for more information about how to use 

Styles.  

  

Font The global Font to use for every Control in the GUI 

Box The Style to use for all Boxes 

Button The Style to use for all Buttons 

Toggle The Style to use for all Toggles 

Label The Style to use for all Labels 

Text Field The Style to use for all Text Fields 

Text Area The Style to use for all Text Areas 

Window The Style to use for all Windows 

Horizontal Slider The Style to use for all Horizontal Slider bars 

Horizontal Slider Thumb The Style to use for all Horizontal Slider Thumb Buttons 

Vertical Slider The Style to use for all Vertical Slider bars 

Vertical Slider Thumb The Style to use for all Vertical Slider Thumb Buttons 

Horizontal Scrollbar The Style to use for all Horizontal Scrollbars 

Horizontal Scrollbar 

Thumb 

The Style to use for all Horizontal Scrollbar Thumb Buttons 

Horizontal Scrollbar Left 

Button 

The Style to use for all Horizontal Scrollbar scroll Left Buttons 

Horizontal Scrollbar Right 

Button 

The Style to use for all Horizontal Scrollbar scroll Right Buttons 

Vertical Scrollbar The Style to use for all Vertical Scrollbars 

Vertical Scrollbar Thumb The Style to use for all Vertical Scrollbar Thumb Buttons 
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Vertical Scrollbar Up 

Button 

The Style to use for all Vertical Scrollbar scroll Up Buttons 

Vertical Scrollbar Down 

Button 

The Style to use for all Vertical Scrollbar scroll Down Buttons 

Custom 1-20 Additional custom Styles that can be applied to any Control 

Custom Styles An array of additional custom Styles that can be applied to any Control 

Settings Additional Settings for the entire GUI 

Double Click Selects 

Word 

If enabled, double-clicking a word will select it 

Triple Click Selects Line If enabled, triple-clicking a word will select the entire line 

Cursor Color Color of the keyboard cursor 

Cursor Flash Speed The speed at which the text cursor will flash when editing any Text Control 

Selection Color Color of the selected area of Text 

Details 

When you are creating an entire GUI for your game, you will likely need to do a lot of customization for every different Control type. In many 

different game genres, like real-time strategy or role-playing, there is a need for practically every single Control type.  

Because each individual Control uses a particular Style, it does not make sense to create a dozen-plus individual Styles and assign them 

all manually. GUI Skins take care of this problem for you. By creating a GUI Skin, you have a pre-defined collection of Styles for every 

individual Control. You then apply the Skin with a single line of code, which eliminates the need to manually specify the Style of each 

individual Control.  

Creating GUISkins 

GUISkins are asset files. To create a GUI Skin, select Assets->Create->GUI Skin from the menubar. This will put a new GUISkin in your 

Project View.  

 

A new GUISkin file in the Project View 

Editing GUISkins 

After you have created a GUISkin, you can edit all of the Styles it contains in the Inspector. For example, the Text Field Style will be 

applied to all Text Field Controls.  

http://unity3d.com/support/documentation/Components/class-GUIStyle.html
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Editing the Text Field Style in a GUISkin 

No matter how many Text Fields you create in your script, they will all use this Style. Of course, you have control over changing the styles 

of one Text Field over the other if you wish. We'll discuss how that is done next.  

Applying GUISkins 

To apply a GUISkin to your GUI, you must use a simple script to read and apply the Skin to your Controls.  

http://unity3d.com/support/documentation/Components/class-GUIStyle.html


// Create a public variable where we can assign the GUISkin 

var customSkin : GUISkin; 

 

// Apply the Skin in our OnGUI() function 

function OnGUI () { 

 GUI.skin = customSkin; 

 

 // Now create any Controls you like, and they will be displayed with the custom Skin 

 GUILayout.Button ("I am a re-Skinned Button"); 

 

 // You can change or remove the skin for some Controls but not others 

 GUI.skin = null; 

 

 // Any Controls created here will use the default Skin and not the custom Skin 

 GUILayout.Button ("This Button uses the default UnityGUI Skin"); 

} 

In some cases you want to have two of the same Control with different Styles. For this, it does not make sense to create a new Skin and re-

assign it. Instead, you use one of the Custom Styles in the skin. Provide a Name for the custom Style, and you can use that name as the 

last argument of the individual Control.  

// One of the custom Styles in this Skin has the name "MyCustomControl" 

var customSkin : GUISkin; 

 

function OnGUI () { 

 GUI.skin = customSkin; 

 



 // We provide the name of the Style we want to use as the last argument of the Control function 

 GUILayout.Button ("I am a custom styled Button", "MyCustomControl"); 

 

 // We can also ignore the Custom Style, and use the Skin's default Button Style 

 GUILayout.Button ("I am the Skin's Button Style"); 

} 

For more information about working with GUIStyles, please read the GUIStyle page. For more information about using UnityGUI, please 

read the GUI Scripting Guide.  
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class-GUIStyle 
GUI Styles are a collection of custom attributes for use with UnityGUI. A single GUI Style defines the appearance of a single UnityGUI 

Control.  

http://unity3d.com/support/documentation/Components/class-GUIStyle.html
http://unity3d.com/support/documentation/Components/GUI%20Scripting%20Guide.html


 

A GUI Style in the Inspector 

If you want to add style to more than one control, use a GUI Skin instead of a GUI Style. For more information about UnityGUI, please read 

the GUI Scripting Guide.  

Properties 

  
Name The text string that can be used to refer to this specific Style 

Normal Background image & Text Color of the Control in default state 

Hover Background image & Text Color when the mouse is positioned over the Control 

Active Background image & Text Color when the mouse is actively clicking the Control 

Focused Background image & Text Color when the Control has keyboard focus 

On Normal Background image & Text Color of the Control in enabled state 

On Hover Background image & Text Color when the mouse is positioned over the enabled Control 

On Active Properties when the mouse is actively clicking the enabled Control 

On Focused Background image & Text Color when the enabled Control has keyboard focus 

Border Number of pixels on each side of the Background image that are not affected by the scale of the Control' 

shape 

Padding Space in pixels from each edge of the Control to the start of its contents. 

Margin The margins between elements rendered in this style and any other GUI Controls. 

Overflow Extra space to be added to the background image. 

Font The Font used for all text in this style 

Image Position The way the background image and text are combined. 

Alignment Standard text alignment options. 

Word Wrap If enabled, text that reaches the boundaries of the Control will wrap around to the next line 

Text Clipping If Word Wrap is enabled, choose how to handle text that exceeds the boundaries of the Control 

Overflow Any text that exceeds the Control boundaries will continue beyond the boundaries 

http://unity3d.com/support/documentation/Components/class-GUISkin.html
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Clip Any text that exceeds the Control boundaries will be hidden 

Content Offset Number of pixels along X and Y axes that the Content will be displaced in addition to all other properties 

X Left/Right Offset 

Y Up/Down Offset 

Fixed Width Number of pixels for the width of the Control, which will override any provided Rect() value 

Fixed Height Number of pixels for the height of the Control, which will override any provided Rect() value 

Stretch Width If enabled, Controls using this style can be stretched horizontally for a better layout. 

Stretch Height If enabled, Controls using this style can be stretched vertically for a better layout. 

Details 

GUIStyles are declared from scripts and modified on a per-instance basis. If you want to use a single or few Controls with a custom Style, 

you can declare this custom Style in the script and provide the Style as an argument of the Control function. This will make these Controls 

appear with the Style that you define.  

First, you must declare a GUI Style from within a script.  

/* Declare a GUI Style */ 

var customGuiStyle : GUIStyle; 

 

... 

When you attach this script to a GameObject, you will see the custom Style available to modify in the Inspector.  



 

A Style declared in a script can be modified in each instance of the script 

Now, when you want to tell a particular Control to use this Style, you provide the name of the Style as the last argument in the Control 

function.  

... 

 

function OnGUI () { 

 // Provide the name of the Style as the final argument to use it 

 GUILayout.Button ("I am a custom-styled Button", customGuiStyle); 

 

 // If you do not want to apply the Style, do not provide the name 

 GUILayout.Button ("I am a normal UnityGUI Button without custom style"); 



} 

 

Two Buttons, one with Style, as created by the code example 

For more information about using UnityGUI, please read the GUI Scripting Guide.  
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 Ragdoll Wizard  
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wizard-RagdollWizard 
Unity has a simple wizard that lets you create your own ragdoll in no time. You simply have to drag the different limbs on the respective 

properties in the wizard. Then select create and Unity will automatically generate all Colliders, Rigidbodies and Joints that make up the 

Ragdoll for you.  

Creating the Character 

Ragdolls make use of Skinned Meshes, that is a character mesh rigged up with bones in the 3D modeling application. For this reason, you 

must build ragdoll characters in a 3D package like Maya or Cinema4D.  

When you've created you character and rigged it, save the asset normally in your Project Folder. When you switch to Unity, you'll see the 

character asset file. Select that file and choose Assets->Import Settings... from the menu bar. In the Import Settings dialog, make sure 

that Generate Meshes is not enabled.  

http://unity3d.com/support/documentation/Components/GUI%20Scripting%20Guide.html
http://unity3d.com/support/documentation/Components/wizard-RagdollWizard.html


Using the Wizard 

It's not possible to make the actual source asset into a ragdoll. This would require modifying the source asset file, and is therefore 

impossible. You will make an instance of the character asset into a ragdoll, which can then be saved as a Prefab for re-use.  

Create an instance of the character by dragging it from the Project View to the Hierarchy View. Expand its Transform Hierarchy by 

clicking the small arrow to the left of the instance's name in the Hierarchy. Now you are ready to start assigning your ragdoll parts.  

Open the Ragdoll Wizard by choosing GameObject->Create Other->Ragdoll from the menu bar. You will now see the Wizard itself.  

 

The Ragdoll Wizard 

Assigning parts to the wizard should be self-explanatory. Drag the different Transforms of your character instance to the appropriate 

property on the wizard. This should be especially easy if you created the character asset yourself.  

When you are done, click the Create Button. Now when you enter Play Mode, you will see your character go limp as a ragdoll.  

The final step is to save the setup ragdoll as a Prefab. Choose Assets->Create->Prefab from the menu bar. You will see a New Prefab 

appear in the Project View. Rename it to "Ragdoll Prefab". Drag the ragdoll character instance from the Hierarchy on top of the "Ragdoll 

Prefab". You now have a completely set-up, re-usable ragdoll character to use as much as you like in your game.  
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script-Terrain 
This section will explain how to use the Terrain Engine. It will cover creation, technical details, and other considerations. It is broken into 

the following sections:  



Using Terrains 

This section covers the most basic information about using Terrains. This includes creating Terrains and how to use the new Terrain tools & 

brushes.  

 

Height 

This section explains how to use the different tools and brushes that alter the Height of the Terrain.  

http://unity3d.com/support/documentation/Components/terrain-UsingTerrains.html
http://unity3d.com/support/documentation/Components/terrain-Height.html
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Terrain Textures 

This section explains how to add, paint and blend Terrain Textures using different brushes.  

 

Trees 

This section contains important information for creating your own tree assets. It also covers adding and painting trees on your Terrain.  

http://unity3d.com/support/documentation/Components/terrain-Textures.html
http://unity3d.com/support/documentation/Components/terrain-Trees.html
http://unity3d.com/support/documentation/Components/terrain-Height.html
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Grass 

This section explains how grass works, and how to use it.  

 

Detail Meshes 

This section explains practical usage for detail meshes like rocks, haystacks, vegetation, etc.  

http://unity3d.com/support/documentation/Components/terrain-Grass.html
http://unity3d.com/support/documentation/Components/terrain-DetailMeshes.html
http://unity3d.com/support/documentation/Components/terrain-Trees.html
http://unity3d.com/support/documentation/Components/terrain-Grass.html


 

Lightmaps 

You can lightmap terrains just like any other objects using Unity's built-in lightmapper. See Lightmapping Quickstart for help.  

 

Other Settings 

This section covers all the other settings associated with Terrains.  

 

iOS 
 

Due to performance hit, Terrain Engine usage is discouraged on pre-ipad2 devices.  
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Android 
 

Due to performance hit, Terrain Engine usage is discouraged on non high-end devices.  
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Desktop  
 

Creating a new Terrain 

A new Terrain can be created from Terrain->Create Terrain. This will add a Terrain to your Project and Hierarchy Views.  

 

Your new Terrain will look like this in the Scene View:  

 

A new Terrain in Scene View 
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If you would like a differently sized Terrain, choose Terrain->Set Resolution from the menu bar. There are a number of settings that 

related to Terrain size which you can change from this dialog. 

 

 

Setting the resolution of your terrain. 

 

On the above image, there are values that can be changed. 

These values are:  

 Terrain Width: The width of the Terrain in units.  

 Terrain Height: The height of the Terrain in units.  

 Terrain Length: The length of the Terrain in units.  

 HeightMap Resolution: The HeightMap resolution for the selected Terrain.  

 Detail Resolution: The resolution of the map that controls grass and detail meshes. For performance reasons (to save on draw calls) the 

lower you set this number the better.  

 Control Texture Resolution: The resolution of the splat map used to layer the different textures painted onto the Terrain.  

 Base Texture Resolution: The resolution of the composite texture that is used in place of the splat map at certain distances.  

Navigating the Terrain 

Terrains work a bit differently than other GameObjects. Most notably, there is no Transform Gizmo that allows you to position the Terrain. 

Instead, you use Brushes to paint and manipulate your Terrain. If you do want to reposition a Terrain, you can modify its Transform 

Position values in the Inspector. This allows you to move your Terrain around, but you cannot rotate or scale it.  

While your Terrain is selected in the Hierarchy, you can gracefully navigate the terrain with the F (focus) key. When you press F, wherever 

your mouse is positioned will be moved to the center of the Scene View. This allows you to touch up an area, and quickly zoom over to a 

different area and change something else. If your mouse is not hovering over an area of the Terrain when you press the F key, the entire 

Terrain will be centered in your Scene View.  

Editing the Terrain 

With the Terrain selected, you can look at the Inspector to see some incredible new Terrain editing tools.  



 

Terrain Editing Tools appear in the Inspector 

Each rectangular button is a different Terrain tool. There are tools to change the height, paint splat maps, or attach details like trees or 

rocks. To use a specific tool, click on it. You will then see a short description of the tool appear in text below the tool buttons.  

Most of the tools make use of a brush. Many different brushes are displayed for any tool that uses a brush. To select a brush, just click on 

it. The currently selected brush will display a preview when you hover the mouse over the terrain, at the size you have specified.  

You will use all of these brushes in the Scene View to paint directly onto your Terrain. Simply choose the tool and brush you want, then 

click & drag on the Terrain to alter it in real-time. To paint height, textures, or decorations, you must have the Terrain selected in the 

Hierarchy View.  

Note: When you have a brush selected, move your mouse over the Terrain in the Scene View and press F. This will center the Scene View 

over the mouse pointer position and automatically zoom in to the Brush Size distance. This is the quickest & easiest way to navigate 

around your Terrain while creating it.  

Terrain Keyboard Shortcuts 

While Terrain Inspector is active, those keyboard shortcuts can be used for fast editing (all of them customizable in Unity Preferences):  

 Shift-Q to Shift-Y selects active terrain tool.  

 Comma (,) and dot (.) cycle through active brush.  

 Shift-comma (<) and Shift-dot (>) cycle through active tree/texture/detail object.  

 

iOS 
 

This feature is currently not available for iOS targets.  

 

Android 
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This feature is currently not available for Android targets.  
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Desktop  
 

Using any of the Terrain editing tools is very simple. You will literally paint the Terrain from within the Scene View. For the height tools and 

all others, you just have to select the tool, and click the Terrain in Scene View to manipulate it in real-time.  

Raising & Lowering Height 

The first tool on the left is the Raise Height tool .  

With this tool, you paint brush strokes that will raise the height of the Terrain. Clicking the mouse once will increment the height. Keeping 

the mouse button depressed and moving the mouse will continually raise the height until the maximum height is reached.  

 

You can use any of the brushes to achieve different results  
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If you want to lower the height when you click, hold the Shift key.  

 

Note:When you have a brush selected, move your mouse over the Terrain in the Scene View and press F. This will center the Scene View 

over the mouse pointer position and automatically zoom in to the Brush Size distance. This is the quickest & easiest way to navigate 

around your Terrain while creating it.  

Paint Height 

The second tool from the left is the Paint Height tool .  

This tool allows you to specify a target height, and move any part of the terrain toward that height. Once the terrain reaches the target 

height, it will stop moving and rest at that height.  

To specify the target height, hold Shift and click on the terrain at the height you desire. You can also manually adjust the Height slider in 

the Inspector.  



 

Now you've specified the target height, and any clicks you make on the terrain will move the terrain up or down to reach that height.  

 

Smoothing Height 

The third tool from the left is the Smoothing Height tool .  

This tool allows you to soften any height differences within the area you're painting. Like the other brushes, paint the areas you want to 

smooth in the Scene View.  

 

Working with Heightmaps 

If you like, you can import a greyscale Heightmap created in Photoshop, or from real-world geography data and apply it to your Terrain. To 

do this, choose Terrain->Import Heightmap - Raw..., then select the desired RAW file. You'll then see some import settings. These will be 

set for you, but you have the option of changing the size of your Terrain from this dialog if you like. When you're ready, click the Import 



button. Once the Heightmap has been applied to the Terrain, you can edit it normally with all the Tools described above. Note that the Unity 

Heightmap importer can only import grayscale raw files. Thus you can't create a raw heightmap using RGB channels, you must use 

grayscale.  

Unity works with RAW files which make use of full 16-bit resolution. Any other heightmap editing application like Bryce, Terragen, or 

Photoshop can work with a Unity Heightmap at full resolution.  

You also have the option of exporting your Heightmap to RAW format. Choose Terrain->Export Heightmap - Raw... and you'll see a 

export settings dialog. Make any changes you like, and click Export to save your new Heightmap.  

Unity also provides an easy way to flatten your terrain. Choose Terrain->Flatten.... This lets you flatten your terrain to a height you specify 

in the wizard.  

 

iOS 
 

This feature is currently not available for iOS targets.  

 

Android 
 

This feature is currently not supported by Android targets.  
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Desktop  
 

Decorate the landscape of your terrain by tiling Terrain Textures across the entire terrain. You can blend and combine Terrain Textures to 

make smooth transitions from one map to another, or to keep the surroundings varied.  

Terrain Textures are also called splat maps. What this means is you can define several repeating high resolution textures and blend 

between them arbitrarily, using alpha maps which you paint directly onto the Terrain. Because the textures are not large compared to the 

size of the terrain, the distribution size of the Textures is very small.  

Note: Using an amount of textures in a multiple of four provides the greatest benefit for performance and storage of the Terrain alpha 

maps.  

To being working with textures, click on the Paint Textures button in the Inspector.  

Adding a Terrain Texture 

Before you can begin painting Terrain Textures, you will add at least one to the Terrain from your Project folder. Click the Options Button-

>Add Texture....  
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This will bring up the Add Terrain Texture dialog.  

 

The Add Terrain Texture dialog 

From here, select a tileable texture in the Splat property. You can either drag a texture to the property from the Project View, or choose one 

from the drop-down.  

Now, set the Tile Size X and Tile Size Y properties. The larger the number, the larger each "tile" of the texture will be scaled. Textures with 

large Tile Sizes will be repeated fewer times across the entire Terrain. Smaller numbers will repeat the texture more often with smaller tiles.  

Click the Add Button and you'll see your first Terrain Texture tile across the entire Terrain.  

 

Repeat this process for as many Terrain Textures as you like.  

Painting Terrain Textures 

Once you've added at least two Terrain Textures, you can blend them together in various ways. This part gets really fun, so let's jump right 

to the good stuff.  



Select the Terrain Texture you want to use. The currently selected Terrain Texture will be highlighted in blue.  

 

Select the Brush you want to use. The currently selected Brush will be highlighted in blue.  

 

Select the Brush Size, Opacity, and Target Strength.  

 

Click and drag on the terrain to draw the Terrain Texture.  

 

Use a variety of Textures, Brushes, Sizes, and Opacities to create a great variety of blended styles.  



 

Note:When you have a brush selected, move your mouse over the Terrain in the Scene View and press F. This will center the Scene View 

over the mouse pointer position and automatically zoom in to the Brush Size distance. This is the quickest & easiest way to navigate 

around your Terrain while creating it.  

 

iOS 
 

This feature is currently not available for iOS targets.  

 

Android 
 

This feature is currently not available for Android targets.  
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Unity's Terrain Engine has special support for Trees. You can put thousands of trees onto a Terrain, and render them in-game with a 

practical frame rate. This works by rendering trees near the camera in full 3D, and transitioning far-away trees to 2D billboards. Billboards in 

the distance will automatically update to orient themselves correctly as they are viewed from different angles. This transition system makes 

a detailed tree environment very simple for performance. You have complete control over tweaking the parameters of the mesh-to-billboard 

transition so you can get the best performance you need.  
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You can easily paint lots of trees for beautiful environments like this 

Adding Trees 

Select the Place Trees button in the Inspector.  

Before you can place trees on your terrain, you have to add them to the library of available trees. To do this, click the Edit Trees button-

>Add Tree. You'll see the Add Tree dialog appear.  

 

The Add Tree dialog 

Select the tree from your Project View and drag it to the Tree variable. You can also edit the Bend Factor if you want to add an additional 

bit of animated "bending in the wind" effect to the trees. When you're ready, click Add. The tree will now appear selected in the Inspector.  

 

The newly added tree appears selected in the Inspector 

You can add as many trees as you like. Each one will be selectable in the Inspector for you to place on your Terrain.  



 

The currently selected tree will always be highlighted in blue 

Painting Trees 

While still using the Place Trees tool, click anywhere on the Terrain to place your trees. To erase trees, hold the Shift button and click on 

the Terrain.  

 

Painting trees is as easy as using a paintbrush tool 

There are a number of options at your disposal when placing trees.  

  

Brush Size Radius in meters of the tree placing brush. 

Tree Spacing Percentage of tree width between trees. 

Color Variation Allowed amount of color difference between each tree. 

Tree Height Height adjustment of each tree compared to the asset. 

Height Variation Allowed amount of difference in height between each tree. 

Tree Width Width adjustment of each tree compared to the asset. 

Width Variation Allowed amount of difference in width between each tree. 



Tree Painting Tips 

 

Different Brush sizes cover different area sizes 

 

Adjust Tree Spacing to change the density of the trees you're painting 

Editing Trees 

To change any import parameters for an added tree, select the detail and choose Edit Trees button->Edit Detail. Or double-click the tree 

you want to edit. You will then see the Edit Tree dialog, and you can change any of the settings.  

Mass Placement 

If you don't want to paint your trees and you just want a whole forest created, you can use Terrain->Mass Place Trees. Here, you will see 

the Mass Place Trees dialog. You can set the number of trees you want placed, and they'll be instantly positioned. All the trees added to 

your Terrain will be used in this mass placement.  



 

10,000 Trees placed at once 

Refreshing Source Assets 

If you make any updates to your tree asset source file, it must be manually re-imported into the Terrain. To do this, use Terrain->Refresh 

Tree and Detail Prototypes. This is done after you've changed your source asset and saved it, and will refresh the trees in your Terrain 

immediately.  

Creating Trees 

Trees can be created in two ways to the terrain engine:  

The first one is by using the Tree creator that Unity comes with, and the second one is by using a 3rd party modeling program compatible 

with Unity, in this case every tree should consist of a single mesh with two Materials. One for the trunk and one for the leaves.  

For performance reasons, triangle count should be kept below 2000 for an average tree. The fewer triangles the better. The pivot point of 

the tree mesh must be exactly at the root of the tree, that is at the point where the tree should meet the surface it is placed on. This makes 

it the easiest to import into Unity and other modelling applications.  

Trees must use the Nature/Soft Occlusion Leaves and Nature/Soft Occlusion Bark shader. In order to use those shaders you also 

have to place the tree in a special folder that contains the name "Ambient-Occlusion". When you place a model in that folder and reimport 

it, Unity will calculate soft ambient occlusion specialized for trees. The "Nature/Soft Occlusion" shaders need this information. If you don't 

follow the naming conventions the tree will look weird with completely black parts.  

Unity also ships with several high quality trees in the "Terrain Demo.unitypackage". You can use those trees readily in your game.  

Using Low Poly Trees 

http://unity3d.com/support/documentation/Components/class-Tree.html


 

One branch with leaves is done with only six triangles and shows quite a bit of curvature. You can add more triangles for even more 

curvature. But the main point is: When making trees, work with triangles not with quads. If you use quads you basically need twice as many 

triangles to get the same curvature on branches.  

The tree itself wastes a lot of fillrate by having large polygons but almost everything is invisible due to the alpha. This should be avoided for 

performance reasons and of course because the goal is to make dense trees. This is one of the things that makes Oblivion's trees look 

great. They are so dense you cant even see through the leaves.  

Setting up Tree Collisions 

If you'd like your trees to make use of colliders, it's very easy. When you've imported your Tree asset file, all you need to do is instantiate it 

in the Scene View, add a Capsule Collider and tweak it, and make the GameObject into a new Prefab. Then when you're adding trees to 

your Terrain, you add the tree Prefab with the Capsule Collider attached. You can only use Capsule Colliders when adding collisions with 

trees.  

Making your Trees Collide. 

 

Terrain Collider Inspector 

If you want to make your trees collide with rigid bodies, make sure you you check the Create Tree Colliders box. else your objects will go 

trough the trees you create.  

 

iOS 
 

This feature is currently not available for iOS targets.  

 

Android 
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This feature is currently not available for Android targets.  
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The Paint Foliage button allows you to paint grass, rocks, or other decorations around the 

Terrain. To paint grass, choose Edit Details button->Add Grass Texture. You don't need to create a mesh for grass, just a texture.  

 

The Add Grass Texture dialog 

At this dialog, you can fine-tune the appearance of the grass with the following options:  

  

Detail Texture The texture to be used for the grass. 

Min Width Minimum width of each grass section in meters. 

Max Width Maximum width of each grass section in meters. 

Min Height Minimum height of each grass section in meters. 

Max Height Maximum height of each grass section in meters. 

Noise Spread The size of noise-generated clusters of grass. Lower numbers mean less noise. 

Healthy Color Color of healthy grass, prominent in the center of Noise Spread clusters. 

Dry Color Color of dry grass, prominent on the outer edges of Noise Spread clusters. 

Grayscale Lighting If enabled, grass textures will not be tinted by any colored light shining on the Terrain. 

Lightmap Factor How much the grass will be influenced by the Lightmap. 

Billboard If checked, this grass will always rotate to face the main Camera. 

After you've clicked the Add button, you'll see the grass appear selectable in the Inspector.  
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The added grass appears in the Inspector 

Painting Grass 

Painting grass works the same as painting textures or trees. Select the grass you want to paint, and paint right onto the Terrain in the 

Scene View  

 

Painting grass is easy as pie 

Note:When you have a brush selected, move your mouse over the Terrain in the Scene View and press F. This will center the Scene View 

over the mouse pointer position and automatically zoom in to the Brush Size distance. This is the quickest & easiest way to navigate 

around your Terrain while creating it.  

Editing Grass 

To change any import parameters for a particular Grass Texture, select it choose Edit Details button->Edit. You can also double-click it. 

You will then see the Edit Grass dialog appear, and be able to adjust the parameters described above.  



You'll find that changing a few parameters can make a world of difference. Even changing the Max/Min Width and Height parameters can 

vastly change the way the grass looks, even with the same number of grass objects painted on the Terrain.  

 

Grass created with the default parameters 

 

The same number of painted grass objects, now wider and taller 

 

iOS 
 

This feature is currently not available for iOS targets.  

 

Android 
 

This feature is currently not available for Android targets.  
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Any Terrain decoration that is not trees or grass should be created as a Detail Mesh. This is perfect for things like rocks, 3D shrubbery, or 

other static items. To add these, use the Paint Foliage button . Then choose Edit Details 

button->Add Detail Mesh. You will see the Add Detail Mesh dialog appear.  

 

The Add Detail Mesh dialog 

  

Detail The mesh to be used for the detail. 

Noise Spread The size of noise-generated clusters of the Detail. Lower numbers mean less noise. 

Random Width Limit for the amount of width variance between all detail objects. 

Random Height Limit for the amount of height variance between all detail objects. 

Healthy Color Color of healthy detail objects, prominent in the center of Noise Spread clusters. 

Dry Color Color of dry detail objects, prominent on the outer edges of Noise Spread clusters. 

Grayscale Lighting If enabled, detail objects will not be tinted by any colored light shining on the Terrain. 

Lightmap Factor How much the detail objects will be influenced by the Lightmap. 

Render Mode Select whether this type of detail object will be lit using Grass lighting or normal Vertex lighting. Detail objects 

like rocks should use Vertex lighting. 

After you've clicked the Add button, you'll see the Detail mesh appear in the Inspector. Detail meshes and grass will appear next to each 

other.  
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The added Detail mesh appears in the Inspector, beside any Grass objects 

Painting Detail Meshes 

Painting a Detail mesh works the same as painting textures, trees, or grass. Select the Detail you want to paint, and paint right onto the 

Terrain in the Scene View.  

 

Painting Detail meshes is very simple 

Note: When you have a brush selected, move your mouse over the Terrain in the Scene View and press F. This will center the Scene View 

over the mouse pointer position and automatically zoom in to the Brush Size distance. This is the quickest & easiest way to navigate 

around your Terrain while creating it.  

Editing Details 

To change any import parameters for a Detail Mesh, select it and choose Edit Details button->Edit. You will then see the Edit Detail 

Mesh dialog appear, and be able to adjust the parameters described above.  



Refreshing Source Assets 

If you make any updates to your Detail Mesh asset source file, it must be manually re-imported into the Terrain. To do this, use Terrain-

>Refresh Tree and Detail Prototypes. This is done after you've changed your source asset and saved it, and will refresh the Detail 

Meshes in your Terrain immediately.  

Hints: 

 The UVs of the detail mesh objects need to be in the 0-1 range because all the separate textures used for all the detail meshes are packed 

into a single texture atlas.  

 

iOS 
 

This feature is currently not available for iOS targets.  

 

Android 
 

This feature is currently not available for Android targets.  
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Terrain Lightmapping 
This section will explain how to use the Terrain Engine. It will cover creation, technical details, and other considerations. It is broken into 

the following sections:  

Using Terrains 

This section covers the most basic information about using Terrains. This includes creating Terrains and how to use the new Terrain tools & 

brushes.  
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Height 

This section explains how to use the different tools and brushes that alter the Height of the Terrain.  

 

Terrain Textures 

This section explains how to add, paint and blend Terrain Textures using different brushes.  

http://unity3d.com/support/documentation/Components/terrain-Height.html
http://unity3d.com/support/documentation/Components/terrain-Textures.html
http://unity3d.com/support/documentation/Components/terrain-UsingTerrains.html
http://unity3d.com/support/documentation/Components/terrain-Height.html


 

Trees 

This section contains important information for creating your own tree assets. It also covers adding and painting trees on your Terrain.  

 

Grass 

This section explains how grass works, and how to use it.  

http://unity3d.com/support/documentation/Components/terrain-Trees.html
http://unity3d.com/support/documentation/Components/terrain-Grass.html
http://unity3d.com/support/documentation/Components/terrain-Textures.html
http://unity3d.com/support/documentation/Components/terrain-Trees.html


 

Detail Meshes 

This section explains practical usage for detail meshes like rocks, haystacks, vegetation, etc.  

 

Lightmaps 

You can lightmap terrains just like any other objects using Unity's built-in lightmapper. See Lightmapping Quickstart for help.  

http://unity3d.com/support/documentation/Components/terrain-DetailMeshes.html
http://unity3d.com/support/documentation/Manual/Lightmapping.html
http://unity3d.com/support/documentation/Manual/Lightmapping.html
http://unity3d.com/support/documentation/Components/terrain-Grass.html
http://unity3d.com/support/documentation/Components/terrain-DetailMeshes.html


 

Other Settings 

This section covers all the other settings associated with Terrains.  

 

iOS 
 

Due to performance hit, Terrain Engine usage is discouraged on pre-ipad2 devices.  

 

Android 
 

Due to performance hit, Terrain Engine usage is discouraged on non high-end devices.  
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There are a number of options under the Terrain Settings button in the Terrain Inspector.  
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All additional Terrain Settings 

Base Terrain  

  
Pixel Error Amount of allowable errors in the display of Terrain Geometry. This is essentially a LOD setting. 

Base Map Dist. The distance that Terrain Textures will be displayed in high-resolution. 

Cast Shadows Should terrain cast shadows? 

Tree & Detail Settings  

  

Draw If enabled, all trees, grass, and detail meshes will be drawn. 

Detail Distance Distance from the camera that details will stop being displayed. 

Tree Distance Distance from the camera that trees will stop being displayed. The higher this is, the further-distance trees can 

be seen. 

Billboard Start Distance from the camera that trees will start appearing as Billboards instead of Meshes. 

Fade Length Total distance delta that trees will use to transition from Billboard orientation to Mesh orientation. 

Max Mesh Trees Total number of allowed mesh trees to be capped in the Terrain. 

Wind Settings  

  

Speed The speed that wind blows through grass. 

Size The areas of grass that are affected by wind all at once. 

Bending Amount that grass will bend due to wind. 

Grass Tint Overall tint amount for all Grass and Detail Meshes. 

 

iOS 
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This feature is currently not available for iOS targets.  

 

Android 
 

This feature is currently not available for Android targets.  
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The Tree Creator allows you to create and edit trees procedurally. The resulting trees can be used as normal GameObjects or integrated 

into the Terrain Engine. With this tool, you can create great looking trees quickly and fine tune your trees using a number of design tools to 

achieve the perfect look in your game. The Tree Creator is very useful when you want to create a forest or a jungle where you need 

different tree forms.  

Building Your First Tree 

In this section we walk you step by step to create your first tree in Unity.  
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Tree Creator Structure 

This section provides a general overview of the Tree Creator's user interface.  

 

Branches 

This section focuses on explaining the specific properties of branches.  

http://unity3d.com/support/documentation/Components/tree-Structure.html
http://unity3d.com/support/documentation/Components/tree-Branches.html
http://unity3d.com/support/documentation/Components/tree-Structure.html


 

Leaves 

This section focuses on explaining the specific properties of leaves.  

http://unity3d.com/support/documentation/Components/tree-Leaves.html
http://unity3d.com/support/documentation/Components/tree-Branches.html


 

Wind Zones 

This section explains Wind Zones and how to apply them to your trees.  

 

Trees in the Terrain Engine 

This section of the Terrain Engine Guide covers all the basics of integrating your trees into the Terrain Engine.  

http://unity3d.com/support/documentation/Components/class-WindZone.html
http://unity3d.com/support/documentation/Components/terrain-Trees.html
http://unity3d.com/support/documentation/Components/tree-Leaves.html
http://unity3d.com/support/documentation/Components/class-WindZone.html


 

 

iOS 
 

This feature is currently not supported on iOS targets.  

 

Android 
 

This feature is currently not supported on Android targets.  
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We'll now walk you through the creation of your first Tree Creator Tree in Unity. First, make sure you have included the tree creator 

package in your project. If you don't, select Assets->Import Package..., navigate to your Unity installation folder, and open the folder 

named Standard Packages. Select the Tree Creator.unityPackage package to get the needed assets into your project.  

Adding a new Tree 

To create a new Tree asset, select GameObject->Create Other->Tree.  
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You'll see a new Tree asset is created in your Project View, and instantiated in the currently open Scene. This new Tree is very basic with 

only a single branch, so let's add some character to it.  

Adding Branches 

 

A brand new tree in your scene 

Select the tree to view the Tree Creator in the Inspector. This interface provides all the tools for shaping and sculpting your trees. You will 

see the Tree Hierarchy with two nodes present: the Tree Root node and a single Branch Group node, which we'll call the trunk of the 

tree.  



In the Tree Hierarchy, select the Branch Group, which acts as the trunk of the tree. Click on the Add Branch Group button and you'll see 

a new Branch Group appear connected to the Main Branch. Now you can play with the settings in the Branch Group Properties to see 

alterations of the branches attached to the tree trunk.  

 

Adding branches to the tree trunk. 

After creating the branches that are attached to the trunk, we can now add smaller twigs to the newly created branches by attaching 

another Branch Group node. Select the secondary Branch Group and click the Add Branch Group button again. Tweak the values of 

this group to create more branches that are attached to the secondary branches.  

 

Adding branches to the secondary branches. 

Now the tree's branch structure is in place. Our game doesn't take place in the winter time, so we should also add some Leaves to the 

different branches, right?  

Adding Leaves 

We decorate our tree with leaves by adding Leaf Groups, which basically work the same as the Branch groups we've already used. Select 

your secondary Branch Group node and then click the Add Leaf Group button. If you're really hardcore, you can add another leaf group to 

the tiniest branches on the tree as well.  



 

Leaves added to the secondary and smallest branches 

Right now the leaves are rendered as opaque planes. This is because we want to adjust the leaves' values (size, position, rotation, etc.) 

before we add a material to them. Tweak the Leaf values until you find some settings you like.  

Adding Materials 

In order to make our tree realistic looking, we need to apply Materials for the branches and the leaves. Create a new Material in your 

project using ^Assets->Create->Material. Rename it to "My Tree Bark", and choose Nature->Tree Creator Bark^^ from the Shader drop-

down. From here you can assign the Textures provided in the Tree Creator Package to the Base, Normalmap, and Gloss properties of the 

Bark Material. We recommend using the texture "BigTree_bark_diffuse" for the Base and Gloss properties, and "BigTree_bark_normal" for 

the Normalmap property.  

Now we'll follow the same steps for creating a Leaf Material. Create a new Material and assign the shader as Nature->Tree Creator 

Leaves. Assign the texture slots with the leaf textures from the Tree Creator Package.  



 

Material for the Leaves 

When both Materials are created, we'll assign them to the different Group Nodes of the Tree. Select your Tree and click any Branch or Leaf 

node, then expand the Geometry section of the Branch Group Properties. You will see a Material assignment slot for the type of node 

you've selected. Assign the relevant Material you created and view the results.  



 

Setting the leaves material 

To finish off the tree, assign your Materials to all the Branch and Leaf Group nodes in the Tree. Now you're ready to put your first tree into 

a game!  

 

Tree with materials on leaves and branches. 

Hints. 



 Creating trees is a trial and error process.  

 Don't create too many leaves/branches as this can affect the performance of your game.  

 Check the alpha maps guide for creating custom leaves.  

 

iOS 
 

Trees are not supported yet for iOS builds.  

 

Android 
 

Trees are not supported yet for Android builds.  
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The Tree Creator's inspector is split into three different panes: Hierarchy, Editing Tools and Properties.  

Hierarchy 

The hierarchy view is where you start building your tree. It shows a schematic representation of the tree, where each box is a group of 

nodes. By selecting one of the groups in the hierarchy you can modify its properties. You may also add or remove groups by clicking one of 

the buttons in the toolbar below the hierarchy.  

 

This hierarchy represents a tree with one trunk, 25 child branches. Child branches have in total 70 fronds attached, 280 leaves and 25 

fronds with branches. Node representing the last group is selected. Also the trunk has 25 leaves of one type and 15 of another type, the 

last group is hidden.  
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Tree Stats Status information about your tree, tells you how many vertices, triangles and materials the tree has. 

Delete Node Deletes the currently selected group in the Hierarchy or a node or a spline point in the Scene View. 

Copy Node Copies the currently selected group. 

Add Branch Adds a branch group node to the currently selected group node. 

Add Leaf Adds a leaf group node to the currently selected group node. 

External 

Reload 

Recomputes the whole tree, should be used when the source materials have changed or when a mesh used in Mesh 

Geometry Mode on leaves has changed. 

Nodes in the tree hierarchy represent groups of elements in the tree itself, i.e. branches, leaves or fronds. There are 5 types of nodes:  

Root Node: 

 

This is the starting point of a tree. It determines the global parameters for a tree, such as: quality, seed to diversify the trees, ambient 

occlusion and some material properties.  

Branch Nodes 

 

First branch group node attached to the root node creates trunk(s). The following branch nodes will create child branches. Various shape, 

growth and breaking parameters can be set on this type of node.  

Leaf Node 

 

Leaves can be attached to a root node (e.g. for small bushes) or to branch nodes. Leaves are final nodes, meaning no other nodes can be 

attached to them. Various geometry and distribution parameters can be set on this type of a node.  

Frond Node 

 

It has a similar behavior as the branch node, with some of the shape properties disabled and frond specific ones added.  

Branch + Frond Node 

 

This kind of node is a mixture of a branch and a frond, with properties of both types being accessible.  

Node Parameters 

 Number at the top right of each node represents the number of elements this node created in the tree. The value is related to the frequency 

parameter from the Distribution tab.  

 A node can be visible ( ) or invisible ( ).  

 If a node was edited manually (branch splines or leaves were manipulated in the Scene View) a warning sign will appear over the node (

). In such a case some procedural properties will be disabled.  

Editing Tools  



 

 

While the Tree Creator works with procedural elements, you can decide at any time to modify them by hand to achieve the exact positioning and shape of elements 

you want. 

Once you have edited a group by hand, certain procedural properties will no longer be available. You can, however, always revert it to a 

procedural group by clicking the button displayed in the Branch/Leaf Group Properties.  

Move Select a node or a spline point in the Scene View. Dragging the node allows you to move it along and around its parent. 

Spline points can be moved using the normal move handles. 

Rotate Select a node or a spline point in the Scene View. Both will show the normal rotation handles. 

Free Hand 

Drawing 

Click on a spline point and drag the mouse to draw a new shape. Release the mouse to complete the drawing. Drawing 

always happens on a plane perpendicular to the viewing direction. 

Global Tree Properties 
Every tree has a root node which contains the global properties. This is the least complex group type, but it contains some important 

properties that control the rendering and generation of the entire tree.  

Distribution 

Allows for diversifying trees by changing the Tree Seed and making groups of trees by adjusting the Area Spread when the frequency on 

the branch node connected to the root node is higher than 1.  

 

Tree Seed The global seed that affects the entire tree. Use it to randomize your tree, while keeping the general structure of it. 

Area Spread Adjusts the spread of trunk nodes. Has an effect only if you have more than one trunk. 

Ground Offset Adjusts the offset of trunk nodes on Y axis. 

Geometry 

Allows to set the overall quality of the tree geometry and to control ambient occlusion.  

 

LOD Quality Defines the level-of-detail for the entire tree. A low value will make the tree less complex, a high value will make the tree more 

complex. Check the statistics in the hierarchy view to see the current complexity of the mesh. Depending on the type of the 

tree and your target platform, you may need to adjust this property to make the tree fit within your polygon budget. With 

careful creation of art assets you can produce good looking trees with relatively few polygons. 

Ambient 

Occlusion 

Toggles ambient occlusion on or off. While modifying tree properties ambient occlusion is always hidden and won't be 

recomputed until you finish your changes, e.g. let go a slider. Ambient occlusion can greatly improve the visual quality of your 



tree, but its computation takes time, so you may want to disable it until you are happy with the shape of your tree. 

AO Density Adjusts the density of ambient occlusion. The higher the value the darker the effect. 

Material 

Controls the global material properties of the tree.  

 

Translucency is one of the effects you can control in the Material properties. That property has an effect on leaves, which are translucent 

meaning that they permit the light to pass through them, but they diffuse it on the way.  

Translucency 

Color 

The color that will be multiplied in when the leaves are backlit. 

Translucency 

View Dependency 

Fully view dependent translucency is relative to the angle between the view direction and the light direction. View 

independent is relative to the angle between the leaf's normal vector and the light direction. 

Alpha Cutoff Alpha values from the base texture smaller than the alpha cutoff are clipped creating a cutout. 

Shadow Strength Makes the shadows on the leaves less harsh. Note: Since it scales all the shadowing that the leaves receive, it should 

be used with care for trees that are e.g. in a shadow of a mountain. 

Shadow Offset Scales the values from the Shadow Offset texture set in the source material. It is used to offset the position of the 

leaves when collecting the shadows, so that the leaves appear as if they were not placed on one quad. It's especially 

important for billboarded leaves and they should have brighter values in the center of the texture and darker ones at the 

border. Start out with a black texture and add different shades of gray per leaf. 

Shadow Caster 

Resolution 

Defines the resolution of the texture atlas containing alpha values from source diffuse textures. The atlas is used when 

the leaves are rendered as shadow casters. Using lower resolution might increase performance. 

Branches 
This section focuses on explaining the specific Branch Group Properties.  

Leaves 
This section focuses on explaining the specific Leaf Group Properties.  
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Branch groups node is responsible for generating branches and fronds. Its properties appear when you have selected a branch, frond or 

branch + frond node.  

Distribution 

Adjusts the count and placement of branches in the group. Use the curves to fine tune position, rotation and scale. The curves are relative 

to the parent branch or to the area spread in case of a trunk.  

 

Group Seed The seed for this group of branches. Modify to vary procedural generation. 

Frequency Adjusts the number of branches created for each parent branch. 

Distribution The way the branches are distributed along their parent. 

Twirl Defines how many nodes are in each whorled step when using Whorled distribution. For real plants this is normally a 

Fibonacci number. 

Growth Scale Defines the scale of nodes along the parent node. Use the curve to adjust and the slider to fade the effect in and out. 

Growth 

Angle 

Defines the initial angle of growth relative to the parent. Use the curve to adjust and the slider to fade the effect in and out. 

Geometry 

Select what type of geometry is generated for this branch group and which materials are applied. LOD Multiplier allows you to adjust the 

quality of this group relative to tree's LOD Quality.  



 

LOD Multiplier Adjusts the quality of this group relative to tree's LOD Quality, so that it is of either higher or lower quality than the rest of 

the tree. 

Geometry 

Mode 

Type of geometry for this branch group: Branch Only, Branch + Fronds, Fronds Only. 

Branch 

Material 

The primary material for the branches. 

Break Material Material for capping broken branches. 

Frond Material Material for the fronds. 

Shape 

Adjusts the shape and growth of the branches. Use the curves to fine tune the shape, all curves are relative to the branch itself.  



 

Length Adjusts the length of the branches. 

Relative Length Determines whether the radius of a branch is affected by its length. 

Radius Adjusts the radius of the branches, use the curve to fine-tune the radius along the length of the branches. 

Cap Smoothing Defines the roundness of the cap/tip of the branches. Useful for cacti. 

Growth Adjusts the growth of the branches. 

Crinkliness Adjusts how crinkly/crooked the branches are, use the curve to fine-tune. 

Seek Sun Use the curve to adjust how the branches are bent upwards/downwards and the slider to change the scale. 

Surface 

Noise 

Adjusts the surface noise of the branches. 

Noise Overall noise factor, use the curve to fine-tune. 

Noise Scale U Scale of the noise around the branch, lower values will give a more wobbly look, while higher values gives a more 

stochastic look. 

Noise Scale V Scale of the noise along the branch, lower values will give a more wobbly look, while higher values gives a more 

stochastic look. 

Flare Defines a flare for the trunk. 

Flare Radius The radius of the flares, this is added to the main radius, so a zero value means no flares. 

Flare Height Defines how far up the trunk the flares start. 

Flare Noise Defines the noise of the flares, lower values will give a more wobbly look, while higher values gives a more stochastic 

look. 

 

These properties are for child branches only, not trunks.  

Welding Defines the welding of branches onto their parent branch. Only valid for secondary branches. 

Weld Length Defines how far up the branch the weld spread starts. 

Spread Top Weld's spread factor on the top-side of the branch, relative to it's parent branch. Zero means no spread. 



Spread Bottom Weld's spread factor on the bottom-side of the branch, relative to it's parent branch. Zero means no spread. 

Breaking 

Controls the breaking of branches.  

 

Break Chance Chance of a branch breaking, i.e. 0 = no branches are broken, 0.5 = half of the branches are broken, 1.0 = all the branches 

are broken. 

Break 

Location 

This range defines where the branches will be broken. Relative to the length of the branch. 

Fronds 

Here you can adjust the number of fronds and their properties. This tab is only available if you have Frond geometry enabled in the 

Geometry tab.  

 

Frond Count Defines the number of fronds per branch. Fronds are always evenly spaced around the branch. 

Frond Width The width of the fronds, use the curve to adjust the specific shape along the length of the branch. 

Frond Range Defines the starting and ending point of the fronds. 

Frond Rotation Defines rotation around the parent branch. 

Frond Crease Adjust to crease / fold the fronds. 

Animation 

Adjusts the parameters used for animating this group of branches. The wind zones are only active in Play Mode.  



 

Main Wind Primary wind effect. This creates a soft swaying motion and is typically the only parameter needed for primary branches. 

Main 

Turbulence 

Secondary turbulence effect. Produces more stochastic motion, which is individual per branch. Typically used for 

branches with fronds, such as ferns and palms. 

Edge 

Turbulence 

Turbulence along the edge of fronds. Useful for ferns, palms, etc. 

Create Wind 

Zone 

Creates a Wind Zone. 
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Leaf groups generate leaf geometry. Either from primitives or from user created meshes.  

Distribution 

Adjusts the count and placement of leaves in the group. Use the curves to fine tune position, rotation and scale. The curves are relative to 

the parent branch.  
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Group Seed The seed for this group of leaves. Modify to vary procedural generation. 

Frequency Adjusts the number of leaves created for each parent branch. 

Distribution Select the way the leaves are distributed along their parent. 

Twirl Twirl around the parent branch. 

Whorled Step Defines how many nodes are in each whorled step when using Whorled distribution. For real plants this is normally a 

Fibonacci number. 

Growth Scale Defines the scale of nodes along the parent node. Use the curve to adjust and the slider to fade the effect in and out. 

Growth 

Angle 

Defines the initial angle of growth relative to the parent. Use the curve to adjust and the slider to fade the effect in and out. 

Geometry 

Select what type of geometry is generated for this leaf group and which materials are applied. If you use a custom mesh, its materials will 

be used.  

 

Geometry Mode The type of geometry created. You can use a custom mesh, by selecting the Mesh option, ideal for flowers, fruits, etc. 

Material Material used for the leaves. 

Mesh Mesh used for the leaves. 

Shape 

Adjusts the shape and growth of the leaves.  



 

Size Adjusts the size of the leaves, use the range to adjust the minimum and the maximum size. 

Perpendicular Align Adjusts whether the leaves are aligned perpendicular to the parent branch. 

Horizontal Align Adjusts whether the leaves are aligned horizontally. 

Animation 

Adjusts the parameters used for animating this group of leaves. Wind zones are only active in Play Mode. If you select too high values for 

Main Wind and Main Turbulence the leaves may float away from the branches.  

 

Main Wind Primary wind effect. Usually this should be kept as a low value to avoid leaves floating away from the parent branch. 

Main Turbulence Secondary turbulence effect. For leaves this should usually be kept as a low value. 

Edge Turbulence Defines how much wind turbulence occurs along the edges of the leaves. 
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Wind Zones add realism to the trees you create by making them wave their branches and leaves as if blown by the wind.  
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To the left a Spherical Wind Zone, to the right a Directional Wind zone. 

Properties 

  
Mode 

Spherical Wind zone only has an effect inside the radius, and has a falloff from the center towards the edge. 

Directional Wind zone affects the entire scene in one direction. 

Radius Radius of the Spherical Wind Zone (only active if the mode is set to Spherical). 

Wind Main The primary wind force. Produces a softly changing wind pressure. 

Turbulence The turbulence wind force. Produces a rapidly changing wind pressure. 

Pulse Magnitude Defines how much the wind changes over time. 

Pulse Frequency Defines the frequency of the wind changes. 

Details 

Wind Zones are used only by the tree creator for animating leaves and branches. This can help your scenes appear more natural and 

allows forces (such as explosions) within the game to look like they are interacting with the trees. For more information about how a tree 

works, just visit the tree class page.  

Using Wind Zones in Unity. 

Using Wind Zones in Unity is really simple. 

First of all, to create a new wind zone just click on Game Object -> Create Other -> Wind Zone. 

Place the wind zone (depending on the type) near the trees created with the tree creator and watch it interact with your trees!.  

Note: If the wind zone is Spherical you should place it so that the trees you want to blow are within the sphere's radius. If the wind zone is 

directional it doesn't matter where in the scene you place it.  

Hints 

 To produce a softly changing general wind:  

o Create a directional wind zone.  

o Set Wind Main to 1.0 or less, depending on how powerful the wind should be.  

o Set Turbulence to 0.1.  

o Set Pulse Magnitude to 1.0 or more.  

o Set Pulse Frequency to 0.25.  

 To create the effect of a helicopter passing by:  

o Create a spherical wind zone.  

o Set Radius to something that fits the size of your helicopter  

o Set Wind Main to 3.0  

o Set Turbulence to 5.0  

o Set Pulse Magnitude to 0.1  

o Set Pulse Frequency to 1.0  

o Attach the wind zone to a GameObject resembling your helicopter.  

 To create the effect of an explosion:  

o Do the same as with the helicopter, but fade the Wind Main and Turbulence quickly to make the effect wear off.  

http://unity3d.com/support/documentation/Components/class-Tree.html
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iOS 
 

This feature is currently not supported on iOS targets yet.  

 

Android 
 

This feature is currently not supported on Android targets yet.  
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AnimationEditorGuide 
The Animation View in Unity allows you create and modify Animation Clips directly inside Unity. It is meant to be a powerful and easy 

tool that can supplement external 3D animation programs or even be used instead. It is great for creating simple Animation Clips, and has 

the added benefits of being able to animate variables of materials and components, and add Animation Events to Animation Clips that can 

call script functions at specific points in time.  

For information about importing animations from external programs see the page about Animation import. For information about animating 

characters through scripting see the page about Animation Scripting.  

This Animation View Guide is broken up into different pages that focus on different areas of the Animation View itself. Please visit the 

following pages to build comprehensive knowledge about using the Animation View.  

Using the Animation View 

 

This section covers the most basic information about using the Animation View. This includes creating Animations Clips and how to edit 

them using the Animation Mode.  
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Using Animation Curves 

 

This section covers how to add Animation Curves directly in the Animation View. This includes creating Animation Curves, creating and 

moving keyframes, setting WrapModes, and tips on all the things can be done with Animation Curves.  

Editing Curves 

 

This section covers how to edit Animation Curves directly in the Animation View. This includes efficient navigation, creating and moving 

keys, and editing tangents and tangent types.  

Objects with Multiple Moving Parts 

http://unity3d.com/support/documentation/Components/animeditor-AnimationCurves.html
http://unity3d.com/support/documentation/Components/EditingCurves.html
http://unity3d.com/support/documentation/Components/animeditor-MultipleParts.html
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This section covers how to animate Game Objects with multiple moving parts and how to handle cases where there is more than one 

Animation Component that can control the selected Game Object.  

Using Animation Events 

 

This section covers how to add Animation Events to an Animation Clip. Animation Events lets you call a script function similar to 

SendMessage as part of playing back an animation.  
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The Animation View can be used to preview and edit Animation Clips for animated Game Objects in Unity. The Animation View can be 

opened from the Window->Animation menu.  
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Viewing Animations on a GameObject 

The Animation View is tightly integrated with the Hierarchy View, the Scene View, and the Inspector. Like the Inspector, the Animation 

View will show whatever Game Object is selected. You can select a Game Object to view using the Hierarchy View or the Scene View. (If 

you select a Prefab in the Project View you can inspect its animation curves as well, but you have to drag the Prefab into the Scene View 

in order to be able to edit the curves.)  

 

The Animation View shows the Game Object selected in the Hierarchy View. 

At the left side of the Animation View is a hierarchical list of the animatable properties of the selected Game Object. The list is ordered by 

the Components and Materials attached to the Game Object, just like in the Inspector. Components and Materials can be folded and 

unfolded by clicking the small triangles next to them. If the selected Game Object has any child Game Objects, these will be shown after all 

of the Components and Materials.  



 

The property list to the left in the Animation View shows the Components and Materials of the selected Game Object, just like the Inspector. 

Creating a New Animation Clip 

Animated Game Objects in Unity need an Animation Component that controls the animations. If a Game Object doesn't already have an 

Animation Component, the Animation View can add one for you automatically when creating a new Animation Clip or when entering 

Animation Mode.  

To create a new Animation Clip for the selected Game Object, click the right of the two selection boxes at the upper right of the 

Animation View and select [Create New Clip]. You will then be prompted to save an Animation Clip somewhere in your Assets folder. If 

the Game Object doesn't have an Animation Component already, it will be automatically added at this point. The new Animation Clip will 

automatically be added to the list of Animations in the Animation Component.  

 

Create a new Animation Clip. 

In the Animation View you can always see which Game Object you are animating and which Animation Clip you are editing. There are 

two selection boxes in the upper left of the Animation View. The left selection box shows the Game Object with the Animation 

Component attached, and the right selection box shows the Animation Clip you are editing.  



 

The left selection box shows the Game Object with the Animation Component attached, and the right selection box shows the Animation Clip you are editing. 

Animating a Game Object 

To begin editing an Animation Clip for the selected Game Object, click on the Animation Mode button.  

Click the Animation Mode button to enter Animation Mode. 

This will enter Animation Mode, where changes to the Game Object are stored into the Animation Clip. (If the Game Object doesn't have 

an Animation Component already, it will be automatically added at this point. If there is not an existing Animation Clip, you will be 

prompted to save one somewhere in your Assets folder.)  

You can stop the Animation Mode at any time by clicking the Animation Mode button again. This will revert the Game Object to the 

state it was in prior to entering the Animation Mode.  

You can animate any of the properties shown in the property list of the Animation View. To animate a property, click on the Key Indicator 

for that property and choose Add Curve from the menu. You can also select multiple properties and right click on the selection to add 

curves for all the selected properties at once. (Transform properties are special in that the .x, .y, and .z properties are linked, so that 

curves are added three at a time.)  

 

Any property can be animated by clicking on its Key Indicator or by right clicking on its name. For Transform properties, curves for .x, .y, and .z are added together. 

When in Animation Mode, a red vertical line will show which frame of the Animation Clip is currently previewed. The Inspector and 

Scene View will show the Game Object at that frame of the Animation Clip. The values of the animated properties at that frame are also 

shown in a column to the right of the property names.  



 

In Animation Mode a red vertical line shows the currently previewed frame. The animated values at that frame are previewed in the Inspector and Scene View and to 

the right of the property names in the Animation View. 

You can click anywhere on the Time Line to preview or modify that frame in the Animation Clip. The numbers in the Time Line are shown 

as seconds and frames, so 1:30 means 1 second and 30 frames.  

Click in the Time Line to preview a given frame. 

You can go directly to a specific frame by typing it in, or use the buttons to go to the previous or next keyframe. 

You can also use the following keyboard shortcuts to navigate between frames:  

 Press Comma (,) to go to the previous frame.  

 Press Period (.) to go to the next frame.  

 Hold Alt and press Comma (,) to go to the previous keyframe.  

 Hold Alt and press Period (.) to go to the next keyframe.  

In Animation Mode you can move, rotate, or scale the Game Object in the Scene View. This will automatically create Animation Curves 

for the position, rotation, and scale properties of the Animation Clip if they didn't already exist, and keys on those Animation Curves will 

automatically be created at the currently previewed frame to store the respective Transform values you changed.  

You can also use the Inspector to modify any of the animatable properties of the Game Object. This too will create Animation Curves as 

needed, and create keys on those Animation Curves at the currently previewed frame to store your changed values. Properties that are not 

animatable are grayed out in the Inspector while in Animation Mode.  

The Keyframe button creates a keyframe for the shown curves at the currently previewed frame (shortcut: K). 

You can also manually create a keyframe using the Keyframe button. This will create a key for all the curves that are currently shown in 

the Animation View. If you want to only show curves for a subset of the properties in the property list, you can select those properties. This 

is useful for selectively adding keys to specific properties only.  



 

When selecting a property in the property list, only the curve for that property is shown. 

Playback 

The Animation Clip can be played back at anytime by clicking the Play button in the Animation View.  

Click the Play button to play back the Animation Clip. 

The playback will loop within the time range that is shown in the Time Line. This makes it possible to focus on refining a small part of the 

Animation Clip that is being worked on, without having to play back the entire length of the clip. To play back the whole length of the 

Animation Clip, zoom out to view the entire time range, or press F to Frame Select with no keys selected. To learn more about navigating 

the Curve View, see the section on Editing Animation Curves.  
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The Property List 

In an Animation Clip, any animatable property can have an Animation Curve, which means that the Animation Clip controls that property. 

In the property list of the Animation View properties with Animation Curves have colored curve indicators. For information on how to add 

curves to an animation property, see the section on Using the Animation View.  

A Game Object can have quite a few components and the property list in the Animation View can get very long. To show only the 

properties that have Animation Curves, click the lower left button in the Animation View to set its state to Show: Animated.  

http://unity3d.com/support/documentation/Components/animeditor-AnimationCurves.html
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Set the toggle button in the lower left corner to Show: Animated to hide all the properties without Animation Curves from the property list. 

Understanding Curves, Keys and Keyframes 

An Animation Curve has multiple keys which are control points that the curve passes through. These are visualized in the Curve Editor 

as small diamond shapes on the curves. A frame in which one or more of the shown curves have a key is called a keyframe. The 

keyframes are shown as white diamonds in the Keyframe Line.  

If a property has a key in the currently previewed frame, the curve indicator will have a diamond shape.  

 

The Rotation.y property has a key at the currently previewed frame. The Keyframe Line marks the keyframes for all shown curves. 

The Keyframe Line only shows keyframes for the curves that are shown. If a property is selected in the property list, only that property is 

shown, and the Keyframe Line will not mark the keys of the curves that are not shown.  



 

When a property is selected, other properties are not shown and the keys of their curves are not shown in the Keyframe Line. 

Adding and Moving Keyframes 

 

The Keyframe Line shows the keyframes of the currently shown curves. You can add a keyframe by double-clicking the Keyframe Line or by using the Keyframe 

button. 

A keyframe can be added at the currently previewed frame by clicking the Keyframe button or at any given frame by double-clicking the 

Keyframe Line at the frame where the keyframe should be. This will add a key to all the shown curves at once. It is also possible to add a 

keyframe by right-clicking the Keyframe Line and select Add Keyframe from the context menu. Once placed, keyframes can be dragged 

around with the mouse. It is also possible to select multiple keyframes to drag at once. Keyframes can be deleted by selecting them and 

pressing Delete, or by right-clicking on them and selecting Delete Keyframe from the context menu.  

Wrap Mode 

An Animation Clip in Unity can have various Wrap Modes that can for example set the Animation Clip to loop. See WrapMode in the 

Scripting Reference to learn more. The Wrap Mode of an Animation Clip can be set in the Animation View in the lower right selection box. 

The Curve View will preview the selected Wrap Mode as white lines outside of the time range of the Animation Clip.  

 

Setting the Wrap Mode of an Animation Clip will preview that Wrap Mode in the Curve View. 

http://unity3d.com/support/documentation/ScriptReference/WrapMode.html


Supported Animatable Properties 

The Animation View can be used to animate much more than just the position, rotation, and scale of a Game Object. The properties of 

any Component and Material can be animated - even the public variables of your own scripts components. Making animations with 

complex visual effects and behaviors is only a matter of adding Animation Curves for the relevant properties.  

The following types of properties are supported in the animation system:  

 Float  

 Color  

 Vector2  

 Vector3  

 Vector4  

 Quaternion  

Arrays are not supported and neither are structs or objects other than the ones listed above.  

Booleans in script components are not supported by the animation system, but booleans in certain built-in components are. For those 

booleans, a value of 0 equals False while any other value equals True.  

Here are a few examples of the many things the Animation View can be used for:  

 Animate the Color and Intensity of a Light to make it blink, flicker, or pulsate.  

 Animate the Pitch and Volume of a looping Audio Source to bring life to blowing wind, running engines, or flowing water while keeping the 

sizes of the sound assets to a minimum.  

 Animate the Texture Offset of a Material to simulate moving belts or tracks, flowing water, or special effects.  

 Animate the Emit state and Velocities of multiple Ellipsoid Particle Emitters to create spectacular fireworks or fountain displays.  

 Animate variables of your own script components to make things behave differently over time.  

When using Animation Curves to control game logic, please be aware of the way animations are played back and sampled in Unity.  

Rotation Interpolation Types 

In Unity rotations are internally represented as Quaternions. Quaternions consist of .x, .y, .z, and .w values that should generally not be 

modified manually except by people who know exactly what they're doing. Instead, rotations are typically manipulated using Euler Angles 

which have .x, .y, and .z values representing the rotations around those three respective axes.  

When interpolating between two rotations, the interpolation can either be performed on the Quaternion values or on the Euler Angles 

values. The Animation View lets you choose which form of interpolation to use when animating Transform rotations. However, the 

rotations are always shown in the form of Euler Angles values no matter which interpolation form is used.  

http://unity3d.com/support/documentation/Manual/Animation%20Scripting.html#Playback


 

Transform rotations can use Euler Angles interpolation or Quaternion interpolation. 

Quaternion Interpolation 

Quaternion interpolation always generates nice interpolations along the shortest path between two rotations. This avoids rotation 

interpolation artifacts such as Gimbal Lock. However, Quaternion interpolation cannot represent rotations larger than 180 degrees, because 

it is then shorter to go the other way around. If you use Quaternion interpolation and place two keys further apart than 180 degrees, the 

curve will look discontinuous, even though the actual rotation is still smooth - it simply goes the other way around, because it is shorter. If 

rotations larger than 180 degrees are desired, additional keys must be placed in between. When using Quaternion interpolation, changing 

the keys or tangents of one curve may also change the shapes of the other two curves, since all three curves are created from the internal 

Quaternion representation. When using Quaternion interpolation, keys are always linked, so that creating a key at a specific time for one of 

the three curves will also create a key at that time for the other two curves.  

 

Placing two keys 270 degrees apart when using Quaternion interpolation will cause the interpolated value to go the other way around, which is only 90 degrees. 

Euler Angles Interpolation 

Euler Angles interpolation is what most people are used to working with. Euler Angles can represent arbitrary large rotations and the .x, .y, 

and .z curves are independent from each other. Euler Angles interpolation can be subject to artifacts such as Gimbal Lock when rotating 



around multiple axes at the same time, but are intuitive to work with for simple rotations around one axis at a time. When Euler Angles 

interpolation is used, Unity internally bakes the curves into the Quaternion representation used internally. This is similar to what happens 

when importing animation into Unity from external programs. Note that this curve baking may add extra keys in the process and that 

tangents with the Constant tangent type may not be completely precise at a sub-frame level.  
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EditingCurves 
Curves can be used for many different things and there are several different controls in Unity that use curves that can be edited.  

 The Animation View uses curves to animate properties over time in an Animation Clip. 

 

The Animation View.  

 Script components can have member variables of type AnimationCurve that can be used for all kinds of things. Clicking on those in the 

Inspector will open up the Curve Editor. 

 

The Curve Editor.  
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 The Audio Source component uses curves to control rolloff and other properties as a function of distance to the Audio Source. 

 

Distance function curves in the AudioSource component in the Inspector.  

While these controls have subtle differences, the curves can be edited in the exact same way in all of them. This page explains how to 

navigate and edit curves in those controls.  

Adding and Moving Keys on a Curve 

A key can be added to a curve by double-clicking on the curve at the point where the key should be placed. It is also possible to add a key 

by right-clicking on a curve and select Add Key from the context menu.  

Once placed, keys can be dragged around with the mouse:  

 Click on a key to select it. Drag the selected key with the mouse.  

 To snap the key to the grid while dragging it around, hold down Command on Mac / Control on Windows while dragging.  

It is also possible to select multiple keys at once:  

 To select multiple keys at once, hold down Shift while clicking the keys.  

 To deselect a selected key, click on it again while holding down Shift.  

 To select all keys within a rectangular area, click on an empty spot and drag to form the rectangle selection.  

 The rectangle selection can also be added to existing selected keys by holding down Shift.  

Keys can be deleted by selecting them and pressing Delete, or by right-clicking on them and selecting Delete Key from the context menu.  

Navigating the Curve View 

When working with the Animation View you can easily zoom in on details of the curves you want to work with or zoom out to get the full 

picture.  

You can always press F to frame-select the shown curves or selected keys in their entirely.  

Zooming 

You can zoom the Curve View using the scroll-wheel of your mouse, the zoom functionality of your trackpad, or by holding Alt while right-

dragging with your mouse.  

You can zoom on only the horizontal or vertical axis:  

http://unity3d.com/support/documentation/Components/class-AudioSource.html


 zoom while holding down Command on Mac / Control on Windows to zoom horizontally.  

 zoom while holding down Shift to zoom vertically.  

Furthermore, you can drag the end caps of the scrollbars to shrink or expand the area shown in the Curve View.  

Panning 

You can pan the Curve View by middle-dragging with your mouse or by holding Alt while left-dragging with your mouse.  

Editing Tangents 

A key has two tangents - one on the left for the ingoing slope and one on the right for the outgoing slope. The tangents control the shape 

of the curve between the keys. The Animation View have multiple tangent types that can be used to easily control the curve shape. The 

tangent types for a key can be chosen by right-clicking the key.  

 

Right-click a key to select the tangent type for that key. 

In order for animated values to change smoothly when passing a key, the left and right tangent must be co-linear. The following tangent 

types ensure smoothness:  

 Auto: The tangents are automatically set so make the curve go smoothly through the key. 

 

 Free Smooth: The tangents can be freely set by dragging the tangent handles. They are locked to be co-linear to ensure smoothness. 

 



 Flat: The tangents are set to be horizontal. (This is a special case of Free Smooth.) 

 

Sometimes smoothness is not desired. The left and right tangent can be set individually when the tangents are Broken. The left and right 

tangent can each be set to one of the following tangent types:  

 Free: The tangent can be freely set by dragging the tangent handle. 

 

 Linear: The tangent points towards the neighboring key. A linear curve segment can be made by setting the tangents at both ends to be 

Linear. 

 

 Constant: The curve retains a constant value between two keys. The value of the left key determines the value of the curve segment. 
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animeditor-MultipleParts 



You may want to animate Game Objects that have multiple moving parts, such as a gun turret with a moving barrel, or a character with 

many body parts. There is always one Game Object that controls the animation of all the movable parts, and that is the Game Object that 

has the Animation Component on it.  

The Animation Component attached to a Game Object can control that Game Object and any of its child Game Objects. However, if the 

Game Object has a parent, the parent cannot be controlled, since it can only control things that are lower in the hierarchy than itself. For 

this reason, if you want to create an animation with multiple moving parts, the Animation Component must be attached to a Game Object 

that is higher in the hierarchy than (or equal to) all the movable parts. Thus, the Animation Component is often placed on the root Game 

Object.  

Animating Child Game Objects 

When you edit Animation Clips with the Animation View, the animation data will always be stored relative to the Game Object with the 

Animation Component. The Game Object with the Animation Component is shown at all times in the leftmost selection box in the 

Animation View.  

You can animate a child Game Object by unfolding that Game Object in the property list of the Animation View - just click the small 

triangle.  

 

Child Game Objects can be unfolded in the property list of the Animation View. 

Alternatively you can just select the child Game Object you want to animate by clicking it in the Hierarchy View. When a child Game 

Objects is selected in the Hierarchy View, only that Game Object is shown in the property list of the Animation View. However, the 

animation data is still stored relative to the Game Object with the Animation Component, which is shown in the left of the two selection 

boxes.  



 

The child Game Objects selected in the Hierarchy View is shown in the Animation View. The Game Object with the Animation Component is shown in the left of 

the two selection boxes. 

Handling Multiple Animation Components 

If a Game Object has an Animation Component and one of its parent Game Objects also have an Animation Component, the leftmost 

selection box can be used to select which Animation Component to animate according to.  

 

If you want to animate a Game Object relative to a different Animation Component than the nearest one, just select it in the left selection box. 

As an example, you may have a multiple characters (Hero and Sidekick) that each have an Animation Component that is used for playing 

back Animation Clips for running and jumping etc. At the same time you may have a Game Object with an Animation Component used 

for controlling cutscenes. A cutscene could have both Hero and Sidekick walking around, animating their global positions in the scene. In 

order for the CutsceneController to be able to control the positions of the Hero and Sidekick, it must have them as child Game Objects.  

Now, if the Hero Game Object is selected in the Hierarchy, the Animation View will as default assume that you want to edit the animations 

of the Hero Game Object itself - since it has its own Animation Component. If you want to animate the Hero Game Object as part of a 

cutscene controlled by the CutsceneController, you need to tell that to the Animation View: Just select the CutsceneController in the left 

selection box.  
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animeditor-AnimationEvents 
The Animation View lets you add Animation Events to Animation Clips. Animation Events lets you call a script function similar to 

SendMessage as part of playing back an animation.  

Animation Events support functions that take zero or one parameter. The parameter can be a float, a string, an object reference, or an 

AnimationEvent. In the case of functions that take an AnimationEvent as parameter, both a float, a string, and an object reference can 

be specified. These three will be passed as member variables of the AnimationEvent.  



// This JavaScript function can be called by an Animation Event 

function PrintFloat (theValue : float) { 

 Debug.Log ("PrintFloat is called with a value of " + theValue); 

} 

An Animation Event can be added to an Animation Clip at the currently previewed frame by clicking the Event button or at any given 

frame by double-clicking the Event Line at the frame where the Animation Event should be. It is also possible to add an Animation Event 

by right-clicking the Event Line and select Add Event from the context menu. Once placed, Animation Events can be dragged around 

with the mouse. It is also possible to select multiple Animation Events to drag at once. Animation Events can be deleted by selecting 

them and pressing Delete, or by right-clicking on them and selecting Delete Event from the context menu.  

 

Animation Events are shown in the Event Line. Add a new Animation Event by double-clicking the Event Line or by using the Event button. 

Adding an Animation Event will add a marker in the Event Line and open a Animation Event dialog. In the dialog you can specify which 

script function to call and fill in the parameter value to pass to the function.  

 

The Animation Event popup dialog lets you specify which function to call and fill in the parameter values. 

All the Animation Events in an Animation Clip are shown as markers in the Event Line. You can quickly get see what a specific 

Animation Event does by holding the mouse cursor over the marker.  



 

Holding the mouse cursor over an Animation Event marker will show which function it calls as well as the parameter value. 
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GUI Scripting Guide 

Overview 

GUI stands for Graphical User Interface. Unity's GUI system is called UnityGUI. UnityGUI allows you to create a huge variety of GUIs 

complete with functionality very quickly and easily. Rather than creating a GUI object, manually positioning it, and then writing a script that 

handles its functionality, you do all of this at once in a small amount of code. This works by creating GUI Controls, which are instantiated, 

positioned, and defined all at once.  

For example, the following code will create a fully functional button from scratch:  

function OnGUI () { 

 if (GUI.Button (Rect (10,10,150,100), "I am a button")) { 

  print ("You clicked the button!"); 

 } 

} 



 

This is the button created by the code above 

Although this example is very simple, there are very powerful and complex techniques available for use in UnityGUI. It is a broad subject, 

and the following sections will help you get up to speed as quickly as possible. This guide can be read straight through, or used as 

reference material.  

UnityGUI Basics 

This section covers the important concepts of UnityGUI, giving you an overview as well as a bunch of working examples you can paste into 

your own projects. UnityGUI is very friendly to play with, so this is a good place to get started.  

Controls 

This section lists every available Control in UnityGUI. It is complete with code examples and images.  

Customization 

Creating functional GUI controls would not be as useful if their appearances couldn't be customized. Thankfully, we've thought of this. All 

controls in UnityGUI can be customized with GUIStyles and GUISkins. This section explains how to use them.  

Layout Modes 

UnityGUI features two ways to arrange your GUIs. You can manually place each control on the screen, or you can use an Automatic Layout 

system which works a lot like HTML tables. Using one system or the other is as simple as using a different class, and you can mix the two 

together. This section explains the functional differences between the two systems, including examples.  

Extending UnityGUI 

UnityGUI is very easy to extend with new Control types. This chapter shows you how to make simple compound controls - complete with 

integration into Unity's event system.  

Extending Unity Editor 

The main Unity editor is written using UnityGUI. It is completely extensible using the same code as you would use for in-game GUI. In 

addition, there are a bunch of Editor specific GUI widgets to help you out when creating custom editor GUI.  
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gui-Basics 
This section will explain the bare necessities for scripting Controls with UnityGUI.  

Making Controls with UnityGUI 

UnityGUI controls make use of a special function called OnGUI(). The OnGUI() function gets called every frame as long as the containing 

script is enabled - just like the Update() function.  

GUI controls themselves are very simple in structure. This structure is evident in the following example.  

/* Example level loader */ 

 

function OnGUI () { 

 // Make a background box 

 GUI.Box (Rect (10,10,100,90), "Loader Menu"); 

 

 // Make the first button. If it is pressed, Application.Loadlevel (1) will be executed 

 if (GUI.Button (Rect (20,40,80,20), "Level 1")) { 

  Application.LoadLevel (1); 

 } 

 

 // Make the second button. 

 if (GUI.Button (Rect (20,70,80,20), "Level 2")) { 

  Application.LoadLevel (2); 

 } 

} 

This example is a complete, functional level loader. If you copy/paste this script and attach it a GameObject, you'll see the following menu 

appear in when you enter Play Mode:  



 

The Loader Menu created by the example code 

Let's take a look at the details of the example code:  

The first GUI line, GUI.Box (Rect (10,10,100,90), "Loader Menu"); displays a Box Control with the header text "Loader Menu". It follows 

the typical GUI Control declaration scheme which we'll explore momentarily.  

The next GUI line is a Button Control declaration. Notice that it is slightly different from the Box Control declaration. Specifically, the entire 

Button declaration is placed inside an if statement. When the game is running and the Button is clicked, this if statement returns true and 

any code inside the if block is executed.  

Since the OnGUI() code gets called every frame, you don't need to explicitly create or destroy GUI controls. The line that declares the 

Control is the same one that creates it. If you need to display Controls at specific times, you can use any kind of scripting logic to do so.  

/* Flashing button example */ 

 

function OnGUI () { 

 if (Time.time % 2 < 1) { 

  if (GUI.Button (Rect (10,10,200,20), "Meet the flashing button")) { 

   print ("You clicked me!"); 

  } 

 } 



} 

Here, GUI.Button() only gets called every other second, so the button will appear and disappear. Naturally, the user can only click it when 

the button is visible.  

As you can see, you can use any desired logic to control when GUI Controls are displayed and functional. Now we will explore the details 

of each Control's declaration.  

Anatomy of a Control 

There are three key pieces of information required when declaring a GUI Control:  

Type (Position, Content)  

Observe that this structure is a function with two arguments. We'll explore the details of this structure now.  

Type 

Type is the Control Type, and is declared by calling a function in Unity's GUI class or the GUILayout class, which is discussed at length in 

the Layout Modes section of the Guide. For example, GUI.Label() will create a non-interactive label. All the different control types are 

explained later, in the Controls section of the Guide.  

Position 

The Position is the first argument in any GUI Control function. The argument itself is provided with a Rect() function. Rect() defines four 

properties: left-most position, top-most position, total width, total height. All of these values are provided in integers, which 

correspond to pixel values. All UnityGUI controls work in Screen Space, which is the resolution of the published player in pixels.  

The coordinate system is top-left based. Rect(10, 20, 300, 100) defines a Rectangle that starts at coordinates: 0,20 and ends at 

coordinates 310,120. It is worth repeating that the second pair of values in Rect() are total width and height, not the coordinates where the 

controls end. This is why the example mentioned above ends at 310,120 and not 300,100.  

You can use the Screen.width and Screen.height properties to get the total dimensions of the screen space available in the player. The 

following example may help clarify how this is done:  

/* Screen.width & Screen.height example */ 

 

function OnGUI () { 

 GUI.Box (Rect (0,0,100,50), "Top-left"); 

 GUI.Box (Rect (Screen.width - 100,0,100,50), "Top-right"); 

 GUI.Box (Rect (0,Screen.height - 50,100,50), "Bottom-left"); 

 GUI.Box (Rect (Screen.width - 100,Screen.height - 50,100,50), "Bottom-right"); 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.html
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The Boxes positioned by the above example 

Content 

The second argument for a GUI Control is the actual content to be displayed with the Control. Most often you will want to display some text 

or an image on your Control. To display text, pass a string as the Content argument like this:  

/* String Content example */ 

 

function OnGUI () { 

 GUI.Label (Rect (0,0,100,50), "This is the text string for a Label Control"); 

} 

To display an image, declare a Texture2D public variable, and pass the variable name as the content argument like this:  

/* Texture2D Content example */ 

 

var controlTexture : Texture2D; 

 

function OnGUI () { 

 GUI.Label (Rect (0,0,100,50), controlTexture); 



} 

Here is an example closer to a real-world scenario:  

/* Button Content examples */ 

 

var icon : Texture2D; 

 

function OnGUI () { 

 if (GUI.Button (Rect (10,10, 100, 50), icon)) { 

  print ("you clicked the icon"); 

 } 

 

 if (GUI.Button (Rect (10,70, 100, 20), "This is text")) { 

  print ("you clicked the text button"); 

 } 

} 



 

The Buttons created by the above example 

There is a third option which allows you to display images and text together in a GUI Control. You can provide a GUIContent object as the 

Content argument, and define the string and image to be displayed within the GUIContent.  

/* Using GUIContent to display an image and a string */ 

 

var icon : Texture2D; 

 

function OnGUI () { 

 GUI.Box (Rect (10,10,100,50), GUIContent("This is text", icon)); 

} 

You can also define a Tooltip in the GUIContent, and display it elsewhere in the GUI when the mouse hovers over it.  

/* Using GUIContent to display a tooltip */ 

 

function OnGUI () { 

 // This line feeds "This is the tooltip" into GUI.tooltip 

 GUI.Button (Rect (10,10,100,20), GUIContent ("Click me", "This is the tooltip")); 



 // This line reads and displays the contents of GUI.tooltip 

 GUI.Label (Rect (10,40,100,20), GUI.tooltip); 

} 

If you're daring you can also use GUIContent to display a string, an icon, and a tooltip!  

/* Using GUIContent to display an image, a string, and a tooltip */ 

 

var icon : Texture2D; 

 

function OnGUI () { 

 GUI.Button (Rect (10,10,100,20), GUIContent ("Click me", icon, "This is the tooltip")); 

 GUI.Label (Rect (10,40,100,20), GUI.tooltip); 

} 

The scripting reference page for GUIContent's constructor for an extensive list of examples.  
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gui-Controls 

Control Types 

There are a number of different GUI Controls that you can create. This section lists all of the available display and interactive Controls. 

There are other GUI functions that affect layout of Controls, which are described in the Layout section of the Guide.  

Label 

The Label is non-interactive. It is for display only. It cannot be clicked or otherwise moved. It is best for displaying information only.  

/* GUI.Label example */ 

 

function OnGUI () { 

 GUI.Label (Rect (25, 25, 100, 30), "Label"); 

} 

http://unity3d.com/support/documentation/ScriptReference/GUIContent.GUIContent.html
http://unity3d.com/support/documentation/Components/gui-Layout.html
http://unity3d.com/support/documentation/ScriptReference/GUI.Label.html


 

The Label created by the example code 

Button 

The Button is a typical interactive button. It will respond a single time when clicked, no matter how long the mouse remains depressed. The 

response occurs as soon as the mouse button is released.  

Basic Usage 
In UnityGUI, Buttons will return true when they are clicked. To execute some code when a Button is clicked, you wrap the the GUI.Button 

function in an if statement. Inside the if statement is the code that will be executed when the Button is clicked.  

/* GUI.Button example */ 

 

function OnGUI () { 

 if (GUI.Button (Rect (25, 25, 100, 30), "Button")) { 

  // This code is executed when the Button is clicked 

 } 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.Button.html


 

The Button created by the example code 

RepeatButton 

RepeatButton is a variation of the regular Button. The difference is, RepeatButton will respond every frame that the mouse button 

remains depressed. This allows you to create click-and-hold functionality.  

Basic Usage 
In UnityGUI, RepeatButtons will return true for every frame that they are clicked. To execute some code while the Button is being clicked, 

you wrap the the GUI.RepeatButton function in an if statement. Inside the if statement is the code that will be executed while the 

RepeatButton remains clicked.  

/* GUI.RepeatButton example */ 

 

function OnGUI () { 

 if (GUI.RepeatButton (Rect (25, 25, 100, 30), "RepeatButton")) { 

  // This code is executed every frame that the RepeatButton remains clicked 

 } 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.RepeatButton.html


 

The Repeat Button created by the example code 

TextField 

The TextField Control is an interactive, editable single-line field containing a text string.  

Basic Usage 
The TextField will always display a string. You must provide the string to be displayed in the TextField. When edits are made to the string, 

the TextField function will return the edited string.  

/* GUI.TextField example */ 

 

var textFieldString = "text field"; 

 

function OnGUI () { 

 textFieldString = GUI.TextField (Rect (25, 25, 100, 30), textFieldString); 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.TextField.html


 

The TextField created by the example code 

TextArea 

The TextArea Control is an interactive, editable multi-line area containing a text string.  

Basic Usage 
The TextArea will always display a string. You must provide the string to be displayed in the TextArea. When edits are made to the string, 

the TextArea function will return the edited string.  

/* GUI.TextArea example */ 

 

var textAreaString = "text area"; 

 

function OnGUI () { 

 textAreaString = GUI.TextArea (Rect (25, 25, 100, 30), textAreaString); 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.TextArea.html


 

The TextArea created by the example code 

Toggle 

The Toggle Control creates a checkbox with a persistent on/off state. The user can change the state by clicking on it.  

Basic Usage 
The Toggle on/off state is represented by a true/false boolean. You must provide the boolean as a parameter to make the Toggle represent 

the actual state. The Toggle function will return a new boolean value if it is clicked. In order to capture this interactivity, you must assign the 

boolean to accept the return value of the Toggle function.  

/* GUI.Toggle example */ 

 

var toggleBool = true; 

 

function OnGUI () { 

 toggleBool = GUI.Toggle (Rect (25, 25, 100, 30), toggleBool, "Toggle"); 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.Toggle.html


 

The Toggle created by the example code 

Toolbar 

The Toolbar Control is essentially a row of Buttons. Only one of the Buttons on the Toolbar can be active at a time, and it will remain 

active until a different Button is clicked. This behavior emulates the behavior of a typical Toolbar. You can define an arbitrary number of 

Buttons on the Toolbar.  

Basic Usage 
The active Button in the Toolbar is tracked through an integer. You must provide the integer as an argument in the function. To make the 

Toolbar interactive, you must assign the integer to the return value of the function. The number of elements in the content array that you 

provide will determine the number of Buttons that are shown in the Toolbar.  

/* GUI.Toolbar example */ 

 

var toolbarInt = 0; 

var toolbarStrings : String[] = ["Toolbar1", "Toolbar2", "Toolbar3"]; 

 

function OnGUI () { 

 toolbarInt = GUI.Toolbar (Rect (25, 25, 250, 30), toolbarInt, toolbarStrings); 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.Toolbar.html


 

The Toolbar created by the example code 

SelectionGrid 

The SelectionGrid Control is a multi-row Toolbar. You can determine the number of columns and rows in the grid. Only one Button can be 

active at time.  

Basic Usage 
The active Button in the SelectionGrid is tracked through an integer. You must provide the integer as an argument in the function. To make 

the SelectionGrid interactive, you must assign the integer to the return value of the function. The number of elements in the content array 

that you provide will determine the number of Buttons that are shown in the SelectionGrid. You also can dictate the number of columns 

through the function arguments.  

/* GUI.SelectionGrid example */ 

 

var selectionGridInt : int = 0; 

var selectionStrings : String[] = ["Grid 1", "Grid 2", "Grid 3", "Grid 4"]; 

 

function OnGUI () { 

 selectionGridInt = GUI.SelectionGrid (Rect (25, 25, 100, 30), selectionGridInt, selectionStrings, 2); 

 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.SelectionGrid.html


 

The SelectionGrid created by the example code 

HorizontalSlider 

The HorizontalSlider Control is a typical horizontal sliding knob that can be dragged to change a value between predetermined min and 

max values.  

Basic Usage 
The position of the Slider knob is stored as a float. To display the position of the knob, you provide that float as one of the arguments in the 

function. There are two additional values that determine the minimum and maximum values. If you want the slider knob to be adjustable, 

assign the slider value float to be the return value of the Slider function.  

/* Horizontal Slider example */ 

 

var hSliderValue : float = 0.0; 

 

function OnGUI () { 

 hSliderValue = GUI.HorizontalSlider (Rect (25, 25, 100, 30), hSliderValue, 0.0, 10.0); 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.HorizontalSlider.html


 

The Horizontal Slider created by the example code 

VerticalSlider 

The VerticalSlider Control is a typical vertical sliding knob that can be dragged to change a value between predetermined min and max 

values.  

Basic Usage 
The position of the Slider knob is stored as a float. To display the position of the knob, you provide that float as one of the arguments in the 

function. There are two additional values that determine the minimum and maximum values. If you want the slider knob to be adjustable, 

assign the slider value float to be the return value of the Slider function.  

/* Vertical Slider example */ 

 

var vSliderValue : float = 0.0; 

 

function OnGUI () { 

 vSliderValue = GUI.VerticalSlider (Rect (25, 25, 100, 30), vSliderValue, 10.0, 0.0); 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.VerticalSlider.html


 

The Vertical Slider created by the example code 

HorizontalScrollbar 

The HorizontalScrollbar Control is similar to a Slider Control, but visually similar to Scrolling elements for web browsers or word 

processors. This control is used to navigate the ScrollView Control.  

Basic Usage 
Horizontal Scrollbars are implemented identically to Horizontal Sliders with one exception: There is an additional argument which controls 

the width of the Scrollbar knob itself.  

/* Horizontal Scrollbar example */ 

 

var hScrollbarValue : float; 

 

function OnGUI () { 

 hScrollbarValue = GUI.HorizontalScrollbar (Rect (25, 25, 100, 30), hScrollbarValue, 1.0, 0.0, 10.0); 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.HorizontalScrollbar.html


 

The Horizontal Scrollbar created by the example code 

VerticalScrollbar 

The VerticalScrollbar Control is similar to a Slider Control, but visually similar to Scrolling elements for web browsers or word processors. 

This control is used to navigate the ScrollView Control.  

Basic Usage 
Vertical Scrollbars are implemented identically to Vertical Sliders with one exception: There is an additional argument which controls the 

height of the Scrollbar knob itself.  

/* Vertical Scrollbar example */ 

 

var vScrollbarValue : float; 

 

function OnGUI () { 

 vScrollbarValue = GUI. VerticalScrollbar (Rect (25, 25, 100, 30), vScrollbarValue, 1.0, 10.0, 0.0); 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.VerticalScrollbar.html


 

The Vertical Scrollbar created by the example code 

ScrollView 

ScrollViews are Controls that display a viewable area of a much larger set of Controls.  

Basic Usage 
ScrollViews require two Rects as arguments. The first Rect defines the location and size of the viewable ScrollView area on the screen. 

The second Rect defines the size of the space contained inside the viewable area. If the space inside the viewable area is larger than the 

viewable area, Scrollbars will appear as appropriate. You must also assign and provide a 2D Vector which stores the position of the 

viewable area that is displayed.  

/* ScrollView example */ 

 

var scrollViewVector : Vector2 = Vector2.zero; 

var innerText : String = "I am inside the ScrollView"; 

 

function OnGUI () { 

 // Begin the ScrollView 

 scrollViewVector = GUI.BeginScrollView (Rect (25, 25, 100, 100), scrollViewVector, Rect (0, 0, 400, 400)); 

 

 // Put something inside the ScrollView 

http://unity3d.com/support/documentation/ScriptReference/GUI.BeginScrollView.html


 innerText = GUI.TextArea (Rect (0, 0, 400, 400), innerText); 

 

 // End the ScrollView 

 GUI.EndScrollView(); 

} 

 

The ScrollView created by the example code 

Window 

Windows are drag-able containers of Controls. They can receive and lose focus when clicked. Because of this, they are implemented 

slightly differently from the other Controls. Each Window has an id number, and its contents are declared inside a separate function that is 

called when the Window has focus.  

Basic Usage 
Windows are the only Control that require an additional function to work properly. You must provide an id number and a function name to 

be executed for the Window. Inside the Window function, you create your actual behaviors or contained Controls.  

/* Window example */ 

 

var windowRect : Rect = Rect (20, 20, 120, 50); 

 

function OnGUI () { 

 windowRect = GUI.Window (0, windowRect, WindowFunction, "My Window"); 

} 

http://unity3d.com/support/documentation/ScriptReference/GUI.Window.html


 

function WindowFunction (windowID : int) { 

 // Draw any Controls inside the window here 

} 

 

The Window created by the example code 

GUI.changed 

To detect if the user did any action in the GUI (clicked a button, dragged a slider, etc), read the GUI.changed value from your script. This 

gets set to true when the user has done something, making it easy to validate the user input.  

A common scenario would be for a Toolbar, where you want to change a specific value based on which Button in the Toolbar was clicked. 

You don't want to assign the value in every call to OnGUI(), only when one of the Buttons has been clicked.  

/* GUI.changed example */ 

 

private var selectedToolbar : int = 0; 

private var toolbarStrings = ["One", "Two"]; 

 

function OnGUI () { 

http://unity3d.com/support/documentation/ScriptReference/GUI-changed.html


 // Determine which button is active, whether it was clicked this frame or not 

 selectedToolbar = GUI.Toolbar (Rect (50, 10, Screen.width - 100, 30), selectedToolbar, toolbarStrings); 

 

 // If the user clicked a new Toolbar button this frame, we'll process their input 

 if (GUI.changed) 

 { 

  print ("The toolbar was clicked"); 

 

  if (selectedToolbar == 0) 

  { 

   print ("First button was clicked"); 

  } 

  else 

  { 

   print ("Second button was clicked"); 

  } 

 } 

} 

GUI.changed will return true if any GUI Control placed before it was manipulated by the user.  
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gui-Customization 

Customizing your GUI Controls 

Functional Controls are necessary for your game, and the appearance of those controls is very important for the aesthetics of your game. In 

UnityGUI, you can fine-tune the appearance of your Controls with many details. Control appearances are dictated with GUIStyles. By 



default, when you create a Control without defining a GUIStyle, Unity's default GUIStyle is applied. This style is internal in Unity and can be 

used in published games for quick prototyping, or if you choose not to stylize your Controls.  

When you have a large number of different GUIStyles to work with, you can define them all within a single GUISkin. A GUISkin is no more 

than a collection of GUIStyles.  

How Styles change the look of your GUI Controls 

GUIStyles are designed to mimic Cascading Style Sheets (CSS) for web browsers. Many different CSS methodologies have been adapted, 

including differentiation of individual state properties for styling, and separation between the content and the appearance.  

Where the Control defines the content, the Style defines the appearance. This allows you to create combinations like a functional Toggle 

which looks like a normal Button.  

 

Two Toggle Controls styled differently 

The difference between Skins and Styles 

As stated earlier, GUISkins are a collection of GUIStyles. Styles define the appearance of a GUI Control. You do not have to use a Skin if 

you want to use a Style.  



 

A single GUIStyle shown in the Inspector 



 

A single GUISkin shown in the Inspector - observe that it contains multiple GUIStyles  

Working with Styles 

All GUI Control functions have an optional last parameter: the GUIStyle to use for displaying the Control. If this is omitted, Unity's default 

GUIStyle will be used. This works internally by applying the name of the control type as a string, so GUI.Button() uses the "button" style, 

GUI.Toggle() uses the "toggle" style, etc. You can override the default GUIStyle for a control by specifying it as the last parameter.  

/* Override the default Control Style with a different style in the UnityGUI default Styles */ 

 

function OnGUI () { 

 // Make a label that uses the "box" GUIStyle. 

 GUI.Label (Rect (0,0,200,100), "Hi - I'm a label looking like a box", "box"); 

 

 // Make a button that uses the "toggle" GUIStyle 

 GUI.Button (Rect (10,140,180,20), "This is a button", "toggle"); 

} 



 

The controls created by the code example above 

Making a public variable GUIStyle 

When you declare a public GUIStyle variable, all elements of the Style will show up in the Inspector. You can edit all of the different values 

there.  

/* Overriding the default Control Style with one you've defined yourself */ 

 

var customButton : GUIStyle; 

 

function OnGUI () { 

 // Make a button. We pass in the GUIStyle defined above as the style to use 

 GUI.Button (Rect (10,10,150,20), "I am a Custom Button", customButton); 

} 

Changing the different style elements 

When you have declared a GUIStyle, you can modify that style in the Inspector. There are a great number of States you can define, and 

apply to any type of Control.  



 

Styles are modified on a per-script, per-GameObject basis 

Any Control State must be assigned a Background Color before the specified Text Color will be applied.  

For more information about individual GUIStyles, please read the GUIStyle Component Reference page.  

Working with Skins 

For more complicated GUI systems, it makes sense to keep a collection of styles in one place. This is what a GUISkin does. A GUISkin 

contains multiple different Styles, essentially providing a complete face-lift to all GUI Controls.  

Creating a new GUISkin 

To create a GUISkin, select Assets->Create->GUI Skin from the menu bar. This will create a GUI Skin in your Project Folder. Select it to 

see all GUIStyles defined by the Skin in the Inspector.  

Applying the skin to a GUI 

To use a skin you've created, assign it to GUI.skin in your OnGUI() function.  

/* Make a property containing a reference to the skin you want to use */ 

 

var mySkin : GUISkin; 

http://unity3d.com/support/documentation/Components/class-GUIStyle.html


 

function OnGUI () { 

 // Assign the skin to be the one currently used. 

 GUI.skin = mySkin; 

 

 // Make a button. This will get the default "button" style from the skin assigned to mySkin. 

 GUI.Button (Rect (10,10,150,20), "Skinned Button"); 

} 

You can switch skins as much as you like throughout a single OnGUI() call.  

/* Example of switching skins in the same OnGUI() call */ 

 

var mySkin : GUISkin; 

 

var toggle = true; 

 

function OnGUI () { 

 // Assign the skin to be the one currently used. 

 GUI.skin = mySkin; 

 

 // Make a toggle. This will get the "button" style from the skin assigned to mySkin. 

 toggle = GUI.Toggle (Rect (10,10,150,20), toggle, "Skinned Button", "button"); 

 

 // Assign the currently skin to be Unity's default. 

 GUI.skin = null; 



 

 // Make a button. This will get the default "button" style from the built-in skin. 

 GUI.Button (Rect (10,35,150,20), "Built-in Button"); 

} 
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gui-Layout 

Fixed Layout vs Automatic Layout 

There are two different modes you can use to arrange and organize your GUIs: Fixed and Automatic. Up until now, every UnityGUI 

example provided in this guide has used Fixed Layout. To use Automatic Layout, write GUILayout instead of GUI when calling control 

functions. You do not have to use one Layout mode over the other, and you can use both modes at once in the same OnGUI() function.  

Fixed Layout makes sense to use when you have a pre-designed interface to work from. Automatic Layout makes sense to use when you 

don't know how many elements you need up front, or don't want to worry about hand-positioning each Control. For example, if you are 

creating a number of different buttons based on Save Game files, you don't know exactly how many buttons will be drawn. In this case 

Automatic Layout might make more sense. It is really dependent on the design of your game and how you want to present your interface.  

There are two key differences when using Automatic Layout:  

 GUILayout is used instead of GUI  

 No Rect() function is required for Automatic Layout Controls  

/* Two key differences when using Automatic Layout */ 

 

function OnGUI () { 

 // Fixed Layout 

 GUI.Button (Rect (25,25,100,30), "I am a Fixed Layout Button"); 

 

 // Automatic Layout 

 GUILayout.Button ("I am an Automatic Layout Button"); 

} 

Arranging Controls 



Depending on which Layout Mode you're using, there are different hooks for controlling where your Controls are positioned and how they 

are grouped together. In Fixed Layout, you can put different Controls into Groups. In Automatic Layout, you can put different Controls into 

Areas, Horizontal Groups, and Vertical Groups  

Fixed Layout - Groups 

Groups are a convention available in Fixed Layout Mode. They allow you to define areas of the screen that contain multiple Controls. You 

define which Controls are inside a Group by using the GUI.BeginGroup() and GUI.EndGroup() functions. All Controls inside a Group will 

be positioned based on the Group's top-left corner instead of the screen's top-left corner. This way, if you reposition the group at runtime, 

the relative positions of all Controls in the group will be maintained.  

As an example, it's very easy to center multiple Controls on-screen.  

/* Center multiple Controls on the screen using Groups */ 

 

function OnGUI () { 

 // Make a group on the center of the screen 

 GUI.BeginGroup (Rect (Screen.width / 2 - 50, Screen.height / 2 - 50, 100, 100)); 

 // All rectangles are now adjusted to the group. (0,0) is the topleft corner of the group. 

 

 // We'll make a box so you can see where the group is on-screen. 

 GUI.Box (Rect (0,0,100,100), "Group is here"); 

 GUI.Button (Rect (10,40,80,30), "Click me"); 

 

 // End the group we started above. This is very important to remember! 

 GUI.EndGroup (); 

} 



 

The above example centers controls regardless of the screen resolution 

You can also nest multiple Groups inside each other. When you do this, each group has its contents clipped to its parent's space.  

/* Using multiple Groups to clip the displayed Contents */ 

 

var bgImage : Texture2D; // background image that is 256 x 32 

var fgImage : Texture2D; // foreground image that is 256 x 32 

var playerEnergy = 1.0; // a float between 0.0 and 1.0 

 

function OnGUI () { 

 // Create one Group to contain both images 

 // Adjust the first 2 coordinates to place it somewhere else on-screen 

 GUI.BeginGroup (Rect (0,0,256,32)); 

 

 // Draw the background image 

 GUI.Box (Rect (0,0,256,32), bgImage); 



 

 // Create a second Group which will be clipped 

 // We want to clip the image and not scale it, which is why we need the second Group 

 GUI.BeginGroup (Rect (0,0,playerEnergy * 256, 32)); 

 

 // Draw the foreground image 

 GUI.Box (Rect (0,0,256,32), fgImage); 

 

 // End both Groups 

 GUI.EndGroup (); 

 GUI.EndGroup (); 

} 

 

You can nest Groups together to create clipping behaviors 

Automatic Layout - Areas 

Areas are used in Automatic Layout mode only. They are similar to Fixed Layout Groups in functionality, as they define a finite portion of 

the screen to contain GUILayout Controls. Because of the nature of Automatic Layout, you will nearly always use Areas.  



In Automatic Layout mode, you do not define the area of the screen where the Control will be drawn at the Control level. The Control will 

automatically be placed at the upper-leftmost point of its containing area. This might be the screen. You can also create manually-

positioned Areas. GUILayout Controls inside an area will be placed at the upper-leftmost point of that area.  

/* A button placed in no area, and a button placed in an area halfway across the screen. */ 

 

function OnGUI () { 

 GUILayout.Button ("I am not inside an Area"); 

 GUILayout.BeginArea (Rect (Screen.width/2, Screen.height/2, 300, 300)); 

 GUILayout.Button ("I am completely inside an Area"); 

 GUILayout.EndArea (); 

} 

Notice that inside an Area, Controls with visible elements like Buttons and Boxes will stretch their width to the full length of the Area.  

Automatic Layout - Horizontal and Vertical Groups 

When using Automatic Layout, Controls will by default appear one after another from top to bottom. There are plenty of occasions you will 

want finer level of control over where your Controls are placed and how they are arranged. If you are using the Automatic Layout mode, 

you have the option of Horizontal and Vertical Groups.  

Like the other layout Controls, you call separate functions to start or end these groups. The specific functions are 

GUILayout.BeginHoriztontal(), GUILayout.EndHorizontal(), GUILayout.BeginVertical(), and GUILayout.EndVertical().  

Any Controls inside a Horizontal Group will always be laid out horizontally. Any Controls inside a Vertical Group will always be laid out 

vertically. This sounds plain until you start nesting groups inside each other. This allows you to arrange any number of controls in any 

imaginable configuration.  

/* Using nested Horizontal and Vertical Groups */ 

 

var sliderValue = 1.0; 

var maxSliderValue = 10.0; 

 

function OnGUI() 

{ 

 // Wrap everything in the designated GUI Area 



 GUILayout.BeginArea (Rect (0,0,200,60)); 

 

 // Begin the singular Horizontal Group 

 GUILayout.BeginHorizontal(); 

 

 // Place a Button normally 

 if (GUILayout.RepeatButton ("Increase max\nSlider Value")) 

 { 

  maxSliderValue += 3.0 * Time.deltaTime; 

 } 

 

 // Arrange two more Controls vertically beside the Button 

 GUILayout.BeginVertical(); 

 GUILayout.Box("Slider Value: " + Mathf.Round(sliderValue)); 

 sliderValue = GUILayout.HorizontalSlider (sliderValue, 0.0, maxSliderValue); 

 

 // End the Groups and Area 

 GUILayout.EndVertical(); 

 GUILayout.EndHorizontal(); 

 GUILayout.EndArea(); 

} 



 

Three Controls arranged with Horizontal & Vertical Groups 

Using GUILayoutOptions to define some controls 

You can use GUILayoutOptions to override some of the Automatic Layout parameters. You do this by providing the options as the final 

parameters of the GUILayout Control.  

Remember in the Areas example above, where the button stretches its width to 100% of the Area width? We can override that if we want 

to.  

/* Using GUILayoutOptions to override Automatic Layout Control properties */ 

 

function OnGUI () { 

 GUILayout.BeginArea (Rect (100, 50, Screen.width-200, Screen.height-100)); 

 GUILayout.Button ("I am a regular Automatic Layout Button"); 

 GUILayout.Button ("My width has been overridden", GUILayout.Width (95)); 

 GUILayout.EndArea (); 

} 

For a full list of possible GUILayoutOptions, please read the GUILayoutOption Scripting Reference page.  
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gui-Extending 
There are a number of ways to leverage and extend UnityGUI to meet your needs. Controls can be mixed and created, and you have a lot 

of leverage into dictating how user input into the GUI is processed.  

Compound Controls 

There might be situations in your GUI where two types of Controls always appear together. For example, maybe you are creating a 

Character Creation screen, with several Horizontal Sliders. All of those Sliders need a Label to identify them, so the player knows what they 

are adjusting. In this case, you could partner every call to GUI.Label() with a call to GUI.HorizontalSlider(), or you could create a 

Compound Control which includes both a Label and a Slider together.  

/* Label and Slider Compound Control */ 

 

var mySlider : float = 1.0; 

 

function OnGUI () { 

 mySlider = LabelSlider (Rect (10, 100, 100, 20), mySlider, 5.0, "Label text here"); 

} 

 

function LabelSlider (screenRect : Rect, sliderValue : float, sliderMaxValue : float, labelText : String) : float { 

 GUI.Label (screenRect, labelText); 

 screenRect.x += screenRect.width; // <- Push the Slider to the end of the Label 

 sliderValue = GUI.HorizontalSlider (screenRect, sliderValue, 0.0, sliderMaxValue); 

 return sliderValue; 

} 

In this example, calling LabelSlider() and passing the correct arguments will provide a Label paired with a Horizontal Slider. When writing 

Compound Controls, You have to remember to return the correct value at the end of the function to make it interactive.  



 

The above Compound Control always creates this pair of Controls 

Static Compound Controls 

By using Static functions, you can create an entire collection of your own Compound Controls that are self-contained. This way, you do not 

have to declare your function in the same script you want to use it.  

/* This script is called CompoundControls */ 

 

static function LabelSlider (screenRect : Rect, sliderValue : float, sliderMaxValue : float, labelText : String) : float { 

 GUI.Label (screenRect, labelText); 

 screenRect.x += screenRect.width; // <- Push the Slider to the end of the Label 

 sliderValue = GUI.HorizontalSlider (screenRect, sliderValue, 0.0, sliderMaxValue); 

 return sliderValue; 

} 

By saving the above example in a script called CompoundControls, you can call the LabelSlider() function from any other script by simply 

typing CompoundControls.LabelSlider() and providing your arguments.  

Elaborate Compound Controls 

You can get very creative with Compound Controls. They can be arranged and grouped in any way you like. The following example creates 

a re-usable RGB Slider.  



/* RGB Slider Compound Control */ 

 

var myColor : Color; 

 

function OnGUI () { 

 myColor = RGBSlider (Rect (10,10,200,10), myColor); 

} 

 

function RGBSlider (screenRect : Rect, rgb : Color) : Color { 

 rgb.r = GUI.HorizontalSlider (screenRect, rgb.r, 0.0, 1.0); 

 screenRect.y += 20; // <- Move the next control down a bit to avoid overlapping 

 rgb.g = GUI.HorizontalSlider (screenRect, rgb.g, 0.0, 1.0); 

 screenRect.y += 20; // <- Move the next control down a bit to avoid overlapping 

 rgb.b = GUI.HorizontalSlider (screenRect, rgb.b, 0.0, 1.0); 

 return rgb; 

} 



 

The RGB Slider created by the example above 

Now let's build Compound Controls on top of each other, in order to demonstrate how Compound Controls can be used within other 

Compound Controls. To do this, we will create a new RGB Slider like the one above, but we will use the LabelSlider to do so. This way we'll 

always have a Label telling us which slider corresponds to which color.  

/* RGB Label Slider Compound Control */ 

 

var myColor : Color; 

 

function OnGUI () { 

 myColor = RGBLabelSlider (Rect (10,10,200,20), myColor); 

} 

 

function RGBLabelSlider (screenRect : Rect, rgb : Color) : Color { 

 rgb.r = CompoundControls.LabelSlider (screenRect, rgb.r, 1.0, "Red"); 

 screenRect.y += 20; // <- Move the next control down a bit to avoid overlapping 

 rgb.g = CompoundControls.LabelSlider (screenRect, rgb.g, 1.0, "Green"); 



 screenRect.y += 20; // <- Move the next control down a bit to avoid overlapping 

 rgb.b = CompoundControls.LabelSlider (screenRect, rgb.b, 1.0, "Blue"); 

 return rgb; 

} 

 

The Compound RGB Label Slider created by the above code 
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gui-ExtendingEditor 

Introduction 

You can create your own custom design tools inside Unity through Editor Windows. Scripts that derive from EditorWindow instead of 

MonoBehaviour can leverage both GUI/GUILayout and EditorGUI/EditorGUILayout controls. Alternatively, you can use Custom Inspectors 

to expose these GUI controls in your GameObject Inspector.  

Editor Windows 

You can create any number of custom windows in your app. These behave just like the Inspector, Scene or any other built-in ones. This is 

a great way to add a user interface to a sub-system for your game.  

http://unity3d.com/support/documentation/ScriptReference/EditorWindow.html
http://unity3d.com/support/documentation/ScriptReference/MonoBehaviour.html
http://unity3d.com/support/documentation/ScriptReference/EditorGUI.html
http://unity3d.com/support/documentation/ScriptReference/GUI.html
http://unity3d.com/support/documentation/ScriptReference/GUILayout.html
http://unity3d.com/support/documentation/ScriptReference/EditorGUILayout.html


 

Custom Editor Interface by Serious Games Interactive used for scripting cutscene actions 

Making a custom Editor Window involves the following simple steps:  

 Create a script that derives from EditorWindow.  

 Use code to trigger the window to display itself.  

 Implement the GUI code for your tool.  

Derive From EditorWindow 

In order to make your Editor Window, your script must be stored inside a folder called "Editor". Make a class in this script that derives from 

EditorWindow. Then write your GUI controls in the inner OnGUI function.  

class MyWindow extends EditorWindow { 

    function OnGUI () { 

        // The actual window code goes here 

    } 

} 

MyWindow.js - placed in a folder called 'Editor' within your project.  

Showing the window 

In order to show the window on screen, make a menu item that displays it. This is done by creating a function which is activated by the 

MenuItem property.  

The default behavior in Unity is to recycle windows (so selecting the menu item again would show existing windows. This is done by using 

the function EditorWindow.GetWindow Like this:  

class MyWindow extends EditorWindow { 

    @MenuItem ("Window/My Window") 

    static function ShowWindow () { 

        EditorWindow.GetWindow (MyWindow); 

    } 

http://unity3d.com/support/documentation/ScriptReference/EditorWindow.GetWindow.html


 

    function OnGUI () { 

        // The actual window code goes here 

    } 

} 

Showing the MyWindow  

This will create a standard, dockable editor window that saves its position between invocations, can be used in custom layouts, etc. To 

have more control over what gets created, you can use GetWindowWithRect  

Implementing Your Window's GUI 

The actual contents of the window are rendered by implementing the OnGUI function. You can use the same UnityGUI classes you use for 

your ingame GUI (GUI and GUILayout). In addition we provide some additional GUI controls, located in the editor-only classes EditorGUI 

and EditorGUILayout. These classes add to the controls already available in the normal classes, so you can mix and match at will.  

For more info, take a look at the example and documentation on the EditorWindow page.  

Custom Inspectors 

A key to increasing the speed of game creation is to create custom inspectors for commonly used components. For the sake of example, 

we'll use this very simple script that always keeps an object looking at a point.  

var lookAtPoint = Vector3.zero; 

 

function Update () { 

    transform.LookAt (lookAtPoint); 

} 

LookAtPoint.js  

This will keep an object oriented towards a world-space point. Let's make it cool!  

The first step to making it work nicely in the editor is to make the script run even when you're not testing the game. We do this by adding an 

ExecuteInEditMode attribute to it:  

@script ExecuteInEditMode() 

 

var lookAtPoint = Vector3.zero; 

http://unity3d.com/support/documentation/ScriptReference/EditorWindow.GetWindowWithRect.html
http://unity3d.com/support/documentation/ScriptReference/EditorWindow.html


 

function Update () { 

    transform.LookAt (lookAtPoint); 

} 

Try adding the script to your main camera and drag it around in the Scene view.  

Making a Custom Editor 

This is all well and good, but we can make the inspector for it a lot nicer by customizing the inspector. To do that we need to create an 

Editor for it. Create a JavaScript called LookAtPointEditor in a folder called Editor.  

@CustomEditor (LookAtPoint) 

class LookAtPointEditor extends Editor { 

    function OnInspectorGUI () { 

        target.lookAtPoint = EditorGUILayout.Vector3Field ("Look At Point", target.lookAtPoint); 

        if (GUI.changed) 

            EditorUtility.SetDirty (target); 

    } 

} 

This class has to derive from Editor. The @CustomEditor attribute informs Unity which component it should act as an editor for.  

The code in OnInspectorGUI is exectued whenever Unity displays the inspector. You can put any GUI code in here - it works just like 

OnGUI does for games, but is run inside the inspector. Editor defines the target property that you can use to access the object being 

inspected.  

The EditorUtility.SetDirty code is executed if the user has changed any of the values by checking GUI.changed.  

In this case, we make one of the Vector3 fields like is used in the Transform Inspector - like so:  

 

Yay for shiny inspectors 



There's a lot more that can be done here, but this will do for now - We've got bigger fish to fry...  

Scene View Additions 

You can add extra code to the Scene View by implementing an OnSceneGUI in your custom editor. In this case, we'll add a second set of 

position handles, letting users drag the look-at point around in the Scene view.  

@CustomEditor (LookAtPoint) 

class LookAtPointEditor extends Editor { 

    function OnInspectorGUI () { 

        target.lookAtPoint = EditorGUILayout.Vector3Field ("Look At Point", target.lookAtPoint); 

        if (GUI.changed) 

            EditorUtility.SetDirty (target); 

    } 

 

    function OnSceneGUI () { 

        target.lookAtPoint = Handles.PositionHandle (target.lookAtPoint, Quaternion.identity); 

        if (GUI.changed) 

            EditorUtility.SetDirty (target); 

    } 

} 

OnSceneGUI works just like OnInspectorGUI - except it gets run in the scene view. To help you make your editing interface, you can use 

the functions defined in Handles class. All functions in there are designed for working in 3D Scene views.  

If you want to put 2D GUI objects (GUI, EditorGUI and friends), you need to wrap them in calls to Handles.BeginGUI() and 

Handles.EndGUI().  
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Network Reference Guide 
Networking is a very large, detailed topic. In Unity, it is extremely simple to create network functionality. However, it is still best to 

understand the breadth and depth involved with creating any kind of network game. The following page will explain the fundamentals of 

networking concepts, and the Unity-specific executions of these concepts for you to use. If you have never created a network game before, 

it is highly recommended that you read this guide in detail before attempting to create one.  

http://unity3d.com/support/documentation/ScriptReference/Handles.html


High Level Overview 

This section will outline all the concepts involved in networking. It will serve as an introduction to deeper topics.  

Networking Elements in Unity 

This section of the guide will cover Unity's execution of the ideas discussed above.  

Network View 

Network Views are Components you use to share data across the network. They are extremely important to understand. This page will 

explain them in detail.  

RPC Details 

RPC stands for Remote Procedure Call. It is a way of calling a function on a remote machine. This may be a client calling a function on the 

server, or the server calling a function on all or specific clients, etc. This page explains RPC concepts in detail.  

State Synchronization 

State Synchronization is a method of regularly updating a specific set of data across two or more game instances running on the network.  

Network Instantiate 

One difficult subject in networking is ownership of an object. Who controls what? Network Instantiation will determine this logic for you. This 

page will explain how to do this. It will also explain the complex alternatives, for situations when you just need more control.  

Master Server 

The Master Server is like a game lobby where servers can advertise their presence to clients. It is also a solution to enabling 

communication from behind a firewall or home network. When needed it makes it possible to use a technique called NAT punchthrough 

(with help from a facilitator) to make sure your players can always connect with each other. This page will explain how to use the Master 

Server.  

Minimizing Bandwidth 

Every choice you make about where and how to share data will affect the bandwidth your game uses. This page will share some details 

about bandwidth usage and how to keep it to a minimum.  

 

iOS 
 

Special details about networking on iOS 

Boot up with Networking for iOS.  

 

Android 
 

Special details about networking on Android 
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Networking on iOS 

iOS and Android 

http://unity3d.com/support/documentation/Components/net-HighLevelOverview.html
http://unity3d.com/support/documentation/Components/net-UnityNetworkElements.html
http://unity3d.com/support/documentation/Components/net-NetworkView.html
http://unity3d.com/support/documentation/Components/net-RPCDetails.html
http://unity3d.com/support/documentation/Components/net-StateSynchronization.html
http://unity3d.com/support/documentation/Components/net-NetworkInstantiate.html
http://unity3d.com/support/documentation/Components/net-MasterServer.html
http://unity3d.com/support/documentation/Components/net-MinimizingBandwidth.html
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
javascript:ShowHideDiv('iosRef','specific-ios',%20'iOS');
http://unity3d.com/support/documentation/Components/Networking%20on%20iOS.html
javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
javascript:ShowHideDiv('androidRef','specific-android',%20'Android');
http://unity3d.com/support/documentation/Components/Networking%20on%20iOS.html
javascript:ShowHideDiv('iosRef','specific-ios', 'iOS');
javascript:ShowHideDiv('androidRef','specific-android', 'Android');


Networking for mobile devices (iOS / Android) 

Unity iOS/Android Networking engine is fully compatible to Unity Networking, so all your networking code should work on iOS/Android 

devices. However you may want to re-engineer your code and adapt it for Wi-Fi or even cellular networks. Moreover depending on the 

mobile, the networking chip may also be the bottleneck as even in high performance Wi-Fi networks pings between mobile devices (or 

between the mobile device and the desktop) are about 40-60 ms.  

Using Networking you can create a game that can be played simultaneously from desktop and iOS over Wi-Fi or cellular networks. In latter 

case your game server should have public IP (accessible through internet).  

Note: EDGE / 3G data connections go to sleep very quickly when no data is sent. Thus sometimes you may need to "wake-up" networking. 

Just make WWW class connection to your site (and yield until it finishes) before making Unity networking connection..  
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net-HighLevelOverview 
The following information is a collection of concepts that are relevant to any kind of game network activity, and are not specific to Unity. It 

will be very helpful for you to understand these concepts before you begin using Unity networking.  

What is Networking? 

The basic concept of networking is communication between multiple computers. To do this you need a client and a server. The server can 

either be a dedicated host machine for everyone, or a player running the game acting as the server for other players. Once a server has 

been established and a client has connected to it, the two computers can exchange data necessary for a multiplayer network game.  

Creating a network game requires a lot of attention to some very specific details. Even in Unity, where most actions are easy to design and 

create, networking remains extremely complex. We chose to make networking in Unity very robust and flexible. This means that you as the 

game creator need to make a lot of choices which you may not otherwise have to think about. These choices will have a big effect on how 

you build your game, so it is best to make them as early as possible. This means learning about these concepts and planning them as 

much as possible, keeping long-term implications in mind.  

Networking Approaches 

There are two common and proven approaches to structuring a network game. These approaches are called Authoritative Server and 

Non-Authoritative Server. Both approaches rely on a server connecting clients and passing information between them. Incidentally, they 

offer more privacy for end users since clients never actually connect directly with each other or have their IP addresses revealed to other 

clients.  

Authoritative Server 

The authoritative server approach requires the server to perform all world simulation, application of game rules, and processing of client 

player input. Each client sends their input (in the form of key presses or requested functions to perform) to the server and continuously 

receives the current state of the game from the server. The client never performs any game logic changes itself. Instead, it tells the server 

what it wants to do, and the server handles internal logic itself and informs the client exactly what has happened.  

Fundamentally, this is a layer of separation between what the player wants to do and what actually happens. This allows the server to listen 

to what everyone wants to do, apply the logic of game rules (which vary from game to game) and tell each client exactly what to do. Think 

of this as "Player tells Server what they want to do --> Server determines what happens --> Server tells client players how to update".  

An advantage of using this approach is that it makes cheating much harder for clients. For example, they do not have the capabilities to tell 

the server (and thus all clients) "I killed your character" because of the technical limitations of the network communication. They can only 

tell the server "I fired my weapon" and the server determines whether or not a kill was made.  



Another example of an authoritative server would be the following for a physics game: "Player client sends input to the server --> Server 

runs physics simulation and determines all collisions & effects of collisions --> Server sends updates of object positions to the player client". 

This means that while each player client appears to be running a full physics simulation, they are not. They are only receiving the result of 

the physics simulation that was performed by the server.  

With an authoritative server local movement has no effect until the server has reacted to it, which can look unnatural to the player. So if you 

press the go forward button, nothing will happen for possibly 100 ms if there is a 50 ms trip time in each direction. To combat this a 

technique called Client Side Prediction is used. This guide will not explain Client Side Prediction in depth, as it is a very technical and 

specialized technique. Essentially, it is a method of allowing each client to operate in the way that it believes it should, and receive 

corrections from the Server only if it calculates something incorrectly. The server can then override the actions of a client when it predicts 

something incorrectly. For more information on Client Side Prediction, simply Google the term.  

Making the server authoritative requires a greater processing load on the server. Imagine the server receiving a variety of different 

processes and commands from 32 different players in an action game. He needs to process each user input and decide what is legal and 

not legal sometimes resolving conflicts between clients.  

Non-Authoritative Server 

A Non-Authoritative Server does not control the outcome of every user input. The clients themselves process user input and game logic 

locally, then send the result of any determined actions to the server. The server then synchronizes all actions with the world state. This is 

easier to implement from a design perspective, as the server really just relays messages between the clients and does no extra processing 

beyond what the clients do.  

There is no need for any kind of prediction methods as the clients handle all physics and events themselves and relay what happened to 

the server. They are the owners of their objects and are the only agents permitted to send local modifications of those objects over the 

network.  

Methods of Network Communication 

Now that we've covered the basic architectures of networked games, we will explore the lower-levels of how clients and servers can talk to 

each other.  

There are two relevant methods: Remote Procedure Calls and State Synchronization. It is not uncommon to use both methods at 

different points in any particular game.  

Remote Procedure Calls 

Also called RPCs, Remote Procedure Calls are used to invoke functions on other machines across the network. This can include the 

player's local game instance as well. Clients can send RPCs to the server, and the server can send RPCs to one or more clients. Most 

commonly, they are used for actions that happen infrequently. For example, if a client flips a switch to open a door, it can send an RPC to 

the server telling it that the door has been opened. The server can then send another RPC to all clients, invoking their local functions to 

open that same door. They are used for managing and executing individual events.  

State Synchronization 

State Synchronization is used to share data that is constantly changing. The best example of this would be a player's position in an action 

game. The player is always moving, running around, jumping, etc. All the other players on the network, even the ones that are not 

controlling this player locally, need to know where he is and what he is doing. By constantly relaying data about this player's position, the 

game can accurately represent that position to the other players.  

This kind of data is regularly and frequently sent across the network. Because this data is time-sensitive, and it requires time to travel 

across the internet tubes from one machine to another, it is important to reduce the amount of data that is sent as much as possible. In 

simpler terms, state synchronization naturally requires a lot of bandwidth, so you should do everything you can to use the least amount of 

bandwidth that you can.  

Connecting servers and clients together 



Connecting servers and clients together can be complex if all factors are considered. Machines can have private or public IP addresses 

and they can have local or external firewalls blocking access. Unity networking tries to provide methods for handling all situations but there 

is no "magic bullet" for this.  

Private addresses are IP addresses which are not accessible directly from the internet, they are also called NAT addresses because of the 

method used to connect them to the internet (Network Address Translation). To explain this in greatly simplified terms, the private address 

goes through a local router which translates the address to a public address. This way a great number of private addresses can use a 

single public IP address to communicate with the internet. This is fine until someone from across the internet wants to initiate contact with a 

private address. He needs to go through the public address of the router which handles the private address and there is no way to do that 

except with a concept called NAT punchthrough. With NAT punchthrough a common server, called a facilitator, mediates communication in 

a way which allows a public address to contact a private address. This works by having the private address first contact the facilitator, 

which "punches" a hole through the local router. The facilitator can now see the public IP address and port which the private address is 

using. Using this information any machine on the internet can now connect directly with the previously unreachable private address. Bear in 

mind that this is a simplified explanation just to cover the basics.  

Public addresses are more simple. Here the primary danger is that connectivity is blocked by an internal or external firewall. An internal 

firewall is a firewall running locally on the machine. In this case the user can be asked to open a port to make the game server accessible. 

An external firewall is understood as a firewall running on the network router or something similar which is outside the control of the users. 

In this case there might be nothing to do about connectivity except attempt to use the NAT punchthrough method to punch a hole through 

the firewall. During testing this did work but there is no research available to indicate how successful this is.  

The above mentioned connectivity issues affect servers and clients differently. Clients are simpler as they just need to contact a server, and 

such contact involves only outgoing traffic. If the client has a public address this almost always works, outgoing traffic is seldom blocked 

except on corporate networks where access is very limited. If the client has a private address it can connect to all servers except servers 

with private addresses which cannot do NAT punchthrough. (More on this later.) Servers are more complicated as they need to be able to 

accept incoming connections from unknown sources. With a public address, the server needs to have the game port open to the internet, 

not blocked by a firewall. If a port is not open and accessible to the internet the server cannot accept any connections from clients and is 

thus unusable. If the server has a private address it must be able to do NAT punchthrough, or else no one can connect to it. Clients which 

cannot do NAT punchthrough will regardless not be able to connect to the server.  

Unity provides tools to test all these different connectivity situations. When everything is resolved and you want to start connecting servers 

and clients together, there are two methods: direct connections by which a client needs to know the DNS name or IP address of the server 

and connections with help from the Master Server. The Master Server allows servers to advertise their presence to clients. The clients in 

that case do not need to know about any servers beforehand.  

Minimizing Network Bandwidth 

When working with State Synchronization across multiple clients, you don't necessarily need to synchronize every single detail in order to 

make objects appear synchronized. For example, when synchronizing a character avatar you only need to send its position and rotation 

between clients. Even though the character itself is much more complex and might contain a deep Transform hierarchy, data about the 

entire hierarchy does not need to be shared.  

A lot of data in your game can be viewed as static, and clients neither have to transfer it initially nor synchronize it. Using infrequent or one-

time RPC calls should be sufficient to make a lot of your functionality work. Take advantage of the data you know will exist in every 

installation of your game and keep the client working by itself as much as possible. For example, you know that assets like textures and 

meshes exist on all installations and they usually don't change, so they will never have to be synchronized. This is a simple example but it 

should get you thinking about what data is absolutely critical to share from one client to another. This is the only data that you should ever 

share.  

This is not an easy thing to do, especially if you have never made a network game before. Consider this: you can use a single RPC call with 

a level name to make all clients load the entire specified level and add their own networked elements automatically. Structuring your game 

to make each client as self-sufficient as possible will result in reduced bandwidth.  

Multiplayer Game Performance 



The physical location and performance of the server itself can greatly affect the playability of a game running on it. Clients which are 

located a continent away from the server may experience a great amount of lag. That's just the way it is and there is really nothing one can 

do about that. No matter how powerful the server hardware is, the distance data has to travel to and from the server will always be a factor 

in your game. It's best if the server and clients are located on the same continent.  

Extra Resources 

We've collected some additional helpful links for learning about networking concepts. We recommend that you read as many networking 

resources as possible.  

 http://developer.valvesoftware.com/wiki/Source_Multiplayer_Networking  

 http://developer.valvesoftware.com/wiki/Lag_Compensation  

 http://developer.valvesoftware.com/wiki/Working_With_Prediction  

 http://www.gamasutra.com/resource_guide/20020916/lambright_01.htm  
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net-UnityNetworkElements 
Unity's native networking supports everything discussed on the previous page. Server creation and client connection, sharing data between 

connected clients, determining which player controls which objects, and punching through network configuration variations are all 

supported out of the box. This page will walk you through the Unity-specific implementation of these networking practices.  

Creating a Server 

Before you can begin playing a networked game, you have to determine the different computers you will be communicating with. To do this, 

you have to create a server. This can be a machine that is also running the game or it can be a dedicated machine that is not participating 

in the game. To create the server, you simply call Network.InitializeServer() from a script. When you want to connect to an existing server 

as a client, you call Network.Connect() instead.  

In general, you will find it very useful to familiarize yourself with the entire Network class.  

Communicating using Network Views 

The Network View is a Component that sends data across the network. Network Views make your GameObject capable of sending data 

using RPC calls or State Synchronization. The way you use Network Views will determine how your game's networking behaviors will work. 

Network Views have few options, but they are incredibly important for your networked game.  

For more information on using Network Views, please read the Network View Guide page and Component Reference page.  

Remote Procedure Calls 

Remote Procedure Calls (RPCs) are functions declared in scripts that are attached to a GameObject that contains a Network View. The 

Network View must point to the script which contains the RPC function. The RPC function can then be called from any script within that 

GameObject.  

For more information on using RPCs in Unity, please read the RPC Details page.  

State Synchronization 

State Synchronization is the continual sharing of data across all game clients. This way a player's position can be synchronized over all 

clients, so it seems it is controlled locally when data is actually being delivered over a network. To synchronize state within a GameObject 

you just need to add a NetworkView to that object and tell it what to observe. The observed data is then synchronized across all clients in 

the game.  

For more information on using State Synchronization in Unity, please read the State Synchronization page.  

http://developer.valvesoftware.com/wiki/Source_Multiplayer_Networking
http://developer.valvesoftware.com/wiki/Lag_Compensation
http://developer.valvesoftware.com/wiki/Working_With_Prediction
http://www.gamasutra.com/resource_guide/20020916/lambright_01.htm
http://unity3d.com/support/documentation/ScriptReference/Network.InitializeServer.html
http://unity3d.com/support/documentation/ScriptReference/Network.Connect.html
http://unity3d.com/support/documentation/ScriptReference/Network.html
http://unity3d.com/support/documentation/Components/net-NetworkView.html
http://unity3d.com/support/documentation/Components/class-NetworkView.html
http://unity3d.com/support/documentation/Components/net-RPCDetails.html
http://unity3d.com/support/documentation/Components/net-StateSynchronization.html


Network.Instantiate() 

Network.Instantiate() lets you instantiate a prefab on all clients in a natural and easy way. Essentially this is an Instantiate() call, but it 

performs the instantiation on all clients.  

Internally Network.Instantiate is simply a buffered RPC call which is executed on all clients (also locally). It allocates a NetworkViewID and 

assigns it to the instantiated prefab which makes sure it synchronizes across all clients correctly.  

For more information please read the Network Instantiate page.  

NetworkLevelLoad() 

Dealing with sharing data, state of client players, and loading levels can be a bit overwhelming. The Network Level Load page contains a 

helpful example for managing this task.  

Master Server 

The Master Server helps you match games. When you start a server you connect to the master server, and it provides a list of all the 

active servers.  

The Master Server is a meeting place for servers and clients where servers are advertised and compatible clients can connect to running 

games. This prevents the need for fiddling with IP addresses for all parties involved. It can even help users host games without them 

needing to mess with their routers where, under normal circumstances, that would be required. It can help clients bypass the server's 

firewall and get to private IP addresses which are normally not accessible through the public internet. This is done with help from a 

facilitator which facilitates connection establishment.  

For more information please read the Master Server page.  

Minimizing Bandwidth 

Using the minimum amount of bandwidth to make your game run correctly is essential. There are different methods for sending data, 

different techniques for deciding what or when to send and other tricks at your disposal.  

For tips and tricks to reduce bandwidth usage, please read the Minimizing Bandwith page.  

Debugging Networked Games 

Unity comes with several facilities to help you debug your Networked game.  

1. The Network Manager can be used for logging all incoming and outgoing network traffic.  

2. Using the Inspector and Hierarchy View effectively you can track object creation and inspect view id's etc.  

3. You can launch Unity two times on the same machine, and open different projects in each. On Windows, this can be done by just 

launching another Unity instance and opening the project from the project wizard. On Mac OS X, multiple Unity instances can be 

opened from the terminal, and a -projectPath argument can be specified:  

    /Applications/Unity/Unity.app/Contents/MacOS/Unity -projectPath 

"/Users/MyUser/MyProjectFolder/" 

    /Applications/Unity/Unity.app/Contents/MacOS/Unity -projectPath 

"/Users/MyUser/MyOtherProjectFolder/" 

Make sure you make the player run in the background when debugging networking because, for example, if you have two instances 

running at once, one of them doesn't have focus. This will break the networking loop and cause undesirable results. You can enable this in 

Edit->Project Settings->Player in the editor or with Application.runInBackground  
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net-NetworkView 
Network Views are the vehicle used to share data across the network. They allow two kinds of network communication: State 

Synchronization and Remote Procedure Calls.  

When you have many clients running the same game, each client has a set of objects which all together make up the game itself. To make 

two or more clients seem identical, these objects need to be synchronized by sharing data. This is called State Synchronization. 

Synchronizing the state of every object in the game requires a massive amount of data, easily too much data to be practically sent across 

the network and keep your game playable. To address this, Network Views are used to specify what data will be shared, and therefore 

which objects will be synchronized. Each Network View watches a specific part of an object and makes sure it is synchronized with the 

same object on other clients. More information about State Synchronization can be found on the State Synchronization page.  

There are other network scenarios like when you want to send out the position of an object or respawn an item for someone to pick up. 

Because these are one-time, infrequent operations, it does not make sense to synchronize the state of the involved objects. Instead, you 

use a Remote Procedure Call to tell the clients or server to perform an operation. More information about Remote Procedure Calls can be 

found on the RPC Details page.  

Technical Details 

Network Views are identified across the Network by NetworkViewID's. A NetworkViewID is basically a unique identifier of an object that all 

networked machines agree on. It is implemented as a 128 bit number but is automatically compressed down to 16 bit when transferred over 

the network where possible.  

Each packet that arrives on the client side needs to be applied to a specific Network View. The NetworkViewID uniquely identifies to which 

Network View it belongs. Using the NetworkViewID, Unity can find the right Network View, unpack the data and finally apply the incoming 

packet to the Network View's observed object.  

More details about using Network Views in the Editor can be found on the Network View Component Reference page.  

If you use Network.Instantiate() to create your Networked objects, you do not need to worry about allocating Network Views and assigning 

them yourself appropriately. It will all work automatically under the hood.  

However, you can manually control the NetworkViewIDs of each Network View by using Network.AllocateViewID. The Scripting 

Reference documentation shows an example of how an object can be manually instantiated on every client with an RPC function 

and then the NetworkViewID manually set with AllocateViewID``.  
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net-RPCDetails 
Remote Procedure Calls (RPCs) let you call functions on a remote machine. It is similar to calling a normal function and almost as easy, 

but there are some important differences to understand.  

1. An RPC call can have as many parameters as you like. All parameters will of course be sent over the network. This makes the 

bandwidth increase with the more parameters you send. Therefore, you should try to minimize your parameters as much as 

possible.  

2. You need to determine who will receive the RPC that is being sent out. There are several RPC call modes, that cover all common 

use cases. You can easily invoke the RPC function on everyone, on only the server, everyone but yourself or a specific 

client/player.  

RPC calls are usually used to execute some event on all clients in the game or pass event information specifically between two parties, but 

you can be creative with it and use it however you want to. For example, a server for a game which only starts after 4 clients have 

connected could send an RPC call to all clients as soon as the forth one connects, thus starting the game. A client could send RPC calls to 

http://unity3d.com/support/documentation/Components/net-StateSynchronization.html
http://unity3d.com/support/documentation/Components/net-RPCDetails.html
http://unity3d.com/support/documentation/Components/class-NetworkView.html
http://unity3d.com/support/documentation/ScriptReference/Network.Instantiate.html
http://unity3d.com/support/documentation/ScriptReference/Network.AllocateViewID.html


everyone to signal that he picked up an item. A server could send an RPC to only a particular client to initialize him right after he connects, 

for example, to give him his player number, spawn location, team color, etc. A client could in turn send an RPC only to the server to specify 

his starting options, like which color he prefers or what items he has bought.  

Using RPCs 

There are two steps involved in setting up RPC calls: declaring the function you want to call and invoking it. When declaring a function you 

have to prefix it with an RPC attribute.  

The following code declares an RPC function.  

// All RPC calls need the @RPC attribute! 

@RPC 

function PrintText (text : String) 

{ 

    Debug.Log(text); 

} 

Once you have declared an RPC call you can invoke it. All network communication goes through the Network View attached to the same 

GameObject as the script. In other words, you need to attach the scripts containing the RPCs functions to a GameObject that contains a 

Network View Component.  

You can use the following variable types as parameters in RPCs:  

 int  

 float  

 string  

 NetworkPlayer  

 NetworkViewID  

 Vector3  

 Quaternion  

The following code invokes an RPC function.  

networkView.RPC ("PrintText", RPCMode.All, "Hello world"); 

This code will use the attached Network View to invoke all "PrintText()" functions in any scripts attached to the same GameObject.  

The first parameter of RPC() is the name of the function to be invoked, the second determines who will have this function invoked. In this 

case we invoke the RPC call on everyone who is connected to the server but did not tell him to buffer the call for clients which connect 

later.  

All the following parameters are the parameters that will be passed to the RPC function and be sent across the network. In this case, "Hello 

World" will be sent as a parameter and be passed as the text parameter in the PrintText function.  



You can also get hold of an extra internal parameter, a NetworkMessageInfo struct which holds details like who sent the RPC. You do not 

need to specifically pass in this information, so the PrintText function shown above will be invoked exactly the same but can be declared 

as:  

@RPC 

function PrintText (text : String, info : NetworkMessageInfo) 

{ 

    Debug.Log(text + " from " + info.sender); 

} 

As already mentioned, in order for RPC function to work in a script, a Network View must exist on the GameObject which contains the 

script. The Network View's State Synchronization can be set to Off, unless you are using State Synchronization with the same Network 

View.  

RPC Buffer 

RPC calls can also be buffered. Buffered RPC calls are stored up and executed in order for each new connecting client. They can be useful 

for making the process of a player joining an existing game session easier. A common scenario is that every player who joins a game 

should first load a specific level. Thus you would send an RPC function to everyone and then also set it to be buffered. By buffering it, 

whenever a new player joins the game, it will automatically be sent to the player. This way you don't need to track players joining and 

manually send load level RPCs specifically to the player.  

Unity also has some functionality to remove calls from the RPC buffer. In the load level example, if the game has progressed through 

multiple levels, all you really care about is having a new player join the current level. In this case, you would remove any previously added 

Load Level RPC calls from the RPC buffer.  
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net-StateSynchronization 
You can enable State Synchronization per Network View by choosing either Reliable Delta Compressed or Unreliable from the State 

Synchronization drop-down. You must then choose what kind of data will synchronized in the Observed property.  

Unity can pack/unpack some specific classes: Transform, Animation, Rigidbody and MonoBehaviour.  

Transforms are serialized by storing position, rotation and scale. Parenting information is not transferred over the network.  

Animation serializes each running animation state, that is time, weight, speed and enabled.  

Rigidbody serializes position, rotation, velocity and angular velocity.  

Scripts (MonoBehaviours) call the function OnSerializeNetworkView().  

Reliability and bandwidth 

Network Views currently support two types of reliability. Reliable Delta Compressed and Unreliable.  

http://unity3d.com/support/documentation/ScriptReference/NetworkMessageInfo.html
http://unity3d.com/support/documentation/Components/class-Transform.html
http://unity3d.com/support/documentation/Components/class-Animation.html
http://unity3d.com/support/documentation/Components/class-Rigidbody.html
http://unity3d.com/support/documentation/ScriptReference/Network.OnSerializeNetworkView.html


Both have their own advantage and disadvantages, and the right mode should be chosen on a case by case basis.  

For additional information about minimizing bandwidth, please read the Minimizing Bandwidth page.  

Reliable Delta Compressed 

Reliable Delta Compressed mode will automatically compare the data that was last received by the client. If no data has changed 

compared to it, no data will be sent. But on top of that the data will also be compared on a per property basis. For example, if your position 

has changed but your rotation has not. Only the position has to be sent across the network.  

In this mode, Unity internally packs one bit prior to each property that determines if the data has actually changed. If it has not changed, the 

property will not be included in the serialized data thus saving a lot of bandwidth.  

Unity will also ensure that every packet that is sent will arrive by resending the packet in the case of UDP packet drop until it is received. 

This means that if a packet is dropped, any packets sent later will not be applied until the dropped packet is re-sent and received. Until 

then, all later packets will wait in the buffer.  

Unreliable  

In Unreliable mode, Unity will send out the current state regardless of if it has changed or not. State will not be delta compressed since it is 

unknown if the sent data will actually arrive on the receiver.  

Deciding which method to use 

The Network layer uses UDP which is an unreliable unordered protocol but it can send reliable ordered packets, just like TCP does. It 

internally uses ACKs and NACKs to control packet transmission, ensuring no packets are dropped. The downside to using reliable ordered 

packets is that if a packet is dropped or delayed, everything stops until that packet has arrived safely. This can cause noticeable delays in 

transmission in lag intensive networks.  

Unreliable sending is useful for data where you know that it is going to change every frame anyway. For example, in a racing game, you 

can practically rely on that the player's car is always moving. Thus delta compression and reliable transfer only adds overhead without 

adding an practical gain.  

In general, you should use Unreliable sending when you know data is changing all the time and minimizing lag is critical. If the data tracked 

by the Network View is not changing every frame and bandwidth is important to you, then delta compressed is preferred.  

It is important to understand that lag is not the same thing as bandwidth. They are two separate properties that you want to optimize for in 

different use case.  

Prediction 

When the server has full authority over the world state, the clients only update the game according to these states they receive from the 

server. One problem which arises is that controls feel unnatural as when a player pushes the forward button for example, he won't move 

until the updated state is received from the server. This delay depends on the latency of the connection so the worse the connection the 

more unnatural the actions of the player become.  

One way to help with this is Player Prediction which means the client, knowing how the server calculates his movement, predicts the 

movement himself. So the player moves instantly with the control but the server sees his position from his last update. When the state 

update arrives from the server, the client will compare what he predicted with what actually happened. This might differ as the server might 

know more about the environment around the player, the client just knows what he needs to know. Errors in prediction are corrected as 

they happen, if they are corrected gradually the correction will look more smooth and less noticeable.  

Dead reckoning or interpolation/extrapolation 

It is possible to apply the same principle with player prediction to the opponents of the player. Extrapolation is when several last (buffered) 

known position, velocity and direction of an opponent is used to predict where he will be in the next frames. When the next state update 

finally arrives with the correct position, the client state will be updated with accurate information, possibly skipping if the prediction was bad. 

http://unity3d.com/support/documentation/Components/net-MinimizingBandwidth.html
http://unity3d.com/support/documentation/Components/net-HighLevelOverview.html


In FPS games the behavior of players can be very erratic so this kind of prediction only has limited effect. If the lag gets high enough the 

opponent will skip badly as the errors in prediction get larger.  

Interpolation is when packets get dropped on the way to the client and the opponent position would normally pause and then jump to the 

newest position when a new packet finally arrives. By delaying the world state by some set amount of time (like 100 ms) and then 

interpolating the last known position with the new one, the movement between these two points, where packets were dropped, will be 

smooth.  
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net-NetworkInstantiate 
Network Instantiate lets you Instantiate a prefab on all clients in a very easy to use way. When a player calls Network.Instantiate(), they 

control any Input commands on that GameObject. All the setup and handling is performed under the hood, so all you need to do to assign 

control is make each player call Network.Instantiate() on the GameObject they should control.  

Instantiating prefabs is one of the most important concepts in Unity. Network Instantiate is an extension to it, which lets you with a single 

function call instantiate an object across all machines on the network.  

The argument list for Network.Instantiate() is as follows:  

static function Instantiate (prefab : Object, position : Vector3, rotation : Quaternion, group : int) : Object 

Like Instantiate the first three parameters describe the prefab to be instantiated and the position and rotation of where it should be placed. 

Additionally the group is passed in as an argument. Usually you just pass in 0 as the group. The group number allows you to group 

together network messages which allows you to filter them if so desired.  

Technical Details 

Behind the scenes, Network Instantiate is simply a convenience function built around RPC calls. It serializes an identifier of the prefab that 

is to be instantiated, serializes all allocated NetworkViewID's, serializes the position, and send it across the network using an RPC call. 

Network.Instantiate() will always buffer the Instantiate call in the RPC buffer, this also means it can be removed from the buffer in the 

same way as other RPC calls.  

In essence this is a regular instantiation that is performed on all clients and automatically buffered. Players that join after the instantiation 

was performed will also receive the Instantiate call.  

Communication Groups 

Communication groups are important to differentiate communication and disable receiving/sending to some clients.  

For example, two connected players might be in separate room without being able to meet. Thus there is no reason to transfer state of the 

two player avatars and depending on your situation. You could have one group for game data and one for chat communication. The game 

data group might be blocked when loading a level but the chat group kept open so players can communicate.  
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Below is a simple example of a way to load a level in a multiplayer game. It makes sure no network messages are being processed while 

the level is being loaded. It also makes sure no messages are sent, until everything is ready. Lastly, when the level is loaded it sends a 

message to all scripts so that they know the level is loaded and can react to that. The SetLevelPrefix function helps with keeping 

unwanted networks updates out of a new loaded level. Unwanted updates might be updates from the previous level for example. The 

example also uses groups to separate game data and level load communication into groups. Group 0 is used for game data traffic and 

group 1 for level loading. Group 0 is blocked while the level is being loaded but group 1 kept open, it could also ferry chat communication 

so that can stay open during level loading.  

var supportedNetworkLevels : String[] = [ "mylevel" ]; 

var disconnectedLevel : String = "loader"; 

private var lastLevelPrefix = 0; 

 

function Awake () 

{ 

    // Network level loading is done in a separate channel. 

    DontDestroyOnLoad(this); 

    networkView.group = 1; 

    Application.LoadLevel(disconnectedLevel); 

} 

 

function OnGUI () 

{ 

 if (Network.peerType != NetworkPeerType.Disconnected) 

 { 

  GUILayout.BeginArea(Rect(0, Screen.height - 30, Screen.width, 30)); 

  GUILayout.BeginHorizontal(); 

 

  for (var level in supportedNetworkLevels) 



  { 

   if (GUILayout.Button(level)) 

   { 

    Network.RemoveRPCsInGroup(0); 

    Network.RemoveRPCsInGroup(1); 

    networkView.RPC( "LoadLevel", RPCMode.AllBuffered, level, lastLevelPrefix + 1); 

   } 

  } 

  GUILayout.FlexibleSpace(); 

  GUILayout.EndHorizontal(); 

  GUILayout.EndArea(); 

 } 

} 

 

@RPC 

function LoadLevel (level : String, levelPrefix : int) 

{ 

 lastLevelPrefix = levelPrefix; 

 

  // There is no reason to send any more data over the network on the default channel, 

  // because we are about to load the level, thus all those objects will get deleted anyway 

  Network.SetSendingEnabled(0, false);  

 

  // We need to stop receiving because first the level must be loaded first. 



  // Once the level is loaded, rpc's and other state update attached to objects in the level are allowed to fire 

  Network.isMessageQueueRunning = false; 

 

  // All network views loaded from a level will get a prefix into their NetworkViewID. 

  // This will prevent old updates from clients leaking into a newly created scene. 

  Network.SetLevelPrefix(levelPrefix); 

  Application.LoadLevel(level); 

  yield; 

  yield; 

 

  // Allow receiving data again 

  Network.isMessageQueueRunning = true; 

  // Now the level has been loaded and we can start sending out data to clients 

  Network.SetSendingEnabled(0, true); 

 

 

  for (var go in FindObjectsOfType(GameObject)) 

   go.SendMessage("OnNetworkLoadedLevel", SendMessageOptions.DontRequireReceiver);  

} 

 

function OnDisconnectedFromServer () 

{ 

 Application.LoadLevel(disconnectedLevel); 

} 



 

@script RequireComponent(NetworkView) 
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net-MasterServer 
The Master Server is a meeting place for games that are actively seeking clients, and player clients who want to connect to them. Its 

purpose is also to hide IP address and port details and perform technical tasks around setting up network connections which might 

otherwise not be possible, like firewall handling and NAT punch-through.  

Each individual running game server provide a Game Type to the Master Server. All games with a matching Game Type are gathered 

together so that compatible clients can easily view them. When a player connects and queries the Master Server for their matching Game 

Type, useful information on the server is displayed for the player to see. This helps the player decide which server to connect to. This 

includes the Game Name, player count and whether or not a password is needed. The two functions used to transmit this data are 

MasterServer.RegisterHost() for the Server, and MasterServer.RequestHostList() for the player client.  

When calling RegisterHost(), you need to pass three arguments - gameTypeName (which is the previously mentioned Game Type), 

gameName and comment - for the host being registered. RequestHostList() takes as an argument the gameTypeName of the hosts you 

are interested in connecting to. All the registered hosts of that type will then be sent to the requesting client. This is an asynchronous 

operation and the actual host list can be retrieved with PollHostList() which returns the list when it has arrived.  

The NAT punchthrough portion of the Master Server is actually done by a separate entity called the Facilitator. The central Unity Master 

Server is also running a Facilitator in addition to being a game lobby so it is OK to think of these functionalities as simply Master Server 

functionalities in that context.  

The Game Type you set for your game should be unique for your game. This is to prevent clients running a completely different game from 

seeing your servers and trying to connect to them. So don't use "Game1" or anything generic like that as the gameTypeName. Be specific 

and unique. If you have different versions of your game out, you could use the comment field to relay that information. That way the client 

will know if their version is incompatible with some servers in the host list. The comment field can also be used to relay any information you 

desire. It is a binary data field and can store objects, you just need to cast them properly yourself.  

More advanced functionality can be done by using the comment field and customizing the Master Server so that it will use that information 

itself. For example you could reserve the first 10 bytes of the comment field for a password and then extract the password in the Master 

Server when it receives the host update. It can compare and reject the host update if appropriate (password check fails). Of course this 

would require editing of the Master Server source code itself, but this can be downloaded and modified. For more information about this, 

skip down the page to the Advanced Section.  

Registering a game 

Before registering a game it is important to set the NAT functionality properly by setting useNat parameter for Network.InitializeServer to 

true or false depending on the networking capabilities of the host. The user hosting the game should know if he has a NAT address or not 

and if the game port is connectable on the public internet, so before hosting the game he will indicate if NAT assistance is needed or not.  

A server might be started with code similar to this:  

function OnGUI() { 

 if (GUILayout.Button ("Start Server")) 

http://unity3d.com/support/documentation/ScriptReference/MasterServer.RegisterHost.html
http://unity3d.com/support/documentation/ScriptReference/MasterServer.RequestHostList.html
http://unity3d.com/support/documentation/printable.html#advanced
http://unity3d.com/support/documentation/ScriptReference/Network.InitializeServer.html


 { 

  // Use NAT punchthrough if no public IP present 

  Network.InitializeServer(32, 25002, !Network.HavePublicAddress()); 

  MasterServer.RegisterHost("MyUniqueGameType", "JohnDoes game", "l33t game for all"); 

 } 

} 

Here we just decide if NAT punchthrough is needed based on if the machine has a public address or not. There is a more involved function 

available called Network.TestConnection() which can tell you if the host machine can do NAT or not. It also does connectivity testing for 

public IP addresses to see if a firewall is blocking the game port. Machines which have public IP addresses always pass the NAT test but if 

the test fails then the host will NOT be connectable to NAT clients. In such a case the user needs to be informed that in order to host a 

game he needs to set up port forwarding if possible. Usually people with cheap broadband connections will have a NAT address and not be 

able to set up port forwarding (as they don't have a personal public IP address at all). In these cases, if the NAT test fails, the user should 

be informed that running a server is inadvisable as no one but clients on the same local network will be able to connect.  

If a host enables NAT functionality without needing it, no harm is done and it will still be connectable, however, client which cannot do NAT 

punchthrough will think they cannot connect to him as he has NAT enabled.  

Connecting to a game 

The host information, HostData, object sent during host registrations or queries contains the following information:  

boolean useNat Indicates if the host uses NAT punchthrough. 

String gameType The game type of the host. 

String gameName The game name of the host. 

int connectedPlayers The amount of currently connected players/clients. 

int playerLimit The maximum amount of allowed concurrent players/clients. 

String[] IP The internal IP address of the host. On a server with a public address the external and internal addresses are 

the same. This is an array as when connecting internally, all the IP addresses associated with all the active 

interfaces of the machine need to be checked. 

int port The port of the host. 

boolean passwordProtected Indicates if you need to supply a password to be able to connect to this host. 

String comment Any comment which was set during host registration. 

String guid The network GUID of the host. This is needed when connecting using NAT punchthrough. 

This information can be used by clients to see the connection capabilities of the hosts. When NAT is enabled you need to use the GUID of 

the host when connecting. This is automatically handled for you when you connect to the HostData struct directly. The connect routine 

might look something like this:  

function Awake() { 

 MasterServer.RequestHostList("MadBubbleSmashGame"); 

} 

 

function OnGUI() { 

http://unity3d.com/support/documentation/ScriptReference/Network.TestConnection.html


 var data : HostData[] = MasterServer.PollHostList(); 

 // Go through all the hosts in the host list 

 for (var element in data) 

 { 

  GUILayout.BeginHorizontal();  

  var name = element.gameName + " " + element.connectedPlayers + " / " + element.playerLimit; 

  GUILayout.Label(name);  

  GUILayout.Space(5); 

  var hostInfo; 

  hostInfo = "["; 

  for (var host in element.ip) 

   hostInfo = hostInfo + host + ":" + element.port + " "; 

  hostInfo = hostInfo + "]"; 

  GUILayout.Label(hostInfo);  

  GUILayout.Space(5); 

  GUILayout.Label(element.comment); 

  GUILayout.Space(5); 

  GUILayout.FlexibleSpace(); 

  if (GUILayout.Button("Connect")) 

  { 

   // Connect to HostData struct, internally the correct method is used (GUID when using NAT). 

   Network.Connect(element);    

  } 

  GUILayout.EndHorizontal();  



 } 

} 

This example code prints out all the relevant information of the hosts returned by the Master Server. Other useful data like ping information 

or geographic location of hosts can be added to this.  

NAT punchthrough 

Bear in mind that NAT punchthrough will not work 100% of the time so certain machines are not suited to run as servers as some clients 

can connect to them and certain client might have trouble connecting to any NAT server.  

By default NAT punch through is done with the help of the Master Server but this functionality does not need to rely on the Master Server. 

The Facilitator is the one who is actually used for the NAT punchthrough routine. If two machines are connected to the Facilitator, one can 

directly connect to the other if as long as it uses the external IP and port. The Master Server is used to provide this external IP and port 

information which is otherwise hard to determine. That is why the Master Server and Facilitator are so tightly integrated. The Master Server 

and Facilitator have the same IP address by default, to change either one use the MasterServer.ipAddress, MasterServer.port, 

Network.natFacilitatorIP and Network.natFacilitatorPort  

Advanced 

The Master Server is a completely separate entity from the Unity editor itself. It can be deployed on Windows, Linux and Mac OS, and 

anyone can have their own Master Server. Unity Technologies has a dedicated Master Server available for anyone to use which is the 

default server used.  

There might be cases where you want to modify how the Master Server handles information and how it communicates. Maybe you need to 

do some optimizations of how the Master Server handles host data information from the individual game servers. Maybe you need to limit 

how many hosts the clients will receive when they request the host list, either numerically or through some kind of filter like location. This 

would mostly be bandwidth optimizations but anything can be done as long as it communicates properly with the Unity player.  

To perform any of these modifications, you must build, deploy, and host your own Master Server. Information about how to do this can be 

found on the Master Server Build page.  
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The source code for all the individual networking servers can be downloaded from the Unity website. This includes the connection tester, 

facilitator, master server and proxy server.  

All source packages include the RakNet 3.732 networking library which handles the basic networking functions and provides plugins used 

by the networking servers.  

The packages include three different types of project files, ready for compilation:  

 An Xcode 3.0 project for Mac OS X  

 A Makefile for Linux and Mac OS X  

 A Visual Studio 2008 solution  

The Xcode and Visual Studio projects can just be opened, compiled and built. To build with the Makefile just run "make". It should work with 

a standard compilation setup on Linux and Mac OS X, if you have gcc then it should work. On Linux you might need to install the ncurses 

library.  

http://unity3d.com/support/documentation/ScriptReference/MasterServer-ipAddress.html
http://unity3d.com/support/documentation/ScriptReference/MasterServer-port.html
http://unity3d.com/support/documentation/ScriptReference/Network-natFacilitatorIP.html
http://unity3d.com/support/documentation/ScriptReference/Network-natFacilitatorPort.html
http://unity3d.com/support/documentation/Components/net-MasterServerBuild.html
http://www.unity3d.com/master-server/index.html


Structure 

The Master Server 

The Master Server uses an internal database structure to keep track of host information.  

Hosts send messages with the RUM_UPDATE_OR_ADD_ROW message identifier and all their host information embedded. This is 

processed in the OnReceive() function in the LightweightDatabaseServer.cpp file. This is where all message initially appear and therefore a 

good place to start if you want to trace how a message is processed. A table is created within the database structure for each game type 

which is set when you use MasterServer.RegisterHost function. All game types are grouped together in a table, if the table does not exist it 

is dynamically created in the CreateDefaultTable() function.  

The host information data is modified by the master server. The IP and port of the game which is registering, as seen by the master server, 

is injected into the host data. This way we can for sure detect the correct external IP and port in cases where the host has a private address 

(NAT address). The IP and port in the host data sent by the game server is the private address and port and this is stored for later use. If 

the master server detects that a client is requesting the host data for a game server and the server has the same IP address then he uses 

the private address of the server instead of the external one. This is to handle cases where the client and server are on the same local 

network, using the same router with NAT addresses. Thus they will have the same external address and cannot connect to each other 

through it, they need to use the private addresses and those will work in this case.  

Clients send messages with the ID_DATABASE_QUERY_REQUEST message identifier and what game type they are looking for. The 

table or host list is fetched from the database structure and sent to the client. If it isn't found and empty host list is sent.  

All messages sent to the master server must contain version information which is checked in the CheckVersion() function. At the moment 

each version of Unity will set a new master server version internally and this is checked here. So if the master server communication 

routine will change at any point it will be able to detect older versions here and possibly refer to another version of the master server (if at 

all needed) or modify the processing of that message to account for differences.  

The Facilitator 

The facilitator uses the NAT punchthrough plugin from RakNet directly with no modifications. This is essentially just a peer listening on a 

port with the NAT punchthrough plugin loaded. When a server and a client with NAT addresses are both connected to this peer, they will be 

able to perform NAT punchthrough to connect to each other. When the Network.InitializeServer uses NAT, the connection is set up 

automatically for you.  
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net-MinimizingBandwidth 
It is important to think about what kind of data you are sending across the network. Ideally, you should be sending the absolute minimum 

amount of data to make your game work correctly on all clients.  

How data is synchronized 

How you decide to synchronize data affects the bandwidth you use. You have a choice of using either Unreliable or Reliable Delta 

Compression in each Network View.  

Unreliable means everything is sent during each iteration of the network update loop. This update loop is executed according to what is set 

by Network.sendRate, by default 15 times per second. By using Unreliable you ensure frequent updates of information and you don't care 

if updates are dropped or delayed. Dropped or delayed packets are ignored. For objects which frequently change state this might be the 

best way of synchronizing.  

http://unity3d.com/support/documentation/ScriptReference/MasterServer.RegisterHost.html
http://unity3d.com/support/documentation/ScriptReference/Network.InitializeServer


Bear in mind amount of data that is constantly being sent out. For example, if you are synchronizing a transform you are sending 9 float 

values, 36 Bytes per update or 288 Bytes per second. For the server, if running with 8 clients, this means he receives (8*36*15) 4,320 

KBytes/s or 34,6Kbits/s and has to transmit (8*7*36*15) 30,2 KBytes/s or 242Kbits/s.  

You can have a dramatic effect on the bandwidth by decreasing the send rate of the network updates. This depends on you game but for 

fast paced game this should be quite high (like 15).  

Reliable Delta Compressed means that data is sent reliably and in order, if out of order packets arrive they are held back until the correct 

packet is there. Data is also delta compressed which means only the difference between the last sent state and the current state is sent. If 

the difference is nothing then nothing is sent. This greatly decreases the bandwidth used by objects depending on how static they are 

during a game. A static object send no updates at all. This can however affect the latency of the state synchronization, packets might arrive 

delayed because they needed to be resent. In this case nothing is received at all until the dropped packet arrives. Using interpolation 

decreases the effect of dropped packets.  

What data is synchronized 

It is important to try and think creatively on how your game can be synchronized so it appears to be the same on all clients. It might not be 

necessary for everything to be exactly the same, a good example is synchronizing animation. When you have, for example, a character 

which has all sorts of animation, like walking, running, jumping etc. You want all this to appear the same but it isn't necessary to be exactly 

the same. If you directly put an Animation component as an observed component in a Network View then it is exactly synchronized. It 

sends time, state and the enable boolean. This generates a lot of traffic as time constantly changes but there is an easy and efficient 

alternative way of doing this. You can make a network animation script which is serializes only a single char variable, and then in the 

animation script you send a message to this network script and tell it what the current animation state is. Only the single char variable is 

sent each time that animation changes, which is nothing compared to brute force synchronizing the animation.  

When to synchronize data 

Is it really necessary to always keep a game completely in sync on all clients? Think about a game where there are large buildings all over 

the place or big race tracks which go into forests or over and under hills. When one client is nowhere in sight of another client there is no 

need to keep them synchronized with each other. This can greatly decrease the load on the server as he no longer needs to tell everyone 

about everyone else. This is sometimes called using Relevant Sets. You have a set of relevancy for each client which defines what data 

he needs to receive. At the moment this can, however, only be done with RPCs as their destination scope has greater control. You can 

direct them to specific network players, based on your own logic on who should get them.  

Level loading 

One exception for when to worry about bandwidth is during startup or level loading. Here it is fine to send bulks of data to initialize the 

game, each client just waits until everybody is ready. You could even send textures or picture data so players can really customize their 

avatars.  
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Asset Server Guide 

Unity Asset Server Overview 

The Unity Asset Server is an asset and version control system with a graphical user interface integrated into Unity. It is meant to be used 

by team members working together on a project on different computers either in-person or remotely. The Asset Server is highly optimized 

for handling large binary assets in order to cope with large multi gigabyte project folders. When uploading assets, Import Settings and 

other meta data about each asset is uploaded to the asset server as well. Renaming and moving files is at the core of the system and well 

supported.  

It is available only for Unity Pro, and is an additional license per client. To purchase an Asset Server Client License, please visit the Unity 

store at http://unity3d.com/store  

http://unity3d.com/store


New to Source Control? 

If you have never used Source Control before, it can be a little unfriendly to get started with any versioning system. Source Control works 

by storing an entire collection of all your assets - meshes, textures, materials, scripts, and everything else - in a database on some kind of 

server. That server might be your home computer, the same one that you use to run Unity. It might be a different computer in your local 

network. It might be a remote machine colocated in a different part of the world. It could even be a virtual machine. There are a lot of 

options, but the location of the server doesn't matter at all. The important thing is that you can access it somehow over your network, and 

that it stores your game data.  

In a way, the Asset Server functions as a backup of your Project Folder. You do not directly manipulate the contents of the Asset Server 

while you are developing. You make changes to your Project locally, then when you are done, you Commit Changes to the Project on the 

Server. This makes your local Project and the Asset Server Project identical.  

Now, when your fellow developers make a change, the Asset Server is identical to their Project, but not yours. To synchronize your local 

Project, you request to Update from Server. Now, whatever changes your team members have made will be downloaded from the server 

to your local Project.  

This is the basic workflow for using the Asset Server. In addition to this basic functionality, the Asset Server allows for rollback to previous 

versions of assets, detailed file comparison, merging two different scripts, resolving conflicts, and recovering deleted assets.  

The rest of this guide explains how to deploy, administrate, and regularly use the Asset Server.  

 Setting up the Asset Server  

 Daily use of the Asset Server  
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assetserver-Setup 

Server-side Installation 

The Asset Server is designed to be a simple one-time installation on a server machine. Interacting with the Asset Server is done through 

Unity. Unity can be installed on the server machine, but it does not need to be. It must be administrated from a Client machine, where 

Projects and Users can be added. Each additional client must be configured to synchronize with a Project, using a specific User credential.  

You can install the Asset Server on Mac OS X 10.4 or later, Windows XP, Windows Vista and various Linux distributions including CentOS, 

Ubuntu and Suse Linux. Download Unity Asset Server from here.  

The installer will install all necessary files, setup a database and launch the Asset Server. At the end of the process you will be asked to 

create an Admin password. This password is required to administer the Asset Server from within Unity. You must connect to the Asset 

Server as the administrator before you can create any projects or users.  

Administrating the Asset Server 

The Asset Server allows any number of Users to connect to a Project. The Administrator must first connect to the Server with Unity as a 

client and create new Projects and Users.  

To access the Administrator controls, launch Unity and select Window->Asset Server, then click the Administration button.  

http://unity3d.com/support/documentation/Components/assetserver-Setup.html
http://unity3d.com/support/documentation/Components/assetserver-DailyUse.html
http://www.unity3d.com/asset-server


 

The Administration tab 

In the Server Address field, enter either the ip address or host name of the computer running the Asset Server that you want to 

administer. If the Asset Server is installed on your local machine, you can use "localhost" as the Server Address. Next, provide the 

administrator name and password. The administrator name is always "admin", and the password is what was entered when installing the 

Asset Server. Finally, hit the Connect button. You're now connected to the Asset Server, and can perform the initial setup.  

Managing Projects and Users 

Each Server can contain several Projects, and each User can have permission to one or more Projects. Projects are generally orthogonal, 

and unique in asset collections. It is best to think "one Project equals one game".  

New Projects can be created by clicking on the Create button in the Server Administration tab.  

 

Click Create, then enter a name for the new project 

New users can be created by first selecting an existing project and then clicking on the New User button.  



 

Creating a new user 

After a user has been created in one Project, the user can be added to another project by enabling the checkbox on the left of the user 

name in the users list.  

You can enable or disable user access for individual projects. To completely remove a project or user from the server use the Delete 

Project and Delete User buttons.  

Firewall settings 

The Unity Asset Server uses TCP port 10733. You might need to enable connections to this port in your firewall and/or router.  

Advanced 

The Asset Server is built using a modified version of PostgreSQL. Accessing the SQL database directly requires a bit of technical 

knowledge about SQL and Unix/Linux command lines. User discretion is advised.  

Backing up 

We have provided a command line tool to back up an asset server. The tool should be run from an administrator account on the machine 

running the asset server. Replace BACKUP_LOCATION with the path name you want the backup tool to place the backups:  

Mac OS X 

sudo /Library/UnityAssetServer/bin/as_backup BACKUP_LOCATION  

Linux 

sudo /opt/unity_asset_server/bin/as_backup BACKUP_LOCATION  

Windows 

"\Unity\AssetServer\bin\as_backup.cmd" BACKUP_LOCATION  

as_backup will create a directory at BACKUP_LOCATION containing one or more files per project plus files containing information about 

each project and a backup of all users and their passwords.  

Restoring a Backup 

To restore an Asset Server backup produced with as_backup, first perform a clean installation of the Asset Server without any projects 

created. (The restore procedure will refuse to overwrite already existing projects with the same name.)  

Then run the provided backup restoration tool, as_restore pointing it to the location of a backup created with as_backup:  

Mac OS X 

sudo /Library/UnityAssetServer/bin/as_restore BACKUP_LOCATION  

Linux 

sudo /opt/unity_asset_server/bin/as_restore BACKUP_LOCATION  



Windows 

"\Unity\AssetServer\bin\as_restore.cmd" BACKUP_LOCATION  

Note that you can also use as_backup and as_restore to move an asset server installation from one machine to another by performing the 

backup on the source machine, moving the backup directory to the destination machine (or mount it through a network file share,) and then 

running as_restore to insert the data into the newly installed Asset Server instance. This will even work when the source and destination 

Asset Servers have different versions or are running on different operating systems.  

Locating the database name of an Asset Server Project 

To view the tables in a Project database, first you need to figure out the name of the actual database. Run this command line command on 

the machine hosting the Asset Server:  

Mac OS X 

/Library/UnityAssetServer/bin/psql -U admin -h localhost -d postgres -c 'select * from 

all_databases__view'  

Linux 

/opt/unity_asset_server/bin/psql -U admin -h localhost -d postgres -c 'select * from 

all_databases__view'  

Windows 

"\Unity\AssetServer\bin\psql.exe" -U admin -h localhost -d postgres -c "select * from 

all_databases__view"  

This and other commands will prompt you for a password. Every time this happens, enter the admin password for the database, which was 

set during the installation. The result will be a table that follows this basic layout:  

    databasename    |    projectname     |       description        | version  

--------------------+--------------------+--------------------------+--------- 

 sandbox            | Sandbox            | Created with Unity 2.0.0 | 1.0 

 game               | Game               | Created with Unity 2.0.0 | 1.0 

 my_game_project    | My Game Project    | Created with Unity 2.0.0 | 1.0 

(3 rows) 

Now you need to identify the "databasename" of the Project you want to back up. When creating a database, the default "databasename" is 

same as the "projectname" as shown inside Unity, but in lowercase and spaces replaced with underscores.  

Note that if your server hosts multiple PostgreSQL databases on different ports you nay need to explicitly provide the port used to connect 

to the Asset Server database. In this case add -p 10733 to the commands given (assuming you have used the default port of 10733 for 

your instance.) For example:  

Linux 

/opt/unity_asset_server/bin/psql -U admin -h localhost -d postgres -c 'select * from 

all_databases__view' -p 10733  



Additional SQL Functions 

These and all other commands use tools from the PostgreSQL distribution. You can read more about these tools here: 

http://www.postgresql.org/docs/8.3/interactive/reference-client.html  
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This section explains the common tasks, workflow and best practices for using the Asset Server on a day-to-day basis.  

Getting Started 

If you are joining a team that has a lot of work stored on the Asset Server already, this is the quickest way to get up and running correctly. If 

you are starting your own project from scratch, you can skip down to the Workflow Fundamentals section.  

1. Create a new empty Project with no packages imported  

2. From the menubar, select Window->Asset Server  

3. Click the Connection button  

4. Enter your user name and password (provided by your Asset Server administrator)  

5. Click Show Projects and select the desired project  

6. Click Connect  

7. Click the Update tab  

8. Click the Update button  

9. If a conflict occurs, discard all local versions  

10. Wait for the update to complete  

11. You are ready to go  

Continue reading for detailed information on how to use the Asset Server effectively every day.  

Workflow Fundamentals 

When using the Asset Server with a multi-person team, it is generally good practice to Update all changed assets from the server when you 

begin working, and Commit your changes at the end of the day, or whenever you're done working. You should also commit changes when 

you have made significant progress on something, even if it is in the middle of the day. Committing your changes regularly and frequently is 

recommended.  

Understanding the Server View 

The Server View is your window into the Asset Server you're connected to. You can open the Server View by selecting "Window->Asset 

Server".  

http://www.postgresql.org/docs/8.3/interactive/reference-client.html
http://unity3d.com/support/documentation/printable.html#Fundamentals


 

The Overview tab 

The Server View is broken into tabs: Overview Update, and Commit. Overview will show you any differences between your local project 

and the latest version on the server with options to quickly commit local changes or download the latest updates. Update will show you the 

latest remote changes on the server and allow you to download them to your local project. Commit allows you to create a Changeset and 

commit it to the server for others to download.  

Connecting to the server 

Before you can use the asset server, you must connect to it. To do this you click the Connection button, which takes you to the connection 

screen:  

 

The Asset Server connection screen 

Here you need to fill in:  

1. Server address  

2. Username  

3. Password  

By clicking Show projects you can now see the available projects on the asset server, and choose which one to connect to by clicking 

Connect. Note that the username and password you use can be obtain from your system administrator. Your system administrator created 

accounts when they installed Asset Server.  

Updating from the Server 



To download all updates from the server, select the Update tab from the Overview tab and you will see a list of the latest committed 

Changesets. By selecting one of these you can see what was changed in the project as well as the provided commit message. Click 

Update and you will begin downloading all Changeset updates.  

 

The Update Tab 

Committing Changes to the Server 

When you have made a change to your local project and you want to store those changes on the server, you use the top Commit tab.  

 

The Commit tab 

Now you will be able to see all the local changes made to the project since your last update, and will be able to select which changes you 

wish to upload to the server. You can add changes to the changeset either by manually dragging them into the changeset field, or by using 



the buttons placed below the commit message field. Remember to type in a commit message which will help you when you compare 

versions or revert to an earlier version later on, both of which are discussed below.  

Resolving conflicts 

With multiple people working on the same collection of data, conflicts will inevitably arise. Remember, there is no need to panic! If a conflict 

exists, you will be presented with the Conflict Resolution dialog when updating your project.  

 

The Conflict Resolution screen 

Here, you will be informed of each individual conflict, and be presented with different options to resolve each individual conflict. For any 

single conflict, you can select Skip Asset (which will not download that asset from the server), Discard My Changes (which will completely 

overwrite your local version of the asset) or Ignore Server Changes (which will ignore the changes others made to the asset and after this 

update you will be able to commit your local changes over server ones) for each individual conflict. Additionally, you can select Merge for 

text assets like scripts to merge the server version with the local version.  

If you run into a conflict while you are committing your local changes, Unity will refuse to commit your changes and inform you that a conflict 

exists. To resolve the conflicts, select Update. Your local changes will not automatically be overwritten. At this point you will see the 

Conflict Resolution dialog, and can follow the instructions in the above paragraph.  

Browsing revision history and reverting assets 

The Asset Server retains all uploaded versions of an asset in its database, so you can revert your local version to an earlier version at any 

time. You can either select to restore the entire project or single files. To revert to an older version of an asset or a project, select the 

Overview tab then click Show History listed under Asset Server Actions. You will now see a list of all commits and be able to select and 

restore any file or all project to an older version.  



 

The History dialog 

Here, you can see the version number and added comments with each version of the asset or project. This is one reason why descriptive 

comments are helpful. Select any asset to see its history or Entire Project for all changes made in project. Find revision you need. You can 

either select whole revision or particular asset in revision. Then click Download Selected File to get your local asset replaced with a copy 

of the selected revision. Revert All Project will revert entire project to selected revision.  

Prior to reverting, if there are any differences between your local version and the selected server version, those changes will be lost when 

the local version is reverted.  

If you only want to abandon the changes made to the local copy, you don't have to revert. You can discard those local modifications by 

selecting Discard Changes in the main asset server window. This will immediately download the current version of the project from the 

server to your local Project.  

Comparing asset versions 

If you're curious to see the differences between two particular versions you can explicitly compare them. To do this, open History window, 

select revision and asset you want to compare and press Compare to Local Version. If you need to compare two different revisions of an 

asset - right click on it, in the context menu select Compare to Another Revision then find revision you want to compare to and select it.  

Note: this feature requires that you have one of supported file diff/merge tools installed. Supported tools are:  

 On Windows:  

o TortoiseMerge: part of TortoiseSVN or a separate download from the project site.  

o WinMerge.  

o SourceGear Diff/Merge.  

o Perforce Merge (p4merge): part of Perforce's visual client suite (P4V).  

o TkDiff.  

 On Mac OS X:  

o SourceGear Diff/Merge.  

o FileMerge: part of Apple's XCode development tools.  

o TkDiff.  

o Perforce Merge (p4merge): part of Perforce's visual client suite (P4V).  

Recovering deleted assets 

Deleting a local asset and committing the delete to the server will in fact not delete an asset permanently. Just as any previous version of 

an asset can be restored through History window from the Overview tab.  

http://tortoisesvn.net/
http://sourceforge.net/project/showfiles.php?group_id=138498
http://winmerge.org/
http://www.sourcegear.com/diffmerge/
http://www.perforce.com/perforce/products/merge.html
http://sourceforge.net/projects/tkdiff/
http://www.sourcegear.com/diffmerge/
http://developer.apple.com/
http://sourceforge.net/projects/tkdiff/
http://www.perforce.com/perforce/products/merge.html


 

The History dialog 

Expand Deleted Assets item, find and select assets from the list and hit Recover, the selected assets will be downloaded and re-added to 

the local project. If the folder that the asset was located in before the deletion still exists, the asset will be restored to the original location, 

otherwise it will be added to the root of the Assets folder in the local project.  

Asset Server training complete 

You should now be equipped with the knowledge you need to start using the Asset Server effectively. Get to it, and don't forget the good 

workflow fundamentals. Commit changes often, and don't be afraid of losing anything.  
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Built-in Shader Guide 
If you're looking for the best information for using Unity's built-in shaders, you've come to the right place. Unity includes more than 40 built-

in shaders, and of course you can write many more on your own! This guide will explain each family of the built-in shaders, and go into 

detail for each specific shader. With this guide, you'll be able to make the most out of Unity's shaders, to achieve the effect you're aiming 

for.  

Using Shaders 

Shaders in Unity are used through Materials, which essentially combine shader code with parameters like textures. An in-depth 

explanation of the Shader/Material relationship can be read here.  

Material properties will appear in the Inspector when either the Material itself or a GameObject that uses the Material is selected. The 

Material Inspector looks like this:  

http://unity3d.com/support/documentation/Manual/Materials.html


 

Each Material will look a little different in the Inspector, depending on the specific shader it is using. The shader iself determines what kind 

of properties will be available to adjust in the Inspector. Material inspector is described in detail in Material reference page. Remember that 

a shader is implemented through a Material. So while the shader defines the properties that will be shown in the Inspector, each Material 

actually contains the adjusted data from sliders, colors, and textures. The most important thing to remember about this is that a single 

shader can be used in multiple Materials, but a single Material cannot use multiple shaders.  

Built-in Unity Shaders 

 Performance of Unity shaders  

 Normal Shader Family  

o Vertex-Lit  

o Diffuse  

o Specular  

o Bumped Diffuse  

o Bumped Specular  

o Parallax Diffuse  

o Parallax Bumped Specular  

o Decal  

o Diffuse Detail  

 Transparent Shader Family  

o Transparent Vertex-Lit  

o Transparent Diffuse  

o Transparent Specular  

o Transparent Bumped Diffuse  

o Transparent Bumped Specular  

o Transparent Parallax Diffuse  

o Transparent Parallax Specular  

 Transparent Cutout Shader Family  

o Transparent Cutout Vertex-Lit  

o Transparent Cutout Diffuse  

o Transparent Cutout Specular  

o Transparent Cutout Bumped Diffuse  

o Transparent Cutout Bumped Specular  

 Self-Illuminated Shader Family  

o Self-Illuminated Vertex-Lit  

http://unity3d.com/support/documentation/Components/class-Material.html
http://unity3d.com/support/documentation/Components/shader-Performance.html
http://unity3d.com/support/documentation/Components/shader-NormalFamily.html
http://unity3d.com/support/documentation/Components/shader-NormalVertexLit.html
http://unity3d.com/support/documentation/Components/shader-NormalDiffuse.html
http://unity3d.com/support/documentation/Components/shader-NormalSpecular.html
http://unity3d.com/support/documentation/Components/shader-NormalBumpedDiffuse.html
http://unity3d.com/support/documentation/Components/shader-NormalBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-NormalParallaxDiffuse.html
http://unity3d.com/support/documentation/Components/shader-NormalParallaxSpecular.html
http://unity3d.com/support/documentation/Components/shader-NormalDecal.html
http://unity3d.com/support/documentation/Components/shader-NormalDiffuseDetail.html
http://unity3d.com/support/documentation/Components/shader-TransparentFamily.html
http://unity3d.com/support/documentation/Components/shader-TransVertexLit.html
http://unity3d.com/support/documentation/Components/shader-TransDiffuse.html
http://unity3d.com/support/documentation/Components/shader-TransSpecular.html
http://unity3d.com/support/documentation/Components/shader-TransBumped%20Diffuse.html
http://unity3d.com/support/documentation/Components/shader-TransBumped%20Specular.html
http://unity3d.com/support/documentation/Components/shader-TransParallax%20Diffuse.html
http://unity3d.com/support/documentation/Components/shader-TransParallax%20Specular.html
http://unity3d.com/support/documentation/Components/shader-TransparentCutoutFamily.html
http://unity3d.com/support/documentation/Components/shader-TransCutVertexLit.html
http://unity3d.com/support/documentation/Components/shader-TransCutDiffuse.html
http://unity3d.com/support/documentation/Components/shader-TransCutSpecular.html
http://unity3d.com/support/documentation/Components/shader-TransCutBumpedDiffuse.html
http://unity3d.com/support/documentation/Components/shader-TransCutBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumFamily.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumVertexLit.html


o Self-Illuminated Diffuse  

o Self-Illuminated Specular  

o Self-Illuminated Normal mapped Diffuse  

o Self-Illuminated Normal mapped Specular  

o Self-Illuminated Parallax Diffuse  

o Self-Illuminated Parallax Specular  

 Reflective Shader Family  

o Reflective Vertex-Lit  

o Reflective Diffuse  

o Reflective Specular  

o Reflective Bumped Diffuse  

o Reflective Bumped Specular  

o Reflective Parallax Diffuse  

o Reflective Parallax Specular  

o Reflective Normal Mapped Unlit  

o Reflective Normal mapped Vertex-lit  
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shader-Performance 
There are a number of factors that can affect the overall performance of your game. This page will talk specifically about the performance 

considerations for Built-in Shaders. Performance of a shader mostly depends on two things: shader itself and which Rendering Path is used 

by the project or specific camera. For performance tips when writing your own shaders, see ShaderLab Shader Performance page.  

Rendering Paths and shader performance 

From the rendering paths Unity supports, Deferred Lighting and Vertex Lit paths have the most predictable performance. In Deferred 

lighting, each object is generally drawn twice, no matter what lights are affecting it. Similarly, in Vertex Lit each object is generally drawn 

once. So then, the performance differences in shaders mostly depend on how many textures they use and what calculations they do.  

Shader Performance in Forward rendering path 

In Forward rendering path, performance of a shader depends on both the shader itself and the lights in the scene. The following section 

explains the details. There are two basic categories of shaders from a performance perspective, Vertex-Lit, and Pixel-Lit.  

Vertex-Lit shaders in Forward rendering path are always cheaper than Pixel-Lit shaders. These shaders work by calculating lighting based 

on the mesh vertices, using all lights at once. Because of this, no matter how many lights are shining on the object, it will only have to be 

drawn once.  

Pixel-Lit shaders calculate final lighting at each pixel that is drawn. Because of this, the object has to be drawn once to get the ambient & 

main directional light, and once for each additional light that is shining on it. Thus the formula is N rendering passes, where N is the final 

number of pixel lights shining on the object. This increases the load on the CPU to process and send off commands to the graphics card, 

and on the graphics card to process the vertices and draw the pixels. The size of the Pixel-lit object on the screen will also affect the speed 

at which it is drawn. The larger the object, the slower it will be drawn.  

So pixel lit shaders come at performance cost, but that cost allows for some spectacular effects: shadows, normal-mapping, good looking 

specular highlights and light cookies, just to name a few.  

Remember that lights can be forced into a pixel ("important") or vertex/SH ("not important") mode. Any vertex lights shining on a Pixel-Lit 

shader will be calculated based on the object's vertices or whole object, and will not add to the rendering cost or visual effects that are 

associated with pixel lights.  

General shader performance 

http://unity3d.com/support/documentation/Components/shader-SelfIllumDiffuse.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumSpecular.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumBumpedDiffuse.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumParallaxDiffuse.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumParallaxSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveFamily.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveVertexLit.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveDiffuse.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedDiffuse.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveParallaxDiffuse.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveParallaxSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedUnlit.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedVertexLit.html
http://unity3d.com/support/documentation/Components/Built-in%20Shader%20Guide.html
http://unity3d.com/support/documentation/Manual/RenderingPaths.html
http://unity3d.com/support/documentation/Components/SL-ShaderPerformance.html
http://unity3d.com/support/documentation/Components/RenderTech-DeferredLighting.html
http://unity3d.com/support/documentation/Components/RenderTech-VertexLit.html
http://unity3d.com/support/documentation/Components/RenderTech-ForwardRendering.html


Out of Built-in Shaders, they come roughly in this order of increasing complexity:  

 Unlit. This is just a texture, not affected by any lighting.  

 VertexLit.  

 Diffuse.  

 Normal mapped. This is a bit more expensive than Diffuse: it adds one more texture (normal map), and a couple of shader instructions.  

 Specular. This adds specular highlight calculation.  

 Normal Mapped Specular. Again, this is a bit more expensive than Specular.  

 Parallax Normal mapped. This adds parallax normal-mapping calculation.  

 Parallax Normal Mapped Specular. This adds both parallax normal-mapping and specular highlight calculation.  

Additionally, Unity has several simplified shaders targeted at mobile platforms, under "Mobile" category. These shaders work on other 

platforms as well, so if you can live with their simplifications (e.g. approximate specular, no per-material color support etc.), try using them!  
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shader-NormalFamily 
These shaders are the basic shaders in Unity. They are not specialized in any way and should be suitable for most opaque objects. They 

are not suitable if you want your object to be transparent, emitting light etc.  

Vertex Lit 

 

Assets needed:  

 One Base texture, no alpha channel required  

Diffuse 

 

Assets needed:  

 One Base texture, no alpha channel required  

Specular 

http://unity3d.com/support/documentation/Components/Built-in%20Shader%20Guide.html
http://unity3d.com/support/documentation/Components/shader-NormalVertexLit.html
http://unity3d.com/support/documentation/Components/shader-NormalDiffuse.html
http://unity3d.com/support/documentation/Components/shader-NormalSpecular.html
http://unity3d.com/support/documentation/Components/shader-NormalVertexLit.html
http://unity3d.com/support/documentation/Components/shader-NormalDiffuse.html


 

Assets needed:  

 One Base texture with alpha channel for Specular Map  

Normal mapped 

 

Assets needed:  

 One Base texture, no alpha channel required  

 One Normal map  

Normal mapped Specular 

 

Assets needed:  

 One Base texture with alpha channel for Specular Map  

 One Normal map  

Parallax 

 

Assets needed:  

 One Base texture, no alpha channel required  

 One Normal map  

 One Height texture with Parallax Depth in the alpha channel  

Parallax Specular 

http://unity3d.com/support/documentation/Components/shader-NormalBumpedDiffuse.html
http://unity3d.com/support/documentation/Components/shader-NormalBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-NormalParallaxDiffuse.html
http://unity3d.com/support/documentation/Components/shader-NormalParallaxSpecular.html
http://unity3d.com/support/documentation/Components/shader-NormalSpecular.html
http://unity3d.com/support/documentation/Components/shader-NormalBumpedDiffuse.html
http://unity3d.com/support/documentation/Components/shader-NormalBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-NormalParallaxDiffuse.html


 

Assets needed:  

 One Base texture with alpha channel for Specular Map  

 One Normal map  

 One Height texture with Parallax Depth in the alpha channel  

Decal 

 

Assets needed:  

 One Base texture, no alpha channel required  

 One Decal texture with alpha channel for Decal transparency  

Diffuse Detail 

 

Assets needed:  

 One Base texture, no alpha channel required  

 One Detail grayscale texture; with 50% gray being neutral color  
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shader-NormalVertexLit 

http://unity3d.com/support/documentation/Components/shader-NormalDecal.html
http://unity3d.com/support/documentation/Components/shader-NormalDiffuseDetail.html
http://unity3d.com/support/documentation/Components/shader-NormalParallaxSpecular.html
http://unity3d.com/support/documentation/Components/shader-NormalDecal.html
http://unity3d.com/support/documentation/Components/shader-NormalDiffuseDetail.html


 

Vertex-Lit Properties 

This shader is Vertex-Lit, which is one of the simplest shaders. All lights shining on it are rendered in a single pass and calculated at 

vertices only.  

Because it is vertex-lit, it won't display any pixel-based rendering effects, such as light cookies, normal mapping, or shadows. This shader 

is also much more sensitive to tesselation of the models. If you put a point light very close to a cube using this shader, the light will only be 

calculated at the corners. Pixel-lit shaders are much more effective at creating a nice round highlight, independent of tesselation. If that's an 

effect you want, you may consider using a pixel-lit shader or increase tesselation of the objects instead.  

Performance 

Generally, this shader is very cheap to render. For more details, please view the Shader Peformance page.  
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shader-NormalDiffuse 

http://unity3d.com/support/documentation/Components/shader-Performance.html


 

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is cheap to render. For more details, please view the Shader Peformance page.  
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shader-NormalSpecular 

http://unity3d.com/support/documentation/Components/shader-Performance.html


 

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is moderately expensive to render. For more details, please view the Shader Peformance page.  
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shader-NormalBumpedDiffuse 

http://unity3d.com/support/documentation/Components/shader-Performance.html


 

Normal Mapped Properties 

Like a Diffuse shader, this computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it 

and the light decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Normal mapping simulates small surface details using a texture, instead of spending more polygons to actually carve out details. It does 

not actually change the shape of the object, but uses a special texture called a Normal Map to achieve this effect. In the normal map, each 

pixel's color value represents the angle of the surface normal. Then by using this value instead of the one from geometry, lighting is 

computed. The normal map effectively overrides the mesh's geometry when calculating lighting of the object.  

Creating Normal maps 

You can import a regular grayscale image and convert it to a Normal Map from within Unity. To learn how to do this, please read the 

Normal map FAQ page.  

Technical Details 

The Normal Map is a tangent space type of normal map. Tangent space is the space that "follows the surface" of the model geometry. In 

this space, Z always points away from the surface. Tangent space Normal Maps are a bit more expensive than the other "object space" 

type Normal Maps, but have some advantages:  

1. It's possible to use them on deforming models - the bumps will remain on the deforming surface and will just work.  

2. It's possible to reuse parts of the normal map on different areas of a model; or use them on different models.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is cheap to render. For more details, please view the Shader Peformance page.  
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shader-NormalBumpedSpecular 

 

Normal Mapped Properties 

Like a Diffuse shader, this computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it 

and the light decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Normal mapping simulates small surface details using a texture, instead of spending more polygons to actually carve out details. It does 

not actually change the shape of the object, but uses a special texture called a Normal Map to achieve this effect. In the normal map, each 

pixel's color value represents the angle of the surface normal. Then by using this value instead of the one from geometry, lighting is 

computed. The normal map effectively overrides the mesh's geometry when calculating lighting of the object.  

Creating Normal maps 

You can import a regular grayscale image and convert it to a Normal Map from within Unity. To learn how to do this, please read the 

Normal map FAQ page.  

Technical Details 

The Normal Map is a tangent space type of normal map. Tangent space is the space that "follows the surface" of the model geometry. In 

this space, Z always points away from the surface. Tangent space Normal Maps are a bit more expensive than the other "object space" 

type Normal Maps, but have some advantages:  

1. It's possible to use them on deforming models - the bumps will remain on the deforming surface and will just work.  

2. It's possible to reuse parts of the normal map on different areas of a model; or use them on different models.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

http://unity3d.com/support/documentation/Manual/HOWTO-Normalmap.html


Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is moderately expensive to render. For more details, please view the Shader Peformance page.  
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shader-NormalParallaxDiffuse 

 

Parallax Normal mapped Properties 

Parallax Normal mapped is the same as regular Normal mapped, but with a better simulation of "depth". The extra depth effect is 

achieved through the use of a Height Map. The Height Map is contained in the alpha channel of the Normal map. In the alpha, black is 

zero depth and white is full depth. This is most often used in bricks/stones to better display the cracks between them.  

The Parallax mapping technique is pretty simple, so it can have artifacts and unusual effects. Specifically, very steep height transitions in 

the Height Map should be avoided. Adjusting the Height value in the Inspector can also cause the object to become distorted in an odd, 

unrealistic way. For this reason, it is recommended that you use gradual Height Map transitions or keep the Height slider toward the 

shallow end.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is on the more expensive rendering side. For more details, please view the Shader Peformance page.  

http://unity3d.com/support/documentation/Components/shader-Performance.html
http://unity3d.com/support/documentation/Components/shader-Performance.html
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shader-NormalParallaxSpecular 

 

Parallax Normal mapped Properties 

Parallax Normal mapped is the same as regular Normal mapped, but with a better simulation of "depth". The extra depth effect is 

achieved through the use of a Height Map. The Height Map is contained in the alpha channel of the Normal map. In the alpha, black is 

zero depth and white is full depth. This is most often used in bricks/stones to better display the cracks between them.  

The Parallax mapping technique is pretty simple, so it can have artifacts and unusual effects. Specifically, very steep height transitions in 

the Height Map should be avoided. Adjusting the Height value in the Inspector can also cause the object to become distorted in an odd, 

unrealistic way. For this reason, it is recommended that you use gradual Height Map transitions or keep the Height slider toward the 

shallow end.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is on the more expensive rendering side. For more details, please view the Shader Peformance page.  

http://unity3d.com/support/documentation/Components/shader-Performance.html
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shader-NormalDecal 

 

Decal Properties 

This shader is a variation of the VertexLit shader. All lights that shine on it will be rendered as vertex lights by this shader. In addition to the 

main texture, this shader makes use of a second texture for additional details. The second "Decal" texture uses an alpha channel to 

determine visible areas of the main texture. The decal texture should be supplemental to the main texture. For example, if you have a brick 

wall, you can tile the brick texture as the main texture, and use the decal texture with alpha channel to draw graffiti at different places on the 

wall.  

Performance 

This shader is approximately equivalent to the VertexLit shader. It is marginally more expensive due to the second decal texture, but will not 

have a noticeable impact.  
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shader-NormalDiffuseDetail 



 

Diffuse Detail Properties 

This shader is a version of the regular Diffuse shader with additional data. It allows you to define a second "Detail" texture that will gradually 

appear as the camera gets closer to it. It can be used on terrain, for example. You can use a base low-resolution texture and stretch it over 

the entire terrain. When the camera gets close the low-resolution texture will get blurry, and we don't want that. To avoid this effect, create 

a generic Detail texture that will be tiled over the terrain. This way, when the camera gets close, the additional details appear and the blurry 

effect is avoided.  

The Detail texture is put "on top" of the base texture. Darker colors in the detail texture will darken the main texture and lighter colors will 

brighten it. Detail texture are usually gray-ish. For more information on effectively creating Detail textures, please view this page.  

Performance 

This shader is pixel-lit, and approximately equivalent to the Diffuse shader. It is marginally more expensive due to additional texture.  
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shader-TransparentFamily 
The Transparent shaders are used for fully- or semi-transparent objects. Using the alpha channel of the Base texture, you can determine 

areas of the object which can be more or less transparent than others. This can create a great effect for glass, HUD interfaces, or sci-fi 

effects.  

Transparent Vertex-Lit 

 

http://unity3d.com/support/documentation/Manual/HOWTO-UseDetailTexture.html
http://unity3d.com/support/documentation/Components/shader-TransVertexLit.html
http://unity3d.com/support/documentation/Components/shader-TransVertexLit.html


Assets needed:  

 One Base texture with alpha channel for Transparency Map  

» More details  

Transparent Diffuse 

 

Assets needed:  

 One Base texture with alpha channel for Transparency Map  

» More details  

Transparent Specular 

 

Assets needed:  

 One Base texture with alpha channel for combined Transparency Map/Specular Map  

Note: One limitation of this shader is that the Base texture's alpha channel doubles as a Specular Map for the Specular shaders in this 

family.  

» More details  

Transparent Normal mapped 

 

Assets needed:  

 One Base texture with alpha channel for Transparency Map  

 One Normal map normal map, no alpha channel required  

» More details  

http://unity3d.com/support/documentation/Components/shader-TransVertexLit.html
http://unity3d.com/support/documentation/Components/shader-TransDiffuse.html
http://unity3d.com/support/documentation/Components/shader-TransDiffuse.html
http://unity3d.com/support/documentation/Components/shader-TransSpecular.html
http://unity3d.com/support/documentation/Components/shader-TransSpecular.html
http://unity3d.com/support/documentation/Components/shader-TransBumped%20Diffuse.html
http://unity3d.com/support/documentation/Components/shader-TransBumped%20Diffuse.html
http://unity3d.com/support/documentation/Components/shader-TransDiffuse.html
http://unity3d.com/support/documentation/Components/shader-TransSpecular.html
http://unity3d.com/support/documentation/Components/shader-TransBumped Diffuse.html


Transparent Normal mapped Specular 

 

Assets needed:  

 One Base texture with alpha channel for combined Transparency Map/Specular Map  

 One Normal map normal map, no alpha channel required  

Note: One limitation of this shader is that the Base texture's alpha channel doubles as a Specular Map for the Specular shaders in this 

family.  

» More details  

Transparent Parallax 

 

Assets needed:  

 One Base texture with alpha channel for Transparency Map  

 One Normal map normal map with alpha channel for Parallax Depth  

» More details  

Transparent Parallax Specular 

 

Assets needed:  

 One Base texture with alpha channel for combined Transparency Map/Specular Map  

 One Normal map normal map with alpha channel for Parallax Depth  

Note: One limitation of this shader is that the Base texture's alpha channel doubles as a Specular Map for the Specular shaders in this 

family.  

» More details  
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shader-TransVertexLit 

 

Transparent Properties 

This shader can make mesh geometry partially or fully transparent by reading the alpha channel of the main texture. In the alpha, 0 (black) 

is completely transparent while 255 (white) is completely opaque. If your main texture does not have an alpha channel, the object will 

appear completely opaque.  

Using transparent objects in your game can be tricky, as there are traditional graphical programming problems that can present sorting 

issues in your game. For example, if you see odd results when looking through two windows at once, you're experiencing the classical 

problem with using transparency. The general rule is to be aware that there are some cases in which one transparent object may be drawn 

in front of another in an unusual way, especially if the objects are intersecting, enclose each other or are of very different sizes. For this 

reason, you should use transparent objects if you need them, and try not to let them become excessive. You should also make your 

designer(s) aware that such sorting problems can occur, and have them prepare to change some design to work around these issues.  

Vertex-Lit Properties 

This shader is Vertex-Lit, which is one of the simplest shaders. All lights shining on it are rendered in a single pass and calculated at 

vertices only.  

Because it is vertex-lit, it won't display any pixel-based rendering effects, such as light cookies, normal mapping, or shadows. This shader 

is also much more sensitive to tesselation of the models. If you put a point light very close to a cube using this shader, the light will only be 

calculated at the corners. Pixel-lit shaders are much more effective at creating a nice round highlight, independent of tesselation. If that's an 

effect you want, you may consider using a pixel-lit shader or increase tesselation of the objects instead.  

Performance 

Generally, this shader is very cheap to render. For more details, please view the Shader Peformance page.  
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shader-TransDiffuse 

 

Transparent Properties 

This shader can make mesh geometry partially or fully transparent by reading the alpha channel of the main texture. In the alpha, 0 (black) 

is completely transparent while 255 (white) is completely opaque. If your main texture does not have an alpha channel, the object will 

appear completely opaque.  

Using transparent objects in your game can be tricky, as there are traditional graphical programming problems that can present sorting 

issues in your game. For example, if you see odd results when looking through two windows at once, you're experiencing the classical 

problem with using transparency. The general rule is to be aware that there are some cases in which one transparent object may be drawn 

in front of another in an unusual way, especially if the objects are intersecting, enclose each other or are of very different sizes. For this 

reason, you should use transparent objects if you need them, and try not to let them become excessive. You should also make your 

designer(s) aware that such sorting problems can occur, and have them prepare to change some design to work around these issues.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is cheap to render. For more details, please view the Shader Peformance page.  
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shader-TransSpecular 

http://unity3d.com/support/documentation/Components/shader-Performance.html


 

One consideration for this shader is that the Base texture's alpha channel defines both the Transparent areas as well as the Specular Map.  

Transparent Properties 

This shader can make mesh geometry partially or fully transparent by reading the alpha channel of the main texture. In the alpha, 0 (black) 

is completely transparent while 255 (white) is completely opaque. If your main texture does not have an alpha channel, the object will 

appear completely opaque.  

Using transparent objects in your game can be tricky, as there are traditional graphical programming problems that can present sorting 

issues in your game. For example, if you see odd results when looking through two windows at once, you're experiencing the classical 

problem with using transparency. The general rule is to be aware that there are some cases in which one transparent object may be drawn 

in front of another in an unusual way, especially if the objects are intersecting, enclose each other or are of very different sizes. For this 

reason, you should use transparent objects if you need them, and try not to let them become excessive. You should also make your 

designer(s) aware that such sorting problems can occur, and have them prepare to change some design to work around these issues.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is moderately expensive to render. For more details, please view the Shader Peformance page.  
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shader-TransBumped Diffuse 

 

Transparent Properties 

This shader can make mesh geometry partially or fully transparent by reading the alpha channel of the main texture. In the alpha, 0 (black) 

is completely transparent while 255 (white) is completely opaque. If your main texture does not have an alpha channel, the object will 

appear completely opaque.  

Using transparent objects in your game can be tricky, as there are traditional graphical programming problems that can present sorting 

issues in your game. For example, if you see odd results when looking through two windows at once, you're experiencing the classical 

problem with using transparency. The general rule is to be aware that there are some cases in which one transparent object may be drawn 

in front of another in an unusual way, especially if the objects are intersecting, enclose each other or are of very different sizes. For this 

reason, you should use transparent objects if you need them, and try not to let them become excessive. You should also make your 

designer(s) aware that such sorting problems can occur, and have them prepare to change some design to work around these issues.  

Normal Mapped Properties 

Like a Diffuse shader, this computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it 

and the light decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Normal mapping simulates small surface details using a texture, instead of spending more polygons to actually carve out details. It does 

not actually change the shape of the object, but uses a special texture called a Normal Map to achieve this effect. In the normal map, each 

pixel's color value represents the angle of the surface normal. Then by using this value instead of the one from geometry, lighting is 

computed. The normal map effectively overrides the mesh's geometry when calculating lighting of the object.  

Creating Normal maps 

You can import a regular grayscale image and convert it to a Normal Map from within Unity. To learn how to do this, please read the 

Normal map FAQ page.  

Technical Details 

http://unity3d.com/support/documentation/Manual/HOWTO-Normalmap.html


The Normal Map is a tangent space type of normal map. Tangent space is the space that "follows the surface" of the model geometry. In 

this space, Z always points away from the surface. Tangent space Normal Maps are a bit more expensive than the other "object space" 

type Normal Maps, but have some advantages:  

1. It's possible to use them on deforming models - the bumps will remain on the deforming surface and will just work.  

2. It's possible to reuse parts of the normal map on different areas of a model; or use them on different models.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is cheap to render. For more details, please view the Shader Peformance page.  
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shader-TransBumped Specular 

 

One consideration for this shader is that the Base texture's alpha channel defines both the Transparent areas as well as the Specular Map.  

Transparent Properties 

This shader can make mesh geometry partially or fully transparent by reading the alpha channel of the main texture. In the alpha, 0 (black) 

is completely transparent while 255 (white) is completely opaque. If your main texture does not have an alpha channel, the object will 

appear completely opaque.  

Using transparent objects in your game can be tricky, as there are traditional graphical programming problems that can present sorting 

issues in your game. For example, if you see odd results when looking through two windows at once, you're experiencing the classical 

problem with using transparency. The general rule is to be aware that there are some cases in which one transparent object may be drawn 

in front of another in an unusual way, especially if the objects are intersecting, enclose each other or are of very different sizes. For this 

http://unity3d.com/support/documentation/Components/shader-Performance.html


reason, you should use transparent objects if you need them, and try not to let them become excessive. You should also make your 

designer(s) aware that such sorting problems can occur, and have them prepare to change some design to work around these issues.  

Normal Mapped Properties 

Like a Diffuse shader, this computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it 

and the light decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Normal mapping simulates small surface details using a texture, instead of spending more polygons to actually carve out details. It does 

not actually change the shape of the object, but uses a special texture called a Normal Map to achieve this effect. In the normal map, each 

pixel's color value represents the angle of the surface normal. Then by using this value instead of the one from geometry, lighting is 

computed. The normal map effectively overrides the mesh's geometry when calculating lighting of the object.  

Creating Normal maps 

You can import a regular grayscale image and convert it to a Normal Map from within Unity. To learn how to do this, please read the 

Normal map FAQ page.  

Technical Details 

The Normal Map is a tangent space type of normal map. Tangent space is the space that "follows the surface" of the model geometry. In 

this space, Z always points away from the surface. Tangent space Normal Maps are a bit more expensive than the other "object space" 

type Normal Maps, but have some advantages:  

1. It's possible to use them on deforming models - the bumps will remain on the deforming surface and will just work.  

2. It's possible to reuse parts of the normal map on different areas of a model; or use them on different models.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is moderately expensive to render. For more details, please view the Shader Peformance page.  
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shader-TransParallax Diffuse 
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Transparent Properties 

This shader can make mesh geometry partially or fully transparent by reading the alpha channel of the main texture. In the alpha, 0 (black) 

is completely transparent while 255 (white) is completely opaque. If your main texture does not have an alpha channel, the object will 

appear completely opaque.  

Using transparent objects in your game can be tricky, as there are traditional graphical programming problems that can present sorting 

issues in your game. For example, if you see odd results when looking through two windows at once, you're experiencing the classical 

problem with using transparency. The general rule is to be aware that there are some cases in which one transparent object may be drawn 

in front of another in an unusual way, especially if the objects are intersecting, enclose each other or are of very different sizes. For this 

reason, you should use transparent objects if you need them, and try not to let them become excessive. You should also make your 

designer(s) aware that such sorting problems can occur, and have them prepare to change some design to work around these issues.  

Parallax Normal mapped Properties 

Parallax Normal mapped is the same as regular Normal mapped, but with a better simulation of "depth". The extra depth effect is 

achieved through the use of a Height Map. The Height Map is contained in the alpha channel of the Normal map. In the alpha, black is 

zero depth and white is full depth. This is most often used in bricks/stones to better display the cracks between them.  

The Parallax mapping technique is pretty simple, so it can have artifacts and unusual effects. Specifically, very steep height transitions in 

the Height Map should be avoided. Adjusting the Height value in the Inspector can also cause the object to become distorted in an odd, 

unrealistic way. For this reason, it is recommended that you use gradual Height Map transitions or keep the Height slider toward the 

shallow end.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance  

Generally, this shader is on the more expensive rendering side. For more details, please view the Shader Peformance page.  
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shader-TransParallax Specular 

 

One consideration for this shader is that the Base texture's alpha channel defines both the Transparent areas as well as the Specular Map.  

Transparent Properties 

This shader can make mesh geometry partially or fully transparent by reading the alpha channel of the main texture. In the alpha, 0 (black) 

is completely transparent while 255 (white) is completely opaque. If your main texture does not have an alpha channel, the object will 

appear completely opaque.  

Using transparent objects in your game can be tricky, as there are traditional graphical programming problems that can present sorting 

issues in your game. For example, if you see odd results when looking through two windows at once, you're experiencing the classical 

problem with using transparency. The general rule is to be aware that there are some cases in which one transparent object may be drawn 

in front of another in an unusual way, especially if the objects are intersecting, enclose each other or are of very different sizes. For this 

reason, you should use transparent objects if you need them, and try not to let them become excessive. You should also make your 

designer(s) aware that such sorting problems can occur, and have them prepare to change some design to work around these issues.  

Parallax Normal mapped Properties 

Parallax Normal mapped is the same as regular Normal mapped, but with a better simulation of "depth". The extra depth effect is 

achieved through the use of a Height Map. The Height Map is contained in the alpha channel of the Normal map. In the alpha, black is 

zero depth and white is full depth. This is most often used in bricks/stones to better display the cracks between them.  

The Parallax mapping technique is pretty simple, so it can have artifacts and unusual effects. Specifically, very steep height transitions in 

the Height Map should be avoided. Adjusting the Height value in the Inspector can also cause the object to become distorted in an odd, 

unrealistic way. For this reason, it is recommended that you use gradual Height Map transitions or keep the Height slider toward the 

shallow end.  

Specular Properties 



Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is on the more expensive rendering side. For more details, please view the Shader Peformance page.  
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shader-TransparentCutoutFamily 
The Transparent Cutout shaders are used for objects that have fully opaque and fully transparent parts (no partial transparency). Things 

like chain fences, trees, grass, etc.  

Transparent Cutout Vertex-Lit 

 

Assets needed:  

 One Base texture with alpha channel for Transparency Map  

» More details  

Transparent Cutout Diffuse 

 

Assets needed:  

 One Base texture with alpha channel for Transparency Map  

» More details  

Transparent Cutout Specular 

http://unity3d.com/support/documentation/Components/shader-Performance.html
http://unity3d.com/support/documentation/Components/shader-TransCutVertexLit.html
http://unity3d.com/support/documentation/Components/shader-TransCutVertexLit.html
http://unity3d.com/support/documentation/Components/shader-TransCutDiffuse.html
http://unity3d.com/support/documentation/Components/shader-TransCutDiffuse.html
http://unity3d.com/support/documentation/Components/shader-TransCutSpecular.html
http://unity3d.com/support/documentation/Components/shader-TransCutVertexLit.html
http://unity3d.com/support/documentation/Components/shader-TransCutDiffuse.html


 

Assets needed:  

 One Base texture with alpha channel for combined Transparency Map/Specular Map  

Note: One limitation of this shader is that the Base texture's alpha channel doubles as a Specular Map for the Specular shaders in this 

family.  

» More details  

Transparent Cutout Bumped 

 

Assets needed:  

 One Base texture with alpha channel for Transparency Map  

 One Normal map normal map, no alpha channel required  

» More details  

Transparent Cutout Bumped Specular 

 

Assets needed:  

 One Base texture with alpha channel for combined Transparency Map/Specular Map  

 One Normal map normal map, no alpha channel required  

Note: One limitation of this shader is that the Base texture's alpha channel doubles as a Specular Map for the Specular shaders in this 

family.  

» More details  
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shader-TransCutVertexLit 

 

Transparent Cutout Properties 

Cutout shader is an alternative way of displaying transparent objects. Differences between Cutout and regular Transparent shaders are:  

 This shader cannot have partially transparent areas. Everything will be either fully opaque or fully transparent.  

 Objects using this shader can cast and receive shadows!  

 The graphical sorting problems normally associated with Transparent shaders do not occur when using this shader.  

This shader uses an alpha channel contained in the Base Texture to determine the transparent areas. If the alpha contains a blend 

between transparent and opaque areas, you can manually determine the cutoff point for the which areas will be shown. You change this 

cutoff by adjusting the Alpha Cutoff slider.  

Vertex-Lit Properties 

This shader is Vertex-Lit, which is one of the simplest shaders. All lights shining on it are rendered in a single pass and calculated at 

vertices only.  

Because it is vertex-lit, it won't display any pixel-based rendering effects, such as light cookies, normal mapping, or shadows. This shader 

is also much more sensitive to tesselation of the models. If you put a point light very close to a cube using this shader, the light will only be 

calculated at the corners. Pixel-lit shaders are much more effective at creating a nice round highlight, independent of tesselation. If that's an 

effect you want, you may consider using a pixel-lit shader or increase tesselation of the objects instead.  

Performance 

Generally, this shader is very cheap to render. For more details, please view the Shader Peformance page.  
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shader-TransCutDiffuse 

 

Transparent Cutout Properties 

Cutout shader is an alternative way of displaying transparent objects. Differences between Cutout and regular Transparent shaders are:  

 This shader cannot have partially transparent areas. Everything will be either fully opaque or fully transparent.  

 Objects using this shader can cast and receive shadows!  

 The graphical sorting problems normally associated with Transparent shaders do not occur when using this shader.  

This shader uses an alpha channel contained in the Base Texture to determine the transparent areas. If the alpha contains a blend 

between transparent and opaque areas, you can manually determine the cutoff point for the which areas will be shown. You change this 

cutoff by adjusting the Alpha Cutoff slider.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is cheap to render. For more details, please view the Shader Peformance page.  
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shader-TransCutSpecular 
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One consideration for this shader is that the Base texture's alpha channel defines both the Transparent areas as well as the Specular Map.  

Transparent Cutout Properties 

Cutout shader is an alternative way of displaying transparent objects. Differences between Cutout and regular Transparent shaders are:  

 This shader cannot have partially transparent areas. Everything will be either fully opaque or fully transparent.  

 Objects using this shader can cast and receive shadows!  

 The graphical sorting problems normally associated with Transparent shaders do not occur when using this shader.  

This shader uses an alpha channel contained in the Base Texture to determine the transparent areas. If the alpha contains a blend 

between transparent and opaque areas, you can manually determine the cutoff point for the which areas will be shown. You change this 

cutoff by adjusting the Alpha Cutoff slider.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is moderately expensive to render. For more details, please view the Shader Peformance page.  
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shader-TransCutBumpedDiffuse 

 

Transparent Cutout Properties 

Cutout shader is an alternative way of displaying transparent objects. Differences between Cutout and regular Transparent shaders are:  

 This shader cannot have partially transparent areas. Everything will be either fully opaque or fully transparent.  

 Objects using this shader can cast and receive shadows!  

 The graphical sorting problems normally associated with Transparent shaders do not occur when using this shader.  

This shader uses an alpha channel contained in the Base Texture to determine the transparent areas. If the alpha contains a blend 

between transparent and opaque areas, you can manually determine the cutoff point for the which areas will be shown. You change this 

cutoff by adjusting the Alpha Cutoff slider.  

Normal Mapped Properties 

Like a Diffuse shader, this computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it 

and the light decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Normal mapping simulates small surface details using a texture, instead of spending more polygons to actually carve out details. It does 

not actually change the shape of the object, but uses a special texture called a Normal Map to achieve this effect. In the normal map, each 

pixel's color value represents the angle of the surface normal. Then by using this value instead of the one from geometry, lighting is 

computed. The normal map effectively overrides the mesh's geometry when calculating lighting of the object.  

Creating Normal maps 

You can import a regular grayscale image and convert it to a Normal Map from within Unity. To learn how to do this, please read the 

Normal map FAQ page.  

Technical Details 

The Normal Map is a tangent space type of normal map. Tangent space is the space that "follows the surface" of the model geometry. In 

this space, Z always points away from the surface. Tangent space Normal Maps are a bit more expensive than the other "object space" 

type Normal Maps, but have some advantages:  

http://unity3d.com/support/documentation/Components/shader-TransparentFamily.html
http://unity3d.com/support/documentation/Manual/HOWTO-Normalmap.html


1. It's possible to use them on deforming models - the bumps will remain on the deforming surface and will just work.  

2. It's possible to reuse parts of the normal map on different areas of a model; or use them on different models.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is cheap to render. For more details, please view the Shader Peformance page.  
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shader-TransCutBumpedSpecular 

 

One consideration for this shader is that the Base texture's alpha channel defines both the Transparent areas as well as the Specular Map.  

Transparent Cutout Properties 

Cutout shader is an alternative way of displaying transparent objects. Differences between Cutout and regular Transparent shaders are:  

 This shader cannot have partially transparent areas. Everything will be either fully opaque or fully transparent.  

 Objects using this shader can cast and receive shadows!  

 The graphical sorting problems normally associated with Transparent shaders do not occur when using this shader.  

This shader uses an alpha channel contained in the Base Texture to determine the transparent areas. If the alpha contains a blend 

between transparent and opaque areas, you can manually determine the cutoff point for the which areas will be shown. You change this 

cutoff by adjusting the Alpha Cutoff slider.  

Normal Mapped Properties 

http://unity3d.com/support/documentation/Components/shader-Performance.html
http://unity3d.com/support/documentation/Components/shader-TransparentFamily.html


Like a Diffuse shader, this computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it 

and the light decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Normal mapping simulates small surface details using a texture, instead of spending more polygons to actually carve out details. It does 

not actually change the shape of the object, but uses a special texture called a Normal Map to achieve this effect. In the normal map, each 

pixel's color value represents the angle of the surface normal. Then by using this value instead of the one from geometry, lighting is 

computed. The normal map effectively overrides the mesh's geometry when calculating lighting of the object.  

Creating Normal maps 

You can import a regular grayscale image and convert it to a Normal Map from within Unity. To learn how to do this, please read the 

Normal map FAQ page.  

Technical Details 

The Normal Map is a tangent space type of normal map. Tangent space is the space that "follows the surface" of the model geometry. In 

this space, Z always points away from the surface. Tangent space Normal Maps are a bit more expensive than the other "object space" 

type Normal Maps, but have some advantages:  

1. It's possible to use them on deforming models - the bumps will remain on the deforming surface and will just work.  

2. It's possible to reuse parts of the normal map on different areas of a model; or use them on different models.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is moderately expensive to render. For more details, please view the Shader Peformance page.  
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shader-SelfIllumFamily 
The Self-Illuminated shaders will emit light only onto themselves based on an attached alpha channel. They do not require any Lights to 

shine on them to emit this light. Any vertex lights or pixel lights will simply add more light on top of the self-illumination.  

This is mostly used for light emitting objects. For example, parts of the wall texture could be self-illuminated to simulate lights or displays. It 

can also be useful to light power-up objects that should always have consistent lighting throughout the game, regardless of the lights 

shining on it.  

Self-Illuminated Vertex-Lit 

http://unity3d.com/support/documentation/Manual/HOWTO-Normalmap.html
http://unity3d.com/support/documentation/Components/shader-Performance.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumVertexLit.html


 

Assets needed:  

 One Base texture, no alpha channel required  

 One Illumination texture with alpha channel for Illumination Map  

» More details  

Self-Illuminated Diffuse 

 

Assets needed:  

 One Base texture, no alpha channel required  

 One Illumination texture with alpha channel for Illumination Map  

» More details  

Self-Illuminated Specular 

 

Assets needed:  

 One Base texture with alpha channel for Specular Map  

 One Illumination texture with alpha channel for Illumination Map  

» More details  

Self-Illuminated Bumped 

 

http://unity3d.com/support/documentation/Components/shader-SelfIllumVertexLit.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumDiffuse.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumDiffuse.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumSpecular.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumSpecular.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumBumpedDiffuse.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumVertexLit.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumDiffuse.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumSpecular.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumBumpedDiffuse.html


Assets needed:  

 One Base texture, no alpha channel required  

 One Normal map normal map with alpha channel for Illumination  

» More details  

Self-Illuminated Bumped Specular 

 

Assets needed:  

 One Base texture with alpha channel for Specular Map  

 One Normal map normal map with alpha channel for Illumination Map  

» More details  

Self-Illuminated Parallax 

 

Assets needed:  

 One Base texture, no alpha channel required  

 One Normal map normal map with alpha channel for Illumination Map & Parallax Depth combined  

Note: One consideration of this shader is that the Bumpmap texture's alpha channel doubles as a Illumination and the Parallax Depth.  

» More details  

Self-Illuminated Parallax Specular 

 

Assets needed:  

 One Base texture with alpha channel for Specular Map  

 One Normal map normal map with alpha channel for Illumination Map & Parallax Depth combined  

http://unity3d.com/support/documentation/Components/shader-SelfIllumBumpedDiffuse.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumParallaxDiffuse.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumParallaxDiffuse.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumParallaxSpecular.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumParallaxDiffuse.html
http://unity3d.com/support/documentation/Components/shader-SelfIllumParallaxSpecular.html


Note: One consideration of this shader is that the Bumpmap texture's alpha channel doubles as a Illumination and the Parallax Depth.  

» More details  
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shader-SelfIllumVertexLit 

 

Self-Illuminated Properties 

This shader allows you to define bright and dark parts of the object. The alpha channel of a secondary texture will define areas of the object 

that "emit" light by themselves, even when no light is shining on it. In the alpha channel, black is zero light, and white is full light emitted by 

the object. Any scene lights will add illumination on top of the shader's illumination. So even if your object does not emit any light by itself, it 

will still be lit by lights in your scene.  

Vertex-Lit Properties 

This shader is Vertex-Lit, which is one of the simplest shaders. All lights shining on it are rendered in a single pass and calculated at 

vertices only.  

Because it is vertex-lit, it won't display any pixel-based rendering effects, such as light cookies, normal mapping, or shadows. This shader 

is also much more sensitive to tesselation of the models. If you put a point light very close to a cube using this shader, the light will only be 

calculated at the corners. Pixel-lit shaders are much more effective at creating a nice round highlight, independent of tesselation. If that's an 

effect you want, you may consider using a pixel-lit shader or increase tesselation of the objects instead.  

Performance 

Generally, this shader is cheap to render. For more details, please view the Shader Peformance page.  
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shader-SelfIllumDiffuse 

 

Self-Illuminated Properties 

This shader allows you to define bright and dark parts of the object. The alpha channel of a secondary texture will define areas of the object 

that "emit" light by themselves, even when no light is shining on it. In the alpha channel, black is zero light, and white is full light emitted by 

the object. Any scene lights will add illumination on top of the shader's illumination. So even if your object does not emit any light by itself, it 

will still be lit by lights in your scene.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is cheap to render. For more details, please view the Shader Peformance page.  
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shader-SelfIllumSpecular 
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Self-Illuminated Properties 

This shader allows you to define bright and dark parts of the object. The alpha channel of a secondary texture will define areas of the object 

that "emit" light by themselves, even when no light is shining on it. In the alpha channel, black is zero light, and white is full light emitted by 

the object. Any scene lights will add illumination on top of the shader's illumination. So even if your object does not emit any light by itself, it 

will still be lit by lights in your scene.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is moderately expensive to render. For more details, please view the Shader Peformance page.  
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shader-SelfIllumBumpedDiffuse 
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One consideration for this shader is that the Alpha Channel of the Normal map also defines the Illumination Map.  

Self-Illuminated Properties 

This shader allows you to define bright and dark parts of the object. The alpha channel of a secondary texture will define areas of the object 

that "emit" light by themselves, even when no light is shining on it. In the alpha channel, black is zero light, and white is full light emitted by 

the object. Any scene lights will add illumination on top of the shader's illumination. So even if your object does not emit any light by itself, it 

will still be lit by lights in your scene.  

Normal Mapped Properties 

Like a Diffuse shader, this computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it 

and the light decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Normal mapping simulates small surface details using a texture, instead of spending more polygons to actually carve out details. It does 

not actually change the shape of the object, but uses a special texture called a Normal Map to achieve this effect. In the normal map, each 

pixel's color value represents the angle of the surface normal. Then by using this value instead of the one from geometry, lighting is 

computed. The normal map effectively overrides the mesh's geometry when calculating lighting of the object.  

Creating Normal maps 

You can import a regular grayscale image and convert it to a Normal Map from within Unity. To learn how to do this, please read the 

Normal map FAQ page.  

Technical Details 

The Normal Map is a tangent space type of normal map. Tangent space is the space that "follows the surface" of the model geometry. In 

this space, Z always points away from the surface. Tangent space Normal Maps are a bit more expensive than the other "object space" 

type Normal Maps, but have some advantages:  

1. It's possible to use them on deforming models - the bumps will remain on the deforming surface and will just work.  

2. It's possible to reuse parts of the normal map on different areas of a model; or use them on different models.  

Diffuse Properties 

http://unity3d.com/support/documentation/Manual/HOWTO-Normalmap.html


Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is cheap to render. For more details, please view the Shader Peformance page.  
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shader-SelfIllumBumpedSpecular 

 

One consideration for this shader is that the Alpha Channel of the Bump map also defines the Illumination Map.  

Self-Illuminated Properties 

This shader allows you to define bright and dark parts of the object. The alpha channel of a secondary texture will define areas of the object 

that "emit" light by themselves, even when no light is shining on it. In the alpha channel, black is zero light, and white is full light emitted by 

the object. Any scene lights will add illumination on top of the shader's illumination. So even if your object does not emit any light by itself, it 

will still be lit by lights in your scene.  

Normal Mapped Properties 

Like a Diffuse shader, this computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it 

and the light decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Normal mapping simulates small surface details using a texture, instead of spending more polygons to actually carve out details. It does 

not actually change the shape of the object, but uses a special texture called a Normal Map to achieve this effect. In the normal map, each 

pixel's color value represents the angle of the surface normal. Then by using this value instead of the one from geometry, lighting is 

computed. The normal map effectively overrides the mesh's geometry when calculating lighting of the object.  

Creating Normal maps 

http://unity3d.com/support/documentation/Components/shader-Performance.html


You can import a regular grayscale image and convert it to a Normal Map from within Unity. To learn how to do this, please read the 

Normal map FAQ page.  

Technical Details 

The Normal Map is a tangent space type of normal map. Tangent space is the space that "follows the surface" of the model geometry. In 

this space, Z always points away from the surface. Tangent space Normal Maps are a bit more expensive than the other "object space" 

type Normal Maps, but have some advantages:  

1. It's possible to use them on deforming models - the bumps will remain on the deforming surface and will just work.  

2. It's possible to reuse parts of the normal map on different areas of a model; or use them on different models.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is moderately expensive to render. For more details, please view the Shader Peformance page.  
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shader-SelfIllumParallaxDiffuse 
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One consideration for this shader is that the alpha channel the normal map is used for both Illumination map and the height for the Parallax 

depth.  

Self-Illuminated Properties 

This shader allows you to define bright and dark parts of the object. The alpha channel of a secondary texture will define areas of the object 

that "emit" light by themselves, even when no light is shining on it. In the alpha channel, black is zero light, and white is full light emitted by 

the object. Any scene lights will add illumination on top of the shader's illumination. So even if your object does not emit any light by itself, it 

will still be lit by lights in your scene.  

Parallax Normal mapped Properties 

Parallax Normal mapped is the same as regular Normal mapped, but with a better simulation of "depth". The extra depth effect is 

achieved through the use of a Height Map. The Height Map is contained in the alpha channel of the Normal map. In the alpha, black is 

zero depth and white is full depth. This is most often used in bricks/stones to better display the cracks between them.  

The Parallax mapping technique is pretty simple, so it can have artifacts and unusual effects. Specifically, very steep height transitions in 

the Height Map should be avoided. Adjusting the Height value in the Inspector can also cause the object to become distorted in an odd, 

unrealistic way. For this reason, it is recommended that you use gradual Height Map transitions or keep the Height slider toward the 

shallow end.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is on the more expensive rendering side. For more details, please view the Shader Peformance page.  
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shader-SelfIllumParallaxSpecular 
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One consideration for this shader is that the alpha channel the normal map is used for both Illumination map and the height for the Parallax 

depth.  

Self-Illuminated Properties 

This shader allows you to define bright and dark parts of the object. The alpha channel of a secondary texture will define areas of the object 

that "emit" light by themselves, even when no light is shining on it. In the alpha channel, black is zero light, and white is full light emitted by 

the object. Any scene lights will add illumination on top of the shader's illumination. So even if your object does not emit any light by itself, it 

will still be lit by lights in your scene.  

Parallax Normal mapped Properties 

Parallax Normal mapped is the same as regular Normal mapped, but with a better simulation of "depth". The extra depth effect is 

achieved through the use of a Height Map. The Height Map is contained in the alpha channel of the Normal map. In the alpha, black is 

zero depth and white is full depth. This is most often used in bricks/stones to better display the cracks between them.  

The Parallax mapping technique is pretty simple, so it can have artifacts and unusual effects. Specifically, very steep height transitions in 

the Height Map should be avoided. Adjusting the Height value in the Inspector can also cause the object to become distorted in an odd, 

unrealistic way. For this reason, it is recommended that you use gradual Height Map transitions or keep the Height slider toward the 

shallow end.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  



Performance 

Generally, this shader is on the more expensive rendering side. For more details, please view the Shader Peformance page.  
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shader-ReflectiveFamily 
Reflective shaders will allow you to use a Cubemap which will be reflected on your mesh. You can also define areas of more or less 

reflectivity on your object through the alpha channel of the Base texture. High relectivity is a great effect for glosses, oils, chrome, etc. Low 

reflectivity can add effect for metals, liquid surfaces, or video monitors.  

Reflective Vertex-Lit 

 

Assets needed:  

 One Base texture with alpha channel for defining reflective areas  

 One Reflection Cubemap for Reflection Map  

» More details  

Reflective Diffuse 

 

Assets needed:  

 One Base texture with alpha channel for defining reflective areas  

 One Reflection Cubemap for Reflection Map  

» More details  

Reflective Specular 

 

Assets needed:  

http://unity3d.com/support/documentation/Components/shader-Performance.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveVertexLit.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveVertexLit.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveDiffuse.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveDiffuse.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveVertexLit.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveDiffuse.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveSpecular.html


 One Base texture with alpha channel for defining reflective areas & Specular Map combined  

 One Reflection Cubemap for Reflection Map  

Note: One consideration for this shader is that the Base texture's alpha channel will double as both the reflective areas and the Specular 

Map.  

» More details  

Reflective Normal mapped 

 

Assets needed:  

 One Base texture with alpha channel for defining reflective areas  

 One Reflection Cubemap for Reflection Map  

 One Normal map normal map, no alpha channel required  

» More details  

Reflective Normal Mapped Specular 

 

Assets needed:  

 One Base texture with alpha channel for defining reflective areas & Specular Map combined  

 One Reflection Cubemap for Reflection Map  

 One Normal map normal map, no alpha channel required  

Note: One consideration for this shader is that the Base texture's alpha channel will double as both the reflective areas and the Specular 

Map.  

» More details  

Reflective Parallax 

 

Assets needed:  

http://unity3d.com/support/documentation/Components/shader-ReflectiveSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedDiffuse.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedDiffuse.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveParallaxDiffuse.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedDiffuse.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveParallaxDiffuse.html


 One Base texture with alpha channel for defining reflective areas  

 One Reflection Cubemap for Reflection Map  

 One Normal map normal map, with alpha channel for Parallax Depth  

» More details  

Reflective Parallax Specular 

 

Assets needed:  

 One Base texture with alpha channel for defining reflective areas & Specular Map  

 One Reflection Cubemap for Reflection Map  

 One Normal map normal map, with alpha channel for Parallax Depth  

Note: One consideration for this shader is that the Base texture's alpha channel will double as both the reflective areas and the Specular 

Map.  

» More details  

Reflective Normal mapped Unlit 

 

Assets needed:  

 One Base texture with alpha channel for defining reflective areas  

 One Reflection Cubemap for Reflection Map  

 One Normal map normal map, no alpha channel required  

» More details  

Reflective Normal mapped Vertex-Lit 

 

Assets needed:  

 One Base texture with alpha channel for defining reflective areas  

http://unity3d.com/support/documentation/Components/shader-ReflectiveParallaxDiffuse.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveParallaxSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveParallaxSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedUnlit.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedUnlit.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedVertexLit.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveParallaxSpecular.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedUnlit.html
http://unity3d.com/support/documentation/Components/shader-ReflectiveBumpedVertexLit.html


 One Reflection Cubemap for Reflection Map  

 One Normal map normal map, no alpha channel required  

» More details  
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shader-ReflectiveVertexLit 

 

Reflective Properties 

This shader will simulate reflective surfaces such as cars, metal objects etc. It requires an environment Cubemap which will define what 

exactly is reflected. The main texture's alpha channel defines the strength of reflection on the object's surface. Any scene lights will add 

illumination on top of what is reflected.  

Vertex-Lit Properties 

This shader is Vertex-Lit, which is one of the simplest shaders. All lights shining on it are rendered in a single pass and calculated at 

vertices only.  

Because it is vertex-lit, it won't display any pixel-based rendering effects, such as light cookies, normal mapping, or shadows. This shader 

is also much more sensitive to tesselation of the models. If you put a point light very close to a cube using this shader, the light will only be 

calculated at the corners. Pixel-lit shaders are much more effective at creating a nice round highlight, independent of tesselation. If that's an 

effect you want, you may consider using a pixel-lit shader or increase tesselation of the objects instead.  

Performance 

Generally, this shader is not too expensive to render. For more details, please view the Shader Peformance page.  
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shader-ReflectiveDiffuse 

 

Reflective Properties 

This shader will simulate reflective surfaces such as cars, metal objects etc. It requires an environment Cubemap which will define what 

exactly is reflected. The main texture's alpha channel defines the strength of reflection on the object's surface. Any scene lights will add 

illumination on top of what is reflected.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is cheap to render. For more details, please view the Shader Peformance page.  
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shader-ReflectiveSpecular 

http://unity3d.com/support/documentation/Components/shader-Performance.html


 

One consideration for this shader is that the Base texture's alpha channel will double as both the Reflection Map and the Specular Map.  

Reflective Properties 

This shader will simulate reflective surfaces such as cars, metal objects etc. It requires an environment Cubemap which will define what 

exactly is reflected. The main texture's alpha channel defines the strength of reflection on the object's surface. Any scene lights will add 

illumination on top of what is reflected.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is moderately expensive to render. For more details, please view the Shader Peformance page.  
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shader-ReflectiveBumpedDiffuse 

http://unity3d.com/support/documentation/Components/shader-Performance.html


 

Reflective Properties 

This shader will simulate reflective surfaces such as cars, metal objects etc. It requires an environment Cubemap which will define what 

exactly is reflected. The main texture's alpha channel defines the strength of reflection on the object's surface. Any scene lights will add 

illumination on top of what is reflected.  

Normal Mapped Properties 

Like a Diffuse shader, this computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it 

and the light decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Normal mapping simulates small surface details using a texture, instead of spending more polygons to actually carve out details. It does 

not actually change the shape of the object, but uses a special texture called a Normal Map to achieve this effect. In the normal map, each 

pixel's color value represents the angle of the surface normal. Then by using this value instead of the one from geometry, lighting is 

computed. The normal map effectively overrides the mesh's geometry when calculating lighting of the object.  

Creating Normal maps 

You can import a regular grayscale image and convert it to a Normal Map from within Unity. To learn how to do this, please read the 

Normal map FAQ page.  

Technical Details 

The Normal Map is a tangent space type of normal map. Tangent space is the space that "follows the surface" of the model geometry. In 

this space, Z always points away from the surface. Tangent space Normal Maps are a bit more expensive than the other "object space" 

type Normal Maps, but have some advantages:  

1. It's possible to use them on deforming models - the bumps will remain on the deforming surface and will just work.  

2. It's possible to reuse parts of the normal map on different areas of a model; or use them on different models.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

http://unity3d.com/support/documentation/Manual/HOWTO-Normalmap.html


Performance 

Generally, this shader is cheap to render. For more details, please view the Shader Peformance page.  
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shader-ReflectiveBumpedSpecular 

 

One consideration for this shader is that the Base texture's alpha channel will double as both the Reflection Map and the Specular Map.  

Reflective Properties 

This shader will simulate reflective surfaces such as cars, metal objects etc. It requires an environment Cubemap which will define what 

exactly is reflected. The main texture's alpha channel defines the strength of reflection on the object's surface. Any scene lights will add 

illumination on top of what is reflected.  

Normal Mapped Properties 

Like a Diffuse shader, this computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it 

and the light decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Normal mapping simulates small surface details using a texture, instead of spending more polygons to actually carve out details. It does 

not actually change the shape of the object, but uses a special texture called a Normal Map to achieve this effect. In the normal map, each 

pixel's color value represents the angle of the surface normal. Then by using this value instead of the one from geometry, lighting is 

computed. The normal map effectively overrides the mesh's geometry when calculating lighting of the object.  

Creating Normal maps 

You can import a regular grayscale image and convert it to a Normal Map from within Unity. To learn how to do this, please read the 

Normal map FAQ page.  

Technical Details 

http://unity3d.com/support/documentation/Components/shader-Performance.html
http://unity3d.com/support/documentation/Manual/HOWTO-Normalmap.html


The Normal Map is a tangent space type of normal map. Tangent space is the space that "follows the surface" of the model geometry. In 

this space, Z always points away from the surface. Tangent space Normal Maps are a bit more expensive than the other "object space" 

type Normal Maps, but have some advantages:  

1. It's possible to use them on deforming models - the bumps will remain on the deforming surface and will just work.  

2. It's possible to reuse parts of the normal map on different areas of a model; or use them on different models.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is moderately expensive to render. For more details, please view the Shader Peformance page.  
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shader-ReflectiveParallaxDiffuse 

 

Reflective Properties 

http://unity3d.com/support/documentation/Components/shader-Performance.html


This shader will simulate reflective surfaces such as cars, metal objects etc. It requires an environment Cubemap which will define what 

exactly is reflected. The main texture's alpha channel defines the strength of reflection on the object's surface. Any scene lights will add 

illumination on top of what is reflected.  

Parallax Normal mapped Properties 

Parallax Normal mapped is the same as regular Normal mapped, but with a better simulation of "depth". The extra depth effect is 

achieved through the use of a Height Map. The Height Map is contained in the alpha channel of the Normal map. In the alpha, black is 

zero depth and white is full depth. This is most often used in bricks/stones to better display the cracks between them.  

The Parallax mapping technique is pretty simple, so it can have artifacts and unusual effects. Specifically, very steep height transitions in 

the Height Map should be avoided. Adjusting the Height value in the Inspector can also cause the object to become distorted in an odd, 

unrealistic way. For this reason, it is recommended that you use gradual Height Map transitions or keep the Height slider toward the 

shallow end.  

Diffuse Properties 

Diffuse computes a simple (Lambertian) lighting model. The lighting on the surface decreases as the angle between it and the light 

decreases. The lighting depends only on the this angle, and does not change as the camera moves or rotates around.  

Performance 

Generally, this shader is on the more expensive rendering side. For more details, please view the Shader Peformance page.  
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shader-ReflectiveParallaxSpecular 

 

One consideration for this shader is that the Base texture's alpha channel will double as both the Reflection Map and the Specular Map.  

Reflective Properties 

http://unity3d.com/support/documentation/Components/shader-Performance.html


This shader will simulate reflective surfaces such as cars, metal objects etc. It requires an environment Cubemap which will define what 

exactly is reflected. The main texture's alpha channel defines the strength of reflection on the object's surface. Any scene lights will add 

illumination on top of what is reflected.  

Parallax Normal mapped Properties 

Parallax Normal mapped is the same as regular Normal mapped, but with a better simulation of "depth". The extra depth effect is 

achieved through the use of a Height Map. The Height Map is contained in the alpha channel of the Normal map. In the alpha, black is 

zero depth and white is full depth. This is most often used in bricks/stones to better display the cracks between them.  

The Parallax mapping technique is pretty simple, so it can have artifacts and unusual effects. Specifically, very steep height transitions in 

the Height Map should be avoided. Adjusting the Height value in the Inspector can also cause the object to become distorted in an odd, 

unrealistic way. For this reason, it is recommended that you use gradual Height Map transitions or keep the Height slider toward the 

shallow end.  

Specular Properties 

Specular computes the same simple (Lambertian) lighting as Diffuse, plus a viewer dependent specular highlight. This is called the Blinn-

Phong lighting model. It has a specular highlight that is dependent on surface angle, light angle, and viewing angle. The highlight is actually 

just a realtime-suitable way to simulate blurred reflection of the light source. The level of blur for the highlight is controlled with the 

Shininess slider in the Inspector.  

Additionally, the alpha channel of the main texture acts as a Specular Map (sometimes called "gloss map"), defining which areas of the 

object are more reflective than others. Black areas of the alpha will be zero specular reflection, while white areas will be full specular 

reflection. This is very useful when you want different areas of your object to reflect different levels of specularity. For example, something 

like rusty metal would use low specularity, while polished metal would use high specularity. Lipstick has higher specularity than skin, and 

skin has higher specularity than cotton clothes. A well-made Specular Map can make a huge difference in impressing the player.  

Performance 

Generally, this shader is on the more expensive rendering side. For more details, please view the Shader Peformance page.  
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shader-ReflectiveBumpedUnlit 

http://unity3d.com/support/documentation/Components/shader-Performance.html


 

Reflective Properties 

This shader will simulate reflective surfaces such as cars, metal objects etc. It requires an environment Cubemap which will define what 

exactly is reflected. The main texture's alpha channel defines the strength of reflection on the object's surface. Any scene lights will add 

illumination on top of what is reflected.  

Normal mapped Properties 

This shader does not use normal-mapping in the traditional way. The normal map does not affect any lights shining on the object, because 

the shader does not use lights at all. The normal map will only distort the reflection map.  

Special Properties 

This shader is special because it does not respond to lights at all, so you don't have to worry about performance reduction from use of 

multiple lights. It simply displays the reflection cube map on the model. The reflection is distorted by the normal map, so you get the benefit 

of detailed reflection. Because it does not respond to lights, it is quite cheap. It is somewhat of a specialized use case, but in those cases it 

does exactly what you want as cheaply as possible.  

Performance 

Generally, this shader is quite cheap to render. For more details, please view the Shader Peformance page.  
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shader-ReflectiveBumpedVertexLit 

http://unity3d.com/support/documentation/Components/shader-Performance.html


 

Reflective Properties 

This shader will simulate reflective surfaces such as cars, metal objects etc. It requires an environment Cubemap which will define what 

exactly is reflected. The main texture's alpha channel defines the strength of reflection on the object's surface. Any scene lights will add 

illumination on top of what is reflected.  

Vertex-Lit Properties 

This shader is Vertex-Lit, which is one of the simplest shaders. All lights shining on it are rendered in a single pass and calculated at 

vertices only.  

Because it is vertex-lit, it won't display any pixel-based rendering effects, such as light cookies, normal mapping, or shadows. This shader 

is also much more sensitive to tesselation of the models. If you put a point light very close to a cube using this shader, the light will only be 

calculated at the corners. Pixel-lit shaders are much more effective at creating a nice round highlight, independent of tesselation. If that's an 

effect you want, you may consider using a pixel-lit shader or increase tesselation of the objects instead.  

Special Properties 

This shader is a good alternative to Reflective Normal mapped. If you do not need the object itself to be affected by pixel lights, but do want 

the reflection to be affected by a normal map, this shader is for you. This shader is vertex-lit, so it is rendered more quickly than its 

Reflective Normal mapped counterpart.  

Performance 

Generally, this shader is not expensive to render. For more details, please view the Shader Peformance page.  
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Rendering-Tech 
This section explains technical details behind various areas of Unity's rendering engine.  

http://unity3d.com/support/documentation/Components/shader-Performance.html


 Deferred Lighting Rendering Path Details  

 Forward Rendering Path Details  

 Vertex Lit Rendering Path Details  

 Hardware Requirements for Unity's Graphics Features  
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RenderTech-DeferredLighting 
This page describes details of Deferred Lighting rendering path. For a technical overview of what Deferred Lighting is, see Deferred 

Lighting Approaches article.  

Deferred Lighting is rendering path with the most lighting and shadow fidelity:  

 There's no limit how many lights can affect any object.  

 All lights are evaluated per-pixel. Which means that they all interact properly with normal maps etc.  

 All lights can have Cookies.  

 All lights can have Shadows.  

Deferred Lighting's advantages:  

 Lighting cost is proportional to light size on screen. Does not matter how many objects it shines on. Small lights = cheap!  

 Consistency. All lighting for all lights is computed per-pixel; there are no lighting computations that break down on large triangles etc.  

Disadvantages: 

 No real anti-aliasing support.  

 Deferred Lighting can't handle semi-transparent objects. Those are rendered using Forward Rendering.  

 Limited lighting model support (Blinn-Phong). All lighting is computed the same way; you can't have drastically different lighting models on 

different objects.  

 No support for "receive shadows" flag and limited support light Culling Masks.  

Requirements for Deferred Lighting 

 Requires Unity Pro.  

 Graphics card with Shader Model 3.0 (or later), support for Depth render textures and two-sided stencil buffer. Most graphics cards made 

after 2004 support it: GeForce FX and later, Radeon X1300 and later, Intel 965 / GMA X3100 and later.  

 Currently does not work on mobile platforms.  

Performance Considerations 

Cost of realtime lights in Deferred Lighting is proportional to number of pixels the light shines on; and not dependent on scene complexity. 

So small point or spot lights are very cheap to render. Point or spot lights that are fully or partially occluded by some scene objects get their 

pixels skipped on the GPU, so they are even cheaper.  

Of course, lights with shadows are much more expensive than lights without shadows. In Deferred Lighting, shadow casters still need to be 

rendered once or more for each shadow-casting light. And the lighting shader that applies shadows is also more expensive than one 

without shadows.  

Implementation Details 

When Deferred Lighting is used, rendering process in Unity happens like this:  

1. Base Pass: objects are rendered, producing screen-space buffers with depth, normals, and specular power.  

http://unity3d.com/support/documentation/Components/RenderTech-DeferredLighting.html
http://unity3d.com/support/documentation/Components/RenderTech-ForwardRendering.html
http://unity3d.com/support/documentation/Components/RenderTech-VertexLit.html
http://unity3d.com/support/documentation/Components/RenderTech-HardwareRequirements.html
http://unity3d.com/support/documentation/Manual/RenderingPaths.html
http://www.realtimerendering.com/blog/deferred-lighting-approaches/
http://www.realtimerendering.com/blog/deferred-lighting-approaches/


2. Lighting pass: lighting is computed using the previous buffers. Lighting is computed into another screen-space buffer.  

3. Final pass: objects are rendered again. They fetch computed lighting, combine it with color textures and add any ambient/emissive 

lighting.  

Objects with shaders that can't handle Deferred Lighting are rendered after this process is done, using RenderTech-ForwardRendering 

path.  

Base Pass 

Base pass renders each object once. View space normals and specular power are rendered into single ARGB32 Render Texture (normals 

in RGB channels, specular power in A). If platform & hardware supports reading Z buffer as a texture, then depth is not explicitly rendered. 

If Z buffer can't be accessed as a texture, then depth is rendered in additional rendering pass, using shader replacement.  

Result of the base pass is Z buffer filled with scene contents and Render Texture with normals & specular power.  

Lighting Pass 

Lighting pass computes lighting based on depth, normals and specular power. Lighting is computed in screen space, so it's independent of 

scene complexity. Lighting buffer is single ARGB32 Render Texture, with diffuse lighting in RGB channels and monochrome specular 

lighting in A channel. Lighting values are encoded using logarithmic encoding to provide extended dynamic range than usually possible with 

ARGB32 texture.  

Lighting model is fixed to Blinn-Phong.  

Point and Spot lights that do not cross camera's near plane are rendered as 3D shapes, with Z buffer test against scene enabled. This 

makes partially or fully occluded Point and Spot lights very cheap to render. Directional lights and Point/Spot lights that cross the near 

plane are rendered as fullscreen quads.  

If a light has shadows enabled, they are rendered and applies in this pass as well. Note that shadows are not "free"; shadow casters need 

to be rendered and a more complex light shader needs to be applied.  

Final Pass 

Final pass produces final rendered image. Here all objects are rendered again; with shaders that fetch the lighting, combine it with textures 

and add any emissive lighting.  

Lightmaps are also applied in the final pass. Close to the camera, realtime lighting is used, and only baked indirect lighting is added. This 

crossfades into fully baked lighting further away from the camera.  
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RenderTech-ForwardRendering 
This page describes details of Forward rendering path.  

Forward Rendering path renders each object in one or more passes, depending on lights that affect the object. Lights themselves are also 

treated differently by Forward Rendering, depending on their settings and intensity.  

Implementation Details 

In Forward Rendering, some number of brightest lights that affect each object are rendered in fully per-pixel lit mode. Then, up to 4 point 

lights are calculated per-vertex. The other lights are computed as Spherical Harmonics (SH), which is much faster but is only an 

approximation. Whether a light will be per-pixel light or not is dependent on this:  

http://unity3d.com/support/documentation/Components/RenderTech-ForwardRendering.html
http://unity3d.com/support/documentation/Components/class-RenderTexture.html
http://unity3d.com/support/documentation/Components/SL-ShaderReplacement.html
http://unity3d.com/support/documentation/Manual/RenderingPaths.html


 Lights that have their Render Mode set to Not Important are always per-vertex or SH.  

 Brightest directional light is always per-pixel.  

 Lights that have their Render Mode set to Important are always per-pixel.  

 If the above results in less lights than current Pixel Light Count Quality Setting, then more lights are rendered per-pixel, in order of 

decreasing brightness.  

Rendering of each object happens as follows:  

 Base Pass applies one per-pixel directional light and all per-vertex/SH lights.  

 Other per-pixel lights are rendered in additional passes, one pass for each light.  

For example, if there is some object that's affected by a number of lights (a circle in a picture below, affected by lights A to H):  

 

Let's assume lights A to H have the same color & intensity, all all of them have Auto rendering mode, so they would be sorted in exactly this 

order for this object. The brightest lights will be rendered in per-pixel lit mode (A to D), then up to 4 lights in per-vertex lit mode (D to G), and 

finally the rest of lights in SH (G to H):  

 

Note that light groups overlap; for example last per-pixel light blends into per-vertex lit mode so there are less "light popping" as objects and 

lights move around.  

Base Pass 

Base pass renders object with one per-pixel directional light and all SH lights. This pass also adds any lightmaps, ambient and emissive 

lighting from the shader. Directional light rendered in this pass can have Shadows. Note that Lightmapped objects do not get illumination 

from SH lights.  

Additional Passes 

Additional passes are rendered for each additional per-pixel light that affect this object. Lights in these passes can't have shadows (so in 

result, Forward Rendering supports one directional light with shadows).  

Performance Considerations 

http://unity3d.com/support/documentation/Components/class-QualitySettings.html


Spherical Harmonics lights are very fast to render. They have a tiny cost on the CPU, and are actually free for the GPU to apply (that is, 

base pass always computes SH lighting; but due to the way SH lights work, the cost is exactly the same no matter how many SH lights are 

there).  

The downsides of SH lights are:  

 They are computed at object's vertices, not pixels. This means they do not support light Cookies or normal maps.  

 SH lighting is very low frequency. You can't have sharp lighting transitions with SH lights. They are also only affecting the diffuse lighting 

(too low frequency for specular highlights).  

 SH lighting is is not local; point or spot SH lights close to some surface will "look wrong".  

In summary, SH lights are often good enough for small dynamic objects.  

Page last updated: 2010-07-08 

 

 

RenderTech-VertexLit 
This page describes details of Vertex Lit rendering path.  

Vertex Lit path generally renders each object in one pass, with lighting from all lights calculated at object vertices.  

It's the fastest rendering path and has widest hardware support (however, keep in mind: it does not work on consoles).  

Since all lighting is calculated at vertex level, this rendering path does not support most of per-pixel effects: shadows, normal mapping, light 

cookies, highly detailed specular highlights are not supported.  
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RenderTech-HardwareRequirements 

Summary 

  PC/Mac iOS/Android 360/PS3 

Deferred lighting SM3.0, GPU support - Yes 

Forward rendering SM2.0 OpenGL ES 2.0 Yes 

Vertex Lit rendering Yes Yes - 

Realtime Shadows SM2.0, GPU support - Yes 

Image Effects Most need SM2.0 Most need OpenGL ES 2.0 Yes 

Vertex Shaders SM1.1 OpenGL ES 2.0 Yes 

Pixel Shaders SM2.0 OpenGL ES 2.0 Yes 

Fixed Function Shaders Yes Yes - 

Realtime Shadows 

Realtime Shadows currently work on desktop & console platforms. On desktops, they generally need Shader Model 2.0 capable GPU. On 

Windows (Direct3D), the GPU also needs to support shadow mapping features; most discrete GPUs support that since 2003 and most 

integrated GPUs support that since 2007. Technically, on Direct3D 9 the GPU has to support D16/D24X8 or DF16/DF24 texture formats; 

and on OpenGL it has to support GL_ARB_depth_texture extension.  

Image Effects 

http://unity3d.com/support/documentation/Manual/RenderingPaths.html
http://aras-p.info/texts/D3D9GPUHacks.html


Image Effects require render-to-texture functionality, which is generally supported on anything made in this millenium. However, all except 

the simplest effects require quite programmable pixel shaders, so for all practical purposes they require Shader Model 2.0 on desktop 

(discrete GPUs since 2003; integrated GPUs since 2005) and OpenGL ES 2.0 on mobile platforms.  

Shaders 

In Unity, you can write fixed function or programmable shaders. Fixed function is supported everywhere except consoles (Xbox 360 & 

Playstation 3). Programmable shaders default to Shader Model 2.0 (desktop) and OpenGL ES 2.0 (mobile). On desktop platforms, it is 

possible to target Shader Model 1.1 for vertex shaders.  
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SL-Reference 
Shaders in Unity can be written in one of three different ways:  

 as surface shaders,  

 as vertex and fragment shaders and  

 as fixed function shaders.  

The shader tutorial can guide you on choosing the right type for your needs.  

Regardless of which type you choose, the actual meat of the shader code will always be wrapped in a language called ShaderLab, which is 

used to organize the shader structure. It looks like this:  

Shader "MyShader" { 

    Properties { 

        _MyTexture ("My Texture", 2D) = "white" { } 

        // other properties like colors or vectors go here as well 

    } 

    SubShader { 

        // here goes the 'meat' of your 

        //  - surface shader or 

        //  - vertex and program shader or 

        //  - fixed function shader 

    } 

    SubShader { 
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        // here goes a simpler version of the SubShader above than can run on older graphics cards 

    } 

}  

We recommend that you start by reading about some basic concepts of the ShaderLab syntax in the sections listed below and then to 

move on to read about surface shaders or vertex and fragment shaders in other sections. Since fixed function shaders are written using 

ShaderLab only, you will find more information about them in the ShaderLab reference itself.  

The reference below includes plenty of examples for the different types of shaders. For even more examples of surface shaders in 

particular, you can get the source of Unity's built-in shaders from the Resources section. Unity's Image Effects package contains a lot of 

interesting vertex and fragment shaders.  

Read on for shader reference, and check out the shader tutorial as well!  

 ShaderLab syntax: Shader  

o ShaderLab syntax: Properties  

o ShaderLab syntax: SubShader  

 ShaderLab syntax: Pass  

 ShaderLab syntax: Color, Material, Lighting  

 ShaderLab syntax: Culling & Depth Testing  

 ShaderLab syntax: Texturing  

 ShaderLab syntax: Fog  

 ShaderLab syntax: Alpha testing  

 ShaderLab syntax: Blending  

 ShaderLab syntax: Pass Tags  

 ShaderLab syntax: Name  

 ShaderLab syntax: BindChannels  

 ShaderLab syntax: UsePass  

 ShaderLab syntax: GrabPass  

 ShaderLab syntax: SubShader Tags  

o ShaderLab syntax: Fallback  

o ShaderLab syntax: other commands  

 Writing Surface Shaders  

o Surface Shader Examples  

o Custom Lighting models in Surface Shaders  

o Surface Shader Lighting Examples  

 Writing vertex and fragment shaders  

o Accessing shader properties in Cg  

o Providing vertex data to vertex programs  

o Built-in state variables in shader programs  

o GLSL Shader Programs  

 Advanced ShaderLab topics  

o Unity's Rendering Pipeline  

o Performance Tips when Writing Shaders  

o Rendering with Replaced Shaders  

o Using Depth Textures  

o Camera's Depth Texture  

o Platform Specific Rendering Differences  

o Shader Level of Detail  

 ShaderLab builtin values  
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SL-Shader 
Shader is the root command of a shader file. Each file must define one (and only one) Shader. It specifies how any objects whose material 

uses this shader are rendered.  

Syntax 

Shader "name" { [Properties] Subshaders [Fallback] } Defines a shader. It will appear in the material inspector listed under name. Shaders 

optionally can define a list of properties that show up as material settings. After this comes a list of SubShaders, and optionally a fallback.  

Details 

Properties 

Shaders can have a list of properties. Any properties declared in a shader are shown in the material inspector inside Unity. Typical 

properties are the object color, textures, or just arbitrary values to be used by the shader.  

SubShaders & Fallback 

Each shader is comprised of a list of sub-shaders. You must have at least one. When loading a shader, Unity will go through the list of 

subshaders, and pick the first one that is supported by the end user's machine. If no subshaders are supported, Unity will try to use fallback 

shader.  

Different graphic cards have different capabilities. This raises an eternal issue for game developers; you want your game to look great on 

the latest hardware, but don't want it to be available only to those 3% of the population. This is where subshaders come in. Create one 

subshader that has all the fancy graphic effects you can dream of, then add more subshaders for older cards. These subshaders may 

implement the effect you want in a slower way, or they may choose not to implement some details.  

Examples 

Here is one of the simplest shaders possible:  

// colored vertex lighting 

Shader "Simple colored lighting" { 

    // a single color property 

    Properties { 

        _Color ("Main Color", Color) = (1,.5,.5,1) 

    } 

    // define one subshader 

    SubShader { 

        Pass { 

            Material { 
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                Diffuse [_Color] 

            } 

            Lighting On 

        } 

    } 

}  

This shader defines a color property _Color (that shows up in material inspector as Main Color) with a default value of (1, 0.5, 0.5, 1). Then 

a single subshader is defined. The subshader consists of one Pass that turns on vertex lighting and sets up basic material for it.  

Subsections 

 ShaderLab syntax: Properties  

 ShaderLab syntax: SubShader  

o ShaderLab syntax: Pass  

 ShaderLab syntax: Color, Material, Lighting  

 ShaderLab syntax: Culling & Depth Testing  

 ShaderLab syntax: Texturing  

 ShaderLab syntax: Fog  

 ShaderLab syntax: Alpha testing  

 ShaderLab syntax: Blending  

 ShaderLab syntax: Pass Tags  

 ShaderLab syntax: Name  

 ShaderLab syntax: BindChannels  

o ShaderLab syntax: UsePass  

o ShaderLab syntax: GrabPass  

o ShaderLab syntax: SubShader Tags  

 ShaderLab syntax: Fallback  

 ShaderLab syntax: other commands  

Page last updated: 2008-06-16 

 

 

SL-Properties 
Shaders can define a list of parameters to be set by artists in Unity's material inspector. The Properties block in the shader file defines 

them.  

Syntax 

Properties { Property [Property ...] } 

Defines the property block. Inside braces multiple properties are defined as follows.  

name ("display name", Range (min, max)) = number 

Defines a float property, represented as a slider from min to max in the inspector.  

name ("display name", Color) = (number,number,number,number) 

Defines a color property.  
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name ("display name", 2D) = "name" { options } 

Defines a 2D texture property.  

name ("display name", Rect) = "name" { options } 

Defines a rectangle (non power of 2) texture property.  

name ("display name", Cube) = "name" { options } 

Defines a cubemap texture property.  

name ("display name", Float) = number 

Defines a float property.  

name ("display name", Vector) = (number,number,number,number) 

Defines a four component vector property.  

Details 

Each property inside the shader is referenced by name (in Unity, it's common to start shader property names with underscore). The 

property will show up in material inspector as display name. For each property a default value is given after equals sign:  

 For Range and Float properties it's just a single number.  

 For Color and Vector properties it's four numbers in parentheses.  

 For texture (2D, Rect, Cube) the default value is either an empty string, or one of builtin default textures: "white", "black", "gray" or "bump".  

Later on in the shader, property values are accessed using property name in square brackets: [name].  

Example 

Properties { 

    // properties for water shader 

    _WaveScale ("Wave scale", Range (0.02,0.15)) = 0.07 // sliders 

    _ReflDistort ("Reflection distort", Range (0,1.5)) = 0.5 

    _RefrDistort ("Refraction distort", Range (0,1.5)) = 0.4 

    _RefrColor ("Refraction color", Color)  = (.34, .85, .92, 1) // color 

    _ReflectionTex ("Environment Reflection", 2D) = "" {} // textures 

    _RefractionTex ("Environment Refraction", 2D) = "" {} 

    _Fresnel ("Fresnel (A) ", 2D) = "" {} 

    _BumpMap ("Bumpmap (RGB) ", 2D) = "" {} 

}  

Texture property options 

The options inside curly braces of the texture property are optional. The available options are:  



TexGen texgenmode 

Automatic texture coordinate generation mode for this texture. Can be one of ObjectLinear, EyeLinear, SphereMap, CubeReflect, CubeNormal; these 

correspond directly to OpenGL texgen modes. Note that TexGen is ignored if custom vertex programs are used.  

LightmapMode 

If given, this texture will be affected by per-renderer lightmap parameters. That is, the texture to use can be not in the material, but taken from the settings of 

the Renderer instead, see Renderer scripting documentation.  

Example 

// EyeLinear texgen mode example 

Shader "Texgen/Eye Linear" { 

    Properties { 

        _MainTex ("Base", 2D) = "white" { TexGen EyeLinear } 

    } 

    SubShader { 

        Pass { 

            SetTexture [_MainTex] { combine texture } 

        } 

    } 

}  
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SL-SubShader 
Each shader in Unity consists of a list of subshaders. When Unity has to display a mesh, it will find the shader to use, and pick the first 

subshader that runs on the user's graphics card.  

Syntax 

Subshader { [Tags] [CommonState] Passdef [Passdef ...] } 

Defines the subshader as optional tags, common state and a list of pass definitions.  

Details 

A subshader defines a list of rendering passes and optionally setup any state that is common to all passes. Additionally, subshader specific 

Tags can be set up.  

When Unity chooses which subshader to render with, it renders an object once for each Pass defined (and possibly more due to light 

interactions). As each render of the object is an expensive operation, you want to define the shader in minimum amount of passes possible. 

Of course, sometimes on some graphics hardware the needed effect can't be done in a single pass; then you have no choice but to use 

multiple passes.  
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Each pass definition can be a regular Pass, a Use Pass or a Grab Pass.  

Any statements that are allowed in a Pass definition can also appear in Subshader block. This will make all passes use this "shared" state.  

Example 

// ... 

SubShader { 

    Pass { 

        Lighting Off 

        SetTexture [_MainTex] {} 

    } 

} 

// ... 

This subshader defines a single Pass that turns off any lighting and just displays a mesh with texture named _MainTex.  
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SL-Pass 
The Pass block causes the geometry of an object to be rendered once.  

Syntax 

Pass { [Name and Tags] [RenderSetup] [TextureSetup] }  

The basic pass command contains an optional list of render setup commands, optionally followed by a list of textures to use.  

Name and tags 

A Pass can define its Name and arbitrary number of Tags - name/value strings that communicate Pass' intent to the rendering engine.  

Render Setup 

A pass sets up various states of the graphics hardware, for example should alpha blending be turned on, should fog be used, and so on. 

The commands are these:  

Material { Material Block } 

Defines a material to use in a vertex lighting pipeline. See material page for details.  

Lighting On | Off 

Turn vertex lighting on or off. See material page for details.  

Cull Back | Front | Off 

Set polygon culling mode.  
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ZTest (Less | Greater | LEqual | GEqual | Equal | NotEqual | Always) 

Set depth testing mode.  

ZWrite On | Off 

Set depth writing mode.  

Fog { Fog Block } 

Set fog parameters.  

AlphaTest (Less | Greater | LEqual | GEqual | Equal | NotEqual | Always) CutoffValue 

Turns on alpha testing.  

Blend SourceBlendMode DestBlendMode 

Sets alpha blending mode.  

Color Color value 

Sets color to use if vertex lighting is turned off.  

ColorMask RGB | A | 0 | any combination of R, G, B, A 

Set color writing mask. Writing ColorMask 0 turns off rendering to all color channels.  

Offset OffsetFactor , OffsetUnits 

Set depth offset.  

SeparateSpecular On | Off 

Turns separate specular color for vertex lighting on or off. See material page for details.  

ColorMaterial AmbientAndDiffuse | Emission 

Uses per-vertex color when computing vertex lighting. See material page for details.  

Texture Setup 

After the render state setup, you can specify a number of textures and their combining modes to apply using SetTexture commands:  

SetTexture texture property { [Combine options] }  

The texture setup configures fixed function multitexturing pipeline, and is ignored if custom fragment shaders are used.  

Details 

Per-pixel Lighting 

The per-pixel lighting pipeline works by rendering objects in multiple passes. Unity renders the object once to get ambient and any vertex 

lights in. Then it renders each pixel light affecting the object in a separate additive pass. See Render Pipeline for details.  

Per-vertex Lighting 

Per-vertex lighting is the standard Direct3D/OpenGL lighting model that is computed for each vertex. Lighting on turns it on. Lighting is 

affected by Material block, ColorMaterial and SeparateSpecular commands. See material page for details.  

See Also 

There are several special passes available for reusing common functionality or implementing various high-end effects:  

 UsePass includes named passes from another shader.  

 GrabPass grabs the contents of the screen into a texture, for use in a later pass.  

Subsections 

 ShaderLab syntax: Color, Material, Lighting  
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 ShaderLab syntax: Culling & Depth Testing  

 ShaderLab syntax: Texturing  

 ShaderLab syntax: Fog  

 ShaderLab syntax: Alpha testing  

 ShaderLab syntax: Blending  

 ShaderLab syntax: Pass Tags  

 ShaderLab syntax: Name  

 ShaderLab syntax: BindChannels  
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SL-Material 
The material and lighting parameters are used to control the built-in vertex lighting. Vertex lighting is the standard Direct3D/OpenGL lighting 

model that is computed for each vertex. Lighting on turns it on. Lighting is affected by Material block, ColorMaterial and 

SeparateSpecular commands.  

Per-pixel lights are usually implemented with custom vertex/fragment programs and don't use vertex lighting. For these you don't use any of 

the commands described here, instead you define your own vertex and fragment programs where you do all lighting, texturing and anything 

else yourself.  

 

Vertex Coloring & Lighting is the first effect to gets calculated for any rendered geometry. It operates on the vertex level, and calculates the 

base color that is used before textures are applied.  

Syntax 

The top level commands control whether to use fixed function lighting or not, and some configuration options. The main setup is in the 

Material Block, detailed further below.  

Color Color 

Sets the object to a solid color. A color is either four RGBA values in parenthesis, or a color property name in square brackets.  

Material { Material Block } 

The Material block is used to define the material properties of the object.  

Lighting On | Off 

For the settings defined in the Material block to have any effect, you must enable Lighting with the Lighting On command. If lighting is off instead, the color is 

taken straight from the Color command.  

SeparateSpecular On | Off 

This command makes specular lighting be added to the end of the shader pass, so specular lighting is unaffected by texturing. Only has effect when Lighting 

On is used.  

ColorMaterial AmbientAndDiffuse | Emission 
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makes per-vertex color be used instead of the colors set in the material. AmbientAndDiffuse replaces Ambient and Diffuse values of the material; 

Emission replaces Emission value of the material.  

Material Block 

This contains settings for how the material reacts to the light. Any of these properties can be left out, in which case they default to black (i.e. 

have no effect).  

Diffuse Color 

The diffuse color component. This is an object's base color.  

Ambient Color 

The ambient color component. This is the color the object has when it's hit by the ambient light set in the RenderSettings.  

Specular Color 

The color of the object's specular highlight.  

Shininess Number 

The sharpness of the highlight, between 0 and 1. At 0 you get a huge highlight that looks a lot like diffuse lighting, at 1 you get a tiny speck.  

Emission Color 

The color of the object when it is not hit by any light.  

The full color of lights hitting the object is:  

  Ambient * RenderSettings ambient setting + 

  (Light Color * Diffuse + Light Color * Specular) + Emission 

The light parts of the equation (within parenthesis) is repeated for all lights that hit the object.  

Typically you want to keep the Diffuse and Ambient colors the same (all builtin Unity shaders do this).  

Examples 

Always render object in pure red:  

Shader "Solid Red" { 

    SubShader { 

        Pass { Color (1,0,0,0) } 

    } 

}  

Basic Shader that colors the object white and applies vertex lighting:  

Shader "VertexLit White" { 

    SubShader { 

        Pass { 

http://unity3d.com/support/documentation/Components/class-RenderSettings.html
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            Material { 

                Diffuse (1,1,1,1) 

                Ambient (1,1,1,1) 

            } 

            Lighting On 

        } 

    } 

}  

An extended version that adds material color as a property visible in Material Inspector:  

Shader "VertexLit Simple" { 

    Properties { 

        _Color ("Main Color", COLOR) = (1,1,1,1) 

    } 

    SubShader { 

        Pass { 

            Material { 

                Diffuse [_Color] 

                Ambient [_Color] 

            } 

            Lighting On 

        } 

    } 

}  

And finally, a full fledged vertex-lit shader (see also SetTexture reference page):  

http://unity3d.com/support/documentation/Components/SL-SetTexture.html


Shader "VertexLit" { 

    Properties { 

        _Color ("Main Color", Color) = (1,1,1,0) 

        _SpecColor ("Spec Color", Color) = (1,1,1,1) 

        _Emission ("Emmisive Color", Color) = (0,0,0,0) 

        _Shininess ("Shininess", Range (0.01, 1)) = 0.7 

        _MainTex ("Base (RGB)", 2D) = "white" {} 

    } 

    SubShader { 

        Pass { 

            Material { 

                Diffuse [_Color] 

                Ambient [_Color] 

                Shininess [_Shininess] 

                Specular [_SpecColor] 

                Emission [_Emission] 

            } 

            Lighting On 

            SeparateSpecular On 

            SetTexture [_MainTex] { 

                Combine texture * primary DOUBLE, texture * primary 

            } 

        } 

    } 



}  
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SL-CullAndDepth 

 

Culling is an optimization that does not render polygons facing away from the viewer. All polygons have a front and a back side. Culling 

makes use of the fact that most objects are closed; if you have a cube, you will never see the sides facing away from you (there is always a 

side facing you in front of it) so we don't need to draw the sides facing away. Hence the term: Backface culling.  

The other feature that makes rendering looks correct is Depth testing. Depth testing makes sure that only the closest surfaces objects are 

drawn in a scene.  

Syntax 

Cull Back | Front | Off 

Controls which sides of polygons should be culled (not drawn)  

Back Don't render polygons facing away from the viewer (default).  

Front Don't render polygons facing towards the viewer. Used for turning objects inside-out.  

Off Disables culling - all faces are drawn. Used for special effects.  

ZWrite On | Off 

Controls whether pixels from this object are written to the depth buffer (default is On). If you're drawng solid objects, leave this on. If you're drawing 

semitransparent effects, switch to ZWrite Off. For more details read below.  

ZTest Less | Greater | LEqual | GEqual | Equal | NotEqual | Always 

How should depth testing be performed. Default is LEqual (draw objects in from or at the distance as existing objects; hide objects behind them).  

Offset Factor , Units 

Allows you specify a depth offset with two parameters. factor and units. Factor scales the maximum Z slope, with respect to X or Y of the polygon, and units 

scale the minimum resolvable depth buffer value. This allows you to force one polygon to be drawn on top of another although they are actually in the same 

position. For example Offset 0, -1 pulls the polygon closer to the camera ignoring the polygon's slope, whereas Offset -1, -1 will pull the polygon even closer 

when looking at a grazing angle.  

Examples 

This object will render only the backfaces of an object:  

Shader "Show Insides" { 

    SubShader { 



        Pass { 

            Material { 

                Diffuse (1,1,1,1) 

            } 

            Lighting On 

            Cull Front 

        } 

    } 

}  

Try to apply it to a cube, and notice how the geometry feels all wrong when you orbit around it. This is because you're only seeing the 

inside parts of the cube.  

Debugging Normals 

The next one is more interesting; first we render the object with normal vertex lighting, then we render the backfaces in bright pink. This has 

the effects of highlighting anywhere your normals need to be flipped. If you see physically-controlled objects getting 'sucked in' by any 

meshes, try to assign this shader to them. If any pink parts are visible, these parts will pull in anything unfortunate enough to touch it.  

Here we go:  

Shader "Reveal Backfaces" { 

    Properties { 

        _MainTex ("Base (RGB)", 2D) = "white" { } 

    } 

    SubShader { 

        // Render the front-facing parts of the object. 

        // We use a simple white material, and apply the main texture. 

        Pass { 

            Material { 

                Diffuse (1,1,1,1) 



            } 

            Lighting On 

            SetTexture [_MainTex] { 

                Combine Primary * Texture 

            } 

        } 

 

        // Now we render the back-facing triangles in the most 

        // irritating color in the world: BRIGHT PINK! 

        Pass { 

            Color (1,0,1,1) 

            Cull Front 

        } 

    } 

}  

Glass Culling 

Controlling Culling is useful for more than debugging backfaces. If you have transparent objects, you quite often want to show the 

backfacing side of an object. If you render without any culling (Cull Off), you'll most likely have some rear faces overlapping some of the 

front faces.  

Here is a simple shader that will work for convex objects (spheres, cubes, car windscreens).  

Shader "Simple Glass" { 

    Properties { 

        _Color ("Main Color", Color) = (1,1,1,0) 

        _SpecColor ("Spec Color", Color) = (1,1,1,1) 

        _Emission ("Emmisive Color", Color) = (0,0,0,0) 

        _Shininess ("Shininess", Range (0.01, 1)) = 0.7 



        _MainTex ("Base (RGB)", 2D) = "white" { } 

    } 

 

    SubShader { 

        // We use the material in many passes by defining them in the subshader. 

        // Anything defined here becomes default values for all contained passes. 

        Material { 

            Diffuse [_Color] 

            Ambient [_Color] 

            Shininess [_Shininess] 

            Specular [_SpecColor] 

            Emission [_Emission] 

        } 

        Lighting On 

        SeparateSpecular On 

 

        // Set up alpha blending 

        Blend SrcAlpha OneMinusSrcAlpha 

 

        // Render the back facing parts of the object. 

        // If the object is convex, these will always be further away 

        // than the front-faces. 

        Pass { 

            Cull Front 



            SetTexture [_MainTex] { 

                Combine Primary * Texture 

            } 

        } 

        // Render the parts of the object facing us. 

        // If the object is convex, these will be closer than the 

        // back-faces. 

        Pass { 

            Cull Back 

            SetTexture [_MainTex] { 

                Combine Primary * Texture 

            } 

        } 

    } 

}  
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SL-SetTexture 
After the basic vertex lighting has been calculated, textures are applied. In ShaderLab this is done using SetTexture command.  

SetTexture commands have no effect when fragment programs are used; as in that case pixel operations are completely described in the 

shader.  

 

http://unity3d.com/support/documentation/Components/SL-ShaderPrograms.html


Texturing is the place to do old-style combiner effects. You can have multiple SetTexture commands inside a pass - all textures are applied 

in sequence, like layers in a painting program. SetTexture commands must be placed at the end of a Pass.  

Syntax 

SetTexture [TexturePropertyName] { Texture Block } 

Assigns a texture. TextureName must be defined as a texture property. How to apply the texture is defined inside the TextureBlock.  

The texture block controls how the texture is applied. Inside the texture block can be up to three commands: combine, matrix and 

constantColor.  

Texture block combine command 

combine src1 * src2 

Multiplies src1 and src2 together. The result will be darker than either input.  

combine src1 + src2 

Adds src1 and src2 together. The result will be lighter than either input.  

combine src1 - src2 

Subtracts src2 from src1.  

combine src1 +- src2 

Adds src1 to src2, then subtracts 0.5 (a signed add).  

combine src1 lerp (src2) src3 

Interpolates between src3 and src1, using the alpha of src2. Note that the interpolation is opposite direction: src1 is used when alpha is one, and src3 is 

used when alpha is zero.  

combine src1 * src2 + src3 

Multiplies src1 with the alpha component of src2, then adds src3.  

combine src1 * src2 +- src3 

Multiplies src1 with the alpha component of src2, then does a signed add with src3.  

combine src1 * src2 - src3 

Multiplies src1 with the alpha component of src2, then subtracts src3.  

All the src properties can be either one of previous, constant, primary or texture.  

 Previous is the the result of the previous SetTexture.  

 Primary is the color from the lighting calculation or the vertex color if it is bound.  

 Texture is the color of the texture specified by [_TextureName] in the SetTexture (see above).  

 Constant is the color specified in ConstantColor.  

Modifiers: 

 The formulas specified above can optionally be followed by the keywords Double or Quad to make the resulting color 2x or 4x as bright.  

 All the src properties, except lerp argument, can optionally be preceded by one - to make the resulting color negated.  

 All the src properties can be followed by alpha to take only the alpha channel.  

Texture block constantColor command 

ConstantColor color 

Defines a constant color that can be used in the combine command.  

Texture block matrix command 

matrix [MatrixPropertyName] 

Transforms texture coordinates used in this command with the given matrix.  

http://unity3d.com/support/documentation/Components/SL-Pass.html
http://unity3d.com/support/documentation/Components/SL-Material.html
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Details 

Older graphics cards use a layered approach to textures. The textures are applied one after each other, modifying the color that will be 

written to the screen. For each texture, the texture is typically combined with the result of the previous operation.  

 

Separate Alpha & Color blending 

By default, the combiner formula is used for calculating both the RGB and alpha component of the color settexture. Optionally, you can 

specify a separate formula for the alpha calculation. This looks like this:  

SetTexture [_MainTex] { combine previous * texture, previous + texture }  

Here, we multiply the RGB colors and add the alpha.  

Specular highlights 

By default the primary color is the sum of the diffuse, ambient and specular colors (as defined in the Lighting calculation). If you specify 

SeparateSpecular On in the pass options, the specular color will be added in after the combiner calculation, rather than before. This is the 

default behavior of the built-in VertexLit shader.  

Graphics hardware support 

Some old graphics cards might not support some texture combine modes, and different cards have different number of SetTexture stages 

available. The shader author should write separate SubShaders for the cards he or she wants to support.  

Graphics cards with pixel shader 1.1 support (NVIDIA GeForce 3 and up, ATI Radeon 8500 and up, Intel 9xx) support all combiner modes 

and have at least 4 texture stages available. The following table summarizes the hardware support:  

Card Stage count Combiner modes not supported 

NVIDIA GeForce 3/4Ti and up 4 In OpenGL on Windows, src1*src2-src3 is not supported 

NVIDIA TNT2, GeForce 256, GeForce 2, GeForce 4MX 2 In OpenGL on Windows, src1*src2-src3 is not supported 

ATI Radeon 9500 and up 4-8 8 in OpenGL, 4 in D3D9 

ATI Radeon 8500-9250 4-6 6 in OpenGL, 4 in D3D9 

http://unity3d.com/support/documentation/Components/SL-Material.html
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ATI Radeon 7500 3   

ATI Rage 2 src1*src2+src3  

src1*src2+-src3  

src1*src2-src3 

Examples 

Alpha Blending Two Textures 

This small examples takes two textures. First it sets the first combiner to just take the _MainTex, then is uses the alpha channel of 

_BlendTex to fade in the RGB colors of _BlendTex  

Shader "Examples/2 Alpha Blended Textures" { 

    Properties { 

        _MainTex ("Base (RGB)", 2D) = "white" {} 

        _BlendTex ("Alpha Blended (RGBA) ", 2D) = "white" {} 

    } 

    SubShader { 

        Pass { 

            // Apply base texture 

            SetTexture [_MainTex] { 

                combine texture 

            } 

            // Blend in the alpha texture using the lerp operator 

            SetTexture [_BlendTex] { 

                combine texture lerp (texture) previous 

            } 

        } 

    } 

}  

Alpha Controlled Self-illumination 



This shader uses the alpha component of the _MainTex to decide where to apply lighting. It does this by applying the texture to two stages; 

In the first stage, the alpha value of the texture is used to blend between the vertex color and solid white. In the second stage, the RGB 

values of the texture are multiplied in.  

Shader "Examples/Self-Illumination" { 

    Properties { 

        _MainTex ("Base (RGB) Self-Illumination (A)", 2D) = "white" {} 

    } 

    SubShader { 

        Pass { 

            // Set up basic white vertex lighting 

            Material { 

                Diffuse (1,1,1,1) 

                Ambient (1,1,1,1) 

            } 

            Lighting On 

 

            // Use texture alpha to blend up to white (= full illumination) 

            SetTexture [_MainTex] { 

                constantColor (1,1,1,1) 

                combine constant lerp(texture) previous 

            } 

            // Multiply in texture 

            SetTexture [_MainTex] { 

                combine previous * texture 

            } 



        } 

    } 

}  

We can do something else for free here, though; instead of blending to solid white, we can add a self-illumination color and blend to that. 

Note the use of ConstantColor to get a _SolidColor from the properties into the texture blending.  

Shader "Examples/Self-Illumination 2" { 

    Properties { 

        _IlluminCol ("Self-Illumination color (RGB)", Color) = (1,1,1,1) 

        _MainTex ("Base (RGB) Self-Illumination (A)", 2D) = "white" {} 

    } 

    SubShader { 

        Pass { 

            // Set up basic white vertex lighting 

            Material { 

                Diffuse (1,1,1,1) 

                Ambient (1,1,1,1) 

            } 

            Lighting On 

 

            // Use texture alpha to blend up to white (= full illumination) 

            SetTexture [_MainTex] { 

                // Pull the color property into this blender 

                constantColor [_IlluminCol] 

                // And use the texture's alpha to blend between it and 

                // vertex color 



                combine constant lerp(texture) previous 

            } 

            // Multiply in texture 

            SetTexture [_MainTex] { 

                combine previous * texture 

            } 

        } 

    } 

}  

And finally, we take all the lighting properties of the vertexlit shader and pull that in:  

Shader "Examples/Self-Illumination 3" { 

    Properties { 

        _IlluminCol ("Self-Illumination color (RGB)", Color) = (1,1,1,1) 

        _Color ("Main Color", Color) = (1,1,1,0) 

        _SpecColor ("Spec Color", Color) = (1,1,1,1) 

        _Emission ("Emmisive Color", Color) = (0,0,0,0) 

        _Shininess ("Shininess", Range (0.01, 1)) = 0.7 

        _MainTex ("Base (RGB)", 2D) = "white" {} 

    } 

 

    SubShader { 

        Pass { 

            // Set up basic vertex lighting 

            Material { 



                Diffuse [_Color] 

                Ambient [_Color] 

                Shininess [_Shininess] 

                Specular [_SpecColor] 

                Emission [_Emission] 

            } 

            Lighting On 

 

            // Use texture alpha to blend up to white (= full illumination) 

            SetTexture [_MainTex] { 

                constantColor [_IlluminCol] 

                combine constant lerp(texture) previous 

            } 

            // Multiply in texture 

            SetTexture [_MainTex] { 

                combine previous * texture 

            } 

        } 

    } 

}  
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SL-Fog 
Fog parameters are controlled with Fog command.  



 

Fogging blends the color of the generated pixels down towards a constant color based on distance from camera. Fogging does not modify 

a blended pixel's alpha value, only its RGB components.  

Syntax 

Fog { Fog Commands } 

Specify fog commands inside curly braces.  

Mode Off | Global | Linear | Exp | Exp2 

Defines fog mode. Default is global, which translates to Off or Exp2 depending whether fog is turned on in Render Settings.  

Color ColorValue 

Sets fog color.  

Density FloatValue 

Sets density for exponential fog.  

Range FloatValue , FloatValue 

Sets near & far range for linear fog.  

Details 

Default fog settings are based on Render Settings: fog mode is either Exp2 or Off; density & color taken from settings as well.  

Note that if you use fragment programs, Fog settings of the shader will still be applied. On platforms where there is no fixed function Fog 

functionality, Unity will patch shaders at runtime to support the requested Fog mode.  
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SL-AlphaTest 
The alpha test is a last chance to reject a pixel from being written to the screen.  

 

After the final output color has been calculated, the color can optionally have its alpha value compared to a fixed value. If the test fails, the 

pixel is not written to the display.  

http://unity3d.com/support/documentation/Components/class-RenderSettings.html
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Syntax 

AlphaTest Off 

Render all pixels (default).  

AlphaTest comparison AlphaValue 

Set up the alpha test to only render pixels whose alpha value is within a certain range.  

Comparison 

Comparison is one of the following words:  

Greater Only render pixels whose alpha is greater than AlphaValue. 

GEqual Only render pixels whose alpha is greater than or equal to AlphaValue. 

Less Only render pixels whose alpha value is less than AlphaValue. 

LEqual Only render pixels whose alpha value is less than or equal to from AlphaValue. 

Equal Only render pixels whose alpha value equals AlphaValue. 

NotEqual Only render pixels whose alpha value differs from AlphaValue. 

Always Render all pixels. This is functionally equivalent to AlphaTest Off. 

Never Don't render any pixels. 

AlphaValue 

A floating-point number between 0 and 1. This can also be a variable reference to a float or range property, in which case it should be 

written using the standard square bracket notation ([VariableName]).  

Details 

The alpha test is important when rendering concave objects with transparent parts. The graphics card maintains a record of the depth of 

every pixel written to the screen. If a new pixel is further away than one already rendered, the new pixel is not written to the display. This 

means that even with Blending, objects will not show through.  

 

In this figure, the tree on the left is rendered using AlphaTest. Note how the pixels in it are either completely transparent or opaque. The 

center tree is rendered using only Alpha Blending - notice how transparent parts of nearby branches cover the distant leaves because of 

the depth buffer. The tree on the right is rendered using the last example shader - which implements a combination of blending and alpha 

testing to hide any artifacts.  

Examples 

The simplest possible example, assign a texture with an alpha channel to it. The object will only be visible where alpha is greater than 0.5  

Shader "Simple Alpha Test" { 
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 Properties { 

  _MainTex ("Base (RGB) Transparency (A)", 2D) = "" {} 

 } 

 SubShader { 

  Pass { 

   // Only render pixels with an alpha larger than 50% 

   AlphaTest Greater 0.5 

   SetTexture [_MainTex] { combine texture } 

  } 

 } 

} 

This is not much good by itself. Let us add some lighting and make the cutoff value tweakable:  

Shader "Cutoff Alpha" { 

 Properties { 

  _MainTex ("Base (RGB) Transparency (A)", 2D) = "" {} 

  _Cutoff ("Alpha cutoff", Range (0,1)) = 0.5 

 } 

 SubShader { 

  Pass { 

   // Use the Cutoff parameter defined above to determine 

   // what to render. 

   AlphaTest Greater [_Cutoff] 

   Material { 

    Diffuse (1,1,1,1) 



    Ambient (1,1,1,1) 

   } 

   Lighting On 

   SetTexture [_MainTex] { combine texture * primary } 

  } 

 } 

}  

When rendering plants and trees, many games have the hard edges typical of alpha testing. A way around that is to render the object 

twice. In the first pass, we use alpha testing to only render pixels that are more than 50% opaque. In the second pass, we alpha-blend the 

graphic in the parts that were cut away, without recording the depth of the pixel. We might get a bit of confusion as further away branches 

overwrite the nearby ones, but in practice, that is hard to see as leaves have a lot of visual detail in them.  

Shader "Vegetation" { 

 Properties { 

  _Color ("Main Color", Color) = (.5, .5, .5, .5) 

  _MainTex ("Base (RGB) Alpha (A)", 2D) = "white" {} 

  _Cutoff ("Base Alpha cutoff", Range (0,.9)) = .5 

 } 

 SubShader { 

  // Set up basic lighting 

  Material { 

   Diffuse [_Color] 

   Ambient [_Color] 

  } 

  Lighting On 

 

  // Render both front and back facing polygons. 



  Cull Off 

 

  // first pass: 

  //   render any pixels that are more than [_Cutoff] opaque 

  Pass { 

   AlphaTest Greater [_Cutoff] 

   SetTexture [_MainTex] { 

    combine texture * primary, texture 

   } 

  } 

 

  // Second pass: 

  //   render in the semitransparent details. 

  Pass { 

   // Dont write to the depth buffer 

   ZWrite off 

   // Don't write pixels we have already written. 

   ZTest Less 

   // Only render pixels less or equal to the value 

   AlphaTest LEqual [_Cutoff] 

 

   // Set up alpha blending 

   Blend SrcAlpha OneMinusSrcAlpha 

 



   SetTexture [_MainTex] { 

    combine texture * primary, texture 

   } 

  } 

 } 

}  

Note that we have some setup inside the SubShader, rather than in the individual passes. Any state set in the SubShader is inherited as 

defaults in passes inside it.  
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SL-Blend 
Blending is used to make transparent objects.  

 

When graphics are rendered, after all shaders have executed and all textures have been applied, the pixels are written to the screen. How 

they are combined with what is already there is controlled by the Blend command.  

Syntax 

Blend Off 

Turn off blending  

Blend SrcFactor DstFactor 

Configure & enable blending. The generated color is multiplied by the SrcFactor. The color already on screen is multiplied by DstFactor and the two are 

added together.  

Properties 

All following properties are valid for both SrcFactor & DstFactor. Source refers to the calculated color, Destination is the color already on 

the screen.  

One The value of one - use this to let either the source or the destination color come through fully. 

Zero The value zero - use this to remove either the source or the destination values. 

SrcColor The value of this stage is multiplied by the source color value. 

SrcAlpha The value of this stage is multiplied by the source alpha value. 

DstColor The value of this stage is multiplied by frame buffer source color value. 



DstAlpha The value of this stage is multiplied by frame buffer source alpha value. 

OneMinusSrcColor The value of this stage is multiplied by (1 - source color). 

OneMinusSrcAlpha The value of this stage is multiplied by (1 - source alpha). 

OneMinusDstColor The value of this stage is multiplied by (1 - destination color). 

OneMinusDstAlpha The value of this stage is multiplied by (1 - destination alpha). 

Details 

Below are the most common blend types:  

Blend SrcAlpha OneMinusSrcAlpha     // Alpha blending 

Blend One One                       // Additive 

Blend One OneMinusDstColor          // Soft Additive 

Blend DstColor Zero                 // Multiplicative 

Blend DstColor SrcColor             // 2x Multiplicative 

Example 

Here is a small example shader that adds a texture to whatever is on the screen already:  

Shader "Simple Additive" { 

    Properties { 

        _MainTex ("Texture to blend", 2D) = "black" {} 

    } 

    SubShader { 

        Tags { "Queue" = "Transparent" } 

        Pass { 

            Blend One One 

            SetTexture [_MainTex] { combine texture } 

        } 

    } 

} 

And a more complex one, Glass. This is a two-pass shader:  

1. The first pass renders a lit, alpha-blended texture on to the screen. The alpha channel decides the transparency.  



2. The second pass renders a reflection cubemap on top of the alpha-blended window, using additive transparency.  

Shader "Glass" { 

    Properties { 

        _Color ("Main Color", Color) = (1,1,1,1) 

        _MainTex ("Base (RGB) Transparency (A)", 2D) = "white" {} 

        _Reflections ("Base (RGB) Gloss (A)", Cube) = "skybox" { TexGen CubeReflect } 

    } 

    SubShader { 

        Tags { "Queue" = "Transparent" } 

        Pass { 

            Blend SrcAlpha OneMinusSrcAlpha 

            Material { 

                Diffuse [_Color] 

            } 

            Lighting On 

            SetTexture [_MainTex] { 

                combine texture * primary double, texture * primary 

            } 

        } 

        Pass { 

            Blend One One 

            Material { 

                Diffuse [_Color] 

            } 



            Lighting On 

            SetTexture [_Reflections] { 

                combine texture 

                Matrix [_Reflection] 

            } 

        } 

    } 

}  
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SL-PassTags 
Passes use tags to tell how and when they expect to be rendered to the rendering engine.  

Syntax 

Tags { "TagName1" = "Value1" "TagName2" = "Value2" } 

Specifies TagName1 to have Value1, TagName2 to have Value2. You can have as many tags as you like.  

Details 

Tags are basically key-value pairs. Inside a Pass tags are used to control which role this pass has in the lighting pipeline (ambient, vertex 

lit, pixel lit etc.) and some other options.  

LightMode tag 

LightMode tag defines Pass' role in the lighting pipeline. See render pipeline for details. These tags are rarely used manually; most often 

shaders that need to interact with lighting are written as Surface Shaders and then all those details are taken care of.  

Possible values for LightMode tag are:  

 Always: Always rendered; no lighting is applied.  

 ForwardBase: Used in Forward rendering, ambient, main directional light and vertex/SH lights are applied.  

 ForwardAdd: Used in Forward rendering; additive per-pixel lights are applied, one pass per light.  

 PrepassBase: Used in Deferred Lighting, renders normals & specular exponent.  

 PrepassFinal: Used in Deferred Lighting, renders final color by combining textures, lighting & emission.  

 Vertex: Used in Vertex Lit rendering when object is not lightmapped; all vertex lights are applied.  

 VertexLMRGBM: Used in Vertex Lit rendering when object is lightmapped; on platforms where lightmap is RGBM encoded.  

 VertexLM: Used in Vertex Lit rendering when object is lightmapped; on platforms where lightmap is double-LDR encoded (generally mobile 

platforms & old dekstop GPUs).  

 ShadowCaster: Renders object as shadow caster.  

 ShadowCollector: Gathers object's shadows into screen-space buffer for Forward rendering path.  

RequireOptions tag 
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A pass can indicate that it should only be rendered when some external conditions are met. This is done by using RequireOptions tag, 

whose value is a string of space separated options. Currently the options supported by Unity are:  

 SoftVegetation: Render this pass only if Soft Vegetation is on in Quality Settings.  

See Also 

SubShaders can be given Tags as well, see SubShader Tags.  
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SL-Name 

Syntax 

Name "PassName" 

Gives the PassName name to the current pass.  

Details 

A pass can be given a name so that a UsePass command can reference it.  
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SL-BindChannels 
BindChannels command allows you to specify how vertex data maps to the graphics hardware.  

BindChannels has no effect when programmable vertex shaders are used, as in that case bindings are controlled by vertex shader inputs.  

By default, Unity figures out the bindings for you, but in some cases you want custom ones to be used.  

For example you could map the primary UV set to be used in the first texture stage and the secondary UV set to be used in the second 

texture stage; or tell the hardware that vertex colors should be taken into account.  

Syntax 

BindChannels { Bind "source", target }  

Specifies that vertex data source maps to hardware target.  

Source can be one of:  

 Vertex: vertex position  

 Normal: vertex normal  

 Tangent: vertex tangent  

 Texcoord: primary UV coordinate  

 Texcoord1: secondary UV coordinate  

 Color: per-vertex color  

Target can be one of:  

 Vertex: vertex position  

http://unity3d.com/support/documentation/Components/class-QualitySettings.html
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 Normal: vertex normal  

 Tangent: vertex tangent  

 Texcoord0, Texcoord1, ...: texture coordinates for corresponding texture stage  

 Texcoord: texture coordinates for all texture stages  

 Color: vertex color  

Details 

Unity places some restrictions on which sources can be mapped to which targets. Source and target must match for Vertex, Normal, 

Tangent and Color. Texture coordinates from the mesh (Texcoord and Texcoord1) can be mapped into texture coordinate targets 

(Texcoord for all texture stages, or TexcoordN for a specific stage).  

There are two typical use cases for BindChannels:  

 Shaders that take vertex colors into account.  

 Shaders that use two UV sets.  

Examples 

// Maps the first UV set to the first texture stage 

// and the second UV set to the second texture stage 

BindChannels { 

   Bind "Vertex", vertex 

   Bind "texcoord", texcoord0 

   Bind "texcoord1", texcoord1 

}  

// Maps the first UV set to all texture stages 

// and uses vertex colors 

BindChannels { 

   Bind "Vertex", vertex 

   Bind "texcoord", texcoord 

   Bind "Color", color 

}  
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SL-UsePass 
The UsePass command uses named passes from another shader.  

Syntax 

UsePass "Shader/Name"  

Inserts all passes with a given name from a given shader. Shader/Name contains the name of the shader and the name of the pass, separated by a slash 

character.  

Details 

Some of the shaders could reuse existing passes from other shaders, reducing code duplication. For example, in most pixel lit shaders the 

ambient or vertex lighting passes are the same as in the corresponding VertexLit shaders. The UsePass command does just that - it 

includes a given pass from another shader. As an example the following command uses the pass with the name "BASE" from the builtin 

Specular shader:  

    UsePass "Specular/BASE" 

In order for UsePass to work, a name must be given to the pass one wishes to use. The Name command inside the pass gives it a name:  

    Name "MyPassName" 

Note that internally all pass names are uppercased, so UsePass must refer to the name in uppercase.  
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SL-GrabPass 
GrabPass is a special passtype - it grabs the contents of the screen where the object is about to be drawn into a texture. This texture can 

be used in subsequent passes to do advanced image based effects.  

Syntax 

The GrabPass belongs inside a subshader. It can take two forms:  

 Just GrabPass { } will grab current screen contents into a texture. The texture can be accessed in further passes by 

@@_GrabTexture@ name. Note: this form of grab pass will do the expensive screen grabbing operation for each object that uses it!  

 GrabPass { "TextureName" } will grab screen contents into a texture, but will only do that once per frame for the first object that 

uses the given texture name. The texture can be accessed in further passes by the given texture name. This is a more performant way 

when you have multiple objects using grab pass in the scene.  

Additionally, GrabPass can use Name and Tags commands.  

Example 

Here is an expensive way to invert the colors of what was rendered before:  

Shader "GrabPassInvert" { 

    SubShader { 

        // Draw ourselves after all opaque geometry 

        Tags { "Queue" = "Transparent" } 

http://unity3d.com/support/documentation/Components/SL-Name.html
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        // Grab the screen behind the object into _GrabTexture 

        GrabPass { } 

 

        // Render the object with the texture generated above, and invert it's colors 

        Pass { 

            SetTexture [_GrabTexture] { combine one-texture } 

        } 

    } 

}  

This shader has two passes: First pass grabs whatever is behind the object at the time of rendering, then applies that in the second pass. 

Now of course, the same effect could be achieved much cheaper using an invert blend mode.  

See Also 

 Regular Pass command  
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SL-SubshaderTags 
Subshaders use tags to tell how and when they expect to be rendered to the rendering engine.  

Syntax 

Tags { "TagName1" = "Value1" "TagName2" = "Value2" } 

Specifies TagName1 to have Value1, TagName2 to have Value2. You can have as many tags as you like.  

Details 

Tags are basically key-value pairs. Inside a SubShader tags are used to determine rendering order and other parameters of a subshader.  

Rendering Order - Queue tag 

You can determine in which order your objects are drawn using the Queue tag. A Shader decides which render queue its objects belong to, 

this way any Transparent shaders make sure they are drawn after all opaque objects and so on.  

There are four pre-defined render queues, but there can be more queues in between the predefined ones. The predefined queues are:  

 Background - this render queue is rendered before any others. It is used for skyboxes and the like.  

 Geometry (default) - this is used for most objects. Opaque geometry uses this queue.  

http://unity3d.com/support/documentation/Components/SL-Blend.html
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 Transparent - this render queue is rendered after Geometry, in back-to-front order. Anything alpha-blended (i.e. shaders that don't write to 

depth buffer) should go here (glass, particle effects).  

 Overlay - this render queue is meant for overlay effects. Anything rendered last should go here (e.g. lens flares).  

Shader "Transparent Queue Example" { 

     SubShader { 

        Tags {"Queue" = "Transparent" } 

        Pass { 

            // rest of the shader body... 

        } 

    } 

}  

An example illustrating how to render something in the transparent queue  

Geometry render queue optimizes the drawing order of the objects for best performance. All other render queues sort objects by distance, 

starting rendering from the furthest ones and ending with the closest ones.  

For special uses in-between queues can be used. Internally each queue is represented by integer index; Background is 1000, Geometry 

is 2000, Transparent is 3000 and Overlay is 4000. If a shader uses a queue like this:  

Tags { "Queue" = "Geometry+1" } 

This will make the object be rendered after all opaque objects, but before transparent objects, as render queue index will be 2001 

(geometry plus one). This is useful in situations where you want some objects be always drawn between other sets of objects. For example, 

in most cases transparent water should be drawn after opaque objects but before transparent objects.  

IgnoreProjector tag 

If IgnoreProjector tag is given and has a value of "True", then an object that uses this shader will not be affected by Projectors. This is 

mostly useful on semitransparent objects, because there is no good way for Projectors to affect them.  

See Also 

Passes can be given Tags as well, see Pass Tags.  
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SL-Fallback 
After all Subshaders a Fallback can be defined. It basically says "if none of subshaders can run on this hardware, try using the ones from 

another shader".  

http://unity3d.com/support/documentation/Components/class-Projector.html
http://unity3d.com/support/documentation/Components/SL-PassTags.html


Syntax 

Fallback "name" 

Fallback to shader with a given name.  

Fallback Off 

Explicitly state that there is no fallback and no warning should be printed, even if no subshaders can run on this hardware.  

Details 

A fallback statement has the same effect as if all subshaders from the other shader would be inserted into its place.  

Example 

Shader "example" { 

    // properties and subshaders here... 

    Fallback "otherexample" 

}  
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SL-Other 

Category 

Category is a logical grouping of any commands below it. This is mostly used to "inherit" rendering state. For example, your shader might 

have multiple subshaders, and each of them requires fog to be off, blending set to additive, etc. You can use Category for that:  

Shader "example" { 

Category { 

    Fog { Mode Off } 

    Blend One One 

    SubShader { 

        // ... 

    } 

    SubShader { 

        // ... 

    } 

    // ... 

http://unity3d.com/support/documentation/Components/SL-SubShader.html
http://unity3d.com/support/documentation/Components/SL-Fog.html
http://unity3d.com/support/documentation/Components/SL-Blend.html


} 

} 

Category block only affects shader parsing, it's exactly the same as "pasting" any state set inside Category into all blocks below it. It does 

not affect shader execution speed at all.  
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SL-SurfaceShaders 
Writing shaders that interact with lighting is complex. There are different light types, different shadow options, different rendering paths 

(forward and deferred rendering), and the shader should somehow handle all that complexity.  

Surface Shaders in Unity is a code generation approach that makes it much easier to write lit shaders than using low level vertex/pixel 

shader programs. Note that there is no custom languages, magic or ninjas involved in Surface Shaders; it just generates all the repetitive 

code that would have to be written by hand. You still write shader code in Cg / HLSL.  

For some examples, take a look at Surface Shader Examples and Surface Shader Custom Lighting Examples.  

How it works 

You define a "surface function" that takes any UVs or data you need as input, and fills in output structure SurfaceOutput. 

SurfaceOutput basically describes properties of the surface (it's albedo color, normal, emission, specularity etc.). You write this code in Cg / 

HLSL.  

Surface Shader compiler then figures out what inputs are needed, what outputs are filled and so on, and generates actual vertex&pixel 

shaders, as well as rendering passes to handle forward and deferred rendering.  

Standard output structure of surface shaders is this:  

struct SurfaceOutput { 

    half3 Albedo; 

    half3 Normal; 

    half3 Emission; 

    half Specular; 

    half Gloss; 

    half Alpha; 

}; 

Samples 

See Surface Shader Examples and Surface Shader Custom Lighting Examples pages.  

http://unity3d.com/support/documentation/Components/SL-ShaderPrograms.html
http://unity3d.com/support/documentation/Components/SL-ShaderPrograms.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaderExamples.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaderLightingExamples.html
http://unity3d.com/support/documentation/Components/SL-ShaderPrograms.html
http://unity3d.com/support/documentation/Components/SL-ShaderPrograms.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaderExamples.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaderLightingExamples.html


Surface Shader compile directives 

Surface shader is placed inside CGPROGRAM..ENDCG block, just like any other shader. The differences are:  

 It must be placed inside SubShader block, not inside Pass. Surface shader will compile into multiple passes itself.  

 It uses #pragma surface ... directive to indicate it's a surface shader.  

The #pragma surface directive is:  

    #pragma surface surfaceFunction lightModel [optionalparams] 

Required parameters:  

 surfaceFunction - which Cg function has surface shader code. The function should have the form of void surf (Input IN, inout 

SurfaceOutput o), where Input is a structure you have defined. Input should contain any texture coordinates and extra automatic 

variables needed by surface function.  

 lightModel - lighting model to use. Built-in ones are Lambert (diffuse) and BlinnPhong (specular). See Custom Lighting Models page 

for how to write your own.  

Optional parameters:  

 alpha - Alpha blending mode. Use this for semitransparent shaders.  

 alphatest:VariableName - Alpha testing mode. Use this for transparent-cutout shaders. Cutoff value is in float variable with 

VariableName.  

 vertex:VertexFunction - Custom vertex modification function. See Tree Bark shader for example.  

 exclude_path:prepass or exclude_path:forward - Do not generate passes for given rendering path.  

 addshadow - Add shadow caster & collector passes. Commonly used with custom vertex modification, so that shadow casting also gets 

any procedural vertex animation.  

 dualforward - Use dual lightmaps in forward rendering path.  

 fullforwardshadows - Support all shadow types in Forward rendering path.  

 decal:add - Additive decal shader (e.g. terrain AddPass).  

 decal:blend - Semitransparent decal shader.  

 softvegetation - Makes the surface shader only be rendered when Soft Vegetation is on.  

 noambient - Do not apply any ambient lighting or spherical harmonics lights.  

 novertexlights - Do not apply any spherical harmonics or per-vertex lights in Forward rendering.  

 nolightmap - Disables lightmap support in this shader (makes a shader smaller).  

 noforwardadd - Disables Forward rendering additive pass. This makes the shader support one full directional light, with all other lights 

computed per-vertex/SH. Makes shaders smaller as well.  

 approxview - Computes normalized view direction per-vertex instead of per-pixel, for shaders that need it. This is faster, but view 

direction is not entirely correct when camera gets close to surface.  

 halfasview - Pass half-direction vector into the lighting function instead of view-direction. Half-direction will be computed and 

normalized per vertex. This is faster, but not entirely correct.  

Additionally, you can write #pragma debug inside CGPROGRAM block, and then surface compiler will spit out a lot of comments of the 

generated code. You can view that using Open Compiled Shader in shader inspector.  

Surface Shader input structure 

The input structure Input generally has any texture coordinates needed by the shader. Texture coordinates must be named "uv" followed 

by texture name (or start it with "uv2" to use second texture coordinate set).  

Additional values that can be put into Input structure:  

 float3 viewDir - will contain view direction, for computing Parallax effects, rim lighting etc.  

 float4 with COLOR semantic - will contain interpolated per-vertex color.  

 float4 screenPos - will contain screen space position for reflection effects. Used by WetStreet shader in Dark Unity for example.  

http://unity3d.com/support/documentation/Components/SL-SubShader.html
http://unity3d.com/support/documentation/Components/SL-Pass.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaderLighting.html
http://unity3d.com/support/documentation/Manual/LightmappingInDepth.html#DualLightmaps
http://unity3d.com/support/documentation/Components/RenderTech-ForwardRendering.html
http://unity3d.com/support/documentation/Components/RenderTech-ForwardRendering.html
http://unity3d.com/support/documentation/Components/RenderTech-ForwardRendering.html


 float3 worldPos - will contain world space position.  

 float3 worldRefl - will contain world reflection vector if surface shader does not write to o.Normal. See Reflect-Diffuse shader for 

example.  

 float3 worldNormal - will contain world normal vector if surface shader does not write to o.Normal.  

 float3 worldRefl; INTERNAL_DATA - will contain world reflection vector if surface shader writes to o.Normal. To get the 

reflection vector based on per-pixel normal map, use WorldReflectionVector (IN, o.Normal). See Reflect-Bumped shader 

for example.  

 float3 worldNormal; INTERNAL_DATA - will contain world normal vector if surface shader writes to o.Normal. To get the normal 

vector based on per-pixel normal map, use WorldNormalVector (IN, o.Normal).  

Further Documentation 

 Surface Shader Examples  

 Custom Lighting models in Surface Shaders  

 Surface Shader Lighting Examples  
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SL-SurfaceShaderExamples 
Here are some examples of Surface Shaders. The examples below focus on using built-in lighting models; examples on how to implement 

custom lighting models are in Surface Shader Lighting Examples.  

Simple  

We'll start with a very simple shader and build up on that. Here's a shader that just sets surface color to "white". It uses built-in Lambert 

(diffuse) lighting model.  

  Shader "Example/Diffuse Simple" { 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Lambert 

      struct Input { 

          float4 color : COLOR; 

      }; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = 1; 

      } 

      ENDCG 

    } 

    Fallback "Diffuse" 

  } 

http://unity3d.com/support/documentation/Components/SL-SurfaceShaderExamples.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaderLighting.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaderLightingExamples.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaderLightingExamples.html


Here's how it looks like on a model with two lights set up:  

 

Texture 

An all-white object is quite boring, so let's add a texture. We'll add a Properties block to the shader, so we get a texture selector in our 

Material. Other changes are in bold below.  

  Shader "Example/Diffuse Texture" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Lambert 

      struct Input { 

          float2 uv_MainTex; 

      }; 

      sampler2D _MainTex; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

      } 

      ENDCG 

    }  

    Fallback "Diffuse" 

  } 

http://unity3d.com/support/documentation/Components/class-Light.html
http://unity3d.com/support/documentation/Components/SL-Properties.html


 

Normal mapping 

Let's add some normal mapping:  

  Shader "Example/Diffuse Bump" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

      _BumpMap ("Bumpmap", 2D) = "bump" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Lambert 

      struct Input { 

        float2 uv_MainTex; 

        float2 uv_BumpMap; 

      }; 

      sampler2D _MainTex; 

      sampler2D _BumpMap; 

      void surf (Input IN, inout SurfaceOutput o) { 

        o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

        o.Normal = UnpackNormal (tex2D (_BumpMap, IN.uv_BumpMap)); 

      } 

      ENDCG 

    }  

    Fallback "Diffuse" 

  } 



 

Rim Lighting 

Now, try to add some Rim Lighting to highlight the edges of an object. We'll add some emissive light based on angle between surface 

normal and view direction. For that, we'll use viewDir built-in surface shader variable.  

  Shader "Example/Rim" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

      _BumpMap ("Bumpmap", 2D) = "bump" {} 

      _RimColor ("Rim Color", Color) = (0.26,0.19,0.16,0.0) 

      _RimPower ("Rim Power", Range(0.5,8.0)) = 3.0 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Lambert 

      struct Input { 

          float2 uv_MainTex; 

          float2 uv_BumpMap; 

          float3 viewDir; 

      }; 

      sampler2D _MainTex; 

      sampler2D _BumpMap; 

      float4 _RimColor; 

      float _RimPower; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

          o.Normal = UnpackNormal (tex2D (_BumpMap, IN.uv_BumpMap)); 

          half rim = 1.0 - saturate(dot (normalize(IN.viewDir), o.Normal)); 

          o.Emission = _RimColor.rgb * pow (rim, _RimPower); 

      } 

      ENDCG 

    }  

    Fallback "Diffuse" 

  } 



 

Detail Texture 

For a different effect, let's add a detail texture that is combined with the base texture. Detail texture uses the same UVs, but usually 

different Tiling in the Material, so we have to use different input UV coordinates.  

  Shader "Example/Detail" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

      _BumpMap ("Bumpmap", 2D) = "bump" {} 

      _Detail ("Detail", 2D) = "gray" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Lambert 

      struct Input { 

          float2 uv_MainTex; 

          float2 uv_BumpMap; 

          float2 uv_Detail; 

      }; 

      sampler2D _MainTex; 

      sampler2D _BumpMap; 

      sampler2D _Detail; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

          o.Albedo *= tex2D (_Detail, IN.uv_Detail).rgb * 2; 

          o.Normal = UnpackNormal (tex2D (_BumpMap, IN.uv_BumpMap)); 

      } 

      ENDCG 

    }  

    Fallback "Diffuse" 

  } 



Using a checker texture does not make much practical sense, but illustrates what happens:  

 

Detail Texture in Screen Space 

How about a detail texture in screen space? It does not make much sense for a soldier head model, but illustrates how a built-in 

screenPos input might be used:  

  Shader "Example/ScreenPos" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

      _Detail ("Detail", 2D) = "gray" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Lambert 

      struct Input { 

          float2 uv_MainTex; 

          float4 screenPos; 

      }; 

      sampler2D _MainTex; 

      sampler2D _Detail; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

          float2 screenUV = IN.screenPos.xy / IN.screenPos.w; 

          screenUV *= float2(8,6); 

          o.Albedo *= tex2D (_Detail, screenUV).rgb * 2; 

      } 

      ENDCG 

    }  

    Fallback "Diffuse" 

  } 



I removed normal mapping from the shader above, just to make it shorter:  

 

Cubemap Reflection 

Here's a shader that does cubemapped reflection using built-in worldRefl input. It's actually very similar to built-in Reflective/Diffuse 

shader:  

  Shader "Example/WorldRefl" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

      _Cube ("Cubemap", CUBE) = "" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Lambert 

      struct Input { 

          float2 uv_MainTex; 

          float3 worldRefl; 

      }; 

      sampler2D _MainTex; 

      samplerCUBE _Cube; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb * 0.5; 

          o.Emission = texCUBE (_Cube, IN.worldRefl).rgb; 

      } 

      ENDCG 

    }  

    Fallback "Diffuse" 

  } 



And since it assigns the reflection color as Emission, we get a very shiny soldier:  

 

If you want to do reflections that are affected by normal maps, it needs to be slightly more involved: INTERNAL_DATA needs to be added 

to the Input structure, and WorldReflectionVector function used to compute per-pixel reflection vector after you've written the 

Normal output.  

  Shader "Example/WorldRefl Normalmap" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

      _BumpMap ("Bumpmap", 2D) = "bump" {} 

      _Cube ("Cubemap", CUBE) = "" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Lambert 

      struct Input { 

          float2 uv_MainTex; 

          float2 uv_BumpMap; 

          float3 worldRefl; 

          INTERNAL_DATA 

      }; 

      sampler2D _MainTex; 

      sampler2D _BumpMap; 

      samplerCUBE _Cube; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb * 0.5; 

          o.Normal = UnpackNormal (tex2D (_BumpMap, IN.uv_BumpMap)); 

          o.Emission = texCUBE (_Cube, WorldReflectionVector (IN, o.Normal)).rgb; 

      } 

      ENDCG 

    }  

    Fallback "Diffuse" 

  } 



Here's a normal mapped shiny soldier:  

 

Slices via World Space Position 

Here's a shader that "slices" the object by discarding pixels in nearly horizontal rings. It does that by using clip() Cg/HLSL function 

based on world position of a pixel. We'll use worldPos built-in surface shader variable.  

  Shader "Example/Slices" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

      _BumpMap ("Bumpmap", 2D) = "bump" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      Cull Off 

      CGPROGRAM 

      #pragma surface surf Lambert 

      struct Input { 

          float2 uv_MainTex; 

          float2 uv_BumpMap; 

          float3 worldPos; 

      }; 

      sampler2D _MainTex; 

      sampler2D _BumpMap; 

      void surf (Input IN, inout SurfaceOutput o) { 

          clip (frac((IN.worldPos.y+IN.worldPos.z*0.1) * 5) - 0.5); 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

          o.Normal = UnpackNormal (tex2D (_BumpMap, IN.uv_BumpMap)); 

      } 

      ENDCG 

    }  

    Fallback "Diffuse" 

  } 



 

Normal Extrusion with Vertex Modifier 

It is possible to use a "vertex modifier" function that will modify incoming vertex data in the vertex shader. This can be used for procedural 

animation, extrusion along normals and so on. Surface shader compilation directive vertex:functionName is used for that, with a 

function that takes inout appdata_full parameter.  

Here's a shader that moves vertices along their normals by the amount specified in the material:  

  Shader "Example/Normal Extrusion" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

      _Amount ("Extrusion Amount", Range(-1,1)) = 0.5 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Lambert vertex:vert 

      struct Input { 

          float2 uv_MainTex; 

      }; 

      float _Amount; 

      void vert (inout appdata_full v) { 

          v.vertex.xyz += v.normal * _Amount; 

      } 

      sampler2D _MainTex; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

      } 

      ENDCG 

    }  

    Fallback "Diffuse" 

  } 



Moving vertices along their normals makes a fat soldier:  

 

Custom data computed per-vertex 

Using a vertex modifier function it is also possible to compute custom data in a vertex shader, which then will be passed to the surface 

shader function per-pixel. The same compilation directive vertex:functionName is used, but the function should take two 

parameters: inout appdata_full and out Input. You can fill in any Input member that is not a built-in value there.  

Example below defines a custom float3 customColor member, which is computed in a vertex function:  

  Shader "Example/Custom Vertex Data" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Lambert vertex:vert 

      struct Input { 

          float2 uv_MainTex; 

          float3 customColor; 

      }; 

      void vert (inout appdata_full v, out Input o) { 

          o.customColor = abs(v.normal); 

      } 

      sampler2D _MainTex; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

          o.Albedo *= IN.customColor; 

      } 

      ENDCG 

    }  

    Fallback "Diffuse" 

  } 



In this example customColor is set to the absolute value of the normal:  

 

More practical uses could be computing any per-vertex data that is not provided by built-in Input variables; or optimizing shader 

computations. For example, it's possible to compute Rim lighting at object's vertices, instead of doing that in the surface shader per-pixel.  
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SL-SurfaceShaderLighting 
When writing Surface Shaders, you're describing properties of a surface (albedo color, normal, ...) and the lighting interaction is computed 

by a Lighting Model. Built-in lighting models are Lambert (diffuse lighting) and BlinnPhong (specular lighting).  

Sometimes you might want to use a custom lighting model, and it is possible to do that in Surface Shaders. Lighting model is nothing more 

than a couple of Cg/HLSL functions that match some conventions. The built-in Lambert and BlinnPhong models are defined in 

Lighting.cginc file inside Unity ({unity install path}/Data/CGIncludes/Lighting.cginc on Windows, 

/Applications/Unity/Unity.app/Contents/CGIncludes/Lighting.cginc on Mac).  

Lighting Model declaration 

Lighting model is a couple of regular functions with names starting with Lighting. They can be declared anywhere in your shader file or 

one of included files. The functions are:  

1. half4 LightingName (SurfaceOutput s, half3 lightDir, half atten); This is used in forward 

rendering path for light models that are not view direction dependent (e.g. diffuse).  

2. half4 LightingName (SurfaceOutput s, half3 lightDir, half3 viewDir, half atten); This is 

used in forward rendering path for light models that are view direction dependent.  

3. half4 LightingName_PrePass (SurfaceOutput s, half4 light); This is used in deferred lighting path.  

Note that you don't need to declare all functions. A lighting model either uses view direction or it does not. Similarly, if the lighting model will 

not work in deferred lighting, you just do not declare _PrePass function, and all shaders that use it will compile to forward rendering only.  

Examples 

http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html


Surface Shader Lighting Examples  
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SL-SurfaceShaderLightingExamples 
Here are some examples of custom lighting models in Surface Shaders. General Surface Shader examples are in this page.  

Because Deferred Lighting does not play well with some custom per-material lighting models, in most examples below we make the 

shaders compile to Forward Rendering only.  

Diffuse 

We'll start with a shader that uses built-in Lambert lighting model:  

  Shader "Example/Diffuse Texture" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Lambert 

      struct Input { 

          float2 uv_MainTex; 

      }; 

      sampler2D _MainTex; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

      } 

      ENDCG 

    } 

    Fallback "Diffuse" 

  } 

http://unity3d.com/support/documentation/Components/SL-SurfaceShaderLightingExamples.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaderLighting.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaderExamples.html


Here's how it looks like with a texture and without an actual texture (one directional light is in the scene):  

 

Now, let's do exactly the same, but write out our own lighting model instead of using built-in Lambert one. Surface Shader Lighting Models 

are just some functions that we need to write. Here's a simple Lambert one. Note that the "shader part" itself did not change at all (grayed 

out):  

  Shader "Example/Diffuse Texture" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf SimpleLambert 

http://unity3d.com/support/documentation/Components/SL-SurfaceShaderLighting.html


 

      half4 LightingSimpleLambert (SurfaceOutput s, half3 lightDir, half atten) { 

          half NdotL = dot (s.Normal, lightDir); 

          half4 c; 

          c.rgb = s.Albedo * _LightColor0.rgb * (NdotL * atten * 2); 

          c.a = s.Alpha; 

          return c; 

      } 

 

      struct Input { 

          float2 uv_MainTex; 

      }; 

      sampler2D _MainTex; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

      } 

      ENDCG 

    } 

    Fallback "Diffuse" 

  } 

So our simple Diffuse lighting model is LightingSimpleLambert function. It computes lighting by doing a dot product between 

surface normal and light direction, and then applies light attenuation and color.  

Diffuse Wrap 

Here's Wrapped Diffuse - a modification of Diffuse lighting, where illumination "wraps around" the edges of objects. It's useful for faking 

subsurface scattering effect. Again, the surface shader itself did not change at all, we're just using different lighting function.  

  Shader "Example/Diffuse Wrapped" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf WrapLambert 

 

      half4 LightingWrapLambert (SurfaceOutput s, half3 lightDir, half atten) { 

          half NdotL = dot (s.Normal, lightDir); 

          half diff = NdotL * 0.5 + 0.5; 

          half4 c; 

          c.rgb = s.Albedo * _LightColor0.rgb * (diff * atten * 2); 

          c.a = s.Alpha; 

          return c; 

      } 

 

      struct Input { 

          float2 uv_MainTex; 

      }; 

      sampler2D _MainTex; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

      } 

      ENDCG 

    } 

    Fallback "Diffuse" 

  } 



 

Toon Ramp 

Here's a "Ramp" lighting model that uses a texture ramp to define how surface responds to angle between light and the normal. This can 

be used for variety of effects, including Toon lighting.  

  Shader "Example/Toon Ramp" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

      _Ramp ("Shading Ramp", 2D) = "gray" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf Ramp 



 

      sampler2D _Ramp; 

 

      half4 LightingRamp (SurfaceOutput s, half3 lightDir, half atten) { 

          half NdotL = dot (s.Normal, lightDir); 

          half diff = NdotL * 0.5 + 0.5; 

          half3 ramp = tex2D (_Ramp, float2(diff)).rgb; 

          half4 c; 

          c.rgb = s.Albedo * _LightColor0.rgb * ramp * (atten * 2); 

          c.a = s.Alpha; 

          return c; 

      } 

 

      struct Input { 

          float2 uv_MainTex; 

      }; 

      sampler2D _MainTex; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

      } 

      ENDCG 

    } 

    Fallback "Diffuse" 

  } 



 

 

Simple Specular 

Here's a simple specular lighting model. It's quite simple to what built-in BlinnPhong actually does; we just put it here to illustrate how it's 

done.  

  Shader "Example/Simple Specular" { 

    Properties { 

      _MainTex ("Texture", 2D) = "white" {} 

    } 

    SubShader { 

      Tags { "RenderType" = "Opaque" } 

      CGPROGRAM 

      #pragma surface surf SimpleSpecular 



 

      half4 LightingSimpleSpecular (SurfaceOutput s, half3 lightDir, half3 viewDir, half 

atten) { 

          half3 h = normalize (lightDir + viewDir); 

 

          half diff = max (0, dot (s.Normal, lightDir)); 

 

          float nh = max (0, dot (s.Normal, h)); 

          float spec = pow (nh, 48.0); 

 

          half4 c; 

          c.rgb = (s.Albedo * _LightColor0.rgb * diff + _LightColor0.rgb * spec) * (atten * 

2); 

          c.a = s.Alpha; 

          return c; 

      } 

 

      struct Input { 

          float2 uv_MainTex; 

      }; 

      sampler2D _MainTex; 

      void surf (Input IN, inout SurfaceOutput o) { 

          o.Albedo = tex2D (_MainTex, IN.uv_MainTex).rgb; 

      } 

      ENDCG 

    } 

    Fallback "Diffuse" 

  } 
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SL-ShaderPrograms 
ShaderLab shaders encompass more than just "hardware shaders". They do many things. They describe properties that are displayed in 

the Material Inspector, contain multiple shader implementations for different graphics hardware, configure fixed function hardware state and 

so on. The actual programmable shaders - like vertex and fragment programs - are just a part of the whole ShaderLab's "shader" concept. 

Take a look at shader tutorial for a basic introduction. Here we'll call the low-level hardware shaders shader programs.  

If you want to write shaders that interact with lighting, take a look at Surface Shaders documentation. The rest of this page will 

assume shaders that do not interact with Unity lights (e.g. special effects, Image Effects etc.)  

http://unity3d.com/support/documentation/Manual/ShaderTut2.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html


Shader programs are written in Cg / HLSL language, by embedding "snippets" in the shader text, somewhere inside the Pass command. 

They usually look like this:  

  Pass { 

      // ... the usual pass state setup ... 
 

      CGPROGRAM 

      // compilation directives for this snippet, e.g.: 
      #pragma vertex vert 

      #pragma fragment frag 

 

      // the Cg code itself 
 

      ENDCG 

      // ... the rest of pass setup ... 
  } 

Cg snippets 

Cg program snippets are written between CGPROGRAM and ENDCG.  

At the start of the snippet compilation directives can be given as #pragma statements. Directives recognized by Unity are:  

 #pragma vertex name - indicates that function name is a vertex program.  

 #pragma fragment name - indicates that function name is a fragment program.  

 #pragma fragmentoption option - adds option to the compiled OpenGL fragment program. See the ARB fragment program specification 

for a list of allowed options. This directive has no effect on vertex programs or programs that are compiled to non-OpenGL targets.  

 #pragma target name - which shader target to compile to. See shader targets for details.  

 #pragma only_renderers space separated names - compile shader only for given renderers. By default shaders are compiled for all 

renderers. See renderers for details.  

 #pragma exclude_renderers space separated names - do not compile shader for given renderers. By default shaders are compiled for 

all renderers. See renderers for details.  

Each snippet must contain a vertex program, a fragment program, or both. Thus a #pragma vertex or #pragma fragment directive is 

required, or both.  

Shader targets 

By default, Unity compiles vertex programs into a shader model 1.1 equivalent, and fragment programs into a shader model 2.0 equivalent. 

Using #pragma target allows shaders to be compiled into other capability levels. Currently these targets are supported:  

 #pragma target default - compile to default target:  

o Vertex shader 1.1 and pixel shader 2.0 on Direct3D 9.  

o ARB_vertex_program with 128 instruction limit and ARB_fragment_program with 96 instruction limit (32 texture + 64 arithmetic), 16 

temporary registers and 4 texture indirections.  

 #pragma target 3.0 - compile to shader model 3.0:  

o Vertex shader 3.0 and pixel shader 3.0 on Direct3D 9.  

o ARB_vertex_program with no instruction limit and ARB_fragment_program with 1024 instruction limit (512 texture + 512 arithmetic), 32 

temporary registers and 4 texture indirections. It is possible to override these limits using #pragma profileoption directive. E.g. #pragma 

profileoption MaxTexIndirections=256 raises texture indirections limit to 256.  

When compiling to 3.0 target, both vertex and fragment programs need to be present.  

Renderers 

Unity supports several rendering APIs (e.g. Direct3D 9 and OpenGL), and by default all shader programs are compiled into for supported 

renderers. You can indicate which renderers to compile to using #pragma only_renderers or #pragma exclude_renderers directives. 

http://unity3d.com/support/documentation/Components/SL-Pass.html
http://www.opengl.org/registry/specs/ARB/fragment_program.txt
http://unity3d.com/support/documentation/printable.html#target
http://unity3d.com/support/documentation/printable.html#renderers
http://unity3d.com/support/documentation/printable.html#renderers
http://www.opengl.org/registry/specs/ARB/vertex_program.txt
http://www.opengl.org/registry/specs/ARB/fragment_program.txt


This is useful if you know you will only target Mac OS X (where there's no Direct3D), or only Windows (where Unity defaults to D3D), or if 

some particular shader is only possible in one renderer and not others. Currently supported renderer names are:  

 d3d9 - Direct3D 9.  

 opengl - OpenGL.  

 gles - OpenGL ES 2.0.  

 xbox360 - Xbox 360.  

 ps3 - PlayStation 3.  

For example, this line would only compile shader into D3D9 mode:  

  #pragma only_renderers d3d9 

Subsections 

 Accessing shader properties in Cg  

 Providing vertex data to vertex programs  

 Built-in state variables in shader programs  

 GLSL Shader Programs  
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SL-PropertiesInPrograms 
Shader declares it's properties in a Properties block. If you want to access some of those properties in a Cg shader program, you need to 

declare a Cg variable with the same name and a matching type. An example is provided in Shader Tutorial: Vertex and Fragment 

Programs.  

For example these shader properties:  

_MyColor ("Some Color", Color) = (1,1,1,1)  

_MyVector ("Some Vector", Vector) = (0,0,0,0)  

_MyFloat ("My float", Float) = 0.5  

_MyTexture ("Texture", 2D) = "white" {}  

_MyCubemap ("Cubemap", CUBE) = "" {}  

would be declared for access in Cg code as:  

float4 _MyColor; 

float4 _MyVector; 

float _MyFloat;  

sampler2D _MyTexture; 

http://unity3d.com/support/documentation/Components/SL-PropertiesInPrograms.html
http://unity3d.com/support/documentation/Components/SL-VertexProgramInputs.html
http://unity3d.com/support/documentation/Components/SL-BuiltinStateInPrograms.html
http://unity3d.com/support/documentation/Components/SL-GLSLShaderPrograms.html
http://unity3d.com/support/documentation/Components/SL-Properties.html
http://unity3d.com/support/documentation/Components/SL-ShaderPrograms.html
http://unity3d.com/support/documentation/Manual/ShaderTut2.html
http://unity3d.com/support/documentation/Manual/ShaderTut2.html


samplerCUBE _MyCubemap; 

Cg can also accept uniform keyword, but it is not necessary:  

uniform float4 _MyColor; 

Property types in ShaderLab map to Cg variable types this way:  

 Color and Vector properties map to float4 variables.  

 Range and Float properties map to float variables.  

 Texture properties map to sampler2D variables for regular (2D) textures. CUBE and RECT textures map to samplerCUBE and 

samplerRECT variables respectively.  
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SL-VertexProgramInputs 
For Cg vertex programs, the vertex data must be passed in as a structure. Several commonly used vertex structures are defined in 

UnityCG.cginc include file, and in most cases it's enough just to use them. The structures are:  

 appdata_base: vertex consists of position, normal and one texture coordinate.  

 appdata_tan: vertex consists of position, tangent, normal and one texture coordinate.  

For example, this shader colors the mesh based on it's normals and just uses appdata_base as vertex program input:  

Shader "VertexInputSimple" { 

SubShader { 

Pass { 

CGPROGRAM 

#pragma vertex vert 

#include "UnityCG.cginc" 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    fixed4 color : COLOR; 

}; 

 

http://unity3d.com/support/documentation/Components/SL-ShaderPrograms.html


v2f vert (appdata_base v) 

{ 

    v2f o; 

    o.pos = mul (UNITY_MATRIX_MVP, v.vertex); 

    o.color.xyz = v.normal * 0.5 + 0.5; 

    return o; 

} 

 

ENDCG 

} 

}  

} 

If you want to access different vertex data, you have to declare vertex structure yourself. The structure members must be from the 

following list:  

 float4 vertex is the vertex position  

 float3 normal is the vertex normal  

 float4 texcoord is the first UV coordinate  

 float4 texcoord1 is the second UV coordinate  

 float4 tangent is the tangent vector (used for normal mapping)  

 float4 color is per-vertex color  

Examples 

Visualizing UVs 

The following shader example uses vertex position and first texture coordinate as vertex shader input (defined in structure appdata). It is 

very useful to debug UV coordinates of the mesh. UV coordinates are visualized as red and green colors, and coordinates outside of 0..1 

range have additional blue tint applied.  

Shader "!Debug/UV 1" { 

SubShader { 

    Pass { 

        Fog { Mode Off } 

CGPROGRAM 



#pragma vertex vert 

#pragma fragment frag 

 

// vertex input: position, UV 

struct appdata { 

    float4 vertex : POSITION; 

    float4 texcoord : TEXCOORD0; 

}; 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    float4 uv : TEXCOORD0; 

}; 

v2f vert (appdata v) { 

    v2f o; 

    o.pos = mul( UNITY_MATRIX_MVP, v.vertex ); 

    o.uv = float4( v.texcoord.xy, 0, 0 ); 

    return o; 

} 

half4 frag( v2f i ) : COLOR { 

    half4 c = frac( i.uv ); 

    if (any(saturate(i.uv) - i.uv)) 

        c.b = 0.5; 

    return c; 



} 

ENDCG 

    } 

} 

} 

 

Debug UV1 shader applied to a torus knot model 

Similarly, this shader vizualizes the second UV set of the model:  

Shader "!Debug/UV 2" { 

SubShader { 

    Pass { 

        Fog { Mode Off } 

CGPROGRAM 

#pragma vertex vert 

#pragma fragment frag 

 

// vertex input: position, second UV 

struct appdata { 

    float4 vertex : POSITION; 



    float4 texcoord1 : TEXCOORD1; 

}; 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    float4 uv : TEXCOORD0; 

}; 

v2f vert (appdata v) { 

    v2f o; 

    o.pos = mul( UNITY_MATRIX_MVP, v.vertex ); 

    o.uv = float4( v.texcoord1.xy, 0, 0 ); 

    return o; 

} 

half4 frag( v2f i ) : COLOR { 

    half4 c = frac( i.uv ); 

    if (any(saturate(i.uv) - i.uv)) 

        c.b = 0.5; 

    return c; 

} 

ENDCG 

    } 

} 

} 

Visualizing vertex colors 

The following shader uses vertex position and per-vertex colors as vertex shader input (defined in structure appdata).  



Shader "!Debug/Vertex color" { 

SubShader { 

    Pass { 

        Fog { Mode Off } 

CGPROGRAM 

#pragma vertex vert 

 

// vertex input: position, color 

struct appdata { 

    float4 vertex : POSITION; 

    float4 color : COLOR; 

}; 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    fixed4 color : COLOR; 

}; 

v2f vert (appdata v) { 

    v2f o; 

    o.pos = mul( UNITY_MATRIX_MVP, v.vertex ); 

    o.color = v.color; 

    return o; 

} 

ENDCG 



    } 

} 

} 

 

Debug Colors shader applied to a model that has illumination baked into colors 

Visualizing normals 

The following shader uses vertex position and normal as vertex shader input (defined in structure appdata). Normal's X,Y,Z components 

are visualized as R,G,B colors. Because the normal components are in -1..1 range, we scale and bias them so that the output colors are in 

displayable 0..1 range.  

Shader "!Debug/Normals" { 

SubShader { 

    Pass { 

        Fog { Mode Off } 

CGPROGRAM 

#pragma vertex vert 

 

// vertex input: position, normal 

struct appdata { 

    float4 vertex : POSITION; 

    float3 normal : NORMAL; 

}; 



 

struct v2f { 

    float4 pos : SV_POSITION; 

    fixed4 color : COLOR; 

}; 

v2f vert (appdata v) { 

    v2f o; 

    o.pos = mul( UNITY_MATRIX_MVP, v.vertex ); 

    o.color.xyz = v.normal * 0.5 + 0.5; 

    o.color.w = 1.0; 

    return o; 

} 

ENDCG 

    } 

} 

} 

 

Debug Normals shader applied to a model. You can see that the model has hard shading edges. 

Visualizing tangents and binormals 



Tangent and binormal vectors are used for normal mapping. In Unity only the tangent vector is stored in vertices, and binormal is derived 

from normal and tangent.  

The following shader uses vertex position and tangent as vertex shader input (defined in structure appdata). Tangent's X,Y,Z components 

are visualized as R,G,B colors. Because the normal components are in -1..1 range, we scale and bias them so that the output colors are in 

displayable 0..1 range.  

Shader "!Debug/Tangents" { 

SubShader { 

    Pass { 

        Fog { Mode Off } 

CGPROGRAM 

#pragma vertex vert 

 

// vertex input: position, tangent 

struct appdata { 

    float4 vertex : POSITION; 

    float4 tangent : TANGENT; 

}; 

 

struct v2f { 

    float4    pos : SV_POSITION; 

    fixed4    color : COLOR; 

}; 

v2f vert (appdata v) { 

    v2f o; 

    o.pos = mul( UNITY_MATRIX_MVP, v.vertex ); 

    o.color = v.tangent * 0.5 + 0.5; 



    return o; 

} 

ENDCG 

    } 

} 

} 

 

Debug Tangents shader applied to a model. 

The following shader visualizes binormals. It uses vertex position, normal and tangent as vertex input. Binormal is calculated from normal 

and tangent. Just like normal or tangent, it needs to be scaled and biased into a displayable 0..1 range.  

Shader "!Debug/Binormals" { 

SubShader { 

    Pass { 

        Fog { Mode Off } 

CGPROGRAM 

#pragma vertex vert 

 

// vertex input: position, normal, tangent 

struct appdata { 

    float4 vertex : POSITION; 



    float3 normal : NORMAL; 

    float4 tangent : TANGENT; 

}; 

 

struct v2f { 

    float4    pos : SV_POSITION; 

    float4    color : COLOR; 

}; 

v2f vert (appdata v) { 

    v2f o; 

    o.pos = mul( UNITY_MATRIX_MVP, v.vertex ); 

    // calculate binormal 

    float3 binormal = cross( v.normal, v.tangent.xyz ) * v.tangent.w; 

    o.color.xyz = binormal * 0.5 + 0.5; 

    o.color.w = 1.0; 

    return o; 

} 

ENDCG 

    } 

} 

} 



 

Debug Binormals shader applied to a model. Pretty! 
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SL-BuiltinStateInPrograms 
Often in shader programs you need to access some global state, for example, the current model*view*projection matrix, the current 

ambient color, and so on. There's no need to declare these variables for the built-in state, you can just use them in shader programs.  

Built-in matrices 

Matrices (float4x4) supported:  

UNITY_MATRIX_MVP  

Current model*view*projection matrix  

UNITY_MATRIX_MV  

Current model*view matrix  

UNITY_MATRIX_P  

Current projection matrix  

UNITY_MATRIX_T_MV  

Transpose of model*view matrix  

UNITY_MATRIX_IT_MV  

Inverse transpose of model*view matrix  

UNITY_MATRIX_TEXTURE0 to UNITY_MATRIX_TEXTURE3  

Texture transformation matrices  

Built-in vectors 

Vectors (float4) supported:  

UNITY_LIGHTMODEL_AMBIENT  

Current ambient color.  
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http://unity3d.com/support/documentation/Components/SL-ShaderPrograms.html


SL-GLSLShaderPrograms 
In addition to using Cg/HSL shader programs, OpenGL Shading Language (GLSL) shaders can be written directly.  

However, use of raw GLSL is only recommended for testing, or when you know you will only target Mac OS X or OpenGL ES 2.0 

compatible mobile devices. In majority of normal cases, Unity will cross-compile Cg/HLSL into optimized GLSL (this is done by default for 

mobile platforms, and can be optionally turned on for desktop platforms via #pragma glsl).  

GLSL snippets 

GLSL program snippets are written between GLSLPROGRAM and ENDGLSL keywords.  

In GLSL, all shader function entry points have to be called main(). When Unity loads the GLSL shader, it loads the source once for the 

vertex program, with VERTEX preprocessor define, and once more for the fragment program, with FRAGMENT preprocessor define. So 

the way to separate vertex and fragment program parts in GLSL snippet is to surround them with #ifdef VERTEX .. #endif and #ifdef 

FRAGMENT .. #endif. Each GLSL snippet must contain both a vertex program and a fragment program.  

Standard include files match those provided for Cg shaders; they just have .glslinc extension: UnityCG.glslinc.  

Vertex shader inputs come from predefined GLSL variables (gl_Vertex, gl_MultiTexCoord0, ...) or are user defined attributes. Usually only 

the tangent vector needs a user defined attribute:  

    attribute vec4 Tangent; 

Data from vertex to fragment programs is passed through varying variables, for example:  

    varying vec3 lightDir; // vertex shader computes this, fragment shader uses this 
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SL-AdvancedTopics 
Read those to improve your ShaderLab-fu!  

 Unity's Rendering Pipeline  

 Performance Tips when Writing Shaders  

 Rendering with Replaced Shaders  

 Using Depth Textures  

 Camera's Depth Texture  

 Platform Specific Rendering Differences  

 Shader Level of Detail  
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SL-RenderPipeline 
Shaders define both how an object looks by itself (its material properties) and how it reacts to the light. Because lighting calculations must 

be built into the shader, and there are many possible light & shadow types, writing quality shaders that "just work" would be an involved 

task. To make it easier, Unity 3 introduces Surface Shaders, where all the lighting, shadowing, lightmapping, forward vs. deferred lighting 

things are taken care of automatically.  

This document describes the pecularities of Unity's lighting & rendering pipeline and what happens behind the scenes of Surface Shaders.  

http://unity3d.com/support/documentation/Components/SL-ShaderPrograms.html
http://unity3d.com/support/documentation/Components/SL-RenderPipeline.html
http://unity3d.com/support/documentation/Components/SL-ShaderPerformance.html
http://unity3d.com/support/documentation/Components/SL-ShaderReplacement.html
http://unity3d.com/support/documentation/Components/SL-DepthTextures.html
http://unity3d.com/support/documentation/Components/SL-CameraDepthTexture.html
http://unity3d.com/support/documentation/Components/SL-PlatformDifferences.html
http://unity3d.com/support/documentation/Components/SL-ShaderLOD.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html


Rendering Paths 

How lighting is applied and which Passes of the shader are used depends on which Rendering Path is used. Each pass in a shader 

communicates its lighting type via Pass Tags.  

 In Deferred Lighting, PrepassBase and PrepassFinal passes are used.  

 In Forward Rendering, ForwardBase and ForwardAdd passes are used.  

 In Vertex Lit, Vertex, VertexLMRGBM and VertexLM passes are used.  

Deferred Lighting path 

PrepassBase pass renders normals & specular exponent; PrepassFinal pass renders final color by combining textures, lighting & 

emissive material properties. All regular in-scene lighting is done separately in screen-space. See Deferred Lighting for details.  

Forward Rendering path 

ForwardBase pass renders ambient, lightmaps, main directional light and not important (vertex/SH) lights at once. ForwardAdd pass 

is used for any additive per-pixel lights; one invocation per object illuminated by such light is done. See Forward Rendering for details.  

Vertex Lit Rendering path 

Since vertex lighting is most often used on platforms that do not support programmable shaders, Unity can't create multiple shader 

permutations internally to handle lightmapped vs. non-lightmapped cases. So to handle lightmapped and non-lightmapped objects, multiple 

passes have to be written explicitly.  

 Vertex pass is used for non-lightmapped objects. All lights are rendered at once, using a fixed function OpenGL/Direct3D lighting model 

(Blinn-Phong)  

 VertexLMRGBM pass is used for lightmapped objects, when lightmaps are RGBM encoded (this happens on most desktops and 

consoles). No realtime lighting is applied; pass is expected to combine textures with a lightmap.  

 VertexLMM pass is used for lightmapped objects, when lightmaps are double-LDR encoded (this happens on mobiles and old desktops). 

No realtime lighting is applied; pass is expected to combine textures with a lightmap.  
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SL-ShaderPerformance 

Use Common sense ;) 

Compute only things that you need; anything that is not actually needed can be eliminated. For example, supporting per-material color is 

nice to make a shader more flexible, but if you always leave that color set to white then it's useless computations performed for each vertex 

or pixel rendered on screen.  

Another thing to keep in mind is frequency of computations. Usually there are many more pixels rendered (hence their pixel shaders 

executed) than there are vertices (vertex shader executions); and more vertices than objects being rendered. So generally if you can, move 

computations out of pixel shader into the vertex shader; or out of shaders completely and set the values once from a script.  

Less Generic Surface Shaders 

Surface Shaders are great for writing shaders that interact with lighting. However, their default options are tuned for "general case". In 

many cases, you can tweak them to make shaders run faster or at least be smaller:  

 approxview directive for shaders that use view direction (i.e. Specular) will make view direction be normalized per-vertex instead of per-

pixel. This is approximate, but often good enough.  

 halfasview for Specular shader types is even faster. Half-vector (halfway between lighting direction and view vector) will be computed 

and normalized per vertex, and lighting function will already receive half-vector as a parameter instead of view vector.  

http://unity3d.com/support/documentation/Components/SL-Pass.html
http://unity3d.com/support/documentation/Manual/RenderingPaths.html
http://unity3d.com/support/documentation/Components/SL-PassTags.html
http://unity3d.com/support/documentation/Components/RenderTech-DeferredLighting.html
http://unity3d.com/support/documentation/Components/RenderTech-ForwardRendering.html
http://unity3d.com/support/documentation/Components/RenderTech-VertexLit.html
http://unity3d.com/support/documentation/Components/RenderTech-DeferredLighting.html
http://unity3d.com/support/documentation/Components/RenderTech-ForwardRendering.html
http://en.wikipedia.org/wiki/Blinn-Phong_shading
http://unity3d.com/support/documentation/Components/SL-SurfaceShaders.html
http://unity3d.com/support/documentation/Components/SL-SurfaceShaderLighting.html


 noforwardadd will make a shader fully support only one directional light in Forward rendering. The rest of the lights can still have an 

effect as per-vertex lights or spherical harmonics. This is great to make shader smaller and make sure it always renders in one pass, even 

with multiple lights present.  

 noambient will disable ambient lighting and spherical harmonics lights on a shader. This can be slightly faster.  

Precision of computations 

When writing shaders in Cg/HLSL, there are three basic number types: float, half and fixed (as well as vector & matrix variants of 

them, e.g. half3 and float4x4):  

 float: high precision floating point. Generally 32 bits, just like float type in regular programming languages.  

 half: medium precision floating point. Generally 16 bits, with a range of -60000 to +60000 and 3.3 decimal digits of precision.  

 fixed: low precision fixed point. Generally 11 bits, with a range of -2.0 to +2.0 and 1/256th precision.  

Use lowest precision that is possible; this is especially important on mobile platforms like iOS and Android. Good rules of thumb are:  

 For colors and unit length vectors, use fixed.  

 For others, use half if range and precision is fine; otherwise use float.  

On mobile platforms, the key is to ensure as much as possible stays in low precision in the fragment shader. On most mobile GPUs, 

applying swizzles to low precision (fixed/lowp) types is costly; converting between fixed/lowp and higher precision types is quite costly as 

well.  

Alpha Testing 

Fixed function AlphaTest or it's programmable equivalent, clip(), has different performance characteristics on different platforms:  

 Generally it's a small advantage to use it to cull out totally transparent pixels on most platforms.  

 However, on PowerVR GPUs found in iOS and some Android devices, alpha testing is expensive. Do not try to use it as "performance 

optimization" there, it will be slower.  

Color Mask 

On some platforms (mostly mobile GPUs found in iOS and Android devices), using ColorMask to leave out some channels (e.g. 

ColorMask RGB) can be expensive, so only use it if really necessary.  
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SL-ShaderReplacement 
Some rendering effects require rendering a scene with a different set of shaders. For example, good edge detection would need a texture 

with scene normals, so it could detect edges where surface orientations differ. Other effects might need a texture with scene depth, and so 

on. To achieve this, it is possible to render the scene with replaced shaders of all objects.  

Shader replacement is done from scripting using Camera.RenderWithShader or Camera.SetReplacementShader functions. Both functions 

take a shader and a replacementTag.  

It works like this: the camera renders the scene as it normally would. the objects still use their materials, but the actual shader that ends up 

being used is changed:  

 If replacementTag is empty, then all objects in the scene are rendered with the given replacement shader.  

 If replacementTag is not empty, then for each object that would be rendered:  

o The real object's shader is queried for the tag value.  

o If it does not have that tag, object is not rendered.  

http://unity3d.com/support/documentation/Components/SL-AlphaTest.html
http://unity3d.com/support/documentation/Components/SL-Pass.html
http://unity3d.com/support/documentation/ScriptReference/Camera.RenderWithShader.html
http://unity3d.com/support/documentation/ScriptReference/Camera.SetReplacementShader.html
http://unity3d.com/support/documentation/Components/SL-SubshaderTags.html


o A subshader is found in the replacement shader that has a given tag with the found value. If no such subshader is found, object is not 

rendered.  

o Now that subshader is used to render the object.  

So if all shaders would have, for example, a "RenderType" tag with values like "Opaque", "Transparent", "Background", "Overlay", you 

could write a replacement shader that only renders solid objects by using one subshader with RenderType=Solid tag. The other tag types 

would not be found in the replacement shader, so the objects would be not rendered. Or you could write several subshaders for different 

"RenderType" tag values. Incidentally, all built-in Unity shaders have a "RenderType" tag set.  

Shader replacement tags in built-in Unity shaders 

All built-in Unity shaders have a "RenderType" tag set that can be used when rendering with replaced shaders. Tag values are the 

following:  

 Opaque: most of the shaders (Normal, Self Illuminated, Reflective, terrain shaders).  

 Transparent: most semitransparent shaders (Transparent, Particle, Font, terrain additive pass shaders).  

 TransparentCutout: masked transparency shaders (Transparent Cutout, two pass vegetation shaders).  

 Background: Skybox shaders.  

 Overlay: GUITexture, Halo, Flare shaders.  

 TreeOpaque: terrain engine tree bark.  

 TreeTransparentCutout: terrain engine tree leaves.  

 TreeBillboard: terrain engine billboarded trees.  

 Grass: terrain engine grass.  

 GrassBillboard: terrain engine billboarded grass.  

Built-in scene depth/normals texture 

A Camera has a built-in capability to render depth or depth+normals texture, if you need that in some of your effects. See Camera Depth 

Texture page.  
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SL-DepthTextures 
 

Desktop  
 

It is possible to create Render Textures where each pixel contains a high precision "depth" value (see RenderTextureFormat.Depth). This is 

mostly used when some effects need scene's depth to be available (for example, soft particles, screen space ambient occlusion, 

translucency would all need scene's depth).  

Pixel values in the depth texture range from 0 to 1 with a nonlinear distribution. Precision is usually 24 or 16 bits, depending on depth buffer 

used. When reading from depth texture, a high precision value in 0..1 range is returned. If you need to get distance from the camera, or 

otherwise linear value, you should compute that manually.  

Depth textures in Unity are implemented differently on different platforms.  

 On Direct3D 9 (Windows), depth texture is either a native depth buffer, or a single channel 32 bit floating point texture ("R32F" Direct3D 

format).  

o Graphics card must support either native depth buffer (INTZ format) or floating point render textures in order for them to work.  

o When rendering into the depth texture, fragment program must output the value needed.  

o When reading from depth texture, red component of the color contains the high precision value.  

 On OpenGL (Mac OS X), depth texture is the native OpenGL depth texture (see ARB_depth_texture).  

http://unity3d.com/support/documentation/Components/SL-SubShader.html
http://unity3d.com/support/documentation/Components/SL-SubshaderTags.html
http://unity3d.com/support/documentation/Components/shader-NormalFamily.html
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http://unity3d.com/support/documentation/Components/shader-TransparentFamily.html
http://unity3d.com/support/documentation/Components/shader-TransparentCutoutFamily.html
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o Graphics card must support OpenGL 1.4 or ARB_depth_texture extension.  

o Depth texture corresponds to Z buffer contents that are rendered, it does not use the result from the fragment program.  

Using depth texture helper macros 

Most of the time depth textures are used to render depth from the camera. UnityCG.cginc helper include file contains some macros to 

deal with the above complexity in this case:  

 UNITY_TRANSFER_DEPTH(o): computes eye space depth of the vertex and outputs it in o (which must be a float2). Use it in a vertex 

program when rendering into a depth texture. On OpenGL this macro does nothing at all, because Z buffer value is rendered implicitly.  

 UNITY_OUTPUT_DEPTH(i): returns eye space depth from i (which must be a float2). Use it in a fragment program when rendering into a 

depth texture. On OpenGL this macro always returns zero, because Z buffer value is rendered implicitly.  

 COMPUTE_EYEDEPTH(i): computes eye space depth of the vertex and outputs it in o. Use it in a vertex program when not rendering into 

a depth texture.  

 DECODE_EYEDEPTH(i): given high precision value from depth texture i, returns corresponding eye space depth. This macro just returns 

i*FarPlane on Direct3D. On OpenGL it linearizes and expands the value to match camera's range.  

For example, this shader would render depth of its objects:  

Shader "Render Depth" { 

SubShader { 

    Tags { "RenderType"="Opaque" } 

    Pass { 

        Fog { Mode Off } 

CGPROGRAM 

#pragma vertex vert 

#pragma fragment frag 

#include "UnityCG.cginc" 

 

struct v2f { 

    float4 pos : SV_POSITION; 

    float2 depth : TEXCOORD0; 

}; 

 

v2f vert (appdata_base v) { 

http://www.opengl.org/registry/specs/ARB/depth_texture.txt


    v2f o; 

    o.pos = mul (UNITY_MATRIX_MVP, v.vertex); 

    UNITY_TRANSFER_DEPTH(o.depth); 

    return o; 

} 

 

half4 frag(v2f i) : COLOR { 

    UNITY_OUTPUT_DEPTH(i.depth); 

} 

ENDCG 

    } 

} 

} 

 

iOS 
 

This feature is not supported for iOS targets.  

 

Android 
 

This feature is not supported for Android targets.  
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In Unity a Camera can generate a depth or depth+normals texture. This is a minimalistic G-buffer texture that can be used for post-

processing effects or to implement custom lighting models (e.g. light pre-pass). Camera actually builds the depth texture using Shader 

Replacement feature, so it's entirely possible to do that yourself, in case you need a different G-buffer setup.  

Camera's depth texture can be turned on using Camera.depthTextureMode variable from script.  

There are two possible depth texture modes:  

 DepthTextureMode.Depth: a depth texture.  

 DepthTextureMode.DepthNormals: depth and view space normals packed into one texture.  

DepthTextureMode.Depth texture 

This builds a screen-sized depth texture.  

DepthTextureMode.DepthNormals texture 

This builds a screen-sized 32 bit (8 bit/channel) texture, where view space normals are encoded into R&G channels, and depth is encoded 

in B&A channels. Normals are encoded using Stereographic projection, and depth is 16 bit value packed into two 8 bit channels.  

UnityCG.cginc Cg include file has a helper function DecodeDepthNormal to decode depth and normal from the encoded pixel 

value. Returned depth is in 0..1 range.  

For examples on how to use the depth and normals texture, please refer to the EdgeDetection image effect in the Shader Replacement 

example project or SSAO Image Effect.  

Tips & Tricks 

When implementing complex shaders or Image Effects, keep Rendering Differences Between Platforms in mind. In particular, using depth 

texture in an Image Effect often needs special handling on Direct3D + Anti-Aliasing.  

In some cases, the depth texture might come directly from the native Z buffer. If you see artifacts in your depth texture, make sure that the 

shaders that use it do not write into the Z buffer (use ZWrite Off).  

 

iOS 
 

This feature is not supported for iOS targets.  

 

Android 
 

This feature is not supported for Android targets.  
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SL-PlatformDifferences 
Unity runs on various platforms, and in some cases there are differences in how things behave. Most of the time Unity hides the differences 

from you, but sometimes you can still bump into them.  
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Render Texture Coordinates 

Vertical texture coordinate conventions differ between Direct3D, OpenGL and OpenGL ES:  

 In Direct3D, the coordinate is zero at the top, and increases downwards.  

 In OpenGL and OpenGL ES, the coordiante is zero at the bottom, and increases upwards.  

Most of the time this does not really matter, except when rendering into a RenderTexture. In that case, Unity internally flips rendering 

upside down when rendering into a texture on Direct3D, so that the conventions match between the platforms.  

One case where this does not happen, is when Image Effects and Anti-Aliasing is used. In this case, Unity renders to screen to get anti-

aliasing, and then "resolves" rendering into a RenderTexture for further processing with an Image Effect. The resulting source texture for an 

image effect is not flipped upside down on Direct3D (unlike all other Render Textures).  

If your Image Effect is a simple one (processes one texture at a time), this does not really matter, because Graphics.Blit takes care of that.  

However, if you're processing more than one RenderTexture together in your Image Effect, most likely they will come out at different 

vertical orientations (only in Direct3D, and only when anti-aliasing is used). You need to manually "flip" the screen texture upside down in 

your vertex shader, like this:  

// On D3D when AA is used, the main texture & scene depth texture 

// will come out in different vertical orientations. 

// So flip sampling of the texture when that is the case (main texture 

// texel size will have negative Y). 

#if SHADER_API_D3D9 

if (_MainTex_TexelSize.y < 0) 

        uv.y = 1-uv.y; 

#endif 

Check out Edge Detection scene in Shader Replacement sample project for an example of this. Edge detection there uses both screen 

texture and Camera's Depth+Normals texture.  

Using OpenGL Shading Language (GLSL) shaders with OpenGL ES 2.0 

OpenGL ES 2.0 provides only limited native support for OpenGL Shading Language (GLSL), for instance OpenGL ES 2.0 layer provides no 

built-in parameters to the shader.  

Unity implements built-in parameters for you exactly in the same way as OpenGL does, however following built-in parameters are missing:  

 gl_ClipVertex  

 gl_SecondaryColor  

 gl_DepthRange  

 halfVector property of the gl_LightSourceParameters structure  

 gl_FrontFacing  

 gl_FrontLightModelProduct  

http://unity3d.com/support/documentation/Components/class-RenderTexture.html
http://unity3d.com/support/documentation/Components/comp-ImageEffects.html
http://unity3d.com/support/documentation/ScriptReference/Graphics.Blit.html
http://unity3d.com/support/resources/example-projects/shader-replacement
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 gl_BackLightModelProduct  

 gl_BackMaterial  

 gl_Point  

 gl_PointSize  

 gl_ClipPlane  

 gl_EyePlaneR, gl_EyePlaneS, gl_EyePlaneT, gl_EyePlaneQ  

 gl_ObjectPlaneR, gl_ObjectPlaneS, gl_ObjectPlaneT, gl_ObjectPlaneQ  

 gl_Fog  

iPad2 and MSAA and alpha-blended geometry 

There is a bug in apple driver resulting in artifacts when MSAA is enabled and alpha-blended geometry is drawn with non RGBA colorMask. 

To prevent artifacts we force RGBA colorMask when this configuration is encountered, though it will render built-in Glow FX unusable (as it 

needs DST_ALPHA for intensity value). Also, please update your shaders if you wrote them yourself (see "Render Setup -> ColorMask" in 

Pass Docs).  
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SL-ShaderLOD 
Shader Level of Detail (LOD) works by only using shaders or subshaders that have their LOD value less than a given number.  

By default, allowed LOD level is infinite, that is, all shaders that are supported by the user's hardware can be used. However, in some 

cases you might want to drop shader details, even if the hardware can support them. For example, some cheap graphics cards might 

support all the features, but are too slow to use them. So you may want to not use parallax normal mapping on them.  

Shader LOD can be either set per individual shader (using Shader.maximumLOD), or globally for all shaders (using 

Shader.globalMaximumLOD).  

In your custom shaders, use LOD command to set up LOD value for any subshader.  

Built-in shaders in Unity have their LODs set up this way:  

 VertexLit kind of shaders = 100  

 Decal, Reflective VertexLit = 150  

 Diffuse = 200  

 Diffuse Detail, Reflective Bumped Unlit, Reflective Bumped VertexLit = 250  

 Bumped, Specular = 300  

 Bumped Specular = 400  

 Parallax = 500  

 Parallax Specular = 600  
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SL-BuiltinValues 
Unity provides a handful of builtin values for your shaders: things like current object's transformation matrices, time etc.  

You just use them in ShaderLab like you'd use any other property, the only difference is that you don't have to declare it somewhere - they 

are "built in".  

http://unity3d.com/support/documentation/ScriptReference/Main.SL-Pass
http://unity3d.com/support/documentation/ScriptReference/Shader-maximumLOD.html
http://unity3d.com/support/documentation/ScriptReference/Shader-globalMaximumLOD.html


Using them in programmable shaders requires including UnityCG.cginc file.  

Transformations 

float4x4 UNITY_MATRIX_MVP  

Current model*view*projection matrix  

float4x4 UNITY_MATRIX_MV  

Current model*view matrix  

float4x4 UNITY_MATRIX_P  

Current projection matrix  

float4x4 UNITY_MATRIX_T_MV  

Transpose of model*view matrix  

float4x4 UNITY_MATRIX_IT_MV  

Inverse transpose of model*view matrix  

float4x4 UNITY_MATRIX_TEXTURE0 to UNITY_MATRIX_TEXTURE3  

Texture transformation matrices  

float4x4 _Object2World  

Current model matrix  

float4x4 _World2Object  

Inverse of current world matrix  

float3 _WorldSpaceCameraPos  

World space position of the camera  

float4 unity_Scale  

xyz components unused; .w contains scale for uniformly scaled objects.  

Lighting 

In plain ShaderLab, you access the following properties by appending zero at the end: e.g. the light's model*light color is 

_ModelLightColor0. In Cg shaders, they are exposed as arrays with a single element, so the same in Cg is 

_ModelLightColor[0].  

Name Type Value 

_ModelLightColor float4 Material's Main * Light color 

_SpecularLightColor float4 Material's Specular * Light color 

_ObjectSpaceLightPos float4 Light's position in object space. w component is 0 for directional lights, 1 for other lights 

_Light2World float4x4 Light to World space matrix 

_World2Light float4x4 World to Light space matrix 

_Object2Light float4x4 Object to Light space matrix 

Various 

 float4 _Time : Time (t/20, t, t*2, t*3), use to animate things inside the shaders  

 float4 _SinTime : Sine of time: (t/8, t/4, t/2, t)  

 float4 _CosTime : Cosine of time: (t/8, t/4, t/2, t)  

 float4 _ProjectionParams :  

x is 1.0 or -1.0, negative if currently rendering with a flipped projection matrix  

y is camera's near plane  

z is camera's far plane  

w is 1/FarPlane.  

http://unity3d.com/support/documentation/Components/SL-ShaderPrograms.html


 float4 _ScreenParams :  

x is current render target width in pixels  

y is current render target height in pixels  

z is 1.0 + 1.0/width  

w is 1.0 + 1.0/height  
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Scripting Concepts 

 Layers  

o Layer-Based Collision Detection.  

 What is a Tag?  

 Rigidbody Sleeping  

Page last updated: 2007-11-16 

 

 

Layers 
Layers are most commonly used by Cameras to render only a part of the scene, and by Lights to illuminate only parts of the scene. But 

they can also used by raycasting to selectively ignore colliders or to create collisions.  

Creating Layers 

The first step is to create a new layer, which we can then assign to a GameObject. To create a new layer, open the Edit menu and select 

Project Settings->Tags.  

We create a new layer in one of the empty User Layers. We choose layer 8.  

 

Assigning Layers 

Now that you have created a new layer, you have to assign the layer to one of the game objects.  

http://unity3d.com/support/documentation/Components/Layers.html
http://unity3d.com/support/documentation/Components/Layer%20Based%20Collision%20detection.html
http://unity3d.com/support/documentation/Components/Tags.html
http://unity3d.com/support/documentation/Components/RigidbodySleeping.html
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In the tag manager we assigned the Player layer to be in layer 8.  

Drawing only a part of the scene with the camera's culling mask 

Using the camera's culling mask, you can selectively render objects which are in one particular layer. To do this, select the camera that 

should selectively render objects.  

Modify the culling mask by checking or unchecking layers in the culling mask property.  

 

Casting Rays Selectively 

Using layers you can cast rays and ignore colliders in specific layers. For example you might want to cast a ray only against the player layer 

and ignore all other colliders.  

The Physics.Raycast function takes a bitmask, where each bit determines if a layer will be ignored or not. If all bits in the layerMask are on, 

we will collide against all colliders. If the layerMask = 0, we will never find any collisions with the ray.  



// bit shift the index of the layer to get a bit mask 

var layerMask = 1 << 8; 

// Does the ray intersect any objects which are in the player layer. 

if (Physics.Raycast (transform.position, Vector3.forward, Mathf.Infinity, layerMask)) 

    print ("The ray hit the player");  

In the real world you want to do the inverse of that however. We want to cast a ray against all colliders except those in the Player layer.  

function Update () { 

  // Bit shift the index of the layer (8) to get a bit mask 

  var layerMask = 1 << 8; 

  // This would cast rays only against colliders in layer 8. 

  // But instead we want to collide against everything except layer 8. The ~ operator does this, it inverts a bitmask. 

  layerMask = ~layerMask; 

 

  var hit : RaycastHit; 

  // Does the ray intersect any objects excluding the player layer 

  if (Physics.Raycast (transform.position, transform.TransformDirection (Vector3.forward), hit, Mathf.Infinity, layerMask)) { 

    Debug.DrawRay (transform.position, transform.TransformDirection (Vector3.forward) * hit.distance, Color.yellow); 

    print ("Did Hit"); 

  } else { 

    Debug.DrawRay (transform.position, transform.TransformDirection (Vector3.forward) *1000, Color.white); 

    print ("Did not Hit"); 

  } 

} 



When you don't pass a layerMask to the Raycast function, it will only ignore colliders that use the IgnoreRaycast layer. This is the easiest 

way to ignore some colliders when casting a ray.  
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Layer Based Collision detection 
In Unity 3.x we introduce Layer-Based collision detection, which is a way to make Game Objects collide with another specific Game 

Objects that are tied up to specific layers.  

 

Objects Colliding with their own layer. 

In the image above you can see 6 GameObjects, (3 planes, 3 cubes) and the "Collision Matrix" to the right that states which Objects can 

collide with which layer. In the example, we have set the Collision Matrix in a way that only GameObjects that belong to same layers can 

collide.  

Setting GameObjects to detect Collisions Based on Layers. 

1. Select a layer your Game Objects will belong to  

 

2. Repeat 1 for each Game Object until you have finished assigning your Game Objects to the layers.  

3. Open the Physics Preference Panel by clicking on Edit->Project Settings->Physics.  

4. Select which layers on the Collision Matrix will interact with the other layers by checking them.  
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Tags 
A Tag is a word which you link to one or more GameObjects. For instance, you might define �Player� and �Enemy� Tags for player-

controlled characters and non-player characters respectively; a �Collectable� Tag could be defined for items the player can collect in the 

Scene; and so on. Clearly, Tags are intended to identify GameObjects for scripting purposes. We can use them to write script code to find 

a GameObject by looking for any object that contains our desired Tag. This is achieved using the GameObject.FindWithTag() function.  

For example:  

// Instantiates respawnPrefab at the location  

// of the game object with tag "Respawn" 

 

var respawnPrefab : GameObject; 

var respawn = GameObject.FindWithTag ("Respawn"); 

Instantiate (respawnPrefab, respawn.position, respawn.rotation); 

This saves us having to manually add our GameObjects to a script�s exposed properties using drag and drop -- a useful timesaver if the 

same script code is being used in a number of GameObjects. Another example is a Trigger Collider control script which needs to work out 

whether the player is interacting with an enemy, as opposed to, say, a random prop or collectable item. Tags make this kind of test easy.  

Applying a Tag 

The Inspector will show the Tag and Layer drop-down menus just below any GameObject�s name. To apply a Tag to a GameObject, 

simply open the Tags drop-down and choose the Tag you require:  

 

http://unity3d.com/support/documentation/Components/class-SphereCollider.html
http://unity3d.com/support/documentation/Components/Layers.html


 

The GameObject will now be associated with this Tag.  

Creating new Tags 

To create a new Tag, click the �Add new tag...� option at the end of the drop-down menu. This will open up the Tag Manager in the 

Inspector. The Tag Manager is described here.  

Layers appear similar to Tags, but are used to define how Unity should render GameObjects in the Scene. See the Layers page for more 

information.  

Hints 

 A GameObject can only have one Tag assigned to it.  

 Unity includes some built-in Tags which do not appear in the Tag Manager:  

o "Untagged"  

o "Respawn"  

o "Finish"  

o "EditorOnly"  

o "MainCamera"  

o "Player"  

o and "GameController".  

 You can use any word you like as a Tag. (You can even use short phrases, but you may need to widen the Inspector to see the tag's full 

name.)  
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RigidbodySleeping 
When Rigidbodies fall to rest - a box landing on the floor - they will start sleeping. Sleeping is an optimization which allows the Physics 

Engine to stop processing those rigidbodies. This way you can have huge amounts of rigidbodies in your scene as long as you make sure 

that they normally don't move.  

Rigidbody sleeping happens completely automatically. Whenever a rigidbody is slower than the sleepAngularVelocity and sleepVelocity it 

will start falling asleep. After a few frames of resting it will then be set to sleep. When the body is sleeping, no collision detection or 

simulation will be performed anymore. This saves a lot of CPU cycles.  

Rigidbodies automatically wake up when:  

 another rigidbody collides with the sleeping rigidbody  

 another rigidbody connected through a joint is moving.  

 when modifying a property of the rigidbody  

 when adding forces.  

So if you want to make rigidbodies fall to rest, don't modify their properties or add forces when they are about to go into sleep mode.  

There are two variables that you can tune to make sure your rigidbodies automatically fall to rest: Rigidbody.sleepVelocity and 

Rigidbody.sleepAngularVelocity. Those two variables are initialized to the sleepVelocity and sleepAngularVelocity variable defined in the 

Physics Manager (Edit -> Project Settings -> Physics).  

Rigidbodies can also be forced to sleep using rigidbody.Sleep. This is useful to start rigidbodies in a rest state when loading a new level.  

http://unity3d.com/support/documentation/Components/class-TagManager.html
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Kinematic rigidbodies wake up sleeping rigidbodies. Static Colliders do not. If you have a sleeping rigidbody and you move a static collider 

(A collider without a Rigidbody attached) into the rigidbody or pull it from underneath the rigidbody, the sleeping rigidbody will not awake. If 

you move a Kinematic Rigidbody out from underneath normal Rigidbodies that are at rest on top of it, the sleeping Rigidbodies will "wake 

up" and be correctly calculated again in the physics update. So if you have a lot of Static Colliders that you want to move around and have 

different objects fall on them correctly, use Kinematic Rigidbody Colliders.  

Kinematic rigidbodies - they will not be calculated during the physics update since they are not going anywhere. If you move a Kinematic 

Rigidbody out from underneath normal Rigidbodies that are at rest on top of it, the sleeping Rigidbodies will "wake up" and be correctly 

calculated again in the physics update. So if you have a lot of Static Colliders that you want to move around and have different objects fall 

on them correctly, use Kinematic Rigidbody Colliders.  
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